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Introduction

all about taking control of your desktop away from the big corpora-

tions and putting it into the hands of the developers working with
your best interests at heart. The software is freely available on the
Internet for you to download — you can even help develop the projects if
you want to get involved. Decisions about what’s on your desktop aren’t
being made based on the profit margins yielded by the software. Instead,
the best interests of the user are of primary concern to the developers.

l inux is open-source software at it’s finest. Open-source software is

Although open-source software is great, have you ever tried to read the
documentation that comes with it? Some of it is very good, but most of it
is written for geeks, by geeks, and a good part of it is flat-out missing.
Don’t blame the developers — they are doing this for free after all. . . .

Our goal in writing this book is to empower you with some of the
stronger features of Linux (and some great open-source tools) to solve
everyday problems, without the headaches and lost time that go with
trying to figure out how to use the tools. Linux provides simple, fast, and
powerful solutions to meet the demands of day-to-day computer use and
system administration — our goal is to save you time, while making the
tools easy to use.

Saving Time with This Book

The Timesaving Techniques For Dummies books focus on high-payoff
techniques that save you time, either on the spot or somewhere down
the road. And these books get to the point in a hurry, with step-by-step
instructions to pace you through the tasks you need to do, without any
of the fluff you don’t want. We’ve identified more than 60 techniques that
Linux users need to know to make the most of their time. In addition,
each technique includes figures that make following along a breeze.
Decide for yourself how to use this book: Read it cover to cover if you
like, or skip right to the technique that interests you the most.
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In Linux Timesaving Techniques For Dummies, you
can find out how to

v Tame time-consuming tasks: We're letting you in
on more than 60 tips and tricks for your Linux
system, so you can spend more time on creating
great results and less time on fiddling with a fea-
ture so that it works correctly.

v Take your skills up a notch: You're already famil-
iar with the basics of using Linux. Now this book
takes you to the next level, helping you become a
more powerful user.

1 Customize Linux to meet your needs: Spending
some upfront time customizing Linux so that it
works faster, more reliably, and more like how
you work on a daily basis can save you time (and
aggravation) later.

v Fine-tune your system: You can fine-tune your
Linux system for better performance and usabil-
ity. Customizing your system to better serve
users saves everyone time.

v Improve your system security: Building a secure
user environment with good user hygiene and
regular backups will save everyone time. With
adequate security in place, your chances of hav-
ing to restore your system are minimized.

v Automate repetitive tasks: You can automate
and schedule repetitive tasks to run while you're
away, and save the bandwidth for the times that
you need it most.

Foolish Assumptions

We assume very little. We do, however, assume you
have a computer that is currently running Fedora,
Mandrake, or SuSE Linux (or that you're considering
a conversion), and that you more than likely are con-
nected to the Internet.

We assume that you know the needs of your users
and the demands of your system. We try to clearly
identify what aspects of a technique are best suited

to an individual user or a large corporate network,
but we assume you know which one you are.

We assume you make backups on a regular basis. If
you don’t, go immediately to Part IX: Backing Up
Means Never Having to Say You're Sorry.

We assume you don’t want to get bogged down in

a lot of useless details, so we concentrate on
getting techniques implemented quickly, without

a lot of overhead spent on theory. That’s a big time-
saver, too.

What’s in This Book

This book is organized into parts — groups of tech-
niques about a common subject that will save you
time and help you get your system running better.
Each technique is written to be independent of the
others, so you only need to implement those tech-
niques that are important to you and your users.
From time to time, we may send you to another tech-
nique to implement a feature that we’ll be using in
our current technique — we just don’t want to waste
valuable space repeating ourselves. Each of the parts
is about a different facet of a Linux system so you
can scan the part title easily, looking for problem-
solving techniques that will help you, quick.

Part I: Making the Desktop Work for You

Part I is full of tips and techniques to help you make
the most of your time at the desktop. Teaching your
system how to recognize file types (so you don’t
have to specify them every time you open a file),
keyboard shortcuts, and customizing your prompt
are included among the techniques. We also include
a rundown on the KDE protocols and the GNOME
virtual file systems — the handy tools that work in a
browser window to access other sources (like cam-
eras or CDs). You'll also find techniques about using
automagic variables and history files to make the
command line simple, easy, and quick.



Part II: Getting the Most from Your File System

This part focuses on moving and sharing data. Using
Windows filesharing across a network, finding the
files you need when you need them, and some quick
downloading techniques are included in this part.
This part also includes a technique about using User
Mode Linux to create a playpen with a built-in copy
of Fedora — handy if you need to jail a server or just
want to experiment with program modifications
safely.

Part lll: Good Housekeeping with Linux

You'll find techniques to help you make the most of
the RPM tool (the Red Hat Package Manager) for
installations, updates, and queries. Part Il also
includes a technique introducing you to Synaptic —
a handy tool that will keep your software current
and up-to-date with just a few clicks of the mouse.
We'll also introduce you to task scheduling tools that
can help you automate administrative tasks to run
without any supervision at all. Everyday timesaving
doesn’t get much better than Part III.

Part IV: Tweaking the Kernel
on Your Linux System

The techniques in Part IV are dedicated to the ker-
nel. We’ll show you how to build a new kernel, clean
up an old kernel, or find out about the condition of
your existing kernel. We’ll also introduce you to SE
Linux — the new security-enhanced kernel fresh
with this release of Fedora.

Part V: Securing Your Workspace

Part V is all about security — we’ll introduce you to
PAM (Pluggable Authentication Modules), and show
you quick ways to encrypt e-mail and files to keep
the prying eyes of snoops out of your personal docu-
ments. We'll also show you how to safeguard your
system by using sudo to dole out the superuser privi-
leges to only those users on your system who need
them. Your system will be a safer place with the
techniques in Part V implemented.

What’s in This Book 3

Part VI: Networking Like a Professional

The techniques in Part VI focus on using network
features and network analysis tools to your advan-
tage. We’ll show you how to set up and use remote
desktops from your local system, as well as how to
share desktops with remote users. We'll also show
you how to take care of your network security by
building sturdy but supple firewalls, and how to
harden those firewalls with the network security
analysis tool, Nessus. We'll also show you how to
watch network traffic to see what’s traveling across
your network to your users.

Part Vil: Monitoring Your System

In this part, we’ll introduce you to tools that will
help you keep an eye on your system resources and
control runaway processes. We'll also show you
some quick ways to take care of users and their
accounts — both new users and old.

Part VIII: Serving Up the Internet and More

In Part VIII, we'll focus on server-related issues. We’ll
show you the quick way to build and configure an
Apache Web server, a Sendmail mail server, and a
MySQL database server, as well as how to monitor
your servers once they’re in place. We'll also show
you how to make your new Web site a more secure
place with SSL certificates, and the easy way to cre-
ate your own certificate signing authority. Then we’ll
delve into e-mail — you’ll save a ton of time with

our techniques that help you avoid spam with
SpamAssassin and retrieve your HTTPMail (that’s
Hotmail, MSN, and Lycos mail) with hotway, avoiding
all of the ads and pop-ups that come with most
Internet mail accounts.

Part IX: Backing Up Means Never
Having to Say You're Sorry

The techniques in this part are all about backing up.
Techniques include getting ready to back up your
data, choosing a fast but sturdy backup scheme,
implementing a good backup routine, and backing
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up to remote storage. We’ll also introduce you to
CVS archiving — a great way to keep not only cur-
rent renditions of projects, but also a living history
of a project’s growth.

Part X: Programming Tricks

These techniques will help you save time in your
programming projects. You'll find a technique that
helps you use prewritten, open-source APIs in your
own code to help you cover ground quickly. You’ll
also find a technique that focuses on moving data in
and out of your PHP code. We'll also introduce you
to a great graphical debugger (DDD) that will save
you time when you need to debug your code —
that’s the last thing you want to spend too much
time on.

Part XI: The Scary (Or Fun!) Stuff

This part contains a medley of timesaving tech-
niques that will help you burn CDs, find dangerous
programs, create a UML jail, troubleshoot problem
programs, and more. We'll introduce you to Bastille,
a system-hardening, open-source tool that makes
most security schemes look wimpy. We'll also give
you the rundown on LIDS — an under-documented
but powerful security tool that you can use on your
system to create a secure user environment. We’ll

throw in an introduction to Zenity — a handy toolkit
you can use to add graphical prompts to any user
shell scripts you use on your system.

Icons Used in This Book

Each technique in this book has icons pointing to
special information, sometimes quite emphatically.
Each icon has its own purpose.

When there’s a way to save time, either now
or in the future, this icon leads the way. Home
in on these icons when every second counts.

L
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This icon points to handy hints that will help
you work through the steps in each technique
or to handy troubleshooting info.

These icons are your trail of breadcrumbs,
leading back to information that you'll want to
remember.

When you see a Warning icon, there’s a
chance your data or your system is at risk. You
won’t see many of these, but when you do,
proceed with caution.

* e @
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Finding the Power
in KDE Protocols

Technique

Save Time By

v~ Creating links to allow
quick access to important
data

+* Moving audio and image
files with Konqueror

v fishing for remote files
with a secure connection

v~ Easily accessing local
network information

+~ Reading documentation
— fast!

hen you type a typical URL, such as http://www.google.com/
Wi ndex.html, into your Web browser, you likely don’t think about

how you’re making use of it. That is, you don’t think about
http:// being a protocol, www.google.com being an address that the proto-

col handler knows how to deal with, and index.htm1 identifying a
resource at that address.

If you haven’t thought about URLs and their individual parts for a while,
you may be surprised to find out that KDE adds a number of new protocol
handlers, called KIO slaves, that know how to serve up data from new and
unusual sources, such as CDs and remote systems, through the Konqueror
Web browser.

Using the right protocol saves you the time of manually copying resources
all over the Web. The protocols are a varied bunch. In this technique,

we show you protocols that work with audio CDs or your digital camera,
handle remote file management, manage printers and e-mail, and read
documentation. Check them out — you can save time in lots of ways.

Discovering Your Protocols

Finding out about KDE protocols is not an easy task. They aren’t well
documented, and they can be tough to find. Some are universally helpful,
whereas others are more specialized (such as the LinPoch project at
Tinpoch.sourceforge.net, which lets you interact with Nokia cell phones
from KDE applications). Here’s how to see what protocols are installed
on the following versions of Linux:

v Fedora: Open the KDE Menu and choose System Tools=Info Center;
then click Protocols.
v SuSe: Open the KDE Menu and choose System=>Monitor=>Info Center.

v Mandrake: Open the KDE Menu and choose Systemr>Configuration=>
KDEr>Information=>Protocols.
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The Available IO Slaves column displays a list of
available protocols. For more information about a
protocol, click the protocol name, and the documen-
tation is displayed in the right column.

Some of the protocols are not documented. If
you find one that sounds interesting, search the
Web to see if someone has written about it.

Depending on which version of KDE you have
and which options are installed, the protocols
you find will vary.

Working with CD Audio
Tracks Using audiocd:

Linux

gives you all sorts of ways to rip the tracks

off audio CDs, but we haven’t found anything easier
than KDE'’s audiocd: protocol. This protocol is a
breeze to use:

1.

N

Insert a music CD into your drive.
If your CD player program starts, just close it.
Open the Konqueror Web Browser.

When Konqueror opens, enter audiocd:/ in the
Location bar and press Enter.

If your copy of KDE was compiled with audiocd:
support, the Web browser displays options for
ripping the audio files, as shown in Figure 1-1.

TaBLE 1-1: RippING Aupio FILES WITH AUDIOCD:

(See the preceding section to find out how to
view a list of available protocols.) See Table 1-1
for details on what the options do and how they
work.
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* Figure 1-1: The KDE audiocd: protocol.

Not all copies of KDE are created equal. The
copy of KDE currently distributed with Fedora
includes support for copying to .wav, .cda,
and . ogg files, but it doesn’t include the infor-
mation to create MP3s. You can get a copy of
KDE that has MP3 compiled in at www . kde . org.

Depending on your MP3 player, you may be
able to save lots of time loading files. If your
player can emulate a hard drive, you can open
it with Konqueror and drag your music on and
off the player.

Option What Is It? How to Use It
CDA Files A directory that contains one file for each audio track  Drag one of these . cda files to your desktop (or to
on the CD (track01l.cda, track02.cda,...). another folder), and audiocd: copies the raw
audio track to the new location.
By Track A directory that contains one file for each audio track  Drag one of these .wav files to your desktop (or to
(trackO0l.wav, track02.wav,...). another folder), and audiocd: converts the audio
track to WAV format.
Ogg Vorbis A directory that contains one file for each audio track, Drag one of these . 0gg files to your desktop (or to

in Ogg Vorbis format (such as 16 Burning Down The

House.ogg, 14 Once In A Lifetime.ogg,...).

another folder), and audiocd: converts the audio
track to Ogg Vorbis format.



Managing Snapshots with the camera: Protocol

Option What Is It? How to Use It
MP3 A directory that contains audio tracks Drag an .mp3 file to your desktop (or to another
in MP3 format. folder), and audiocd: converts the audio track to
MP3 format.
By Name A directory that contains audio tracks (with song

Album Name

names) in WAV format (16 Burning Down The
House.wav, 14 Once In A Lifetime.wav,...). This
directory is similar to By Track, except that you get
to see song titles in the By Name directory (By Track
only shows you the track numbers). You won'’t see a
By Name directory if Konqueror can’t find your CD
in the Web’s cddb database.

A directory that contains one file for each audio track,
in WAV format (identical to By Name except that the

directory name is the album name).

Managing Snapshots with
the camera: Protocol

The camera: protocol treats your digital camera like
it’s just another storage device, only this one is full
of pictures. camera: gives you thumbnail previews of
the photos on your camera, so you can easily iden-
tify and move your images to where you need them.
Just drag the images to your desktop (or to another
folder). Double-click an image file to open it with
your favorite editor (see Technique 3 to find out how
to choose an editor), and you’re working in a snap.

You can also use an image as your desktop
wallpaper. Drag the thumbnail to the desktop
and choose Set as Wallpaper from the menu
that appears.

To use the camera: protocol, follow these steps:
1. Plug in your digital camera and be sure it’s
turned on.

2. Open the Konqueror Web Browser.

3. Type camera:/ in the address line and press
Enter.

That’s all there is to it (see Figure 1-2).

B camena P PhatoSmart 120 (PTP mode)/siore_ 00010081/ DOIM/100HP 20 - Konquerr

Location Ede View Go Bookmarks Tools Setings Window Help

ALP.OFOSORE w QAT i-
b Lcation: | (@ camera:/(HP PhotaSman 320 (FTP mode)/store_ 00010001 DCIM/100HPIZ0 "E o]

IMDO2OIS. JPG| IMOOZ0I6 IPG  IMOOZ0AT JPG  IMOGZ03E IPG  IMOOKORE. IPG  IMOGOO4D, JPG IMOC204L. IFG

IMOO2CH2. JPG  IMDOZOMI_JPG  IMOO20S4. JPG

IMO0203_JPG (624.7 KB) JPEG Image |

¢ Figure 1-2: The camera: protocol, in action.

From here, finding your way around the inside of
your camera is just a matter of exploring.

When we plug in our HP PhotoSmart 320
digital camera and use the camera: protocol,
we see the single directory HP PhotoSmart 320
(PTP mode). Underneath the HP PhotoSmart
320 folder, our pictures are in a subdirectory
named store_00010001/DCIM/100HP320.
The directory structure used by your digital
camera is likely to be different. Use Konqueror
to find your way around the inside of your
camera. After you know where your images
are stored, you should be able to open those
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images directly from KDE-friendly applications
like KuickShow and KView.

Don’t bother trying to remember a long, com-
plex URL that corresponds to where your pic-
tures are stored. Instead, drag the folder to
your desktop and choose Link Here. Then,
whenever you want to play with your camera,
plug it in and click the shortcut.

7
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One thing to note — your pictures reside only in
your camera until you copy them onto your com-
puter. Be sure to store the pictures on your com-
puter before deleting them from your camera. After
you copy the pictures you want to keep, it’s easy to
erase the images from your camera; just delete them
or drag them to the trash like any other file.

Remote File Management
with fish:

fish: is a remote file access protocol. Using fish:,
you can work with files stored on a remote Linux
system as if they were located right on your desktop.
To use fish:, open a KDE browser (Konqueror is a
good choice) and enter fish:// followed by the host
name (or IP address) of the machine you're fishing for.

Under the hood, fish: uses SSH (Secure Shell) to do
its work, so you must have an SSH server up and
running on the remote machine before you can go
fishing. fish: prompts you for a user name and pass-
word on the remote system before allowing you
access to files. After you’'ve connected, you can
interact with the remote files and directories in

the same way you would deal with local files: Drag
them to your desktop, drag them to other folders,
drag them to the trash, or just edit them in place.

Here are some quick things you can do with the
fish: protocol:

v Manage files on another system with the
Konqueror file manager/browser. Using fish:
and Konqueror, you can easily move, copy,

archive, open, and browse remote files the same
way you handle files stored on your computer.

v Open fish: folders on two (or more!) systems
and copy files or even entire directories from one
machine to another by dragging from one win-
dow to another.

v Create a secure link on your local desktop that
points to a remote system. When you open the
link, fish: prompts you for login information
S0 not just anyone can get access via your com-
puter. To create a desktop link, right-click on your
desktop and choose Create Newr>Filer>Link to
Location (URL). Type in a name for your link and
enter a URL in the form fish://computer-name/
directory, for example fish://bastille/home/
freddie/Desktop.

v Edit remote files with KWrite. When you open
aremote file (such as fish://versaille/.
bash_profile), any changes that you make are
automatically saved back to the remote system.

The KDE protocols are a part of KDE, not
Linux. That means that any KDE-friendly appli-
cation (Kate, Konqueror, KMail, and so on) can
use them, but non-KDE applications won't
understand them. You can open a fish: URL
in just about any KDE application, and the
resource appears as if it were on your local
system. Note that not all KDE applications are
protocol-enabled, which means that they
won’t understand fish: URLs. You'll just have
to try out each application.

Getting Help with help:,
info:, and man:

KDE protocols give you fast access to help when you
need it. KDE sports three documentation protocols:
man:, info:, and help:. To use the protocols, open
your Konqueror browser, enter the protocol name in
the Location line, and press Enter. Konqueror will
take you to the top-level index for the protocol you
choose:



v man: When you browse through the man: proto-
col, you see a short index that provides access
to the ten or so sections of the Linux man pages.

The man: protocol is a great way to read man
pages because the documentation is pleas-
antly formatted and cross-referenced.

L/
e {4
&

When you navigate down one level from the
main index, the second level leaves a bit to be
desired. For some reason (we assume that
someone intends to fill in more information
later), it says “no idea” in a column to the right
of the topic list. Just ignore this and click your
topic, and you'll find the information you need.

v info: This protocol gives you access to docu-
mentation written in the Texinfo format, a format
popular with GNU software. Like man:, info:
documentation is cross-referenced and displays
a browsable menu with links that take you to the
documentation you want to read.

v help: This protocol lets you read documentation
in KDE’s documentation format. To find subjects
within help:, type help:/, followed by the topic
name. (For example, help:/kate takes you to the
Kate handbook.) If you need general information
about your KDE environment, a good starting
point is help:///khelpcenter.

) Just like Web page bookmarks that you
can create when surfing the Web, documen-
& tation bookmarks are great navigational time-
savers. Bookmark your favorite man pages
so they're easily accessible the next time you
need them! To create a new bookmark, just

choose Bookmarks->Add Bookmark.

Viewing Your Local Network
with the smb: Protocol

Use the smb: protocol to quickly browse other
machines on your local SMB (Samba and Windows
file/printer sharing) network. Enter smb:/ in the

Other KDE Protocols ’ ’

Konqueror address line and press Return to see the
SMB workgroups in your local network. Click an SMB
workgroup to see all the computers in that work-
group. Click one of the computers, and you see the
resources that computer is willing to share. Just drag
and drop the data you need or make clickable links
to resources — the time you save will amaze you.

L/ Use smb: to create desktop shortcuts to your
(a network locations. Just start your copy of

Konqueror, enter smb: / in the address line,
and press Enter. Choose a workgroup and
then a computer within that workgroup. Now
drag a share name to your desktop. Next time
you need data from that machine, you have it
at the click of a button.

Other KDE Protocols

We haven’t covered all the KDE protocols in this
technique. There are quite a few others you can
explore. Check out the ones listed in Table 1-2.

TaBLE 1-2: OTHER KDE ProtocoLs

Protocol What You Do with It

print: Manage printers, print jobs, and
print queues from your Web
browser.

devices: Find all your storage devices
here — hard drives, NFS and
Samba file systems, and
removable media.

imap: Send, receive, or just play around

pop3: with your mailbox as if it were a

mailto: local file system.

webdav: Modify a remote Web site or col-

laborate with others over the Web.

You can find more protocols on the Web.
Search for KIO slave at your favorite search
engine.
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KDE protocols versus GNOME VFS

KDE has protocols, and GNOME has the VFS (virtual file
system). KDE protocols and GNOME VFS modules do
pretty much the same thing: They make data available
from unconventional sources. The name protoco/ may
seem a bit misleading, but it's called that because the name
of the protocol goes in the protocol part of a URL. We think
that virtual file system is a more straightforward name than
protocol because a virtual file system basically creates
make-believe file systems and lets you use them to quickly
access your data.

Both the KDE protocols and the GNOME VFS work from
within a Web browser, but the GNOME VFS works best at
the command line. We have to admit that we're fond of
KDE for its usability and speed. However, sometimes
GNOME can be a real timesaver, as you discover in
Technique 2.



Getting GNOME
Virtual File Systems

Technique” to Do the Work

Save Time By

+* Using GNOME virtual file
systems

v Combining VFS modules

v~ Using VFS to work with
packages

+* Burning CDs and DVDs
from a browser

v~ Previewing fonts and
themes with Nautilus

for Vou

inux supports a wide variety of physical file systems. A file system’s
Ljob is to make sense of the bytes stored on a disk so that other pro-

grams don’t have to interpret them. A file system module, for exam-
ple, might look at the bytes in sector 52033 on your hard disk and say,
“Hey, that’s a directory.” File system modules also work in the other
direction as well. For example, a program might ask for a listing of the
/tmp directory, and the file system knows how to find that data on the
disk. A file system module creates order out of the billion or more bytes
of chaos on your disk.

GNOME takes the physical file system one step further by introducing
the virtual file system (or VFS for short). A virtual file system performs
the same function as a physical file system except that the underlying
data comes from somewhere beyond your disk. A virtual file system gath-
ers data from an unusual source and makes that data appear as a set of
directories, subdirectories, and data files. Using a VFS, you can peek into
tar, gzip, and RPM archives, treat remote files as if they were local, and
even access CD audio tracks as if they were normal data files. GNOME
also has some handy preview tools that let you view fonts and desktop
themes as if they were normal files.

In this technique, we show you how to save time by using some of the
more useful GNOME VFS modules. When you use the VFS, you don’t have
to waste time finding (and opening) the right program to view a file in an
unconventional location — GNOME does the hard work for you. Whether
you use the VFS in a browser or at the command line, the time you save
and the power you gain will surprise you.

Using GNOME UFS Modules

The GNOME VFS is still evolving, and not all GNOME applications are VFS
savvy. We've found that most (if not all) VFS modules work when you use



’4 Technique 2: Getting GNOME Uirtual File Systems to Do the Work for You

them from the command line, but some fail in
strange and quirky ways when you try to use them
from a browser. If you can’t get a VFS URL to work,
try it at the command line (we show you how in a
moment). If it works there, the problem is in the
browser.

To use a VFS module, simply use the module name
as if it were a protocol. For example, to open a font
that’s installed on your system, you can browse to
the URL fonts://Courier. Finding out which VFS
modules are installed on your system can be tricky.
The VFS modules are listed in a group of files in
/etc/gnome-vfs-2.0/modules, but just because you
find a module listed there doesn’t mean that the

TasLE 2-1: CommonLy IncLubep VFS MobuLes

module is actually installed. You also have to check
for the library in /usr/1ib/ gnome-vfs-2.0/modules/.
To save you some time, Table 2-1 lists some of the
most commonly included VFS modules.

/proc is a virtual file system that works in either
KDE or GNOME and exposes kernel data — see
Technique 26 for more information.

We cover only a few of the VFS modules dis-
tributed with Linux, but you can find others on
the Web. If you find another module you want
to use, you'll likely need to download and
compile it. See Technique 14 for help with
downloading and compiling programs.

Module Name What It Does

http: Accesses data stored on a Web server

https: Accesses data stored on a secure Web server (typically an e-commerce site)
ftp: Accesses data stored on an FTP server

mailto: Sends e-mail

bzip2: Peeks inside bzip2 archives

cdda: Treats CD audio tracks as if they were normal files

file: Accesses data stored in a local physical file system

nntp: Reads newsgroups by using the network news transport protocol
gzip: Peeks inside gzip archives

dav: Accesses data stored on a WebDAV server

pipe: Accesses data sent to a pipe

ssh: Connects to a remote SSH server

tar: Peeks inside uncompressed tar archives

fonts: Accesses font information

burn: Burns CDs from within a browser

themes: Accesses desktop themes installed on your system




Stacking UFS Modules

GNOME VFS URLs can be stacked together. For
example, if you have an uncompressed tar file located
on a remote system, you can stack a tar URL on top
of an http:// URL to get to the data stored inside.
Suppose that you have an uncompressed tar archive
named /tmp/pics.tar that contains an image named
freddie.jpg and you want to view that picture with
GNOME'’s Eye Of Gnome viewer.

Sure, you could un-tar the archive and tell the viewer
to open the JPG photo (reminding yourself to clean
up all the temporary files after you finish). But you
can save yourself time and trouble by making VFS
worry about those details. Rather than extracting
the image to a temporary location, you can use a
VFS URL like this:

$ eog file:///tmp/pics.tarfftar:/freddie.jpg

Here’s how the pieces of the command fit together.
First, the eog part is the name of the command that
you're running (Eye Of Gnome). Next, you see a typi-
cal URL (file:///tmp/pics.tar) that uses the file:
protocol to open /tmp/pics.tar. Next comes the
magical part: #tar:/freddie. jpg. That tells GNOME
to treat everything that precedes #tar: as a tar
archive and to access the freddie.jpg member
within.

What happens if the picture that you want to view is
stored in a compressed tar archive? Simple, just put

another VFS component (gzip) on the stack, like this:

$ eog file:///tmp/pics.tgzifgzip:ftar:/
freddie.jpg

If the pics.tgz file lives on a remote Web server, you
can combine the http: protocol with gzip: and tar:
like this:

$ eog http://myserver.example.com/pics.
tgzftgzip:#tar:/freddie.jpg

Working with Packages: rpm and rpms ’5

Most of the VFS documentation that you find
@ tells you that you can stack VFS URLs with the
following syntax: urlfurl/suburl. For exam-

ple, if you have a tar archive named /tmp/
foo.tar that contains a file named bar.txt,
the GNOME VFS documentation tells you
that you can access the bar. txt file with the
URL file://tmp/foo.tarfftar/bar.txt.
You can’t — the documentation is wrong.
Instead, you have to use file://tmp/foo.
tarfftar:/bar.txt. Notice the extra :
between tar and /bar.txt. Without that
colon, the fftar/bar.txt component acts like
a named anchor in an HTML document, not
like a VFS module.

Working with Packages:
rpm and rpms

The rpm: VFS module lets you peek inside an RPM
installer file. You can use the rpm: VFS to extract
select files from an RPM package without having to
install the whole thing. rpm: also lets you extract
metadata (such as the name of the package ven-
dor, the target distribution, and copyright) from

a package.

The rpm: module creates a virtual file system that
represents the contents of the RPM file. If you list
the directory of an rpm: URL, you see the name of
each file that would be installed by that RPM. You
also see a number of virtual files that expose the
extra data stored inside the RPM. Here’s an example:

[freddie@bastille] cd /mnt/cdrom/
Fedora/RPMS

[freddie@bastille] gnomevfs-1s file:
gnome-applets-2.4.1-1.1386.rpmffrpm:

-r--r--r-- 1 root root 941 Oct 3 2003
HEADER

-r-xr-xr-x 1 root root 39 Oct 3 2003
INSTALL

-r-xr-xr-x 1 root root 39 Oct 3 2003

UPGRADE
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dr-xr-xr-x 3 root root 0 Oct
INFO

-r--r--r-- 1 root root 0 Oct
INFO/NAME-VERSION-RELEASE

-r--r--r-- 1 root root 0 Oct
INFO/GROUP

-r--r--r-- 1 root root 0 Oct
INFO/BUILDHOST

-r--r--r-- 1 root root 0 Oct
INFO/SOURCERPM

-r--r--r-- 1 root root 0 Oct
INFO/DISTRIBUTION

-r--r--r-- 1 root root 0 Oct
INFO/VENDOR

-r--r--r-- 1 root root 0 Oct
INFO/DESCRIPTION

-r--r--r-- 1 root root 0 Oct
INFO/SUMMARY

dr-xr-xr-x 1 root root 0 Oct
INFO/SCRIPTS

-r--r--r-- 1 root root 0 Oct
INFO/SCRIPTS/POSTIN

-r--r--r-- 1 root root 0 Oct
INFO/SCRIPTS/ALL

-r--r--r-- 1 root root 0 Oct
INFO/PACKAGER

-r--r--r-- 1 root root 0 Oct
INFO/URL

-r--r--r-- 1 root root 0 Oct
INFO/SERTAL

-r--r--r-- 1 root root 0 Oct
INFO/COPYRIGHT

-r--r--r-- 1 root root 0 Oct
INFO/LICENSE

-r--r--r-- 1 root root 0 Oct
INFO/BUILDTIME

-r--r--r-- 1 root root 0 Oct
INFO/RPMVERSION

-r--r--r-- 1 root root 0 Oct
INFO/0S

-r--r--r-- 1 root root 0 Oct
INFO/SIZE

-r--r--r-- 1 root root 0 Oct
INFO/REQUIRENAME

-r--r--r-- 1 root root 0 Oct
INFO/OBSOLETES

-r--r--r-- 1 root root 0 Oct
INFO/PROVIDES

-r--r--r-- 1 root root 0 Oct
INFO/CHANGELOG

-rw-r--r-- 1 root root 63419 Oct

3

3

3

3

3

2003

2003

2003

2003

2003

2003

2003

2003

2003

2003

2003

2003

2003

2003

2003

2003

2003

2003

2003

2003

2003

2003

2003

2003

2003

10:28

/etc/gconf/schemas/battstat.schemas

-rw-r--r-- 1 root root 8364 O0Oct 3 10:28
/etc/gconf/schemas/cdplayer.schemas
-rw-r--r-- 1 root root 21092 Oct 3 10:27
/etc/gconf/schemas/charpick.schemas

The first 28 files listed are virtual files, and the rest
are real files that would be installed on your system
if you installed this particular package.

You can extract a single file from an archive by using
gnomevfs-cat, for example:

[freddie@bastille] gnomevfs-cat
file:gnome-applets-
2.4.1-1.1386.rpmffrpm:HEADER

Name : gnome-applets
RelTocations: (not relocateable)
Version c2.4.1
Vendor: Red Hat, Inc.
Release 1

Build Date: Fri Oct 3 10:29:07 2003
Install Date: (not installed)

Build Host: daffy.perf.redhat.com
Group : User Interface/Desktops

Source RPM: gnome-applets-

2.4.1-1.src.rpm

Size : 11210002
License: GPL
Signature : DSA/SHA1, Tue Oct 28
19:10:23 2003, Key ID b44269d04f2a6fd2
Packager : Red Hat, Inc.
<http://bugzilla.redhat.com/bugzilla>
URL : http://www.gnome.org/
Summary : Small applications for the

Gnome panel.

Description :

Gnome (GNU Network Object Model
Environment) is a user-friendly set of

applications and desktop tools to be used
in conjunction with a window

manager for the X Window System. The
gnome-applets package provides

small utilities for the Gnome panel.

Notice that you can access both virtual and real files
within the RPM.

The rpms: module (note the s on the end) lets you
treat the database of installed software as a virtual
file system. In other words, when you view the



content of an rpms: URL, you see a list of the pack-
ages (sorted by category) installed on your system.

You can also use the deb: module to play with
Debian Package Manager packages.

Putting UFS to Work at the
Command Line

The GNOME VFS system includes a few VFS-friendly
programs that you can use at the command line (or
within shell scripts):

v gnomevfs-cat: This program is equivalent to the
normal Linux cat command: It writes the contents
of a file to standard output. Unlike the simple cat
command, gnomevfs-cat can deal with VFS URLs.
gnomevfs-cat deals with all of the normal hassle
of downloading, unpacking, and cleaning up tem-
porary files when you're finished. For example:

$ gnomevfs-cat http://myserver.example.
com/index.html > index.htm]l

v gnomevfs-copy: This handy file copy utility is
powerful. When you run this program, you can
specify a URL for the source, the destination, or
both. Just like gnomevfs-cat, gnomevfs-copy
handles the dirty work — it downloads (or
uploads!) files for you, inserts new content into
existing archives, or extracts content from an
archive without all the prep-work and cleanup.
For example, here’s how to copy a file from a
remote Web site to your local system:

$ gnomevfs-copy http://myserver.example.
com/foo.txt file:///tmp/foo.txt

v gnomevfs-info: This program displays tidbits of
information about a given URL. You can see the
modification time, file size, and MIME type. (See
Technique 3 for more information about MIME

types.)
v gnomevfs-1s: This program lists the contents

of a directory accessed through a VFS URL.
gnomevfs-1s is great when you want to browse
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through an archive (or an RPM package) stored
at a Web site, but you don’t want to download
the file first. For example, to list the contents of
an RPM file, use the following command:

$ gnomevfs-1s http://myserver.example.
com/foor.rpmfrpm:

¥ gnomevfs-mkdir: Use this program to create a
directory with a VFS URL. You'll probably find
this program most useful when you need to cre-
ate a directory on a remote system (using the
http:, smb:, or ftp: protocols).

Burning CDs with a UFS

One of the handiest VFS modules is burn:///, which
lets you burn CDs and DVDs from within the Nautilus
browser. If you have a CD or DVD burner, browse to
burn:///, and Nautilus shows you an empty folder.
From there, to burn a CD you just drag a file to the
folder, insert a blank CD into your drive, and click
Write to CD (on the toolbar). Don’t forget that you
can drag a remote file directly into the burn:///
folder — just open a second Nautilus window and
browse to the server that holds the file you want.

Skinning Your Desktop with UFS

The themes: VFS gives you quick access to the desk-
top themes installed on your system. Browse to
themes:///, and Nautilus shows you all the themes
installed on your system. If you find a theme that
you like, just double-click the preview, and you've
changed your desktop theme.

Another handy VFS is fonts:. The fonts: VFS exposes
all the fonts installed on your system. Browse to
fonts:/// to see thumbnail samples of all the fonts
available on your system (along with the font names).

] If you see a font that you want to use as your
> («a desktop font, right-click the icon and choose
& Set as Application Font from the drop-down
menu.
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Save Time By

v+~ Understanding how
MIME classifies data and
how your files are
affected

+~ Tweaking file associa-
tions in KDE

v~ Creating MIME types
quickly with GNOME

HTML desktop file, and GNOME opens that file in Mozilla. How does

Linux know which program to use? It consults a MIME — not those
folks on street corners wearing striped shirts and tons of makeup, but a
registry of data types that associates a file type with a specific application.

C lick a JPEG file, and KDE opens the image in KuickShow. Click an

The default associations are a fine place to start, but after you develop
your own preferences about which applications you want to use for certain
file types, the defaults can begin to get in your way. You’'ll save time (and
effort) in the long run if you tweak these MIME types to establish quick
links between your data files and your favorite applications. For example,
if you edit a lot of graphics files but have several graphics editors, you
most likely have a favorite. Instead of opening and navigating through
your favorite program every time you have to open a graphics file, give
your favorite editor the highest priority. Double-click the data icons, and
you've opened not only your data, but also your favorite program!

In this technique, we show you how to create new MIME data types and
associate your applications with the data types that you use frequently.
The technique is a little different depending on which desktop environ-
ment (KDE or GNOME) you use, but either way;, it’s quick and easy.

Classifying Data with MIME

Before you start tweaking your file associations, it’s helpful to know

the basics about how MIME works with your files. Originally, MIME
(Multipurpose Internet Mail Extensions) was designed for e-mail clients
to categorize e-mail attachments. Nowadays, it’s used in many other pro-
grams as well, such as Web browsers, graphics utilities, and productivity
tools. The MIME registry performs two distinct functions, but the line
between those functions is pretty blurry:

v MIME looks at a chunk of data (usually a data file) and categorizes it
based on the file extension or based on patterns in the data.

v The MIME registry connects applications and data by associating an
application with each data type.



Thus, opening a file with MIME is a two-step process:
MIME categorizes the data, and then it finds an appli-
cation that knows how to deal with that kind of data.

Typically, a program that knows how to process a
given file type automatically creates MIME associa-
tions for that type, but that’s not always the case:

v If you open a file that doesn’t have a MIME asso-
ciation, Linux prompts you to select a program
to use. You have to do the grunt work of setting
the association yourself.

v You may find that you have more than one appli-
cation that knows how to process a given file
type. For example, text/html is often associated
with both Konqueror and Mozilla. If a MIME type
is associated with more than one application,
Linux chooses the application with the highest
priority when you open that file type. You can
tell Linux which application to use by giving the
program you prefer the highest priority in the
MIME registry.

Web pages make great desktop links. After
you associate HTML files with your favorite
browser, add the links you use most fre-
quently to your desktop. Double-click a link,
and it opens in your favorite browser.

When you begin customizing your file associations,
you’ll find that MIME data types are arranged in a
tree-structured hierarchy. At the bottom of the tree,
you find the data type definitions themselves. Upper
levels in the tree group similar data types. For exam-
ple, text/htm1 describes the htm1 data type within
the text group. MIME can determine a file’s data
type in two ways:

v By extension: When you open a file such as
backup.tar, MIME searches for the extension
(.tar) in its database of known file types. If it
finds a match, MIME classifies the file by exten-
sion (in this case application/x-tar).

v By content: Several extensions can map to the
same MIME data type; for example, .htm and
.htm1 are both classified as text/htm1. If you
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open a file whose extension is not recognized,
MIME peeks inside the file and tries to recognize
a pattern. For example, all JPEG picture files
include the string JFIF near the beginning of the
file; PNG pictures include the string PNG near
the beginning of the file; and Real Player audio
streams begin with four bytes whose values are
0x2e7261fd.

Creating KDE File Associations

Most applications that create data of a given type
automatically associate with that type, but occasion-
ally you need to adjust those associations. For exam-
ple, say that you frequently work with buttons on
Web sites, so you always design new buttons as
JPEG files in Icon Editor. You can save yourself the
time of poking around in the interface by simply
changing your default JPEG editor from KuickShow
to Icon Editor.

- text file in your favorite editor in a snap with
the KDE desktop. Just right-click on the desk-
top, choose Create New, and then choose Text
File from the list of data type options. Enter a
name for the new file and click OK, and KDE
adds the icon to the desktop. Now, a simple
double-click opens the new file in the editor

you set with file associations.

2 You can use file associations to open a new
=)

&

With MIME, you can associate any number of appli-
cations with a single MIME type, and KDE uses the
application with the highest priority to open data of
that type. It’s easy to change the default program
that opens your data in KDE:

1. In Fedora or SuSE, open the KDE menu and
click Control Center.

If you're using Mandrake, open the KDE Menu
and choose System=>Configuration=>Configure
Your Desktop.

2. On the left side of the Control Center, click KDE
Components and then click File Associations.
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The File Associations — Control Center dialog
(shown in Figure 3-1) appears, displaying the pre-
defined MIME types in the Known Types area.

Rl File Associations - Contral Center
Bl Wew Help
Indox . Seweh | Help | Find floname partem Genenl || Enbedng =
[= = appeasance & Themes | .
=~ & Deskiop | ricwn Types = Fename Patterns
image
| ‘ oo yt egm E g || [*dees Add.
o BBy nvamar & Morwork g I,-ia |+4og
& KDE Compenems (BN
Addmss Riook gt E — |+
£ Companent Choaser
wong Descrption

) File Manages # svgermi IPEG Image

Service Manager Wt

{6 Session Manager - Application Preforence Cedor

“% Spell Checker W || | [Kuckshow
+ 5 Peripherals xdee Image Viewes
+ 53 Powes: Contral Wxdng Icon Exor
R Regional & Accessibility o x-msed "
< [l Secusity & Privacy oo xpex [
+ [ Sound & Multimedia W x-photo-cd
+ B Sysbem Admiristration o x-porabie-b...
= 4 Web Browsing vt x-ponabieg...v o
'_l )| Dedaudrs Apply | —J

* Figure 3-1: The File Associations - Control Center dialog.

3. Inthe Known Types area, expand the relevant
group to show a list of known image types.

For our example, we click the Image group.

4., Click the file type whose association you want
to set or change.

We click jpeg. The right side of the dialog dis-
plays the current file associations.

5. In the Application Preference Order box, if you
don’t see the application that you want to asso-
ciate with the file type, click the Add button
and use the file chooser to find the program
that you want.

6. In the Application Preference Order box, select
the application you want to make the first pri-
ority, and then click the Move Up button until
the application appears at the top of the list.

In our example, we select Icon Editor and then
click the Move Up button to move Icon Editor to
the top of the list.

7. When you're finished, click Apply to save your
work and close the dialog.

Now, when you open the file type (such as a . jpg,
or .JPG file), KDE opens the file with the applica-
tion you selected (Icon Editor, for example).

Technique 3: Streamlining Your Work with File Associations

With the same dialog that you just used to change
the application preference order, you can also do the
following:

v To associate a new file extension with the
selected MIME type, click the Add button in the
Filename Patterns box. If you need to add a dif-
ferent spelling of a filename extension (which
you probably won’t have to do often), this is the
place to do it.

v Choose the icon to the left of the Filename
Patterns box to change the icon for this type.
Control Center displays a palette of alternate
icons that you can choose from — just click the
one you like.

7 Changing the icon to something you can
remember lets you instantly recognize file
& types in your browser or on your desktop.

Well-behaved KDE applications (such as Kate,
the KDE programmer’s editor) know how to
deal with MIME file associations. If you open a
file whose data type isn’t included in Kate’s
MIME associations, KDE opens the program
you've assigned to that file type in your MIME

registry.

Creating New MIME Types
with GNOME

The GNOME MIME mapping system is a bit more com-
plex than KDE’s. GNOME lets you define an icon for
each MIME type, a default action (such as print, view,
or edit), and a list of applications that know how to
deal with that type. MIME defines a two-level hierar-
chy for data type; for example text/htm1 describes
the html type in the text group. GNOME introduces a
new layer that collects related groups in categories.
This practice is handy in theory, but it makes it a little
harder to find the MIME type you’re looking for.

This next example sets your JPEG editor to xview —
an oldy but a goody that needs special treatment.



xview isn’t included in the Default Action list, so you
need to add it as a custom program. To associate a
new application with an existing MIME type:

1. Open the GNOME menu and choose
Preferences.
2. Click File Types and Programs.

The File Types and Programs dialog, shown in
Figure 3-2, appears.

- Flle Typos and Programs
| Descilption =1 | Add File Type...
b Audo Add Service... |
P Dotuments Edt... 1
= Images =
whender file Fprte
Windows BEmag image
CGM image
GIF mage
IEF Image
PG Image
SNVG an
TIFF Image
AutcdAD image =
3 eip 3 Close
¢ Figure 3-2: The File Types and Programs dialog in
GNOME.

If you're using SUSE, open the GNOME menu
and choose Desktop Preferences->Advanced>
File Types and Programs.

3. Click the arrow next to the category you want
to change, and you’ll see the list of MIME types
in that category.

In our case, we chose Images.

If you ever need to add a new MIME type
(one that doesn't already appear in the list of
known types), open the File Types and
Programs dialog, click the Add File Type but-
ton, and follow the on-screen prompts.

4, Click the MIME type you want to change and
then click the Edit button.

Because we want to assocate xview with JPEG
photos, we clicked JPEG Image.
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The Edit File Type dialog opens, as shown in Figure 3-3.

Description: JPEG image

MIME type: image/ipeg

Category: Images Choose.
Filename extensions:

Add: e

Ipeg
chis Irg -
Actions

Viewer component: View as Image
Dafault aclion Custom
Program to run: ~| Browse,

Run in Terminal

X Cancal POK

* Figure 3-3: The Edit File Type dialog in GNOME.

5. Select Custom from the Default Action drop-
down list.

6. Click the Browse button (to the right of the
Program to Run box), and find the application
that you want to associate with this type.

The xview program is located in /usr/bin/X11,
so we pointed the file chooser to that directory,
highlighted xview, and clicked OK.

xview is now your default JPEG editor, and it has
been added to the Default Action list. Now if you
ever switch to a different default editor again,
you can easily go back to xview because it’s on
the list.

7. If you want to associate an icon with the newly
defined file type, click the No Icon button and
select an icon from the icon palette. Click OK
when you’re finished.

After you choose the icon, your new icon is dis-
played at the top of the Edit File Type dialog.

L/ By changing the icon to something more
i (@ memorable, you can quickly recognize file
&

types in your browser or on your desktop.

8. Click OK and then click Close to save your
work.
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You may have noticed that the Edit File Type dialog
has a drop-down list labeled Viewer Component. Most
GNOME-savvy applications can display certain file
types in-line. This means that if you open a file that
has a built-in viewer component, the file is displayed
within your application — you don’t have to stop
what you're doing and open a new application just
to see your data.

For example, if you're using the Evolution e-mail client
(a GNOME-savvy application) and you receive a JPEG

image as an attachment, Evolution allows you to view
the image without firing up an external application —
the image displays in-line.

When you’re modifying MIME types, the Viewer
Component drop-down list is disabled unless
GNOME has a component that can handle your file.
In some cases, GNOME can display your file type
with a number of different components; choose the
one you prefer from the Viewer Component drop-
down list.



Prompting Yourself
with a Custom

Technique  Prompt

Save Time By

+~ Keeping useful informa-
tion handy

v~ Colorizing your prompt to
convey useful information

v~ Saving your prompt pref-
erences

+* Warning yourself when
you hold potentially
dangerous privileges

working in the shell. If you haven’t already modified it, your
prompt displays your machine name and current directory. But
why settle for less information than you could really use?

Your prompt is your connection to the Linux world when you’re

Customize your prompt to keep information that you need in plain sight
when you’re working at the command line. You can add information such
as the time, date, number of users, and more. In addition to displaying
system information, your prompt can change colors. If you use multiple
terminal windows connected to multiple machines, use a different-colored
prompt on each machine to give you a quick clue about your location, all
without taking up screen space.

The prompt also reflects your status as a superuser (or as a mere mor-
tal). Keep an eye on your privilege level to prevent damage from the acci-
dental use of privileges. We've included code in this technique to make
the prompt change color when you hold elevated (and thus potentially
dangerous) privileges.

In this technique, we show you how to manipulate your prompt to dis-
play the information that lets you get the job done quickly. Information is
power, and power definitely saves time.

] Long prompts can take up a lot of screen real estate and also consume
- { -a) alot of space on the printed page. In this technique, we show you
& complete prompts that enable you to see useful info quickly and eas-
ily. However, you don’t want to work with these prompts all the time.
In other techniques, we shorten the prompt to $ or # to save space.

Making Basic Prompt Transformations

In the bash shell, the prompt is controlled by a set of environment vari-
ables, the most important of which is $PS1. Change $PS1, and you change
your prompt. The $PS1 variable is displayed when bash is waiting for a
command from you. The $PS?2 variable is also worth mentioning — it’s
displayed when bash needs more input to complete a current task.
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If $PS1 contains a simple text string (such as "Hi,
I'm the prompt"), that string is displayed whenever
a command completes and the shell is waiting for
the next command. Modifying the prompt is easy:
Just enter strings that you want to test and hit Enter,
and the results are displayed instantly. Saving your
changes takes a bit of maneuvering, but we cover
that in the next section. Here’s a quick example of
how to change the prompt:

[freddie@bastille] PS1="Hi, I'm the
prompt "
Hi, I'm the prompt

Notice how the prompt changed from
[freddie@bastille]l to "Hi, I'm the prompt".

Adding Dynamically Updated
Data to Your Prompt

Static prompts, such as the example in the preceding
section, are kind of boring, so bash lets you include
special character sequences (we’ll call them macros)
that represent changing data. Each macro starts with
a backslash and is followed by a single character
that tells bash which chunk of data you want to dis-
play. For example, if you want to display the current
date and time whenever the prompt is displayed,
use the \d (date) and \t (time) macros like this:

[freddie@bastille] PS1="\d \t "
Thu Dec 18 03:37:48

TaBLE 4-1: Hanpy Macros For Your PRompT

You can mix dynamic macros and static text in the
same prompt. To enclose the date and time in brack-
ets, just include the brackets in $PS1:

[freddie@bastille] PSI="[\d \t] "
[Thu Dec 18 03:37:50 1]

It's usually a good idea to end each prompt
with static text (a character like ], -, or >) and
a space to make the prompt easier to read.

If you press Enter a few times with this prompt, you
see that the macros in $PS1 are evaluated each time
the prompt is displayed:

[freddie@bastille] PS1="[\d \t] "
[Thu Dec 18 03:37:51 ]
[Thu Dec 18 03:37:51 ]
[Thu Dec 18 03:37:58 1]
[Thu Dec 18 03:38:01 ]

You can include as many macros as you want, in any
order that you want, in $PS1. For example, to display
the current date and time, your user name, your
host name, and the current working directory (in
that order), try this:

[freddie@bastille] PS1="[\d \t \u@\h:\w] "
[Thu Dec 18 03:40:20
freddie@bastille:/home/freddie]

Spacing is important. Be sure to leave some white
space between macros to make the info easier to
read. Table 4-1 lists some of the most useful macros
that you can include in a bash prompt.

Macro What It Does/Displays Timesaving Bonus Info

\a Speaker beep To keep users on their toes, code the $PS? variable to beep when
the user needs to input additional information. Just enter
$PS2="\a >", and the computer beeps when it needs attention!

\d Weekday (Sun-Sat), month name, and date Handy when you’re pulling all-nighters and you need to know

("Thu Dec 18", for example)

when Saturday morning rolls around.
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Timesaving Bonus Info

\D{}

\e

\h

\H

\n
\'s

\t
\T
\@
\A
\u

\W

\w
\\
\ !

\$

Date and/or time in a format of your choosing

Escape character; used for complex strings

Host name up to the first . (dot)

Entire host name

Newline

Shell name — such as bash or csh

Current time in 24-hour (HH:MM:SS) format
Current time in 12-hour (HH:MM:SS) format
Current time in 12-hour (am/pm) format
Current time in 24-hour (HH:MM) format

Current user name

Trailing component of your current
working directory

Entire current working directory
Backslash character

History number

If the effective UID is 0, a #; otherwise a $

The \D macro must be followed by a format string enclosed in
braces. bash interprets the format string by using the same rules
as the strftime library function (see man strftime for more
details). If the format string is empty, the braces are still required,
but bash chooses a display format appropriate to your locale.

Escape characters introduce complex, unfriendly terminal
command sequences. We show you a better way later in this
technique.

If you work on a number of different hosts from the same work-
station, \h can help you remember which one you're currently
connected to.

Similar to \h, but takes up too much screen real estate for our
taste.

Use a new line to create a multiline prompt.

We’ve never found a particularly good use for this one because
we always stick to bash.

Is it 5:00 yet?

Include \u if you need to do work on someone else’s behalf (in
other words, if you're an administrator). That way you won't for-
get who you are and send flaming e-mail using someone else’s
name!

This is probably the most useful macro you could include in a
custom prompt — sort of a “You Are Here” sign.

Similar to \W, but takes up a lot of room on your command line.

Every command that you execute is stored in a history log, and
you can refer to a specific command in the log by its history num-
ber. Include the \ ! macro in your prompt, and you'll see the his-
tory number assigned to each command. (We talk more about
history processing in Technique 9.)

The \ $ macro displays a pound sign (#) if you hold superuser
privileges or a dollar sign ($) if you don’t. You can use the \$
macro to help you remember when you have enough privileges to
seriously damage your system, but we show you a better way in
the section “Seeing a Red Alert When You Have Superuser
Privileges,” later in this technique.
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Colorizing Your Prompt

Changing the color of your prompt may not save you
tons of time, but it can make the prompt more read-
able and convey extra information without taking up
screen real estate.

What kind of information can you encode with
e («ﬂ colorized prompts? Just about anything. Turn

your prompt green when you're logged into
one host and blue when you're logged into
another. Display your prompt in green when
the system load is low, yellow as it increases,
and red when you're running into resource
bottlenecks. Or, just change the color of your
prompt to a fixed color so that it stands out on
the screen.

You can colorize your prompt two ways. The most
common (but not the most timesaving) way is to
include special “escape” characters (characters that
your terminal window understands, but humans
don’t) in your prompt. For example, the following
string turns your prompt blue:

[freddie@bastille] PSI1="\[\033[0;34m\]
[\u@\hJ\[\033[0m\] "
[freddie@bastille]

Of course, because this is a black-and-white book, you
can’t see the color here, but if you try this example,
you'll see that the prompt turns blue. This method
works, but it has two drawbacks. First, the syntax is
hard to read (and hard to get right in the first place).
Second, this method works only if your terminal
emulator supports ANSI escape sequences — many
terminal emulators (and many terminals) don’t.
Fortunately, you can fix both problems at once by
using tput.

7 When changing the color of your prompt, using
- («a tput makes your prompts portable. That is, if
) you move to another terminal emulator, you
don't have to change prompts. tput also

knows the right escape sequences, so you
don’t have to spend time looking them up.

The blue prompt in the preceding example looks like
this when you use tput:

[freddie@bastille] BLUE=$(tput setaf 4)

[freddie@bastille] BLACK=$(tput setaf 0)

[freddie@bastille] PS1="\[$BLUE\]\u@\h]\
[$BLACKN] "

[freddie@bastille]

The first line uses tput to find the character sequence
that changes the foreground color to blue. The sec-
ond line finds the character sequence that changes
the foreground color to black. Notice that you don’t
need to know the magic escape sequences; tput
keeps a database of terminal descriptions and con-
sults that database to find the sequence that corre-
sponds to the terminal (or terminal emulator) you're
using. The third line patches the $BLUE and $BLACK
sequences into the $PS1 prompt string.

The $PS1 string, however, is still more complicated
than it needs to be — it’s got a few extra \[ and \]
sequences. Those extra characters are required so
that bash knows which prompt characters take up
screen real estate and which ones don’t (the invisible
characters must appear between a \[ and \] pair).

When you use tput, you can clean up extra
characters a bit more by including those extra
characters in the $BLUE and $BLACK variables:

[freddie@bastille] BLUE="\[$(tput setaf
4)\]"

[freddie@bastille] BLACK="\[$(tput setaf
0\

[freddie@bastille] PS1="$BLUE\u@\h]$BLACK "

[freddie@bastillel]

tput can do much more than just change the foreground
color of the prompt. Table 4-2 shows a few of the more use-
ful tput sequences. (For a complete list, see man tput and
man terminfo.)
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TaBLE 4-2: Some USEFUL TPUT SEQUENCES Notice that we used tput sgr0 to restore the text

back to its normal state (default color, no underline,

no bold). That’s usually a good idea when you use

tput to customize your prompt. Otherwise, what-

tput bold Display text in bold font. ever you type in after the colorized prompt will be
colorized as well.

Sequence What You Use It For

tput sgro Reset all formatting.

tput rev Display inverse-colored text (white on black
instead of black on white, for example).

tput smul Start underlining text. Seeinq a Red A[ert When yau
tput rmul Stop underlining text. Ha (/'e Superuser Pri (/i ,eqes

tput setaf Set foreground color.

tput setab  Set background color. We mention earlier in this technique that we can
show you a better way to remind yourself that you
These are your choices for foreground and back- hold dangerous superuser privileges. The typical
ground colors: way to distinguish between superuser status and
mere-mortal status is to change one character in
0 Black your prompt (usually the last character) from $ to #.
But that’s a pretty small change and can easily go
1 Red unnoticed. Superuser privileges are dangerous: one
2 Green mistake, and you're looking at hours of cleanup.
3 Yellow Here’s a way to make your privilege level jump out

at you: When you hold superuser privileges, your
prompt is displayed in red, and when you don’t,

5 Magenta your prompt is displayed in blue. The following
steps explain how to make this change:

4 Blue

6 Cyan
7 White 1. Open a terminal window and give yourself
superuser privileges with the su command.
Just find the color you want to use and stick it at the $ su
end of the tput setaf or tput setab command. Password:
# su
You can combine the different text effects to produce
colored and underlined prompts, boldface inverse 2. Open the /etc/bashrc file in your favorite
fonts, and any combination of your terminal supports. editor.
For example, you can display an underlined blue # kedit /etc/bashrc

prompt:
If you prefer GNOME, you can use gedit instead:

[freddie@bastille] BLUE="\[$(tput setaf # gedit /etc/bashrc

4HN]"
[freddie@bastille] ULINE="\[$(tput smul)\]1"
[freddie@bastille] RESET="\[$(tput sgr0)\1" If you're using SuSE, modify the
[freddie@bastille]l PSI="$BLUESULINE[L\ /etc/bash.bashrc.local file. If the file
U@\hJ$RESET " doesn't already exist, it is automatically

[freddie@bastille] created when you save your changes.
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3. Add the following code to the end the file:

function setprompt

{
lTocal BLUE="\[$(tput setaf 4)\1"
Tocal RED="\[$(tput setaf 1)\1"
lTocal RESET="\[$(tput sgr0)\]1"

# If 'id -u” returns 0, you have
# superuser privileges

if [ id -u = 0]

then
PS1="$RED[\u@\h:\WI$RESET "
else
PS1="$BLUE[\u@\h:\WI$RESET "
fi
1
setprompt

4. Save your work and close the editor; you're
finished!

We want to note a couple of interesting points about
this sample code:

v First, you must add this function to the /etc/
bashrc file, not your own personal ~/.bashrc
file. Why? Because you want to modify the
prompt not only for yourself, but also for the
superuser. (Remember, /etc/bashrc is executed
for all users, and ~/.bashrc is executed only
when you log in.)

v Second, notice that we created a shell function
and put most of the code inside that function. By
declaring the $BLUE, $RED, and $RESET variables
as local, they're destroyed as soon as the func-
tion (setprompt) ends. If you don’t wrap the vari-
ables inside a function, you’ll find them in your
list of environment variables and probably won-
der where they came from. We give some more
words of shell-scripting wisdom in Techniques 8
and 10.

Saving Your Work

When you find a prompt that you’d like to keep, you
want to store the $PS1 variable somewhere so that
your prompt returns the next time you log in. The
safest place to set $PS1 is in your ~/.bashrc login
script. (This script is executed every time you start
a new shell.) To save your fancy new prompt:

1. Start your favorite editor (kate, kedit, or the
GNOME Text Editor will do).

2. Open the file /home/user-name/ .bashrc.

Make sure you type in your Linux user name
instead of user-name and make sure you include
the period before the word bashrc. Your .bashrc
file will probably look something like this:

# .bashrc
# User specific aliases and functions

# Source global definitions

if [ -f /etc/bashrc 1; then
/etc/bashrc

i

3. Add the following code to the end of the file:

## Customize the prompt
BLUE="\[$(tput setaf 4)\]"
ULINE="\[$(tput smul)\]1"
RESET="\[$(tput sgrO)\1"
PS1="$BLUESULINE[\u@\hJ$RESET "

4. Now save your changes and close the editor.

If you want to change the default prompt for newly
created user accounts, give yourself superuser privi-
leges and modify the /etc/skel/.bashrc file.
/etc/skel/.bashrc is copied to a user’s home direc-
tory when his or her user account is created.



Your ~/.bashrc script is executed whenever you log
in. If another user logs in, the .bashrc script in that
user’s home directory is executed. If you want to cus-
tomize the prompt for all users (not just for new
users), store your changes in /etc/bashrc.

Technique 8 spells out the rules for deciding which
login script you want to modify — see that tech-
nique for all the details.

Saving Your Work 2 9

If you're intrigued by the idea of customizing your
bash prompt and want more information, browse
around the bashprompt project Web site at

www.gilesorr.com/bashprompt/howto/
bookl.htm]l

This site offers some great examples and back-
ground information.
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Save Time By

v~ Using shortcuts to com-
plete filenames

v~ Using environment vari-
ables to filter results

v~ Customizing name com-
pletion for remote logins

line for pure speed and raw power. Using bash is an obvious choice

when you need to do something fast, but unless you're the perfect
typist, keyboard errors can slow you down — especially if you type faster
backwards (that is, with the Delete key) or if you’re working in a case-
sensitive environment like Linux.

Graphical applications look nice, but it’s hard to beat the command

With a few shortcut keystrokes, bash will complete your command line
for you — we call that feature a dynamic shortcut. Not having to retype
incorrectly entered commands or filenames can save you hours in no
time. With dynamic shortcuts, you make fewer keystrokes . . . and fewer
keystrokes mean fewer wrong keystrokes. In this technique, we show you
how to use shortcuts at the command line to save time and keystrokes
and to avoid typing errors.

Completing Names Automatically

bash knows how to complete filenames, command names, user names,
and host names on your behalf. Try the following steps:

1. Open a terminal window. You can find one in the GNOME or KDE
Menu under System Tools (or System, if your version of GNOME or
KDE doesn’t have a System Tools menu choice).

2. Type the first few letters of the command, variable, or whatever
you’re looking for and press the Tab key twice.

For example, if you type host, a list of commands that start with the
letters host appears. See Table 5-1 for more details on autocompleting
variables, user names, and so on.

3. If you need to narrow down your options further, type the next few
letters of the command and press the Tab key again.

To tell bash how to complete the hostname command, you’d type n. If
you have more than one command that begins with the letters hostn,
bash shows you a list of those commands. Just type enough letters to



TaBLE 5-1: GETTING THE ITEM Y0ou WANT WITH AUTOCOMPLETE

Using the Escape Key to Your Advantage 3 ’

If the Partial Text Begins With ... bash Looks For-... Example
$ A matching environment If you type cd $HO and then press Tab, bash
variable translates that to cd $HOME.
~ (tilde) A matching user name Typing cd ~fre and pressing Tab translates to
cd ~freddie/.
@ A matching host name mail freddie@bas followed by a tab translates to

No special symbol
and, finally, a filename

A command name completion

freddie@bastille.

Typemore /etc/pass and then press Tab, and bash
completes your command as more /etc/passwd.

make the choice unambiguous, and bash will
complete the command name.

4. After bash completes the command name,
press Enter, and the command is executed.

If, at any time, you press the Tab key and nothing hap-
pens (or you just hear a beep), bash either found no
completions or a bunch of completions. (In this con-
text, bunch is a technical term that means some num-
ber greater than one.) If you press Tab a second time,
you see a list of all possible completions (if any exist).

Using the Escape Key to
Vour Advantage

The Tab key completes environment variables, user
names, host names, command names, and filenames.
You can fine-tune bash completions with the Esc key.
Use the Esc key in combination with other keys to
limit the type of completion that bash attempts, or
to view or insert several completions at once. Table
5-2 has all the details.

we’ve never bothered to memorize them all.
Your number-one timesaving friend is the Tab
key. We use it all day long.

] The Esc-key options are very powerful, but
B> (ﬂ

é

bash can complete any filename pattern, not just a
prefix. If you have a few tarballs (that is, files whose

names end in .tgz) in your current directory, add all
of them to the command line like this:

[freddie@bastille] 1s -1 *.tgz <Esc-*>

When you press Esc-*, bash replaces the *.tgz part
with the names of all files matching that pattern.

Environment variables that affect
filename completion

Set the following environment variables to screen out files
you don’t want to include in the completion list:

v FIGNORE: This is a colon-separated list of file suffixes
to ignore during filename completion. For example,
compilers often produce filenames that end in . o. If
you want the filename completion mechanism to
ignore those files, set FIGNORE to . o, like this:

$ export FIGNORE=.o

v HOSTFILE: Use this environment variable to tell the
completion mechanism which hosts to consider when
completing a host name. If you don’t set HOSTFILE,
bash searches the /etc/hosts file. You can use
HOSTFILE to limit host name completion to only
those hosts that you use frequently. If you've created
a file named ~/myhosts that contains the names of
the hosts that you frequent, set HOSTFILE like this:

$ export HOSTFILE=~/myhosts
If you want your environment variables in place every time

you log in, see Technique 8, in which we show you how to
modify your login and logout scripts.
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TaBLE 5-2: UsiNG ESCAPE FOR COMPLETIONS

What to Press What It Does

Timesaving Bonus Info

Esc-? Displays all possible completions — command
names, filenames, and user names — and presents
them in table form for you to read through and

complete the command.

Esc-? works very much like the Tab key except that it
doesn’t actually complete a word; it just shows you
the possible completions. If you want to see a (very
long) list of all the commands in your search path,
press Esc-? in a blank command line.

Esc-* Inserts all possible completions into your command. This is helpful if you have few possible completions.
Esc-/ Completes the filename to the left of the cursor. Esc-/ attempts filename completion only. That’s
handy when you know you want a filename — you
won'’t get a host name or user name by accident.
Esc-~ Completes the user name to the left of the cursor. Complete user names only — don’t try the other com-
pletion types.
Esc-$ Completes the variable name to the left of the cursor. Complete variable names only — don’t try the other
completion types.
Esc-@ Completes the host name to the left of Complete host names only — don’t try the other
the cursor. completion types. This option is useful when you
need to type a host name, but you don’t have a @
in the command, for example, ssh bastille.
Esc-! Completes the command name to the left of Complete command names only — don’t try the
the cursor. other completion types.

Customizing Completion for
Maximum Speed

Suppose that you take care of a network of comput-
ers and you find yourself logging into remote hosts
by using ssh. To ssh to host bastille, you might
type in ssh b and then press Tab thinking that bash
will fill in the rest of the host name (bastille) for
you. bash doesn’t know that ssh is always followed
by a host name, so instead of doing what you want,
bash goes through its normal search routine trying
to find a matching filename. To tell bash to complete
hostnames for ssh, use the following command:

[freddie@bastille] complete -A hostname ssh

The -A hostname part tells bash that you want to
complete host names (from the /etc/hosts file or
from $HOSTFILE if defined). The ssh part tells bash
which command you want to customize. You can
customize several (probably related) commands at
the same time, for example:

[freddie@bastille] complete -A hostname ssh
sftp rsh ping

This command tells bash to complete host names
for ssh, sftp, rsh, and ping. Of course, you can tell
bash to use other completion types, too:

[freddie@bastille] complete -A username
usermod passwd



This command tells bash to complete user names
after the usermod and passwd commands. The most
useful completion actions are listed in Table 5-3.

TaBLE 5-3: UseruL COMPLETION ACTIONS

Use This Action To Do This

-A command Complete command names (useful for the
which command).

-A directory Complete directory names (perfect for
cd).

-A file Complete filenames.
-A hostname Complete host names.

-A user Complete user names.

bash supports many completion actions in
addition to the ones listed in Table 5-3. See
man bash for more options.
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You can also customize completion for a command by
creating filters. If you use OpenOffice.org frequently,
you may want to customize completion for OOWriter
and OOCalc:

[freddie@bastille] complete -G "*.sxw"
oowriter

[freddie@bastille] complete -G "*.sxc"
oocalc

Now when you type oowriter and press Tab, bash
only completes filenames that end in . sxw (the
OOWriter file format). The second command tells
bash to complete OOCalc spreadsheets when you
run oocalc.

Don't forget to save your customizations to
one of the bash startup files. See Technique 8
if you're not sure which file to use.



Using cd Shortcuts
for Rapid Transit

Technique

Save Time By

v~ Using bash (rather than a
graphical interface) for
file management

v~ Getting around your disk
quickly

v~ Defining search paths to
take you places fast

+* Remembering where
you've been with pushd
and popd

dow. With all the graphical programs available, you can do virtually

anything without ever having to go near the command line. The
downside of heavy dependence on a graphical interface is that you lose
speed — few graphical programs provide good looks and high power in
the same package.

‘. 7 ou can use Linux for ages without venturing near the terminal win-

Getting around quickly is a matter of knowing the fastest route, whether
you’re using the command line or a browser. bash (the program in charge
of the command line) knows this, and helps out with a bunch of handy
ways to jump to the locations you need when you use the command line.

Backtracking at the command line can be a timesaver, too. In this technique,
we show you how to use pushd and popd to make a retraceable path.
You’ll be moving back and forth through your directories in no time.

We also introduce you to a handy environment variable — CDPATH — that
you can use to make directory changes quickly without searching for the
correct pathnames. The CDPATH variable makes the command line friend-
lier and faster.

Can’t find your way out of a paper bag? After reading this technique,
you’ll know not only where you are, but also where you’'ve been and the
quickest way to get where you're going!

Using cd and Is to Navigate through bash

The cd command is the mode of travel through the terminal window.
With cd, you can go anywhere fast:
v To return to your home directory, type cd and press Enter.

v To go to a specific directory, type cd, a space, and the directory name;
then press Enter.



Setting Your CDPATH Variables to Find Directories Fast

v To go to a specific directory (with less typing),
type cd, a space, and the first few characters of
the directory name, and then press Tab to auto-
matically complete the rest of the directory name.
(See Technique 5 for more details.)

v To go to a subdirectory, type cd, a space, and the
subdirectory name; then press Enter.

v To go to the parent directory of the directory
you're in, type cd .. and press Enter.

v To return to the directory you were just in, type
cd - and press Enter.

- directory changes from your history file. Just
press the up- and down-arrow keys to scroll
through the list of commands until you find

the one you need.

2 Use the up-arrow key (T) to recall complex
)

&

To find out where you are, use the pwd command.
Enter pwd at the command line and press Enter, and
bash displays your current directory.

To find the contents of your directory at the com-
mand line, use the 1s command. These are the basic
options:

V¥ 1s -1 gives you expanded information about the
items in your directory.

v 1s -ashows all files — even the hidden ones.

v 1s -t sorts by date changed. (This is handy if
you forget what you’ve worked on but know
when you worked on it. For example, you're try-
ing to remember what you did on Monday.)

v 1s -Rshows the entire tree listings for directo-
ries within your current directory.

You can also combine the 1s flags. For example,
1s -1a gives you an expanded listing of all the files
in your directory.

With those two basic commands (cd and 15s), you
can navigate through your file system. Now read on
to find out how to pick up some speed.
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Setting Your COPATH Variables
to Find Directories Fast

The CDPATH variable contains a list of directory
names that bash searches through when you cd to a
directory without providing a complete path.

) The directories in your CDPATH should be the

directories that contain your most commonly
& visited subdirectories. The big timesaver comes
after you've set your CDPATH: Instead of typing

a complex directory name with layers of sub-

directories, you simply cd to the endpoint.

CDPATH should contain a series of directory names,
each separated by a colon. Save your CDPATH variable
to your startup file — ~/ .bashrc — so you don’t have
to type it every time you log in. The following steps
explain how to set up CDPATH in GNOME and KDE.

Files whose names start with a . don't show
up on normal directory listings. They're there;
you just can’'t see them when you do an 1s.

To set your CDPATH variable, follow these steps:

1. Atthe command line:

If you’re using GNOME, enter gedit ~/.bashrc
and press Enter.

If you're using KDE, enter kate ~/.bashrc and
press Enter.

gedit or kate opens, displaying the contents of
your .bashrc file. If you don’t have a .bashrc
file, the editor creates one for you.

2. Type the following command:

export CDPATH=/home/freddie/work:/etc/
sysconfig

Substitute your most commonly used pathnames
into the preceding string. You can have as many
directories as you need — just remember to sepa-
rate each of them with a colon (:).
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3. Click Save and then close the editor.

The next time you log in, bash will search
through all the directories included in CDPATH
whenever you use the cd command.

You've just set the search path for your user
account. If you want to define cd paths for other
users, see Technique 8.

If your .bashrc file already has stuff in it, make
room at the top of the file and add CDPATH.
This way, if .bashrc includes other programs,
it's sure to execute the CDPATH command
before moving on to the other programs.

When you're finished, your .bashrc file will look
something like this:

# .bashrc

export
CDPATH=/home/freddir/work:/etc/sysconfig

# Source global definitions

if [ -f /etc/bashrc 1; then
. /etc/bashrc

fi

Be careful with CDPATH if you run a lot of shell
6 scripts (such as configure). Most shell scripts
assume that CDPATH is not defined and get

terribly confused if it is.

It’s important to remember that CDPATH is a search
path. That means that cd starts searching in the first
directory you list in CDPATH, and it stops searching as
soon as it finds the first candidate. If two (or more)
of the directories in CDPATH have identically named
subdirectories, cd will ignore all but the first (unless
you cd to a fully-qualified directory name).

Remembering Where Vou've
Been with pushd and popd

The pushd and popd commands work together to
leave a virtual trail of breadcrumbs so that you can

Technique 6: Using cd Shortcuts for Rapid Transit

find your way back $HOME again (sorry, we usually try
to avoid nerdy puns). You can backtrack quickly
without having to remember where you’ve been.

pushd works exactly like cd except that it records
your current directory on a stack of directory
names. popd removes the most recent entry in the
list and cds to that directory for you. pushd puts a
directory on top of the stack, and popd takes a direc-
tory back off again — in either case, you're always
working at the top of the stack.

Here’s how to use the two commands to retrace your
steps:

1. Use pushd to move to a directory (just as you
would a cd command):

$ pushd /usr/local/src

2. Then pushd to another directory:
$ pushd /tmp

After each pushd, your current location is added
to the front of a directory list displayed above
your prompt. We discuss how this list is useful in
the next section.

3. Enter popd and press Enter.

You return to /usr/local/src.

pushd remembers multiple moves, so you can
popd back as far as you need to.

Manipulating Your
Stack with dirs

Each time you pushd or popd, as explained in the pre-
ceding section, bash automatically executes the dirs
command to display the directory stack above your

prompt. Consider it bonus information from bash —
you may not ask for it, but it’s there, and useful.

You can use the dirs command by itself to make
quick changes to the stack. The basic dirs command



tells you what is on your stack. Use the dirs options
to manipulate the directory stack to your liking:

v dirs -c clears the stack. This is handy if your
stack is getting too long, or if you want to erase
evidence of where you've been.

Manipulating Your Stack with dirs 3 7

dirs -1 takes the abbreviations out of your
stack. By default, bash abbreviates your home
directory to ~.

dirs -p shows you the directories you've visited
in a line-by-line format. This is a quick way to
clearly see where you've been.



Technique

Typing Less and
Doing More with
Handy Automagic
Variables

] orking at the prompt can be a huge timesaver — no graphics
Save Time BV programs to load, no images to refresh, no mouse to chase.

v~ Using your process ID to
create unique filenames

+* Using command output to

What could be better? Well, less typing for starters. It would

also be nice if you didn’t have to remember things like process IDs or the
complete pathnames of seldom-used commands.

build complex commands Luckily for you (and us), bash can help. bash uses environment variables

v~ Scripting tasks to check
for privileges

to keep information handy. Some environment variables you define your-
self; others (we like to call them “automagic variables”) are defined by
bash. You can use environment variables at the command line or within

1~ Creating search paths for shell scripts. In this technique, we show you a few of the more useful
commands and using bash variables and how to save time by using variables instead of manu-
shortcuts ally typing everything in. Here’s a quick preview of automagic variables’
v~ Creating custom variables possibilities:

v The $$ variable holds the process ID of the bash shell. You can use $$

to create unique filenames that won’t clash with other users. If you
want to browse through a long directory listing, just redirect the out-
put from 1s into a temporary file named /tmp/$$ and then open that
file (/tmp/$$) with your favorite editor. When you're finished with it,
just delete the temporary file with the command rm /tmp/$$.

Shell scripting everyday tasks can save you a lot of time and key-
strokes. Tasks such as mounting and unmounting CD drives are well
suited to scripting, but your scripts should include some verification
of user privileges. Use $UID and $EUID to screen your script users to
decide if they should be allowed to run that script.

When you need to run a program or shell script, bash needs to know
not only the name of the program but also the location. With $PATH,
you can create search paths for bash so that you need to enter only
the name to run the program. In this technique, we tell you how.

Another automagic variable creates command-line arguments out of
program results. Save time and space by moving data without having
to create files. Just use $( ) for command substitution, as described
later in this technique.



Show Me the $$: Giving
Temporary Files Unique Names

The $$ variable contains the unique process ID of
the shell you're running. To see the value of $$, just
type in echo $$. You can use this ID to generate
unique names for temporary files.

@ If you have multiple users who create tempo-
B> (ﬂ

rary files, setting a naming standard will save
time (and confusion). Tell all your users to use
$$ to create the names for their temporary
files. Because each process ID is unique, each
filename will be unique. If you're careful to
remove temporary files when you're done
with them, you'll avoid lots of confusion in
the long run.

é

Garbage stacks up: Data directories can grow and
grow when you’re not looking (nature abhors a
vacuum, and so does your disk drive). If you're
browsing through a directory that won't fit on one
screen, you can pipe the output to more like this:

$ 1s-1 | more

A better way to browse through a huge directory
listing is to make a searchable catalog of the files in
that directory, which makes it a lot easier to find the
files you're looking for. To create and edit a file con-
taining the contents of a directory, follow these steps:

1. Navigate to the directory you want to list.
2. Enter1s -1 > /tmp/$$ and press Enter.

The file /tmp/$$ now contains a listing of the
files in your current directory. Of course, because
$$ contains your process ID, you've actually cre-
ated a file with a name like /tmp/5542 (or what-
ever your process ID happens to be).

The > directs the output of a command to the
file listed to the right of >. This technique works
with basically any commands that create output.

Streamlining Archive Searches 3 9

3. Enter gedit /tmp/$$ (if you're using GNOME) or
alternately kate /tmp/$$ (if you're using KDE).

Your new file opens, ready for you to use.

We should point out that using $$ in a filename sim-
ply generates a name that'’s likely to be unique — it
doesn’t actually create a temporary file. You still have
to delete the file when you’re finished with it.

Streamlining Archive Searches

When you need to find a missing file, searching
through tarballs and zip files (with obscure names)
that have accumulated in your download directory
can take eons. You can save time by exposing the
archives’ contents in the easiest and fastest possible
way. Here’s how you do it for different file types:

v Tarballs: To find out what’s in a tarball without
unpacking it, you can easily capture the archive
catalog in a temporary file (and then browse the
catalog with your favorite editor). To do so, use
the following command:

$ tar -ztvf tarballname.tgz > /tmp/$$

This command displays the filenames from a tar-
ball and captures the output to a temporary file
that you can browse at your leisure.

v RPM package: If you want to know which files
are included in an RPM package, you can gener-
ate a list of the filenames with this command:

$ rpm -gpl rpmfilename.rpm > /tmp/$$

v Zip file: Zip files also tend to pile up. To peek
inside a Zip archive, enter the following
command:

$ unzip -1 zipfilename > /tmp/$$

After you have the archive contents in full view, just
check your temporary file for the contents you need.
Cruising through your archives to find missing files
is easy and fast.
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] If you have a lot of archives to go through (they
e { @ do accumulate), work with two windows —
) one terminal window and a browser window

open to your temporary directory. You can
open the file with a quick double-click and
drag it to the trash when you're done.

7 If you're a GNOME aficionado, you can use
- { <@ the File Roller tool to peek inside most archives
) instead of creating a temporary file to hold

the catalog. Just open Nautilus, jump to the
directory that holds the archive, and click the
filename.

Turning the Qutput of a
Command into a Variable

with $( )

bash has another trick up its sleeve that can save
you a lot of time — it’s called command substitution.
Command substitution turns the output from a com-
mand into a variable. Command substitution is a big
help with simple results, such as sending e-mail to
all the users in a particular group. Command substi-
tution is indispensable for complex jobs like chang-
ing the ownership of all the files extracted from an
archive.

Command substitution is so named because it sub-
stitutes the output from a command into the com-
mand line. To use command substitution, just
surround a command with parentheses and put a
dollar sign in front of it, like this:

$ file $(which bzgrep)
/usr/bin/bzgrep: a /bin/sh script

When bash sees the contruct $ (command), it executes
the command and builds a new command line based
on the output generate by command. The command
file $(which bzgrep) is equivalent to:

$ which bzgrep
scribble down the result (/usr/bin/bzgrep)
$ file whatever you scribbled down

Here’s another example that shows command substi-
tution in action:

1. Set up the variable and the command:
$ NOW=$(date)

The value of $NOW is set to the output of the date
command.

2. To display the value of $NOW, use the echo
command:

$ echo $NOW
Fri Dec 26 13:02:01 EST 2003

Of course, you can shorten that whole sequence to
echo $(date).

g Make command substitution a habit — it cer-
e («a tainly is for us. Command substitution not only
& saves typing but also reduces the chance of

error.

Here’s a good example of how command substitution
can reduce typing errors. When you unpack a tarball,
files are often scattered all over your system. If you
need to change ownership of all those files, your
options are to track down and chown those files one at
a time, or to build a command with the output gener-
ated by another command. Personally, we're more
likely to leave a file out of the list than bash is. The
following command converts the output of the tar
command into a list of filenames for chown to act on:

$ chown freddie $(tar -ztvf
tarballname.tgz)

You've used tar to create list of the files that you're
interested in and then feed that list to chown as a set
of command-line arguments.

tar isn’t the only command that can generate a list
of names. In this next example, we use grep to gen-
erate a list of user names.

The /etc/group file contains one row for each group
you've defined on your system. Each row contains a
group name, a password, a group number, and then
a comma-separated list of the users within that group.
A typical group file will look something like this:



support:x:500:george, fred,barney
operators:x:501:elroy
acctg:X:502:wilma,betty,judy, jane

You can use grep to pull a specific row out of the
group file, like this:

$ grep support /etc/group
support:x:500:george, fred,barney

To extract the user names from a row, use the cut
command to pick out a specific “column.” Because
/etc/group uses a colon to separate columns, you can
extract the user names with the following command:

$ grep support /etc/group | cut -d ':' -f 4
george, fred,barney

The -d ':' part tells cut to use the colon character
as a field separator, and the -f 4 part picks out the
fourth field.

Now you can use command substitution to feed that
list of user names to the mai1 program (maybe send-
ing a message to everyone in the Accounting, or
acctg, department):

$ mail $(grep acctg /etc/group | cut -d

i - 4)

Subject: Downtime

The accounting system will be down this
weekend
-- Freddie

CcC:

names when you need to issue a command

2 Use variables to hold groups of files or user
<8}
that affects the whole group.

If you want to see a preview of your command
after substitution but before execution, press
Esc-Ctrl-E. If the preview looks good, press
Enter to execute the command.

Using SUID and $EUID in Shell Scripts 4 1

Using SUID and SEUID
in Shell Scripts

When you create a user account, Linux assigns a
numeric user ID to that user. bash stores the user ID
in the $UID variable; your effective user ID is kept in
the $EUID variable. (Your real user ID is always the
same, but your effective user ID changes if you
impersonate another user with the su command.)
For example, user freddie might be logged on with a
$UID of 500, but if freddie uses su to gain superuser
privileges, his $£UID changes from 500 to 0.

A superuser’s $EUID is always 0. This is a quick
and easy way to verify user privileges when
you're writing shell scripts.

You can use $EUID inside a shell script to determine
whether the user running the script holds extra priv-
ileges. For example, it’s easy to write a shell script
that mounts the CD drive for users who have enough
privileges.

If you’re using Fedora or Mandrake, follow these
steps:

1. Open your terminal window and enter the fol-
lowing command:

$ gedit /usr/local/bin/mount-cd

This command opens the gedit editor and cre-
ates a file called mount-cd in the /usr/local/bin
directory.

2. Type in the following text:
{1 /bin/bash

if [[ $EUID -eq O 1]

then
mount /dev/cdrom /mnt/cdrom
else

echo "Sorry, you must be a
superuser"

echo "to mount a CD"
fi
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3. Save the file and close gedit.
4., Atthe command line in the terminal window,
type this command:

chmod a+x /usr/Tocal/bin/mount-cd

This command makes the file executable for
everyone on your system.

If your system is running SuSE Linux, follow these
steps to create a shell script that mounts the CD
drive for users with an effective user ID of 0:

1. Open your terminal window and enter the fol-
lowing command:

$ gedit /usr/local/bin/mount-cd
This command opens the gedit editor and cre-

ates a file called mount-cd in the /usr/local/bin
directory.

2. Type in the following text:
#!/bin/bash

if [[ $EUID -eq 0 1]

then
mount /dev/cdrom /media/cdrom
else

echo "Sorry, you must be a
superuser"

echo "to mount a CD"
fi

3. Save the file and close gedit.

A

At the command line in the terminal window,
type this command:

chmod a+x /usr/local/bin/mount-cd

This command makes the file executable for
everyone on your system.

Now if users want to mount a CD by using the
program you just created, all they need to do is
enter mount-cd at the command line. Any user
can run this script, but only those users whose
$EUIDs are 0 (the superusers) can actually mount
a CD.
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Getting Quick Access to
Programs with $PATH

Shell scripts can be big timesavers, but only if you
don’t have to search for them. Populating your $PATH
environment variable with the directories that con-
tain your most commonly used scripts (and other
programs) will save you tons of time (and aggrava-
tion) because you can start programs with just a
program name rather than a complete pathname.

The $PATH variable is a colon-separated list of direc-
tory names that bash searches through to find your
program names. Each user has his or her own $PATH
variable.

It’s a good idea to keep dangerous commands in a
directory that’s not on the average user’s search
path (that is, the user’s $PATH variable). If you don't,
a naive user might accidentally run a damaging pro-
gram when he doesn’t mean to. Keeping dangerous
programs out of the normal search path won'’t stop a
malicious user, but it can save you from accidental
damage.

The superuser’s $PATH should never include a
period (.). The *.’ directory means “the current
directory.” As you cd from directory to direc-

tory, .” changes with you. If “." is in the supe-
ruser’s search path, a malicious user could
drop a Trojan horse into a directory that the
superuser is likely to visit. For example, if a
malcontent knows that the superuser spends
time in the /tmp directory, he could create a
Trojan horse with an innocuous-looking name
like /tmp/1s.

If the superuser cd’s to /tmp and runs the 1s
command, he may be in danger. If *.” appears
early in the search path (earlier than /bin/15s),
the superuser will run the Trojan horse instead
of the real 1s — and he'll be giving the Trojan
superuser privileges too! Some high-security
sites are even more paranoid — they make sure
that the superuser has an empty $PATH, forcing
him to type the complete pathname to every
command.



To set the $PATH environment variable for a user,
follow these steps:

1. Atthe command line, enter gedit
~user/.bashrc and press Enter.

2. When the editor opens, add the following line
to the end of the file:

PATH=$PATH:/foo/bar/baz

Substitute your directory name for
/foo/bar/baz.

The command you just entered appends the
directory to the user’s current search path.

3. Click the Save icon and close the editor.

Now, when this user enters a program name, bash
searches through all the directories listed in $PATH.

You can add as many directories to the user’s
@ path as you'd like, but remember that as you
hand out easy access to commands, you could

invite accidents.

Customizing Variables for
Rapid Transit

All the environment variables you’'ve seen so far

are automagic variables — bash defines them for
you, and they can change value over time. You can
also create custom variables to make your life easier.
For example, we spend a lot of time in the directory
/usr/local/src (that’s where open-source source
code typically lives). In our system-wide login script
(/etc/bashrc), we define an environment variable
named $SRC that equates to /usr/local/src. That
makes it easy to navigate to our workplace — just cd
$SRC and we're there.

Of course, you can use environment variables to

do things other than just cd: You can copy files

(cp $SRC/foo.c $DST/), create archives (tar -zcvf
$SRC/mycode.tgz $SRC/kde/), or just about anything

Customizing Variables for Rapid Transit 43

else. Unfortunately, most graphical programs don’t
know how to deal with environment variables, but
they can sure save you time at the command line.

Just think of the pathnames you use over and over
every day, and you’ll see why custom environment
variables can be a great timesaver.

The following shell script defines a few custom vari-
ables you can use to get somewhere quickly:

# File name: setvars.bash

i Define a few shortcuts

#

export SRC=/usr/local/src # cd
$SRC will take me to /usr/local/src

export DESK=~/Desktop # cd

$DESK will take me to my desktop
export ACCTG=/opt/data/accounting 4 cd
$ACCTG will take me to my bookkeeping
data
echo "Your custom variables are ready for
use"

To use the code:

1. Open your favorite editor and create the file
~/setvars.bash.

$ gedit ~/setvars.bash

2. Type in the variables that you want to define
(be sure to put the word export in front of each
one).
export SRC=/usr/local/src
export DESK=~/Desktop
export ACCTG=/opt/data/accounting

Note: Be sure that you don’t have any spaces
before or after the =; otherwise, bash will com-
plain when you try to run your script.

3. Save your work and close the editor.

At the command line, adjust the permissions for the
file you've just created, making it executable:

$ chmod a+x setvars.bash
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Now, to execute your program and have your custom
variables ready for use, just put a period (.) and a
space at the beginning of the command line, like this:

$ . setvars.bash

Your custom variables are ready for use
$ echo $SRC

/usr/local/src

$

When you run a shell script that defines environ-
ment variables (like this one does), you have to put
a . at the beginning of the command line. The . char-
acter is also known as the source command. In fact,
you can type source setvars.bash instead of using .,
but that’s more typing. If you don’t source (or *.")

the script, bash will start a new shell session, run
your script, and immediately terminate the new shell
session.

Why is immediate termination a problem? Because
the environment variables are defined in the sub-
shell (that new shell session) instead of your shell
session. When the sub-shell ends, your fancy new
variables disappear! The source command tells bash
to execute a script within the current shell instead of
firing up a new shell.

After you create the pathname shortcut, you
can move to your source code directory by
typing cd $SRC and pressing Enter. You're at

your location in a snap!



Logging In,
Logging Out

Techniqie

Save Time By
* Customizing your shell
scripts

v Changing defaults in shell
scripts for groups of
users

v Customizing your logout
script

v~ Customizing your startup
desktop

and shell scripts that prepare your desktop and command line envi-

ronment. You can customize your command line login scripts to
your liking — for example, set color preferences and language prefer-
ences and set up the information that will be included in your prompt.

Every time you log in, Linux launches a chain of startup programs

You can also arrange for KDE to automatically start programs for you when
you log in. Not having to find all the programs you need to start your day
is a great timesaver. Calendars, terminal windows, word processors, and

even Tux Racer can be there waiting for you after your first cup of coffee.

Linux defines four sets of login/logout scripts. In this technique, we show
you how to decide which scripts you need to change to customize your
work environment when you log in or log out:

v System-wide gdm login/logout scripts
v System-wide shell login scripts
v Per-user shell login/logout scripts

v Skeleton (or prototype) shell login/logout scripts

This technique is all about saving time by having your work environment
ready for you when you need it. Finding the right script to modify at login
or logout is the key to success.

Finding the Right Shell Script

When you want to customize some aspect of your desktop (or command
line) environment, finding just the right script can be tricky. Some scripts
are shared by all users; others are personal scripts that execute for only a
given user. If you're using a desktop environment like KDE or GNOME, your
choices are even more complex. The following sections explain how to
find the right script, when to run your code, and finally how to automati-
cally arrange your desktop just the way you like it, each time you log in.
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Choosing your victims

Start out by deciding how intrusive you want your
change to be. That is, do you want to change every-
one’s settings or just your own?

What files you change depends on which of the fol-
lowing settings you're changing:

v Personal settings: If you change your personal
login/logout scripts, you won'’t interfere with
other users. For example, if you want to change
your own bash prompt (see Technique 4), modify
~/.bashrc. Personal settings are stored in your
home directory.

v New user prototypes: Change the prototype
scripts to provide a starting point for new users
(users whose accounts are created affer you
change the prototypes). For example, modify
/etc/skel/.bashrc (the prototype .bashrc
script) to suggest a default prompt for new
users. When you create a new user account, the
scripts found in /etc/skel are copied to the new
user’s home directory. Prototype scripts are
stored in /etc/skel.

v System-wide settings: If you change system-wide
scripts, you affect every user on your system. If
you want to customize the bash prompt for all
users, modify /etc/bashrc (the system-wide
bashrc script). System-wide settings are stored
in /etc or in a subdirectory of /etc.

If you want to modify shared, system-wide
scripts, you must hold superuser privileges.
However, you don't need extra privileges to

modify your own scripts.

Timing is everything

Next, determine when your code needs to run. Here
the choices start to get complex. You can modify
scripts that execute when you log in, scripts that
execute when you start each new shell, and scripts
that execute when you log out.

Here’s the sequence of scripts that Linux runs when
you log in to a new GNOME or KDE session managed
by gdm (the GNOME display manger):

1. /etc/X11/gdm/Postlogin/Default (system
wide)

2. /etc/X11/gdm/PreSession/Default (system
wide)

3. /etx/X11/xdm/Xsession (system wide)
The first three scripts run with superuser privi-
6 leges even if you log in as a non-privileged
user. Be careful what you do, or you may
introduce vulnerabilities.

4., /etc/profile (system wide)

5. /etc/profile.d/*.sh (system wide)
6. ~/.bash_profile (personal)

7. ~/.bashrc (personal)

8. ~/etc/bashrc (system wide)

On SuSE systems, the first two scripts are found in
/etc/opt/gnome/gdm instead of /etc/X11/gdm.

If you're running SuSE Linux or Mandrake Linux,
you're probably using the KDE display manager
(kdm) instead of GNOME'’s display manager (gdm), and
the login/logout scripts will be different. We recom-
mend using gdm even if you're a KDE user (gdm can
create KDE desktops just like kdm can create GNOME
desktops). See the sections on switching display
managers in SuSE Linux and switching display man-
agers in Mandrake Linux in Technique 35 for more
information.

You'll rarely want to modify any of the first three
scripts (in fact, we have never modified them), but
it’s common to modify /etc/profile. If you're
uncomfortable modifying /etc/profile, just add a
new script to /etc/profile.d/, and bash (actually
/etc/profile) will happily invoke it for you.



@ Saving your customizations in a separate script
(«a (/etc/profile.d/myscript.sh) allows you
to more easily debug and maintain the script
in the future — your script won't be tangled
up in all the “stuff” already in /etc/profile.
Make sure that the name of any script that
you save in /etc/profile.d/ endsin .sh.

&

Every time you start a new bash shell (by opening a
new terminal window or running a shell script), bash
executes these scripts:

1. ~/.bashrc (personal)
2. /etc/bashrc (system wide)

Notice that ~/.bashrc runs every time you start a
new shell. Don’t put any time-consuming tasks in
~/.bashrc, or you'll spend a lot of time waiting for
each shell session to complete its startup code.
~/.bashrc is a great place to define environment
variables (see Technique 7), aliases, and shell func-
tions (see Technique 10).

When you log in to your computer without creating a
new GNOME or KDE session (by sshing from another
computer for example), bash executes these scripts:

1. /etc/profile (system wide)

2. /etc/profile.d/*.sh (system wide)
3. ~/.bash_profile (personal)

4., ~/.bashrc (personal)

5. /etc/bashrc (system wide)

In case you didn’t catch it, there’s a pattern here. Each
time you log in to your computer (whether you start a
new GNOME or KDE session or ssh from another com-
puter), bash runs the profile scripts (/etc/profile,
/etc/profile.sh/*.sh,and ~/.bash_profile). Every
time you start a new shell, bash runs the rc scripts
(~/.bashrc and /etc/.bashrc). To save yourself some
time, be sure to put long-running tasks (such as file
indexing or mail checking) in a profile script and not
in an rc script.

b7

Finding the Right Shell Script

When you log out of a command line ssh session,
bash executes just one file:

~/.bash_logout (personal)

The ~/.bash_logout script is a good place to invoke
cleanup-related tasks. For example, if you have a
habit of creating temporary files, delete them in
~/.bash_logout. You may also want to encrypt sensi-
tive files when you log out (and decrypt them when
you log in) — see Technique 28 for more information
about encrypting and decrypting files.

When you log out of a KDE or GNOME session, gdm
(the GNOME display manager) executes just one file:

/etc/X11/gdm/PostSession/Default

On SuSE systems, the PostSession/Default script is
stored in /etc/opt/gnome/gdm instead of /etc/X11/gdm.

Cleaning up made easy

Notice that the normal ~/.bash_Togout script is
never executed if you use KDE or GNOME — all the
cleanup code that’s stored in ~/.bash_logout is
ignored. That’s a bit inconvenient because you have
to maintain two different logout scripts: one that
executes when you log out from a command line ses-
sion and one that executes when you log out from a
graphical session.

You could try to fix this dual-script problem by creat-
ing a new script (with a name of your choosing) and
invoking that script from ~/.bash_logout and /etc/
X11/gdm/PostSession/Default. That solution would
work, but now you’re maintaining three scripts
instead of one!

Here’s a better solution to the dual-logout-script
problem: Simply modify /etc/X11/gdm/PostSession/
Default so that it invokes ~/.bash_logout for you.
That way, you (and every other user on your sys-
tem) can keep cleanup code in ~/.bash_logout that
runs whether you exit a command line session or a
graphical session.
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Follow these steps to run ~/.bash_logout every time
you log out of your computer:

1. Open a terminal window, give yourself super-
user privileges, and move into the PostSession
directory:
$ su
Password:

# cd /etc/X11/gdm/PostSession

If you're running SuSE Linux, cd to /etc/opt/
gnome/gdm instead.

2. Rename the original PostSession/Default script:
# mv Default Default.dist

3. Use a text editor to create a new file that
includes the following code:

#!1/bin/bash
if [ -x $HOME/.bash_logout 1]
then
su -c "$HOME/.bash_logout" $USER
fi

SCRIPTDIR=$(dirname $0)

exec $SCRIPTDIR/Default.dist

4., Save your work to /etc/X11/gdm/
PostSession/Default and close the
editor.

If you're a SuSE user, save your work to /etc/opt/
gnome/gdm/PostSession/Default instead.

After making this change, your ~/.bash_logout
script will run whether you’re using a KDE session, a
GNOME session, or a command line ssh session.

Changing prototype scripts

Have you ever wondered how ~/.bash_profile,
~/.bashrc, and ~/.bash_logout got into your home
directory to begin with? When you create a new user
account, you don’t have to write the login and logout
scripts yourself, but they must come from somewhere,
right? Right! Each time you create a new user account,

Linux copies the prototype scripts from a directory
named /etc/skel (that’s skel as in skeleton).

If you try to look at the /etc/skel directory with a
normal 1s command, it looks empty, but it’s not. All
the files in /etc/skel have names that start with a
period ( . ), meaning that they are hidden from the
1s command. If you really want to see what’s in
/etc/skel, use 1s -ainstead (that -a option tells 1s
to display hidden files as well as normal files). You’ll
see (at least) three files:

v [etc/skel/.bash_profile: Copied to
~/.bash_profile

v [etc/skel/.bashrc: Copied to ~/.bashrc

v [etc/skel/.bash_logout: Copied to
~/.bash_Tlogout

/etc/skel/.bash_profile may be missing if you're
running SuSE Linux. If you want to change a login

(or logout) script inherited by new users, change
the script in /etc/skel. That way, when you create

a new user account, Linux copies the modified script
into the spankin’ new home directory.

Now you know how the Linux login and logout
scripts work. Whenever you feel a need to modify a
login (or logout) script, be sure to ask yourself whom
you want to affect and when your code needs to run.

Customizing Your Autostart File

If you're like us, each time you log in to your graphical
desktop (KDE or GNOME), you launch a few handy
programs: xmms to play some music, Evolution to
read e-mail, and Mozilla to surf the Web. Wouldn't it
be nice if Linux started those programs automati-
cally, every time you logged in to your desktop?

Meet Autostart. Autostart is the KDE way to have
your desktop ready for you every time you log in —
no extra keystrokes or mouse clicks are required.
KDE autostarts the programs you need and has them
waiting for you on your desktop.



Autostart and the login scripts described earlier are
somewhat related: They both prepare your environ-
ment for you. Login scripts set up your command
line environment. Autostart sets up your graphical
environment the way you like it.

Autostart is easy to set up and change. Just open a
few browser windows and surf and drag, and with a
few clicks, Autostart is up and running. To remove
something from the Autostart menu, just drag the
icon to the Trash.

To arrange your desktop with Autostart, follow these
steps:

1. Double-click the Start Here icon on the desktop
to open Konqueror.

2. Surf to the Autostart directory:
/home/username/.kde/Autostart

If you can’t see your . kde directory, you can
find it by choosing Viewr>Show Hidden Files.

3. Double-click the Start Here icon again to open
another Konqueror window.

Now the fun starts!

Customizing Your Autostart File 4 9

4. In the second Konqueror window, start surfing
for the programs you want to see on your
desktop.

Start in the Applications directory, where you’ll
find your tools (and games) in the appropriate
folders.

When you find a program that you want on

. gr
your desktop at login, grab the icon and drag
it to the Autostart folder.

When you drop it, a little dialog opens.
6. In the dialog, choose Link Here.
The icon now appears in the Autostart folder.

7. Repeat Steps 5 and 6 to add additional icons if
you want.

That’s all there is to it. When you reboot, your
tools are there waiting for you!

B Autostart folder again and drag the icons you
don’t want to the Trash. You're just throwing
away links, so the originals are still there if you

need them.

Z To remove startup programs, open the
-

&



Making History
(Work for You)

Technique

Save Time By

v~ Using history to recall
previous commands

v~ Including the history
command number in your
bash prompt

v~ Filtering your history file
to prevent accidents

+* Reusing complex com-
mand lines

directories, and files that you work with. The bash shell keeps track

of every command that you type in the history list — including those
commands that you use most frequently. You can take a peek at your his-
tory list in a file named ~/.bash_history, where, by default, bash stores
the most recent 1,000 commands.

I ike any typical Linux user, you likely have a small core of commands,

) If you know how to move in and out of the history list with ease, his-
- { <@ tory can save you a lot of keystrokes. With Linux, you can use the
) history list to recall previous commands, modify them if you need to,
and execute them again without all that typing (and all those typing
mistakes).

In this technique, we show you how to use the history file to save time at
the command line. Less typing = fewer mistakes. Fewer mistakes = more
commands that work the first time. More commands that work the first
time = more time left for other things that you'd rather be doing.

Navigating the History List

To see the history list, type history and press Enter. With the history
list ready and waiting for you, you can move through it in all sorts of
ways. This section explains the different ways to get to the command
you need — quickly. Table 9-1 gives you an overview of your options
and when it’s best to use them.

Scrolling
You can scroll through the list by using the up- and down-arrow keys:
v Up arrow: Recalls commands starting with the most recent and moving

towards the oldest. For example, press the up arrow once to see the
previous command and press it again to see the command before that.
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Navigating the History List 5 ’

Navigation Method When It's Useful

Scrolling

Scroll through your history when you know that the command you're looking for is close by. If you have

to scroll through more than five or six commands to find the one you want, use a different method.

Recalling by
command

number at once.

Searching

If you include the history command number in your bash prompt (see Technique 4), you can recall
a specific command by number. That works great if you can see 20 or more commands on your screen

If the command you're looking for is not close by (you've executed a number of commands since the

one you want to recall), press Ctrl-R to search for commands that contain a specific pattern. We show

you how in “Searching through history.”

v Down arrow: Moves in the opposite direction — it
starts at the current command and moves towards
the most recent. (You can’t use the down-arrow
key until you’'ve used the up-arrow key. The down
arrow won’t anticipate your next move and make
up a command for you . . . we wish it did.)

After you find the command that you want, change it
if you need to and then press Enter.

Summoning a command by number

Each command is assigned a number when it’s placed
in the history list. (The first command is command 1,
and the numbers increase from there.) When you type
history and press Enter to see the history list, you
also see that a number precedes each command:

$ history
53 ssh Tlouvre
54 ssh versailles

55  pwd

56 1s -1

57 rm *.tmp

58 mail franklin
59 history

You can use the command number to recall a specific
command. Just type an exclamation point ( ! ) and
follow it with the number of the command that you
want to recall. For example, to recall the ssh command
in freddie’s history, you would enter the following:

$ 154
ssh versailles
[freddie@versailles]

e to your history list, we recommend including
the command number in your bash prompt;
just include \! in $PS1. See Technique 4 for

more information.

z If you want to use command numbers to refer
<€

&

Searching through history

You can also ask bash to search through the history
list on your behalf. Press Ctrl-R to start an incremen-
tal search. As you type each character, bash recalls
the most recent command that includes the charac-
ters you've entered. For example, given the command
history for freddie, an incremental search for ssh
would go like this:

1. Press Ctrl-R.
The prompt changes from [ freddie@bastille] to

(reverse-i-search)'"':

2. Type s (the first character in ssh).

bash finds the most recent command that
includes an s (which is history), and the prompt
changes to

(reverse-I-search)'s': history

3. Type s again (the second letter in ssh).

bash finds the most recent command that
includes ss (whichis ssh -A versailles), and
the prompt changes to

(reverse-I-search)'ss': ssh -A
versailles
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4, If you want the most recent ssh command (ssh
versailles), just press Enter. If you want an
earlier ssh command (ssh louvre), press Ctrl-R
to tell bash to keep looking.

It's easy to make mistakes while you're getting
- («@ familiar with the history command. You can
save a lot of time if you ask bash to show you
each command after expansion but before the
command is executed. The histverify shell
option does the trick; just add shopt -s
histverify to your ~/.bashrc file.

When you're comfortable with the history fea-
ture, you may want to turn off histverify.
You can still press Esc and then Ctrl-E to pre-
view your command line after expansion.

Customizing the History List

bash gives you a lot of control over the history list.
To customize the history list for how you work, you
can modify the defaults and filter out commands
that just get in your way.

Adjusting key default settings

Here are the defaults that you'll likely want to modify:

v To adjust the number of commands that bash
remembers, use $HISTSIZE.

v To set the number of commands that bash
remembers from session to session, use
$HISTFILESIZE.

v To change the location of the saved history
file from the default (~/.bashrc), modify the
$HISTFILE environment variable.

See the previous technique (Technique 8) to find out
how to make your preferences permanent so they
take effect every time you log in.

Filtering the history list

You can also filter out certain commands from the
history list. After you've used the history feature
awhile, you’ll probably notice that some commands
really don’t belong in the history list. Here are a few
examples:

v It’s redundant to maintain the history command
itself in the history list.

v It’s unnecessary to record exit commands. (The
exit command will log you out of the shell.)

v It’s alittle dangerous to keep rm commands
(or other data-destroying commands) in your
history list because you might recall them by
accident.

You filter out those nasty (or just plain annoying)
commands with the $HISTIGNORE variable. Set
$HISTIGNORE to a colon-separated list of patterns to
exclude from the history list. To filter out the com-
mands we just mentioned, use this:

$ export HISTIGNORE="history:exit:rm *"

You may also want to filter out repeated commands.
To do so, include the magic character & in
$HISTIGNORE:

$ export HISTIGNORE="&:history:exit:rm *"

Occasionally, you'll type in a command that you know
you don’t want stored in the history list (maybe
you're restoring files from an archive and you don’t
want to risk doing it again later by accident). To
exclude from the history list any command that
starts with a space or tab, add the pattern [ \t]1*

to $HISTIGNORE (be sure to include the space
between [ and \):

$ export HISTIGNORE=
"[ \tl*:&:history:exit:rm *"
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Now, whenever you type in a command that you want
to exclude from the history list, just put a space (or a
tab) at the beginning of the command line.

Executing Commands Quickly
with History Variables

$HOME is the name of your home directory, $PWD is the
name of your current working directory, and so on.
The history command adds a few more variables to
the mix. The history variables let you treat a previ-
ous command, or part of a previous command, as a
variable. Master the use of these automagic vari-
ables, and you’ll save time by not having to spot and
fix typing mistakes.

For a quick refresher course in automagic vari-
ables, check out Technique 7. It tells you about
the predefined variables that bash makes
available for your use.

Most variable names in bash start with a $
character, but the history variable names all
start with !.

The !! variable contains the text of the last com-

mand. If you type !'! at the command line, bash reex-
ecutes your last command:

$ ps

PID TTY TIME CMD
5562 pts/4 00:00:00 bash
12442 pts/4 00:00:00 ps
$ 1!

PID TTY TIME CMD
5562 pts/4 00:00:00 bash
12464 pts/4 00:00:00 ps

) Of course, if you all you want to do is reex-
- { 4@ ecute the previous command, you'd probably
& just press the up-arrow key and then Enter
rather than use ! !. The real timesaving advan-
tage of !! is that it contains the text of the

53

previous command, which you can use to
create new commands. If you have a complex
command that you use frequently, you can
save that command into a file with a meaningful
name and save yourself the effort of re-creating
the command the next time you need it.

Here’s an example of how you can use !! to create
new commands. You can use the tar command to
move a directory structure, but the syntax of the
command is a bit hairy:

$ tar -cf - * | (cd $DST ; tar -xf - )
After you've executed that command, use !! to
recall the command and save it to a file:

$ echo "!!" > $HOME/bin/movedir
$ chmod u+x $HOME/bin/movedir

The next time you want to move a directory, just
type movedir and press Enter.

Here are some other handy tricks you can do with
automagic variables:

v Dial up a command number quickly. In
Technique 4, we show you how to include the
history command number in your bash prompt.
Here’s the payoff. You can refer to a command by
its command number with !n. If you display the
history command number in your prompt, you
can easily recall complex commands by number.

[10281# w -hsf

franklin :0 2:23m Chromium
georgette pts/1 0:02m mailx
freddie pts/2 0:0s w -hsf
[1029]1# ki11all Chromium

(103014 !1028

franklin :0 0:01m bash
georgette pts/1 0:02m mailx
freddie pts/2 0:0s w -hsf

v See your command before you execute it. The
Esc, Ctrl-E trick works with history variables,
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too. To see your command after variable expan- TABLE 9-2: HiSTORY VARIABLES
sion but before execution, just press Esc followed " -
Variable Meaning
by Ctrl-E:
I i
[10311# !1029 (now press Esc Ctrl-E) o Previous command
[1031]# ki11all Chromium I'n Command number n
1 Peel off parts of commands with word designa- I-n Current command number minus n commands

(!-1is the previous command, ! -2 is the com-

. Y n also refer rts of a previ
tors. You can also reter to parts of a previous mand before that, and so on)

command by adding a word designator to the end
of the history variable. The most useful word Itext Most recent command that starts with text
designators are $ to refer to the last argument in

1?text Most recent command that includes text

a command, and * to refer to all arguments. For

example, to create a new directory and then

move there, use this: . .

Speaking the lingo

$ mkdir /usr/local/src/coolcode

$ cd I1$ Seasoned propeller-heads pronounce ! as “bang,” not

$ pwd “exclamation point.” So, !! is pronounced “bang bang.”

Jusr/local/src/coolcode The * character is pronounced “splat.” You can, of course,

combine these to come up with witty phrases like “bang

Table 9-2 shows the complete list of history variables. bang splat.” If you enter a room where people are using
Remember that you can include a word designator language like this, back away slowly. . . .

after the variable name to refer to part of a command.
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Simple with Aliases

Tethnigile  and Functions

Save Time By

v~ Using the predefined
aliases that come with
bash

v Making aliases for com-
mon commands

+* Correcting your spelling
with aliases

v~ Using functions to auto-
mate downloading and
installing

you spend less time typing. You can create aliases that give mean-

ingful names to obscure commands; provide extra safety when
you’re doing something dangerous; create an abbreviation for a long,
complex command; or just correct typing mistakes.

ﬁ n alias is a command line shortcut. Creating an alias means that

A function is a series of commands designed to perform a task. Functions
can work with aliases to make it easy to automate tedious and time-
consuming tasks. A function can be one or two lines long, or can grow
into extremely complex programs that involve user interaction and error
checking. In this technique, we include functions that make it easy to
monitor your system with a few quick keystrokes and automate the com-
plex task of exploring and unzipping archives.

In this technique, we’'ve included some of our favorite aliases and func-
tions. Without them, we’d be correcting our spelling all day long. Use
them or create your own from our examples to save keystrokes and time
at the command line.

Viewing Your Aliases

Viewing your aliases is simple. bash is often configured with a few prede-
fined aliases, so you can test this command even if you haven’t created
any user-defined aliases yet. To view the aliases in your shell, just type
alias and press Enter:

$ alias

alias 1.='"1ls -d .* --color=tty'
alias 11="1s -1 --color=tty"
alias 1s='ls --color=tty’

alias vi='vim'

You may see a few more (or less) depending on which Linux packages
you've installed. The first three aliases in the preceding list provide
shortcuts for common variations of the 1s command, which you can see
in Table 10-1.
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Type bash Expands To To Do This

1. 1s -d .* --color=tty Listdirectory names and
hidden files (files whose
names start with a .
[period]) and colorize

the on-screen output

11 1s -1 --color=tty Display a detailed direc-

tory listing (in color)

1s 1s --color=tty Display the content of a
directory in short format

(in color)

The fourth predefined alias is there for old UNIX
users who are accustomed to using the vi editor.
Linux doesn’t include vi anymore, but it does
include a much-improved replacement called vim.
That old habit of typing in vi now starts the new
program, vim.

These are just a few of the timesaving aliases that
you may find in your shell. Read on to find out how
to create a few aliases yourself.

Creating Simple Timesaving
Aliases

Creating a new alias is easy. Here’s an example that
creates an alias to fix our most common typing error:

$ alias pdw=pwd

Now, whenever we want to know our current work-
ing directory and we accidentally type in pdw, bash
helps out by translating the typo into the correct pwd
command.

bash expands an alias only if it’s the first word in the
command line. Some of our favorite aliases fix
spelling mistakes, create shortcuts, and help us out
when we’re forgetful.

Technique 10: Keeping Your Life Simple with Aliases and Functions

These are some common spelling corrections you
might want to include in your alias list:

alias pdw=pwd
alias mroe=more
alias fiel=file

You may want to add an alias that translates old
familiar commands into Linux form:

alias dir="1s -1"

Navigational aliases are handy, too:

alias up="cd ..

You can create aliases for commonly used (but cum-
bersome) commands, such as unpacking tarballs:

alias unpack="tar -zxvf "

To display a list of programs that have open network
connections (for example, Web browsers or stream-
ing audio), create this alias:

alias netcon="netstat -p | grep -v'“unix"'"

Create an alias that protects you against accidents.
For example, the rm command (remove file) usually
does its work without any more input from you.
But, if you include a -i on the command line, rm
asks you to confirm each file that it wants to delete.
That can be a lifesaver if you ever type rm * .tgz
instead of rm *.tgz. (The extra space after the * in
the first command tells rm to delete everything in
your directory — which is probably not what you
wanted.)

alias rm="rm -i"
alias cp="cp -i"
alias mv="mv -i"

7 Turning dangerous commands into safe com-
B> (481

mands can save you a lot of time. Most users
would agree that restoring from a backup is
not an enjoyable way to spend an afternoon.

&



To save your aliases, use your favorite editor to
add them to the ~/ .bashrc file. This way,
each time you log in, your aliases are there

when you need them. To add system-wide
aliases, check out Technique 8.

Using Aliases for Complex
Commands

You can also create aliases that execute complex
commands. For example, the following alias con-
verts all GIF files in the current directory into PNG
form:

alias cnv="'for fi in *.gif; do giftopnm
$fi | pnmtopng > ${fi%%.gif}.png; done’

Aliases make it easy to create customized com-
mands that are preconfigured with the arguments
and options that you most frequently use. The find
command is a great candidate for an alias or two
because it’s such a complex command (see
Technique 12). Here are two aliases that do the
heavy lifting for you:

alias f='find .
alias fi='find .

-name’
-iname’

After defining these aliases, you can search for a file
(by name) like this:

$ f myfile.sh
./tmp/myfile.sh

Or, use the second alias to search for a filename
without regard to letter case:

$ fi myfile.sh
./tmp/myfile.sh
./work/MyFile.sh

Using Aliases for Complex Commands 5 7

Viewing your alias

When bash sees an alias name at the beginning of the com-
mand line, it replaces the alias name with the body of the
alias. Normally, the substitution happens behind the scenes,
and you can't see it. If you want to see the substitution before
you press the Enter key, just press Esc-E. For example, if you
type fi myfile.sh and then press Esc-E, bash replaces
your command line with find . -name myfile.sh.

Anything that could legally follow the alias body
can follow the alias name. This means that you can
include additional options on the command line
when you use an alias. For example:

$ f myfile.sh -1s
819 8 -rw-rw-r-- 1 freddie freddie 5104
Feb 26 06:57./tmp/myfile.sh

bash aliases have one weakness: You can’t move
command line arguments to other parts of the com-
mand. For example, consider this alias:

-type f -print0 | xargs

alias gf="find .
-0 -e grep -n -e

The gf alias combines find and grep to search for
specific text in all the files in a directory tree. You
can use the alias like this:

$ gf Martini

./recipes/drinks.txt:200: the perfect
Martini

./spystories/bond.htm1:22: I prefer my
Martinis shaken, not stirred

The gf alias works great as long as you want to
search every file in a directory tree, but what if you
want to search through . txt files and ignore .htm1
files? You can’t do that with an alias because the
-name qualifier has to go in the middle of the com-
mand line; it can’t be at the end. Instead, you need a
function, which we explain how to create in the next
section.
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Automating Tedious Tasks
with Functions

A bash function is like an alias on steroids. A func-
tion has none of the restrictions of an alias. You can
execute many commands within a bash function,
and you can pass arguments to a function and use
those arguments wherever you need them.

Filtering file searches by file type

Here’s another version of gf, this time written as a
function instead of an alias:

function gfn ()

{
find . -name "$2" -print0 | xargs -0 -e
grep -n -e $1

}

This function, which we’ve called gfn to distinguish
it from the gf alias, expects two arguments. The first
argument is a filename pattern, such as "*.c", that
specifies which files you want to search. The second
argument to gfn is the text that you want to search
for. If you want to search through all the files in your
current directory, just use the pattern "*" (the dou-
ble quotes are important). Now you can search for
text in . txt files like this:

$ gfn Martini "*.txt"
./recipes/drinks.txt:200: the perfect
Martini

The $1 variable holds the first command line
argument (Martini), and $2 holds the second
("*.txt"). With a function, you can use the

command line arguments wherever you need
them. (With an alias, the arguments get tacked
onto the end of the command line.)

Automatic downloading

In its most basic form, a function is a name that
you give to a sequence of one or more commands.
Functions are perfect for automating tasks that you

find yourself doing over and over again. If you often
download, configure, and build software from the
Web, you can save time by creating a simple function
to automate that task:

function loadcode ()
{
wget -q -0 - $1 | tar -zxvf -

cd $(basename $1 .tar.gz)
./configure

make
1

The Toadcode function expects a single argument, the
URL for a tarball that you want to download and
install. To use this function, open your favorite edi-
tor, type the text for the 1oadcode function as shown,
and save your changes to ~/. funcs.sh (which is just
a random filename we’re using for this example).
Now, use the source command to install Toadcode
into your shell:

$ source ~/funcs.sh

Next, find a package that you want to install and
then run the 1oadcode function like this:

$ Toadcode
ftp://ftp.gnu.org/gnu/barcode/barcode-
0.98.tar.gz

barcode-0.98/
barcode-0.98/CVS/
barcode-0.98/Changelog
barcode-0.98/COPYING
barcode-0.98/Makefile.in
barcode-0.98/INSTALL
barcode-0.98/barcode.h

The Toadcode function has four commands inside

it. The first command uses wget to download the
tarball and feeds the download to tar for unpacking.
When you unpack a tarball like barcode-0.98.tar.gz,
the content is stored in a subdirectory named
barcode-0.98; the second command moves into that
directory. The last two commands do the GNU-install



two-step: configure (in this case, with all the default
options) and make. When 1oadcode completes, just
give yourself superuser privileges and do a make
install.

Toadcode is just a name that you've given to a
sequence of commands. The commands execute one
after the other, and if something goes wrong, the
script just keeps going. You can improve this func-
tion by adding a bit of error checking:

function loadcode ()
{
if ( wget -g -0 - $1 | tar -zxvf - )

then
cd $(basename $1 .tar.gz) || return 1
./configure && make

else

echo "Can't download $1"
fi
}

Now if something goes wrong, 1oadcode fails instead
of continuing on its merry (and misleading) way. The
new version of 1oadcode shows three ways to check
for error conditions:

v The first command is now wrapped inside an if
statement. If the wget or tar commands fail (that
is, if they exit with a result code of 0), 1Toadcode
jumps to the else clause and displays a friendly
error message. If the wget and tar commands
succeed, Toadcode jumps into the then clause.

v The cd command can fail if the tarball that you're
unpacking doesn’t follow the usual naming con-
vention. To catch that sort of problem, Toadcode
uses the | | (logical or) operator to exit if the cd
command fails. You can read that command as
“either cd successfully or return 1.”

v The configure command can also fail if you
don’t have all the prerequisites for the package
you're installing. In this case, 1oadcode uses the
&& operator to catch a configuration failure. You
can read that command as “configure and, if
that succeeds, make.”
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Monitoring Your System in a Snap

Adding a timer to loadcode

Aliases and functions can work together. Here’s an alias that
makes your computer beep when loadcode is finished
running (assuming you have a properly configured audio
card). It's kind of like the timer on a microwave.

alias beep='tput bel'

Invoke beep inside the Toadcode module, or just use it on
the command line, like this:

$ loadcode
ftp://ftp.gnu.org/gnu/barcode/barcode-
0.98.tar.gz ; beep

You'll hear a beep when Toadcode has finished its work
(Toadcode can take a while to run if you have a slow net-
work connection).

Monitoring Vour System
in a Snap

So far, you've seen functions and aliases designed to
work with the command line, but you can also spawn
graphical programs from the command line. Here is
an alias that spawns a new xterm window that dis-
plays the output of the top command (sort of a
build-it-yourself system monitor):

alias xtop="xterm -e top &"

After defining this alias, just type xtop to open a new
window that runs the top command (see Figure 10-1).

If you want to run a program that has a more com-
plex command line, just define a function. For exam-
ple, the following function opens a new window that
displays the last few lines of a file and continues to
display new text as it’s added to the file:

function xtail ()
{

xterm -e "tail -f $1" &
}
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If you have superuser privileges, you can use xtai .

to watch the system log file:

# xtail /var/log/messages

Un-

tarring the Easy Way

You can also save time by creating self-adjusting
functions that adapt to command line arguments.

LisTing 10-1: CHooSING THE RIGHT PROGRAM BASED ON FiLE TYPE

You know that the tar command (at least the GNU

n of tar) can handle uncompressed, gzip-

compressed, and bzip2-compressed archives. It’s
easy to create a wrapper function that invokes tar
with the right set of flags based on the archive that
you give it. The tar1s function (see Listing 10-1) uses

1e command to determine whether the given

archive is compressed and, if so, which compression
method was used. tarls is much longer than the
other functions in this technique, so we've included
two timesaving features in this listing:

Local variables that hold intermediate results:
You could rewrite this function without the local
variables, but it would be much more time-
consuming to maintain.

Comments that help future maintainers under-
stand our rationale: bash syntax can get awfully
cryptic, and you’ll save yourself a lot of time in
the future by commenting your code now.

function tarls ()

{

# Figure what type of file we are working with.

local filetype # Output from the file command
local tartype ## $filetype without filename
local compresstype # First word from $tartype

local tarflags # Flags given to the tar command

# Given an argument like:

# dicons.tgz

# filetype will contain

i icons.tgz: gzip compressed data
filetype=$(file "$1" )

# Now strip the leading filename
# from $filetype, leaving

# gzip compressed data
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tartype=${filetypefs$l:}

# Finally, grab the first word
# from $tartype, leaving
# gzip

compresstype=$(echo $tartype | cut -d ' ' -f 1)

case $compresstype in

gzip) tarflags=-ztvf;;

bzip2) tarflags=-jtvf;;

POSIX) tarflags=-tvf;;

*) echo "Unknown archive type"; return 1;;
esac;

tar $tarflags $1
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machines, a couple of Windows machines, and a Mac or two are

combined to create a network that is fast, versatile, and user
friendly. We're not trying to suggest that Linux isn’t the best thing since
sliced bread, but in reality, a complete conversion to a Linux-only net-
work isn’t always possible. Sometimes, the Penguin just has to learn how
to get along with Windows.

Most networks sport an assortment of computers. A few Linux

The need to share data across a network is nothing new, but with more
networks being made up of assorted machines, the open-source software
movement has grown to include a lot of excellent (and might we add,
free) software that knows how to deal with data sharing — programs that
let you share data and hardware across your network painlessly and fast.

In this technique, we show you how to share data and printers across
your network. Saving time, saving money . . . all in all, creating a friendlier
world.

What Is Samba?

Most people think of the Brazilian dance when they hear the word samba.
We prefer to think of the triplochiton scleroxylon (commonly known as
the Samba tree), a west African tree having axillary cymose panicles. We
have no idea what a cymose panicle is, axillary or otherwise.

In the Linux world, Samba is a suite of resource-sharing utilities included
in most Linux distributions. You use Samba to share Linux file systems,
directories, files, and printers with other hosts on your network. Samba
is designed specifically to work with the Microsoft Windows file-sharing
and printer-sharing features. Two hosts are involved in every Samba con-
nection: The server makes a resource available to clients, and the client
accesses the resource shared by a server. A Linux host can act as a
client, as a server, or as both.
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Under the hood, Samba clients interact with Samba
servers by using a protocol called SMB (Server
Message Block). SMB is also known as CIFS (Common
Internet File System). A server can expose two kinds
of resources: printers and shares. A share is a direc-
tory (and all the subdirectories underneath it). A
printer is, well, a printer.

Samba has been around awhile, and it’s very stable.
You can use Samba to share resources even if you

don’t have any Windows computers in your network.

Samba lets you expose resources to the rest
6 of the world. We specifically chose the word
expose to remind you that Samba can share

secrets that you may not want to share. It's
easy to make Samba reasonably secure, but
it's also easy to make Samba insecure. See
Technique 37 for some helpful tips about
hardening your system against malicious
(or accidental) abuse.

Getting Up and Running
with Samba

Before you can use Samba to share printers, direc-
tory trees, or both, you have to do a little upfront
work. The following sections help you check your
installation and then enable Samba.

Checking whether Samba is installed

The first step in preparing to use Samba is making
sure that you have all the parts installed. Samba is
typically distributed in five separate packages, but
the exact details vary by distribution:

V¥ samba-client contains the software required to
act as a Samba client.

V¥ samba contains the software required to act as a
Samba server.

v samba-common contains files required by both
samba and samba-client.

v samba-doc contains the documentation for
Samba.

V¥ samba-swat is a browser-based configuration
utility for Samba.

If you want your computer to act as a Samba
server (that is, if you want to expose data or
printers located on your computer), you must
install the samba (or samba-server) package.
However, we recommend installing all the
packages because it makes life a lot easier.

If you install all four packages, your com-
puter can act as a Samba client or a Samba
server, and you'll have a nice configuration
tool as well.

To find out if Samba is already installed on your
Fedora host, open a terminal window and type in the
following command:

$ rpm -q samba samba-client samba-common
samba-swat samba-doc

SuSE aficionados should use the command:

$ rpm -q samba samba-client samba-doc

If you are running Mandrake Linux, type in:

$ rpm -q samba-server samba-client samba-
common samba-swat samba-doc

If rpm reports that any packages are not installed, dig
out your OS install media and install them.

Enabling Samba

Samba runs as a service process, hanging around in
the background waiting for client requests. After you
have Samba installed, you have to enable it to start
the Samba server. If you're running Fedora, follow
these steps to enable the Samba service:

1. Open the GNOME or KDE main menu.

2. Choose System Settings->Server Settings=>
Services.
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3. Enter the superuser password if requested.

4. Scroll through the list on the left until you see
the SWAT check box.

5. Select the SWAT box.

That tells Linux to automatically start the SWAT
service whenever you boot your machine. (See
the next section for more on SWAT.)

6. Scroll back up until you see the SMB service.
7. Select the SMB box next to SMB.

This tells Linux to automatically start the SMB
service whenever you boot your machine.

8. Click Start (in the toolbar), and a window
appears telling you that the SMB service has
started. Click OK to close the window.

9. Click Save to save your changes.
70. Press Citrl-Q to quit (or just close the dialog).

If you're using Mandrake, start the services at the
command line with the commands:

# /sbin/service smb start
# /sbin/service swat start

If you're using SuSE, you can start the services at the
command line with the commands:

# /etc/init.d/smb start
# /etc/init.d/swat start

Now it’s time for a little configuration work. Don’t
worry, configuring Samba is as easy as swatting flies.

Sharing Linux Resources with
Other Computers (SMB Clients)

After you install and start Samba, as described in the
previous section, you can start configuring all the
computers so that they can share resources, which
is what this section is all about.
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Samba is controlled primarily by the /etc/samba/
smb.conf configuration file. If you were to peek at
that file immediately after you install Samba (which
we don’t recommend), you may find it a tad bit
intimidating: It’s nearly 300 lines long and has all
sorts of options and parameters that you typically
don’t need.

Fortunately, Samba has a graphical configuration
tool called SWAT that makes it much easier to man-
age Samba. SWAT runs a mini-HTTP server on your
host (listening for connection requests on port 901)
and manages the Samba configuration file (/etc/
samba/smb.conf) and the Samba password file (/etc/
samba/smbpasswd) for you.

The first time you run SWAT, it installs a new configu-
ration file that exposes any printers installed on
your Linux host along with the users’ home directo-
ries. You still have to adjust the workgroup name (if
necessary) and create Samba user accounts. Then
you can share the resources on your Linux computer
with other Windows and Linux computers on your
network. The following sections contain all the
details.

Adjusting the workgroup name
and creating user accounts

Before a remote computer can access the data that
you expose on your Linux host, the remote com-
puter must prove its identity to Samba. Computers
authenticate themselves by sending a workgroup
name, a user name, and a password to your Samba
server. Of course, you have to tell Samba which
workgroup names and user names are valid and
assign a password to each user account.

To adjust the workgroup name and create user
accounts, follow these steps:

1. Open your Konqueror browser.

- 2 a To open Konqueror, double-click Start Here on
A your desktop.
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2. To connect to SWAT, enter http://localhost:
901 in the Location field and press Enter.

A dialog appears prompting you for a user name
and password. You must log in as root and pro-
vide the superuser password. If you don’t, SWAT
allows you to log in, but you won’t be able to do
anything except read the documentation.

3. Click Globals.

)

Scroll down to the Workgroup box.

The default value for Workgroup is MYGROUP. If
you already have a Windows workgroup, enter
the workgroup’s name here. If not, choose a
name (MYGROUP is a reasonable choice) and
type it into the Workgroup box.

5. Click Commit Changes to write your changes to
the /etc/smb.conf file.

6. Click Password.

The password management page appears. This
page lets you create new Samba users, delete
them, and enable and disable their accounts. Use
the top part of the page to manage the Samba
server. The bottom part of the page (labeled
Client/Server Password Management) lets you
change passwords on other (client) hosts.

7. Type your user name into the User Name field
and enter a password into the New Password
and Re-type New Password fields.

SMB clients must provide the user name and
password that you enter here before they can
access the resources that you export (we’ll show
you how to share specific resources a little later
in this technique).

8. Click Add New User.
9. Click Enable User.

That’s it! If everything went well, Samba is up and
running, and you can access your Linux home direc-
tory (~) from an SMB client. To verify that every-
thing’s working, follow these steps:

-

Open a terminal window.

2. Type smbclient //localhost/$USER and press
Enter.

If you see a message like Connection to
localhost failed, the Samba server is config-
ured, but not actually running. In this case, log
back into SWAT (with your Web browser), click
Status, and then click Restart All.

3. Type in the password that you assigned to your
Samba account and press Enter.

You're greeted with a new prompt (smb: \>) that
indicates you're running the smbclient program,
connected to your home directory. You can type
1s to see a directory listing, cd to move to a sub-
directory, and help for a complete command list.
Type exit when you’re finished.

The smbclient program is useful in a pinch (we use
it just to make sure everything is configured prop-
erly), but you really want to mount your new share
on another computer, which we cover next.

Giving a Windows machine access to
your home directory

If your other computer is a Linux machine, sit tight,
and we’ll show you how to mount an SMB share in a
few moments. If your other machine is a Windows

host, follow these directions to mount the new share:

1. On your Windows desktop, right-click My
Computer or Network Neighborhood and
choose Map Network Drive from the pop-up
menu.

2. Type your host name and share name into the
Folder field.

Windows expects SMB share names to start with
two backslashes, then the host name (or IP
address) of the SMB server, a single backslash,
and the share name. For example, if your Linux
host is named bastille and you want to mount
the home directory of user frank1in, you would
enter the folder name \\bastille\franklin.



3. Click Finish.

4, If prompted, enter your Samba user name and
password and click OK.

After a short delay, a window appears (on your
Windows desktop) displaying the contents of your
Linux home directory. You can drag and drop files,
copy them, print them, or create new ones. Just
remember: The Samba-hosted files you see on your
Windows computer are actually stored on your
Linux computer.

Sharing Linux files and directories
with other computers

The standard configuration that SWAT chooses
exposes home directories (and all printers). SWAT
makes it easy to create new SMB shares for other
directories (even other devices) on your Linux com-
puter. To share your CD drive with others, follow
these steps:

1. To connect to SWAT, open your Web browser
and jump to http://localhost:901.

2. Log in as user root when prompted.
3. Click Shares.
The share manager page appears.

4. Type CD-Drive into the field next to the Create
Share button.

You can choose any name you like for the share
name, but don’t get foo fancy. In particular, don’t
include a forward slash or a backward slash in
your share name — SWAT will let you do it, but
you won't be able to mount that share from
another computer.

5. Click Create Share.
The share parameter page appears.

6. Enter a descriptive name (such as Shared
CD Drive) in the Comment field.
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7. Type /mnt/cdrom in the Path field (if you’re run-
ning SuSE Linux, type /media/cdrom instead).

8. Click Commit Changes (near the top of the
page).

Now you should be able to remotely access your

CD drive from another computer. Note that you still
have to mount the CD (mount /dev/cdrom) from your
Linux host before others can see it. See the section,
“Plugging In to Remote Data with Linux Programs
Quickly” later in this technique for more details.

Hooking Everyone Up
to the Printer

Samba can expose printers as easily as it shares files
and directories. In fact, Samba automatically shares
your Linux printers with anyone in your SMB work-
group. You can also access (from Linux) printers that
are connected to Windows computers. In this section,
we show you how to manage Samba printer shares.

Sharing Linux printers with SWAT

If you have any printers connected to your Linux
computer (and you've configured them), Samba
automatically shares them with other computers in
your workgroup; you don’t have to expose them
yourself. Samba discovers the printers on your com-
puter by reading the /etc/printcap file. Normally,
you don’t edit the printcap file yourself; you let a
KDE or GNOME helper do that for you.

If you have a printer that you don’t want to share,
you can use SWAT to hide it from other computers:

1. To connect to SWAT, open your Web browser
and jump to http://localhost:901.
2. Login as user root when prompted.
3. Click Printers.

The printer manager page appears.
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4. Click Choose Printer.
The printer parameters page appears.

5. Scroll to the bottom of the page and change
Available to No.

6. Click Commit Changes.

Using a Windows printer from Linux

Using a remote printer makes life much easier when
you're working on a network. Sharing resources
saves a small company not only dollars, but also lots
of time in potential maintenance. Sharing a printer
means that if Freddie’s printer breaks, he can use
Roberta’s printer and still get his work done on time
without shuffling disks, data, or cables.

If you're accessing Windows-hosted resources from a
Linux host, you don’t need to install the Samba
server — just the client. Now, with a few quick
clicks, you’ll have access to a network printer.
Follow these steps:

1. Click the printer icon on your taskbar.

The GNOME Print Manager window opens
(see Figure 11-1).

2. If you have no printers loaded, you're asked
if you want to run the configuration tool.

Click OK.

Printer Edit View Help

| ™ Question =]

@ No printers found. Run the printer configuration tool?

No Printers

* Figure 11-1: The GNOME Print Manager.

3. You’re prompted for the superuser password.
Enter the password and click OK.

4. Click New.

After a short delay, the Add a New Print Queue
dialog opens, as shown in Figure 11-2.

b Add a new print queue =1k

Add a new print queue

On the following screens, you will be asked to provide basic
information for adding a new print queue. You will be able to
edit the more advanced options afterwards.

Nothing will be done to your settings until you hit "Finish” on
the last screen.

&3 Help | & Cancel || < Back | ‘ bEaMard‘

* Figure 11-2: The Add a New Print Queue dialog.

5. Click Forward.

6. When the next dialog opens, type in a name
and a description for your printer. Click
Forward again.

7. In the next dialog (see Figure 11-3), select the
SMB queue type and highlight the network
share that you want to use.

hd Add a new print queue =]k

Queue type

Select a queue type: | Networked Windows (SMB) *

ﬂshare |Comment I - I

> kaGa |

» SHRKEY 7

| W2KSVR-VMWARE ‘
I MAYNARD =

& Help ‘ 98 cancel ‘ | < Back ‘ | bEurward|

* Figure 11-3: Select the SMB queue type and highlight the
network share.
8. Click Forward.

The Authentication dialog opens, as shown in
Figure 11-4.
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¥ Add a new print queue ax

Queue type

had Authentication

Select a queue typ
Workgroup: WORKGROUP

Share i
[Shae || semerkach
|7 KAGA Share:| 251

251
User name: |susan
localps

SHRKEY

[ |

Password: | * |

‘ ® Cancel H qgack—| P> Forward

¢ Figure 11-4: The Authentication dialog.

9. Enter the user name and password you use to
log into the Windows computer and click OK.

70. In the next dialog that opens, use the list box
(initially labeled Generic) to choose your
printer type and model.

711. Click Finish, and print a test page to verify that
the printer is properly configured.

To print on the remote printer, just click the printer
button usually found on the toolbar, or navigate
through the File menu. The Print dialog opens to
let you adjust the properties of your print job

(see Figure 11-5).

ad Print - Kongqueror

[] Preview

— Printer

Name: |@ Lexy

State: Idle (accepting jobs)

Type: Remote printer queue on kobe
Location:
‘Comment:

=

Print system currently used ‘ Generic UNIX LPD Print System (default) '|

No plugin information available

\m Help ‘ % Erint

|V Expand |Q System Options...

‘ ® cancel

* Figure 11-5: The Print setup dialog.

Plugging In to Remote Data
with Linux Programs Quickly

Mounting a remote directory on your local system is
a great way to use your favorite Linux programs with

Windows data (or data stored on another Linux com-
puter). Just add a quick line or two to the /etc/
fstab file, and Linux mounts a network share with
just one command.

In a typical Linux system, you have to hold super-
user privileges to mount a file system. That’s very
secure, but not very convenient. If you want a non-
privileged user to be able to mount his or her own
home directory, you need to give some extra privi-
leges to the SMB mount program (see Technique 27
for more information about file permissions and
privileges):

1. At the command line, give yourself superuser
privileges.
2. Change permissions for smbmnt:

chmod u+s /usr/bin/smbmnt

3. Change ownership for smbmnt:
Chown root /usr/bin/smbmnt

Granting privileges to programs (instead of to
users) can create security risks should some
hacker discover a flaw in the smbmnt program.

Be sure to check out Technique 57 to decide
whether privileged programs are right for you.

Now, if you add a line or two to your /etc/fstab
file, mounting a remote SMB share is a snap. To edit
the file, follow these steps:

1. Open a terminal window and give yourself
superuser privileges with the su command.

2. Type kwrite /etc/fstab and press Enter.

A KWrite window opens, with /etc/fstab
displayed.

3. Add aline at the end of the file that reads like
this:

//bastille/freddie
smbfs

/mnt/bastille \
noauto,user 0 0
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You need to customize the entry in this step as 4. Save the file and close KWrite.
follows: )

You're ready to mount a share!
» The first field, //bastille/freddie, describes

the device to be mounted. This is the computer
name, followed by the remote directory name.

The second field, /mnt/bastille, defines the
mount point. This is the directory on your
computer where the content of the remote
directory will appear. The mount point can be
anywhere in your directory tree that you
would like your share to be, but you need to
create the directory and set the privileges
before you mount it.

The third field is the file system type: smbfs.
Many file system types work with Linux, but
smbfs is the choice for what you're doing.

The fourth field, noauto, user, describes the
options to invoke for this mount. Set the
noauto option to tell Linux not to mount this
file system at boot time (you never want to
auto-mount a network share), and set the
user option to permit a nonprivileged user to
mount the share.

The fifth field works with the backup com-
mand. You don’t want to be backing up this
share remotely, so set it to 0.

The sixth field indicates whether the file sys-
tem of the share should be checked at boot
time. Again, pass on this option and set it to 0.

Need more information about the fstab file?
For the fastest route to this info, type man
fstab at the command line and press Enter.
All the documentation is at your fingertips.
Use the up- and down-arrow keys to scroll
through the documentation, and when you're
finished, press q to quit.

Need the documentation in a nicer format?
Double-click the Start Here icon on your desk-
top and enter man: / in the Location line. You
might need to search a bit for the documenta-
tion, but it's more readable and includes hyper-
links to other information related to your topic.
Oh, and fstab is documented in Section 5.

Now, to mount the new share, just use the mount
command at the command line:

$ mount //bastille/freddie

Access your new share just like it’s a part of your
local machine. You can work on it with all your
favorite Linux programs or copy files back and forth
effortlessly.

7 If you're graphically inclined, use Konqueror to
e- { <@ navigate your new file system. It works just
& like a part of your local machine now.



Finding What
Vou Need

Technique

Save Time By
v~ Locating files by name

v~ Finding files by their quali-
fications and attributes

v Finding out who's hogging
the disk space

v~ Executing simple com-
mands with find and
exec

v~ Building complex com-
mands with find and
Xargs

e’ve all been there — you create a new file, and then you forget
where you put it and what you called it. How do you find it again?
Fortunately Linux has a few options for finding lost data fast.

In this technique, we introduce you to the find command. find can
search through your file system looking for files based upon a diverse set
of qualifications that you can combine to create complex searches. With
find, you can search for your file based on information like the modifica-
tion date, the file size, ownership, and other file attributes. find also
works with the xargs command to build complex commands based on
search results. We also show you how to use the Tocate command to
search through a system-maintained catalog of files and how to update
that catalog to be sure it contains current entries.

We've also included a diskusage utility that you can use in conjunction
with find to play “find the disk hog.” If you need to free up resources,
this is a quick way to find out who’s using all the space.

This technique is all about finding files fast, with whatever information
you have on hand. You know what you need to find. You might not
remember it’s name, but we’ll help you find it anyway.

Finding Files with locate

Every night, an automatically scheduled program waltzes across your
disk drive(s) and records all the filenames it can find in a database. The
locate command searches through that database to find files with a
particular name.

7 If you find your installation of Linux is missing the 1ocate command,
e { -a) you can add it by installing the appropriate RPM package: for SuSE,
) install findutils-locate-version.rpm; for Mandrake, install
slocate-version.rpm; for Fedora, install slocate-version.rpm.
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You can use locate to find data files, directories, or
programs. For example, if you can’t remember where
the ifconfig program is located, just type Tocate
ifconfig and press Enter. You instantly see a list of
all the files on your system whose names include
ifconfig:

$ locate ifconfig
/usr/share/man/man8/ifconfig.8.gz
/usr/share/man/de/man8/ifconfig.8.9z
/usr/share/man/fr/man8/ifconfig.8.9z
/usr/share/man/pt/man8/ifconfig.8.gz
/sbin/ifconfig

That’s pretty close but not exactly what you were
looking for. Save some time by using a regular
expression (also known as a filename pattern) to
narrow down the results:

$ locate -r "/ifconfigs$"
/sbin/ifconfig

The -r flag tells Tocate to expect a regular expres-
sion. In this case, you want a list of all filenames
where /ifconfig appears at the end of the name.
($ means end of name; see man -S 7 regex for a
complete list of valid regular expressions.)

- searches through a database rather than the
complete file system. It's a great tool for sim-

ple filename searches.

Z The Tocate command runs quickly because it
<

&

Like anything that’s simple and easy, the Tocate
command has a few drawbacks:

v The database becomes outdated quickly if you
add, delete, or rename many files during the day.
If you have superuser privileges, you can update
the database yourself. Use the same command
that the nightly update job executes:

/etc/cron.daily/slocate.cron.

v The database is incomplete because the nightly
database update excludes several directories
(/tmp, /var/tmp, /usr/tmp, /afs, and /net) and
remote file systems.

If you don’t have superuser privileges, or your
search requirements are more complex than the sim-
ple filename matching that 1ocate provides, you
need to use the find command, which is discussed
next.

Finding Files with find

The find command is one of the most complex and
useful commands that you'll find in Linux. find
searches through a file system looking for files that
fit a pattern (which you define) and then performs
an action on those files. The most frequently used
find command searches for a file with a specific
name, starting in the current directory:

$ find . -name drinks.txt -print ./recipes/
drinks.txt

When you use the find command, you have to pro-
vide three pieces of information:

v Location: Where to start searching. Typically,
you specify . to start searching in the current
directory or / to start searching at the root of
your file system tree. If you list multiple direc-
tory names, find searches in all those directory
trees.

v Qualifications: Which files should be included in
the result. In the example, freddie is looking for a
file named drinks.txt. See the next section for
details on handy qualifiers.

v Actions: What you want find to do when it
locates a qualifying file. In the example, -print
simply echoes the relative pathname of the file.
See “Acting on What You Find,” later in this chap-
ter, for details on putting actions to good use.
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Oualifying Your Search
with the find Command

find gives you a wide variety of qualifiers, and this
section delves into the more timesaving ones. For
details on using qualifiers with find, see the preced-
ing section.

Doing updated filename searches

Two of the most frequently used qualifiers are -name
and -1iname, both of which must be followed by a
filename pattern:

v -name tells find to operate on any files that
match the given pattern.

¥ -iname does the same except that it ignores case
differences.

You can use the normal shell wildcards with -name
and -iname. For example, -name "*.c" matches any
filenames that end with . c. If you include wildcards,
you must surround the filename pattern with quotes
to prevent the shell from expanding them before
find gets a chance to see it.

The -name and -iname qualifiers make find
very similar to the Tocate command. Tocate
searches through a database of filenames,
whereas find searches through the file sys-
tem. find gives you more up-to-date results
but takes much longer to perform a thorough
search.

Adding time-based qualifications

You can also search for files based on time of last
access, content-modification time, or attribute-
modification time. The content-modification time of
a file is updated whenever you write to that file. The
attribute-modification time of a file is updated when-
ever you make a change to the file’s attributes (by
changing ownership or permissions, for example).

Table 12-1 lists qualifications that select files based
on their timestamps.

TaBLE 12-1: QUALIFICATIONS THAT SEARCH FOR TIMESTAMPS

Qualification ~ What It Finds

-atime n True if the file was last accessed n days ago

-amin n True if the file was last accessed n minutes
ago

-ctime n True if the file’s attributes were last changed
n days ago

-cmin n True if the file’s attributes were last changed
n minutes ago

-mtime n True if the file’s contents were last changed
n days ago

-mmin n True if the file’s contents were last changed

n minutes ago

To find files in your home directory (and all subdi-
rectories) that were last changed a week ago, use
this command:

$ find ~ -mtime 7 -print

If you run this command, you may be surprised by
the results. -mtime 7 does not show you all the files
modified in the previous seven days; it shows the
files modified exactly seven days ago. To locate files
modified in the previous seven days (yesterday, or
the day before, or the day before that, . . .), specify
-mtime -7 (note the minus sign in front of the 7), as
follows:

$ find ~ -mtime -7 -print

You can read that command as “find files where the
date of last modification is less than seven days
ago.” Now suppose you change the command to this:

$ find ~ -mtime +7 -print
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You see a list of files whose dates of last modifica-
tion are greater than seven days ago. You can find
files modified within a range of dates by using both
the + and - signs. For example, to find all files modi-
fied four or five days ago, use this command:

$ find ~ find . -mtime +3 -mtime -6 -print
Read this command as “modified more than three
days ago but less than six days ago.”

You can use the -atime qualifier to find unused (or at
least not recently used) user files on your system:

$ find / -atime +90 -print

Filtering by file size

The find command also lets you filter files based on
their size. The -size n qualifier selects any files
whose size is n.

The + and - tricks that you can use for time qualifica-
tions work with -size qualifications, too: -size +n
selects all files larger than n, and -size -n selects all
files smaller than n. When you use -size n, you can
specify n in terms of bytes, kilobytes, or 512-byte
blocks:

v To specify a byte count, follow -size n with a c.

v To specify a number of kilobytes (1024 bytes),
follow -size n with the letter k.

v The default unit is 512-byte blocks, but you can
make your intention explicit with a suffix of b.

As find examines each file, it rounds the file’s size
up to the nearest unit (kilobyte or block) and then
applies the qualifier. For example, -size 2k selects
files between 1025 and 2048 bytes long.

Table 12-2 shows a few examples using the -size
qualifier.

TaBLE 12-2: ExampLES USING THE -SizE QUALIFIER

Command Result

-size 2048c Files exactly 2048 bytes long

-size +2048c Files 2049 bytes or larger

-size -2048c Files smaller than 2048 bytes

-size 2k Files between 1024 and 2048 bytes long

-size +2k Files larger than 2048 bytes

-size -2k Files smaller than 1025 bytes

-size +1k Files larger than 1024 bytes and smaller
-size -3k than 2049 bytes

The rounding that find performs can be confusing,
so we’ve written a short shell function that trans-
lates a value like 2M (megabytes) or 3G (gigabytes)
into the equivalent number of bytes. Listing 12-1
shows the unit function.

LisTING 12-1: THE unIT FUNCTION

function unit ()

{
# Extract the last character from
# the first (and only) parameter.
1
# Given a value like 5M, the suffix
# is the character 'M'

suffix=${1l: -1: 1}

# Remove the suffix from the argument
# and we should be left with number
# units ('5' if we were given 5M)

count=${1%%$suffix}

case $suffix in
K| k) echo $(expr $count \* 1024)c;;
MIm) echo $(expr $count \*
1048576)c; ;
G|g) echo $(expr $count \*
1073741824)c;;

*) echo $1"c"
esac;
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Use the unit function to make find behave a bit more

predictably. For example, the following command

$ find ~ -size +$(unit 2M) -print

translates into

$ find ~ -size +2097152c -print

Press Esc-E to view the translated command line
before you press Enter. (Notice that unit included
the c suffix, which forces find to turn off its funky
rounding trick.) The unit function translates kilo-
bytes (K or k), megabytes (M or m), and gigabytes
(G or 9g).

Joining qualifications with
AND and OR operators

By joining qualifications, you can get more mileage
out of the find command.

- z a To quickly find large files that haven’'t been
& used in a while, combine -size and -atime.

For example, use the following command to search
for files 5 megabytes or larger that haven’t been
used in the last 30 days:

$ find ~ -size +$(unit 5M) -atime +30
-print

TaBLE 12-3: CommonLy USED QUALIFIERS
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By default, find joins multiple qualifiers together
with the AND operator. Given two qualifiers —
-size +$(unit 5M) and -atime +30 — a file qualifies
only if it meets both criteria.

You can also join qualifiers with the OR operator. To
find all files that are either empty or haven’t been
used in a while (or both), stick an -or between the
qualifiers, like this:

$ find ~ -size 0 -or -atime +30 -print

With the -or operator, a file must meet either

(or both) of the qualifiers to be selected. You can
also use -not to reverse a qualifier (for example,
-not -size 0) and -and to explicitly and qualifiers
together. Use quoted parentheses to build complex
expressions. For example, the following command
finds large files (larger than 5M) that have not been
accessed in the previous 30 days and adds empty
files to the list as well:

find / "(" -size +$(unit 5M) -and -atime
+30 ")" -or -empty -1s

The -empty qualifier is a synonym for -size 0.

Perusing commonly used qualifications

Table 12-3 shows the most commonly used qualifiers.

Qualifier Result

-name pattern
-iname pattern

-regex EXPI‘GSSfOﬁ

Select files that match the given filename pattern.
Select files that match the given filename pattern, ignoring differences in letter case.

Select files that match the given pathname regular expression (similar to -name except that

-regex matches the entire path where -name matches only the filename).

-iregex expression

Select files that match the given pathname regular expression, ignoring differences in letter case

(similar to -iname except that - iregex matches the entire path where -name matches only the

filename).
-atime [+]|-1n
-ctime [+]|-1n
-mtime [+]|-1n

Select files that have been accessed (-atime), attribute-changed (-ctime), or content-changed
(-mtime) n days ago. If n is preceded by a +, select files last accessed more than n days ago. If n
is preceded by a -, select files last accessed within that previous n days.

(continued)
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TaBLE 12-3 (continued)

Qualifier Result

-amin [+]-1n
-cmin [+]-1n
-mmin [+]-1n
-daytime
rather than exactly 24 hours ago.
-size [+]|-1 n
select files smaller than n.
-empty Select empty files and directories.

-type filetype

Same as above except that n specifies minutes instead of days.

Measure -atime, -ctime, -mtime, -amin, -cmin, and -mmin from the beginning of the current day

Select files n bytes long. If n is preceded by a +, select files larger than n. If n is preceded by a -,

Select files of the given filetype. filetype may be b to select block devices, c to select charac-

ter devices, d to select directories, p to select named pipes, f to select regular files, 1 to select

symbolic links, or s to select sockets.

-user username
-group groupname

-nouser
-ngroup

-perm [+]-]
permissions

Select files owned by the given username or groupname.

Select orphan files (that is, files owned by users or groups that no longer exist on your system).

Select files based on their permissions. The most useful values for permissions are
-perm +ug+s; this matches any files that are setuid or setgid and could be used to

impersonate other users (see Technique 57 for more information).

-xdev
remote file systems.

Select files only on the given file system. Use this option to avoid searching other disk drives and

Acting on What You Find

As we mention earlier in “Finding Files with find,”
actions tell find what to do when it finds a qualifying
file. The -print command that you’ve been tacking
on the end of each find command displays the name
of each qualifying file, but find can do a whole lot
more than that. The following sections give you the
timesaving highlights.

Cracking open a file's info with -Is

You can use the -1s action to see more details about
each selected file:

$ find ~ -size +$(unit 5M) -print
/home/freddie/bigdatafile
/home/freddie/tmp/deleteme

$ find ~ -size +$(unit 5M) -1s

35525 8204 -rw-rw-r-- 1 freddie freddie
8388608 Dec 20 09:52
/home/freddie/bigdatafile

44201 6156 -rw-rw-r-- 1 freddie freddie
6291457 Dec 20 09:52
/home/freddie/tmp/deleteme

-1s gives you far more details than are provided by
-print. -1s displays the following columns (from left
to right):

v The file’s inode number (a number that uniquely
identifies each file within its file system)

The number of 1K blocks consumed by the file
The file’s type and permissions

The number of hard links to the file

The file’s owner

A W W W W

The file’s size (in bytes)



v The date and time of the most recent modification

v The file’s name

Displaying specific info with -printf

In most cases, the -1s action gives you more infor-
mation than you really need. You can use the
-printf action to view only those nuggets of knowl-
edge that you want. To use -printf, you have to
follow the action with directives that specify the
information you want to display. For example, take
a look at the following command:

find ~ -size +(unit 5M) -printf %p %s %u

This command displays the file’s complete pathname
(%p), size in bytes (%s), and owner (%u), like this:

$ find ~ -size +$(unit 5M) -printf %p %s %u
/home/freddie/bigdatafile 8388608 freddie
/home/freddie/tmp/deleteme 6291457 freddie

-printf offers a wide variety of directives (see man

find for a complete list), but we show you only a few
of the more useful ones in Table 12-4.

TaBLE 12-4: CommON PRINTF DIRECTIVES

Directive = Meaning

-%p Complete pathname of the selected file

-%f Same as %p with the leading directory names
stripped off

%h Same as %p with the filename stripped off
the end

%U Name of the user who owns the selected file

%U Numeric user ID of the user who owns the
selected file

%S Size of file (in bytes)

Checking disk usage by user

The -printf action is extremely useful when you
want to feed the results from a find command into
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another program. With -printf, you can customize
the output from a find command to fit the needs of
the program that you're running. Listing 12-2 shows
a shell script that summarizes disk usage by user.

LisTing 12-2: Disk USAGE

f#1/bin/bash
f# Filename: diskusage

# Create three arrays, each indexed by
numeric user ID

i $sizes[] will accumulate the disk
space consumed by each user

i $uids[] will store the numeric
user ID for each user

i $users[] will store the user name

for each user

# The caller will send us lines of the
form
i numeric-user-id filesize username

while read uid filesize user

do
# Find the current amount of space
used by this $uid
size=${sizes[$uidl:-0}

# Add the space consumed by this
file and store it back

# in $sized[$uid]

let sizes[$uid]l=$filesize+$size

# Store the numeric user ID and
user name too
uids[$uidl=%uid
users[$uid]=$user

done

# We've now accumulated all of the disk
space usage
# for the caller, display the results

for uid in ${uids[*]}

do
printf "%15d\t%s\n" ${sizes[$uid]l}
${users[$uid]l}

done




80 Technique 12: Finding What You Need

To use the diskusage script, follow these steps:
1. Open your favorite editor and type in the text
shown in Listing 12-2.

2. Save your script to a file named diskusage in a
directory that’s included in your search path.

/usr/local/bin is usually a good place.

3. Use chmod to make the file executable:

chmod a+x /usr/local/bin/diskusage

To use diskusage, use the find command to locate
the files that you're interested in and use -printf to
create the output required by diskusage:

$ find /home -type f -printf "%U %s %u\n"

| diskusage
211128211 franklin
602579 1001
4525391478 root
8756011463 freddie

Whenever find locates a qualifying file, it feeds the
owner ID, file size, and owner name to diskusage.
diskusage adds up the disk space consumed by each
user and prints the results when find stops feeding
it. The nice thing about this combination is that you
can select files so many ways with find, and no mat-
ter which qualifiers you choose, diskusage happily
sums things up for you. For example, you can change
the previous command to see disk space, by user,
that hasn’t been accessed within the last 30 days:

$ find /home -type f -atime +30 -printf
"%U %s %u\n" | diskusage

128211 franklin
602579 1001
4000324962 root
22315532 freddie

If you compare these results with the previous
results, you'll see that although freddie is a disk hog,
he’s at least using the data that he’s storing. User
1001, on the other hand, hasn’t even logged in dur-
ing the last month.

] When diskusage displays a numeric user ID
- { <@ instead of a user name, the user account has
& probably been deleted. This is a quick and
easy way to find abandoned files and recycle
disk space.

Executing commands with find

It’s time to switch gears and look at a very power-
ful (and occasionally dangerous) feature of find:
the -exec action.

You've seen that the -print, -1s, and -printf
actions display information about selected files. The
-exec action executes a program of your choosing
with the files that find has selected. Suppose that
you're a system administrator and one of your
coworkers has recently left the company. Your task
is to find all the files owned by that user (call him
ted) and give them to user franklin. The -user qual-
ifier will locate the files that you're interested in, and
-exec will execute a command (in this case, chown)
on each of those files:

$ find / -user ted -exec chown franklin
Tyt

This command may look a bit cryptic to you (it sure
looks cryptic to us). find executes the -exec action
once for each selected file. When find executes
the command, it replaces {} with the name of the
selected file. You must include a quoted semicolon
at the end of the command (';"). You can probably
imagine all sorts of uses for the -exec action —
removing old files, moving certain files to other
locations, fixing permissions, and so on.

Never, never, never use the -exec action with-
out first viewing the list of qualified files with

-1s or -print. Never. Make sure that you

know exactly which files will be acted upon.
To avoid running find twice (once to see which files

are selected and again to execute the required com-
mands), use the -ok action instead of -exec. When



you use -ok, find asks if you want to execute each
command. If you answer y (or Y, or yes, or Yes, .. .),
find executes the command. If you answer anything
else, find moves on to the next file.

When you select a large number of files, executing
the -exec (or -ok) action on each file, one at a time,
can be painfully slow. Many Linux commands can
process multiple files in a single pass, and you can
use find to produce the argument list for those
commands.

Building Complex Commands
with xargs

The xargs command builds long command lines for
you. xargs reads filenames from the output of
another command (like find) and builds commands
by using those filenames. For example, look at the
following command:

$ echo /tmp/icons.tar | xargs tar -tvf

xargs reads the filename from the echo command
and constructs the new command:
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$ tar -tvf /tmp/icons.tar

xargs isn’t particularly useful when you need to
process a single filename, but find usually produces
a whole mess of filenames. To use find and xargs
together, craft a find command that locates the files
that you're interested in and use the action -print0
to echo the selected filenames. Pipe the output of
the find command to xargs like this:

$ find /home -user ted -print0 | xargs -0
-e grep -n "secret password"

When you execute this command, find lists the
names of all files owned by user ted and feeds that
list to xargs, and xargs then constructs (and exe-
cutes) a grep command for you. xargs tries to group
many files into a single command. If you find the
three files /home/ted/secrets, /home/ted/mail, and
/home/ted/work, for example, xargs executes the
command:

grep "secret password" /home/ted/secrets
/home/ted/mail /home/ted/work

rather than three separate commands.
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effort that it takes to move a single file. An archive is a file that

contains other files. You can build an archive out of just about any-
thing: text files, programs, pictures, audio files, and even other archives.
Archives are easy to build, and you can compress an archive to help
speed up data transfers. For example, a tarball is nothing more than an
archive built with the tar command.

ﬁ rchiving data makes it easy to move multiple files with the same

Using good tools to create archives saves time. In this technique, we
introduce you to File Roller, a handy feature that’s included with GNOME.
With File Roller, you can not only create an archive, but also inspect an
archive’s contents before unpacking it. You can save time by choosing
just the portions of archives that you need to unpack.

The tar command creates archives at the command line and works well
with the RPM query commands and the find command. We show you
how to use tar in powerful combinations to build complex, custom
archives.

The sp1it command can split large files or archives into bite-sized pieces
for transferring. If a connection drops midtransfer, you can resend only
the portion of the file that didn’t make it. We also show you how to use
checksums to make sure that your entire file got to its destination.

Every day is moving day on a computer, and doing a good job packing
makes moving easier. Good labels on neat packages make it easier to find
things when you need to unpack them again. In this technique, we show
you tools and tricks that make moving easier.

Creating Archives with File Roller

You can e-mail multiple files just as easily as a single file when you bun-
dle the files together in an archive. Creating compressed archives for
e-mail attachments saves time and bandwidth for both the sender and
the receiver.



L If you're running the GNOME desktop, File
i («ﬁ

Roller is probably installed automatically. If
you need to add File Roller, you'll find it (in
most Linux distributions) in an RPM pack-
age called file-roller-version.rpm. See
Technique 17 for help installing RPM packages.

&

GNOME'’s File Roller is the easy way to browse and
choose the files to include in an archive. To make a
tarball using File Roller, follow these steps:

1. Open the Main Menu and choose Run
Command.

The Run Command dialog, shown in Figure 13-1,

opens.
w|; 0 and - KDeskiop -
2 | F Enter the name of the application you want to run or
4 the URL you want to view.
Command: ll » |
RQetionsazal) D [ gancel |

* Figure 13-1: The Run Command dialog.

KDE and GNOME auto-launch File Roller if
you've configured your MIME database. (See
Technique 3 for more information on MIME.)

2. Enter file-roller in the Command field and
click Run.

The File Roller window opens ready to build a
tarball (see Figure 13-2).

3. Click New on the toolbar to open the New
Archive file chooser (see Figure 13-3).

4. In the Archive Type drop-down list, select the
type you want to create.

In this case, choose the Tar Compressed with
gzip option.

5. Enter your tarball name in the Selection field
and click OK.

Now it’s time to add files to your archive.

Creating Archives with File Roller
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6. Click Add (on the toolbar) to open the file
chooser window. Use the file chooser to browse
directories for the files that you want to
include and then add them to the tarball.

Double-click a selection to add it to the archive.
To add additional files to an archive, click Add on
the toolbar, and double-click the next file to be

included.

Archive Edit View Help

t O @& @ B ©

New  Open Add Extract View Stop

4 Up | Location

b File Roller

BEIES

* Figure 13-2: The File Roller window.

¥ File Roller

Archive Edit View Help

B = @&

New  Open Adc

Extract Vi

& Up | Location

icw Archive 727

‘ New Folder | Delete File | Rename File |

/home/susan *

| Folders

o

o
autocutsel-0.6.2/
Desktop/
evolution/
example/

jaily

o= 2
5717374004.png
| aaa

aaa.asc

| autocutsel-0.6.2 tar.gz
balsa-2.0.15-1.i386.rpm

| balsa-2.0.15-1.i386.rpm.tar

[+] | bbb =

Archive type: | Automatic

z ‘

Selection: /home/susan

* Figure 13-3: The New Archive file chooser.
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You can include a tarball in an archive, but it
won’t get any smaller. One serving of com-
pression per file, please.

7. When you're finished adding files to the
archive, close the File Roller window.

The archive is waiting for you in the directory
you created it in, which is usually your home
directory. Just attach the archive to your e-mail
and send it off.

g Use File Roller to create archives to send via
- («a SSH or FTP. Multiple files are easier to manage
) when they’re bundled, and compressing the
data makes it travel faster.

Inspecting and Extracting
Archives with File Roller

File Roller makes it easy to inspect and extract files
from archives. With just a few quick clicks, you can

see the contents of the files included in an archive or

extract the portion of the archive you need.

] The File Roller is especially handy if you share
- { -@ data via e-mail. Use File Roller to check out
) the archive’s contents before you take the
time to unpack it.

To open an archive with File Roller, follow these steps:

1. Open the Main Menu and choose Run
Command.

2. Enter file-roller in the Command field and
click Run.

3. Click Open on the toolbar to open the file
chooser.

4. Use the file chooser to locate the archive you
want to open. Highlight the archive name and
click OK.

The contents of the archive appear in the File
Roller window.

After you open an archive, you can extract a file
(or files) from it by following these steps:

1. Highlight the file(s) in the list and click Extract.

The Extract dialog opens, as shown in
Figure 13-4.

¥ wu-ftpd-current.tar.gz

¢ O

New Open

© A Up | Location

Archive Edit VI

Destination folder

/home/susan/

Name

an(
Dmakeﬁ\es
= sre

[ support
E)um

J .indent.pro
/7 build

[ ] config.quess
[ contig.h.in
J config.h.noac

{7 config.sub

fhome/susan
/home/susan/tmp

Files

W chances O Al files

@ Selected files

O Eiles:

4

[] Wiew destination folder after extraction

241 files (1.5 MB), 1

o Add to Bookmarks | ‘ - ﬂemwe‘

Actions
Re-create folders
Ovenwrite existing files
[] Do not extract older files

Password

¢ Figure 13-4: The Extract dialog.

2. In the Destination Folder field, type the name
of the folder where you want to save the
extracted files, or from the Bookmarks list,
choose a bookmark to use for the destination.

Add often-used directories — such as ~/tmp —
to the Bookmarks list. Later, when you need
one of these directories, just double-click the
directory to select it as the destination folder.

3. If you highlighted more than one file before
you clicked Extract in Step 1, choose from the
following options in the Files area:

» All Files: Unpack the entire archive.

» Selected Files: Extract the files highlighted on
the previous screen (hold down Shift to select
multiple files).

» Files: Specify files by name, or groups by
using wildcards (such as *.png or *. txt).
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4. Check the Re-create Folders box to restore the
folder structure.

didn’t want to re-create folders. If you don’t
select the Re-create Folders check box, all

the subdirectories and their contents end up
in your current directory. Cleaning up the
unpacked pile of structureless files wastes time.

z We've never encountered a case where we
B+

5. Check the Overwrite Existing Files box to
replace any file with a duplicate name in your
folder.

6. Check the Do Not Extract Older Files box to
preserve the most recent copy of the file.

If the copy on your computer is more current
than the archived copy, the older file is not
extracted. This option works only if the
Overwrite Existing Files option is checked.

7. Check the View Destination Folder After
Extraction box to open a file manager window
with your newly unpacked archive.

8. When you’re ready, click OK to unpack the
file(s).

If the destination folder doesn't already exist,
File Roller asks if you want to create it.

included in a tarball before unpacking it. To do
so, right-click the filename and choose View
File from the drop-down menu to display the
file's contents. If the file looks questionable,
don't open it!

? Inspect suspicious-looking files that are
)

&

Adding Functionality to tar
with Complex Commands

The File Roller enables you to quickly and easily

build or unpack archives, but sometimes using the
command line with the tar command is the way to
go. The following sections explain how combining

the tar command with other functions can give you
extra power when you need it.

Building archives from the command line

You can build simple archives (containing one file or
many) with the tar command. Here is a basic tar
command to create a gzip-compressed archive:

$ tar -zcvf archivename filestoarchive

If you want to archive multiple files, just list them at
the end of the command line (separate the names
with a space character).

] Compressing an archive increases the time it
a («

takes to create the archive. If you don't need
to transfer the file over the Web or if the data
is already compressed (such as RPMs), skip the
-z or - j options when you create the archive.

&

tar has a lot of powerful options, the most useful of
which are listed in Table 13-1.

TaBLE 13-1: USEruL TAR OPTIONS
Option What It Does

-z Compress to (or uncompress from) gzip
form.

-J Compress to (or uncompress from) bzip2
form.

e Create an archive.

- X Extract from an archive.

-t Display a list of the files in the archive.

-V Verbose — tell me what you're doing.

-f file Write to (or read from) the archive file.

Enter man tar at the command line for a complete
listing of tar options and flags.

The GNU man pages are handy, but they can
be a bit overwhelming at times. Take a deep
breath and remember that you can close the

page at any time by entering q.
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Archiving complex search results

Use the pipe character ( | ) to combine programs
like find and rpm with the tar command to create
archives that contain the results of complex
searches.

Using tar with find can seem complex, but it is very
useful. One example of a combined command is as
follows:

$ find / -user freddie | tar -zcvf
fredfiles -T -

This command finds all the files owned by the user
Freddie and sends the output (the list of filenames)
to the tar command. The -T - portion of the com-
mand instructs tar to read the list of filenames from
its standard input (which, in this case, is the output
of the find command) rather than from the com-
mand line.

For more in-depth information about using the find
command, see Technique 12.

Backing up an installed package

Use tar with rpm to create a backup of an installed
package. To back up an installed copy of the webmin
package, use this command:

$ rpm -q1 webmin | tar -cvf webminbackup
,T,

7 . . . .
( a For more information about using rpm queries,
A see Technique 16.

Uprooting Entire Directory
Trees with scp

Sometimes, you need to move more than a single
file — you need to move an entire directory tree

(a directory and all the files and subdirectories
underneath it). When that’s the case, use scp to get
the job done quickly and easily. For example:

v lIf you carry your work to and from the office on a
laptop, use the scp to copy files from your laptop
to your home computer (and back again).

v You can also use the scp -r command to quickly
move a user from one machine to another.

v lIf you're upgrading to a new system, scp -ris an
easy way to quickly transfer your work with no
disruptions.

scp was designed to copy files from one com-
puter to another. You can also use scp to copy
a file from one place to another within your

computer, just like you would use cp. We find
scp to be much more intuitive when it comes
to copying directory trees.

To move a directory tree with scp, open your termi-
nal window and enter this command:

$ scp -r user@host:source user@host:
destination

That’s all there is to it. The -r flag tells scp to copy
source and everything underneath it.

Table 13-2 highlights two options worthy of mention.

TaBLE 13-2: WORTHWHILE ScP OPTIONS
What It Does

-C Compresses the data stream for faster
transfers.

Option

-1 Timit  Throttles file transfers to no more than
17imitK bits per second. (Use this option if
you're sharing a network connection and you

don’t want to hog all the bandwidth).

Getting familiar with scp (and its secure shell
i («& cousin, ssh) is definitely worth the time. scp is

a fast, secure, and easy way to move files and
archives from one location to another. scp and
ssh share many command-line options
because scp is built from ssh. For more infor-
mation about ssh, see Technique 33.



Splitting Big Files into
Manageable Chunks

While you’re working across the Web or across a net-
work, the inevitable happens: You lose the network
connection mid-upload. You have to go all the way
back to the beginning and start the transfer over.

ISPs are known to place limits on the size of incom-
ing files. E-mails with oversized attachments are
returned undelivered and unseen by the recipients.
How can you get around that?

To transfer a large file to a user with limited access
(or over a questionable connection), use the sp1it
command. sp1it doesn’t actually speed up the trans-
fer, but it does speed up the recovery if a connection
drops.

split breaks a file (any file — archives, pictures,
data ... you name it) into segments that you can
reassemble on the other end.

To reassemble the split file accurately, all the
@ pieces must be included. split can't tell if
they're all there or not — it just re-assembles

what it has. If great-aunt Gertrude’s nose looks
a bit off, you may have lost a segment.

Use the following command to break a file into
1-megabyte segments for transfer:

$ split --bytes=1lm filetosplit
segmentprefix

sp1it appends the segmentprefix with a unique suf-
fix. When it’s finished, you still have the original file,
but you also have a set of 1 megabyte segments. If
you started with a 2.5 megabyte file, you end up with
three segments: The first two contain 1 megabyte
each, and the third file contains the leftovers.

Splitting Big Files into Manageable Chunks
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It’s a good idea to calculate an MD5 checksum on
the original file to compare it to the reassembled
result. Save the number generated by the following
command — you’ll need it later:

$ mdSsum filetosplit

md5 stands for message digest #5. It's a cryp-
tographic program that’s good at detecting
differences between files. It's kind of like a fin-
gerprint for a file.

®

[/ Send the checksum with the attachments or
(ﬂ save them to compare to the checksum of the

reassembled file. If the checksums match, you
can be sure that the entire file was received
and reassembled.

&

It’s easy to move all the segments securely with one
scp command:

$ scp segmentprefix.* user@host:directory

- to log in to the remote machine, and use cd
to move to the directory containing the

segments.

2 To rebuild the file after the upload, use ssh
a

&

To reassemble the segments, enter this command:

$ cat segmentprefix.* > filename

cat rebuilds the file into its original structure.

After the file is rebuilt, run a new MD5 checksum and
compare it to the fingerprint of the original file. The
two fingerprints should be identical.

$ md5sum originalfilename
If you've sent the sp1it file to a friend

running Windows, the type command will
concatenate sp1it files on Windows.
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ing something on the Web. When you use the Internet, you're con-

stantly moving data. Using the right tools to upload and download
files can make a huge difference in the time it takes you to get the job
done.

The Internet is pervasive. Few days go by when we aren’t research-

In this technique, we walk you through downloading and compiling a
software tarball. You can find tarballs all over the Web, with great, time-
saving software just waiting to be downloaded. The example we show
you is for another timesaver — SuperKaramba — that just happens to be
fun, too.

When it comes to moving data around, don’t overlook the command line.
Using wget to create mirrors of Web sites you visit frequently is a great
way to save time — you don’t have to wait for page downloads, and you
can take the entire site with you when you travel. You can even schedule
wget to perform mirror updates at night, when the network traffic is low.
Now that’s a timesaver.

wget also has a few other tricks up its sleeve for downloading. It can play
spider, cruising the Web sites in your bookmarks or links files checking to
see if all the links still work. wget doesn’t give up on downloads if a con-
nection drops. It’s a persistent agent and will try again to complete a
download.

We also show you how to use curl to manage file uploads. Unlike ftp,
curl manages uploads with just one entry at the command line. You can
schedule your uploads, just like your downloads, to happen without your
help.

Building Software from Downloaded tarballs

Free software packages are all over the Web. Many packages are available
in RPM format, but some of the really good stuff only comes wrapped up
in a tarball that you have to compile yourself.



No problem — you can deal with tarballs. First, we
give you the basic steps and then we explain how to
use those steps for SuperKaramba.

Compiling a tarball: The basic steps
The basic steps don’t vary much for most software
you find on the Web:

1. Download the tarball.

Unpack the tarball (see Technique 13 for more
information).

w

Use configure to determine the software
needs.

Use the make command to run the compiler.

“r ™

Run make install to run the install script for
the package.

If there are any variations in the procedure or any
software prerequisites, the download page should
include instructions specific to the package.

Downloading and compiling SuperKaramba

SuperKaramba is a tool that builds custom desktop
features. In this section, we present the basic steps
for downloading and compiling SuperKaramba as a
fun and useful example of how you apply the basic
steps to an actual program.

propeller-heads) can create desktop acces-
sories fast. Use SuperKaramba to display infor-
mation you’'ve read over the Internet, create
custom toolbars, or create virtual pets (Chia-
Penguins perhaps?). You can download some
pretty cool, ready-to-run SuperKaramba
resources, too!

? With SuperKaramba, anyone (not just the
E)

7 If you're running SuSE, you're in luck —
B («s SuperKaramba is already included with the
KDE desktop in a standard installation. If
you're running SuSE, just open the main
menu and choose Systemr>Desktop Applet—>
karamba.
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If you're running Mandrake, you'll find
SuperKaramba is included with the standard
distribution, but you need to install it. You
may want to download and compile your own
version anyway, to check out the most recent
features as they develop.

To build SuperKaramba, follow these steps:

1. Open your browser and surf to

netdragon.sourceforge.net

2. Click the Download SuperKaramba link at the
bottom of the page.

3. Scroll down to the Official Releases and click
the link for SuperKaramba source code.

available? Well, if the RPM package that you
find isn’t from an official source, the integrity
of the software may be questionable.
Although it is possible for someone to intro-
duce a Trojan horse into source code (just like
a prebuilt version), it doesn’t happen often.
RPM packages are platform specific, and the
platform you need may not be available.

z Why use a tarball when an RPM package is
<}

4, Click the link for the most recent release:
$ superkaramba-0.33.tar.gz

5. The download page instructs you to choose a
mirror site near you. Click the link for the
site nearest you and then save the file to your
desktop.

6. Open a terminal window and move to your
Desktop directory:

$ cd ~/Desktop

7. Unpack the tarball with the following command:
$ tar -zxvf superkaramba-0.33.tar.gz

8. Move into the superkaramba-0.33 directory:
$ cd superkaramba-0.33
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Enter the following command:

$ ./configure --prefix=$(kde-config
-prefix)

configure determines the correct set of tools
and compiler options to customize the software
for your computer.

The --prefix=$(kde-config -prefix) por-
tion of the command is unique to KDE. Use
configure --help to get more configuration
options for KDE and non-KDE programs.

If configure complains about any problems, now
is the time to correct them. configure does
remarkably well at describing the cause of any
problem it encounters. If you see an error mes-
sage that just doesn’t seem to make sense, type
the text of the message in to Google and you’re
likely to find a solution waiting for you some-
where out there on the Web.

Installing a SuperKaramba theme

After you install SuperKaramba, we suggest grabbing a
theme or two to see how easy this program makes chang-
ing your desktop. SuperKaramba themes are different from
other desktop themes. They're active desktop decorations —
little accessories for your desktop that actually function.

One desktop applet that we really like is Liquid Weather++.
You could go to KDE-Took.org and spend hours looking
through the pages of Karamba themes — do that later. To
find Liquid Weather++ quickly, go to www.google.com and
search for Liquid Weather Karamba, and follow the link.

To download and unpack Liquid Weather++, follow these
steps:

1. Open your favorite browser and surf to the
download site for Liquid Weather++.

2. Click the download link and save the tarball to
your desktop.

Notice that this tarball is different; it ends with the
.bz?2 file extension. Different flavors of tarballs exist —

10. Enter this command: gzips and bzips. Gzips and bzips are basically the
$ make same, but bzips generally offer better compression
and download speed. You can unzip either kind
make runs the compiler for you. The compiler is with Linux.
translating the source code into a program one . .
bit at a time. The make program coordinates the 3. Open your terminal window and move to the
build — think of it as the job site foreman. Desktop directory.
$ cd Deskto
71. Give yourself superuser privileges: P
$ su 4. Create a themes directory with this command:
$ mkdir themes
Enter the superuser password when prompted.
12. Enter this command: 5. Move to the themes directory:
# make install b cd themes
make install runs the install script for the pack- G Ll t.he T B LG
age. Depending on the package you're installing, $ tar -jxvf ../tarball
Elr;igitearﬂ;t(i:g: tni?gl[l)lg ise ascélt‘t';;:iglfsz?pymg This extracts the tarball into the themes directory.
accounts, and so on. To start SuperKaramba, open the Main Menu and choose
73. Turn in your superuser privileges with the exit Run Command. Enter superkaramba in the Command

command.

field and click Run. The SuperKaramba window opens, as
shown in the following figure.

After SuperKaramba is installed, you can use it to
decorate your desktop. See the sidebar, “Installing a
SuperKaramba theme” for details.



To run Liquid Weather, click Open on the SuperKaramba
menu page. Browse to ~/Desktop/themes/1iquid_
weather_plus and choose 1iquid weather.theme
from the files listed. Double-click the icon to open a
weather report on your desktop (see the following figure).

To customize Liquid Weather, right-click on the weather
screen and choose Configure Themer>Enter Your Location’s
Code. Enter your zip code (or weather code if you're in
Britain) and choose OK, and the weather forecast is
updated to your region.

Versatile Downloading
with wget

wget uses the HTTP, HTTPS, and FTP protocols from
the command line to retrieve files or Web sites. wget
is handy if you have a slow or undependable Internet
connection. If a connection drops partway through a
download, wget keeps trying. If the server allows it,
wget will continue the download where it left off.

Versatile Downloading with wget 9 ’

wget has a lot of options that combine to make it a
versatile download tool. You can use it in the follow-
ing ways:

v For recursive Web site downloads
For updating Web site mirrors

As a spider to verify links

For executing scheduled downloads

As a persistent agent to download large files

] wget works quietly in the background with no
(«a further input from you. You can schedule wget

(with Task Scheduler) to start downloads when
network use is at its lowest so that you don't
interfere with other users. For more informa-
tion about scheduling tasks with Task
Scheduler, check out Technique 20.

Mirroring sites with wget

You might wonder why anyone would mirror a Web
site. Many generous people who support the open
source movement help provide the world with extra
information and closer, quicker downloads by set-
ting up servers and creating sites that mirror and
distribute open source software and information.

You can also use site mirrors for quicker access to
sites that you use often. Not only do you have
quicker access to the site, but you can also take it
with you anywhere you go — even without a Web
connection.

Download an entire Web site recursively with the
following command:

$ wget -r -k http://www.website.com

The -r in this command stands for recursive (mean-
ing that wget copies the directory you name and all
the files and subdirectories underneath it) — by
default, wget copies five levels of subdirectories to
your local system. The -k (or --convert-Tinks if you
want to type it out) redirects the links on those five
levels to refer back to your local system. If you leave
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out the -k option, the documents that you download
will still point back to the original Web site.

If you find yourself setting up a site mirror, either for
internal use or for the world, you’ll want to keep it
up-to-date. Schedule a job (with Task Scheduler) to
run every night:

$ wget -r --mirror -k
http://www.website.com

The --mirror option checks your copy of the site
against the version published on the Web, and down-
loads only those files that have changed.

Verifying your bookmarks with wget

If you're anything like us, your bookmark collection
is, well, a mess. Bookmarks accumulate over time
and pages that you may have been interested in a
few months (or years) ago might not be there any
more. It’s a good idea to weed out obsolete links now
and then just to keep your bookmark collection
under control. Use wget to check all the links on
your bookmarks or links page, with one easy com-
mand. To make wget impersonate a spider and inves-
tigate links, use this command:

$ wget --spider --force-html -i
bookmarks.html

wget visits each link, and reports successful or
unsuccessful connections for each entry in your
bookmarks page.

the command locate -i bookmark to
generate a list of all the files with the word
bookmark in their name.

7 Forget where you left your bookmarks? Use
g (43

&

Downloading files with wget

To use wget to download a file from an FTP server,
enter the following command:

$ wget ftp://www.sitename.com/filename
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If the download is interrupted, resume the download
with this command:

$ wget -c ftp://www.sitename.com/filename

The -c option instructs wget to resume the down-
load where it left off.

Downloading and unpacking in one quick step

You can redirect the output of a wget download to a
tar command to download and unpack in one easy
step:

$ wget -0 - http://tarball | tar -zxvf -

The -0 option redirects the output to the tar com-
mand. tar then unpacks it to a subdirectory in your
current directory.

wget's optional flags

Dozens of flags work with wget — we’ve noted a few
in Table 14-1. For a complete list, type man wget at
the command line.

TaBLE 14-1: HANDY WGET OPTIONS

Option What It Does

-b Goes to background after starting.
-q Turns off the output of wget

-V Displays long debugging messages.
-nv Displays errors or basic info only.
-t count Tries count times before giving up.
-nc Doesn’t overwrite files.

One other option worthy of mention is
--limit-rate=bandwidth. Use this flag to limit
the download speed so you don’t steal all the
bandwidth away from other users on your
system.

$ wget --limit-rate=20k



The preceding command limits the download rate to
20 kilobytes per second — a very generous gesture if
you’re sharing a network link.
) If you use a proxy server to connect to the
> (@ Internet, wget can use it, too. wget uses the
) $http_proxy environment variable to find
your proxy server. Enter the command
$ export http_proxy proxyaddress:port
at the command line to set the environment
variable. Add this environment variable to
your bash startup script to run the command
each time you log in.

Downloading and Uploading
with curl

curl (a client for URL) works with the HTTP and FTP
protocols to download or upload files. curl is an
easy way to upload files when you’re maintaining a
Web site, or to keep files synchronized with the work
of remote employees.

[ curl is a powerful download tool, too. For
S («&

more information about the features of curl,
é type man curl at the command line.
When you upload with ftp, you have to drive the
entire process. You have to enter passwords, type in
the put commands one at a time, and disconnect
when you're finished. Unlike ftp, curl can do its
job without additional user input. You can also
schedule cur1 to do large uploads when the network
is quietest — you’ll get the best throughput and
provide the least aggravation to other users.

To upload a file with cur1, enter this command:

$ curl -T uploadfile
ftp://ftp.sitename.com/filename
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Replace uploadfile with your local filename and
substitute the ftp sitename information into the
command, and the file is on its way. That’s all there
is to it.

g Set up an ftp server where remote employees’
e- { 4@ can save their work. Schedule a nightly job on
& the remote employees’ machines to keep up-
to-date with their important files — and they
won't have to babysit the upload!

If you create an ftp server to hold your employees’
nightly updates, you’ll want that server to be secure.
To use curl to upload a file to a secure site, use the
following command:

$ curl -T uploadfile -u user:passwd
ftp://ftp.sitename.com/filename

curl gives you the option to update single files, mul-
tiple files, or entire systems with a single command.
When you combine the powerful uploads that you
can get with cur1 with the scheduling features of
Task Scheduler, you'll find lots of ways to save time!

Visit the CURL Web site at curl.haxx.se for
a complete overview of the curl project.

The basics of URL syntax

Have you ever wondered what that string of characters you
type into your Web browser is made of?

A simple address like http://www.wiley.com tells the
browser to use the http protocol to connect to a host
named wiley.com.

A more complex address like http://www.wiley.com/
newbooks.htm1 tells your browser to open the newbooks .
htm1 resource at the host wiley.com.

An ftp URL often contains a user name and password
for the ftp server. The address ftp://freddie:FuNkY@
bastille/mixers.html tells ftp that the user freddie,
with a password of FuNkY, wants to log into bastille to
access the resource mixers.html.
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Save Time By

v~ Creating a virtual work
environment with User
Mode Linux

v~ Using ADIOS to set up a
Fedora VM

v+~ Using graphical inter-
faces to your advantage
in server management

v Making permanent
changes to your virtual
machine

safe and secure to hold a server or to try out some new software.

Are you interested in trying the latest features in the Linux kernel,
but you're stuck with version 2.4 for a while? User Mode Linux (UML) is
what you’re looking for.

Sometimes, you could really use a second computer — someplace

User Mode Linux is a virtual machine (VM) — which is just like a regular
computer, but it’s built entirely of software. The physical computer that
contains the VM is called the host. The host and the virtual machine can
share resources such as files, disk drives, and network interfaces.

With UML, you can even simulate hardware that you don’t have. If you
have a single Linux computer, you can run two or three UML sessions to
simulate a local area network. You can try out new kernels while safe-
guarding your real work on a familiar kernel. You can also use UML to
create jails for hack-vulnerable programs (such as Apache or DNS
servers). A jail is an environment that confines a dangerous program by
limiting access to important files and devices that the program doesn’t
need (and more importantly, shouldn’t damage).

In this technique, we show you how to install a UML system based on
the Fedora Core distribution. This technique is one you can really build
on. After you've installed a virtual machine, you can jump ahead to
Technique 24 to find out how to build a new kernel and try it out in a safe
environment before you install it, or you can skip ahead to Technique 58
to create a UML jail.

Choosing the ADIOS Version
of User Mode Linux

You can download, compile, and install UML by hand, but we know a much
quicker way thanks to the nice folks at the Queensland University of
Technology in Brisbane, Australia. They have put together a package
named ADIOS that makes it easy to install UML, loaded with a Fedora



distribution, onto your Linux system. Download and
install ADIOS, and you’ll have a complete Fedora Core
server that you can use for tons of other things.

Every Linux computer needs two major components:
a kernel and a root file system. The same is true for
UML — you need a UML kernel and a root file sys-
tem. The root file system contains the configuration
files, data files, and programs that run inside the VM.
A UML kernel is a full Linux kernel compiled to run
on Linux rather than a real CPU. When the VM needs
access to a piece of hardware, it asks the host to do
the dirty work. The ADIOS root file system is built
from Fedora Core (release 1, Yarrow at the time we
write this). It includes a version 2.4 kernel and a
basic set of Fedora RPM packages. ADIOS offers
some nice features that make it stand apart from
other UML packages:

» A minimal set of packages is already installed.
Each ADIOS root file system comes with a mini-
mal set of RPM packages (just enough to get up
and running). That means that your VMs are as
small as is practical and are not bloated with
software that could introduce vulnerabilities.

1 RPM is already up and running. You can use the
Red Hat package manager to install new pack-
ages into the virtual machine or to remove things
you don’t need. Just start the VM, mount your
install media, and use the normal RPM com-
mands to install new packages.

v ADIOS automatically configures network inter-
faces. Each ADIOS VM comes with a virtual
Ethernet interface configured to talk to your
host’s TCP/IP network. That means that you
can log into the VM from your host, transfer
files, mount host drives, and even run a Web
browser — all from the safety of your VM.

v ADIOS can create an X desktop for you. When
you run startx within the VM, a new window
appears on your desktop. Inside that window,
you see the VM’s desktop.

1 Root privileges are not required. After you've
installed ADIOS, you can relinquish your super-
user privileges. UML lets you create new VMs
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without requiring superuser privileges, which
makes your system less vulnerable to typo-
related accidents.

v The Linux Intrusion Detection System is
included. Two of the four ADIOS VM’s include
LIDS (Linux Intrusion Detection System). LIDS
protects your VM in a number of ways, but most
importantly, it takes away most of the privileges
from the superuser account. When you're run-
ning under LIDS, a hacker who somehow gains
superuser privileges cannot destroy your system.
We tell you more about LIDS in Technique 58.

v* SELinux is included. SELinux (security-enhanced
Linux) is a hardened version of Linux developed
by the U.S. National Security Agency. Like LIDS,
SELinux closes vulnerabilities and limits the
superuser’s power. SELinux is more difficult to
use than LIDS.

Setting Up ADIOS

Now that we’ve convinced you to use ADIOS, you
need to set it up. To do so takes three steps: First,
you download ADIOS, then you burn it to CD, and
finally, you install it. ADIOS makes it easy to install
UML and the Fedora file system.

Downloading ADIOS

To download ADIOS, open a Web browser and navi-
gate to the address dc.qut.edu.au/adios/iso/uml/.
Right-click um1-fedoral-1.00.iso and choose Save
Link Target As. Highlight your Desktop directory,
click Open, and then click Save.

The version specified in the name of the ISO
file is the operating system inside the VM.

In other words, when you install this ISO disc
image, you're installing Fedora Linux in the
UML VM.

when you download it, this would be a good

z The ADIOS package is 121 megabytes long, so
-a
time to get a cup of coffee, go to a meeting,
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and so on. A better idea might be to schedule
this download to happen at night when the net-
work load is low — see Technique 20 for help.

Because this is such a big package to download,
you should verify that the bits that you received
are really the same bits that the server sent you

(in other words, make sure that the file didn’t get
corrupted in transit). When the download com-
pletes, use your command line to compute the MD5
checksum and compare it to the corresponding
checksum from the Web site. Type the following
command and then press Enter:

$ md5sum ~/Desktop/uml-fedoral-1.00.7so

(If you didn’t save the download to your Desktop
directory, substitute the correct pathname.) The
command line displays the checksum:

bf8237afabb5e99ec31b7elaaff5856e

If your checksum matches the one on the Web site,
your download succeeded.

It's important to check your sum against the
6 one on the Web site (instead of the one you
see in this book) in case the package has been

changed.

If the checksums don’t match, delete your local copy

and download the package again.

Burning ADIOS to CD

ADIOS is distributed as an ISO disc image. If you
have a CD burner, copy the ISO image to your CD

(see Technique 56 for details). If not, mount the disc

image by using the Linux loopback device:

1. Open a terminal window and use the su com-
mand to give yourself superuser privileges:

$ su
Password:

2. Create a mount point for the loopback driver:
# mkdir /mnt/loop

3. Mount the disc image over the loopback mount
point:
# mount -o loop ~username/Desktop/
uml-fedora-1.00.iso /mnt/loop

The content of the ADIOS disc image appears in
the /mnt/100p directory. (In other words, if you
cd to /mnt/7Toop, you see the file system inside the
uml-fedora-1.00.1so disc image.) If you've burned
ADIOS onto a CD and mounted the CD, ADIOS
appears in /mnt/cdrom.

Installing ADIOS
To install ADIOS, follow these steps:

1. Make sure you have complete superuser privi-
leges by using the su- command:
$ su -
Password:

#

2. Move to the mount point (either /mnt/Toop or
/mnt/cdrom):

# cd /mnt/Toop

3. Run the INSTALL program:
# ./INSTALL

The installer program takes a few moments to
copy the root file system to your computer and
then asks you a few questions.

ADIOS asks whether you want to install Mozilla
Firebird. Answer y here to run Firebird within
the UML VMs.

5. When prompted, type y to install the Ice WM
window manager.

This is a lightweight desktop environment, which
takes up a lot less room (and CPU) than GNOME
or KDE.



6. When prompted, enter y to install Xnest on
your host.

Xnest lets you view the VM'’s graphical desktop
within a window on your desktop.

7. If prompted, answer y to add iptables rules to
modify your network firewall so that you can
talk to the VM from your local network.

If you're using KDE, the installer creates a new sub-
menu (named User Mode Linux) on your KDE main
menu. To start UML, open the KDE main menu and

choose User Mode Linux=>LIDS Off.

At installation, UML adds four options to your
menu. LIDS and SELinux are hardening sys-
tems that make your computer less vulnerable
to attacks from nasty people. We tell you
more about UML jails in Technique 58 and
more about LIDS in Technique 61. For now,
use UML LIDS Off — it will behave just like a
standard installation of Fedora.

A console window appears, showing a typical Linux
boot sequence; that’s your new virtual machine
(see Figure 15-1).
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* Figure 15-1: The UML login screen.
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When your UML VM has finished booting, login as
user root (the initial password is 12qwaszx).

To shut down your virtual machine, enter halt
at the command line.

Finding Your Way around UML

When you first start up a VM, the host file system is

mounted on /mnt/host. This means that the VM can
access every file and directory on your host. Go
ahead — take a look:

[root@um1l/] 1s /mnt/host

bin etc jail misc proc tmp
boot home 1ib mnt root usr
dev initrd lost+found opt sbin var

Here are some more important things you’ll likely

want to do from the VM:

v Use the resources of the host computer: Preface
the resource pathname with /mnt/host. For
example, to access the CD drive, enter the follow-
ing command:

$ cd /mnt/host/mnt/cdrom

Before you can use a host file system from
within the VM, you have to mount the file sys-
tem from the host. For example, if you want to
use the CD drive from within the VM, you
must mount /dev/cdrom in the host. Then
use the /mnt/host prefix to access the periph-
eral devices.

v Find the programs on your host: ADIOS has con-
figured the $PATH environment variable to match
the $PATH in your host (adjusting it to find com-
mands first within the VM and then on the host).
If $PATH is setto /bin:/usr/bin on the host,
UML changes that to /mnt/host/bin:/mnt/
host/usr/bin. This means that all the programs
you use on the host are available within the VM
(although configuration files may not be in the
right place).
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1 Get the IP address: Your new VM has a virtual
Ethernet adapter. You can find the IP address
with the ifconfig command:

ff /sbin/ifconfig eth0 | grep inet
inet addr: 192.168.201.1
Bcast:192.168.201.255
Mask: 255.255.255.0

Typically, the first VM you create has an IP
address of 192.168.201.1, the second VM has an
IP address of 192.168.202.1, and so on. You can
ping the VM from your host or ping the host
from your VM. You can also ssh from one to the
other.

Connecting to the Internet
from an ADIOS UM

If you want your VM to be able to access the rest of
the Internet, you need to turn on NAT (Network
Address Translation). NAT enables you to share a
physical network interface among multiple comput-
ers (in this case, one physical computer and a few
virtual computers). Here’s how to turn on NAT in
Fedora or Mandrake Linux:

1. From the host computer (not from the VM),
open your terminal window and give yourself
superuser privileges with the su command.

2. Enter the following command:
# kate /etc/sysconfig/iptables

The Kate text editor opens, with the iptables
file ready to edit.

3. Add the following code to the end of the file:

*nat

:POSTROUTING ACCEPT [0:0]
:QUTPUT ACCEPT [0:01]
:PREROUTING ACCEPT [0:0]
COMMIT

4., Save your work and close the editor.

5. Execute the following command to restart your
firewall with the new rules you just put in
place:

# /sbin/service iptables restart

If you're using SuSE, check out Technique 34
for information about enabling NAT within
your firewall.

Now you should be able to access the Internet
(and your local network) from within the VM.

Using a GUI with UML

IceWM is a minimal desktop environment — it doesn’t
come with a ton of bells and whistles, but it’s also
not a big resource hog.

7 While you're configuring your VM, the GUI
Q can be a great help. But after you're up and
& running, you'll probably use the command line
for most of your work. Having a GUI that's a

bit sparse really isn't a problem — you won't
be here for that long.

To run IceWM, open a virtual machine and enter
startx at the command line. A new window opens,
displaying the IceWM window manager.

Click the IceWM button in the upper-left corner to
open the drop-down menu. The other buttons on the
taskbar control your workspaces within lceWM,
open an Xterm window, or start the Mozilla browser.

Installing Software into UML

The ADIOS distribution of UML comes with the RPM
package manager installed and ready to use, making
software installation quick and easy. In fact, you



don’t have to copy an RPM package into the VM
before you install it; just mount the host drive that
contains the package and nab the file by using the
/mnt/host prefix.

As an example, we walk you through an installation
of Webmin. Webmin is a handy tool for managing
servers from within a Web browser. Webmin takes
care of just about every system administration task
you can think of, making it a great addtion to UML. In
the next section, we show you how to install Webmin
into the VM prototype so all your VMs have quick
and easy access to Webmin.

/ If you need to set up a server that makes
i («@ resources available to the outside world (such

b as a Web server or an e-mail server), build the
server inside a VM. If troublemakers do get in,
you can limit their access to the rest of your
system. We show you how in Technique 58.

To install Webmin in a UML Virtual Machine, follow
these steps:

1. On your host machine, open a Web browser
and browse to www.webmin.com. Click the RPM
download link in the upper-right corner.

You jump to the download server page.

- directly into your virtual machine, but it’s
faster to download to your host machine and

access the result via /mnt/host.

z You can surf from inside UML and download
<

&

2. Click the Download link for the location that’s
closest to you. When the Download Manager
opens, click the Save button to save the file.

3. From within the VM, cd to the directory that
contains the RPM package that you just saved:

$ cd /mnt/host/home/user

Don’t forget to include /mnt/host in your path
because you saved the package on the host.
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4. Unpack the RPM package with the following
command:

$ rpm -Uhv webmin-1.121-1.noarch.rpm

If you downloaded a new version, substitute its
name in the command.

5. Press Enter, and the whirring begins.

Webmin creates a mini-Web server inside your VM.
You can use Webmin from your host machine to set
up the servers you install in the VM. Just open a
browser on your host machine and jump to

192.168.201.1:10000

Log in as root and enter your password, and you can
quickly manage your virtual servers from the com-
fort of your host’s browser!

Merging Changes
to Your Prototype

If you run many VMs at the same time, each new
VM starts out with its own copy of the original
ADIOS root file system (we call that the prototype
file system because new VMs are created from that
file system). This means that software you install in
one VM won’t show up in the other VMs.

Occasionally, you may want to install a tool in every
virtual machine on your host. To make a permanent
change to your prototype file system, change one of
the VMs and then merge the changes back into what
then becomes your new prototype UML virtual
machine.

need to set up multiple VMs with similar
attributes (for example, you want to use
Webmin to manage all your servers). Make
your changes to one machine and commit
those changes to the prototype. New VMs will
reflect the changes.

2 Merging changes can be a timesaver if you
=)
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To merge your changes back into the prototype file
system, follow these steps:

1. Open a copy of UML and make the changes you

want reflected in all your VMs.

2. Shut down the VM by using the halt command.

3. Open a terminal window and enter the follow-
ing command:

$ uml_moo -d /tmp/root_fsl

4. Press Enter.

That’s it — all the changes you’ve made to the
virtual machine are merged into the prototype
UML. Next time you start a new VM, your
changes will be waiting for you.

Your original root file system is never modified
by changes you make to an open VM unless
you merge the changes back into the proto-

type. All your modifications are recorded in a
separate file.

Peeking into the virtual file cabinet

When you start a new UML VM, a few new files appear in
the /tmp/uml directory. If you casually browse through
/tmp/uml, you may be alarmed to see some huge files. If
you've started a single VM, you'll see a file named /tmp/
uml/root_fs1. That's the root file system for your VM.
Use the 1s -1 command to see this file, and you'll discover
its over 500 megabytes long! Start a second VM and
another 500 megabyte file appears for the second root
file system. Don't worry, the apparent file size is very
misleading.

UML uses a brilliant strategy known as copy-on-write, or
COW. When you start a VM, UML mounts the original
root file system (/opt/uml/root_fs) in read-only mode,
but it also creates a second file (/tmp/uml/root_fs1).
When your VM maodifies a file within its root file system, the
changes are written to the /tmp/uml/root_fs1 file, not to
the original file. If you really mess up something in your
VM (or if an intruder has made his or her way into
your VM), COW makes it easy to revert to a fresh copy of
Linux — just remove the COW file (root_fs1) from
/tmp/uml. The next time you start the VM, UML creates a
fresh new COW file for you.
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install media

v~ Finding package
dependencies

+* Querying remote pack-
ages before bringing
them home

ware, but behind the scenes, RPM maintains a database of useful

information. Every RPM package includes a mini-database that con-
tains basic information about the package itself. When you install an RPM
package, the mini-database is added to the master database of installed
packages. The rpm command can peek inside the RPM databases to tell
you about software that you’ve already installed or packages that you
may want to try out.

R PM (the Red Hat Package Manager) is typically used to install soft-

An RPM package typically contains a collection of programs, data files,
and documentation. A package can also contain scripts that execute
when you install, remove, upgrade, or verify the package. Each package
also contains a package digest that contains information about the pack-
age itself. The digest can tell you a lot about the package: who built the
package, when they built it, and what the package is supposed to do. The
digest also lists prerequisites for the package (that is, you must install
package A before you install package B).

An RPM package also contains two components critical to ensuring that
you're installing software from a trusted source. When an RPM package is
created, the person creating the package signs the package with a digital
signature. You can use the digital signature to determine whether the
package has been modified since it was signed (a mismatched signature
tells you that the package has been tampered with). Every file installed
by a package is fingerprinted at the time the package is created; you can
come back at a later date and verify the fingerprint of the installed ver-
sion to make sure that the file has not been tampered with since installa-
tion. We show you how to verify digital signatures and fingerprints in
Technique 18.

In this technique, we show you how to use the rpm command to query
RPM databases in useful and interesting ways. We also show you how to
save time by creating a complete catalog of your installation media for
handy reference.
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Technique 16: Red-lining RPM Queries

Ouerying RPM Packages
for Content

If you've ever used RPM from the command line,
you know about the -1i (install) and -U (upgrade)
options, but you may not be familiar with RPM’s
query features. When you run a query against an
RPM database, you have to tell rpm which database
you want to view. If you want to peek inside a pack-
age file (typically a file whose name ends in . rpm),
include --package filename on the command line
(or -p filename for short); otherwise, rpm will dis-
play information from the master database of pack-
ages that you've already installed.

Table 16-1 shows some of the most useful rpm query
options. To use each of the commands, just open a
terminal window and type in the command — no
special privileges are required.

You can run each of the commands shown in
Table 16-1 against multiple packages (or package
files) at once. Just list the names that you're inter-
ested in at the end of the command like this:

$ rpm -q kdebase gnome-desktop

kdebase-3.1.4.2
ghome-desktop-2.4.0-1

TaBLE 16-1: Some Hanoy RPM Query OpTIONS

When you view a package’s digest, rpm tells you
which group the package belongs to, for example:

$ rpm -qi kdebase

Name : kdebase

Version . 3.1.4

Release : 2

Install Date: Tue 28 Oct 2003 03:11:28
Group : User Interface/Desktops

The kdebase package is part of the group User
Interface/Desktops. You can use the group name to
select the packages that you're interested in. To find
all the games installed on your system (or at least
those games installed with RPM), use this command:

$ rpm -qg "Amusements/Games"
tuxracer-0.61-23
chromium-0.9.12-24

- z a To display a list of all the RPM group names on
A your system, type in the following command:

$ rpm -ga --gf "%Z{GROUP}\n" | sort -u

In addition to the queries shown in Table 16-1, here
are a few combinations that we find particularly
handy:

To Do This

Use This Query for Installed Packages

Use This Query for RPM Package Files

Display the package version number rpm -q package-name rpm -qp filename.rpm
Display the package digest rpm -qi package-name rpm -qpi filename.rpm
(a summary of the package content)

Display the prerequisites for the pm -qR package-name rpm -qpR filename.rpm
package r

Display the list of files installed rpm -ql package-name rpm -gpl filename.rpm
by the package

Display only documentation files rpm -qd package-name rpm -qpd filename.rpm
installed by the package

Display only configuration files rpm -qc package-name rpm -qpc filename.rpm

installed by the package




v rpm -qf filename

This query displays the name of the package that
owns the given file. Use this query when you run
into a file and you don’t know where it came
from. You have to include the complete path-
name of the file that you're interested in, not just
the filename.

¥ rpm -qa --last | head -n 10

This query displays the names (and install dates)
of the ten most-recently-installed packages.

V¥ rpm -qa | grep -i name

Use this query to locate an installed package
when you don’t know the exact spelling of the
package name. (The -1 option tells grep to do a
case-insensitive search.)
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Creating a Package Index

v Name of the source RPM: Most packages are
built from a source RPM. The source RPM con-
tains the source code for the package.

v RPM size

Some open-source software packages are dis-
tributed for noncommercial use only. Check
the information digest to be sure that you're

not violating the license.

Creating a Package Index

When you download a distribution from the Web
site, you typically download a set of disc images.
The standard Fedora distribution takes four CDs
(unless you want the source code, too — in which
case, it takes eight). The Fedora distribution con-
tains lots of files . . . 300,682 according to our latest

questlnq Inf ormation distribution. What if you need to know which disk

just two or three of them are on?
Every RPM package includes a digest. Here’s a run- J

down of the information included in a typical digest
(not all packages include every item that we list
here):

Fortunately, Linux makes that information readily
available and easy to store. With just a few easy
steps, you can create a complete catalog that con-

v Package name: A package whose name includes
devel is meant for developers. A package whose
name starts with /ib doesn’t do anything all by
itself; it adds features to other packages. lib-
packages are typically prerequisites for other
packages.

Version number
RPM build date

Author or vendor’s name

X Y % X

Project Web site: The project Web site is a great
place to look for more documentation, add-ons,
and ways to commune with other users.

\

Product license type

v Product description

tains a list of the CD contents. After you make the
index, you can open it with a text editor (like Kate)
and search for what you need.

E Creating (and saving) a package index will
- («a save you time whenever you need to install a
& new package: You won’t have to search
through all the CDs for the one you need.

To create a package index for the Fedora distribu-
tion, follow these steps:

1. Open a terminal window and give yourself
superuser privileges:

$ su
Password:
$

2. Insert and mount the first install disc:

# mount /dev/cdrom /mnt/cdrom
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3. Move to the RPMS directory:
# cd /mnt/cdrom/Fedora/RPMS

4. Enter the following command:

# for name in*.rpm

This command starts a for loop: The bash shell
executes each command in the loop a number of
times. The variable $name holds the name of the
next package file each time through the loop.
When you press Enter, the shell displays a differ-
ent prompt to tell you that you're in the middle
of a complex command.

5. Next to the new prompt, enter the next line of
code and press Enter:

> do

6. On the next line, enter this command:
> rpm -gpi $name >> ~/DiscOne

This command displays the digest from the pack-
age file ($name) and appends the output to the
file ~/DiscOne.

7. Then enter this:
> rpm -gpl $name >> ~/DiscOne

This appends the name of each file in the pack-
age to the end of ~/DiscOne.

8. Enter done and press Enter.

If you have more than one install disc, repeat this
sequence for each disc (but change the name of the
output file to ~/DiscTwo, ~/DiscThree, and so on).

The procedure to create a package index is
similar for the SuSE or Mandrake Linux distri-
butions. Just substitute the appropriate file and
directory names.

This sequence of commands takes a while to com-
plete, but when it’s done, you have a file in your
home directory that you can use over and over. To
find the files you need, just open the package list
with the editor of your choice, and search.

Ouerying for Prerequisites

Before installing an RPM package, it’s handy to know
what other packages you’ll need to install at the
same time. The prerequisites can vary from needing
a specific version of the Linux kernel, to needing
some pretty exotic libraries.

B»(ﬂ
&

To save yourself time and grief, query your
RPM package for its dependencies before you
install it. If you need a library file that hasn’t
been seen in recent history, or 20 or 30 other
obscure files, it might be quicker to find a
piece of software that’s not so needy.

To query an RPM package for its dependencies, use
the following command:

$ rpm -gpR name.rpm

Run the command on Webmin, and the result looks
something like this:

$ rpm -gpR webmin-1.121-1.noarch.rpm
/bin/sh
/usr/bin/per]

You can see that Webmin needs a bash shell and
perl to install and run properly. These are easy
requirements — you can find these two common
packages on most distribution discs!

Don’t Put That in Your Drive;
VYou Don’t Know Whevre
That'’s Been!

Everywhere on the Web you see them . . . RPMs just
waiting to be grabbed. But how do you know what’s
in them? Should you really be downloading things to
your safe and secure system without at least looking
at them first?
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You can use rpm with a remote FTP site to query for
the contents of a remote package. After you see the
contents, you can decide if it’'s something worth
bringing home.

Just remember, if someone really wants to be
malicious and change filenames and mask cre-
ation information, he or she can. chroot jails

can be a big help in isolating programs you
want to try but don't trust completely (see
Technique 58 for more information).

Usually, downloads from the Web come from an FTP
or HTTP server. To perform a remote query on an
FTP server, use this command:

$ rpm -ql ftp://ftp.example.com/path.rpm
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To perform a remote query on an HTTP server, enter
the following command:

$ rpm -ql http://www.example.com/path.rpm

These queries are straightforward. If you need to,
you can include user names and passwords, just like
you would in a normal URL. See Technique 14 for
more information about downloading from Web
servers or FTP servers.

In Technique 18, we show you how to verify a pack-
age’s digital signature before you install it. We also
show you to find out whether the files installed

by a given package have been changed since you
installed them — a great way to watch for tampering
fingers wandering around on your computer.



Installing Made
Easy with RPM

Technique

Save Time By

+* Using RPM at the com-
mand line for speedy
installations

v~ Using RPM at the com-
mand line to remove
unwanted programs

v~ Using RPM with a graphi-
cal interface for a friendly
installation

v Installing from media (CD
or DVD)

ing RPM packages (that is, software packages installed with the rpm
command). Here’s where we share how this handy trick is done.
This is a good technique to bookmark because you’ll be using it a lot.

Throughout the book, we tell you to see Technique 17 for help install-

RPM (the Red Hat Package Manager) works great at the command line or
with a graphical interface. The command line gives you raw speed and
power, but it’s not as friendly as a browser-based interface. Fortunately,
you get to choose the method that you prefer.

RPM also makes quick work of uninstalling programs — no more lost disk
space or time wasted trying to chase down all the program files. With
one command, you can erase programs that are no longer used or don’t
live up to their initial promises.

In this technique, we show you how to use RPM to install new software at
lightning speeds. Other package managers are available, but RPM is the
standard method for installing software on Linux systems. We don’t want
to give you the impression that RPM is the only way to install, but for
speed and simplicity, RPM is a good choice.

Dissecting an RPM Package

An RPM package is a collection of files and (usually) a few scripts that
run whenever you install or remove the package. You can peek inside
an RPM package with the command rpm -qp1 package-name (we show
you some other handy RPM queries in Technique 16).

The name of an RPM package tells you a lot about what'’s inside it. For
example, most Linux distributions include two related packages named
kdeedu-3.1.4-1.1386.rpm and kdeedu-devel-3.1.4-1.7386.rpm. The nam-
ing convention for RPM packages is name-version-platform.rpm. In the
first package, the name of the package is kdeedu, the versionis 3.1.4.1,
and the platform is 1386. The second package is named kdeedu-devel and
shares the same version number and platform. Here’s how you use each
part of the package name:



v Name: This part is how you refer to the package
after it’s been installed. For example, if you install
the kdeedu-3.1.4-1.1386.rpm package file and
later want to remove it, you specify only the
kdeedu part of the package name.

v Version: This number is used to compare two
versions of the same package — the higher the
version number, the newer the package.

v Platform: This part tells you which CPU the
package was built for. An i386 (Intel 80386) pack-
age will run on all Intel 80386, 80486, and Pentium
CPUs (and compatible CPUs like the Athlon). An
i686 package will run on Pentium CPUs but may
not work on older Intel CPUs. You’ll also run
across PPC (PowerPC Macintoshes and IBM RISC
computers) packages; you can’t use these unless
you have a Power PC CPU. You may also see
packages built for the noarch platform. noarch
packages are not CPU-dependent. A noarch pack-
age is typically a program written in a portable
language, such as Java or Python, or it may sim-
ply be a collection of text files.

The kdeedu and kdeedu-devel packages are related.
The kdeedu package installs the programs and docu-
mentation you need to run KDE Education programs;
kdeedu-devel installs the files that you would need if
you wanted to develop (that is, alter and rebuild) the
KDE Education programs. The -devel on the end of
the package name is your clue that an RPM package
is meant for developers rather than users.

Not all package names follow the conventions that
we’ve described, but the vast majority do.

Using RPM at the
Command Line

Using RPM at the command line to install a program
is an easy and straightforward process. As an exam-
ple, we explain how to download and install Webmin
in this section. Webmin is a great tool that we refer
to in several other techniques.
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tration chores. It's a browser-based tool that can
help you manage users, create disk partitions,
restore from backup, and more. Check it out.

If you aren’t sure about the pedigree of the
package that you're installing, see Technique 18
to find out how to trace the lineage of packages

that come from dubious sources. Technique 18
explains how to use digital signatures to ensure
that a package hasn’t been tampered with. A
digital signature also ensures that a package
comes from the person who claims to have
created it in the first place.

B

)

? Use Webmin to manage your system adminis-

&

To download and install Webmin, follow these steps:

1. Open your Web browser and surf to

www.webmin.com

2. In the upper-right corner of the screen is a link
labeled RPM. Click the link to open a download

page.
3. Click a Download site near you.

The Download Manager window opens.

4. Click Save to start the download and then go
make a quick cup of coffee. . ..

5. Open your terminal window and navigate to
the directory holding your new download.

The directory name is displayed in the status
bar of the Download Manager.
Give yourself superuser privileges with the

su command.

6.
7. Type in the following command:
rpm -Uhv webmin-1.121-1.noarch.rpm

- this is to type the first few letters and then

z The easiest way to enter a long filename like
-
press Tab. (See Technique 5 for details.)

&

8. Press Enter.

After a short delay, rpm informs you that Webmin
is installed.
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When you install Webmin, you see a message
@ like this: You can now login to http://
Tocalhost:10000/. That's the URL of the

mini-Web server that Webmin installed on
your system. Jump to that URL in your
favorite browser, and you're connected to
Webmin. Check it out!

If you try to install a package that requires
other packages, rpm tells you about it. Check
the notes on the download page. If the devel-
oper is friendly, he or she will tell you what you
need and where to find it. See Technique 18 to
learn about a tool (Synaptic) that helps resolve
interpackage dependencies automatically.

Removing RPMs

RPM packages are just as easy to get rid of as they are
to install. To remove a program installed with RPM,
open your terminal window, give yourself superuser
privileges, and issue the following command:

rpm --erase package_name

g To find the package name to erase, look at the
e («a file that you used to install the package. The
package name precedes the version humber
in the name of the package file.

If you're having trouble finding the package name for
the software you want to remove, see Technique 16.
In that technique, you find a whole mess of RPM
queries that you can use to track down packages
and the stuff that they install.

Flagging Down RPM

To put it mildly, the rpm command has a fon of
options. Some of the most useful flags are listed in
Table 17-1.

Technique 17: Installing Made Easy with RPM

TasLe 17-1: Hanoy RPM Fracs

Flag What It Does

=i Installs a new package, but displays an error mes-
sage if an older version is already installed

-U Installs a new package, upgrading an older version if
found

-e Uninstalls a package

-h Displays a progress bar while it’s working
-v Gives a bit more feedback while it’s working
7 Our favorite combination is -Uhv. That installs

- { <@ (or upgrades) a package, displays a progress
& bar, and displays an informative message if
something goes wrong.

Type rpm --help | more at the command
line for a quick view of all the flags and options.

Getting Graphic with RPM

Web-wide, open-source software is often distributed
in RPM form. We refer you to a lot of RPMs in this
book, but you’ll no doubt be surfing and finding
more timesavers daily.

Fedora, Mandrake, and SuSE each come with their
own tools for managing RPM packages included on
the distribution media. In the sections that follow,
you'll find step-by-step directions on how to use
each distribution’s package management tool.

Quick installations from distribution media with
Fedora's Package Manager

Adding packages from the Fedora distribution media
(CD or DVD) is easy. To install a package from your
Fedora disc, follow these steps:

1. Put the DVD or CD in the drive and wait for
the disc to mount. Depending on your current
user privileges, you may be prompted for a
password.



The Add or Remove Packages window opens, as
shown in Figure 17-1.

= Package Management [=I=])=]
=
Add or Remove Packages ]o“

Install packages from 'Fedora Core 1'

‘ #8 Cancel ‘ ‘ < Back | | bﬁumard‘

¢ Figure 17-1: The Add or Remove Packages window.

2. Click Forward.

Fedora searches your system to see which pack-
ages are already installed. Then the Add or
Remove Packages detail window opens, display-
ing the current status of your system packages,
as shown in Figure 17-2.

=
Add or Remove Packages 15

X Window System [35/39] Details

J Install this group of packages to use the base graphical (X)
{‘( user interface.

GNOME Desktop Environment [39/42] Details

e GNOME is a powerful, graphical user interface which
includes a panel, desktop, system icons, and a graphical
file manager.

KDE Desktop Environment
o> KDE is a powerful, graphical user interface which includes
IE\ "3 apanel, desktop, system icons, and a graphical file
manager.

Applications

Editors [2/6] Details ||

Total install size: 2,668 Megabytes

[14/16] Details

‘ #8 cancel ‘ ‘ < Back | | bﬁorward‘

¢ Figure 17-2: The Add or Remove Packages detail window.
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3. To change the packages that are currently on
your system, either check (to install) or
uncheck (to remove) the box next to a package.

To the right of the checked package names is a
fraction that represents the number of programs
installed and how many programs are available
in that package.

The packages with unchecked boxes to the left
of their names aren’t installed, but contain pro-
grams that you can install. To view the contents
of a package, click Details to the right of the
package listing, and a dialog opens, showing the
detailed contents of the package you've chosen
(see Figure 17-3).

[~ | ; Games and Entertainment Package Details [x]

A package group can have both standard and extra package
members. Standard packages are always available when the
package group is installed.

Select the extra packages to be installed:

~ Extra Packages

Maelstrom - A space combat game.

tuxracer - Tux Racer.

gnome-games - GNOME games.

freeciv - The Freeciv multi-player strategy game.

kdegames - K Desktop Environment - Games

xboard - An X Window System graphical chessboard.

chromium - Chromium B.S.U. is a fast paced, arcade-style space shooter.

[#] joystick - Utilities for configuring most popular joysticks.

Package Information

Full Name: None
Size: None

Close

¢ Figure 17-3: The Package Details dialog.

The changes you make to the check boxes repre-
sent the status of your system packages after the
update is complete.

4. After you've identified the packages you want
to install (or remove), click Forward.

A list of changes is displayed, as shown in
Figure 17-4.
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Package Management

Package Installation Overview

23 packages are queued for installation

This will take 210,032 Kilobytes of diskspace.

Packages to be Installed =
arts-devel-8:1.1.4-3.1386 1,124 Kilobytes
cdparanoia-devel-0:alphad.8-18.i1386 140 Kilobytes
cups-devel-1:1.1.19-13.i386 364 Kilobytes
kdbg-1:1.2.9-1.i386 1,096 Kilobytes
kdebase-devel-6:3.1.4-6.i386 320 Kilobytes
kdegraphics-devel-7:3.1.4-1.1386 92 Kilobytes
kdelibs-devel-6:3.1.4-4.i386 94,532 Kilobytes| |
kdenetwork-devel-7:3.1.4-1.i386 372 Kilobytes
kdepim-6:3.1.4-1.i386 8,816 Kilobytes
kdepim-devel-6:3.1.4-1.1386 180 Kilobytes
kdesdk-0:3.1.4-1.1386 8,096 Kilobytes
kdesdk-devel-0:3.1.4-1.1386 128 Kilobytes
'

et Aot a aaiane BV |

| 8 Cancel ‘ ‘ < Back | | bEnrward|
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these steps to install an RPM package from the SuSE
distribution media with YaST:
1. Open the Main Menu and choose System=>YaST.
Enter your root password if prompted.
2. Click Install and Remove Software.

3. Use the arrow to the right of the Filter field to
open the drop-down list box and choose
Package Groups.

The window displays a list of the available and
installed RPM packages, as shown in Figure 17-5.

R T — e T R

Fie Padage Eximm Hep

Faur | Pacage G P St L

-

* Figure 17-4: The Package Installation Overview dialog.

5. Click Forward.

Fedora goes to work, upgrading your system. If
everything goes well, you see a screen telling you
the package update is complete.

6. Click Finish.

One of the nice features of the Add or Remove
Packages tool is that it automatically resolves inter-
package dependencies for you (the command line
rpm command doesn’t). One of the not-so-nice fea-
tures of Add or Remove Packages is that it only
works with packages distributed on the Fedora dis-
tribution discs. In Technique 19, we show you how
to automatically resolve interpackage dependencies,
even for packages that you download from the Web.

You can also start Fedora’s Package Manager
e («a from the Main Menu. Open the Main Menu

& and choose System Settings—>Add/Remove
Applications.

Using SuSE’s package manager to
your advantage
The SuSE Linux distribution comes with a powerful

package manager called YaST (Yet another Setup
Tool). YaST makes adding software a snap. Follow

[
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* Figure 17-5: The YaST package manager.
The package manager window features four panels:

v The upper-left panel displays package groups.
Use the tree control to browse through the
groups and subgroups. When you highlight a
group in the tree control, the panel in the upper
right displays the packages within that group.

The filter selector enables you to change the
views in the upper-left panel: You can choose
from selections, package groups, search, and
installation summary.

v Use the Package Summary panel in the upper-
right corner of the window to view a list of
packages.



@ To the left of the package name is a check
(«a box. This is not an ordinary check box: Each
time you click the check box, it displays a new
icon. A check mark in the box means that the
package will be installed. A trash can means it
will be removed. The (slightly cryptic) update
symbol will check for package updates.

&

v The lower-right corner of the screen displays a
tab-controlled dialog with information about the
currently highlighted RPM package. Choose from
the tab controls to view information about the
package and its dependencies.

v The lower-left corner of the screen contains a
handy bar graph, displaying your current disk
usage.

To add a new RPM package, follow these steps:

1. Select the check box to the left of the package
name in the Package Summary panel.

) Want to install a package quick, just to test the
e- { <@ technique? May we recommend tuxracer. It's
& lots of good clean fun. You'll find it in the
Games category.

2. Click the Check Dependencies button.

A dialog opens, verifying that all package
dependencies are okay.

3. Click the OK button.
4. Click the Accept button in the lower-right cor-

ner of the screen.

A screen opens, displaying the installation progress.
YaST takes it from here, adding your new software
and updating the system.

Using Rpmdrake to install from media

The Rpmdrake package installer included with
Mandrake makes it easy to install RPM packages from
the distribution media. Just follow these steps:
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1. Open the main menu and choose System>
Configuration=>Packaging=>Install Software.

2. Enter your root password if prompted.

The Rpmdrake package installer opens (see
Figure 17-6).

(@ Software Packages Installation
2

Find: | innames Search

@ fiandrake choices,

() All packages, alphabetical ® Normal information

All packages, by group 2 Maximum information

b Development

[ Graphical Environment
[ server

b Workstation

Help Selected: 0 MB / Free disk space: 163 MB Install Quit

¢ Figure 17-6: The Rpmdrake package installer.

3. Click the All Packages Alphabetical option
button to display a list of the packages on
your installation media.

Highlight a package name in the list to see
detailed information about the package in the
right panel.

4. Click the check box next to the name of the
package you want to install (see Figure 17-7).

If other packages need to be installed to satisfy
the package’s dependencies, a dialog opens, ask-
ing you to verify their installation.

5. Click the Install button to add the new package.

Rpmdrake takes it from there, installing the new
RPM package on your system.
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f@ Software Packages Installation
P

Find: | in names = Search

Mandrake choices

® All packages, alphabetical ® Normal information

All packages, by group e Maximum information
WEVS £ £-Imak
tmake-1.10-2mdk
tmdns0.1-12mdk
toppler-1.0.5-1mdk
transfig-3.2.4-3mdk
tree-1.4b3.1mdk
trophy-1.1.3-3mdk

a |Name: tuxracer
Version: 0.61-15mdk
Size: 12000 KB

Summary: Tux Racer

Description: Tux Racer is a simple OpenGL-based racing
game featuring Tux. The object of the game isto slide down
a snowe- and ice-covered mauntain as quickly as possiole,
avoiding the trees and rocks that will slow you down

tuxracer-0.61-15mdk

tvfonts1.1-1mdk
tutime-0.9.12-2mdk
ucd-snmp-utils-4.2.3-8mdk
uirm-0.2.8-3mdk

OoooDoogoOoo0o0oon

uirm-applet.0.2 8-3mdk

umb-scheme-3.2-20mdk -

Help Selected: 12 MB / Free disk space: 163 MB Install Quit

* Figure 17-7: The YaST package manager.

Installing from your Konqueror browser

With the Konqueror (KDE) browser, you can install
RPM packages with just a couple of clicks from the
comfort of your browser window. You can use the
Konqueror browser to install RPM packages down-
loaded from the Web, or from disk.

If you're using Fedora, follow these steps:
1. Open your Konqueror browser and navigate to
the directory holding the . rpm file.
2. Double-click the package filename.
In a snap, the Package Manager walks you
through the installation.
Follow these steps if you're running SuSE:
1. Open the Konqueror browser and surf to the
file’s location.

2. Click the package’s icon to view a description
of the package’s content.

Technique 17: Installing Made Easy with RPM

Change to the Files tab to see a list of the files
included in the RPM package.

3. Click the Install Package with YaST button.

Enter the superuser password if prompted.

YaST takes it from there, and installs your package!

If you're a Mandrake user, follow these steps:

1. Open the Konqueror browser and move to the
directory containing the RPM package.

2. Right-click on the package’s icon, and choose
Software Installer from the pop-up menu.

3. Enter your root password if prompted and
click OK.

A message dialog opens, asking if you would like
to install the software package on your computer
or just save the file.

If you need additional files to satisfy the
dependencies of the package, you'll be
prompted to accept their installation as well.

4. Click the Install It button.

A progress bar opens, and the package is installed.
That’s all there is to it!

Be sure you're getting RPM packages from a
reputable source. A not-so-friendly but crafty
programmer with an axe to grind could poten-

tially infect an RPM package with a virus and
do mega-harm to your system. Technique 18
shows you how to verify that a package comes
from the person who claims to have built it. Be
sure to perform backups on a regular basis if
you're doing a lot of downloading (see
Techniques 49 and 50 for more information
about backing up your system).
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Technique

Save Time By

v~ Updating rather than
installing your software

v~ Verifying your system
integrity

+~ Keeping an eye on file
ownership

v~ Determining whether
a package has been
tampered with

tion and query features of RPM (the Red Hat Package Manager). In this
technique, we introduce you to some of the eclectic (but handy) fea-
tures that often go by the wayside — verify and update.

In Techniques 16 and 17, we show you the fast (and powerful) installa-

RPM just might be your system’s best friend. After all, it knows more about
your system than anyone. RPM maintains a database of information about
the packages installed on your system. By comparing that database to
the current state of your system, RPM can tell you if a package has been
altered after you installed it. The --verify feature can help you detect
intruders, users trying to do things they shouldn’t be doing, or configura-
tion problems just waiting to ruin your weekend.

RPM can also verify the digital signature (and integrity) of a package
before you install it to see if the package has been tampered with. You
can save yourself hours of misery by keeping your system safe from
potential Trojan horses. If the key signature doesn’t match, you don’t
install it.

In this technique, we walk you through some RPM features that you may
not be familiar with. Some of these features are great timesavers — you
just need to know about them.

Saving Time with --upgrade

When you add a new package to your system, you can use rpm --install
to install or rpm --upgrade to upgrade. We recommend going the upgrade
route rather than the install route. rpm --install fails if an older version

of the package is already installed, but rpm --upgrade upgrades an exist-

ing package or installs a new one, whichever is appropriate.

To use any of the RPM features that modify the rpm database —
@ including installing and updating — you need to hold superuser privi-
leges. If the rpm command displays a cryptic message (such as cannot

get exclusive lock or cannot open Packages index), check
your privileges.



116

When you use --install, rpm first looks at your sys-
tem to see if the package is already installed. If it is,
rpm complains about file conflicts. (And if you look
very closely, you also see a message that states the
package is already installed — a message that’s kind
of hard to see among all the other complaints.)

When you use --upgrade, rpm checks to see if the
package is installed and, if so, compares the
installed package to the version you’re trying to
install. If you're installing a more recent version, rpm
upgrades to the more recent version. If you're trying
to install an older version, it tells you that your cur-
rently installed software is more recent than the
copy you're trying to upgrade to, and quits. If the
package is not currently installed on your system,
rpm installs it.

Here’s our favorite command line for installing new
software:

# rpm --upgrade -vh filename.rpm

You can use this command to do initial installs or to
upgrade versions. bash doesn’t care which because
it knows that your intention is to get the most recent
copy of the program on your system as quickly as
possible.

] An easy timesaver is to use the shortcut ver-
e- { -a@ sion of the upgrade command to install RPM
& packages, # rpm -Uvh filename.rpm.

All the command line options that work with
--install also work with --upgrade. Check out
the man page (man rpm) for a complete list.

Verifying Your System

When you install a package, RPM records detailed
information about the package content in a data-
base. The database includes information such as
expected file size, expected owner, and expected
permissions. RPM also stores an MD5 checksum
(effectively a fingerprint that uniquely identifies
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the file content; see the sidebar, “What’s this MD5
stuff anyway?”) for each file in each package. At
your request, RPM compares the information stored
in the database with the installed version of a given
package.

When you run the command rpm --verify package-
name, rpm searches through the list of files owned by
that package and compares the file as it exists on
your hard drive with the information stored in the
database. For each file, -verify compares the file’s
size, permissions, group and owner, modification
time, and MD5 checksum. RPM verifies that pack-
ages you've installed are still in good form and
haven’t been tampered with.

You can verify a single package, a group of packages,
or all the packages installed on your computer. If
your packages are clean, rpm --verify completes
without printing any messages. If rpm --verify finds
a file that’s out of whack, it displays a cryptic look-
ing string of characters that tells you what’s wrong.
The failure codes are listed in Table 18-1.

TaBLE 18-1: RPM --VERIFY FAILURE CODES

Code Meaning

S The file’s size differs from the expected value.

M The file’s permissions differ from the expected
values.

5 The MD5 checksum has changed — this one is

important because it means someone has tampered
with a file after you installed it.

D This file is a device-interface file, and the major
or minor device numbers differ from the expected
values.

L This file is a symbolic link but is pointing to the

wrong place.

U The file’s ownership has changed — watch this one.
A change in ownership can alert you to an intruder
who’s trying to gain extra privileges or to modify
files he (or she) shouldn’t modify.

G The file’s group ownership has changed.

T The modification time has changed.




We’ve purposefully damaged one of the files on our
computer just to see what --verify reports:

$ rpm --verify coreutils
S.5....7T d /usr/share/man/manl/yes.1l.gz

The failure codes tell us that the file has changed
size (S), its MD5 checksum is wrong (5), and the
modification time doesn’t match the value stored
in the RPM database (7).

Check out any inconsistencies that --verify uncovers
because they could indicate intruders or other prob-
lems waiting to bite you:

v The MD5 checksum value is like a fingerprint of
the data within a file. If the number changes, the
content has changed.

v If the user ownership changes, users might be
getting in and giving themselves privileges they
shouldn’t have.

v Likewise, a change in group ownership could
indicate an intruder.

v If the MD5 checksum has changed, but the modi-
fication time has not changed, an intruder may
be trying to cover his or her tracks.

To verify a single package, include the package name
on the command line, like this:

$ rpm --verify bash

You can also verify all the packages within a group:

$ rpm --verify --group "Amusements/Games"

To verify all the packages installed on your com-
puter, use the following command:

$ rpm --verify --all

Verifying your entire system takes quite some time,
but when you’re done, you'll have a very thorough
understanding of the state of your system.
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Reading the Tamper-Proof Seal

) The --verify command can take awhile to
& { @) complete. Start the command and let it run
) while you're in a meeting or when you go
home at night.

What's this MD5 stuff anyway?

MDS5 is a message-digest algorithm (in fact, MDS5 is a rather
uninspired acronym for message digest number 5). A mes-
sage digest is like a fingerprint that belongs to a chunk of
data. Two different chunks of data are highly unlikely to
have the same fingerprint (that is, the same MD5 check-
sum). MDS5 is cryptographically strong, meaning that it
would take an incredibly fast computer (or an astonishingly
brilliant mathematician) to come up with another chunk of
data with the same fingerprint.

A digest algorithm generates two different digest values for
two different files. A good digest program pays attention
not only to the characters in the file, but also to the ordering
of the characters in the file (so ab generates a different
checksum than ba).

When an RPM package is first created, RPM computes the
MD5 checksum of each file in the package. When you
install the package, the MD5 checksums are copied into
the RPM database. When you verify a package, RPM
recomputes the checksum of each file in the package (it
reads through the whole file and computes the checksum
again from scratch) and compares that checksum to the
value stored in the database. If the checksums are different,
the file has been modified.

Reading the Tamper-Proof Seal

When you get a new RPM package, whether from a
Web site or on a disc, you really have no guarantee
that it hasn’t been tampered with — that is, unless
you use RPM to verify its digital signature.

Just like the tamper-proof seal on a bottle of aspirin,
the digital signature is there to protect you from
potential headaches. After all, you would never use
medicine from a bottle with a broken seal. A digital
signature ensures that a package was created by the
person (or organization) claiming to have produced
the package.
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When you install Linux from a CD or DVD, the disc
should include a public key from the packager. Every
package included in your Linux distribution is (or at
least can be) signed with the packager’s private key.
You can use RPM (and the public key) to verify each
package. When you download a package, look
through the project’s Web site to see if it makes a
public key available. If you find one, use it. (If you
can’t find a public key, e-mail the maintainers asking
them to sign their packages.)

In this section, we use the Fedora install DVD as an
example of how to import a public key and then use
that key to check the signature of a package — we
assume most of you have installation media. Not all
vendors include keys on their software, but it’s a
really good idea to run an integrity check if they do.

To verify the integrity of your Fedora disc, follow
these steps:

1. Open a terminal window and give yourself
superuser privileges.

2. Insert and mount either the DVD or the first CD
of the Fedora distribution, and move to the
cdrom directory.

$ cd /mnt/cdrom

3. Type the following command and press Enter:
$ rpm --import RPM-GPG-KEY

The --import command installs the public key
(RPM-GPG-KEY) into your RPM database. After it’s
there, RPM will use the public key to verify any
package you install that’s been signed with the
corresponding private key. See Technique 28 for
more information ahout how digital signatures,
public keys, and private keys all fit together.

Technique 18: Getting Comfortable with RPM

Depending on your distribution, one key or
many keys may exist. If multiple keys exist,
install them all before checking the package’s
signature. The easy way to do this is to use
rpm --import RPM-GPG*.

7
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&

4. Move to the directory of the package you want
to verify and press Enter. For our example,
enter

$ cd /mnt/cdrom/Fedora/RPMS

5. Enter the following command:
$ rpm --checksig bash

6. Press Tab to autocomplete the package name
and then press Enter.

rpm displays a message that looks something like

this:

bash-2.05b-31.1386.rpm: (shal) dsa shal
md5 gpg OK

From this message, you know that your bash pack-
age is OK. If the result set returns a NOT 0K or MISSING
KEYS, you should at least question the integrity of the
package. Some system administrators won'’t install
software that doesn’t come with proper digital signa-
tures to avoid any potential problems.

Some open-source software that has integrity
doesn’t have keys. We wish it did because the
software is good, reputable, and worthy of
downloading.

In our example, the key was distributed on the disc
with the software. Often, the keys are available at
the project’s Web site, as a separate download. If you
have trouble finding the key, consider e-mailing the
site administrator.
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Technigite  Synaptic

Save Time By

v Automating software
updates

v Using Synaptic and apt
to resolve RPM package
dependencies

+~ Using a software reposi-
tory to find tons of open-
source software

v~ Adding repository keys to
your system key ring

favorite software will likely include new features, fixes for old bugs,

and most importantly, fixes for security vulnerabilities. Open-source
software evolves astonishingly fast. Given that most, if not all, of the soft-
ware on your Linux computer is of the open-source variety, keeping cur-
rent can be quite a chore. Although you could keep a list of your software
packages and check the sites regularly for more recent versions, we know
a better way.

K eeping your software up-to-date is important. A new release of your

apt (Advanced Package Tool) is a handy tool that can save you tons of
time. apt by itself is good; apt coupled with Synaptic is even better.
Synaptic is an attractive, friendly wrapper around the apt command line
tool. Synaptic knows how to check your installed RPM packages against
the most recent versions, download any updates, and automatically
resolve package dependencies.

If you've installed many packages with RPM, you know what dependen-
cies are: When you install a new software package, that package may
require (or depend on) other packages. If you use RPM by itself, you have
to satisfy a package’s dependencies before you can install the package
(that is, you have to install all the other software required by the package
that you really want to install). Technique 17 explains how to use RPM
from the command line. Quite often, a dependency has dependencies of

its own. The chain of dependencies can get very long, very fast. With
Synaptic, the frustration and time lost tracking down and installing all the
program dependencies are gone — Synaptic handles the process for you.

In this technique, we introduce you to Synaptic. Installing and updating
your software has never been so quick or easy.

Setting Up Synaptic and apt in a Snap

apt is a wrapper around the command line tool, rpm. Synaptic is a graphi-
cal wrapper around apt. You already have rpm (it’s a fundamental Fedora
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component), but you need to install apt and
Synaptic before you can use the three tools together
to make quick work of package management.

If you're using SuSE, use Google to search for the
most recent versions of the apt and synaptic RPM
packages. You'll need two packages — the apt pack-
age and the synaptic package.

To download and install apt with Fedora, follow
these steps:

1. Open your favorite browser and surf to

apt.freshrpms.net

2. Click the link to Fedora Linux 1 (rpm 4.2.x).

This moves you to the Index of /pub/freshrpms/
fedora/linux/1/apt.

3. Click the link to download the most recent
RPM package. Right now, that is

apt-0.5.15cnc3-0-1.fr.i386.rpm

The Download Manager opens (assuming that
your browser offers a download manager).

4., Save the RPM package to your desktop.

5. Close the Download Manager and minimize
the Web browser (you’ll be using it again in a
minute).

Click the RPM Package icon on the desktop.

N S

If you’re not already logged in as the super-
user, a query window opens, prompting you
for the root password. Enter the password
and click OK.

The RPM graphical installer opens, telling you
that the system is being prepared for package
installation.

8. When the preparations are complete, click
Continue.

The apt package installs.
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Now, download the RPM package for Synaptic:

1. Reopen your browser and surf to

dag.wieers.com/packages/synaptic

2. Click the download link for
synaptic-0.45-0.rhfcl.dag.i386.rpm

3. Save the package to your desktop.

4. Close the Download Manager and the browser
window, and return to the desktop.

4. Click the desktop icon for the Synaptic RPM
package.

The graphical installer begins. Again, you may be
prompted for the root password.

Now that you have apt and Synaptic installed, you're
ready to update your system.

Keeping Up-to-Date with apt
and Synaptic: The Basics

Using apt with Synaptic is a quick and easy way to
keep your system software up-to-date. To run Synaptic
and do a package update, follow these steps:

1. Open a terminal window and give yourself
superuser privileges with the su command.

2. Type the following command and press Enter:
# synaptic

Synaptic starts and, after a short delay, displays
the packages currently installed on your com-
puter (see Figure 19-1). The package list is sorted
by category and displayed in a tree-type control
panel in the middle of the screen. Click the little
arrow to the left of a category to view the pack-
ages within that category.

When Synaptic starts, it displays all the packages
available at the default repository (you can add
more repositories later).
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packages for which newer versions are
available.

» Broken: Show packages that are currently
installed but have unsatisfied dependencies.

» Programmed Changes: Show packages
selected for installation, upgrade, removal,
or repair.

» New in Archive: Show packages that have
just been added to the archive list on your
computer.

[ One of the most useful features is the
s («a Upgrad(e)able filter. Select Upgradable from
the Show drop-down list and then click a tree
control to see the outdated packages in that
category (see Figure 19-3).

é

¢ Figure 19-3: Outdated packages.

4. When you find a package that needs to be
updated, click the package name to highlight it.

5. Click the Upgrade button (in the lower-right
corner of the screen).

g include another package in its installation. If
this is the case, you need to authorize apt to
remove the old package before it can update

to the new version.

Z Sometimes a package might be changed to
<8}

&
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In some cases, the package that needs to be
6 removed isn’t included in the new package,
but it's blocking the installation anyway. You

may need to reinstall a package after the
updating is complete.

6. Depending on the package you're updating, a
dialog may appear that shows other changes
that you must authorize. If the dialog does
appear, review the additional changes and
click the Apply button.

For example, the new version of a package may
have new dependencies that were not required
by the currently installed release. Or, you may

have to upgrade other packages at the same time.

The packages to be upgraded are highlighted in
the list, as shown in Figure 19-4.
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¢ Figure 19-4: Highlighted packages are ready to upgrade.

7. To carry out the upgrade (and any related
changes), click the Execute button (on the
toolbar).

The Summary dialog opens (see Figure 19-5).

8. Click the Proceed button in the Summary dia-
log to continue.

The new versions are downloaded, and the
upgrade begins — pretty simple.
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D summary

80 packages were kept back and not upgraded;
1 package will be upgraded;

328 will be freed after finished.
91.4kE need to be downloaded.

Package changes
+ To be upgraded

[ To be kept back

[] Perform package download enly.

Show Details | | Cancel | | Proceed

¢ Figure 19-5: The Summary dialog.

Upgrading Your Entire
Computer

Synaptic can install and upgrade individual pack-
ages, but its real power lies in its ability to upgrade
your entire system with just a few quick clicks of the
mouse. Synaptic offers two system-update modes:

v Dist Upgrade: If you want to upgrade to the most
recent versions of all the packages currently
installed on your system, click the Dist Upgrade
(Distribution Upgrade) button on the toolbar.
Dist Upgrade updates all the packages on your
computer and adds any new software needed to
satisfy program dependencies.

v Upgrade All: If you're short on disk space, use
the Upgrade All button to upgrade only those
packages that can be freshened without installing
extra software required by new dependencies.
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Synaptic can install new packages too. With so many
packages available, the choices can seem overwhelm-
ing. Fortunately, Synaptic has a few tools that can
help you narrow down the package list to a more
manageable size. You can also find out a lot about a
package before you download and install it on your
computer.

Changing repositories

Synaptic works its magic by connecting to software
repositories scattered around the Internet. Synaptic
comes preconfigured with the information required to
connect to a number of repositories, and it’s ready
to use the repository that’s right for a Fedora distri-
bution. Most repositories organize packages into
types and sections. The two most frequently seen
types are rpm (installable packages) and rpm-src
(source code for package): Unless you want to build
your software from source code, stick with the rpm
type. Sections are more diverse. At any given reposi-
tory, you may see sections such as testing, stable,
and updates. The section name gives you some idea
of how safe the packages are within that section.
Stay away from the testing section unless you're in
an adventurous mood.

By default, Synaptic enables only the “safe” sections.
You may need to make changes to the repository list
if a package that you want to install (or upgrade) can’t
be found in the preconfigured sections. When you
enable a section, the Packages list shows new pack-
ages distributed from that section (hopefully, the
Packages list contains the package you’re looking for).

To enable a new section, follow these steps:

1. In Synaptic, choose Preferences->Repositories.

A dialog appears, showing the repositories that
Synaptic currently knows about.
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2. Enable a section by checking the box in the
Enabled column to the left of the reposi-
tory URL.

offer packages for your specific Linux distribu-
tion. However, the other repositories include
some great packages that might be worth
checking out when you have some time to
spare.

2 It's safest to choose from the repositories that
<}

3. Click OK to close the repository list, and then
click Update List to retrieve a list of available
packages.

This process takes a minute or two, depending
on your Web connection speed. Synaptic dis-
plays a pop-up as it retrieves index files.

Now when you open a package category, each
package is color-coded:

» The white ones are currently installed.

» The beige ones have just been added to the
list of known packages.

» The red ones are broken packages (installed
packages with unsatisfied dependencies).

» The mint ones are the packages you've
selected to install.

K/ .
- < a You can set your own color choices by choos-
A ing Preferences—>Preferences.

Viewing package details

Synaptic’s main package list can be a bit overwhelm-
ing because it displays so many packages. To narrow
your choices a bit, use the Show drop-down list to
filter out packages in different ways. Our favorite fil-
ter is Not Installed — that filter shows all of the
packages just waiting to fill up your hard drive (see
Figure 19-6).
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¢ Figure 19-6: Tons of free software.

With so much free software to choose from, it’s a
good idea to check out the package details before
you download.

When you highlight a package, the frame at the bot-
tom of the screen displays information about that
package. You can navigate this information by click-
ing the following tabs:

v Common: Contains a short summary of the
package — what section the program belongs
to and who maintains the software.

v Description: Shows a more detailed description
of the package.

v Dependencies: Shows a list of the other packages
required by the one you've selected. Any
dependencies shown in red are not currently
installed, but that’s okay; Synaptic automatically
resolves dependencies for you.

v Expert: Offers options for the adventurous —
usually alternative versions (which might be
untested).

Read through the package information care-
fully to decide if an alternative package is right
for you.
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Installing new packages with Synaptic

When you find a package that you want to install,
follow these steps:

1. Highlight the package name and click Install
Latest Version.

If you want to install more packages, highlight
each one and click Install Latest Version.

2. When you’ve finished selecting packages, click
Execute, and the installation begins.

Depending on the packages you're installing, a
dialog may appear that shows other changes that
you must authorize. If the dialog does appear,
review the additional changes and click the
Apply button.

For example, the new package may have required
other packages or updates to currently-installed
packages.

3. Click the Proceed button in the Summary dia-
log to continue.

The new packages are downloaded, and the installa-
tion begins — pretty simple.

T Technique 58 shows you how to set up a UML
jail. Resolving dependencies within a jail can
& be a time-consuming chore. Use apt and
Synaptic to resolve the dependencies for you.

Importing the Keys to
the Repository

Sometimes Synaptic prefers that you have the public
keys that were used to sign each package before it

allows you to install new software. It’s a good idea to
install the keys so they’re ready when you need them.



Each repository has its own set of keys, and you have
to hunt around the repository Web site to find them.
To download and install the keys to the primary
Fedora repository, follow these steps:

1. Open your favorite browser and surf to
freshrpms.net/packages.

2. Right-click the GPG Key Used to Sign All
Packages link. Save the file to the desktop.

Importing the Keys to the Repository ’2 5

3. Open a terminal window and give yourself
superuser privileges with the su command.

4. Use the following command to import the keys
to the repository:
# rpm --import /home/susan/Desktop/RPM-
GPG-KEY.txt

The keys to the repository are added to your RPM
key ring, where Synaptic can find them if it needs
them.
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etting up automatic
asks with Task Scheduler

diting existing tasks

reating an environment
or your automated tasks

Setting Up
Automatic
Services

updating Web site mirrors — are easy to automate. You can save

tons of time by creating automatic tasks that do your job without
any help from you. To help you automate these tasks, you have two
handy tools at your disposal: Task Scheduler and the Services
Configuration Tool.

ﬁ dministrative tasks — such as backing up, updating data files, and

Task Scheduler is a graphical interface that schedules programs to run
automatically with the program cron. Setting up jobs to run when net-
work demands are low can save time (and user frustration from the
bogged-down network). Task Scheduler has a nice interface and offers a
quick way to set up cron jobs.

In this technique, we’ll show you how to automate your work with Task
Scheduler.

Letting Task Scheduler Work for You

Task Scheduler is a graphical interface for cron (the Linux scheduling
tool). With Task Scheduler, you can set up recurrent downloads, backups,
or other system maintenance jobs to run at night (or when your network
load is the lightest).

Task Scheduler is part of the kdeadmin package (if you're using KDE,
make sure you've installed the kdeadmin package or you won't find Task
Scheduler in the KDE Menu). The Mandrake 10.0 Community Edition dis-
tribution does not include the kdeadmin package (although later editions
may) — if you can’t find kdeadmin in your distribution, you’ll have to
download and install it from the Web.

GNOME doesn’t have an official task scheduler yet, but if you Google for
GNOME and Task Scheduler, you should find a few options.



Before Task Scheduler will work, you need to start

the crond daemon. To start crond, follow these steps:

1. Open a terminal window and give yourself
superuser privileges with the su command.

2. Type in the following command and press
Enter.

If you're a Fedora or Mandrake user, use this
command:

# /sbin/service crond start

SuSE users should use this command:
# /etc/init.d/cron start

Scheduling a new task

After you've started the crond daemon, you're ready
to set up automated tasks:

1. To start Task Scheduler, open the Main Menu
and choose System Tools~>Task Scheduler.

The Task Scheduler window opens, showing a
summary of the scheduled tasks and their envi-
ronment variables (see Figure 20-1).

hd Task Scheduler [modified] BEE

Eile Edit Settings Help

& &

Tasks/Variables w | value
B Tasks

- Bvariables

| Description

| Ready.

¢ Figure 20-1: The Task Scheduler window.

If you're logged in as root, you see everyone’s
scheduled tasks. If not, you're privileged to see
your own tasks only.
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2. To add a new task, right-click the Tasks folder
and choose New.

The Edit Task window opens (see Figure 20-2).

AT Task - Task Schdular 7777 NIRRT
Comment: [ |
Enabled
[] silent
-~ Months —Days of Month — Daily

Caniary — |[1] (2] [3][#] [5][] [7]

(] Februziy IEI [] Run every day

[] march

| [22)[2] 8] 2] [ ] o] | ™" m

Llwar [o]

L1 June -Days of Week —————— E .

] July [] Monday

[] August [ Tuesday

Tl Sentember [] wednesday
[] Thursday

[[] October ) ~Minutes ———————————————

[C] November EZ:‘:’:“ E E

L_lID==sbes [ Sunday

¢ Figure 20-2: The Edit Task window.

3. To create a new task, fill in the following fields:
» Comment: Enter a descriptive name.

» Program: Enter the command you want to run.

It's a good idea to use the complete pathname
for a command, not just the command name.
That way, changes to your environment (your
$PATH variable in particular) won't affect sched-
uled tasks. For example, enter /usr/bin/wget
-r --mirror -k http://www.website.comto
update a Web site nightly. If you don't know the
complete pathname, use the Browse button to
find your program. Most of the commands are
in /bin, /usr/binor /usr/local/bin.
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» Enabled: Check this box to make the task
active. If the box isn’t checked, the task
won’t run.

» Silent: Check this box to turn off the logging
features.

» Months: Check the box next to each month
that you want the job to run.

» Days of Month, Days of Week, or Run Every
Day: You can choose when the task runs in
one of three ways. Choose the days of the
month that the job executes, or choose the
days of the week that the job executes, or
check the Run Every Day box to automatically
choose all the months, days, and dates.

» Hours and Minutes: Choose the hours and

Technique 20: Setting Up Automatic Services

It's hard to predict the environment in which
6 your scheduled tasks will run. Use full path-
names and define the environment variables

that you need. That also makes you more
immune to changes in the system configuration.

If you're scheduling a complex task (one that
involves running multiple commands), write
yourself a shell script and schedule the script
instead of a complex command line. It's much
easier to debug a script than a complex com-
mand line that resides somewhere in the Task
Scheduler’s database. Technique 10 has some
handy information about creating shell scripts.

Editing a task

minutes that the task should begin.

i
&
for when you really need it.

4. Click OK.

The new job is added to the Tasks list, as shown

in Figure 20-3.

(v Tack Scheduler 2

night when network traffic is low. The jobs will

z Set up network-intensive jobs to execute at
a
run faster, and you'll be saving the bandwidth

Eile Edit Settings Help

a &

Tasks/Variables w | value
EEE Tasks

‘- BVariables

[« S— || —]

‘- £2Update website mirror fusr/binfwget -r —mirror -k http:/fwww.conje|

l;Readv.

¢ Figure 20-3: The new task is added to the list.

5. If you’re done using Task Scheduler, click Save.
Or if you haven’t defined the environment vari-
ables, see “Adding environment variables,”

later in this technique, to do so.

If you need to go back and edit a task, open the Main
Menu and choose System Tools=>Task Scheduler. In
Task Scheduler, right-click the task (refer to Figure
20-3) and choose Modify from the pop-up menu.
When you’re done, click Save so that the scheduler
remembers the new settings.

Adding environment variables

Task Scheduler works in its own environment, so
you need to add any environment variables that
your task needs to run properly (such as $PATH).

To add or edit a variable, follow these steps:

1. Choose System Tools->Task Scheduler, right-
click Variables, and choose New from the pop-
up menu.

The Edit Variable dialog opens, as shown in
Figure 20-4.

2. To add a new variable, fill in the fields on the
dialog:

» Variable: Enter the variable name, or choose
from the most common variables in the drop-
down list.

If you don’t define the HOME , MATLTO, and
SHELL variables, they default to your normal
values. Change these variables if you want to
override the defaults.



The PATH variable holds the search path that

cron uses to locate your programs.

» Value: Enter the variable’s value.

» Comment: Enter a description of the variable.

» Enable: Check this box to make the variable
active. If the box is not checked, the variable

doesn’t take effect.

Click OK when you’ve completed this dialog.

Your new variable is added.

% Task Scheduler [modified] -

n |
=

Eile Edit Settings Help

Tasks/Variables w I\.l'alue !Descnptlcn

ATasks

& Variables T PR I Y I P T T
I Edit Variable - Task Scheduler =-0%

Variable: l— M= &

Value: |

Comment:

I |Adding new entry...

|®| Enabled

Cancel

* Figure 20-4: The Edit Variable dialog.
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4. When you're finished using Task Scheduler,
click the Save icon to save your changes and

then close the window.

Your newly scheduled programs will run without

any help from you!

] If you use a proxy server to access the
B> (@
b
quickly with Task Scheduler, as shown

Figure 20-5.

net,

wget can use the http_proxy variable to
speed up data transfers. Create the variable

in

% Task Scheduler [modified]

Eile Edit Settings Help

Tasks/Variables = | value !Descriptian

ATasks

Il Eclit Variable - Task Scheduler

Wariable: IthU_PfOXY =

&

Value: [192.168.0.1:0877

Comment: | ser the hrtp_proxy variable
speed up data transfers!

'|Addmg new entry...

(3] Enabled

o

Cancel

* Figure 20-5: Setting the http_proxy variable.
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Save Time By

v~ Using disk quotas to keep
resources in check

+~ Using system accounting
to monitor user activity

v+~ Watching program
activity with system
accounting

Productive )

s system administrator, you want to be sure that system resources
A are available when needed. Doling out resources to users that need

them and keeping track of the overall system performance are
important. Fortunately, tools exist that make it really quick and easy.

Imposing disk quotas is a quick and easy way to control precious system
resources. Define user quotas to limit the amount of disk space each user
can consume so you're sure that those who need it can get it.

Disk quotas are self-governing. After you've set up the quota (and a grace
period), Linux ensures that users can’t use up all your disk space. If you
need to know whether you've budgeted too little space for some users, a
quick glance at the disk quota report tells you how well users are staying
within their quotas.

The Linux system accounting package is a small collection of tools that
give you quick access to information about how your system is being
used. You can quickly determine which users are spending the most time
logged in and what resources they’re using. You can also spot programs
that shouldn’t be used at all.

In this technique, we show you how to control your system usage. You're
not being a control freak — you’re just ensuring that your users have
what they need to get their jobs done.

Reining In Resources with Disk Quotas

If you're the administrator of a multiuser system, you've probably
encountered disk hogs — users who download every game or graphic
they can find, keep a copy of every e-mail they’ve ever received, and
keep multiple copies of work in progress. Such users can cause major
disk clogs — especially if your resources are limited.



Use the diskquota tool to stop resource problems
before they start. Placing limits on the storage space
or the number of files a user can have on a system
will make your users more conscientious about not
keeping unneeded files around.

) If users exceed their allotted disk space, they
i («a receive a warning, and Linux starts a grace-
& period countdown. At the end of the grace

period, these users are not allowed any addi-
tional disk space until they clean up their act.

Installing the quota RPM package

Before you can create and allocate disk quotas, you
must install the quota RPM package included with
most Linux distributions. To install quota on your
system, follow these steps:

1. Open a terminal window and give yourself
superuser privileges with the su command.

2. Mount your distribution disc in the CD drive.

3. Use the cd command to move to the directory
containing the quota RPM package.

4. Install the quota package with the following
command:

# rpm -Uhv quota-version.rpm

That’s all there is to it. The quota package is
installed and ready to use.

[ If you don’t have the distribution disc, but
- («a

need the package, just Google for it.
Downloads of the quota RPM package
abound on the Web.

é

Enabling file system quotas

You can create disk quotas for any file system on

your computer, but you have to change the mount
options first. To enable quotas for a particular file
system, follow these steps:

1. Open a terminal window and give yourself
superuser privileges with the su - command.
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Don’t forget the hyphen when you type in the
su - command. The hyphen sets up your
search path ($PATH) so you can find the super-
user’s tools.

2. Open the /etc/fstab file in your favorite editor
(which in our case is kedit):

# kedit /etc/fstab

kedit opens, as shown in Figure 21-1.

¥ root@kobe:~ - Shell - Konsole -0%

Session Edit View Bookmarks Settings Help

Pasq| File Edit Go Tools Settings Help

[rod| = = =

Tl Edés 9 eEDh &
ILAEEL:/ / ext3 defaults,usrquota,grpy
LABEL=/boot /boot ext3 defaults 12
none /dev/pts devpts gid=5,mode=620 0 0
none /proc proc defaults 00
none /dev/shm tmpfs defaults 00
/dev/hda3 swap swap defaults 00
/dev/cdrom Jmnt/cdrom udf, is09660 noauto,owner,kudz
/dev/fdo /mnt/£loppy auto  noauto,owner,kudzu O |
//kaga/susan /mnt/kaga smbfs noauto,user 0 0
//192.168.0.1/SHARKEYC /mnt/sharkey smbfs  username=Administratoj]
[+1 1 [
[ INS |Line: 1 Col: 1

* Figure 21-1: The /etc/fstab file opened with kedit.

3. Find the file system that you want to modify.

4. Add the usrquota and grpquota options to the
fourth column.

Finding the correct column in a typical fstab file
can be tricky. The first column contains the device
name, the second column specifies the mount
point, the third column determines the file system
type, and the fourth column contains a comma-
separated list of options (typically, defaults):

LABEL=/ / ext3
defaults,usrquota,grpquota 1 1

The preceding code shows the changes needed
to add quotas for the root file system.

5. Save your changes and close the editor.
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Now, remount the file system that you modified to
enable the new options. The easiest way to remount
an active file system is to reboot.

- type reboot at the command line and press

Z What's the quickest way to reboot fast? Just
<
Enter.

&

Getting your files together

Now it’s time to create the quota control files:
aquota.user and aquota.group. These files record
the quotas that you assign to each user (or group)
on that file system as well as the amount of space
currently in use. You'll find the quota control files in
the root directory of each quota-enabled file system.
When you create the control files, Linux computes the
current disk usage to create a starting point for you.

To create the quota control files, follow these steps:

1. Open a terminal window and give yourself
superuser privileges with the su - command.

2. Type the following command and press Enter:
# quotacheck -acugm

The flags in this command tell quotacheck to cre-
ate (c) a new control file for users (u) and groups
(9) in all currently mounted file systems (a).

3. Type the following command and press Enter:

# quotacheck -avugm

Running the quotacheck command again without
the create (¢) flag populates the control files
with the current usage information. The current
usage reflects the blocks and files allocated to
users (u) and groups (g) on all quota-enabled file
systems (a) . By default, quotacheck won’t com-
pute disk usage on mounted file systems. (If
you've enabled quotas for the root file system
[/], you can’t unmount that drive.) The -m flag
forces quotacheck to inspect file systems that
can’t be remounted in read-only mode.

Technique 21: Making Your Inner System Administrator Happy (And Productive)

That’s it! The quota files are created, populated, and
ready to use.

Remember that systems vary. The preceding
steps work great on our system (and should
work well on most simple configurations), but
if you need more information about command
options that might suit your specific hardware
configuration, check out the official documen-
tation. Just enter info quotacheck at the
command line for fast access to the online
documentation.

g

B><<§1
&

Setting quotas

At this point, the quota tools have been installed,
and the control files are in place (which we explain
how to do in preceding sections). Now it’s time to
impose quotas. Here, we explain how to set quotas
for a user name or group and how to set the grace
period for users who have met their quotas and
need to clean up their files.

) The default editor for quota is vi, a powerful
- { <@ but unfriendly editor. When you first set quo-
& tas, we recommend fixing up the quota editor
a bit. Our editor of choice is kedit or kate.
See the following steps to find out how.

To set quotas for a user, follow these steps:

1. Open a terminal window and give yourself
superuser privileges with the su - command.

2. To change the default editor for quota, enter
the following command:
# export EDITOR=$(which kedit)

7
e { @
&

If you prefer another editor, just substitute it
for kedit in the preceding command.

3. To edit the control files and define quotas,
enter the following command:

# edquota username



edquota creates a temporary file that contains
the current quota settings for username and then
opens that file in the editor that you specified, as
shown in Figure 21-2.

hd tmp (EP a0y HmWr - KEdiT -
File Edt Go Tools Settings Help
BEUes ¢ Db & l
Disk quotas for user duncan (uid 301):
Filesystem blocks soft hard inodes soft hard
| Jdev/hda2 44 143000 16000 13 s0 65
L INS Linec 4 Cok 1 _I

* Figure 21-2: The disk quota file.

The quota file that you see contains one line for each
quota-enabled file system (the file system name is in
the first column). edquota lets you control disk usage
in 1024-byte blocks. You can also control the total
number of files that a given user can create on a file
system. (The quota tools all refer to inode quotas —
inode is essentially a synonym for file.)

The numbers listed under blocks and inodes show
disk space (and file count) currently used by the
given user. A Linux quota is defined by three values:

v Soft limit: This controls the maximum amount of
space that you should use.

v Hard limit: This controls the maximum amount
of space that you can use.

1 Grace period: When you exceed the soft limit,
Linux warns you and gives you a grace period.
During the grace period, you can continue to
accumulate more disk space (up to the hard
limit). If, at the end of the grace period, you're
still over the soft limit, the soft limit becomes a
hard limit.

For example, suppose your soft limit is 2GB, your
hard limit is 2.5GB, and the grace period is one week.
As soon as your disk usage exceeds 2GB, Linux dis-
plays a warning. You can exceed your soft limit for
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one week (but you can never go above 2.5GB). After
the grace period, you can’t create any new files (or
write more data to existing files) until you clean up
enough stuff to fall back to the 2GB soft limit. You
can exceed the soft limit (for a week), but you can’t
exceed the hard limit.

Deciding how many blocks or inodes a user
needs is a matter of system resources. If
users need access only to e-mail, they obvi-
ously need fewer files (and less disk space)
than users doing development work. If you
have plenty of room, you can allocate larger
pieces of the total pie.

You can also assign quotas to a group of users. To
assign group quotas, follow these steps:

1. Give yourself superuser privileges with the
su - command.

2. To edit the control files and define the group
quota, use the following command:

## edquota -g groupname

The -g indicates that the following name is the
name of a group.

3. Edit the quotas as desired (following the same
basic rules we discuss earlier in this section),
and then save the file and close the editor.

Linux is far kinder than many people would
be. If you exceed a soft limit, your files are still
there (Linux doesn’t delete the extra data).

You just don’t get any more space until you
trim down a bit.

To set the grace period, enter the following command:

# edquota -t

The editor opens, displaying the current settings
for the block and inode grace periods, as shown in
Figure 21-3.
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fd /tmp//EdP.aTriRqU - KEdit
Eile Edit Go Tools Settings Help

B el &

hrace period before enforcing soft limits for users:

Time units may be: days, hours, minutes, or seconds
Filesystem Block grace period Inode grace period
JSdev/hda2 7days 7days

| INS  [Line: 1 Col: 1

* Figure 21-3: The grace period file.

Change the grace period if you want — you can
specify a number of days, hours, minutes, or sec-
onds. Be sure to give yourself a reasonable amount
of time to clean things up (at least a day). Save the
file and close the editor when you're finished.

Reviewing your quotas

To generate a complete listing of the quota defini-
tions and the current system usage, type in this
command:

# repquota -vugs /home

repquota generates a quota report listing the space
used by all users (-u) and groups (-g) on the /home
file system. The -v option tells repquota to produce
a more detailed (or verbose) report that displays
quota definitions that are not currently in use. By
default, repquota displays quota information in terms
of 1024-byte blocks; the -s flag tells repquota to print
the totals in more readable terms (megs instead of
blocks). The last argument in the command indicates
the file system — in this case, the /home file system.
To display quota information for all file systems, use
the -a flag instead (repquota -avugs).

The listing shows user quotas first and then group
quotas, as shown in Figure 21-4.
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(A root@ kobe:/home - Shell - Konsole EE x
Session Edit View Bookmarks Settings Help
[
“** Report for user guotas on device /dev/hda2 E|
Block grace time: 7days; Inode grace time: 7days
Block limits File limits
[User used soft hard grace used soft hard grace
jroot = 3731M 0 0 203k 0 0
daemon ] 8 0 0 3 0 0
1p == 11888 0 0 13 0 0
games s o (0] 0 59 (0] 0 IT
Irpm s 54852 (0] 0 109 (0] 0 =
vesa - 8 0 0 129 0 0 =
ntp 3 8 0 [} 2 0 [} II
mamed . 8 0 0 2 0 0
apache - 8 (4] 0 2 (4] 0
Irpcuser = 16 0 0 2 0 0
smmsp = 2 0 0 b 0 0
desktop = 200 0 0 433 0 0
efs == 4 0 0 2 0 0
gdn . 4 0 0 1 0 0
susan S5 244M 0 0 2994 0 0
franklin -- 40 0 0 11 0 0
freddie s 40 (4] 0 1 0 0
duncan 3 44 14000 16000 13 50 65
fleetwood —- 40 0 0 12 0 0
[korry - 9460 (] 0 562 45000 45000
#8482 = 27900 0 0 549 0 0 ‘E

¢ Figure 21-4: The user quota report.

Worthy of note are the grace columns. If a quota has
been exceeded, the amount of time left in the grace
period is displayed. If the grace period has expired,
none appears in the column.

Using System Accounting to
Keep Track of Users

Linux gives you a number of command-line tools
that can help you keep track of the resources used
by a given user (not just disk space, but CPU time,
connect time, and memory usage as well). After
you've installed the tools, with a few quick key-
strokes you can determine which users spend the
most time at their keyboards.

Setting up system accounting

To install the psacct package on Fedora or
Mandrake, or the equivalent, acct on SuSE, follow
these steps:

1. Open a terminal window and give yourself
superuser privileges with the su command.

2. Insert and mount your distribution disc.
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3. Use the cd command to move to the directory
containing the RPM packages.
4. Type the following command and press Enter:

# rpm -Uhv psacct-version.rpm

On SuSE, install the acct package with the
command:

f#frpm -Uhv acct-version.rpm

The installation process creates a new back-
ground daemon.

To start the psacct service (or acct, if you're
running SuSE), follow these steps:

1. Open a terminal window and give yourself
superuser privileges with the su command.

2. Start the service:

If you're running Fedora, the command is

f# /sbin/service psacct start

If you're running Mandrake, use the command:
# /sbin/service psacct start

If you're a SuSE user, start the service with the
command:

# /etc/init.d/acct start

Now you’re up and running. Linux keeps track of
resource usage in the /var/run/utmp and /var/log/
wtmp files.

The wtmp file can grow quickly. It's a good idea
to clean it up every now and then.

Looking up user login hours

Of all the information you can call up in a flash, sum-
maries of user login hours are among the most use-
ful. Use the ac command to find out how long (in
hours) your users have been logged in. To generate
a list of login hours, itemized by user, enter the fol-
lowing command:

$ ac -p
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The result will look something like this:

[freddie@bastille freddiel$ ac -p
freddie 7.03
duncan 2.02
franklin 6.54
root 1.02
total 16.61

To generate a list of total login hours on a daily
basis, use the -d flag:

$ ac -d

The result is a daily list of connect-time hours:

[freddie@bastille freddiel$ ac -d
Feb 1total 0.33

Feb 2total 12.54

Todaytotal 1.01

One thing to note — the daily total is for everyone
logged in.

B man hours if you need to answer to account-
ing about department costs or want to request

more resources in a budget meeting.

Z This is a quick way to find out total system
E)

&

The two flags we’ve listed are probably the most
useful, but other flags work with the ac command
as well. Check out the man page for more ideas —
man ac.

Checking out command and program usage

Another useful command that comes courtesy of
system accounting is the sa command. Use the sa
command to find out which programs are being used
on your system. To use the sa command, first you
need to give yourself superuser privileges with the
su - command. Then to generate a report of com-
mand usage, enter the following command:

# sa

The report shows the command usage for the sys-
tem, as shown in Figure 21-5.
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hd root@ kobe:/home - Shell - Konsole EE x
Session Edit View Bookmarks Settings Help
@
[root@kobe home]# sa E|
10460 147431.51re 315.03cp Oavio 3420k
56 5393.08re 198.06cp Oavio 2792k *#Fgther®
296 50793.93re 83.26cp Oavio 5850k  kdeinit*®
9 2124.80re 12.76cp Oavio 19205k  mozilla-bin
8 37.14re 3.15cp Oavio 1203k  tar
8 1135.04re 1.75cp Oavio 6378k  ksnapshot
9 1222 .85re 1.66¢cp Oavio 6792k  nautilus
4 1222 .40re 1.41cp Oavio 7014k  rhn-applet-gui
2753 242.27re 1.33cp Oavio 8370k  uml_linux_lids* =
706 5.66re 1.07cp Oavio 748k  modprobe
4 1222.53re 0.74cp Oavio 5630k gnome-panel
9 1.11re 0.69cp Oavio 1656k  rpmg
4 1221.07re 0. 64cp Oavio 4566k mixer_applet2
4 1222.80re 0.62cp Oavio 3463k  metacity
7 15.00re 0.52cp Oavio 9074k  gdmgreeter
35 36.77re 0.47cp Oavio 1131k we
9 1257 .86re 0.38cp Oavio 3313k  gconfd-2
29 6.50re 0.34cp Oavio 1324k  gpg
5 18.68re 0.32cp Oavio 5747k python
279 0.40re 0.28cp Oavio 692k  sed
4 1221.02re 0.28cp Oavio 4784k  wnck-applet
71 0.46re 0.27cp Oavio 2065k cel
22 1628 .34re 0.26cp Oavio 1632k sshd*
2 6.92re 0.25cp Oavio 10788k superkaramba
2 8.09re 0.25cp Oavio 3608k emacs EI

* Figure 21-5: The result set from the sa command.

The columns in the result set (from left to right) con-
tain the following information:

7

X Y\

X\ \

Total number of invocations
Total elapsed time
Combined system and user time in seconds

Average number of I/O operations (not currently
used in some versions of Linux)

Memory usage in 1K blocks

Command name
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The sa command generates a list showing a subset
of all commands. (Commands executed only once
and commands with unprintable characters are
grouped into an entry labeled ***other*.) To see a
complete list, use this command:

# sa --list-all-names

To summarize the list by user, use this command:

# sa -m

For a quick overview of system usage that includes
statistics by percentage of resource used, use the
following command:

ffsa -c

Combine the sa command with the grep command to
show usage of a specific program:

#f sa | grep program

The preceding command returns a report including
statistics only on the command named.

7 Keeping an eye on command usage can tell
- { -a) you what people are up to. You can find out if
& a lot of cping is going on that shouldn't be.

These are just some of the options of the sa com-
mand. For a complete list, check out the man
page —man sa.
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Save Time By

v~ Customizing your
runlevels

v~ Disabling unused serv-
ices to close extra, open
ports

+* Removing unused serv-
ices with the Service
Configuration Tool

v Cleaning up after
ex-users

leaning up is an essential part of running a secure and efficient sys-

tem. You can use resources most efficiently if your system doesn’t

have an abundance of unused services hanging around in the back-
ground, tying up CPU time. Unnecessary services are also an invitation to
hackers. Can hackers exploit an open port you've forgotten about? In this
technique, we explain the best ways to avoid these pitfalls by

v Tidying up the runlevel you work in most often: Linux runlevels are
collections of services that define your system’s capabilities. Each run-
level has a purpose. You can choose from the predefined runlevels or
customize runlevels for your use. Shutting down the extra services in
the runlevel you're using saves CPU time and system resources.

v Shutting down unused services: When you leave an unattended serv-
ice running, listening for a client’s request, it can accept a request from
either an approved user or a hacker. Shutting down the services that
don’t need to be running is a good way to tighten system security.
That’s because when you shut down services, you close off the extra
open ports you're not using — and hackers can’t use them either.

v Getting rid of old users’ stuff: Old files are another waste of resources —
why take up good disk space for outdated data? When users move on
and you clean up, be sure to remove all their old files; otherwise, you're
just wasting space by storing data that’s unlikely to be used again.

The following sections are about cleaning house. By doing so, you’ll keep
your work environment neat, secure, and productive; and everyone will
save time!

Running Down the Runlevels

You can save time and make better use of your system resources by run-
ning at the minimum runlevel you need. A runlevel is a collection of serv-
ices. You can customize the services available at each runlevel to make
the most of your system resources.
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Runlevel basics

Most Linux distributions define the following
runlevels:

0 Halt

1 Single-user mode

2 User-definable — nongraphical

3 Multiuser command line environment
4 User-definable — nongraphical

5 Multiuser graphical environment

6 Reboot

The different runlevels are used for different reasons.
If you need the system all to yourself for repairs or
system maintenance, booting into runlevel 1 guaran-
tees that you're the only user on the system. However,
you have to work from a terminal window because
runlevel 1 doesn’t support a graphical interface.

If you need to save on the system load and your
users don’t need a graphical interface, you can boot
your system into runlevel 3. If your application soft-
ware doesn’t need graphics capabilities, your users
will recognize the boost in speed they get from run-
ning at the lower runlevel.

For all the bells and whistles of a graphical environ-
ment, boot your system into runlevel 5. It’s definitely
the most comfortable user environment. You can use
the command line if you want, but the graphical
options are also available. (Runlevel 5 is the default
runlevel for Fedora, Mandrake, and SuSE systems.)

Customizing runlevels in Fedora

Customizing a runlevel is easy in Fedora or SuSE
Linux, but it’s a little trickier in Mandrake. In this
section, we show you how to use Fedora’s runlevel
editor. If you're a SuSE or Mandrake user, skip ahead
to the appropriate section.

To turn Fedora services on or off or to edit the serv-
ices included in your runlevel, follow these steps:
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Before you make any changes to your config-
uration, be sure that you have a working
emergency repair disk. If you don’t, you might

lock yourself out of your computer without
giving yourself a way back in. See Technique 24
for details on making a boot disk.

1. From the Main Menu, choose System Settings->
Server Settings->Services.

You're prompted for the superuser password.

2. Enter the superuser password and click OK.

The Service Configuration window opens,
as shown in Figure 22-1. Use the Service
Configuration Tool to edit the services that
are enabled for your runlevel or to create a
new runlevel.

O ervice Contanndian 2
File View Actions Edit Runlevel Help
> 0 & d
Start Stop Restart Save Revert
Currently Running in Runlevel: 5 Editing Runlevel: 5
acpid Description
Pr—— Listen and dispatch ACPI events from the kernel
apmd
atd
autofs
1 chargen
[ chargen-udp
crond Status
cups
] cups-pd
[ daytime
[] daytime-udp
[ echo
[ echo-udp

* Figure 22-1: The Service Configuration window.

3. To modify a runlevel other than the default (5),
choose Edit Runlevel on the menu bar and
select the runlevel you want to customize.

Runlevels 2 and 4 are user-definable — Fedora
set them aside just for you. Be aware that
they're not graphical, so you'll be working at

the command line. If you're managing a Web
server, database server, or e-mail server, con-
figure runlevel 4 to run only the services you



need — you can still switch to runlevel 5 (and
a graphical desktop) when you need to man-
age your system.

- need to run on your system gives you a leaner,
meaner machine. Your users will thank you for

the extra speed.

z Defining a runlevel with only the services you
<8}

é

4. Look at the Editing Runlevel indicator above
the description frame to make sure the run-
level displayed is correct. (You don’t want to
accidentally edit the wrong runlevel.)

5. To edit the runlevel services, scroll through the
list and disable the services your users don’t
need or enable services that would be handy.

You can enable or disable a service by checking
or unchecking the check box to the left of the
service. If the box is checked, the service is on.

You can get a quick description of the service
by highlighting the service name and looking
at the description box. Most of the descrip-
tions are pretty informative.

6. After you've changed the services for your new
custom runlevel, click the Save icon on the
toolbar.

You now have a leaner, meaner runlevel to
worKk in.

Customizing runlevels in SuSE

SuSE Linux supports runlevels 1 through 6, but

you can’t modify runlevel 4 without resorting to

a command-line interface. SuSE also adds a few
new runlevels: Runlevel B corresponds to the boot
process, and runlevel S is another single-user run-
level (just like runlevel 1, but you can customize the
services to create two distinct single-user runlevels).

We strongly recommend that you don't
6 change any of the services in runlevel B (boot)
or runlevel 0 (halt), or your system may

become inoperable.

7 If you need to customize runlevel 4 for some
(3 («a reason, see the man page for the chkconfig
) command.

To turn SuSE services on or off, or edit the services
included in each runlevel, follow these steps:

Before you make any changes to your configu-
ration, be sure that you have a working emer-
gency repair disk. A working boot disk will

give you a way back into your system if you
accidentally lock yourself out. See Technique 24
for details on making a boot disk.

Running Down the Runlevels

1. From the main menu, choose System=>YaST.
You're prompted for the superuser password.
2. Enter the superuser password and click OK.

3. When the YaST Control Center appears, click
System (in the left-hand pane).

4. Click Runlevel Editor, and then click Expert
Mode.

The Runlevel Editor displays the services installed
on your computer, as shown in Figure 22-2.

Runlevel editor: details

() Sy Mods {5 Empas Lo

St bt ren b v bocrtiog 11

a1 e e vt a8 ke tham iy EcEE datee
- i

s i e

* Figure 22-2: SuSE’s Runlevel Editor.

5. To start or stop a service, highlight the service
and click the Start/Stop/Refresh button (near
the bottom of the window).
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The column labeled Running displays Yes if a
given service is currently running or No if the
service is not running.

The columns labeled B, 0, 1, 2, 3, 5, 6, and S indi-
cate whether the service is enabled or disabled
for that runlevel.

6. To enable or disable a service, check (enable)
or clear (disable) the check box next to the run-
level you want to change.

The check boxes are displayed below the list of
services (refer to Figure 22-2).

7. When you’re done customizing the runlevels,
click Finish.

8. When prompted, click Yes to save your changes
and close the YaST Control Center.

Customizing runlevels in Mandrake

Mandrake Linux offers a runlevel editor that’s a bit
different. The graphical runlevel editors in Fedora
and SuSE Linux let you customize the set of services
enabled for each runlevel. Mandrake’s graphical edi-
tor lets you enable or disable services for all run-
levels. In other words, if you disable a service using
Mandrake’s editor, you've disabled that service for
all runlevels. You can customize individual runlevels,
but you have to resort to the command line to do it.
See the next section for the details.

To enable or disable services using the Mandrake
Control Center, follow these steps:

1. From the Main Menu, choose System=>
Configuration=>Configure Your Computer.
You’re prompted for the superuser password.

2. Enter the superuser password and click OK.

3. When the Mandrake Control Center appears,
click System.

4. Click Services.

The Services editor displays the services installed
on your computer, as shown in Figure 22-3.
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devtid rnmng  infe| X Onboot st | Swp
drn runring e | (X Onboat swan| | swp
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harddenks manning  nfs| (X Onbost Swan| | Swp
hetplug dopped  Infe ©n boal Start| | Siop

g nnming  inke X O boot sean| | Swp
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¢ Figure 22-3: The Mandrake Services editor.

The name of each service is listed down the left-
hand side.

5. If you're not sure what a particular service
does, click the Info button to see a short
description.

6. To start or stop a service, click the Start or Stop
button on that row.

7. To enable a service, check the box next to the
words On Boot or Start When Requested. To
disable a service, clear the check box.

Remember, you're enabling (or disabling) the
service for multiple run levels, not just the cur-
rent runlevel.

The services labeled Start When Requested are
network servers that start when a client tries to
connect to those services. If you disable a net-
work service, the client will typically display a
message such as Connection Refused. The serv-
ices labeled On Boot are background processes
that run all the time.

8. When you're finished, click OK to save your
changes or Cancel to discard your changes, and
then close the Mandrake Control Center.

Your changes will take effect the next time you boot
your computer.



Customizing runlevels at the command line

We mention earlier that Mandrake users must resort
to the command line to customize individual run-
levels; this section describes how.

The graphical runlevel editors are friendly and easy
to use, but sometimes it’s faster to hit the command
line. Regardless of whether you're using Mandrake,
Fedora, or SuSE Linux, you can use the chkconfig
command to adjust the services available at a par-
ticular runlevel. You can also use chkconfig to view
your service configuration. You must have superuser
privileges to use the chkconfig command.

To view the configuration for a service, use the com-
mand: chkconfig --1ist service-name. For example,
to view the runlevels for your Web server (httpd),
type in

# chkconfig --1ist httpd
httpd: O:off 1:off 2:0ff 3:on 4:on 5:o0n
6:0ff

If you leave off the service name, chkconfig will
display all services.

To enable a service for a given runlevel, use the com-
mand: chkconfig --Tevel runlevel service-name on.
For example, to enable your Web server at runlevel 2,
type in

# chkconfig --level 2 httpd on

To disable a service for a given runlevel, use the
command: chkconfig --level runlevel service-
name off.If you want to disable your Web server at
level 5, type the command

# chkconfig --level 5 httpd off
Switching to a new runlevel
To change into your new runlevel, follow these steps:

1. Open a terminal window and give yourself
superuser privileges with the su - command.
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2. Enter the following command:

# telinit runlevel

For example, to switch to runlevel 2, use this:
# telinit 2

Your system reboots and presents you with a
command line to log in.

Any runlevels lower than 5 aren’t graphical.

If you don’t like the new runlevel, use the telinit
command to return to the previous runlevel and then
fine-tune the service settings to better suit your needs.

Disabling Unused Services

Most services leave open ports that can be exploited
by hackers. Shutting off the services that you don’t
use regularly is a good way to close ports that hack-
ers could use to gain access to your system.

B off. It is still available when you need it — you
can turn it on with a few clicks of the mouse,
and off again when you're done. If you never
use a service, you're better off removing it

altogether. See the next section for details on

removing services.

Z If you use a service infrequently, just turn it
-

&

If you find a service that you don’t think you'll need,
we recommend disabling it for a while before you
remove it, just in case you change your mind later.
Here are some services that you might want to
disable:

You may not see all of these services on your
computer (depending on the software pack-
ages you've installed), or you may see a few
that we haven't listed here.

v acpid: This service controls what happens when
you press the power button on your computer.
The configuration file for this service is empty by
default, so acpid doesn’t actually do anything.
(See info acpid for more information.)
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apmd: This service monitors the battery level on
laptop computers. If you're not using a laptop,
you probably don’t need apmd.

atd: This service runs jobs that you've sched-
uled with the at command. If you don’t use the
at command, disable this service.

autofs: This service automatically mounts file
systems when you first use them. If you're not
using automount file systems (and unless you’'ve
configured them yourself, you're not), turn off
this service. autofs and the related automount
system are frequently targeted by hackers.

chargen: This silly little network service simply
generates a stream of characters whenever a
client connects. You can safely live without this
service.

chargen-udp: chargen’s cousin, this service
sends a stream of characters to a UDP-connected
client. If you disable chargen, disable chargen-
udp as well.

cups: This service is the Common UNIX Printing
System. If you're not printing anything, you don’t
need cups. (You can always turn it back on later
if you need it.)

cups-1pd: This service provides an 1p-style inter-
face to cups. (1p is an older printer protocol.) If
you aren’t sharing printers with other UNIX sys-
tems (systems that use the 1p protocol), disable
this service.

daytime: This network service tells a client com-
puter what time it is (at least, what time your
computer thinks it is; if you're like us, your VCR
always thinks it’s 12:00 and so do your comput-
ers). daytime is rarely used — you can safely dis-
able this service.

daytime-upd: This service is the same as daytime,
except it works with UDP clients instead of TCP
clients. Because this protocol is rarely used, you
can safely disable this service.

echo: This is another silly network service that
echoes client input back to the client. (It’s inter-
esting to note that this service and the chargen
service were both proposed by the same person

in 1972.) Unless you're developing network soft-
ware, you can safely disable this service.

echo-upd: This service is the same as echo,
except it services UDP clients instead of TCP
clients. Unless you're developing network soft-
ware, you can safely disable this service.

irda: If you have a laptop, it most likely has an
infrared port built in. If you don’t use it (or you
don’t have one), disable irda.

irgbalance: This service balances the workload
on a multi-CPU computer. If you have only a sin-
gle CPU, disable irgbalance.

isdn: This service manages ISDN network con-
nections. If you don’t have an ISDN connection,
you don’t need this service.

ktalk: This is the KDE talk server service. If you
don’t chat with other users on your computer,
disable ktalk.

1isa: 1isa discovers SMB (Samba) computers on
your local network, giving you a Linux equivalent
to the Windows network neighborhood. If you
don’t have any SMB servers (that is, Samba or
Windows servers), you can do without 1isa.

nfs: The NFS server service provides NFS file
sharing to other NFS computers. NFS is a fre-
quent target for hackers, so if you don’t use NFS
sharing, disable NFS (and the nfslock service).

nfslock: This service provides file locking for
the nfs service. If you've disabled nfs, disable
nfslock too.

ntpd: This service synchronizes the date/time
clock on your computer with network time
servers. Enable this protocol if you want to stan-
dardize your computer’s clock with the rest of
the world, or disable it if you’re happy setting
the clock yourself.

rawdevices: This service is used by high-
performance database servers to access your
hard disk without going through the normal file
system route. If you’re not using a program that
needs raw disk access, disable rawdevices.



rsync: rsync is a package that speeds up file
transfers by sending only the differences between
two versions of the same file. Disable this service
if you aren’t running an rsync server.

saslauthd: SASL is an authentication protocol
used by mail servers (and other network
servers). If you know you don’t need it, disable
it; if you're not sure, leave it alone.

sendmail: The sendmail service moves e-mail
from your machine to other machines (that is, it
delivers the e-mail that you send). If you aren’t
sending e-mail from your Linux computer or
you're using a different mail server, you can
safely disable sendmail.

services: This service provides a listing of all
the network services that your computer pro-
vides to other clients. Disable this service unless
you know that you need it.

smb: If your computer acts as a Samba server
(see Technique 11), you need the smb service. If
not, you can safely disable this service.

snmp: This service is the Simple Network
Management Protocol (SNMP) daemon. It serv-
ices network management requests. If you're
unsure whether you need this, disable it for now
(SNMP has been the target of some hack
attacks).

snmptrapd: This is another component of SNMP.
If you disabled snmp, you can disable snmptrapd
too.

swat: SWAT is a mini-Web server that you use to
configure the Samba server. If you aren’t running
a Samba server, disable swat.

time: This service is similar to the daytime
service. It sends the current date and time (in
seconds, since midnight January 1, 1900) to any
client that connects to it. You can safely disable
this service.

time-udp: This service is the same as time, except
it serves UDP clients instead of TCP clients. You
can safely disable this service as well.
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v winbindd: This service pulls user account infor-
mation from Windows servers, letting you use
your Windows user name and password on a
Linux computer. If you aren’t intimately sharing
authentication information with a Windows
server, disable winbindd.

Removing Unneeded Services

Having extra, unused services on your system can
be a security risk. You may have a service disabled
at the moment, but a hacker or Trojan horse can
turn it on and exploit its open ports.

If you find an obscure service that you'll never
use, remove it so it's not available for exploita-
tion by a hacker or a Trojan horse.

Removing the services you don’t need is a good way
to secure your system.

] Don’t worry about removing the services you
B (@ aren’t using now. Services are easy to reinstall
& if you find you need them.

If you're a Fedora user, you can use the same Services
Configuration Tool that you use to start or disable
services (or configure a custom runlevel) to com-
pletely remove services.

To remove a service, Fedora users follow these
steps:

1. Open the Main Menu and choose System
Settings~>Server Settings=>Services.
You're prompted to enter the root password.
2. Type in the root password and click OK.
The Service Configuration window opens.

3. Highlight the service you want to remove and
choose Actions=>Delete Service from the menu
bar (see Figure 22-4).
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¢ Figure 22-4: The Actions drop-down menu.

A pop-up window appears asking you to verify
that you want to remove the service.

4. Click Yes to remove the service, and in a snap,
the service is gone!

If you're a SuSE or Mandrake user, you can remove
a service from the command line by following this
procedure:

1. Open a terminal window and give yourself
superuser privileges with the su command.

2. Type in the following command and press
Enter:

# /sbin/chkconfig --del service-name

You can also use the chkconfig command on Fedora
systems if you don’t want to take the time to start
the Services Configuration Tool.

When you delete a service with the Services
Configuration Tool, the underlying programs
remain on your system; you've deleted only
the startup and shutdown scripts for the serv-
ice. If you want to completely remove the
service and its underlying programs and data
files, erase the package with the rpm com-
mand (see Technique 17).

Removing Old Users
and Their Files

When users leave, the clutter they may be leaving
behind can tie up valuable system resources. Why
store all of their old files, which aren’t important any-
more, when you can use the disk space for fresh data?

After you've made sure that you've saved any of the
ex-users’ important documents, you can remove all
traces of these users and their files with a few mouse
clicks. Removing (and adding) user accounts is easy,
and each distribution provides a graphical tool that
allows you to manage users without resorting to a
command line.

In this section, we show you how to remove user
accounts with the Fedora User Manager. If you're
a Mandrake user, use the Mandrake User Manage-
ment tool (found in the main menu at System=>
Configuration®>Other=>User Administration). If
SuSE is your favorite flavor, use the User and Group
Administration tool in YaST (System=>YaST>
Security and User.

7 A quick follow-up with kfind will find any files
e («m that former users might have stashed on your

& system, but that are off the beaten path.

Before removing a user’s account, make note
of his or her user ID. You'll need it to clean up
after deleting the account.

&

To remove an old user account, follow these steps:
1. Open the Main Menu and choose System
Settings=>Users and Groups.
You're prompted for the root password.
2. Enter the root password and click OK.

The Fedora User Manager opens, as shown in
Figure 22-5.

3. To delete a user, highlight the user’s name in the
list and click the Delete button (on the toolbar).



You're asked to verify that you want to remove
the user, as shown in Figure 22-6.

4., Check the Delete User’s Home Directory box if
you want to remove the user’s old belongings.

Be sure that you don’t need any of the user’s

old belongings. This is a good time to refer to
Technique 50 and back up the user's home
directory before deleting it.

5. Click Yes to remove the user’s identity and
home directory.
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* Figure 22-5: The Fedora User Manager.
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¢ Figure 22-6: Verify that you want to remove the user’s
account.
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After the user is removed from the user list, and his
or her home directory is gone, you can use kfind to
search for any orphaned files that the user may have
left in other directories. To search for other files, fol-
low these steps:

1. Open the Main Menu and choose Run Command.

2. Enter kfind in the Command field and click Run.

The KFind window opens (see Figure 22-7) to the
Name/Location tab. The Name field should con-
tain a *. Enter a / in the Look In field.
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¢ Figure 22-7: The KFind window.

3. Click the Properties tab, and enter the user ID
of your ex-user in the Files Owned by User field.

4. Click the Find button, and the search begins.

When the search is complete, the frame at the
bottom of the window displays all the now-
orphaned files previously owned by the ex-user.

5. Right-click the filename to open a pop-up menu,
displaying the filename at the top, followed by
your file management choices:

Copy

Delete

Open Directory
Open With
Open

vV vy vy vy Vvyy

Properties
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You can delete old system files that contain
configuration information and preferences for
your ex-user without much concern for inter-
fering with other users, but most other files
should be investigated more closely.

6. To delete an old file, choose Delete from the

W(«ﬂ
&

pop-up menu.

You're asked to confirm the deletion. Click Yes to
delete the file.

You can select multiple files by holding down
the Shift key and highlighting the files with a
mouse click (or by using the arrow keys to
select multiple files). Then right-click the file
group and choose Delete from the pop-up
menu. You're asked to confirm the deletion.
Click Yes, and the files disappear quickly!

7. Ifyou see files in the list that may contain work
or data important to others, right-click and
choose Properties from the pop-up menu to
open the Properties dialog (see Figure 22-8).
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=

* Figure 22-8: The Properties dialog.

8.

Click the Permissions tab to view the file own-
ership information, and note the name of the
group that owns the file.

It might be prudent to consult with the other
members of that group before deleting the file.

If the list includes files that you can’t recognize
by filename or location, you can

» Open the file and manually inspect the con-
tents. Depending on how prolific the ex-user
was, this might be the best option to start
with. However, if the user left you with hun-
dreds of files, you’ll probably want to use the
other option.

» Narrow the inspection a bit by deleting the
things that aren’t important. Right-click the
filename and choose Open from the pop-up
menu. You're treated to a view of the file, in
the default viewer for that type of file.

If you see a listing with /proc/processID in
the In Subdirectory column of the result table,
it means that the ex-user still has a process
running somewhere on your system. Make a
note of the process ID so you can use KDE
System Guard to kill off the process. (See
Technique 41 for complete details; see the fol-
lowing steps for the short version.)

To kill off abandoned processes, follow these steps:

1

2.

Open a terminal window and gain superuser
privileges with the su command.

Type the following command and press Enter:
# ksysguard

The KDE System Guard window opens, as shown
in Figure 22-9.

Click the Process Table tab to move to a list of
currently running processes, and look for the
process ID in the PID column.

When you’ve found the process ID, highlight
the entry for that process and click the Kill
button.

A dialog opens asking if you really want to kill
the selected process (see Figure 22-10).



5. Click Kill to confirm your choice.

The process is terminated.
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* Figure 22-9: The KDE System Guard window.
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~— 00
® kwin 22998 1.30 0.00
43 kwrapper 22995  0.00 0.00
<
[] Tree All Processes - @ Refresh
. e
|| 62 Processes | Memory: 304376 KB used, 15956 KB free | Swap: 2368 KB used, 648256 KB free

* Figure 22-10: Confirm the process termination.

With a little vigilance, you’ll avoid the piles of files
that ex-users can amass on your system and save

the resources for the users that need them.
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Save Time By

v~ Manipulating your kernel
on the fly

v~ Using your boot time
parameters to custom-
tailor your kernel

make up the software interface between your system hardware and

the system software. On a fresh Linux installation, over 900 kernel
modules are ready to load into your kernel. The actual number may vary
depending on the specific hardware that Linux finds when it sets up
housekeeping, but on our Fedora system, 968 modules exist.

The kernel is the software core of your computer. Kernel modules

You can also download and install new kernel modules. You can find
many open-source modules bouncing around the Web that do everything
from silencing annoying beeps to enabling wireless network cards. The
beauty of the system is the flexibility that kernel modules provide the
computer industry. Every time a new piece of hardware is invented, you
don’t have to modify and rebuild the Linux kernel — you just add a new
module.

Manipulating kernel modules is quick and simple, thanks to a series of
commands that work at the command line to update your kernel without
a complete rebuild. You can also find-tune your kernel by using the boot
time parameters. Boot time parameters are the kernel options that are
enforced every time you boot your system.

Not all features are modules, and you may want your kernel to be config-
ured so that some features can’t be changed. If that is the case, a com-
plete kernel rebuild is called for (see Technique 24 for information about
building a kernel from scratch). If you can get by with a simple patch to
the kernel, this is the technique for you. In this technique, we introduce
you to the commands that let you customize your kernel — quickly and
easily.
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Adding and Removing Kernel
Modules

Linux contains some handy commands you can use
to manipulate your kernel while it’s running. The ker-
nel module tools make it easy to experiment with
kernel changes without making any lasting or perma-
nent changes.

These commands don’t make permanent
changes to your kernel; the changes last only
until you reboot. To automatically implement a

change at boot time, you need to add the
change to a startup script. For the quickest
way to make a change to your system startup
script, check out Technique 26, where we
show you a couple of easy-to-follow examples
in the section about closing down security
gaps with /proc.

To use the kernel tools, you need to open a terminal
window and give yourself superuser privileges with
the su - command. Be sure to include the hyphen,
which ensures that the module tools are on your
$PATH search path.

Learning about modules

You can find out what kernel modules are on your
system by entering the following command:

# 1s -R /Tib/modules/$(uname -r)

If you don’t have the kernel module that you
need to control a device or configure a piece
of hardware, do a Google search for the kernel
module you need. Lots of modules are avail-
able on the Web.

The modinfo command displays all sorts of informa-
tion about a kernel module, as shown in Listing 23-1.

Technique 23: Taking Good Care of Your Kernel

LisTinGg 23-1: ViEwing MobDULE INFORMATION WITH MODINFO

# modinfo iforce

filename: /1ib/modules/
2.4.22-1.2115.npt1/kernel/
drivers/char/joystick/iforce.o

description: "USB/RS232 I-Force
joysticks and wheels driver"

author: "Vojtech Pavlik
<vojtech@suse.cz>, Johann Deneux
<deneux@ifrance.com>"

Ticense: "GPL"

Installing a module with insmod

The insmod command installs a module into a run-
ning kernel (or at least tries to). The typical com-
mand syntax is

# insmod modulename

Taking care of dependencies automatically
with modprobe and depmod

We said that insmod tries to install a module, but it’s
not always successful. Some modules depend on
other modules. For example, if you want to load the
Iforce joystick driver, you must first load the generic
serial joystick driver and USB driver. If you try to
load a module with unsatisfied symbols, you see
error messages like this:

unresolved symbol serio_close_R393d70c3
unresolved symbol serio_open_R17abfb2f
unresolved symbol serio_unregister_device
unresolved symbol serio_register_device

Deciphering these messages can be nearly
impossible.

Fortunately, modprobe solves dependency problems
for you. The modprobe command works with the
information computed by depmod to automatically
load any dependent modules.



depmod computes the interdependencies among
kernel modules and writes the results to /1ib/
modules/$(uname -r)/modules.dep. The modprobe
command reads dependency information from that
file. depmod runs each time you boot your system so
the dependency database is always up-to-date,
unless you build or install a new module. To rebuild
the dependency database, use the following
command:

# depmod -a

As we mention earlier, modprobe uses the information
gathered by depmod to automatically load any mod-
ules dependent on the one you want to use. The syn-
tax for modprobe is essentially the same as the syntax
for insmod:

# modprobe modulename

If any of the dependencies can’t be resolved,
modprobe gives up and undoes any of the work it’s
already done.

Loading a module for a slightly different
kernel with insmod and modprobe

Because modprobe automatically resolves any
dependencies for you, why would you ever want to
use insmod? Every kernel module is compiled for a
specific kernel version. Occasionally, you run into a
module that’s compiled for the wrong kernel, but
you're pretty sure it will work with your version.
(For example, you may find a great sound card
driver compiled for kernel version 2.4.22-1.2115.
nptl1, and you're running 2.4.22-1.2116.npt1.) If you
try to modprobe a module with the wrong version,
modprobe won’t do it. You can force insmod to load
the module (even though it’s been built for the
wrong version) by including the --force option on
the command line:

# insmod --force iforce

But, insmod will still complain about unresolved
dependencies. Don’t give up — you can still use
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modprobe to do the hard work for you. Just use the
-n and -v options:

# modprobe -n -v iforce
insmod input.o

insmod usbcore.o

insmod serio.o

insmod iforce.o

When you use the -n and -v options, modprobe shows
you the insmod commands that you need in order to
load dependent modules in the correct order (but it
doesn’t actually execute those commands). Now you
can execute those commands yourself; just be sure
to include the --force option when you load the mis-
matched module:

# modprobe -n -v iforce
insmod input.o

insmod usbcore.o

insmod serio.o

insmod iforce.o

# insmod input.o

# insmod usbcore.o

# insmod serio.o

# insmod --force iforce.o

The 1smod command displays a list of the modules
that are currently loaded on your system (see
Figure 23-1).

hd root®localhost:~ - Shell - Konsole

Session Edit View Bookmarks Settings Help

3 [

v

soundcore 6468 0 (autoclean) El
parport_pc 19076 1 (autoclean)

1p 9060 0 (autoclean)

parport 37056 1 (autoclean) [parport_pc 1p]

autofs 13364 0 (autoclean) (unused)

orinoco_cs 5556 1

orinoco 39756 0 [orinoco_cs]

hermes 8068 0 [orinoco_cs orinoce] ]
ds 8680 2 [orinoco_cs]

yenta_socket 13664 2

pemecia_core 57216 0 [orinoco_cs ds yenta_socket]

floppy 58012 0 (autoclean)

sg 36492 0 (autoclean) (unused)

scsi_mod 108168 1 (autoclean) [sgl

microcode 4700 0 (autoclean)

keybdev 2976 0 (unused)

hid 24708 0 (unused)

usb-uhci 26380 0 (unused)

usbcore 79168 1 [hid usb-uhei]

mousedev 5556 1 (autoclean)

input 5888 0 (autoclean) [keybdev hid mousedev]

ext3 71300 2

jbd 52084 2 [ext3] L
[root@localhost rootl# [ [+]

* Figure 23-1: Currently loaded kernel modules.
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Removing modules with rmmod

The rmmod command removes a loadable module
from the kernel. You can’t remove a module if it’s in
use (1smod will tell you whether or not the module is
being used). To remove a module, use the following
command:

# rmmod modulename

When you delete a module, it’s still on your com-
puter; it’s just not loaded into the kernel.

Manipulating Boot Time
Parameters

The Linux kernel is a program just like any other
program (well, maybe that’s a bit of oversimplifica-
tion): It has a command line, and you can specify
options and parameters to the kernel when you boot
your system.

Each time you boot your system, the boot loader
pauses for a moment at the boot selection screen —
you usually hit Enter (or just wait for the built-in
timer to expire) when you see the selection screen,
and your computer happily boots the Linux kernel
using the default boot parameters. Linux can do a lot
more.

If you're running Fedora Linux, press the A key while
the boot selection screen is displayed to modify the

TaBLE 23-1: FEDORA B00OT-LINE PARAMETERS
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kernel arguments (note, you have only a few sec-
onds before the boot loader starts your kernel). If
you’re running Mandrake or SuSE Linux, press the
Esc key (while the boot selection screen is dis-
played) to reach the Linux boot prompt.

If you have multiple kernels or multiple oper-
ating systems installed on your system, they're
displayed on the boot loader selection screen.

The Linux kernel supports a huge variety of options
and parameters, but you only need to know about a
few of them.

To find a complete (though slightly unattrac-
e («a tive) list of boot time parameters, install the
kernel-doc RPM package, which is included
with most Linux distributions. You find the list
in /usr/src/Tinux-$Cuname -r)/
Documentation/kernel-parameters.txt.
Just open the file with your favorite editor.

The default command line for Fedora is as follows:

grub append> ro root=LABEL=/ rhgb

If you're running Mandrake or SuSE Linux, the
default command line will differ slightly.

Table 23-1 lists various parameters that you may
want to use to alter the default command line. You
can change the kernel command line to modify the
way your Linux kernel boots, or to change the way
the Linux kernel runs after it’s done booting.

To Do This Make This Change to the
Default Linux Command Line

Timesaving Bonus Info

View detailed boot
messages (Fedora only).

Remove the rhgb (Red Hat
Graphical Boot) from the
end of the command line.

Removing rhgb saves a little bit of boot time, and you
have a better starting point if you have to investigate a
boot problem.



To Do This

Make This Change to the
Default Linux Command Line
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Timesaving Bonus Info

View detailed boot
messages (SuSE or
Mandrake).

Make a menu of screen size
options appear when you
boot.

Include more details in the
boot process as the system
boots.

If you don’t use any USB
devices, you can turn off
the USB device modules.

Turn off power-
management
control features.

Boot into a runlevel other
than the default.

Boot into single-user mode
without a password.

Remove splash=silent from
the command line.

Add the vga=ask option to the
end of the command line.

For example:

grub append> ro root=
LABEL=/ rhgb vga=ask

Add the word debug to the
command line.

For example:

grub append> ro root=
LABEL=/ rhgb debug

Add the no usb command.
For example:

grub append> ro root=
LABEL=/ rhgb no usb

Add the acpi=off command
to the GRUB command line.
For example:

grub append> ro root=
LABEL=/ rhgb acpi=off

Add the runlevel (1-5) to the
end of the command line.
For example:

grub append> ro root=
LABEL=/ 5

Add an S to the end of the
command line.

For example:

grub append> ro root=
LABEL=/ rhgb S

Enabling detailed boot messages can help you pinpoint
the cause of a boot problem.

Choose a larger screen resolution to fit more text on the
screen. If you like a certain text size, you can make the
change permanent by changing the menu. 1st file in the
/boot/grub directory. To do so, open the file with your
favorite text editor and append your changes to the line
starting with the word kernel. Save the file when you're
finished, and next time you boot, the changes take effect.
Be careful when you change this file because it’s easy to
make your system hard to boot.

If you’re having problems booting, this is a quick way
to find the problem.

You may gain a bit of CPU performance. Warning: Make
sure you don’t depend on USB devices (like mice)
before you disable this module.

You may want to do this if your laptop powers off
intermittently or has battery problems (even when it’s

plugged in).

Server machines typically don’t need a graphical environ-
ment most of the time (why run X Windows on a mail or
Web server?). Specify the runlevel on the command

line if you need to do system maintenance work and want a
friendly desktop environment. See Technique 22 for more
information about runlevels.

This is incredibly handy if you forget the root password.
When you're at the command line, you can change the
root password with the command sh-2.05b# passwd.
Enter a new password and confirm the new password when
prompted. When you're finished, type the command
sh-2.05b# reboot to reboot the system so you can log in
with your newly assigned password. Warning: Anyone can
use the S option. Be sure you know who has physical
access to your computer because with this tidbit of knowl-
edge, anyone can bypass the root password.

(continued)
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TaBLE 23-1 (continued)

To Do This

Make This Change to the
Default Linux Command Line

Timesaving Bonus Info

Boot into emergency repair
mode.

Add the word emergency to the
end of the command line.

For example:

grub append> ro root=
LABEL=/ emergency

Boot into emergency mode if you discover a problem
that prevents you from booting into single-user (or multi-
user) mode. When you boot into emergency mode, Linux
does not run any of the normal startup scripts — you're
dumped at a command line, and you're ready to fix what-
ever it is that’s gone wrong.
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Creating a Custom
Kernel

Linux kernel at the core. The kernel deals with hardware and pro-
vides basic functions such as creating processes, managing privi-
leges, and managing file systems.

F edora is a collection of applications, daemons, and drivers with a

In most cases, you don’t need to build your own kernel — plenty of well-
configured kernels are available for use. You may need features that
aren’t currently supported by the kernel included in the most recent
Fedora release. You may want to

v Add support for unusual hardware — USB scanners, cameras, joy-
sticks, and sound cards.

v Use additional encryption features that aren’t part of the standard
Fedora kernel.

v Explore alternative file systems.
v Omit drivers for devices you may never have.

v Omit amateur radio support — unless you're really into amateur radio.

Many kernel features are included in the form of modules — chunks of
code that are not loaded until you actually use the features. Modules don’t
take up a lot of space if you don’t use them, but removing the unused mod-
ules will save you time when you're rebuilding the kernel. You can also gain
some security by omitting modules that you don’t need.

In this technique, we show you how to build a kernel customized for your
needs, based on a safe and sound prototype, and with all the drivers that
you need to get your work done quickly.
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Reconfiguring Your Kernel —
Ready, Set, Go!

The kernel that’s included with the Fedora release is

a well-functioning and stable piece of software —
versatile, dependable, and sturdy. But what if it
doesn’t include the functionality you need?

No problem — you can just rebuild it. Stick with us,

and we’ll show you how to make it bigger, better, and

stronger . . . whatever you need.

The process of rebuilding your kernel involves sev-
eral steps, and each step is covered in the following
sections. Here’s an overview of the process:

1. Make a boot disk.
. Find the source code.
Configure the new kernel.

Customize the kernel.

And, finally, build the kernel.

AwN

“

Peeling onions

The Linux operating system is like an onion. If you peel
away the outer layers (the KDE desktop, the bash shell, and
so on), you find a layer of operating system libraries. The
libraries provide commonly used functions that enable
applications to find things like the current date, the IP
address of a given host, and so on.

Underneath the library layer is a set of system calls, which are
functions that perform low-level operations like changing
your user ID, allocating more memory, and opening a file.

At the core of the onion, you find the kernel. The kernel
uses device drivers to manage system hardware. The kernel
also schedules disk I/0O and CPU usage, responds to exter-
nal signals, creates and tears down processes, and performs
other low-level operations. But the kernel itself is layered,
too. The Linux kernel has a portable layer that runs on any
computer. At the very center of the onion is a hardware-
dependent layer that is customized for each CPU (Intel x86,
PowerPC, StrongARM, and so on).

Technique 24: Creating a Custom Kernel

Step 1: Making an Emergency
Plan, or Boot Disk

Before building a custom kernel, you need to make
a boot disk. A boot disk gives you a way back into
your system in a kernel emergency. If you're running
Mandrake or SuSE Linux, you can also create a res-
cue disk. A rescue disk is similar to a boot disk, but
it also contains diagnostics that can tell you a little
more about your computer if you run into boot prob-
lems. The process of creating a boot (or rescue) disk
varies by distribution.

To make a boot disk on a Fedora or Mandrake com-
puter, follow these steps:

1. Insert a floppy disk in your drive, open the ter-
minal window, and give yourself superuser
privileges.

2. Type the following command:
# /sbin/mkbootdisk “uname -r°

After some whirring and clicking, your floppy is
bootable.

3. To test the floppy (a good idea), shut down
completely and restart.

To make a rescue disk on a Mandrake system, follow
this procedure:

1. Insert a floppy disk in your drive, open the ter-
minal window, and give yourself superuser
privileges.

2. Type the following command and press Enter:
## /sbin/mkrescue

3. To test the floppy (a good idea), shut down
completely and restart.

If you're running SuSE Linux, use the YaST control
center to create a boot disk or a rescue disk (or both):

1. Open the main menu and choose System->YaST.
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2. When the YaST control center appears, click
System (in the left-hand pane).

3. Click Create a Boot, Rescue, or Module Floppy.

4. Follow the on-screen instructions to create a
boot floppy, rescue floppy, and module floppy.

You may need to boot into your computer’s
BIOS setup mode to change the boot sequence
to test the floppy. How you enter setup varies
with your machine, but instructions are typically
displayed on-screen at boot time.

You can also use the first install disc of your distri-
bution’s CD (or DVD) collection to boot into rescue
mode.

To boot into rescue mode on a Mandrake system, fol-
low these steps:
1. Place the first install disc in the CD/DVD drive.
2. Power up your system.

3. When you see the Press <F1> for more
options prompt, press F1.

A screen full of help text appears, followed by
the boot prompt (boot:).

4. Type rescue and press Enter.
Booting into rescue mode on a SuSE system is similar:

1. Place the first install disc in the CD/DVD drive.
2. Power up your system.

3. When the boot menu appears, use the down
arrow key to highlight Rescue System and
press Enter.

4. When prompted, choose your preferred lan-
guage from the menu and press Enter.

To boot into rescue mode on a Fedora computer:

1. Place the first install disc in the CD/DVD drive.
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Power up your system.

w

When the boot: prompt appears, type in the
following command and press Enter:

boot: Tinux rescue

(Don’t type the word boot:, that’s the boot
prompt — just type in 1inux rescue and press
Enter.)

. en prompted, choose your preferred lan-
Wh d, ch f d 1
guage from the menu and press Enter.

5. Choose your keyboard type from the menu and
press Enter.

6. At this point, Fedora asks if you want to start
the network devices in your computer. Choose
Yes or No (use the left- and right-arrow keys to
select the option that you want) and press
Enter to continue.

Fedora will try to find the root file system on your
hard drive and mount that file system so that you
can carry out any repairs that you need to make.
If you want to poke around a little without endan-
gering anything on your hard drive, tell Fedora to
mount the root file system in read-only mode.

7. Choose the mount mode you prefer (choose
Continue to mount your root file system in read/
write mode, Read-Only to safeguard your file
systems, or Skip to tell Fedora not to mount
your root file system).

If Fedora locates and mounts your root file
system, you can find it in the directory /mnt/
sysimage. If you look in that directory, you'll see
subdirectories such as /mnt/sysimage/bin, /mnt/
sysimage/boot, /mnt/sysimage/dev, and so on.
Those subdirectories correspond to the /bin,
/boot, and /dev directories on your computer’s
root file system.

Regardless of which distribution you’re using, after
you’ve booted into rescue mode, you eventually end
up at a command line. From there, you can mount
your root file system (and any other file systems
that you may need), make any repairs that you need,
and reboot.
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Step 2: Finding the Source Code

To rebuild the kernel, you first need to be sure that
the source code for the kernel is on your system.
Fedora distributes the kernel source in the form of
an RPM package. You could use the Red Hat Package
Manager to install the kernel source package by

hand,
depen

®
B»(ﬂ
&

but you’d also need to install a number of
dencies. Here’s an easier way:

Reusing the kernel that is included with the
latest distribution saves time. It’s a lot faster to
alter a kernel you already have handy than to
go through the work of downloading, cus-
tomizing, and building a whole new kernel
from scratch.

1. Open the Main Menu and choose System

Settings=>Add/Remove Applications.
Enter the root password when prompted.

The Package Manager checks the system for
installed packages and opens the Add or Remove
Packages window, showing both the installed
and available packages.

Scroll down the list and check the box next to
Kernel Development.

Click the Update button.

The System Preparation dialog opens.

Click the Continue button.

If prompted, insert the required disc and click OK.

When the installation is complete, a confirmation
window is displayed.

The Add/Remove Applications tool may get
confused if you're installing software from a
DVD instead of a CD. If the disc you're using
gives you trouble, just insert it and let the
autorun procedure start. Then follow the setup
wizard to install additional packages.

Step 3: Configuring
a New Kernel

After making a boot disk and installing your source
code, it’s time to configure a new kernel.

To build a custom kernel, follow these steps:

1

2.

Open a terminal window and give yourself
superuser privileges with the su command.
Type the following command and press Enter:
# cd /usr/src/linux-2.4

If you're using a kernel version newer than 2.4, cd
to that directory instead.

Type the following command and press Enter:
# make mrproper

This command cleans up any remnants of previ-
ous builds that might confuse your new build.

Identify the type of processor in your computer:

# uname -p

The command displays the processor type that
you're currently using (we assume i686 in the
examples that follow).

Copy the configuration file that matches your
processor type into your current directory:

# cp configs/kernel-2.4.22-1686.config
.config

By using a predefined configuration file, your
new kernel starts out in a well-defined and func-
tional state.

Type the following command and press Enter:
# make oldconfig

This step runs for a while and displays a ton of
messages. Just ignore the messages and grab
some caffeine.



Step 4: Customizing the Kernel

When you’re done with the preceding steps, you're
ready for the fun part: customization. Here’s how it
works:

1. Enter the following command:

# make menuconfig

The Linux Kernel Configuration window opens,
as shown in Figure 24-1.

i ocathostyusysrc/linux2.4
Go Help
Linux Kernel v2.4.22-1.2115.nptlcustom Configuration

File Edit View Terminal

Arrow keys navigate the menu. <Enter> selects submenus -—-->.
Highlighted letters are hotkeys. Pressing <Y> includes, <N> excludes,
<M> modularizes features. Press <Esc><Esc> to exit, <?> for Help.
Legend: [*] built-in [ ] excluded <M> module < > module capable

oadable module support ---

rocessor type and features --——>

eneral setup ---—>

M mory Technology Devices (MID) --->
arallel port support -—->

lug and Play configuration --->

lock devices --->

M 1ti-device support (RAID and LVM) -—--—>
N tworking options --->

< Exit > < Help >

* Figure 24-1: The Linux Kernel Configuration window.

If you run into some documentation that
suggests make xconfig rather than make
menuconfig, ignore it. xconfig has a nice user
interface, but in the 2.4 kernel series, it has a
serious flaw that will cause you all sorts of grief.

2. The menuconfig window (refer to Figure 24-1)
displays a list of feature groups. Use the arrow
keys to move up and down through the list and
press Enter to select the highlighted group.

The left- and right-arrow keys move you through
the <Select>, <Exit>, and <Help> choices at the
bottom of the window. To return to the previous
screen, choose <Exit>.

When you select a feature group and press Enter,
you see the list of features within that group (see
Figure 24-2). To the left of each feature, you see
an indicator that shows the state of the feature
(see Table 24-1).
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susan@kobe:/usr/src/linux2.4- Shell -Konsole

Session Edit View Bookmarks Settings Help

=

Linux Kernel v2.4.22-1.2115.nptlcustom20040126 Configuration

Arrow keys navigate the menu. <Enter> selects submenus --->.
Highlighted letters are hotkeys. Pressing <Y> includes, <N> excludes,
<M> modularizes features. Press <Esc><Esc> to exit, <?> for Help.
Legend: [#*] built-in [ ] excluded <M> module < > module capable

([(§] Quota support|

<*> FS v0 quota format support

<M> ernel automounter support

<M> ernel automounter version 4 support (also supports v3)

T
|
|
|
|
| eiserfs support

| nable reiserfs debug mode

| tats in /proc/fs/reiserfs

| DFS file system support (EXPERIMENTAL)

| miga FFS file system support (EXPERIMENTAL)
| pple HFS file system support (EXPERIMENTAL)
L

< Exit > < Help >

* Figure 24-2: The File Systems submenu.

TABLE 24-1: MENUCONFIG INDICATORS

Indicator Description

[ ] The feature is not selected and won’t be
included in the new kernel. You can build the
feature as a loadable module.

[*] The feature will be included (and can only be
compiled) in the new kernel.

<D The feature is not selected and won'’t be
compiled as a loadable module.

<M> The feature will become a loadable kernel

module.

Indented lines show separate components of a
feature. You can’t enable a component without
the parent feature.

The <He1p> button displays a help screen that
describes the highlighted feature. Most features
are well documented and include links to more
information, as shown in Figure 24-3.

Finding features in the Kernel Configuration
menu is like digging around in an old attic.
You'll find features for technologies that are
long since retired or so obscure that the aver-
age human will likely never know anyone who
needs them. Still, if you do need them, they're
here — just look around.
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x Kernel v2.4.22-1.2115.nptlcustom20040126 Configuration
CONFIG_QUOTA:
support (you can download sources from

<http://www.sf.net/projects/linuxquota/>). For further details, read
the Quota mini-HOWTO, available from

Technique 24: Creating a Custom Kernel

susan@kobe:jusr/src/linux2.4 - Shell - Konsole
Session Edit View Bookmarks Settings Help

* Figure 24-3: The Configuration help screen.

3.

4.

Make any changes that you want.

A couple of useful features to point out are alter-
nate file systems and USB support for otherwise
unsupported devices (such as cameras or USB
scanners).

If you have a single CPU in your machine,
(which is likely), you should choose to disable
SMP support in your new kernel. This feature
is included on the Processor Type and Features
menu and is labeled Symmetric Multiprocess-
ing Support. Click the button next to the n
before continuing.

When you’ve chosen the options you want to
include in your new kernel, choose <Exit> and
save your work.

Step 5: Building the Kernel

Now it’s time to start building the kernel. (Note:
Some of these steps will run for quite some time, so
you better grab a donut.) Follow these steps:

1

At the command line, enter the following com-
mand and press Enter:

# make dep

The make dep command computes dependencies
for the features that have changed.

7.

Enter the following command and press Enter:

# make clean

This command cleans up old unwanted files to
prepare for the build.

Choose a name for your new kernel (typically,
just add the current date to the end of the
name). Use your favorite editor to change the
EXTRAVERSION variable in the Makefile file. To
use kate (a KDE-friendly editor), type in the fol-
lowing command and press Enter:

# kate Makefile

Add the date to the end of the EXTRAVERSION
variable (after the word custom).

EXTRAVERSION=-1.2115.nptlcustom012504

Save the file and close the editor.

At the command line, type the following com-
mand and press Enter:

# make bzImage

This step takes quite a while, possibly a few
hours, because you're compiling most of the ker-
nel source code here.

Type the following command and press Enter:

# make modules

This compiles the source code for the kernel
modules that you selected. This step also takes
some time.

You did make a boot disk and test it, right?
If not, stop what you're doing, go back to
“Step 1: Making an Emergency Plan, or Boot
Disk,” earlier in this technique, and follow the
steps there.

Type the following command and press Enter:
# make modules_install
This step installs the new kernel modules. Don’t

worry — you’re not replacing your current ker-
nel; you're just adding another choice.



Type the following command and press Enter:

# make install

This step copies the new kernel into place and
adds the kernel to your boot menu.

To use the new kernel, reboot and highlight the
new kernel in the list of choices. Then press
Enter.

Your system boots with the newly built kernel.

Step 5: Building the Kernel ’63

Building kernels can be a tricky business. If
you experience trouble at boot time (kernel
panic)), reboot into your old kernel, and try
building the new kernel again.

Write down error messages! You can Google
for them later to see if other Linux users have
had similar problems and published work-
arounds on the Web.



Coping with the
SELinux Security

Technique  System

Save Time By

+~ Exploring the principles of
SELinux

v~ Understanding SELinux
terminology

v~ Disabling or disarming
SELinux

v~ Finding out about your
security policy

SELinux. Other distributions will incorporate SELinux in later

releases. You may not have to worry about it now, but this technique
will come in handy later. The SE in SELinux stands for Security Enhanced.
The driving force behind SELinux has been the National Security Agency
(NSA), which developed SELinux and donated the code to the open-source
community.

F edora Core 2 includes a new enhancement to the Linux kernel:

The SELinux package is a collection of kernel modifications, program
modifications, and configuration files that all work together to harden
your computer against abuse. Old Linux kernels (pre-SELinux) grant all
privileges to a special user named root (actually, privileges are granted
to the user whose numeric user ID is zero, and by convention that user is
named root). Any process whose user ID is zero is granted all privileges.
A process running as user ID zero is called a superuser. If you log in to
Linux as user root, you can do anything you want. If you log in as a non-
privileged user and then use the su command to become a superuser,
you can do anything you want. If you break into a Linux computer and
somehow manage to change your user ID to zero, you can do anything
you want. SELinux changes that.

Under Linux, access rules are based on the user ID, group ID, and file per-
missions. With SELinux, access rules are determined by the policy file,
and the rules are subject to change.

In this technique, we introduce you to SELinux. It’s a relatively new addi-
tion to the security force patrolling Fedora. It’s got some room to grow,
but it shows a lot of promise as a timesaving way to super-harden your
system.

Understanding the Principles of SELinux

When you enable SELinux, the kernel grants privileges based on three
factors: the security context of your process, the security context of the
object that you're trying to access, and a database of access rules called



a policy. The important feature that SELinux brings
to Linux is mandatory access control (MAC). A stan-
dard Linux kernel exercises discretionary access con-
trol (DAC). In a DAC system, a user can grant to any
other user access to things that he owns, at his own
discretion. DAC sounds friendly, but if you're trying
to run a secure organization, you don’t want us mere
users granting extra privileges to our friends. In a
MAC system, ownership and access are governed by
a complex and customizable set of rules controlled
by the organization.

The normal Linux security mechanism (access modes
and user/group IDs) and the SELinux mechanism
work together. Before a process can access an object,
the process must satisfy both mechanisms. If your
user ID has write permissions to a given file, it doesn’t
necessarily mean that SELinux will give its blessing,
too — it all depends on the policy.

SELinux introduces a few new terms to the Linux
lexicon, and it helps to have a good understanding
of those terms before going much further.

Everything is an object

An object is something that you can protect and
something that you can access. The Fedora Core 2
security policy defines a number of objects: A file is
an object, a file system is an object, a network socket
is an object, and a device is an object. In all, the FC2
policy defines 12 top-level objects:

\

Files (and directories)

File systems

File descriptors (a handle to an open file)
Sockets

Network nodes

Network interfaces (eth0, ppp0, and so on)

Processes

) W W W W W WA

IPC mechanisms (shared memory, semaphores,
and message queues)
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v The SELinux security server

\

The system log (syslog)

v Kernel capabilities (kill, reboot, set time, and
SO on)

v Passwords

The policy also defines a number of fine-grained spe-
cializations, such as a program file versus a configu-
ration file versus a data file.

Identifying subjects in SELinux

A subject is something that can act on an object
(think back to your elementary school grammar
classes, ugh). A process is a subject. Indirectly, a
user is considered a subject, too, because a new
process inherits its security context from the user.
A program can also play a part in determining the
security context of a process, so a program is often
considered a subject as well.

Every subject and every object have an associated
security context (or context for short). When a subject
wants to access an object, the kernel compares the
subject context, the object context, and the type of
access requested against a set of rules called the pol-
icy to decide whether to grant or deny the requested
access.

Understanding the security context

A security context is made up of three components:
an identity, a role, and a type. You can see the con-
text assigned to your login session with the com-
mand id -7Z:

$ id -Z
user_u:user_r:user_t

In this example, the identity is user_u, the role is
user_r, and the type is user_t. If you're logged in as
user root, you see a different context:

#id -z
root:staff_r:staff_t



106

The FC2 policy doesn’t create an identity for every
user: Nonprivileged users share the user_u identity.

By convention, role names end with _r, and type
names end with _t. A type that belongs to a process
is also known as a domain. A role is a name given to
a group of process types. Every user is assigned a
role, and the role determines which process types
(or domains) the user is authorized to use.

To see the security context assigned to a file (or
directory), use 1s -Z (we've trimmed a few columns
to fit it on the page):

# 1s -7 /var
system_u:object_r:acct_data_t account
system_u:object_r:var_t cache

system_u:object_r:var_t db
system_u:object_r:var_t empty
system_u:object_r:xserver_log_t gdm

system_u:object_r:var_lib_t 1ib
system_u:object_r:var_t Tocal
system_u:object_r:var_lock_t Tock
system_u:object_r:var_log_t 1og

Notice that in this example, the identity assigned to
each file is system_u: That’s a generic identity just
like user_u. user_u is shared by nonprivileged sub-
jects, and system_u is assigned to almost every file
object. Most files share the same identity (system_u)
and role (object_r). The type classifies each file
according to its security needs.

When you run a program whose type ends with
exec_t, that program causes a transition from your
current domain into a new domain. For example,
take a peek at the program that you use to change
your password (/usr/bin/passwd). The passwd
program lets you modify files that are normally
protected against nonprivileged users: When you
change your password, the new password is (typi-
cally) stored in /etc/shadow — a write-protected
file. If you look at the context assigned to /usr/bin/
passwd, you see this:
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$ 1s --scontext /usr/bin/passwd
system_u:object_r:passwd_exec_t
/usr/bin/passwd

Notice that the type name ends with _exec_t; that’s
your clue that this is a “domain transitioning” pro-
gram. When you run /usr/bin/passwd, your context
changes from user_u:user_r:user_t to user_u:
user_r:passwd_t, giving you just enough privileges
to modify /etc/shadow and /etc/passwd. If this
sounds suspiciously similar to a setuid root pro-
gram, it is. The important difference is that a domain
transition gives you only the privileges required to
act on the protected objects that you need, but a
setuid root program gives you all privileges.

Given the number of subjects, objects, and access
types on a typical Linux system, SELinux security
rules are far more complex than the old system.

Disabling or Disarming SELinux

The SELinux kernel can operate in enforcing mode
(the default) or in permissive mode:

v When you run in enforcing mode, the kernel
enforces the security policy that you've installed.

v When you run in permissive mode, the kernel
consults the security policy, but instead of pre-
venting you from doing something that the pol-
icy prohibits, the kernel simply logs the
violation.

Running in permissive mode will tell you what
kind of problems you're likely to encounter
when you switch over to enforcing mode.
Policy violations appear at the Linux console
and in the system log file (/var/1og/dmesg).

By default, Fedora Core 2 boots into enforcing

mode. If you want to switch over to permissive mode
after your computer has booted, use the following
command:



# echo "0" > /etc/selinux/enforce

(You need superuser privileges to write to the /etc/

selinux/enforce.) To switch back to enforcing mode,

use this command:

# echo "1" > /etc/selinux/enforce

If you want Fedora to run in permissive mode each
time you boot, give yourself superuser privileges
and type in the following command:

# echo "SELINUX=permissive" > /etc/
sysconfig/selinux

If you prefer to run in enforcing mode after each
boot, use this command:

# echo "SELINUX=enforcing" > /etc/
sysconfig/selinux

If you're sure that you’ll never want to use SELinux
on your computer, you can completely disable the
kernel extensions with the following command:

# echo "SELINUX=disabled" > /etc/
sysconfig/selinux

B> abled modes is that in permissive mode, the
kernel logs policy violations and labels new files
with the appropriate security context. If you
disable SELinux completely, new files and
directories are created without a security con-
text, and if you ever want to turn SELinux back
on, you'll have to relabel your computer (that
is, reapply security contexts). Relabeling can be
a lot of work — we recommend running in per-
missive mode instead of disabling SELinux.

2 The difference between permissive and dis-
)

&

Playing the Right Role

One of the consequences of SELinux is that mere-
mortal users can’t access objects that they may

have been able to access before. For example, if your

security context is user_u:user_r:user_t and you
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run the ps (process status) command, you can’t see
privileged processes.

It’s very important to use the correct role when you
do system administration work. Some commands
work in the staff_r role but produce the wrong
results. For example, if you create a new user
account while you're logged in to the sysadm_r role,
the home directory for the new account is created
with the right context:

#id -z
root:sysadm_r:sysadm_t

# useradd franklin

# 1s -7 /home/franklin
root:object_r:user_home_dir_t

However, if you create a new account from root’s
default role (staff_r), the home directory is labeled
incorrectly:

#id -z
root:staff_r:sysadm_t

# useradd franklin

# 1s -7 /home/franklin
root:object_r:home_root_t

You may be wondering why the identity component
of each context is root instead of franklin. The
answer is a bit confusing. frank1in is a generic user;
that is, franklin appears in the Linux user database,
but not in the SELinux policy. That means that
franklin is not an identity and therefore can’t be
assigned as the identity for his home directory.
Generic users share a common identity: user_u.

To create a new Linux user with a corresponding
identity, use seuseradd instead of useradd:

# newrole -r sysadm_r
# seuseradd -r -m trixie
loading new policy...

We’ve thrown another new command at you in this
example: newrole. newrole starts a new shell with a
different security context. Your identity stays the
same, but your role changes to the one you
requested. See man newrole for more details.
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Finding Out about Your
SELinux Policy

At the time we’re writing this, Fedora Core 2 provides
few utilities that you can use to manage SELinux
policies. That will change as software vendors and
open-source developers learn more about SELinux.
For now, you can use the utilities provided by the
setools and setools-gui RPM packages (included in
the Fedora Core 2 distribution) to find out more
about the default policy installed on your system.
See Technique 17 for more information about install-
ing RPM packages.

The seinfo command can show you a wealth of
information about your policy. For example, to see a
list of all identities, give yourself superuser privi-
leges and then type in the following command:

# seinfo --users
Users: b
system_u
user_u
root
freddie
trixie

To see the list of roles defined for your system, use
this command:

# seinfo --roles

Roles: 5
object_r
system_r
sysadm_r
user_r
staff_r

To see the roles that each identity is allowed to
assume, add the --expand option, like this:

# seinfo --users --expand
Users: 5
system_u
system_r
user_u
user_r
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root
staff_r
sysadm_r
system_r

freddie
staff_r
user_r

trixie
staff_r

To see the domains that a given role is allowed to
assume, use --roles=name --expand

# seinfo --roles=sysadm_r --expand
sysadm_r
null_device_t
zero_device_t
devtty_t
local_login_t
remote_login_t

Every object class defines a list of permissions, but
it’s probably easier to think of a permission as an
action. For example, you can mount, unmount, and
remount an object belonging to the filesystem class.
To see the permissions (actions) defined for a given
class, use this command:

# seinfo --classes=filesystem --expand

filesystem
mount
remount
unmount
getattr
relabelfrom
relabelto
transition
associate
quotamod
quotaget

Use the following command to see the list of types:

# seinfo --types
Types: 291
device_t
null_device_t
zero_device_t
console_device_t
memory_device_t



random_device_t
urandom_device_t
devtty_t

To see the attributes of a given type, use this
command:

Finding Out about Your SELinux Policy ’6 9

# seinfo --types=bin_t
bin_t
file_type
sysadmfile

By convention, an object of type bin_t is a file (it has
the attribute file_type), and it’s a system adminis-
tration file (sysadmfile).
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the current state of your Linux kernel. The files in /proc don’t really

exist on disk; rather, they’re collections of data that can be viewed
and navigated just like real files. If you look at the modification time for
the files in /proc, you'll see that the date is always current. That’s accu-
rate because the content of each file is being created on demand as you
view it.

The /proc file system is a virtual file system full of files representing

You can discover a lot about your system by viewing the contents of the
files in /proc. Every process running on your system has a directory in
/proc. Each process directory is full of subdirectories and files that con-
tain tidbits of data about the process. Because the information is broken
down into small pieces, you can search quickly for just what you need to
know about a process.

The /proc file system also contains information about system resources —
such as memory usage, CPU usage, and system statistics. The files are
constantly being updated, so the information you get from /proc is always
current. /proc also maintains information files about all the devices on
your network. You can use this information to help debug troublesome
new devices.

Using the /proc file system to manipulate the state of the kernel is a real
timesaver. Instead of using complex arguments to adjust your kernel, the
/proc file system gives you easy access to many of the kernel’s variables.
You can tighten security with just a few variable settings, and improve on
an existing firewall in no time.

In this technique, we introduce you to /proc, and show you some subtle
but effective (and quick) changes you can make to the kernel that will
make your system safer and save you a few keystrokes in the long run.

Exploring the Process-Related Entries in /proc

Every process running on your system has its own directory in the /proc
file system. You can use the files in the process directory to identify the
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processes running on your system. You can discover
who’s running the process, what command line argu-
ments started the process, and what files that
process currently has open.

The directory name for each process is taken from
the process ID. For example, the directory that con-
tains information about process 1 (the init process)
is named /proc/1. To view the process directory, fol-
low these steps:

1. Open the Konqueror Web browser.
2. Type file:/proc in the Location field and

press Enter.

Press the F9 key to close Konqueror's naviga-
tion panel and buy more screen real estate for
the directories and files in /proc.

You're treated to a view of the contents of the
/proc directory, as shown in Figure 26-1.
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B0 12 08 Directory 20000310 1310 rarar et 1000
SR 0B Directory 20000310 1310 rarar ot e o
B 15585 0B Directory 20000310 1310 pursrx oot oot
£3 15638 08 Direciory 2004-03-10 1310 rararx ot gém
2 15630 0R Dieciory 20040310 13:10 rurarx oot oot
25 15648 O Directory 0040310 1310 Furrx susan susan
2215701 0 Directory 20040310 1310 rarara susan suman
215731 OB Directory 20040310 1310 Fararx susan susan
< 15736 08 Directory 2004-03-10 1310 r-xr-5rx susan Susan
L 15739 08 Directory 2004-03-10 13: 10 r-xr-xr-x susan SUsan
215742 08 Directory 2004-03-10 13:10 r-xr-xrx susan susan
= 15750 00 Directory 2004-03-10 1310 r-xr-xr-x susan Suman
215756 0B Directory 2004-03-10 1310 rxrxrx susan Susan
15757 08 Directory 2004-03-10 1310 r-xr-xrx susan Susan
= 15759 0B Direclory 2004-03-10 13:10 t-xr-xr-x susan Susan
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* Figure 26-1: Viewing /proc in Konqueror.

3. For the best view of the /proc directory, choose
Viewr>View Moder>Detailed List View.

The directories with numerical names contain
information about the processes currently run-
ning on your system (the directory name corre-
sponds to the process number).
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4. Double-click a process directory to view the
directory contents (see Figure 26-2).
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* Figure 26-2: The contents of a process directory.

Table 26-1 lists the files and directories where
you can find some interesting information about
a process.

5. To view the contents of any file in the process
directory, right-click the filename and choose
Open With from the pop-up menu.

6. Enter kedit in the Open With field and click OK.

kedit opens, displaying the file contents, as
shown in Figure 26-3.
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¢ Figure 26-3: Exposing the status file with kedit.
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TaBLE 26-1: PRocesS-RELATED DIRECTORIES IN THE /PROC FILE SYSTEM
Directory What You Find

cwd The cwd directory is a symbolic link to the current working directory of the process (the directory named in
the Link column). If you're running a bash shell and your current working directory is /tmp, /proc/$$/cwd is a
symbolic link to /tmp ($$ is a shell variable that contains your process ID).

fd The fd directory contains one entry for each open file. Like cwd, the files in the fd subdirectory are symbolic
links to the open files. File descriptor 0 is connected to the standard input stream for the process, descriptor 1
is connected to the standard output stream, and descriptor 2 is connected to the standard error stream.

cmdline Open the cmd1ine file with kedit to view the command line arguments that started the process.
environ Open the environ file to view the environment variables used by the process.

mounts Open the mounts file to view a list of currently mounted devices in use by the process.

status The status file keeps running statistics about the current process.

7. When you’re done exploring the file contents, e Bl Ve B i
close the editor window. &=
1 El;.;::l: ‘!}.,:E;"“._,Jn, version i
7 If you check the Remember Application Asso- s vl
- («a ciation for This Type of File box when you 3 omn e o seckoiss leda' e’
&>/ open afile with kedit, you can just double- T G TR
click to open future files with the editor. vup: deessare Soisrio smetsoass
S
If you prefer working at the command line (or you rched: s ko
don’t have a graphical interface handy), you can use Rectine: Taeas e
the more command to display the contents of files gt ok
within the process directory: raplotals 630024 k8
Eoisasn peeet B o
1. Open a terminal window and move into the * Figure 26-4: Exposing the status file with more.
process directory.
2. Display the file you want to read with the fol- g If you go to /proc/self, you'll find it contains
lowing command: - («a a symbolic link to the process you're running.
$ more filename & Look in the Link column for the process ID. Be
aware that /proc/self is pretty shifty. If you
The contents of the file are displayed in the ter- use a command like 1s to look at the /proc/
minal window, as shown in Figure 26-4. self directory and then look at it again with
’ another tool, it changes. /proc/self magically
3. Press the spacebar to see the next page of data. points to whichever process opens it.

Whether you get information with kedit or at the

command line, you can find lots of handy informa- Su”/ey"nq your System ﬁ,om /’.’”"00

tion about the processes on your system with /proc.

Files that contain configuration information for
devices connected to your computer are scattered



throughout the /proc file system. The /proc file
system also contains files full of information about
system resources. To find the device or system
resource information on your system, you may need
to do some exploring, but we show you some good
places to start.

A few of the files in /proc that relate directly to hard-
ware and system resources are worth mentioning:

v /proc/bus/usb: This file contains information
about USB (Universal Serial Bus) devices cur-
rently plugged into your system. In this file, you
find a rundown of the mice, cameras, and serial
storage devices currently connected to your
computer, as shown in Figure 26-5.

Session Edt View Bookmarks Setiings Help

3=

susanflocalhost ush]$ more devices L
T: Bus=01 Lev=00 Prat=00 Port=00 Cnt=00 Devé= 1 Spd=12 MxCh= 2

B:  Allocs118/500 us (13%), #int= 1, flso= O

D: Vers 1.00 Cls=Cd(hub ) Sub=00 Prot=00 MxPS= @ sCfgs= 1

F: Vendor=0000 ProdiD=0000 Rev= 0,00

ProductzUSE UHCT Roat Hab

T

rinlNusber={ca0

#lfss 1 Cfges 1 AtT=40 MxPwrs

i If#= 0 Alt= O #IPs= 1 Cls= m“l\db } Sub=00 Prot=00 Draver=hub

E: Ad=BL(I) AtT=03(Int.) MuPS= 8 Ivl=I5ins

T: Uus=01 Lav=01 PPat=0l Port=00 Cat=01 Deve= 3 Spa=13 MxCh= O
e fe ) Sub=0b Prot=00 NxPs=1s sfge= 1

B PwT=  OmA

t 1f8= 0 Alt= 0 #EFe= 3 Cle=06(still) Sub=01 Prot=01 Driver=(none)
+ Ad=RI(T) AtT=02(fulk) WxPi= 64 Tvisims

Ad=04(0) Atr=02(Dulk) MxPS= 64 Ivi=Des

Ad=BS(1) Atr=03(Int.) MxPS= B4 Ivlslins
fus=0l Lev=0l Prat=01 Port=0l Cnt=02 Deve= 2 Snn—l 5 Mxtn L]
Vers 1.00 Cls=00(»ifc ) Sub=00 Prot=00 MxPi= 8 oCf)

Vendor=046d FrodiD=co0l Revs 4.01
uanufacturer=Logitech
Froductsi4g

* #1fs= 1 Clg#= 1 Atr=al MxPwr= 26mA
1fe= 0 Alt= 0 #EPs= 1 Cls=Q3(HID )} Sub=01 Prot=02 Driver=hid

FRnrSEOm e o

L

¢ Figure 26-5: Viewing the currently connected USB
devices.

7 If you're having trouble getting a camera or
S («@ scanner to work, look here first to be sure that
& the device is properly connected and identified.

V¥ /proc/scsi/scsi: This file contains information
about any SCSI devices currently attached to
your system. Check it out if you're having trouble
getting a SCSI device to work.

K/
a Q@
&

If you're having device driver problems and
decide to appeal to a newsgroup for help,
include the information you find in the /proc
file corresponding to the device. The /proc file
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might contain information that helps a news-
group member determine the cause of your
problem.

v /proc/cpuinfo: This file contains a collection of
information about the system’s CPU. This is the
place to look for all the really geeky details about
your CPU.

v /proc/crypto: The /proc/crypto file contains
information about the current encryption algo-
rithms and digital signature tools installed on
your system.

v /proc/meminfo: This file contains a wealth of
information about your system’s memory
resources, as shown in Figure 26-6.

2 s Vocalhosi pioe - Shell - Kansole
Session Edr View Boobmarks Setiings Help
[g)|=

[susan@localhost proc]s mere meminfo

ata Uhe T shared: buffers: ca
Men: 3250!9968 iz 523590 15491072 0 27947 005 ..02039296
Swap: SGGIZHITE  SHLETI0 BEOITOLEE
MerTotal: 320332 kB
MenFroe: 15128 k¥
uamshared:
Buffers:
Cached:

swaptached: 1632 k¥
hctiva: 134378 kB
Inactive: 137892 kB
HighTotal: 0 k8
HighFree: 0 kB
LowTotal: 20332 kB
LouFree: 15128 kB
swapTatal: 650624 kH
SwapFree: G444 ki

[susanglocalhost procl$

o

¢ Figure 26-6: Checking out the status of the system'’s
memory.

] If your system performance is bad, check out

- («a the /proc/meminfo file to find out if you're

& running short on memory.

v /proc/filesystems: This file contains informa-
tion about the file system types that can be
mounted on your system. Check out /proc/
filesystems to find out what kind of drives you
can mount on your system. If ntfs isn’t in the
list, you can’t mount Windows drives on your
Linux machine.

v /proc/uptime: You trivia buffs out there will
enjoy this one. This first number in this file is the
length of time the system has been running (in
seconds), and the second number is the number
of seconds that the system has been idle.
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] Divide the number of seconds idle by the
(8 (4& uptime, and you'll find out the percentage of
) time that your system is running without being

used. If you have extra CPU time to share, get
in touch with setiathome.ss1.berkeley.edu
to share the wealth.

Closing Down Security
Gaps with /proc

With just a few quick changes to the files in /proc,
you can make a good firewall even better. The Linux
kernel includes a number of variables that affect sys-
tem security. The variables receive their default set-
tings when the kernel is built, but you can customize
them to tighten up your security even more. With a
little help from /proc, you don’t need to completely
rebuild your kernel to take advantage of some of
these optional benefits; you can tweak the running
kernel with the variables in /proc.

Any changes you make in the /proc files will revert
back to the stored kernel configuration when you
reboot your system. To make the changes take effect
every time you reboot, you can create a startup
script (or modify an existing one) to apply the
changes automatically.

By making changes to the kernel variables, you can
close security gaps that are commonly left open in
most kernels. The changes in our example won’t
keep out every hacker or shut down all denial-of-
service requests, but they’re a good place to start.

If you are running Fedora or Mandrake, you can
change the settings of the kernel variables at
startup, by following these steps:

1. Open a terminal window and give yourself
superuser privileges with the su command.

2. Move to the /etc/rc.d directory:
# cd /etc/rc.d

Technique 26: Finding Out about Your System with /proc

3. Open the rc.local file with your favorite edi-
tor (we're using kedit):
# kedit rc.local

4. Add the following lines of code to the end of
the rc.local file:

echo 1 > /proc/sys/net/ipv4/icmp_echo_
ignore_broadcasts

echo 1 > /proc/sys/net/ipv4/conf/*/1og_
martians

echo 0 > /proc/sys/net/ipvé4/conf/*/
accept_redirects

5. Save the changes and close the editor.

6. Reboot your system to make the changes take
effect.

If you're a SuSE user, you need to make the same
additions, but to a different file. Follow these steps
to change your kernel variables at startup:

1. Open a terminal window and give yourself
superuser privileges with the su command.

2. Move to the /etc/init.d directory:
# cd /etc/init.d

3. Open the boot.Tlocal file with your favorite
editor (we’re using kedit):
## kedit boot.local

4. Add the following lines of code to the end of
the boot.1ocal file:

echo 1 > /proc/sys/net/ipv4/icmp_echo_
ignore_broadcasts

echo 1 > /proc/sys/net/ipv4/conf/*/Tog_
martians

echo 0 > /proc/sys/net/ipv4/conf/*/
accept_redirects

4. Save the changes and close the editor.
6. Reboot your system to make the changes take
effect.

The three variables we’ve changed tighten your net-
work security a bit. They are as follows:
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V¥ icmp_echo_ignore_broadcasts: Enabling this
variable tells your system to ignore broadcast
pings, which can help spare you from denial-of-
service attacks.

v log_martians: Enable this variable to tell the
kernel to send a message to the system log when
an illegally addressed packet is received. After
setting this variable, monitor the syslog files
(see Technique 41) to find out if you're receiving
nasty packets.

V¥ accept_redirects: Disable this variable to help
prevent man-in-the-middle attacks. Turning off
accept_redirects tells your system to prevent
outgoing packets from being redirected. Hackers
can’t grab your outbound packets looking for
sensitive information (such as passwords or
credit card numbers).

You can change many variables to affect the state of
your kernel. Some of the variables work like on/off
switches. To turn on a variable (or enable the vari-
able), echo a 1 to it in the startup script. To turn a
variable off (or disable the variable), echo a 0 to it in
the startup script. Variables that control time settings
or cache sizes are manipulated with integer values.

) You can find many good resources on the
B (@ Web that list kernel variables and what they
& control. Google for /proc/sys variables,
and you'll get dozens of hits that will help you
find good settings for your system.

Popping the Cork: Speeding
Up WINE with /proc

If you use WINE in your daily life and want a quicker
way to start your programs, using the files in /proc
can help.

/ If you're not familiar with WINE (the program,
not the beverage), it's a package that lets you
) run Windows programs on Linux machines.
The abbreviation WINE stands for Wine Is Not
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an Emulator. WINE doesn’t emulate Windows
machines, but it runs their programs in a
Linux environment.

Normally, to start a program with WINE, you need
to preface the command with wine. With a simple
change to the startup file, you can run a Windows
program simply by typing its name, just like the
Linux programs on your system.

To simplify the startup of your Windows programs in
Fedora or Mandrake, follow these steps:

1. Open a terminal window and give yourself
superuser privileges with the su command.
2. Move to the /etc/rc.d directory:
# cd /etc/rc.d

3. Open the rc.local file with your favorite editor:
# kedit rc.local

4. Add the following commands to the end of
the file:

modprobe binfmt_misc

echo '":Wine:M::MZ::/usr/local/bin/
wine:"' > /proc/sys/fs/binfmt_misc/
register

5. Save your work and exit the editor.

6. Reboot your system to make the changes take
effect.

If you're a SuSE user, you can add similar code to
your boot script. To simplify the startup of your
Windows programs in SuSE, follow these steps:

1. Open a terminal window and give yourself
superuser privileges with the su command.
2. Move to the /etc/init.d directory:
# cd /etc/init.d

3. Open the boot.Tlocal file with your favorite
editor:

# kedit boot.local
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o »

Add the following commands to the end of

the file:

modprobe binfmt_misc

echo ':Wine:M::MZ::/usr/local/bin/
wine:" > /proc/sys/fs/binfmt_misc/
register

Save your work and exit the editor.

Reboot your system to make the changes take
effect.

Technique 26: Finding Out about Your System with /proc

The preceding steps change the boot script that is
executed at boot time. The two lines shown in Step 4
tell Linux to automatically recognize Microsoft Win-
dows programs and execute them with wine. For
example, to play Minesweeper, you can simply type
the command . /winmine.exe.

e to remember to type wine before entering the
program name. This also makes it easier to
include Windows programs on menus and

shortcuts.

? When you make this change, you don’t have
g}

&
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“A centralized security management system sounds
fine, but. then what would we do with the dogs?”






Closing Those
Prying Eyes

Technique

Save Time By

v~ Reading and understand-
ing file permissions

v~ Limiting file permissions
to block access to sensi-
tive information

1~ Setting user permissions
with a browser

with well-assigned permissions and good system administration

K eeping private documents out of the hands of snoops is easy
practices.

In this technique, we explain how to use file permissions to limit access
to sensitive documents and dangerous programs on a Linux machine.
You can set the permissions either at the command line or with a graphi-
cal interface. If you have access to a graphical environment (either
Konqueror or Nautilus will work), it’s definitely the friendlier way to go.

Reading and Understanding File Permissions

Knowing how to read and use file permissions is important for maintain-
ing privacy in your file system. Limiting a user’s access is simple when
you understand the permissions.

Every file and directory in a Linux computer is owned by one specific
user and one specific group. When you try to access a file, you're classi-
fied into one of three categories:

v Owner: You're the owner if your effective user ID is the same as the
file’s owner.

v Group member: You're a member of the group if your effective group
ID is the same as the file’s group.

v Other: You're an “other” if you're not the owner and not a member of
the group.

After you’'ve been categorized, Linux looks at the permissions assigned
to your category. For example, if you're accessing a file owned by user
freddie and you're logged in as user freddie, Linux examines the owner
permissions for that file (because you are the owner). If you're not logged
in as user freddie but you are a member of the group that owns the file,
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Linux examines the group permissions for the file. If
you're not the owner and you’re not a member of the
file’s group, Linux examines the other permissions.

Next, Linux compares the permissions (owner per-
missions, group permissions, or other permissions)
with the type of access you’re attempting. If you are
the file’s owner and are trying to read the file, Linux
checks the read bit in the owner permissions. If
you're trying to modify the file, Linux checks the
write bit on the owner permissions.

You can control three types of access for each user
category:

v Read permissions grant (or deny) the right to
read a file or to list the contents of a directory.

v Write permissions control the right to change
the contents of the file or directory.

v Execute permissions control the right to run a
program or script. If you're accessing a directory,
the execute permissions control whether you
can access the files within the directory.

To display the permissions for an entire directory,
enter 1s -1 at the command line. The -1 flag forces
1s to display permissions (and the file’s owner

and group) along with the name of each file (see
Figure 27-1).

K susan@kobe:/home/susan - Shell - Konsole =[o]x
Session Edit View Bookmarks Settings Help
_U‘lﬂ
i
[root@kobe susan]# 1ls -1 ’E
total 15188
~I'W-I--T=-— 1 root root 62136 Jan 9 06:15 5717374004.png

—TW-TW-T-— 1 susan susan 494538 Jan 7 13:11 aaa

-TW-TW-T—— 1 susan susan 65591 Jan 20 10:48 aaa.asc

ArWXTWXT WX 2 1000 users 4096 Jan 2 09:11 autocutsel-0.6.2
~TW-—————— 1 susan susan 40776 Jan 2 08:59 autocutsel-0.6.2.tar.
-TW-T--T—— 1 susan susan 1957266 Oct 28 17:58 balsa-2.0.15-1.1386.T
-TW-TW-T-- 1 susan susan 2498560 Jan 14 09:42 balsa-2.0.15-1.i386.T
tar

—TW-TW-T—— 1 susan susan 494538 Jan 20 14:22 ccc

drwxr-xr-x 4 susan susan 4096 Feb 9 09:00 Desktop

drwn-———-—- 5 susan susan 4096 Jan 21 13:12 evolution

drwxrwxr-x 7 susan susan 4096 Jan 13 13:57 example

drwXTWXr-X 5 susan susan 4096 Jan 8 17:27 jail

drwxr-xr-x 3 root root 4096 Jan 8 17:38 jail2

-TW-TW-T—— 1 susan susan 851968 Feb 8 08:55 myimage.iso

-TW-TW-T-— 1 susan susan 65587 Jan 19 16:25 packagelist.asc

drwxr —Xxr-X 2 susan Toot 4096 Feb 9 09:46 pictures [
ATWXTWRT -X 2 susan susan 4096 Feb 8 12:08 pictures.old =
-TW-TW-T—— 1 susan susan 5476 Feb 1 08:29 sensorlog [
-TW-TW-T—— 1 susan susan 48096 Jan 13 10:25 test.tgz

drwxr-xr-x 4 susan susan 4096 Jan 14 14:03 tmp [
-TW-—————— 1 susan susan 726319 Jan 1 18:09 vnc-3.3.7-1.i386.Tpm |

¢ Figure 27-1: The long form of directory contents.

The listing shows seven groups of information. From
right to left, they are as follows:
v File permissions
Link count
Name of the user that owns the file
Name of the group that owns the file

File size (in bytes)

A W W W WY

Date and time the file was last modified

v File (or directory) name

The file permissions are displayed as an odd collec-
tion of ten characters, with dashes replacing the
privileges that are denied to that user category.

For the sake of dissection, we’ve chosen the following
listing as an example:

drwxr-x--- 4 freddie acctg 65595 Jan 20
14:14 tables

The first letter in the permissions column doesn’t
have anything to do with permissions. Instead, it
tells you what kind of file you're dealing with. The
most common entries are d for directory or - for file.
In our example, the d at the beginning of the listing
indicates that it is a directory.

The next three-letter grouping tells you the access
permissions for the file’s owner (user freddie, in
this example). The letters rwx stand for read, write,
and execute. freddie has full permissions to this
directory.

The next three-letter grouping tells you the group
privileges. In our example, r-x stands for read and
execute. The acctg group isn’t allowed to change
files in the directory.

The last three-letter group tells you the file permis-
sions for any other user (not the owner and not a
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member of the file’s group). In our example, the ---
means that anyone who isn’t a member of the acctg
group or isn’t the file owner is denied all access to
the file.

Controlling Permissions at
the Command Line

If you have access to a desktop environment,
maintaining permissions is easy and quick with

a browser. If you need to set permissions over an
SSH connection or for a dedicated server (without
a desktop environment), you can use the command
line to change ownership and file permissions.

See Table 27-1 for details on changing ownership
permissions.

Use the chmod command to change the permissions
for users, groups, or others. Table 27-2 explains how.
The chmod command also works with the + (plus)
and - (minus) signs to turn permissions on and off.
Substitute the plus or minus sign for the equal sign
in the command, and the permissions listed in the
argument are turned on or off. A plus sign turns the
listed permission on, and a minus sign turns it off.

TaBLE 27-1: CHANGING OWNERSHIP PERMISSIONS

181

For example, the following command turns on read
permissions for the user without changing any of the
other permissions:

$ chmod u+r filename

This command turns off write permissions for a
group:

$chmod g-w filename

This command turns off all permissions for non-
group users:

$ chmod o-rwx filename

You can see a pattern starting to form.

If you need to, you can use the command line to set
privileges, but there is a friendlier way, as described
in the next section.

If you really want to test the spin in your pro-
peller, you can set the permissions with octal
numbers. The process is a little cryptic, but if
you're inclined to try it, check out the info
chmod page and follow the links to Note File
Permissions=>Numeric Modes.

To Do This

Use This Command

Change ownership of a file or directory at the command line.

Change ownership of a directory and all the directories below
it (that is, just add the -R recursive flag).

Change the group ownership of a file.

Change the group ownership of a directory and all
the directories below it.

$ chown username filename

$ chown -R username directoryname

$ chgrp groupname filename

$ chgrp -R groupname directoryname
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TaBLE 27-2: CHANGING FiLE PERMISSIONS

To Do This Use This Command

Change the user (owner) permissions to include read, write, $ chmod u=rwx filename
and execute.

Exclude a permission from the user. You do this by excluding it $ chmod u=rx filename
from the command. For example, to assign read and execute (Note: w is excluded)
privileges only, use rx.

Set permissions for a group. Note that you substitute a g into the $ chmod g=rwx filename
command.

Set permissions for users who aren’t group members or an owner. $ chmod o=rwx filename
Deny privileges to nongroup members who aren’t owners. $ chmod o= filename

The Properties dialog opens, as shown in

Changing File Permissions Figure 292,
from a Desktop

W file:/home/susan/ - Konqueror -0x
Location Edit View Go Bookmarks Tools Settings Window Help
. . . . hd Properties for packagelistasc - Konqueror ax 4
Sometimes the command line is your only choice, e =]
. . . E Location: General | p " 3l T
but if you have access to a graphical interface, . — —= 5
. . . . . autocutsel-0.6.. jail2
there’s a friendlier way to manage file permissions: \@ - o IS
< (0, |packagelist.asc |
the Konqueror browser. - =
pictures : [17374004.png
Type: PGP/MIME Encrypted Message Header 7
Nautilus offers the same functionality to S . o
GNOME users. Double-click the Start Here Size 54.0KB (65,567 =
icon on the desktop and Surf along /-‘ Free space on/:  959.9 MB/5.2 GB (83% used) S
: L) Modified:  01/19/04 04:25 pm @j
myimage.iso Accessed:  02/08/04 12:50 pm bmm-i.lzl—l.
To view and modify file permissions with the “5
Konqueror browser, follow these steps: = %-d = Cancel
1 CliCk the Start Hel’e or Home iCOll on your KDE packagelist.asc (64.0 KB) PGP/MIME Encrypted Message Header
desktop or taskbar. * Figure 27-2: The Properties dialog.

2. When Konqueror opens, locate the file you

want to modify. 4. Click the Permissions tab.

The Permissions dialog opens showing the cur-

¥\ You can navigate to the file you want to modify rent permissions for the file (see Figure 27-3).
- { <@ in one quick step by entering file:/pathname The permissions dialog is easy to interpret and
& in the Location field to step directly into the change.

directory that contains your file.
If the check boxes and fields displayed on the

3. After you've located the file you want to work window are disabled, you don’t have enough
with, right-click the file and choose Properties privileges to edit the permissions for that file. If
from the pop-up menu. you need superuser privileges to change per-

missions for a file or directory, open a terminal
window and use the su command to gain



superuser privileges. Then type konqueror in
the command line and press Enter to start a
copy of the browser with your newly enhanced
privileges.

General 4Eermi55\ons ]

~Access Permissions
Class Read Write Exec Special
User -] (R CJ ] Setuid
Group (R = I I SetGID
Others (R I =i ICJ Sticky

— Ownership -

User. susan

Group: susan ¥

Cancel

* Figure 27-3: The Permissions dialog.

5.

To change read, write, or execute privileges for
the file or directory, simply check the boxes
next to User, Group, or Others.

If a box is checked, the user (or group) has that
permission. If the box is empty, that permission
is denied.

Before you modify the check boxes in the
Special column, make sure that you know
what you're doing; read the sidebar, “What

6.

makes a check box Special?” for details.

To change ownership, enter the new user or
group owner in the appropriate field.

Nautilus users: Use the drop-down list boxes
to choose from existing users and groups
when you change the ownership of a file or
directory.

Changing File Permissions from a Desktop ’83

After you make the necessary changes to the
Permissions dialog, click OK to save your
changes and close the dialog.

What makes a check box Special?

Under the column header labeled Special, you see check
boxes next to the labels Set UID, Set GID, and Sticky.
These check boxes merit special consideration.

v Set UID: When a Set UID bit is turned on for a

program, your EUID (effective user ID) becomes the
same as the program’s owner when you run the
program. You also gain all the privileges of the
program'’s owner. In other words, if user freddie
runs a Set UID program owned by user root,
freddie has superuser privileges while that pro-
gram is running.

Set UID affects programs only; it's really not impor-
tant for data files and directories. If you find a Set
UID program, read the WARNING!

Warning: Set UID programs are potentially danger-
ous. Users can gain extra privileges by using files that
grant them superuser privileges. See Technique 57 for
information about preventing security breaches
uncovered by the setuid and setgid bits.

Set GID: The Set GID bit works similarly to Set
UID — anyone running the program gains all the
privileges of the group.

When the Set GID box is checked for a directory,
the files in that directory belong to that group
regardless of who puts the files in the directory.

Sticky: Checking the Sticky box affects directories
only. If this box is checked, you can’t remove (or
rename) a file in that directory unless you're the file
owner.



Using Encryption
for Extra Security

Technique

Save Time By

v Using kgpg in your desk-
top environment

v~ Using gpg at the com-
mand line

»* Encrypting and signing
e-mail with Evolution

v~ Adding Enigmail security
to Mozilla

save you a lot of headaches. Public-key cryptography provides a

quick and easy way to safeguard e-mail messages and sensitive files.
Public-key cryptography involves two big numbers: a public key and a pri-
vate key. When you create a key pair, you keep the private key to yourself
and share the public key with anyone you wish. The numbers in a key pair
are related in a fiendishly clever way: Data that you encrypt with the public
key can be decrypted only with the private key, and data encrypted with
the private key can be decrypted only with the public key (private
decrypts public, public decrypts private).

This technique is all about privacy. Keeping private data private can

If you encrypt a message with your friend’s public key, only your friend
can decrypt it (because your friend has never shared his private key with
anyone, even with you). Encrypt a message with your private key and
send it to your friend: If he uses your public key to decrypt the message
(and the result looks meaningful), he’ll know the message came from you.
(Nobody else could have sent the message because it’s encrypted with
your private key, and no one else knows your private key.) You can com-
bine these techniques to encrypt and sign a message.

In this technique, we show you how to use gpg (the GNU Privacy Guard)
at the command line for those cases where you need security but don’t
have access to a desktop environment. You can use gpg to encrypt,
decrypt, and sign e-mail messages. gpg can also encrypt documents that
you don’t intend to share with others, so snoops won’t be able to read
anything you need to keep private. Encrypt the original document, delete
the unencrypted version, and only you can decrypt it again to read it.

kgpg (KGpg) is a graphical interface for gpg that runs in the KDE Desktop
environment. It’s a great tool that packs lots of functionality into a user-
friendly package. In this technique, we show you how to download,
install, and use kgpg. We also show you how to create a gpg key pair
(from the command line and with kgpg). After you've created a key pair,
you can distribute your public key to your friends, or you can upload the
public key to a server — a number of public-key registries are available
on the Web.
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In this technique, we also show you ways to keep
your e-mail private. Encrypting e-mail adds a new
level of security, enabling you to prevent Peeping
Toms from reading your e-mail as it travels across
the Internet. Add a digital signature to your e-mail
messages for extra protection. If your message is
tampered with, the recipient knows (because the sig-
nature is invalid).

Encryption Made Easy with
kapg and the KDE Desktop

If you're working in a desktop environment, a graphi-
cal package such as kgpg makes gpg encryption much
faster and easier to use. You still may need to return
to the command line if you're encrypting an entire
directory tree, but for most of your everyday needs,
a graphical tool works great.

kgpg is a user interface that works with the KDE
Desktop to make using and managing gpg keys easy
and fast. With kgpg, you can encrypt and decrypt
files on your desktop in seconds.

v To get started, you need to create a pair of keys
(a public key and a private key). See the section
titled “Creating keys with kgpg,” later in this
technique, for details.

v To send encrypted e-mail (or e-mail that contains
a digital signature), you have to publish your
public key. See the section titled “Sharing your
key with the world,” later in this technique, for
more information.

v To read an encrypted e-mail message (or other
secure document), you need to import a public
key first. See the section titled “Importing a pub-
lic key from a public-key server,” later in this
technique, to understand the process.

v To encrypt documents that need to be secure,
see the section, “Encrypting documents on your
home system.”
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? kgpg is part of the kdeutils package in KDE
)

- Versions 3.2 and later. If you're using an older
) version of KDE, search the Web for a kgpg
RPM package that matches your version.
Creating keys with kgpg

gpg keys (both public and private) are stored in a
key ring (which is a set of files in your ~/ . gnupg
directory). The first time you run kgpg, it offers to
create a new gpg key pair (unless you've already cre-
ated a key pair with another tool). Here’s what you
need to do to create a key pair:

1. Open KGpg:

To open kgpg on Fedora Linux, open the
Main Menu and choose Accessories=>More
Accessories>KGpg.

If you're using SuSE, open the Main Menu and
choose System=>Security~>KGpg.

On Mandrake, find kgpg by opening the Main
Menu and choosing System=>Other=>KGpg.

2. In the dialog that appears, click Yes.

The Key Generation dialog opens, as shown in
Figure 28-1.

3. Enter your name, e-mail address, and a com-
ment and then click OK.

Enter your first name for the real name, your
last name for the comment, and your real
e-mail address. When you publish your public
key on a public-key server, it appears as
name(comment)e-mail@addr.com, so every-
one can tell with a glance who owns the
public key.

The passphrase dialog appears, as shown in
Figure 28-2.

4. Enter a passphrase in the Password field and
then reenter it in the Verify field. Click OK to
continue.
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* Figure 28-1: The Key Generation dialog.

It's important to keep your private key private.
If gpg simply stored your private key in plain
text, anyone with access to your home directory

could use your private key. Instead, gpg pro-
tects your key ring with a passphrase. You must
provide the passphrase whenever you want to
encrypt, decrypt, and sign documents. Don’t
give out your passphrase, or others will be able
to decrypt documents encrypted with your key.

hd kapg 'BEE
a Enter passphrase for
af.' susanmdouglas® mac.com:
& Passphrase should include non alphanumeric

characters and random sequences

Password "’“*M

Veiify: e

Cancel

¢ Figure 28-2: The passphrase dialog.

After you click OK in Step 4, the Tip of the Day
window opens. Look carefully, and you’ll notice
that an icon has been added to the taskbar. The
icon looks like a padlock covering a sheet of
paper, as shown in the lower-right corner of
Figure 28-3. This means your key has been
created.
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After you've created a key pair, the taskbar icon
becomes your interface to kgpg. Click the taskbar
icon and choose Open Key Manager from the menu.
The Key Management window opens, showing the
key you've just created (see Figure 28-4).

- Did you know...?
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* Figure 28-3: The kgpg icon is now included on the
taskbar.

From the Key Management window, you can export
your key (to a file, to the clipboard, or to an e-mail
message), get key information, sign your key, make
changes to your keys, import other keys, generate
new key pairs, and more.

|v k;Managemem - kgpg =) \ X
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LR>RAAGEB OB

Key = | Trust | Expiration | Size | Creat
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¢ Figure 28-4: The Key Management window.

Sharing your key with the world

After you have an encryption key pair, you need to
publish the public part. Other people can encrypt
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private messages with your public key, but you're
the only person who can decrypt these messages
because you hold the private key. When you send an
e-mail, sign the message with your private key and
the recipient can use your public key to verify that
the message really came from you. How do you dis-
tribute your public key? Use a public-key server.

A public-key server is a directory that lists people
and their public keys. kgpg knows how to export
your public key to a key server and how to import
keys from a key server. kgpg is preconfigured to talk
to two public-key servers, but you can add more
servers if you want to.

To publish your public key, follow these steps:

1. Click the kgpg taskbar icon (which looks like a
padlock; refer to Figure 28-3) and choose Open
Key Manager from the menu.

The Key Management window opens (refer to
Figure 28-4).

2. Choose File>Key Server Dialog (or click the
toolbar icon that looks like a globe).

The Key Server Operation dialog appears.
3. Select the Export tab.

The dialog displays two drop-down lists, as
shown in Figure 28-5.

4. Use the Key Server drop-down list to choose
the server that you want to distribute your key.

Use the Key to Be Exported list to select the
. Yy P
public key that you want to export.

6. After you've chosen the server and key to be
exported, click Export.

Now that you've published yourself, your friends can
find your public key on the server that you chose.
(Many servers share their public keys with other
servers, so after you've published your public key, it
appears on other servers as well.) With your public
key, someone can send encrypted e-mail to you, and
no one else can read the e-mail.
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* Figure 28-5: The Export tab of the Key Server Operation
dialog.

Importing a public key from a public-key server

You can also use kgpg to locate and import keys from
a public-key server. Here’s how to find and import
keys:

1. Click the kgpg taskbar icon (which looks like a
padlock) and choose Open Key Manager from
the menu.

The Key Management window opens.

2. Choose File>Key Server Dialog (or click the
toolbar icon that looks like a globe).

The Key Server Operation dialog appears.
3. Select the Import tab.

)

Choose a public-key server from the top list
box and enter the name or e-mail address of
the person you’d like to contact in the second
field.

You can choose any of the public-key servers
listed; they all talk to each other and share the
same database of public keys.

5. Click the Search button to continue.

The Search Result dialog appears, as shown in
Figure 28-6.

B results. Search by e-mail address to narrow the

z Common names are likely to yield many
<}
field a bit.

&
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* Figure 28-6: The Search Result dialog.

6. When you find the key you’re looking for, click
the key and then click Import to import that key.

After you've imported a public key into your key
ring, you can encrypt e-mail (and other docu-
ments) with that key. The only person who can
decrypt that e-mail is the person who holds the
matching private key.

Encrypting and decrypting documents
with drag-and-drop ease

kpgp is well-integrated with the rest of KDE, making it
quick and easy to encrypt and decrypt files.

Keep private information private by encrypting
- («a your personal files. After encrypting a file,

delete the unencrypted version. Decrypt the
file again when you need it. Only those
entrusted with your passphrase can read your
private documents.

To encrypt a document, follow these steps:
1. Open Konqueror and browse to the directory

that contains the file you want to encrypt.

2. Right-click the file icon and choose Encrypt File
from the menu.

The Encryption dialog opens, as shown in
Figure 28-7.

3. Highlight the key you want to use and then
click Encrypt.

kgpg encrypts the file with your public key; that
way, only someone with the matching private key
(that would be you) can decrypt the file.

The newly encrypted file appears in the same
directory as the original: The encrypted version
has .asc tacked on to the end of the filename.
kgpg doesn’t delete the original version.
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* Figure 28-7: The Encryption dialog.

4., If you want to keep the content private, be sure
to delete the unencrypted version.

To decrypt an encrypted file, follow these steps:

1. Click the encrypted file in your Konqueror
browser.

Konqueror asks for the passphrase to unlock
your private key.

2. Enter the proper passphrase.

kgpg decrypts the file and saves it in the same
directory as the encrypted version (the name of
the encrypted version ends with the extension
.asc; the decrypted version does not). The
newly decrypted file appears in your browser
window.

3. To view a decrypted file in a simple text
browser (without saving it), drag the file icon
onto the kgpg icon in the taskbar, and choose
Show Decrypted File from the menu.

If you drag an unencrypted document to the
trash to delete it, it’s still there (and still
exposed) until you empty the trash. To really
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delete an item, right-click the item and choose
Delete. If you do drag things into the trash,
don't forget to take out the garbage by right-
clicking the can and choosing Empty Trash Bin!

kgpg is well integrated with the Konqueror
browser. Click an encrypted file, and it decrypts.
Right-click a document and choose Encrypt File

from the menu to encrypt a file.

Encrypting Documents with
gpyg at the Command Line

Encrypting documents with gpg is an easy and quick
way to keep information out of the hands of people
who shouldn’t have it. If you’re using SSH or working
on a system without a desktop environment, you can
use gpg encryption from the command line to keep
your private files private.

Sharing a secretfile

To encrypt a private document for your friend’s eyes
only, you need his public key. When you'’ve received
his public key (by e-mail or on disk), save it to a direc-
tory. To import a public key into your key ring, open
your terminal window, move to the directory contain-
ing the public key, and use the following command:

$ gpg --import keyname.gpg

Now you can encrypt your file with your friend’s key
by using the following command:

$ gpg --encrypt --armor -r keyname
filename

Share the file as you normally would — you can send
it by e-mail or hand your friend a CD. Unless some-
one has your friend’s private key, that person won’t
be able to read the document.

To open the file, your friend uses his private key
with the following command:

$ gpg --decrypt filename
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Creating a key pair and receiving
encrypted documents
To receive encrypted documents, your friend needs

your public key. Follow these steps to generate a
public/private key pair with gpg at the command line:

1. Open a terminal window and enter the follow-
ing command:

$ gpg --gen-key

A slightly awkward, but functional menu opens,
prompting you to select the kind of key you want.

2. Type 1 and press Enter.

You'’re prompted to enter the key size.
3. Type 1024 and press Enter.

gpg asks for an expiration date.

4. Type 0 to create a nonexpiring key and press
Enter.

gpg notifies you that the key does not expire and
asks you to verify that you want to generate a
permanent key:.

5. Type y and press Enter.

6. 9pg asks for your real name. Type it in and
press Enter.

This is used to identify your key in your friend’s
key ring.

7. When gpg prompts you for a comment, type one
in if you wish.

The comment is optional. Remember, if you enter
one, the public will see it.

8. g9pg prompts you for your e-mail address. Type
your e-mail address and press Enter.

gpg displays your name, comment, and e-mail
address.

Q. Verify that the information is correct (or select
the appropriate item to change). When the
information is correct, enter O (the letter, not
the number) to verify that the information is
okay and then press Enter.
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You're prompted for a passphrase.
70. Type a passphrase and press Enter.
You’re asked to repeat the passphrase.
71. Type the passphrase again and press Enter.

That’s all there is to it — you’ve created a key.

To exchange your key with others so that you can
send and receive encrypted files, you need to do a
little more upfront work:

1. Write your public key to a file by using the fol-
lowing command:

$ gpg --armor --export e-mailaddress >
filename

The --armor option tells gpg to write your public
key in an e-mail-friendly form by using only
printable characters.

2. Send the key file to your friends or post it on
your Web site.

3. Your friends need to import your public key
with the key file (using the gpg --import com-
mand as described at the beginning of this sec-
tion) before they can decrypt your messages.

Now people can send you encrypted files that
only you can read with your private key.

If you need to encrypt or decrypt messages on a
Windows computer, check out “A Practical Introduc-
tion to GPG in Windows” at www.gnupg.org/(en)/
documentation/guides.html.

To open a message encrypted with your public key,
use the following command:

$ gpg --decrypt filename

gpg is a powerful encryption program, but it’s
not completely foolproof. We've only scratched
the surface here. Good key management

makes a big difference in how well gpg can pro-
tect your private bits. Many encryption options
and security features are available with gpg. For
more information about encrypting with gpg,
visit www . gnupg.org.
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Encrypting documents on your home system

You can use the same key pair that you created to
exchange with others (see the preceding section) to
encrypt documents for your own use. Encrypt the
document and delete the unencrypted version, and
only those users that know your passphrase can
decrypt and read the document.

Follow these steps to encrypt a document:
1. Open your terminal window and move into the
directory containing the file to be encrypted.

2. Enter the following command:

$ gpg --encrypt --armor -r keyname
filename

Substitute the real name you used to create the
key pair for keyname and the name of the file you
want to encrypt into i 7ename.

You’re prompted for the passphrase you entered
when you created your key pair.

3. Enter the passphrase and press Enter.
The new, encrypted file appears in your direc-

tory as filename.asc.

You can now delete the unencrypted document with
this command:

$ rm filename

When you need to use your document again, follow
these steps:

1. Open your terminal window and move to the
directory containing the encrypted file.
2. Enter the following command:
$ gpg --decrypt filename.asc > newfile
You're prompted to enter your passphrase.
3. Enter your passphrase and press Enter.

The file is decrypted and written to the filename
specified in the command as newfile.



That’s all there is to it. Encryption is a quick, easy
way to keep personal documents private — only
people with your passphrase can read encrypted
files. If you do a good job keeping that passphrase
private, no one other than you can access the files
you want to keep to yourself.

Encrypting E-Mail for
Added Security

Public-key cryptography can help secure your e-mail
in two ways:

v When you send e-mail, encrypt the message with
the recipient’s public key to ensure that only the
recipient can read it.

v Sign the message with your private key, and the
recipient can verify that the message really came
from you by validating the signature against your
public key.

Encrypting an e-mail document ensures that anyone
watching the bits fly by on the Web won’t be reading
your sensitive information. The only person who can
read the encrypted message is the person holding
the private key.

A digital signature seals an e-mail document. If the
document is changed in any way, the signature will
be disturbed, and the recipient will know about it.
When you sign a document, you sign it with your
private key. The recipient then uses your public key
to verify that the digital signature is authentic and
hasn’t been tampered with.

The Mozilla e-mail client and Evolution e-mail client
both support public-key encryption. The built-in
support makes it easy (and quick) to send and
receive encrypted e-mail and to apply and verify
digital signatures.

Encrypting with Ximian Evolution

If you're already using Evolution to manage your
e-mail, adding a bit of security to your outgoing and

191

Encrypting E-Mail for Added Security

incoming letters is a snap. If you've followed the
steps in the section titled “Creating keys with kgpg”
at the beginning of this technique, Evolution knows
how to find your gpg key ring, and can use the keys
on it to encrypt and decrypt e-mail with a simple
click and a passphrase.

] If you're not already using Evolution, the setup
e («a wizard will set you up in a few simple steps.
Answer the questions, and you'll be up and
running in no time!

To send an encrypted e-mail with Evolution, follow
these steps:
1. Open Evolution:

If you're using Fedora, open the main menu and
choose InternetcoEvolution Email to start the
Evolution e-mail client.

If you're a Mandrake user, open the main menu
and choose Internet=>Main=>Evolution.

On SuSE, open the main menu and choose
Internet>E-Mail=>Ximian Evolution.

2. Click New to create a new e-mail.
3. Type the recipient’s address and your message.

4. Click Security (on the menu bar), and choose
GPG Encrypt to encrypt the message and GPG
Sign if you want to sign the message.

Sending an encrypted e-mail encrypts it with
the recipient’s public key. You have to have
the public key in your key ring; if it's not in

your key ring, you get an error message.

5. Click Send.

The Enter Password dialog appears, waiting for
your gpg passphrase (see Figure 28-8).

6. Enter your passphrase and click OK.
That’s all there is to it. The encrypted and signed

e-mail is sent on its way.

Opening an encrypted document with Evolution is
just as easy as sending one:
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* Figure 28-8: The Enter Password dialog.

7. When an encrypted e-mail arrives in your mail-
box, click the message.

A dialog appears, prompting you for your gpg
passphrase.

2. Enter your passphrase.

Evolution now has access to your key ring until
you close the session.

The message automatically decrypts and opens.

3. If the message was signed, click the lock icon
next to the signature to verify the signature.

Evolution tells you whether or not the signature
is good.

Setting up Mozilla e-mail for encryption

Mozilla e-mail can send encrypted e-mail just as
easily as Evolution, but before it’s ready to deal with
encryption, you need to download and install a plug-
in. (Plug-ins are snippets of code that enhance the
features offered by a program.)

Follow these steps to download and install the
Enigmail plug-in:

7. Open your terminal window and give your-
self superuser privileges with the following
command:

$ su
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2. Enter your superuser password when
prompted.

3. Typemozillain the command line and press
Enter.

You need superuser privileges to install the
plug-in, so opening the browser with those
privileges transfers the privileges to the
browser.

4. Navigate to enigmail.mozdev.org.

5. Click the Download link in the Resources list
near the top of the page.

6. Scroll down and choose your download from
the versions listed under Standard Download.

Choose the download that most closely matches
the version of Mozilla that you’re using.

To find your Mozilla version, choose Help=>
About Mozilla.

@.

Click the Install button for the Linux version
that matches your computer.

N

If can’t find an installer for Fedora, Red Hat 9
is close enough.

@.

A dialog appears, stating that a Web site is
requesting permission to install.

8. Click the Install button.

After some whirring and clicking, the browser
informs you that Enigmail installation has com-
pleted successfully.

9. Restart Mozilla at the command line (still
with superuser privileges) to complete the
installation.

Now it’s time to configure Enigmail:

1. Open the Edit menu and choose Preferences.

The Preferences dialog appears.



2. Choose Privacy & Security->Enigmail.

The Enigmail Preferences dialog appears, as
shown in Figure 28-9.

3. Check the Use From E-Mail Address for Signing
to Determine GPG Key box.
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¢ Figure 28-9: The Enigmail Preferences dialog.

4., Select a default encryption type.

Your options are No Default Encryption, Encrypt
if Possible, or Encrypt + Sign if Possible.

5. Click OK to save your preferences.
The Enigmail plug-in is installed and configured.

You're now ready to send encrypted e-mail with
Mozilla!

Sending and receiving encrypted
messages with Mozilla mail

To send an encrypted and signed message with
Mozilla and Enigmail, follow these steps:
1. Open Mozilla’s Window menu and choose Mail
and Newsgroups.
The Mozilla mail client appears
2. Click the Compose icon (on the toolbar).

A new message window opens.
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3. Compose an e-mail message as you normally
would.

4. When your message is complete, choose
Enigmail from the menu bar.

The encryption options appear in the Enigmail
menu, as shown in Figure 28-10.
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* Figure 28-10: The Compose/Enigmail menu options.

5. Choose a message type from the drop-down
menu. Choose either Encrypted Send or
Encrypt + Sign Send.

If you sign an e-mail, the recipient needs your
public key to verify the signature.
6. Enter your passphrase when prompted and
click OK.

Your message is on its way!

When an encrypted e-mail arrives in your inbox,
Enigmail automatically decrypts it and verifies the
signature. The signature status is shown in the mes-
sage header, right above the subject line.

If a message does not automatically decrypt,
you may need to select Automatically Decrypt/
Verify Messages from the Enigmail menu.



Securing a Large
Network with Custom

Technique Authentication

Save Time By

v~ Using cross-platform
authentication to keep
user information
centralized

v~ Using Kerberos with PAM
for simple and secure
third-party authentication

know the routine: Each time you connect to a different system, you have

to type in your user name and password. Chances are, you use the same
password to log in to most servers, but you haven’t gotten around to syn-
chronizing all your passwords (or maybe you don’t want to use the same
password everywhere, just in case someone discovers it). Keeping your
passwords straight is a hassle and a good way to waste time.

If you have more than a handful of computers in your local network, you

In this technique, we introduce you to some simple (but powerful) tools
that can make network-wide authentication safe and easy by

v Streamlining password setup and maintenance: If you're the adminis-
trator of a large network, using cross-platform authentication can save
you time. With only one password file to maintain, you save time not
only in setup but also in maintenance — the fewer files you maintain,
the less chance you’ll make a mistake while updating information.

v Creating a secure, network-wide login system that’s more user
friendly: When you're finished with this technique, you’ll have a login
system that requires only one login and one password to access any
authorized server on your network.

To build a better login, all you need are PAM and Kerberos. First, we show
you how to use PAM authentication to access the user database on a Win-
dows machine to authenticate Linux users. Sacrilegious? Not if you already
have a Windows domain and you're slowly adding Linux computers.

Kerberos — a secure, single-login, network-wide authentication service —
adds security to the mix. When you login to a kerberized network, you
give your user name and password to the Key Distribution Center (KDC),
and in return, you receive a ticket that you can give to other kerberized
servers. A Kerberos ticket is like a passport. The KDC verifies your iden-
tity and then gives you a set of credentials that you can hand to other
servers: If the server trusts the KDC, it accepts your credentials.

By using PAM with Kerberos, you get automagic ticket handling. With one
login, you have access to all the kerberized servers on your network.
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If you're adding Linux systems to an existing
Windows network, connect PAM to your
domain controller to centralize your user data-

base. If you're setting a (mostly) Linux network,
consider using Kerberos to give secure, single-
login access to your users.

At the time we’re writing this, Mandrake Linux is not
shipped with the software required to handle cross-
platform authentication. SuSE Linux does ship with
the required software, but the necessary configura-
tion tools in SuSE’s YaST control center don’t seem
to work. The methods that we describe in this tech-
nique will only work with Fedora Linux.

Using Cross-Platform
Authentication with
Linux and Windows

If you already have a medium-sized or large network
of Windows computers, you're probably using a Win-
dows domain to manage security. A Windows domain
is a network of computers that uses a single data-
base to hold user information (user names, user IDs,
passwords, and the like). A single machine, called
the primary domain controller, stores all user infor-
mation and provides authentication services to the
rest of the computers in the domain. A Windows
domain often contains backup domain controllers to
lighten the load on the primary controller (and to
provide authentication should the primary con-
troller fail).

Don’t confuse a Windows domain with a DNS
domain name. A Windows domain is a net-
work of computers that consolidates all user

information in a single database. A DNS
domain name is a name that you give to a
network of computers.

PAM (the basic authentication framework on Fedora
computers) can rely on a Windows domain to
authenticate users. If you keep your authentication
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information on a Windows machine, a simple addition
to your PAM configuration lets you share your Win-
dows authentication files with your Linux systems.

B and secure is a lot quicker if you have only one
file to maintain. You need to update the user
information in only one database, and PAM
allows all the Linux machines on your network
to use that database for authentication. This
streamlined setup also increases network secu-
rity, because you aren’t storing password files

all over your network.

Z Keeping your network user database up-to-date
<}

&

Prepping for cross-platform authentication

You need three pieces of information to set up PAM/
Windows authentication — get these from your
Windows administrator (if that’s you, odds are you
know these tidbits of trivia):

v Your Windows domain name: Your domain
name is the name assigned to your network of
trust. It’s often the same as the name of your
physical network.

v The primary domain controller’s name: This is
the computer on your network that holds the pri-
mary authentication database.

v A backup domain controller’s name: This
machine keeps a backup of the authentication
database. This is important because if the
machine holding your primary authentication
database goes down, you still want your users
to have access to the other machines on the
network.

To set up cross-platform authentication, you also
need to have the pam_smb-1.1.7-2.1386.rpm package
installed.

Check to see if the RPM package is installed with the
following command:

# rpm -q pam_smb
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If the program isn’t installed, you need to add it. Con-
veniently, it’s included with the Fedora distribution.
Insert and mount your Fedora media and enter this
command:

# rpm -Uhv /mnt/cdrom/Fedora/RPMS/pam_smb-
1.1.7-2.1386.rpm

Now you're ready to follow the steps in the next sec-
tion, where you actually set up authentication.

Setting up cross-platform authentication
With the pam_smb package in place, you're ready to
set up cross-platform authentication:

1. Open the Main Menu and choose System

Settings=>Authentication.

A dialog may appear, prompting you for the root
password.

2. Type the root password (if prompted) and
press Enter.

The Authentication Configuration window opens.

3. Choose the Authentication tab to view authenti-
cation options, as shown in Figure 29-1.

R4 Authentication Configuration i G

User Information| Authentication;

[[] Use Shadow Passwords
[[] Use MDS5 Passwords

LDAP

The Lightweight Directory Access Protocol is a
standard way of searching a directory, which can hold
arbitrary data in a structured hierarchy. LDAP is
increasingly being used in small to large networks.

Configure LDAP...

Kerberos is a trusted third-party authentication system
which is commonly used in medium to large networks.

[] Enable Kerberos Support | Configure Kerberos...

SMB Authentication

SME authentication verifies user passwords by
attempting to connect to a server which uses the
SMB (system message block) protocol suite.

Configure SMB...

¢ Figure 29-1: The Authentication tab.

[] Enable LDAP Support

Kerberos

[] Enable SMB Support
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4. Check the Enable SMB Support box and then
click the Configure SMB button.

The SMB Settings dialog opens, as shown in
Figure 29-2.

sakai.localdomain

Workgroup

Domain Controllars | kagal sakai

| 8 cancel H o oK ‘

¢ Figure 29-2: The SMB Settings dialog.

5. Enter the workgroup (domain) name in the
Workgroup field.

6. Enter the name of the primary domain con-
troller in the Domain Controllers field, fol-
lowed by a comma and the backup domain
controller’s name.

Don’t add any spaces between the names and
the comma.

7. Click the OK button to close the dialog.

8. Click the OK button on the Authentication
Configuration window to close that window.

Now, whenever you log in to your Linux computer,
Fedora asks the domain controller to validate your
password. If the primary domain controller fails to
respond in a reasonable period of time, Fedora con-
tacts the backup domain controller. You still need a
user account on your Linux computer (your Linux
user ID, home directory, and login shell information
are stored in Linux), but the password comes from
Windows.

After you follow the preceding steps, there’s
one more trick to setting up cross-platform
authentication: When you create a user account

on the Linux machine, leave the password
blank. If you want to change the password you
use to log in to Linux, change your Windows
password.
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Using PAM and Kerberos to
Serve Up Authentication

If your local network doesn’t include a Windows
domain controller, PAM can still streamline authenti-
cation and increase your network security using
Kerberos. Kerberos is a security protocol that uses a
trusted third party to verify authentication informa-
tion. With PAM and Kerberos working together, you
get a single, secure network-wide login system, which
can save a lot of time.

7 This technique is best suited to large networks.
3 (@ You should have a domain in place and a DNS
& server up and running to take advantage of
the benefits of using Kerberos with PAM for

authentication.

With this setup, Kerberos makes the login more
secure, and PAM makes ticket management auto-
matic. Users first access a kerberized server, where
they must prove their identity to the Key Distribution
Center (KDC). Only after the verification can users
obtain a ticket that represents their fully authenti-
cated identity.

After users log in, they can log in to any machine
running Kerberos authentication or use a kerberized
server on a remote machine without manually obtain-
ing a ticket for the session. That means you (or your
users) log in once and can access any kerberized
server on your network without proving your iden-
tity again for that login session.

[ Kerberos tickets expire over time, so at the
2 («& end of an eight-hour day, the ticket can’t be
) reused by an intruder.
The process of setting up Kerberos to work with
PAM has several phases. Here’s an overview of what
you need to do:

1. Synchronize the system times.

2. Testthe DNS.
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3. SetupaKDC.
4., Setup PAM for automagic ticket management.

5. Add users to the KDC.

The following sections explain each step in more
detail.

Establishing synchronized system times

For extra security, Kerberos tickets are time sensi-
tive. Just like a real passport, your Kerberos ticket
expires after some period of time (you have to prove
your identity to the KDC every once in a while to
prevent a nefarious hacker from using an old pass-
port that you've left sitting around somewhere).

The time-sensitive nature of Kerberos tickets means
that all your kerberized servers (and the KDC) must
agree on the current date and time. If the time varies
by just five minutes between a Kerberos client
machine and the KDC, Kerberos will deny an other-
wise valid ticket. To ensure a consistent time, start
the NTP daemon and enable the Network Time Pro-
tocol on all the computers on your network. (The fol-
lowing steps show you how in just a few quick steps.)

The Network Time Protocol (NTP) visits a server
located on the Internet and retrieves time updates.
It synchronizes the clock on the local machine with
the clock on the time server. Setting up the NTP
daemon on all the machines on your network to
synchronize their clocks with the same time server
ensures a consistent time for Kerberos.

Before you enable the Network Time Protocol, you
need to start the NTP daemon:

1. Open the Main menu and choose System
Settings—>Server Settings=>Services

A dialog opens, prompting you for the root
password.

2. Enter your root password and click OK.

The Service Configuration window opens, as
shown in Figure 29-3.
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[ Service Configuration [=[2]x
Eile View Actions Edit Runlevel Help
P © & d

Start Stop Restart Save Revert
Currently Running in Runlevel: 5 Editing Runlevel: 5

Description

E— ﬁ Listen and dispatch ACPI events from the kernel
apmd

atd

autofs

[[] chargen

[[] chargen-udp
crond

cups

[ cups-pd

[ daytime

| e i

Status

[+]

* Figure 29-3: The Service Configuration window.

3.

4.

5.
6.

7.

Use the scroll bar in the left frame to scroll
through the list of services until you find the
entry for ntpd.

Check the box next to the ntpd entry and click
the Start button (on the toolbar).

An Information dialog opens, telling you that the
ntpd started successfully.

Click OK to close the dialog.

Click the Save button to save the changes to
your services.

Close the Service Configuration window.

Now that the ntpd daemon is running, you're ready
to enable the Network Time Protocol. To synchro-
nize your systems time, follow these steps:

1

Open the Main Menu and choose System
Settings>Date & Time.

A dialog opens, prompting you for the root
password.

Enter the root password and click OK.

The Date/Time Properties window opens, as
shown in Figure 29-4.

Check the Enable Network Time Protocol box.
The Server drop-down list becomes activated.

Use the Server drop-down list to choose a net-

work time server, or add the name of your own

network time server.

[l Date/Time Properties
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===
Date & Time |Time Zone

Date Time
|4 March » 42004 b|

[ b T wei T ro- |
1 2 3 4 5 6 Hour: |14
7B o 10 1 12 13
14 15 16 17 18 19 20
2122 23 24 25 %6 27
28 29 30 31

Current Time ©  14:37:00

Minute : |36

Second _23

Network Time Protocol
‘Your computer can synchronize its clock with a remote time server
using the Network Time Protocol.

[[] Enable Network Time Protocol

Server,

¢ Figure 29-4: The Date/Time Properties window.
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The kind people at Red Hat provide two time
servers for public use. We recommend using
the same server to synchronize all the
machines on your network.

Alternatively, if your entire network doesn’t have
Internet access, you can set up a time server on
one of your own computers and synchronize to
it, but it’s a bit of work. For more information
about establishing your own time server, visit
www.ntp.org.

Click OK.

A confirmation screen verifies that the update is
taking place, as shown in Figure 29-5. After some
thought, your machine updates the time settings
to synchronize with the server. When the update
completes, the Date/Time Properties window
closes.

Contacting NTP server. Please wait...

. 8 cancel |

* Figure 29-5: Confirmation of contact.
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If you configure all your machines to synchro-
nize to the same server, time won't interfere
with your Kerberos logins.

Testing your domain name server (DNS)

Kerberos makes extensive use of the DNS server.
Before you set up Kerberos, it’s a good idea to be
sure that all your computers are on a first name
basis.

Every computer on your network can talk to any
other computer just by knowing its IP address, but
with Kerberos, your computers must know each
other by name. The easiest way to verify that DNS is
working is with a series of pings:

v Ping the Key Distribution Center by name from
each potential client.

v Ping each client machine by name from the Key
Distribution Center.

v Each potential client should ping any other
potential client (by name) that it will access.

Just in case you’re not familiar with pinging, a ping
is like a handshake across the network. To ping a
machine, open the terminal window and enter the
following command:

$ ping machinename

Your machine sends a note to the other machine
telling it to send back a packet of data. If the DNS
service is working properly, you start getting a stream
of replies that looks something like this:

$ ping bastille

PING bastille (192.168.0.28): 56 data
bytes

64 bytes from 192.168.0.28: icmp_seq=0
tt1=64 time=34.893 ms

64 bytes from 192.168.0.28: icmp_seq=1
tt1=64 time=2.918 ms

--- bastille ping statistics ---

2 packets transmitted, 2 packets received,
0% packet loss

round-trip min/avg/max = 2.918/18.905/
34.893 ms
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Use the Ctrl-C combination to stop pinging.

Setting up a Key Distribution Center

Kerberos can make authentication on a large net-
work quick and easy. The centerpiece to Kerberos
authentication is the trusted third party — the Key
Distribution Center (KDC). All the other machines on
your network look to the KDC for authentication
services.

Time is crucial to using Kerberos successfully — the
KDC and all the other Kerberos client and server
machines must agree on the current time. Be sure
that the NTP (Network Time Protocol) is up and run-
ning on all your computers. See the earlier section,
“Establishing synchronized system times,” for details.
You should also test your DNS, which we also explain
earlier in “Testing your domain name server (DNS).”

Here’s how to set up a Key Distribution Center:

1. Log in to the computer that you want to use as
the KDC.

You can do this at the console, or by using SSH
to log in over the network.

2. Open a terminal window and give yourself
superuser privileges with the su command.

3. Insert and mount the Fedora distribution disc.

4. Move to the directory containing the RPM pack-
ages (/mnt/cdrom/Fedora/RPMS) and use the fol-
lowing commands to install the Kerberos
packages:

# rpm -Uhv krb5-1ibs-1.3.1-6.1386.rpm
# rpm -Uhv krb5-server-1.3-1.6.1386.rpm

# rpm -Uhv krb5-workstation-
1.3-1.6.1386.rpm

5. To begin creating a script that will automati-
cally update a few of the configuration files
that the KDC needs to operate, open your
favorite editor and create a file named /tmp/
fixrealm:

# kedit /tmp/fixrealm
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7.

You can make all these changes manually, but

<) to save a bit of time, we've added a quick
script to update the configuration files. This
tool works only if your DNS server is running
and you have a domain in place.

Add the following code to /tmp/fixrealm:
#!/bin/bash

OLDDOMAIN=example.com
OLDREALM=EXAMPLE.COM
OLDKDC=kerberos.example.com

NEWDOMAIN=$(dnsdomainname)

NEWREALM=$(echo $NEWDOMAIN | tr
"[:Tower:]1" "[:upper:1")

NEWKDC=$(hostname)

function fixup()
{
cp $1 $l.orig

echo "Fixing $1 (original saved in
$1.orig)"

sed s/$OLDREALM/$NEWREALM/ $1.orig |
sed s/$OLDDOMAIN/$NEWDOMAIN/ |
sed s/$0LDKDC/$NEWKDC/ > $1

}

fixup /etc/krb5.conf
fixup /var/kerberos/krb5kdc/kdc.conf
fixup /var/kerberos/krb5kdc/kadmb.acl

Save the file and close the editor.

Double-check your typing before you save the
code. (We managed to wipe out our Kerberos
configuration files with just a few typos.)

Make the script executable with the following
command:

# chmod a+x /tmp/fixrealm

Run the script with the following command:
## /tmp/fixrealm

10.

11.

12.
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The script saves a copy of the originals and
updates the working configuration files by using
default values it finds on your network. fixrealm
shows you its progress as it works.

Create the KDC database with the following
command:

# kdb5_util create -s
You're prompted for the KDC database masterkey.
Type a password and press Enter.

You're prompted for the KDC database master-
key again to verify the entry.

Retype the password and press Enter.

Don't forget this password. It's important!

13.

4.

15.

Add your own user name to the KDC database
with the following command:

# kadmin.local -q "addprinc username"

Enter the password that you want to use when
you log in.

Reenter your password when prompted.

The creation of your user account is verified by
Kerberos.

Now, you need to start the KDC with the Service
Configuration tool. To start the KDC services, follow
these steps:

1.

2.
3.

Open the Main Menu and choose System
Settings=>Server Settings->Services.

A dialog opens prompting you for the root pass-
word.

Enter the root password and click OK.

Use the scroll bar to find the following services:
» krb524

» krb5kdc

» kadmin

One service at a time, check the box next to the
service and click the Start icon.
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You must click the Start icon after checking
@ each box. If you check all three and then click
Start, Fedora starts only the last service you

checked.

As each service starts, a dialog opens confirming
that the service started successfully. Click OK
(in the pop-up) and start the next service.

5. When all three services have been started,
click the Save button (in the toolbar) and close
the Service Configuration window.

Your KDC should be up and running and ready
to distribute tickets. Don’t forget that you need
to add each user (or program) that requests
authentication to the KDC database.

) Jump ahead to the section “Adding users to
e- { -1 the Key Distribution Center” for details about
Yy

adding principals to the KDC database.

Setting up automatic ticket management
with Kerberos and PAM

After you've synched your clocks, tested your DNS,
and established the Key Distribution Center (KDC)
on your network (all explained in earlier sections),
you'’re ready to configure your workstation so that
PAM manages your Kerberos login session tickets.
To set up Kerberos authentication, you need two
pieces of information:

v The workgroup name of the computers that trust
authentication from your KDC (the Kerberos
realm)

v The name of the computer that is acting as
your KDC
Follow these steps to enable Kerberos authentication:
1. Open the Main Menu and choose System
Settings—>Authentication.

A dialog opens, prompting you for the root
password.
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2. Enter the root password and click OK.
The Authentication Configuration window opens.
3. Click the Authentication tab.
4., Check the Enable Kerberos Support box.
5. Click Configure Kerberos.

The Kerberos Settings dialog opens, as shown in
Figure 29-6.

¥ Authentication Configuration = %|

User Information| Authentication

[] use Shadow Passwords

[] use MD5 uKerbems Setiings R
LDAP
The Lightweight OJ
standard way of s|
arbitrary data in a|
increasingly being

["] Enable LDAP

Realm |FOODFRANCAIS.COM
KDCs | kdc.foodfrancais.com:88

Admin Servers kd(.fnodfrancsls.(uml 749
Kerberos

Kerberos is a trus| |

which is commonly"Gsed T medim [0 Targe nemworks.

Enable Kerberos Support | Configure Kerberos...

SMB Authentication

SMEB authentication verifies user passwords by
attempting to connect to a server which uses the
SMB (system message block) protocol suite.

* Figure 29-6: The Kerberos Settings dialog.

["] Enable SMB Support

Fill in the dialog with the information about your
Kerberos realm.

6. Enter the Realm name in the Realm field.

7. Enter the KDC name in the KDCs field, followed
by a colon and the port number 88.

computername:88

8. Enter the KDC name in the Admin Servers field,
followed by a colon and the port number 749.
computername:749

9. Click OK to close the dialog and save the
settings.

70. Click OK to close the Authentication
Configuration window.
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Now, each time you log in to your workstation, PAM
automatically obtains a Kerberos ticket for you.
The Kerberos infrastructure quietly passes that
ticket from server to server as you move around
your network — the ticket proves that you are who
you claim to be.

Adding users to the Key Distribution Center

The KDC doesn’t hand out any session tickets unless
it recognizes the user. Users must verify their identi-
ties to the KDC with a password. Only when they’re
recognized are they issued a ticket.

To the KDC, the user is known as a principal.
A principal can be a host, a user, or a program.
A principal is anyone who trusts the KDC. If a

program needs to honor tickets across the net-
work, it must be defined as a principal.

After you follow the steps in the preceding four sec-
tions, you're ready to add a principal to the KDC:

1. Log in to the KDC (as user root):
# ssh root@kdcname

2. Enter the following command:

# kadmin.local -q "addprinc username"

3. When prompted, enter the login password for
the new principal.
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4. When prompted, reenter the password.

The creation of the new principal is confirmed
with a message.

&, Repeat Steps 2 through 4 to create more princi-
pals (users) and then log out of the KDC when
you’re finished.

At this point, you have two passwords: the old
login password and the new Kerberos pass-
word. If you give the old password when you

log in, PAM doesn’t get a chance to do its
work, and you won’t be granted a Kerberos
ticket. If you give the new password, PAM
obtains a ticket for you.

g

(Kerberos) password, you know that the
Kerberos and PAM setup is working. After you
know things are running okay, you can
remove the old login password.

z If you can successfully log in with the new
<l

&

To remove the old login, open the terminal window
and give yourself superuser privileges with the su
command. Then execute the following command:

## passwd -1 username
Locking password for username.
passwd: Success

After executing this command, only the new Kerberos
password will work for logins.



Customizing
Authentication

Yethnigile With PAM

Save Time By

v Understanding the PAM
configuration files

v~ Building your own
authentication rules

v~ Searching the Web for
PAM modules

v~ Skipping the root pass-
word if you dare

You install it at a few sites, and your users love it. Now, you sell your

database to a bank that uses a smart card to identify each user. You
have to modify your database to handle smart card authentication. A few
months later, you run into a customer that wants to use a retinal scanner
to protect access to his data. Again, you have to modify your database to
handle retinal scanners. Next, someone wants to use voice authentication.
More changes.

Suppose that you've written the world’s spiffiest database program.

In this technique, we introduce you to PAM, which stands for Pluggable
Authentication Modules (or methods). Flexible, well-rounded, and ever-
expandable, PAM is a great system resource to get to know. It was designed
to hide authentication methods from an application. If you modify your
database to interact with PAM, you don’t have to change your code just
because an administrator wants to try out a fancy new authentication
tool. With PAM, you can

v Create complex login procedures (two or three passwords,
challenge/response mechanisms, and so on).

v Use high-tech methods like biometric scans to authenticate users.
You obviously need extra hardware to use mechanical authentication
methods, but if the data is valuable enough to justify the cost of the
protection, PAM can help manage the technology.

v Avoid entering the root password when you need superuser privi-
leges. With just a few quick file changes, you’ll save time whenever
you need to su (as well as when you need to use the Linux configura-
tion tools). We don’t recommend using PAM to circumvent root for
everyone, but if you’re working on a system that doesn’t need to have
tight security, it can make administrative or system tasks a breeze.

This technique shows you how. If you're interested in setting up a Linux
host in a Windows domain network or if you want to use Kerberos to
authenticate your users, take a peek at Technique 29 as well.
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Understanding Modules and
Configuration Files: The
Basics of PAM

Authentication

PAM (Pluggable Authentication Modules) is the pro-
gram that is responsible for authenticating users who
connect to a Linux system. Most programs packaged
with Linux distributions use PAM for authentication,
as do many other open-source projects.

PAM gains its flexibility from plug-in modules. PAM
itself doesn’t do a whole lot, relying instead on mod-
ules to do the heavy lifting. Developers write the
modules to fulfill a number of diverse tasks. Some
modules store passwords on an smb mounted net-
work share, while others are specialized to use hard-
ware devices like smart cards and biometric
scanners.

PAM keeps track of the level of security you desire in
a set of configuration files. You can change the PAM
configuration files to require multiple passwords,
limit access based on a user/location relationship, or
enable biometric devices. Each configuration file
specifies a set of modules that PAM employs to
authenticate a user.
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We explain the basics of finding a module and cus-
tomizing its rules in the next section. Then, in “Build-
ing Good Rules with PAM,” we explain the basic
syntax of rules and what your customizing options
are. And we help you better understand what’s actu-
ally in a configuration file in “Dissecting a Configura-
tion File” also later in this technique.

With a little extra hardware and PAM, you can
use biometric scans or other high-tech devices
to secure super-important data.

Technique 30: Customizing Authentication with PAM

Finding a Module and
Customizing Its Rules

Adding your own rules to the PAM configuration files
is relatively simple when you understand what the
different modules do.

If you use Fedora, you can find documentation about
PAM modules in

$ /usr/share/doc/pam-0.77/txts

If you're a Mandrake user, you find documentation
about PAM modules in

$ /usr/share/doc/pam-doc-0.77.txts

If you use SuSE, look for PAM documentation in

$ /usr/share/doc/packages/pam/modules

Move into the directory, and use the 1s command
to see a list of the documents available. Use the
more command to display the contents of the
documentation:

$ more README.pam_nologin

Press the spacebar while the document is displayed
to see more of the document.

When you’ve found a PAM module you want to use
for program authentication, add a rule to the pro-
gram configuration file that tells PAM when to invoke
the module.

Building Good Rules with PAM

This is the section where we begin to break down
what your options are for customizing levels of secu-
rity in PAM. A PAM-enabled program can rely on a
chain of one or more rules to authenticate the user.
PAM configuration rules can seem a bit overwhelming



at first, but they’re actually quite simple. The basic
format of a configuration rule is this:

phase control-level module-pathname
arguments

We explain what you need to know about each part
of a rule in the following sections.

Phase

Each configuration file controls four different phases
of the authentication process: authentication, account
management, session management, and password
management. Each configuration rule belongs to a
specific phase according to the first word in the rule:

v auth: An auth rule verifies that you are who you
claim to be, by password, biometric scanner,
smart card, or other authentication means.

V¥ account: Account rules allow or deny access to
a service based on available system resources
(a certain number of users may be allowed to
log in at one time), user location (root users
must be sitting in front of the computer con-
sole), and other factors. You can use account
rules to help control system resources and
privileged access.

v session: Session rules put in place the session
information for the user that is logging in. A typi-
cal session rule may mount your home directory
when you log in or set up a log file that records
your entire login session.

V¥ password: Password rules change the password
or other authentication means that a module
uses to identify the user.

PAM modules are diverse, each controlling different
aspects of authentication and session management.
A given module may service all four phases (authen-
tication, account management, session management,
and password management) or only a few. For exam-
ple, the pam_nologin.so module (which prohibits
user logins if the file /etc/nologin exists) works in
the auth phase, but doesn’t have anything to offer
the password phase.
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If you need an authentication module for an

unusual security application, search the Web.
Modules are out there — just search the Web
for PAM modules.
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Control level

The control level determines what happens if the
module fails. For example, if the user fails to provide
a proper password but passes a retina scan, you may
want to let that user into your system.

Here are the control-level options:

v sufficient:If aruleis satisfied that is deemed
sufficient, you are allowed to continue. A user
entering a correct password in a step that is
deemed sufficient is allowed either to continue
with the login process or to access the program.

v required: This rule must succeed, or the user is
not allowed to run the program.

v optional: This rule does not need to be satisfied
for the user to be allowed to use the program.

v requisite: If two passwords are used to authen-
ticate identity, using the requisite control type
stops authentication when the first password
fails.

Module pathname

The third feature in a configuration rule is the path-
name to the PAM module that the rule uses. The
modules are located in /1ib/security.

Arguments

The fourth item in a PAM configuration rule is a set
of zero or more arguments that gets passed along to
the PAM module when the module is invoked. The
arguments vary depending on the module. The sim-
plest of arguments is debug, which causes a module
to write debugging information to the system log
(which is handy if you’re having trouble logging into
your system).
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Dissecting a Configuration File

Modifying a PAM configuration file isn’t difficult, but
the format appears pretty cryptic at first. In this sec-
tion, we show you a typical configuration file and
explain what each line does. After you can read a
PAM configuration file, you can tailor your own files
to more closely match your needs.

Each file in the /etc/pam.d directory controls PAM
authentication for a single client. A client roughly
equates to a program, and the filename is the same
as the program name. The /etc/pam.d/Togin file
contains all the authentication rules for the Togin
program, the sshd file contains all the authentication
rules for ssh, and so on.

The contents of your PAM configuration files
@ may vary. The following is just an example of
one possible configuration for a login file.

To peek into the 1ogin configuration file, open a ter-
minal window and enter the following command:

$ kedit /etc/pamd.d/login

The PAM configuration file opens, displaying the
authentication rules for the 1ogin command, as
shown in Listing 30-1.

Here’s a line-by-line breakdown of the rules in this file:

v Line 1: The first line in /etc/pam.d/loginis a
comment. You can ignore that line for now, but
notice that you can include comments in a

ListinG 30-1: THE PAM LoGIN ConFIGURATION FILE

PAM configuration file by prefixing the comments
with a #.

The next three rules are invoked, in order, during
the authentication phase. (They all start with the
word auth.)

Line 2: The first authentication rule invokes

the pam_securetty.so module. If you track
down the documentation for that module (see
/usr/share/doc/pam-0.77/txts/README.
pam_securetty), you see that this module allows
privileged (that is, root) logins only from specific
workstations. The idea behind securetty is that
you can physically secure certain workstations
(by placing them behind a locked door) and then
allow root logins from only those workstations.
Because the rule is required (see the second
column), pam_securetty.so must return a posi-
tive response before PAM will continue with
authentication.

pam_securetty.so makes sure that privileged
users (like root) cannot log in from remote
computers. They have to be sitting at one of
the workstations listed in /etc/securetty.

Line 3: The second auth rule requires that the
pam_stack.so module return a positive response
when passed the argument service=system-auth.
pam_stack.so doesn’t really do any authentica-
tion checks by itself. Instead, it switches over to a
common set of rules stored in another configura-
tion file. Keeping commonly used rules in a single
file makes it easier to manage PAM configuration.
pam_stack.so returns a positive response if the
rules in the other file (in this case, /etc/pam.d/
system-auth) are satisfied.

1 - #%PAM-1.0

2 auth required pam_securetty.so
3 - auth required

4 - auth required pam_nologin.so

5 - account required

6 - session required

7 - session optional pam_console.so

8 - password required

pam_stack.so service=system-auth

pam_stack.so service=system-auth
pam_stack.so service=system-auth

pam_stack.so service=system-auth
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Quite a few modules use the system-auth
configuration file. The system-auth file holds
common configuration information in one file.
Each file that needs the common information
just refers to the system-auth file instead of
duplicating that information.

When the authentication rules found in the
system-auth file are satisfied, PAM continues to
the third authentication rule (also required).

Line 4: The third auth rule requires a positive
result from the pam_nologin.so module. The
pam_nologin.so module checks for the existence
of the /etc/nologin file. If the /etc/nologin file
exists, only root is allowed to log in.

Create the /etc/nologin file to block other

7
(@ users from logging in to the system while

you're performing system maintenance. Just be
sure to delete the file again when you're done
because no other users (other than root) are
allowed to log in while /etc/nologin exists.

When the authentication rules are met, and PAM
is satisfied that the user is who he or she claims
to be, PAM moves on to the account rules.
Authentication rules lay out the procedure users
must follow in order to prove that they are who
they claim to be. Account rules kick in after the
authentication process is completed.

Line 5: This is the only account rule in this file.
The rule simply defers to the account rules in
/etc/pam.d/system-auth. You can use account
rules to enforce policies that aren’t related to
authentication but are still important — password
aging, disabled accounts, and so on.

The system-auth file holds the most com-
@ monly used system configuration rules. You
can look inside the file with the following

command:

$ kedit /etc/pam.d/system-auth

Looking in the system-auth file tells you that the
pam_unix.so module is being invoked. The
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pam_unix.so module is responsible for password
aging and other account-related concerns.

When the account-related issues have been satis-
fied, the 10gin program requests that PAM sat-
isfy any session rules that are required. By
looking in the configuration file (lines 6 and 7),
you can see two session rules — one required
and one optional.

Line 6: The required rule is applied first. The
required rule defers to the system-auth configura-
tion file rules, where the pam_1imits.so module
and the pam_unix.so module are required to sat-
isfy requirements before the 10gin program can
continue. pam_1limits.so enforces limits imposed
by the /etc/security/1imits.conf file (limits on
disk usage, CPU usage, memory usage, and so on).
The requirements of the pam_1imits.so module
must be met before login is allowed to continue.

Line 7: Optional rules don’t need to be satisfied to
continue — they’re optional. This rule specifies
that the pam_console.so module may or may not
be satisfied before the 10gin program continues.

The pam_console module changes the file
permissions when you log in at the console,
and changes them back when you log out.
The theory behind pam_console is that if you
have physical access to the machine, you
should have physical access to the peripherals.
This is a fairly volatile module, and not one we
recommend playing with.

Line 8: The password rule is invoked only when
the Togin program requests that a password be
changed. Then PAM looks in the configuration
file, sees that the password rule requires that the
system-auth password rules be satisfied before
the user is allowed to change the password. In
our system-auth file, the password rule requires
that the pam_crack1ib module be satisfied before
the new password is accepted. Notice that pass-
word rules aren’t actually part of the authentica-
tion sequence — they’re only used to change the
password (or retina scan, or fingerprint, or what-
ever you have configured).
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] The pam_crack1ib module works only with
(8 (4& the password rule type. It checks the password
) against a dictionary to see if the new password

entered is guessable. If you set pam_cracklib
to required, only complex, difficult-to-crack
passwords will be accepted.

Skipping a Password with PAM

You can tighten security fast with PAM, but you can
also relax security standards to save time in certain
cases. On a system that’s not holding data that is life-
and-death important, and that’s not an integral link
in a network, you can make PAM skip the request for
a root password when you need superuser privileges
at the command line.

The pam_wheel.so module returns a positive result
whenever members of the wheel group try to authen-
ticate themselves. That means that if you're a mem-
ber of the group named wheel, PAM assumes that
you've already authenticated yourself and lets you
continue without a password. What'’s the significance
of the name whee1? We can’t figure it out either.

Think twice before disabling root passwords.
6 Never having to slow down to enter a pass-
word is a definite timesaver, but it’s about the

loosest security you can have.

The following example works for Fedora or
Mandrake. The same technique will work for
SuSE, but because SUSE doesn’t use a com-
mon configuration file (like system-auth), you
need to decide for yourself which files you
want to modify.

To change the PAM configuration files to allow
superuser access without a password, follow these
steps:

1. Open your terminal window and give yourself
superuser privileges.

2. Enter the following command:
# kedit /etc/group file

Technique 30: Customizing Authentication with PAM

The kedit window opens, displaying the contents
of /etc/group.

Find the line in the file that starts with wheel.

3
4. Add a comma, followed by your username, to
the line.

wheel:x:10:root,username

4. Save the file and exit.

6. Enter the following command:
$ kedit /etc/pam.d/system-auth

7. If you're using Fedora, find the lines that look
like this:

# Uncomment the following line to \
implicitly trust users in the \
"wheel" group.

f#lauth sufficient \
/1ib/security/$ISA/pam_wheel.so \
trust use_uid

If you're using Mandrake, you won’t have the last
line included in your system-auth file.

You’ll need to add the following line as the sec-
ond rule in your system-auth file:

auth sufficient \
/1ib/security/$ISA/pam_wheel.so \
trust use_uid

8. If you're using Fedora, remove the # from the
beginning of the auth rule.

The result should look like this:

# Uncomment the following line to \
implicitly trust users in the \
"wheel" group.

auth sufficient \
/1ib/security/$ISA/pam_wheel.so \
trust use_uid

Now, when you use the su command, PAM recog-

nizes that you are a member of the wheel group and
doesn’t ask for the root password.

If you decide to allow PAM to skip password
prompts and you leave your desktop logged in

and unattended, you may be asking for trouble.
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Gaining Privileges

else; a user who wants more privileges than anybody else has; a
user who can do things others can’t do. We call him the superuser,
but his real name is root.

Every Linux system has a user who thinks he’s better than everyone

This technique shows you how to gain and use superuser privileges
safely from the comfort of your desk — no phone booths or funny tights
required. Limiting the power of the superuser is important if you want to
keep your system safe and secure. You'll save a lot of time if you don’t
have to recover from disasters caused by (accidentally) flexing too many
superuser muscles. Sometimes you need superuser privileges to do sys-
tem administrator work like configuration, user management, and privi-
lege management. But we show how to limit your exposure by gaining
only the privileges that you need and only when you need them.

Feeling the Power

In most systems, a single user, named root, holds superuser privileges.

(You can think of user root as synonymous with superuser.) The superuser

can do anything he wants on your system, such as the following operations:
v Modify (or delete) any file.

Change any password.

Use any device.

Create new user accounts.

AN W WY

Delete old user accounts.

\

Lock you out of your system.

Sounds like someone you want to keep out of your system, doesn’t it?
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Sometimes, you need to do those things because
users come and go, passwords are forgotten, and
files need changing. Save yourself a lot of time by
limiting your powers and minimizing the damage
that you can do. Save the power for when you really
need it.

Gaining Superuser Privileges

Given all the exciting and hazardous things that a
superuser can do, how do you become one? Simple:
Just type su at the command prompt. Okay, the
process is not quite as simple as that — you also
have to know the superuser’s password.

Here’s a short example. Say that you want to modify
the /etc/motd file. (The content of /etc/motd is dis-
played whenever you log in to your system — motd
stands for message of the day.) Customizing /etc/
motd is a quick way to alert your users that some-
thing important is happening today. On most sys-
tems, /etc/motd can be modified only by the
superuser, as described in the following steps:

1. Log in to your system as a normal (that is, non-
superuser) user.
2. Type the su command at the prompt:
[freddie@bastille /1$ su

su requests the superuser password:

Password: <enter the superuser password
here>

3. Enter the password.

If you've entered the correct password, the
prompt changes from $ to # to remind you
that you hold elevated privileges. See the “Do-
it-yourself identity checking” sidebar for details
on an even better way to see your privileges
at the prompt.

[root@bastille /1#

At this point, su starts a new, highly privileged
shell for you.

4. Overwrite the /etc/motd file as follows:

[root@bastille /I1# echo "Bastille will
be down this evening for an upgrade"
> /etc/motd

[root@bastille /1#

5. Now here’s the most important part: Exit the
privileged shell, forfeiting your new privileges:

[root@bastille /1# exit
[freddie@bastille /1%

Do-it-yourself identity checking

The bash shell is just trying to be helpful when it changes
your prompt from $ to # (and back again), but if you mod-
ify your prompt, you can’t rely on this cue. For a more
definitive hint, the id command is your answer. id prints
out your current identity:

[freddie@bastille /]1$ id
uid=501(freddie) gid=501(freddie)
groups=501(freddie)

Notice that id printed your user ID (and name) and a list of
groups to which you belong (in this case, a single group
named freddie). Now give yourself superuser privileges
and try the id command again:

[freddie@bastille /1$ su

Password:

[root@bastille /1# id

uid=0(root) gid=0(root) groups=
O0Croot),1(bin),

[root@bastille /I1# exit

[freddie@bastille /1$ id

uid=501(freddie) gid=501(freddie)
groups=501(freddie)

You see that the su command changes more than just your
privileges: It changes your identity as well.

Pretending to Be Other Users

Because su gives you a way to become the superuser,
you may be thinking that su stands for superuser.

In fact, su stands for substitute user: You can imper-
sonate any user with su (as long as you know the
right password).



One reason that you might want to impersonate
another user is to gain privileges to a particular
piece of software, but you may not need all the privi-
leges of the superuser to accomplish what you need
to do. If you give yourself only the privileges that
you need instead of giving yourself the power to
accidentally destroy your system, you'll save your-
self a lot of grief and wasted time.

To see how impersonating a user without gaining all
the powers of the superuser works, take MySQL as
an example. When you install a MySQL database,
you usually create a new user account for the MySQL
administrator. The MySQL administrator is not a real
person (in most cases), it’s just a name for a set of
privileges. To fire up your MySQL database, you
must become the MySQL administrator for a while:

[freddie@bastille /]$ su - mysql
[mysgl@bastille /1$ id
uid = 301(mysql) gid=301(mysql)
groups=301(mysql)
[mysql@bastille /1% mysqld_safe &
[mysgl@bastille /1% exit

Notice the hyphen in this command, which tells su
to invoke the login scripts for user mysq1. When you
run su without a hyphen, you're impersonating
another user. When you run su with a hyphen, you're
impersonating another user and inheriting the envi-
ronment variables (and shell aliases and functions)
that belong to that user.

The most common problem you run into
(if you forget the hyphen) is that your $PATH
environment variable is wrong. For example, if

you forget the hyphen when you su mysql,
it'’s pretty unlikely that the mysqld_safe com-
mand will be in your $PATH search path:
mysqld_safe is on mysql’s search path. In
other words, su - is a complete impersonation.

Limiting Privileges with sudo

What’s wrong with the su command? Running a shell
as the superuser is sort of like hunting squirrels with
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a bazooka; sure, you can hunt squirrels that way, but
it’s safer to use a smaller armament. If you're run-
ning a shell while you have superuser privileges, it’s
just too easy to make a typing mistake that deletes
important information. (Trust us, we’ve done that a
few too many times.)

One way to avoid shooting yourself in the foot is to
use sudo instead of su. From a user’s point of view,
sudo is very similar to su: Each command starts a
new program that holds elevated privileges. su gives
you all privileges, but sudo gives you only the privi-
leges granted by an administrator. In other words,
sudo gives you a way to grant partial privileges to
those who need them, without giving them the
whole bazooka. Really, you need to su only when
you configure sudo.

- is to save yourself time by avoiding disasters. If
you decide to use su in your normal course of
work, be sure to read Techniques 49 and 50

(backup and recovery).

2 The whole point of using sudo (instead of su)
<8}

&

sudo is controlled by a configuration file named
/etc/sudoers. The layout of a sudoers file can be a
bit confusing at first, but don’t be intimidated. Here’s
a simple /etc/sudoers file:

# file: /etc/sudoers
freddie bastille = /bin/mount

The first line is a comment (anything that follows a #
is treated as a comment). The second line grants user
freddie the right to run the /bin/mount command as
long as he’s logged into a computer named bastille.

Now if freddie wants to mount a file system, he’ll
have to ask sudo to do the work for him:

[freddie@bastille /1% sudo mount
/dev/cdrom /mnt/cdrom
[freddie@bastille /1%

When you add entries to the sudoers file, be
@ sure to include the complete pathname to
each command. If you don’t, dastardly users
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can simply slip a bogus program (with the
same name) into their search path and gain
privileges that you don’t want them to have.

The first time you edit the /etc/sudoers file,
you'll notice that it's already filled in with sam-
ple entries. Don't even look at them. They're

too confusing. Just add the one or two lines
that you need and ignore the samples.

Freddie can now mount CDs, but he can’t unmount
them. That’s easy to fix; just add the umount com-
mand to the list of privileges:

# file: /etc/sudoers
freddie bastille = /bin/mount, /bin/
umount

Now freddie can mount and unmount file systems.
But what if you want freddie to mount and unmount
only CDs, not other file systems? That’s easy, too:

# file: /etc/sudoers
freddie bastille = /bin/mount /dev/cdrom,
/bin/umount /dev/cdrom

Save time by including host names in the

- («a sudoers file, maintaining a single master copy
of the file, and copying it to each machine on

your network. That way, you don’t have to cre-

ate a separate sudoers file for each machine.

In fact, you can store the sudoers file in CVS

(see Technique 13) to maintain a complete his-
tory of all the privileges you've ever granted
on your entire network.

Of course, you can also list multiple users in the
same sudoers file:

# file: /etc/sudoers

freddie bastille = /bin/mount
/dev/cdrom, /bin/umount /dev/cdrom

franklin,tex versaille = /usr/bin/reboot,
/sbin/dump, /sbin/restore

The third line grants two users (franklin and tex)
the right to reboot and the rights to backup and
restore, but only on a host named versaille.

You can see the pattern: Each entry starts with a user
name (or a list of user names), a host name (or a list
of host names), an equals sign, and then a command
(or list of commands). Each entry grants a set of privi-
leges to one or more users on one or more hosts.

The man pages for sudo (and sudoers) state
that you must use the visudo command
to edit the /etc/sudoers file. That’s not
really true; you can use any editor you
like. visudo does some extra error check-
ing whenever you save your file, but we
find the error messages to be more con-
fusing than helpful.



sudo Pseudonyms

Technique

Save Time By

v~ Creating a User_Aliasto
manage group privileges

v~ Using a Host_Alias to
assign resource privi-
leges to groups

v~ Creating a Cmnd_Alias
to keep dangerous com-
mands under control

v~ Sharing superuser com-
mands without sharing
the password

must secure your system against both accidental and intentional

damage. On the other hand, you can’t tighten security to the point
where average users can’t get their jobs done. In a traditional Linux (or
UNIX) system, privileges are granted to the superuser. If you need a privi-
lege, you impersonate the superuser (with the su command). The prob-
lem with this approach is that you gain all privileges as soon as you know
the superuser password. Give yourself enough privileges to mount a CD,
and you’ve also gained enough privileges to delete every file on your
computer. sudo (see Technique 31) can help by handing out privileges to
specific users and programs. But if you have a medium- to large-sized net-
work, managing sudo privileges can become a time consuming chore.

Every system administrator walks a thin tightrope. On one hand, you

Assigning privileges with sudo aliases can help make quick work of the
task. A sudo alias is an easy way to refer to a group of users, hosts, or
commands when handing out privileges that are normally given to the
superuser. The elements of the superuser privileges can be assigned indi-
vidually, so the administrator doesn’t have to give out the root password.
Only the privileges that a user really needs are given out.

With sudo aliases, you can create User_Alias groups to assign privileges
to groups of users. If the group (or department) gains new users, just add
those new users to the User_Alias, and they automatically have all the
privileges shared by that group. No one gets the superuser password, so
you don’t need to worry about runaway superuser privileges.

Host aliases allow you to control groups of computers with one set of
privilege assignments. You can quickly combine user aliases and host
aliases to grant access to machine resources to the users that really need
the resources, but still restrict the superuser privileges that might pose a
security threat to the system.

In this technique, we show you how to save time by using sudo’s aliases
to assign privileges to groups. When you become a sudo superuser, you
really start to save time. In this technique, we show you how to use sudo
aliases to save time assigning privileges. And your system will be a safer
place for it.
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Installing sudo

To find out if sudo is installed on your computer, look
for afile called /etc/sudoers. If it’s not there, install
sudo from your Linux distribution disc. Open a termi-
nal window and give yourself superuser privileges
with the su command. Mount the distribution disk,
move into the directory holding the RPM packages,
and install sudo with the following command:

# rpm -Uhv sudo-version.rpm

Adding Up the Aliases

The sudoers file holds sudo configuration informa-
tion; program permissions and sudo aliases are
defined in /etc/sudoers. An alias (a sudo alias any-
way) is a name that you give to a group of one or
more users, hosts, commands, or “run as” names.

7 The idea behind an alias is that you can assign
(or deny) privileges to the named group rather

& than to each individual group member, making
setup and maintenance much easier. For exam-
ple, you may have a small group of users who
perform system maintenance tasks (such as
backup and restore operations). Rather than
assigning privileges to each individual operator,
create an operator alias (a group that includes
all your operators) and assign backup and
restore privileges to the alias. That way, if you
hire new operators, you simply add them to the
operator alias, and they have all the privileges
they need. Or, if you switch to a different
backup program, you can change the privileges
assigned to the operator group rather than to
each individual.

By modifying the sudoers file, you can create four
kinds of aliases:

v User_Alias:AUser_Alias creates a group of
users. A User_Alias definition can contain a
combination of groups, individual users, and
other user aliases.

V¥ Runas_Alias: Using a Runas_Alias allows a user
to borrow the privileges of another user (typi-
cally, root). A Runas_Alias definition can include
user names, UIDs, user groups, and other
Runas_Aliases.

v Host_Alias:UseaHost Alias to manage groups
of computers if you manage a large network.
Assigning a Host_Alias to a group of Web servers
allows you to apply sudo rules to all the systems
in the group. A Host_Alias can reference host
names, IP addresses, netmasks, or other host
aliases.

v Cmnd_Alias: A command alias groups similar
commands (similar in their danger levels).
Grouping commands like rm, mkfs, and parted
(potentially dangerous commands) and limiting
access to them can help decrease the likelihood
that you’ll be restoring from backup anytime
soon. A Cmnd_Alias can refer to command
names, directories, and other command aliases.

Adding Aliases to the sudo
Configuration File

sudo aliases are defined in the /etc/sudoers file.
Adding an alias is quick and simple:

1. Open the terminal window and give yourself
superuser privileges with the su - command.

2. Tell the visudo command (which you use in
a moment) which editor you want to use (the
default editor is vi, and we’d rather not go
there).

For example, if you want to use kedit, use the
following command:
# export EDITOR=kedit

You can use kate, emacs, or another editor if you
prefer.

3. To edit the /etc/sudoers file, enter the follow-
ing command:

# visudo



The /etc/sudoers file opens.

The file contains four commented lines, acting as
placeholders for alias definitions.

4. Enter the aliases under the appropriate
headings.

For example, if you're creating a Cmnd_Alias,
place it under the comment that says # Cmnd_
Alias specifications. See the next section,
“Defining the Alias,” for more information about
the format of an alias.

5. When you're finished adding aliases, save the
file and exit the editor.

When you save the file edits, you may get an
error message in the terminal window:

Warning: undeclared Host_Alias 'NAME'
referenced near line 12

>>>sudoers file: syntax error, line
11<K

What now?

The sudoers error messages aren't very help-
ful. Odds are, you made a typing error, so enter
an e to reopen and edit the file and then check
your entry. sudo is particularly fussy about
capitalization; the first letter of the alias type
and the word alias need to be capitalized.

Defining the Alias

Before you can add an alias, you need to decide what
the alias will contain. This takes a bit of thought, but
as you think about your users and their roles in the
workplace, some logical divisions of privileges will
probably emerge.

i roles that your users take on and the real-
world privileges that the company structure
might impose. A management hierarchy
might translate into a hierarchy of user aliases

and privileges.

2 Model the sudo aliases against the real-world
<8}

é
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Defining the Alias

Here’s the basic format of an alias definition:

Alias_Type ALIASNAME = member one, member
two

Note that capitalization is important in the sudoers
file. Alias names may contain only uppercase letters,
numbers, and underscores (and must begin with a let-
ter). The words User_Al1ias, Runas_Alias, Host_Alias,
and Cmnd_Al1ias must all be captalized as shown in
this sentence.

Creating a User_Alias

To create a User_Alias named ACCTG consisting of
Freddie, Franklin, and Georgette, add the following
code to the /etc/sudoers file:

User_Alias ACCTG = freddie, franklin,
georgette

To create an alias consisting of the members of
another group but excluding a certain member, you
can define a group as follows:

User_Alias MGMT = ACCTG, ! georgette

The ! excludes Georgette from the MGMT group.

You can use the ! to exclude the rights to cer-
tain privileges from certain users, but don't
consider that to be absolute security. Wily users

can find their way around a lack of privileges if
they really want to.

Creating a Runas_Alias

The command to create a Runas_Alias is similar to
the command to create a User_Alias, but you can
also specify members by their user numbers:

Runas_Alias OPERATORS = #1, murphy,
rachel, bernie

A single user can belong to many aliases — the
user gains the privileges of each group. In a small
company, the timesaving benefits might not be
immediately obvious, but if you’re managing the
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privileges of dozens of users, aliases can really help
speed things up.

Simplifying group managment
with a Host_Alias

Use the Host_Alias to make management of groups
of computers easier. To add a Host_A1lias named
FRANCE consisting of bastille, versaille, and Touvre,
add the following line to the sudo configuration file:

Host_Alias SERVERS = bastille, versaille,
lTouvre

You can also specify computers by IP addresses:

Host_Alias SERVERS = 192.168.0.1,
192.168.0.36, 192.168.0.22

You can use a Host_Alias in combination with a
User_Alias to assign the user group privileged
access to a group of computers without giving out
the superuser password.

Mounting and unmounting CDs without the
superuser password

You might want to allow users to mount and unmount
CDs without becoming the superuser. If you don’t
want to expose the privilege on all your computers,
create a Host_Alias that includes the computers that
the users will access. To do so, follow these steps:

7. Add the Host_Alias to the Host Alias Specifica-
tion section of the sudoers file:
Host_Alias CDROMHOSTS = 192.168.0.1,
192.168.0.28, 192.168.0.218

2. Add aline in the User Privilege Specification
section of the sudoers file that gives the privi-
leges to everyone:

ALL CDROMHOSTS = NOPASSWD: /sbin/umount
/dev/cdrom, /sbin/mount /dev/cdrom

] ALL is a built-in alias that matches all items of
- { -a) that particular kind (all users, all hosts, and so
& on). Use the expression ALL where you would

put a user name, and it will include all the
users. Use the expression ALL where you
would use a host name, and it will interpret it
to mean all the hosts it knows about.

Instead of using ALL, you can substitute your
own User_ATias into the command and limit
the users that can mount and unmount CDs.

After you set up users by following the steps in this
section, the users need to add sudo to the front of
the mount and umount commands when entering them
to use their sudo privileges.

Including the NOPASSWD flag exempts your users from
having to enter their sudo passwords. Passwords
offer an extra line of security, but for some things
(such as mounting a CD), your users will thank you
for not requiring a password.

Managing access to dangerous commands
with command aliases

Use command aliases to easily manage privileges for
dangerous commands. When a user needs to use a
dangerous command, you can ration the access
instead of giving out the superuser password and
unlimited access to all commands. Here are some
commands you might consider controlling with sudo:

\

su
rm
mkfs
kill
killall

A W W W WY

parted

One handy command that other users would
find helpful, but that normally requires super-
user privileges, is rpm. If you read Techniques 17
and 18, you already know how handy rpm is
when it comes to installing and updating soft-
ware. And with sudo aliases, you can share the
tool without sharing the superuser password.



1. To add a command alias to the sudo configura-
tion file, define the Cmnd_A11as with the fully
qualified pathname to the command:

Cmnd_ATlias DANGER = /usr/su, /usr/bin/
kill, /usr/bin/killall, /bin/rm,
shbin/mkfs

The location of the commands may vary sys-
tem to system. Use the fully-qualified path-
name when you define your command alias.
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Defining the Alias

Cmnd_Alias RPM = /bin/rpm

Then add a line to the sudoers file under the
User Privilege Specification section:

OPERATORS ALL = NOPASSWD: RPM

This line grants access to the rpm command to all
members of the OPERATORS User_Alias on ALL
host machines.

OPERATORS must add sudo to the front of
.. . e the rpm command in order for sudo to grant
2. Add a command alias in the Cmnd Alias Specifi- the required privilege: $ sudo rpm -Uhv

cations section of the sudoers file to create an
alias for the RPM command:

rpmpackage.rpm.



Securing Your
Connections

Yethnigiie  with SSH

Save Time By

~ Keeping your private bits
private

v~ Using a secure GUI
across a network

+* Using public-key authen-
tication for remote login

v~ Using scp to copy files

v Forwarding ports to
securely breach a
firewall

simply ran telnet. The telnet program would reach across a network

and give you a remote command line. When you typed a command
into the telnet client, the characters that you typed were sent blissfully
over the wire, and the telnet server on the other end would execute the
command and send the results back to you. Were we really so young then?
With the advent of the Internet, new villains appeared, eager to grab our
passwords and credit card numbers as they leapt from ISP to ISP. The
problem with telnet is that everything that you type is sent across the net-
work in the clear. Anyone watching the bits stream across the network
can see your private bits. The solution to this problem is SSH.

In the good old days, if you wanted to log in to a remote computer, you

SSH, which is an acronym for secure shell, encrypts your data as it travels
across a network so that passwords, financial data, and private e-mail are
never exposed to any hacker who can intercept them. An SSH connection
consists of two parts: a server and a client. An SSH server waits patiently
on a host computer, listening on a specific port for a client to log in. When
an SSH client connects to a server, the two programs begin a lengthy
negotiating session that results in a fully encrypted connection.

SSH provides a remote command line. With SSH, you can start graphical
programs that run on the server but display their data on your local
computer.

SSH also provides port forwarding. With port forwarding, you can tunnel
through firewalls to gain access to machines on the other side. Forwarded
data is protected traveling back and forth to the protected host, while the
server remains secure behind its firewall.

In this technique, we introduce you to the benefits of using an SSH client.
SSH provides a secure connection across a local network or over the Inter-
net, through firewalls, and with great speed, and it merges with your desk-
top environment via a quick link. We show you how to use your SSH client
(which comes complimentary with Fedora) to do all of these things.
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Using SSH for Top-Speed
Connections

The great thing about SSH is that you get all the secu-
rity benefits, plus access to a GUI environment with
speeds that can’t be matched by the other desktop
sharing tools. SSH can compress the bits traveling
over the network connection to improve perform-
ance. The speed advantage is really evident if you
have a low-bandwidth or high-latency connection.

Think of /atency as the distance between your
computer and the server that you're connected
to. If you're connected to a computer 10 feet
away from you, you probably have a low-
latency connection. If you need to log in to a
computer in a foreign land over a satellite con-
nection, all your data travels from your com-
puter, up to the satellite, back down to earth,
and then across the rest of the network: That's a
high-latency connection.

Setting Up Public-Key
Authentication to
Secure SSH

When you log in to a typical personal computer, you
provide a password. The password authenticates
that you are who you claim to be. Anyone who knows
your password can fake out a server. Passwords are
typically very short and easy to remember; those
two qualities make passwords easy to use, but also
make them incredibly insecure.

Public-key authentication is an alternative to pass-
word authentication. Public-key authentication is
very secure, and SSH also makes it convenient. In
public-key authentication, each key has two parts —
a public key and a private key. You always keep
your private key a secret, but you share your public
key. The two keys are mathematically related in a
way that only Stephen Hawking can understand. A

message encrypted with the public key can be
decrypted only with the private key. A message
encrypted with the private key can be decrypted
only with the public key.

To authenticate a connection by using a public key,
the server encrypts a message with your public key
and sends the result to your client. The SSH client
decrypts the message using your private key and
reencrypts it with the server’s public key. In this
exchange, you’ve proven you are who you say you
are and verified that you're connected to the proper
server.

] Public-key authentication is perfect for telecom-
e (ﬂ muters and those doing customer support work
& because it enables you to easily access comput-

ers that you will log in to often. Just copy your
public key once, and you're ready to go.

The public and private keys are stored in the ~/.ssh
directory. To set up key authentication with SSH,
here’s an overview of what you need to do:

1. Generate the key pair.

2. Give the SSH server a copy of your public key
(but keep your private key to yourself).

You can copy the public key to the server by
using a file transfer tool such as scp (secure cp).

3. (Optional) Set up your passphrase so that you
don’t have to enter it every time you log in.

Your public/private key pair is generated from
a whole mess of random numbers. It's very
unlikely that any two key pairs will be identical.
A typical key is at least 128 characters long.

] Linux automatically contains everything you
e (@ need to use public-key authentication, so you
&

don't have to install any extra software. Yay!

Generating the key pair

To generate your public/private key pair, follow
these steps:
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1. Open a command line, type the following com-
mand, and press Enter:

$ ssh-keygen -t rsa

You’re prompted to enter a file to save the key in.

2. Press Enter, and SSH will find a good place for
the file.

You're prompted for a passphrase.
3. Enter a good password.

Check out the sidebar “Choosing good pass-
words,” later in this chapter, for some ideas
about choosing passwords.

4. Enter the same passphrase again to verify it.
Remember the passphrase; you'll need it later.

SSH acknowledges that it has created your key
pair and displays the filenames where the keys
are saved. ssh-keygen also issues a key finger-
print, but you can ignore that for now. To use your
key pair with SSH, you need to distribute the
public key, which we explain how to do in the
next section.

Distributing your public key

Before you can use your key pair to log in to an SSH
server, you have to copy your public key into your
~/.ssh directory on the server. The easiest way to
get your key to the server is to use the scp command.

Don’t share anything but your public key by
e-mail. The private key is always kept private,
encrypted on your system.

Listing 33-1: HanbinGg Out Your PusLic Key

Technique 33: Securing Your Connections with SSH

Follow the steps shown in Listing 33-1 to transfer
your public key to the remote system. After you
enter each command, you're prompted for your
password on the remote system.

In the example, substitute your user name on
the remote system for freddie, and the name
(or IP address) of the remote system for
bastille.

Passing on your passphrase

If you did all that work to avoid typing in a pass-
word, why should you have to enter a passphrase
instead? The passphrase unlocks your private key
for use when you log in to a remote system. Without
a passphrase, your private key would be exposed on
your local machine for anyone to see.

(2 add the passphrase to your startup procedure
and create desktop shortcuts to save you time
logging in and out. The following steps explain
how to arrange for KDE or GNOME to
prompt you for the passphrase when you log
in to your desktop environment. See “Creating
Shortcuts to Your Favorite SSH Locations” for

information about creating desktop shortcuts.

If you're in an environment where security is
crucial, never walk away from your computer
without first logging out. A troublemaker who

walks up to your unattended computer can
impersonate you if you're logged in. If you fol-
low the steps described in this section, anyone
with physical access to your computer can also
use your private key while you're logged in.

? If you do a lot of work on a remote machine,
<€

&

$ ssh freddie@bastille "mkdir .ssh"

.ssh .ssh/authorized_keys2"

Password:

$ ssh freddie@bastille "cat >> .ssh/authorized _keys2" < .ssh/id_rsa.pub
Password:

$ ssh freddie@bastille "chmod 700

Password:

$




To eliminate the need to enter your passphrase every
time you log in to a remote system, you have to talk
KDE (or GNOME) into asking you for the passphrase
when you first log in to your local desktop. After the
key is unlocked, it’s ready for use (and reuse) until
you log out of your local desktop.

If you use KDE, the easiest way to set this up is with
Konqueror. Here’s how:

1. Open your Konqueror browser and surf to the
following directory:

~/.kde/Autostart
2. Rightclick on the browser and choose Create

New= Link to Application from the pop-up
menu.

3. Name your link (Passphrase) and click the
Execute tab.

4. Inthe Command field, enter the following
command:

/usr/bin/ssh-add
5. Click OK.

A new Autostart icon appears in the Konqueror
window. The next time you log in to KDE, you’ll
be prompted for your passphrase.

If you're a fan of GNOME, follow along to edit your
Autostart folder:

1. Open the Main Menu and choose Preferences~
More Preferences->Sessions.

2. Click the Sessions icon to open the Sessions
dialog.

3. Click the Startup Programs tab and then
click Add.

The Add Startup Program dialog appears.

4. Type /usr/bin/ssh-add in the Startup
Command field and click OK.

Logging In with SSH and Key Authentication
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Logging In with SSH and
Key Authentication

When you log in to an SSH server using public-key
authentication, you're greeted with a remote com-
mand line. The commands that you enter are exe-
cuted by the SSH server until you log out. If you want
to use graphical environments, you can access those,
too. We give you the details in the following sections.

Starting from the command line

To use your key authentication to log in to a machine
with SSH, follow these steps:

1. At the command line, type ssh bastille and
press Enter.

You're prompted for your passphrase (the one
you entered when you generated your key set).

2. Enter the passphrase.

You're logged in!

A few quick words about fingerprints

The first time you log in with SSH, your local system adds
the server’s public key to its list of known computers and
issues a warning similar to the following:

The authenticity of host °192.168.0.135"
can't be established.

RSA key fingerprint is

b4:2y:88:23:98:33:91:03:ec:7b:d8:2b:b8:83:
y3:f8.

Are you sure you want to continue
connecting (yes/no)?

Type yes and press Enter to continue.

In the future, if the server’s public key changes, SSH will
warn you.

Some nasty people intercept transmissions
and redirect logins to steal password informa-
tion that will enable them to get into places
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they don't belong. If the system fingerprints
don’t match, SSH will warn you and you'll know
you have a potential man-in-the-middle attack.
If that happens, ask the remote system adminis-
trator to read you his or her server’s fingerprint
over the phone.

Getting graphic

You can also run graphical programs from your
remote machine on your local desktop. The SSH
server forwards X Windows traffic over the SSH con-
nection automatically. Here are a few examples to
illustrate how this works:

v To see what time it is on the remote system, type
the command xclock &. The clock displays the
time on your local desktop, but it also displays
the time on the server (you can'’t tell the differ-
ence if you're in the same time zone).

v To see the files on the server, type konqueror &
and press Enter. The Konqueror browser starts
running on the server, but the display appears on
your local desktop.

Creating Shortcuts to Your
Favorite SSH Locations

SSH is handy at the command line, but you can also
launch SSH sessions from a desktop link. And, if
you're a KDE aficionado, you can use the fish: pro-
tocol to create a link to a remote file or folder.

To add a desktop link that opens a terminal window
connected to an SSH server, follow these steps:

1. Right-click on your desktop and choose
Create Newr>Link to Application.
A dialog opens.

2. Type a name for the link and click the Exe-
cute tab.

Technique 33: Securing Your Connections with SSH

3. Inthe Command field, enter the following
command:

gnome-terminal -x ssh bastille

4. Click OK.

Double-click the new link, and you’re logged in and
working. If you've configured your desktop as we
describe earlier in “Passing on your passphrase,” you
don’t need to stop and enter passwords along the way.

g With your remote terminal, you can open any
e («a graphical application on your Linux host.
& At the command line, enter the name of the

program — kedit, kate, konqueror ... the
list is endless.

You can open as many windows on your local desk-
top as your connection will support. These windows
work like local windows in all respects, with the
exception of drag and drop. Instead of drag and drop,
we recommend using scp at the command line. See
the next section for details.

If you're using KDE as your desktop environment,
you can create a link to a remote file or directory.
Double-click a link to a remote directory, and KDE
will open the directory with the Konqueror browser.
After you double-click a link to a remote file, KDE
opens the file using the right application (based on
the file’s MIME type). Follow these steps to create a
new link to a remote directory:

1. Right-click on the desktop and choose
Create NewLink to Location (URL) from the
pop-up menu.
2. Enter the following command in the Enter Link
to Location (URL) field and click OK:
fish://bastille/home

Substitute your remote machine’s name or IP
address for bastille.

fish: is a KDE protocol that provides remote
file management over an SSH connection. See
Technique 1 for more information.
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When the dialog closes, a link on the server’s
/home directory appears on your desktop.

3. To connect to the remote machine, just double-
click the icon.

A Konqueror browser window opens, showing
the /home directory.

Copying Files with scp

scp is similar to the cp command: It copies a file from
a source to a destination. The difference between
scp and cp is that scp can deal with files stored on
remote hosts. scp uses the SSH protocol to encrypt
the file being transferred and can take advantage of
SSH’s compression feature to save you time. You can
use scp to completely replace cp. To copy a file from
one directory to another (on your local machine),
use the following command:

$ scp /tmp/drink-recipes.txt /home/

If you want to copy a file from an SSH server or to an
SSH server, include the remote host name on the
command line, like this:

$ scp louvre:/pics/monalisa.jpg /tmp/
$ scp /tmp/monalisa.jpg orsay:/pics/

If you see a name that includes a colon, it
most likely refers to a remote computer.

The first command copies /pics/monalisa.jpg from
host Touvre to the /tmp directory on your local com-
puter. The second command copies the picture from
your local computer to host orsay. If you haven’t
copied your public key to Touvre or orsay, you're
asked for a password.

You can also use scp to copy from one remote
machine to another remote machine:

$ scp louvre:/pics/monalisa.jpg
orsay:/pics

Enable compression with the -C option:

$ scp -C /tmp/monalisa.jpg orsay:/pics/

If you don’t specify a fully qualified pathname, scp
assumes that you want to copy into (or from) your
home directory on the remote computer. For exam-
ple, the command

$ scp -C Touvre:paintings.list orsay:

copies a file from your home directory on Touvre to
your home directory on orsay.

You can include wildcards in an scp command, but
you have to quote them if you want the wildcards to
be expanded by the computer on the other end of
the connection. For example, to copy all the . jpg
files in your home directory on 1ouvre to your local
machine, use the following command:

$ scp -C "louvre:*.jpg" /tmp/

If you forget the quotes, the bash shell expands the

wildcard before scp ever gets a chance to see it.

- z You can use scp to copy an entire directory
A tree with the - r option.

Secure (And Fast) Port
Forwarding with SSH

No Web site should be without a good firewall
because too many villains are out there waiting to
attack your computer. Firewalls keep the bad guys
out, but they can sure make life tough for those of us
wearing the white hats. Fortunately for the good
guys, SSH can slip you past a firewall in no time.

Port forwarding lets you securely connect to a spe-
cific port on a remote computer without being
blocked by a firewall. Neither the remote machine nor
your local system can even tell that a firewall is there.



224

Port forwarding with SSH can solve a lot of problems
for you, such as the following:

v Some software packages require access to spe-
cific port numbers.

v You can reach software on the other side of a
firewall.

v Your data is traveling in encrypted form and
can’t be seen by villains.

v Your data is compressed and zips through the
network much faster.

Port forwarding is kind of a strange process. The
basic idea is that you connect to a port on your local
computer, and SSH takes all the data that you send to
that port and forwards it to another port on another
computer. SSH also sends data back in the other
direction for a complete connection.

Here’s an example. PostgreSQL database servers
typically listen for clients on TCP port 5432. When
you run a PostgreSQL client application, the client
connects to the server on that port. The client and
server exchange SQL queries and results over the
connection and disconnect when they’re finished. A
PostgreSQL client can connect to a server on the
same computer (using local port 5432) or a server
running on a remote computer (using the remote
host name and port 5432).

You can introduce SSH into this mix to solve three
different problems:

v If afirewall is present between the client and the
server, SSH can carry the data across the firewall
for you.

v If you have a slow connection to the server, SSH
can compress the data stream to improve
performance.

v If you're transmitting sensitive data across an
insecure network, SSH will encrypt the data
stream for you.

Technique 33: Securing Your Connections with SSH

To set up port forwarding between a PostgreSQL
client running on your local computer and a
PostgreSQL server running on 1ouvre, simply use
SSH to log into Touvre and include a bit of command
line magic:

$ ssh -L 5432:Touvre:5432 Touvre

To break that command down a bit, the ssh command
connects to the SSH server running on host Touvre.
The cryptic-looking bit in the middle of the command
(-L 5432:10uvre:5432) forwards data from port 5432
on your local computer to port 5432 on Touvre. Now
when you start up a PostgreSQL client, you connect
to local port 5432, even though the PostgreSQL server
is running on a different computer:

$ psql -h Tocalhost -p 5432
Welcome to psql, the PostgreSQL

interactive terminal
freddie=#

If you have a firewall between yourself and 1ouvre,
you can ask SSH to forward data across the firewall
to a third computer. For example, if bastille is act-
ing as a firewall (meaning that you can’t directly con-
nect to any machines behind bastille), this command
arranges for SSH to carry PostgreSQL data across
the firewall and deliver it to Touvre:

$ ssh -L 5432:1ouvre:5432 bastille

Notice that with this command, you're logging into
bastille, but SSH is forwarding the data to Touvre.
SSH can forward data to any machine that bastille
can talk to. When SSH forwards data for you, the
data stream is automatically encrypted. If you want
to compress the data as well, just add a -C to the
command line.

Choosing good passwords

Choose your passwords carefully. A good password should
include both upper- and lowercase letters, numbers, and
punctuation if allowed. The system will set a limit on the
length of your password, but generally speaking, the longer
the password the better. It's a bad idea to honor pets,



children, and spouses in your password unless you've taken
care to obscure the name with other characters like
Fr3ddi3*! — and even then it's not a great idea. It's also a
bad idea to use your license plate number — that should be
obvious, but you'd be surprised how many people do it.

Be sure to choose a password that is obscure, but memo-
rable. Writing it down leaves the password susceptible to
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the prying eyes of anyone who gets access to your work-
space. One common mnemonic is to use the first letter of
each word in a phrase you won't forget. Throw in some
punctuation, or change case now and then, and you have a
memorable password that’s also hard to guess. All King
Edward’'s Horses Can Master Big Fences! translates to
AkehCmBf!, which is pretty unguessable.
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Protecting Vourself
with a Firewall

fechnique

Save Time By

v~ Installing an intruder-
proof firewall

line of defense against intruders. Obviously, if your system has no

contact with the outside world (either via the Web or by modem),
you don’t need a firewall. If your system does have contact with the
Web, you should consider screening what comes through your network

ﬁ good firewall is important to any network because it’s your first

v Preserving network interfaces.
resources and limiting
exposure to nasty viruses Network information travels in packets — groups of data that are encased
by limiting Internet in layers of envelopes. Each layer of the packet contains a different kind
access of information about the data within the packet. The outermost layer

1+~ Keeping a tight firewall contains information about the hardware that the packet is coming from.
but allowing SSH access The next layer within contains the IP address for the source and the

destination. Inside that envelope is the TCP information — the port num-
bers and sequence numbers of both the source and destination machines.
At the heart of the packet is the packet payload — the real data that
you're interested in.

A good firewall can filter the incoming or outgoing packets based on
the information contained in any of the envelope layers. Because the
envelopes are nested within one another, if you toss the outer enve-

lope, the inner envelopes go with it, and the data never reaches your
application.

In this technique, we show you ways to set up a firewall that’s tight
enough to protect your system, but loose enough to allow useful data in
and out. You'll save time with a safer system that gives everyone the
access they need to get their jobs done.

Finding Your Firewall

Starting with kernel version 2.4, most Linux distributions include a
sophisticated packet filtering package called netfilter. You can use netfil-
ter to build firewalls, perform network address translation (NAT), per-
form port translation, and alter network packets as they traverse your
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system. netfilter is part of the Linux kernel — you
can configure netfilter with the iptables command.
Notice that we said that you can configure netfilter
with the iptables command, not that you should.
Creating a firewall by typing in a bunch of iptables
commands is something best left to the propeller
heads.

Instead, you should use a firewall builder. A firewall
builder is a tool that (usually) asks you a series of
questions about how you use your computer and
then runs a sequence of iptables commands on
your behalf. A good firewall builder will store your
choices in a set of one or more configuration files
and then arrange for the corresponding iptables
commands to execute each time you boot your
computer.

You can find a variety of firewall builders on the
Web. Some are designed to create a simple firewall
as quickly as possible; others are less friendly, but
give you more control over the security of your sys-
tem. SuSE, Mandrake, and Fedora each come with a
firewall builder (and they’re all different).

Setting up a simple firewall in Mandrake Linux

In keeping with Mandrake’s reputation for simplicity,
drakfirewall (the Mandrake firewall builder) makes
it very easy to configure a simple firewall. To run the
Mandrake firewall builder, follow these steps:

1. Open the main menu and choose System->
Configuration=>Configure your computer.
The Mandrake Control Center opens.
2. Choose Security->Firewall.

The drakfirewall configuration editor opens, as
shown in Figure 34-1.

3. Use the check boxes to configure your firewall.

Start out by clearing each check box — that will
lock your system down so that outsiders can’t
get through your firewall. Then, check each

Technique 34: Protecting Yourself with a Firewall

service that you want to provide to the outside
world. For example, if you want to log in to your
computer from another system, select the SSH
Server check box. If you're running an Apache
Web server, select the Web Server check box.

Mandrake Control Center 10 [on localhost]

Fil=  Options  Profiles  Help

! Firewall

k)

Which services would you like to allow the
Internet to connect to?

Everything (ne firewall)
X Web Server

Domain Name Server
X SSH server

FTP server

Mail Server -
Yfou can enter miscellaneous ports

Valid examples are: 139tcp 139/udp 600-610/tcp 600-610/udp.

Have a look at fetc/services for information.

Other ports

Cancel Basic Ok

* Figure 34-1: The Mandrake Firewall Builder.

If you need to temporarily disable your firewall,
select the Everything (No Firewall) check box —
drakfirewall is kind enough to remember your
original settings so that you can restore your fire-
wall again later.

4., When you're finished, click OK to save your
changes.

When you save your changes, drakfirewall saves
your choices to a set of configuration files in the
/etc/shorewall directory and executes a sequence
of iptables commands that configures netfilter
according to your preferences.

Mandrake Linux actually uses two firewall builders,
one layered atop the other. drakfirewall (the tool
we just described) is a very high-level firewall
builder — it’s very simple, but not very flexible.
Under the hood, drakfirewall drives another fire-
wall builder called Shorewall. You can find more
information about Shorewall at www.shorewall.net.
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When you installed Fedora, you ran a program called
system-config-security. You might not have even
noticed it — it’s part of the installation script, and
goes by with just a quick question or two. At installa-
tion time, it created a firewall and firewall rules for
you. You may have chosen not to install a firewall at
that time; if that’s the case, you have no firewall
rules in place.

If you chose not to install a firewall when you
installed Fedora, you can change your mind later.
The same configuration tool that runs during the
install procedure will create (or remove) simple
firewall rules. To run Fedora’s firewall builder, follow
these steps:

1. Open the Main Menu and choose
System Settings=>Security Level.

You're prompted for the root password.

2. Enter the root password and click OK.

If you have a terminal window open and super-
user privileges, you can start the configuration
tool by entering system-config-
securitylevel at the command line.

The Security Level Configuration dialog opens.
This dialog is similar to the firewall information
window you saw at installation time.

3. From the Security Level drop-down list, select
Enable Firewall.

If you disable the firewall, any custom rules
you've created are lost.

4. To create the most robust firewall possible,
enable the firewall with no trusted services or
trusted devices.

That is, deselect all the check boxes, as shown in
Figure 34-2.
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The best way to build a robust firewall is to
disallow all traffic, and then relax the restric-
tions to allow data to flow. It's easier to recog-

nize your friends one at a time.

Finding Your Firewall

ELf =
EIJ: Please choose the security level for the system.
]

Security level: ‘ Enable firewall 5

'] WWW (HTTP)

O FrP
Trusted services: |[] SSH
|[] Telnet
[ mail (SMTP)
] etho
Trusted devices:
#8 Cancel o oK

* Figure 34-2: A very secure firewall.

] If you have multiple network cards listed in
>~ («a the Trusted Devices frame, you can trust
& devices that connect to your own network, but
don’t trust the devices that connect to the out-
side world. That way, the devices within your
network can access the machine via SSH or
Telnet, but the outside world can’t get in.

5. Click the OK button to continue.

A pop-up opens, warning you that if you con-
tinue, you’ll change the existing firewall
configuration.

6. Click Yes to continue.
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Setting up a simple firewall in SuSE Linux

The crew at SuSE have put a lot of work into their
firewall builder (called SuSE Firewall2), making it
powerful and easy to use. Like the Mandrake and
Fedora firewall builders, SuSE Firewall2 stores your
preferences in a configuration file (/etc/sysconfig/
SUSEfirewal12) and executes a series of iptables
commands when you apply your changes.

To run the SuSE firewall builder, follow these steps:

1. Open the main menu and choose System=>YaST.
The YaST Control Center appears.

2. Click Security and Users (in the left-hand pane),
and then click Firewall.

The SuSE Firewall2 window appears, as shown in
Figure 34-3.
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4, If your computer has two network adapters,
SuSE assumes the second interface is con-
nected to a local (internal) network — choose
the internal interface from the drop-down list.

4. Click Next to move to the next step.

The Services list appears, as shown in Figure 34-4.
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Abort

* Figure 34-3: The SuSE firewall builder (Step 1).

3. Choose your external interface from the drop-
down list.

The external interface is the network interface
connected to the outside world (the Internet).

system up-to-date with the
latest updals packages
from the SuSE FTP

|
serverm. iﬂ Back

Expert

Abajt

* Figure 34-4: The SuSE firewall builder (Step 2).

6. Use the check boxes to configure your firewall.

Start out by clearing each check box — that will
lock your system down so that outsiders can’t
get through your firewall. Then, select each serv-
ice that you want to provide to the outside
world. For example, if you want to log in to your
computer from another system, select the Secure
Shell (ssh) check box. If you're running an
Apache Web server, select the HTTP check box
and the HTTP with SSL (https) check box.

If you need to allow other services through your
firewall, click the Expert button and list the serv-
ice names (or port numbers) in the text box
provided.

7. Click Next to move to the next step.

The Features dialog appears (see Figure 34-5).
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|4 '._I‘_‘"‘_J o..q
GCheose which packets should  Firawall Configuration (Step 4 of 4): Logging Options

be logged
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Accepted Packets, only
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Back Abort

* Figure 34-5: The SuSE firewall builder (Step 3).

8. Select the features that you want, or simply
accept the default values.

We recommend that you select the Allow
Traceroute and the Protect All Running Services
check boxes. If you're sharing your external
interface with other machines (in other words,

if your computer is acting as a gateway for an
internal network), you should also select the
Forward Traffic and Do Masquerading check box.

The text box on the left side of the window
explains each option in more detail.

9. Click Next to move to the last step.

The Logging Options window appears, as shown
in Figure 34-6.

70. Select the logging and debugging options that
you want.

We recommend accepting the default values.
After your firewall has been in place for a while
and you're satisfied that it is working properly,
you can disable all firewall logging to conserve
disk space.

71. Click Next, and then click Continue to save
your changes and (re)start the firewall.

* Figure 34-6: The SuSE firewall builder (Step 4).

When you save your changes, SuSE Firewall2 executes
a whole slew of iptables commands to tell netfilter
about your choices.

Editing the Rules with Webmin

After you've configured your firewall with a friendly
firewall builder, you may want to fine-tune netfilter
to better fit your needs. If you’re running Mandrake
or Fedora Linux, the graphical firewall builders don’t
give you many options. SuSE Firewall2 is a bit more
powerful, but it was really designed to be simple, not
flexible. Relax, you don’t have to hit the command
line.

The quickest and easiest way to tweak your firewall
rules is with a system administration tool called
Webmin. With Webmin, you can perform tasks such
as configuring servers, managing users and groups,
arranging backups, and scheduling cron jobs, all
from within your favorite browser. If you prefer, you
can use Webmin to do many of the tasks that are
handled by Mandrake, SuSE, and Fedora administra-
tion tools. Many third-party modules are also avail-
able to expand on Webmin’s basic capabilities.
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B> when you have some free time, and check it
out. Getting familiar with Webmin can be a

real timesaver.

Z We really like Webmin. Go to www.webmin.com
R

&

Technique 17 gives detailed instructions about
downloading and installing Webmin. If you haven’t
already installed Webmin, see Technique 17 for more
information.

Starting a Webmin session

With Webmin installed, start a Webmin session:

1. Open a browser and go to
http://1ocalhost:10000.

Webmin opens, displaying a login window, as
shown in Figure 34-7.

Fle Edt View Go Bockmarks Tools Wiodow Help

DN R e
|| mack ™ rominl * Relowd s |2 Muaidocalhost 100000

M) 3 - [

7 Ghmome  shEockmarks o Hed Hat, inc. o Red Hat Network (4 Suppont [ shop ([ Prodects (1 Traimng

* Figure 34-7: The Webmin login window.

2. Enter root in the Username field, and the root
password in the Password field. Click Login to
continue.

Unless you trust everyone who has access to
your desktop, we don’t recommend clicking
the Remember Login Permanently box.

Webmin allows access to some sensitive parts
of your system.
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The opening window of Webmin is displayed, as
shown in Figure 34-8. From this window, move
from page to page by clicking the round buttons
(labeled System, Servers, Networking, and so on)
across the top. Each page provides tools to man-
age different aspects of your system.

b Webmin 1.130 an localbostiocaldomain (Redhat Linus Fedora 1) - Marilla _:H x
4. 8 . h W hitp:flocalhost: 1000

_pe Edt View Go [ockmarks Tools Window Help
e Mlesas 3 - [

T mome | whBockmarks o Fed Mat, ine, o Red Hat Network (4 Suppont 4 Shop (4 Products. (4 Training

S rordoack | 7.¢logou B
0.0

tE Nt WBTkIng I HerdWere cliE eri o iere

...... 1130 1 ... | W= =5 |off|

3 L |

* Figure 34-8: The Webmin main window.

Reading the rules with Webmin

You can see and manage your firewall rules from the
Networking tools page in Webmin. Just click Linux
Firewall.

If you're running Fedora Linux, Webmin knows how
to read the firewall rules created by Fedora’s firewall
builder — any changes you make through Webmin
will appear the next time you run system-configure-
securitylevel.

If you're running Mandrake Linux, Webmin will offer
to convert your Shorewall configuration files to the
more standard Webmin format (if you choose to con-
vert, any changes you make through Webmin will be
discarded when you switch back to the Shorewall
configurator). If you prefer to keep Shorewall in
place, you can use Webmin’s Shorewall Firewall
module instead of the Linux Firewall module.



The SuSE firewall builder stores its configuration
information in a format that Webmin’s Linux Firewall
module can’t directly read — to use the Linux
Firewall module on a SuSE computer, click Module
Config (near the top of the page) and select Directly
Edit firewall rules instead of savefile. Webmin will
interrogate the running kernel to discover the fire-
wall rules you have in place. After you've made any
necessary changes, use the iptables-save command
(at the command-line) to create a savefile — see man
iptables-save for more information.

In this section, we show you how to read (and mod-
ify) firewall rules as they appear in Webmin’s Linux
Firewall module. We use a firewall generated by
Fedora’s system-config-securitylevel as an
example.

When you start the Linux Firewall module, the rules
you established with the system-config-security
Tevel tool (see the section, “Setting up a simple fire-
wall in Fedora Linux,” earlier in this technique) are
shown in Figure 34-9.

The first rule set on the page displays the rules
applied to incoming packets. If you’'ve chosen the
default setup for the firewall, the only rule in the set
is to always run the chain RH-Firewall1-1-INPUT
(which we describe in a moment). You can add new
rules to this chain with the Add Rule button or
remove all the rules from the rule set with the Clear
All Rules button.

The second rule set decides the fate of forwarded
packets (packets routed through your computer).
Again, the only action defined by default is to run
the chain RH-Firewall-1-INPUT.

The third rule set displayed on the screen applies to
outgoing packets. With the default firewall, no rules
are applied to the outgoing packets — only incoming
packets.

Near the bottom of the page, you see the rules that
make up the RH-Firewall-1-INPUT chain, as shown
in Figure 34-10. This chain is referred to by the
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Incoming and Forwarded actions (at the top of the
page). The rules in the RH-Firewal1-1-INPUT chain
control the flow of packets through the firewall.

B Linix Firewall - Mosilla
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* Figure 34-9: Webmin displays the firewall rules.

The Condition column lists the constraints that are
placed on incoming packets, and the Action column
dictates the actions taken when the conditions are
met. When a network packet arrives at your com-
puter, the firewall processes the packet using the
rules in the RH-Firewall-1-INPUT chain.

Take a peek at the chain shown in Figure 34-10. The
first rule states that a packet arriving at interface 100
(which is the internal loopback interface that lets
your computer talk to itself) should be accepted. As
soon as a packet is accepted by the firewall, the rest
of the rules are ignored.

If the packet isn’t arriving on inteface 100, it’s com-
ing from some other interface (like your Ethernet
card) and the firewall moves on to the second rule. If
the packet is an ICMP message, the firewall accepts
it ACMP is a low-level network management protocol
that’s reasonably safe). The third and fourth rules
accept packets belonging to protocols 50 and 51
(those are “next-generation” IPv6 network packets).
The fifth rule states that incoming packets that are
part of a previously established connection are okay.
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If a packet doesn’t satisfy any of the first five condi-
tions, the firewall applies the final rule, which rejects
all packets.

The default firewall rules are very secure — they
allow just enough traffic to get through that your
outbound network connections (like a Web browser)
will still work.
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* Figure 34-10: The chain of rules.

When a packet enters your network interface,
Fedora gives the packet to each rule in the chain, in
the sequence listed. Every inbound packet is evalu-
ated according to the Condition listed in the first
rule; if the packet satisfies the condition, Fedora
takes the action specified in the Action column:

v Do Nothing: Does nothing with the packet but
continues testing with the chain

v Accept: Accepts the packet into the network,
ignoring the remaining rules

v Drop: Destroys the packet with no relayed mes-
sage to the other end of the connection

v Reject: Rejects the packet, but notifies the other
end of the connection

v Userspace: Exports data to a userspace program
that’s not part of the kernel (you can write your
own filters by using Userspace rules)
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v Exit Chain: Exits the chain and returns to previ-
ous chain

»* Run Chain: Moves to another chain of rules

If a packet doesn’t meet the first condition, it’s
tested against the next condition. If the packet meets
that condition, it is subjected to the specified action
or tested against the next rule in line. This testing
continues until the packet is either accepted or
rejected. By default, the last rule in the chain rejects
any packets that are not accepted by earlier rules.

After you understand how the rules are set up in
Webmin, you can feel free to change them. The next
section explains how.

Changing the rules

Given that the default firewall rules are very secure,
you may need to relax them a little to better suit
your needs. For example, if you host a Web server
on your computer, you may want to allow inbound
traffic on TCP port 80 (the port typically used by
Web browsers). If you're hosting a Web server for
internal use only (that is, you want other computers
on your local network to access your server, but
nobody else), you can allow inbound traffic on TCP
port 80, but only if the packet originates on a nearby
address.

Editing existing rules

You can change the actions taken for a condition by
following these steps:

1. Start a Webmin session (see the earlier section,
“Starting a Webmin session”), click the
Networking button, and then click Linux
Firewall.

2. On the Linux Firewall page, scroll down to the
Action link in the table and click it.

The Edit Rule window opens, as shown in

Figure 34-11. You can change either the condition
or action details for a rule from the Edit Rule
window.
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* Figure 34-11: The Edit Rule window.

3. To change the action, click the radio button
next to the desired action in the Action to Take
field.

4. The condition details are a bit more involved,
but not hard to change. Under the Condition
Details portion of the window, use the drop-
down list to enable the filter you want to
enforce and then enter the condition parame-
ter in the field to the right of the condition.

For example, to filter packets based on the ICMP
network protocol, find the Network Protocol line,
change the first list box on that line from Ignored
to Equals, and change the second list box to ICMP.
(Don’t actually do this, it’s just an example.)

5. After making any changes to rules in the Edit
Rules window, be sure to click the Save button
to save the changes.

You go back to the table (refer to Figure 34-10).

6. Click the Apply Configuration button when you
return to the chain of rules.

Your new rule is now in effect.

Adding a new rule with Webmin

The rightmost column in the rules table is labeled
Add, and it contains a pair of up and down arrows.
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To add a new rule above an existing rule, click the up
arrow. To add a rule below it, click the down arrow.
Remember, packets travel through the chain from
top to bottom, so the order is important.

e umn to rearrange the order of the rules within

z Use the up and down arrows in the Move col-
<}
the chain.

&

You have a really secure firewall in place, but you
may need to open up the system for use by others.

If you open up a port for a tool like Telnet, you’ll be
exposing cleartext passwords to anyone who may be
spying on your network. Be sure to use secure net-
work programs like SSH — SSH encrypts everything
that it sends over your network.

To open up your system for SSH use, follow these
steps:

1. Click the down arrow in the Add column of the
first rule in the chain of rules table.

The Add Rule window appears, as shown in
Figure 34-12.
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* Figure 34-12: The Add Rule window.
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2. In the Rule Comment field, enter a comment
like this:

Accept incoming SSH packets
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The Rule Comment is there to remind you why
you created the rule. Be sure to include good
comments in your firewall, and you’ll save your-
self a lot of time later when you need to make
another change.

3. Click the Accept radio button.

4. In the Condition Details area, find the Network
Protocol line and change the list boxes to
Equals and TCP.

5. Find the Destination TCP or UDP Port line and
change the list boxes to Equals and 22.

6. Click the Create button at the bottom of the
page.

You're returned to the first page where you can

see that your new rule has been added to the list.

7. Click Apply Configuration to apply the rule.

You still need to start the sshd daemons, but the fire-
wall will now let an SSH session through. See
Technique 33 for useful information about using SSH
to share your data without exposing yourself to
intruders.

In some cases, you may want a computer that’s
2 («a already behind a firewall to accept incoming
packets only from machines within your net-
work. That way, your corporate firewall can let
Internet-originated traffic through, but you can
secure individual machines more thoroughly.
To do this, create a firewall on that machine
with a rule that limits inbound packets to
addresses from within your own network.

You can limit access to the Internet to protect your
system from unfortunate downloads that might
bring in viruses or other trouble. You’ll save network
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bandwidth, disk space, and time when you don’t
have to worry about restoring your system because
of someone else’s careless download.

Follow these steps to disable Internet access from
within your system (you’ll have to enable the fire-
wall on your computer first; see the section titled
“Finding Your Firewall” at the start of this technique
for details):

1. Click the down arrow in the Add column of the
first rule in the chain.
The Add Rule window appears.

Enter a comment in the Rule Comment field:

N

Close off Internet Access

w

Click the Reject radio button.

)

Use the drop-down list boxes to change the
Network Protocol condition to Equals and TCP.

“

Change the Source TCP or UDP Port condition
to Equals Port 80.

Click the Create button at the bottom of the
window.

N

You're returned to the first page where you can
see your new rule has been added to the list.

7. Click Apply Configuration to apply the rule.

If you're using a proxy server, you need to disable
that port as well. Just add another rule like this one
to reject the packets from that port.

Now your system is insulated from incoming packets
from the Internet, and disk space and network band-
width are preserved for in-house use.
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Save Time By

v~ Sharing your desktop
with VNC

v~ Extending personal invita-
tions to your desktop

+* Exposing your desktop for
others

+~ Using tsclient for remote
viewing

v~ Turbo charging cut and
paste

v~ Creating desktops on
demand with gdm

Using UNC to
Connect to Remote

Desktops

utility that lets you share graphical desktops across a local net-

work or across the Internet. Before VNC server came along, you
could use the KDE or GNOME desktop environments only if you were
actually sitting in front of the computer. With VNC server, you can create
a separate desktop (KDE, GNOME, or whatever environment you prefer)
for use from a different computer — located in the next room or in
another country.

VNC (an acronym for virtual network computing) is a client/server

In this technique, we show you how to set up and use remote viewers
and servers. VNC makes it easy. VNC is friendly, intuitive, fast, and free
(all in all, some of our favorite software features). You can

v Combine the best of different platforms on one monitor.

v Share a desktop with another user to get help or collaborate on a
project.

v Share Linux machines without sharing desktops — each user has his
own work environment, complete with privacy. You can even stream-
line the setup of private remote desktops by creating new VNC desk-
tops on demand.

The time you can save by using other desktops without taking a step is
amazing.

Sharing Desktops with UNC

When you run a VNC (virtual network computing) server on your Linux
computer, you create a new graphical desktop that you can use from a
VNC viewer. Linux is a multi-user operating system: Many users can log
into your computer at the same time.
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When you run a VNC viewer, you see a remote desk-
top within a window on your local desktop. If you
click the Full Screen option, it feels like you’re sitting
in front of the VNC server. When you move your
mouse, the cursor follows. When you type at the
keyboard, the characters are sent to the remote
desktop. Open Konqueror on the remote desktop
and you can drag files around your remote desktop.

VNC is portable:

v You can run the VNC server on a Linux computer,
a Windows computer, a Macintosh, or on a num-
ber of different UNIX distributions.

v You can run the VNC viewer on a Linux com-
puter, a Windows computer, a variety of UNIX
workstations, a Macintosh, or even within a Web
browser.

You can run a VNC server on one platform and the
VNC viewer on a different platform. For example, if
you have a nice big screen on a Windows computer,
run a VNC viewer on Windows connected to your
Linux VNC server. You may like to keep your e-mail
on a Windows-based computer, while using your
favorite graphics program on a Mac, but use your
Linux desktop for everything else.

With just a few mouse clicks, you can have a window
open for each desktop, with each desktop running
the programs you like to use on that system. For
example, in Figure 35-1, you can see three desktops:
in the background you see our workstation (Fedora
Core running KDE), in the upper-left you see a
Windows desktop, and in the foreground is a remote
session waiting for us to log into another Fedora
host.

Because each remote desktop appears within its
own window on your local desktop, you can work
with multiple desktops at the same time.

- opinion about a problem on your desktop —
just let your most technically adept friend log

in and help.

Z Desktop sharing makes it easy to get a second
<}

&
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* Figure 35-1: Multiple remote desktops.

Inviting Your Friends
to Use Your Desktop

If you've installed the KDE Networking package, you
can share your desktop with another user (if you
haven'’t installed the kdenetwork package, flip back to
Technique 17 for a quick refresher). Sharing your
desktop is a great way to get help from another user,
or to collaborate on a project. When you share your
desktop, the other user connects to your desktop
using a VNC viewer (such as vncviewer or rdesktop).

To invite another user to share your desktop, follow
these steps:
1. Open the KDE menu.

2. If you're running Fedora Linux, choose System
Tools>More System Tools->Desktop Sharing.

If you're running SuSE Linux, choose System=>
Remote Access=>Desktop Sharing.

Mandrake users choose Internet->Remote
AccessDesktop Sharing.

The KDE Desktop Sharing window appears.



3. Click Create Personal Invitation.

The Personal Invitation window appears, show-
ing the display information and password that
the other user will need to view your desktop.

When you create an invitation, other users have
one hour to connect to your desktop using the
password displayed on your computer.

4. Share this information with the other user. You
can phone your friend and read him the Host
information and Password, or e-mail the infor-
mation to him.

When another user connects to your desktop, a
window will appear asking if you want to accept
the connection. (The window includes the name
of the other computer so you can see who's try-
ing to connect.)

5. If you check the Allow Remote User to Control
Keyboard and Mouse box, your friend will be
able to take control of your computer from his
desktop.

6. Click Accept Connection.

The other user will see the contents of your
desktop and be able to take control, if you chose
to do that.

Serving Up a New Desktop
with UNC Server

The KDE Desktop Sharing tool is perfect when you
want to let another user see your desktop, but VNC
can do much more than that.

When you run a VNC server on your Linux computer,
VNC creates a new desktop that you can see only
with a VNC viewer. The difference between KDE
Desktop Sharing and a VNC server is that, with KDE
Desktop Sharing, two or more users are looking at
the same desktop at the same time. The VNC server
creates a private desktop for the viewer.

Serving Up a New Desktop with UNC Server
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RPM version from www.realvnc.com. Check
out Technique 17 for information about
installing RPM packages.

? If you need to download VNC server, get the
<8

The first time you run the VNC server, VNC creates a
new directory named ~/.vnc. VNC also creates an
xstartup file in ~/.vnc. By default, the VNC server
assumes that you want to run the twm window man-
ager instead of KDE or GNOME. twn is a really old,
nasty window manager, which is as powerful and
friendly as a thermonuclear fly swatter.

To start your normal desktop environment (KDE or
GNOME) in the new VNC desktop instead of twm:

$ mkdir ~/.vnc
$ cp .Xclients ~/.vnc/xstartup

Now open a terminal window, and enter the
command:

$ vncserver -depth 24

The first time you run vncserver, you're
prompted to create a password. Remember
that password because you'll need it to con-

nect to the new desktop.

vncserver displays your new desktop address:

New 'kobe:1 (freddie)' desktop is kobe:1l

That’s all there is to it. Your local machine is now
ready to serve VNC viewers.

] If you're setting up a Windows host, visit www .
a Q@

realvnc.com and download the executables.
Using the Setup Wizard, Windows installation
is simple and fast, and Windows takes good
care of you — right down to putting the icons
on the desktop.

&

VNC Server and Viewer are out there for
OSX, but the Web sites are a bit nomadic in
nature right now. Just use your search engine,
and you'll find good workable renditions so
you can share desktops with your Mac.
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We explain a quicker way to create VNC desktops in
“Creating New VNC Desktops on Demand” later in
this technique. Now you’re ready to connect to your
server with a VNC viewer.

Using tsclient to Uiew Remote
Desktops from Linux

VNC isn’t the only desktop sharing protocol that
you’ll run into (but it’s the most portable). If you
have access to a Windows Terminal Server (or
Windows XP), you can use the RDP (remote desktop
protocol) to connect to your Windows desktop.
Citrix users can connect to Citrix servers with wfica.
You can run VNC server on any Windows computer,
but RDP runs much faster if you can use it.

tsclient is a user-friendly interface that can make
connections with VNC, RDP, and Citrix ICA desktops.
As if that isn’t enough, it’s included with Fedora and
simple to install. You can be connected to a host in
minutes with tsclient.

We recommend the tsclient package for all your
remote desktop viewing needs. Its graphical inter-
face makes it quick and easy to connect to any
remote desktop using the protocols that you've
installed. If you've installed the vncviewer RPM
package, tsclient gives you a friendly interface to
remote VNC desktops. Install rdesktop, and tsclient
lets you connect to Windows Terminal Server desk-
tops. tsclient will even build Citrix connections for
you if you’ve installed the Citrix client software on
your computer.

Go ahead and install the tsc1ient and VNC RPM
packages (see Technique 17 if you need help with
the RPM installer). Install the rdesktop package if
you are going to connect to any of the following
Windows platforms:

v Windows NT Terminal Server

v Windows 2000 Terminal Server

v Windows XP Professional
v Windows Server 2003

To run tsclient:

1. Open the Main Menu.

2. Click Run Command (or Run Application if
you’re a GNOME user).

The Run Command dialog appears.
3. Type tsclient and click Run.

When tsclient starts, you see a window like
that shown in Figure 35-2.

ld Terminal Server Client -2

Connection Profile

General | Display | Local Resources | Programs | Performance

Logon Settings

n Type the name of the computer or choose a

=== computer from the drop-down list.

Computer: |

Protocol: | RDP z |

User Name:
Password:
Domain:

Client Hostname: |
Protocol File: | :|:|

‘ Dgp«en H QSa\reﬁs|

‘ & Help H A Less H 8 cancel H @Coﬂnect|

* Figure 35-2: The tsclient window.

If you're connecting to a VNC server, read the next
section. If you're connecting to an RDP server

(a Windows Terminal server, Windows XP, or Citrix
server), skip ahead to the section titled “Using
tsclient with an RDP server.”
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Using tsclient with a VNC server

To connect to a VNC desktop:

1. Run tsclient following the steps earlier in this
section.

2. Choose VNC from the Protocol list box, and
type the remote computer name (or IP address)
into the Computer field.

If you are connecting to a Linux- or UNIX-hosted
desktop, you may need to include the display
number along with the computer name. For
example, to connect to desktop 3 on host
bastille, you would enter bastille:3.If you
don’t include a desktop number, tsclient
assumes that you want to connect to desktop 0.

3. Click More to see all the tsclient controls and
then click the Display tab to choose the initial
size for your viewer window and the color
depth.

4. If you have a fast connection to the server,
choose a color depth of 24 bits. If you have a
slow dial-up connection, choose a lower color
depth.

@ Turn off busy screen savers if you're using
&> («s VNC viewer, and VNC will run a lot faster.
& Any little animated graphic can bog down

screen repaints when all the bits are getting
sent across a network.

The other tabs (Local Resources, Program, and
Performance) are not used for VNC connections.

5. Click Save As to save your connection profile.

The next time you want to connect to the same
desktop, just click Open and choose the connec-
tion profile that you've just created.

) Make good use of VNC to do customer sup-
B (@ port by opening a window to your customer’s
desktop. Diagnosing problems and making
fixes over a local network or across the Internet
saves travel time, and it leaves you with access
to books and tools that you might need.
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Using tsclient with an RDP server

After you run tsclient, as explained earlier in this
section, you're ready to set up tsclient so that you
can view the remote desktop. Before you can con-
nect to a Windows RDP desktop, you need to be sure
your Windows host is ready. Follow the steps for
whichever Windows version you’re using:

v If the host is running Windows XP Professional:

1. Open My Computer and double-click
Properties.

2. Choose the Remote tab.

3. Check the Allow Users to Connect
Remotely box.

v If the host is running a Windows Server
Edition:

1. Choose Start=>Settings~Control Panel=>
Services.

2. Right-click Terminal Services and click Start.

To connect to an RDP desktop (one of the Windows
flavors we mentioned earlier):

1. Choose RDP (or RDPvS5) from the Protocol list-
box and type in the name of the computer that
you want to connect to.

When you use the RDP protocol, you have a few
more options. (Don’t forget to click More to see
the full set of tsclient controls.)

2. On the General tab, you can supply a User
Name and Password, as well as a Domain
name.

3. Click the Local Resources tab to redirect
sound from the remote desktop to your local
computer.

4. On the Programs tab you can specify a startup
program and directory for the remote desktop.

If you don’t specify a startup program, the
remote desktop runs the Explorer shell.
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5. Click the Performance tab to optimize the con-
nection. We recommend that you check Enable
Bitmap Caching and Do Not Send Motion
Events.

If you see any Windows programs behaving
erratically, uncheck Do Not Send Motion
Events the next time you connect.

6. Click Save As to create a new profile or
Connect to connect to the remote desktop.

If you're using a remote Windows desktop,
anyone who is in the room with the remote
computer can see what you're doing — all

your mouse movements, typing, and windows
are right there for the world to see. Be aware
that you might be sharing your e-mail (or
embarrassing browsing habits) with someone
else when you share desktops!

Making Cut and Paste
Commands Work on a
Remote Desktop

VNC tries very hard to share clipboard content

(cut and paste) between the VNC viewer and the
VNC server. You can cut (or copy) from one desktop
and paste in the other. VNC tries, but without a little
help from a program called autocutsel, the clip-
board is pretty unreliable. autocutsel synchronizes
the viewer and server clipboards to give you better
success and save time in the long run. To install
autocutsel:

1. To download the tarball, go to http://lepton.
fr/tools/autocutsel, click the download link,
and save the tarball to your Desktop directory.

2. Open a terminal window and cd to the direc-
tory that contains the downloaded tarball
(~/Desktop).
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The complete pathname is visible in the bot-
tom bar of the Download Manager dialog.

3. Extract the tarball with the command:
tar -xzvf autocutsel-0.6.2.tar.gz

This extracts the contents of the tarball to a new

directory called autocutsel-0.6.2.

4. cd to the new directory and type the following
command and press Enter:

./configure

autocutsel clicks and whirs and checks for
things it needs.

4. Type make and press Enter.

6. Give yourself superuser privileges with the
su command.

7. Typemake install and press Enter.

8. Type exit to relinquish your superuser

privileges.

Now, to run autocutsel, type autocutsel& at the
command line and press Enter.

=

See Technique 8 to find out how to add
4 autocutsel to your Startup folder so it starts
automatically each time you log in.

¥
e

autocutsel runs quietly in the background; you
won’t see any evidence that it’s running (except
that your clipboard starts working reliably).

L/ Even without autocutsel, the clipboard (cut
- { <@ and paste) works sometimes. The clipboard
& isn't too dependable, but it's definitely a time-

saver if it works with your programs. If you
don’t want to take the time to download and
install autocutsel, cutting and pasting is still
worth a try, but don’t waste too much time on
this one — it either works or it doesn't.



Creating New UNC Desktops
on Demand

In the “Serving Up a New Desktop with VNC Server”
section, earlier in this technique, we show you how
to manually set up a VNC server. That works well for
a quick-and-dirty solution, but to really save time,
you can configure the GNOME Display Manager (gdm)
to create new desktops on demand. Fedora Linux
uses gdm to manage graphical desktops even if you're
running KDE. SuSE and Mandrake Linux assume that
you want to use the KDE display manager. The tech-
nique we describe here works only if you're using
the GNOME display manager, so we also show you
how to switch from the KDE display manager to gdm.
When you hook up gdm and the VNC server, a new
desktop is created each time you log in with a VNC
viewer. Now that’s a timesaver!

) One really great thing about the gdm/VNC
- («a combination — lots of users can log in to the

same machine and each one gets his own indi-

vidual desktop. This is a great way to make
Linux converts out of your stalwart Windows
users.

&

Switching display managers in SuSE Linux

To switch your SuSE Linux system from kdm (KDE
display manager) to gdm (GNOME display manager),
follow this procedure:

1. Open the main menu and choose Systemr>YaST.

2. If prompted, enter the superuser password and
click OK.

3. When the YaST control center appears,
choose System, and then choose Editor for
/etc/sysconfig Files.

4. When the System Configuration Editor appears,
open the Desktop section of the tree control
(in the left-hand pane).

5. Open the Display manager section of the tree
control and click DISPLAYMANAGER.
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Your System Configuration Editor window should

look like Figure 35-3.
YasT2 L=
CenuRIGn gpEns Current Desktop/Display manager
+~Applcatons
El:Dasleiop. Ssiting of: DISPLAYMANAGER
{-X_MDUSE_GURSOR
< Diplay manager LE““"" ¥ | Detaut
U e i
i [-DISPLAYMANAGER_REMOTE_ACC | kam
| -DISPLAYMANAGER_ROOT_LOGIN || sim
i -DISPLAYMANAGER_STARTS_XSE wedm
DW_SHUTDOWN cansake
Dl_USERS
H | GREETSTAING
I L-DISPLAYMANAGER_AUTOLOGIN Description:
| L DISPLAYMANAGER_PASSWORD_I
+-KDE Here you can set the defaull Display manager fdm'xdmgdmwdmconsale)
el allchangss in this file require a restart of the displaymanager
+- Window managr
+- Hardwars
+- Metwark
+-System
I 3]
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* Figure 35-3: The System Configuration Editor.

6. Open the drop-down list labeled Setting of:
DISPLAYMANAGER and choose gdm.

7. Click Finish to close the System Configuration
Editor, and then close YaST.

8. Reboot your computer.

When your computer reboots, it runs the
GNOME display manager.

Switching display managers in Mandrake Linux

The Mandrake Control Center makes it very easy to
switch display managers — just follow these steps:

1. Open the main menu and choose System=>
Configuration=>Configure your computer.

If prompted, enter the superuser password and
click OK.

When the Mandrake Control Center appears,
click System, and then click Display Manager.

Click GDM (GNOME Display Manager), and
then click OK.

N W N

At this point, the Display Manager editor asks if
you want to restart the dm (display manager)
service. Before you click Yes, be sure to close
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any other applications that you have open on
your desktop: When you click Yes, your graphi-
cal environment will shutdown and then restart
using gdm.

5. After closing all other applications, click Yes to
restart the display manager.

Connecting gdm and VNC

To connect gdm and VNC:

1. Open a terminal window and give yourself
superuser privileges:

$ su
Password:

#

2. Start your favorite editor and enter the text
shown in Listing 35-1.

You can adjust the “-geometry 1024x768” part if
you want a larger or smaller desktop.

3. Save your work in a file named
/etc/xinetd.d/vncserver.

4. Open /etc/services and add the following line
to the end of the file:
vnc 5900/tcp # VNC Server screen :0

That defines a TCP protocol named vnc (on
port 5900). Whenever xinetd detects a connec-
tion attempt on port 5900, it consults /etc/
xinetd.d/vncserver to figure out which pro-
gram to run.

5. Save your work and close the editor.

6. Run the gdm configuration program.
# gdmsetup

This opens the Login Screen Setup dialog, shown
in Figure 35-4.

7. Choose the XDMCP tab, check Enable XDMCP,
and then click Close.

8. Atthe command line, tickle the gdm daemon to
make it re-read its configuration file:

ki1l -SIGHUP $(cat /var/run/gdm.pid)
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in Screen Setup

\General| Standard gzeeler|Graph‘\caJ greeter | Security |XDMCP‘

Greeter
Local ‘ Graphical greeter x ‘
Remote: ‘ Standard greeter ¥ ‘

[] Always use 24 hour clock format
Welcome string; Welcome

Remote welcome string; Welcome to %n

Automatic Login

[C] Login a user automatically on first bootup

Automatic login usermame:
Timed Login

[[] Login a user automatically after a specified number of seconds

Timed login usemame:

Seconds before login: 30 =

* Figure 35-4: The Login Screen Setup dialog.

9. Finally, tell xinetd to re-read its configuration
files:

kill -SIGHUP $(cat /var/run/xinetd.pid)

Now you’re ready to create new desktops when you
need them. When another user wants to connect to
your computer (or if you want a new desktop because
you're sitting at a different workstation), just log in
with a VNC viewer. gdm and VNC will be listening for
connections to display 0 (if your computer’s name is
brussels, you want to connect to brussels:0). When
a connection request comes in, VNC creates a new
desktop, and you're ready to log in.

LisTiNG 35-1: /etc/xinetd.d/vncserver

service vnc
{

disable = no
socket_type = stream
protocol = tcp

wait = no

user = nobody

server = /usr/bin/Xvnc
server_args = -inetd -query

localhost -once securitytypes=none
-geometry 1024x768 -depth 24
log_on_failure += USERID
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Save Time By

+* Checking out file usage
with 1sof

v~ Looking for open servers
with 1sof and grep

v~ Using the Ethereal
Network Analyzer to
follow network traffic

v~ Adding color to Ethereal
reports for easy reading

atching what your users are up to can tell you a lot about the
Wrequirements of your network. It can also alert you to practices

that are going on that shouldn’t be. This technique is all about
watching file and network traffic to find out what your users are doing.

You use the 1sof command to get a list of all the open files on your sys-
tem as well as useful information about each file — the file owner, the
process that’s using it, and more. You can also use the 1sof command to
find a list of all the files currently in use by a single user — a quick way to
see what someone’s up to.

When you combine the 1sof command with grep, you can query your
computer for a list of network services. It’s easy to find out what’s out
there listening for processes — ssh, vnc, webmin, and so on. You can also
use the combination of commands to generate a complete list of connec-
tions and servers to get a clear picture of the activity on your network.

The Ethereal Network Analyzer tool is included with most standard dis-
tributions, and it gives you a cozy place to watch network traffic. You can
even colorize and filter network traffic to discover details about the spe-
cific information types you’re watching for. If too much surfing is going
on and clogging network resources, Ethereal helps you to find this out.
This tool also tells you who's doing it.

This technique is about being a snoop. Snooping can be a bad thing, or a
good thing. Snooping to get people in trouble isn’t nice, but snooping for
a good cause can be useful. Use this technique wisely, and you can watch
for bad guys in your system and network slowdowns that can be averted
with a quiet word to a coworker.

Exploring Your Network with Isof

1sof is one of the most powerful tools in the Linux toolbox. 1sof displays
a list of all the files currently open on your computer. Browsing through
the output from 1sof gives you a clear picture of who’s logged in, what
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they’re running, and what resources they’re using.
You can also see which background daemons are
running and what resources they’re using.

Running Isof

To use 1sof, open a terminal window and give your-
self superuser privileges with the su- command.
Enter the command 1sof and press Enter.

You can run 1sof without giving yourself
superuser privileges. However, you can only
view processes that you own, and you proba-
bly have to use the complete pathname when
you invoke 1sof (/usr/sbin/1sof).

Stretch your terminal window as wide as possi-
ble before running 1sof. Line-wrapping in a
narrow window makes the list hard to read.

If it's not already installed on your system, you
can add the 1sof.version.rpm package from
your distribution media. See Technique 17 for
helpful hints about installing RPM packages.

The results from the 1sof command appear, as
shown in Figure 36-1.

[
Session Edt View Bookmarks Semings Melp

|

kdeinit 12288 susan mem  REG 0

] 163584
kdeinit 12268  susan oem REG 3 104224
kdeinit 12288  susan mem  REG 3,2 1603424
kdeinit susan mnem REG 3

kdeinit
kdeinit
kdeinit
kdeinit

susan nem  REG E
susan nem REG 3
susan nem  REG 1
susan  nem REG 3
kdeinit susan nem  REG E
kdeinit 12288 susan mnem REG 3
kdeinit 12288 susan mem  REG 3
kdeinit 12288 susan mnem REG 3
3
3
£
3
El

kdeinit 12288 susan wmem  REG ib/T1s/1ibprhread-0.60, 50

kdeinit 12268 susan mnem REG 2 sr/X11RE/11b/1ibXmm 50 . 6.2
kdainit 12288 susan mem  REG ] 181420 fust/1ib/kded/kio_file.so
kdeinit 12268  susen mem  REG 2 52090 /1ib/libresolv-2.3.2.50

kdainit 12288  susan nem REG 3,2 6866224 475502 fusr/1ib/qr-3.1/1ib/14

b0.3.1.2

kdainit 12288 susan mem  REC 3,3 4RIN44 1ib/1ibkdeui .50, 4.1.0
kdeinit 12288 susan mem  REC 3,2 201112 Lib/1ibkio,s0.4.1.0
kdeinit 12288 susan  Or  CHR 1,3 11 i
kdeinit 12288  susan 1w FIFO 0,5

kdainit 12788 susan  Iw FIFO 0,5

kdeinit 12288 susan 3 unix OxcZeooH¥O0

kdainit 12288 susan ¢ FIFO 0,5 67 pips r
kdeinit 12268  susan S8 FLFO 0,8 H7794%0 pipe ;_I

* Figure 36-1: The list of open files.

Interpreting the Isof output

The output from 1sof contains a wealth of informa-
tion. Each line represents a file that’s currently in
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use. The columns, from left to right, display the
following information:

\

Name of the program that’s using the file
Process ID

User name

File descriptor or usage type

File type

Device where the file is located

File size

W W W W W WA ¥

Inode number

\

Complete pathname of the file

The column labeled FD displays either a file descrip-
tor number or a usage type.

If you see a number (followed by a letter or two),
that’s a file descriptor number. The number isn’t
very useful except in three cases:

v File descriptor number 0 is connected to the
standard input stream for the process.

v File descriptor number 1 is connected to the
standard output stream.

v File descriptor number 2 is where the program
sends error messages.

File descriptors 0, 1, and 2 are usually connected to
a terminal device (/dev/ttynn or /dev/ptynn) for
interactive processes. If you see one of those
descriptors connected to a file, you know that that
stream has been redirected witha >ora<.Ifa
descriptor is connected to a pipe, it’s connected to
the standard input stream (or standard output
stream) of another process with a pipe character |.
If an output descriptor (descriptor 1 or 2) is con-
nected to /dev/null, output sent to that stream is
thrown away:. If descriptor 0 is connected to /dev/
null, that process is reading from an empty file.

The letters following the file descriptor number tell
you how the process is using the file:



v r means that the file is opened for read-only
access.

v wmeans that the file is opened for write-only
access.

v umeans that the file is opened for read and write

access.

You may see other letters following the file descrip-
tor number — see the man 1sof page for full details.

If you don’t see a number in the FD column, 1sof is
showing you the usage type for that file:

v cwd: This file (actually a directory) is the current
working directory for the process.

v rtd: This directory is the root directory for the
process. (It's almost always /, except when the
process is running in a chroot jail.)

v mem: This is a memory-mapped file (usually a
shared object library).

v txt: This is the full pathname of the program.

Again, you may see other usage types, and man 1sof
will give you a complete list.

Reading file types

The file type column (fifth from the left, labeled
TYPE) tells you what kind of file you're looking at.
Linux is known for treating just about anything as

if it were a file, so you'll see a variety of file types.
A typical 1sof report shows the following file types:

V¥ REG: A plain old disk file

v DIR: Adirectory

» FIF0: A named pipe (a connection between two
Of more processes)

v CHR: A character-type device (such as a serial
port or terminal)

» BLK: A block-type device (such as a raw disk
drive or CD)
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v unix: A UNIX-domain socket (an interprocess
communication link)

v 1Pv4: An IPv4 network connection

v 1Pv6: An IPv6 network connection

Discovering Network
Connections

When you’re viewing network information with 1sof,
the last two file types in the preceding list — IPv4
and IPv6 — are the ones that you're interested in.
IPv4 and IPv6 files are active network connections or
network service providers (v4 and v6 refer to the
network address type).

When 1sof finds a network connection, rather than
show you a filename, it displays the IP address of the
network interface on your computer, the local port
number, the IP address of the remote side of the con-
nection, and the connection state.

Here’s an example:

bastille:38517->Touvre (ESTABLISHED)

bastille is the name of the local network interface,
38517 is the TCP port assigned to this session,
Touvre is the name of the computer at the other end
of the connection, and (ESTABLISHED) tells you that
the network link is up and running.

The local interface name is useful when you
have more than one network card in your
computer.

Connections listed as (ESTABLISHED) show you
active network connections (such as an ssh session
or a Web browser connection). If you see a connec-
tion listed as (LISTEN), you're looking at a network
server. For example, if you see

*.ssh (LISTEN)
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you're viewing the sshd server. (In this case, the left-
most column should tell you that the sshd program
is servicing this network port.)

In addition to simply looking for network connec-
tions, you can do some other handy things to check
out those connections:

v List all listening servers: You can combine the
1sof command with grep to discover the net-
work servers running on your system. The
command

# 1sof | grep LISTEN

generates a list of services that are listening on
your system — Web servers, ssh daemons, VNC
servers, and so on (see Figure 36-2).

Rl root ¥ kobe:~ - Shell - Komsole
Session Edit View Bookmarks Seftings Help |
4 |

[[reotokabe roatin 0
rootekebe root]|# lsof | grep LISTEN

portmap 1872 Tpe du TPwvd 1915 TCP *:sunrpe (LISTEN)

rpc.statd 1885 rpcuser 5w IPvd 1956 TCP *:32774 (LISTEN)

cupsd 2242 reot 0w IPwd 2485 TCP localhost. localdomadn:ipp (L1
STEN)

sahd 2263 reor  Au IPwd 2518 TCP *:ash (LISTEN)

xinetd 2209 root Su IPwd 2605 TCP localhost.localdomain:32775 (
LISTEN)

xinetd 2209 root Gu IPvd 2610 TCP *:vmc (LISTEN)

nendnail 2373 root  du IPwe 2626 TCP localhost. localdomain:sntp (L
15TEN) m
ninisery. 2440 oot  du IPvd 223 TCP *iwebnin (LISTEN) 0
[icuotskobe root)s 2 |

* Figure 36-2: The list of open services.
] If you find that 1sof is running very slowly,

. (« add 1 to the command line. The n flag tells
& 1sof to turn off host name resolution. You'll

see IP addresses rather than host names, but
you'll see them much more quickly.

v Add components next to port names: If you see
a server that displays a port number rather than
a service name, you can save yourself time by
adding a new entry to the /etc/services file:

1. Track down the program that’s serving up the
anonymous port.

2. Open /etc/services with kate (or your
favorite editor):

# kate /etc/services
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3. Add a line at the end of the file with the serv-

w

ice name, port number/protocol, and a com-

ment out to the right, as shown in Figure 36-3.

.Eir Edn Document Bookmarks Yiew Iools Setings Help

M=

BE4dr QI Q s¢cRHOB KEQ T8 6
| o SE yhond 20012/ uidp, : T ® voice box system =]
| |wmndxe. 22305/ tep, § E # used by the kWnn package
L ]| mmnd_cn. 22289/ tep, # used by the chnn package
——————— wnn4_Tw 22321/ tep, # used by the twnn package
EdP.avSlevE | bingp 24554/ tcp, # Binkley
binkp, 24554 /udp, # Rinkley
asp. 2 tep. # Address Search Protocal
asp, . 2 udp, ® Address Search Protocol
thide, . 60177/ tep, # Timail
tiida, BOL77 fudp, # Tfmail
fida, 60170/ tep, # Ifmail
fida, 60179/ udp, # Tfmail
 Lacal services
wme, . 5800/ tep, # VHC Server screen (0 i
webmin, . 10000/ tep, # Webmin serves|
Line: 570 Col: 63 | | INS | NORM services

o

cd 'fete”
[rootfkobe root]s cd *fetc’
[rootokobe etc]# []

* Figure 36-3: Adding a friendlier server description.

4. Save the file and then exit.

The next time you check for open services,
you'll see the more recognizable name rather
than the port number.

v List all servers and active connections: If you
want to see a list of all the servers and active
connections on your computer, enter the follow-
ing command:

# 1sof -1

This command shows you not only the ports that
are open and waiting for a connection, but also
the ports that are in use.

Other Timesaving Isof Tricks

1sof is a good tool for looking at the network con-
nections on your computer, but it has a few more
tricks up its sleeve.

First off, you can limit the files displayed by 1sof in a
number of ways:
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v -c command: Displays files that are opened by
any occurrence of the given command. (You can
specify a partial command name here; for example,
-c xmdisplays files opened by commands whose
names start with xm.)

v -u username: Displays files opened by user
username.

v -i TCP@host: Displays TCP connections to host.

V¥ -p processID: Displays files opened by the given
process.

If you've ever tried to umount a CD that’s being used
by another user, you know that Linux won'’t let you.
The other user might not even be using the CD; if
that user has a terminal window open to the direc-
tory, you can’t eject the CD until he or she is done.
To find out who’s hogging the drive, use the follow-
ing command:

# 1sof | grep /mnt/cdrom

The result set shows you the device user. Hopefully,
this user can surrender the drive so others can
use it.

Packet Sniffing with the
Ethereal Network Analyzer

Normally, your machine doesn’t read the network
packets that aren’t intended for it. The Ethereal
Network Analyzer is a packet sniffer that watches all
the packets that go across your network and lets
you open and read the packets you choose.

Starting Ethereal

To open the Ethereal Network Analyzer, follow these
steps:

1. If you're running Fedora Linux, open the Main
Menu and choose Internet=>More Internet
Applications->Ethereal.

If you're using SuSE, open the Main Menu and
choose Internet>Administration.
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If you're using Mandrake, open the Main Menu
and choose System=>Monitoring=>Ethereal.

2. Enter your password when prompted.

Ethereal opens, as shown in Figure 36-4.

(% The Ethereal Network Analyzer
Eile Edit Captwe Display Tools Help

o, _[Time [source [Destination [Protocel [info ]

Reset|[apply| Ready o load or capture

* Figure 36-4: The Ethereal main window.

The Ethereal Network Analyzer is included
with most Linux distributions. If it's not on
your menu, it should be on the disc. Just
install the RPMs with the following commands:

# rpm -Uhv ethereal-version.rpm
# rpm -Uhv ethereal-gnome-version.rpm
Capturing packets
To start capturing network packets in Ethereal,
follow these steps:
1. Choose Capturer>Start.

The Capture Options setup dialog opens, as
shown in Figure 36-5.

2. In the Interface list box, choose the network
interface that you want to watch.

Typically, you choose eth0.

3. Check the Update List of Packets in Real Time
and Automatic Scrolling in Live Capture boxes.
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(hal Ethereal: Capture Options
Capture

Interface: | ethO

[ Limit each packetto |&a * bytes

Capture packets in promiscuous mode

Capture file(s)

[JUse ring buffer  Mumber of files |2

[] Rotate capture file every |1 = second(s)
Display options

[[] Update list of packets in real time
[] Automatic scrolling in live capture

Capture limits
[] Stop capture after |1 * packet(s) captured

w
-

w

[] Stop capture after |1 kilobyte(s) captured

[] Stop capture after |1 -
Mame resolution

Enable MAC name resolution

secandis)

w

[] Enable network name resolution

Enable transpart name resolution

| Ok | | Cancel |

* Figure 36-5: The Capture Options setup dialog.

- Z a As a rule, checking the Enable Network Name

A Resolution box really slows things down.

4. Click OK.

Ethereal starts sniffing (see Figure 36-6). If you
look closely at the Source and Destination
columns, you'll see that packets are flowing back
and forth between machines.

] Use the Start and Stop options in the Capture

& («a menu to sample short segments of network
usage for a quick scan. Unless you tell Ethereal

to save the captured packets, it doesn’t create
a log file, but the working file can get big fast.
If your system has plenty of power, it won't
hurt to leave the capture session running, but
if you're running on a slow machine, sampling
is a good idea.
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¥ The Ethereal Network Analyzer -0
File Edit Capture Display Tools Help
No.. |Time Source Destination [ratocot]ints

25 5,247836  192,168,0,28 69,78, 156,62 TP 33275 » 8140 [ACK] Seq4207148239 Ack=d03710382
259 B.344033  192.168.0.1 19.168.0.28 TP 3877 ) 33512 [ROK] SeqmL75844256 Aok=042335920
260 7.048988  192,168.0.28 £9,28,166.62 TEP 33275 > BL40 [ACK] Seqmd207146239 Ack=403710332
261 7,067748  §3,28,156,52 192,168,0,28 TP B140 > 33275 [ACK] Seq=d037L09821 Ack=420714623
262 7.067908  192.168.0.28 69.28.156.62 TP 33275 > 8140 [RCK] Seqmd207146233 Ack=403711078
263 7.070739  63.28.186.52 182.168.0,28 TP 8140 > 35275 [ACK] Sea=i0S7110782 Ack=420714623
264 7,073858  £3,28,1%6,52 19,168,0,28 TP 8140 > 33275 [CK] Seqd03TLLIET0 Ack=420714623
265 7.074085  192.168.0.1 192.158.0.28 TP 9877 > 33512 [PSH, ACK] Seq=L7SB44256 Ack=84293
265 7.108210  192.168.0.28 69,28, 186,62 TP 8275 > 8140 [CK] G

267 708783 152.168.0.28 192.168.0.1 TP 332 > 977 [ACK]
268 7,115722  192,188,0,1 192,168,0,28 TP 9877 > 3/ [PSH,
269 7.116189  192.168.0.28 192,168.0.1 T sl e Lk ([
270 TALTE0 152.168.0.28 192,168.0.1 TP 332 > 977 [FSH, P
271 7,24573  132,188,0,1 192,168,0,28 TP 9877 > 3312 [CK] || Total 271 (100.0%)
| ] SCTP 0 (00%)
TP 270 (396%)
Frane L (5% bytes on uire, 54 bytes capturcd) UDP 0 (0%
Ethernet 11, Sro: 00:90:96:63:20517, Dst: 00:04:5a:7dy \CMP 0 (@om
Internet Protocol, Src Addr: 152,166,0,28 (192, %), Tt Aod: 69,28,156.62 (89.28.13| mmp 1A
Transnissian Cantrol Protocol, Src Port; 33275 (33275), st Port; B140 (8140), Seq: 42071)| (one q
(0.0%)
GRE 0 (0.0%)
[T NetBIOS 0 (0.0%)
0000 00 04 5a 7d 7F O5 00 90 95 63 20 17 0B 00 45 00 .7}, E 23 O (@O
0010 00 28 93 05 40 00 40 06 05 ac c0 aB 00 1c 45 1 (.0 E. VINES 0 (00%)
0020 9= 3c B1 Fb 1F o= fa c3 Fé FF FO a0 B la 50 10 Other 0 (0.0%)
0030 OF 2d Fd 41 00 00
Running  00:00:08
TR

* Figure 36-6: Ethereal capturing network packets.

Applying filters to screen packets

To make the traffic easier to follow, apply filters to
select only the packets you're interested in. Ethereal
filters screen packets by protocol type. You can
choose from hundreds of protocols, but many are so
obscure that you’ll never encounter them.

- Internet traffic between your system and the
Web. If excessive surfing is slowing down
the network, you can screen all the network
packets for the HTTP protocol and find the

prime offenders.

z You can set up an HTTP filter to monitor the
<€

&

To add and apply a filter, follow these steps:

1. Choose Edit~>Display Filters.

The Edit Display Filter List dialog opens, as
shown in Figure 36-7.

2. TypeHTTP Packets in the Filter Name field and
type http in the Filter String field, and then
click New.

3. Click Save and then click Close.

You've created a new filter named HTTP Packets.
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Il Ethereal: Edit Display Filter List

Dizplay Filters

Add Expression...

Filter name: |HTTP Packets

Filter string: | http

Save || Close |

¢ Figure 36-7: Adding a display filter.

4. To apply the filter, click the Filter button in the
lower-left corner of Ethereal’s main window.

5. In the Display Filter dialog that appears, high-
light the filter name and click OK.

After a short delay, the packet list shows only
HTTP packets.

Peeking in packets

When you’ve found a series of packets that might be
interesting, you can take a peek inside. Highlight a
packet and choose Tools>Follow TCP Stream. A win-
dow opens, displaying the contents of the TCP
stream. The dialog displays the chatter between the
machines, with each machine responding in a differ-
ent color.

Packet data is not meant to be readable by
@ humans. Some protocols contain recognizable
text (such as the HTML code that a Web

browser uses), but other protocols (like SSH)
are encrypted.
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Network chatter is sent in a series of wrappers. The
outermost layer contains hardware information, and
the inner layers hold the meat of the message. The
outermost layers are the least human-friendly, and
the inner layer is occasionally understandable.

In the middle pane of the Ethereal window, you see a
display of the wrappers that make up the packet
(refer to Figure 36-6). The wrappers that are higher
in the tree control are the machine-friendly wrap-
pers. The lower wrappers are human-friendly.

Expand the lower branches in the tree control to see
an interpretation of the packet that’s highlighted in
the top panel. The bottom window displays the cor-
responding raw data in the packet.

Color-coding packets coming

from your network

The packet listing is much easier to read if you col-
orize the packets coming from the computers on

your network. Follow these steps to add color to the
display:

1. Choose Display->Colorize Display.
The Apply Color Filters dialog opens.
2. Click New.
The Edit Color Filter dialog opens.
3. Enter a name in the Name field.

4. In the String field, enter the IP address you
want to colorize by using the following form
(see Figure 36-8):

ip.src == 192.168.0.218
5. Click the Foreground Color button and use the

color selector to choose the font color. Then
click OK.
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e T . 6. Click OK to close the Color Filter dialog.
Order Filter Edit
Marme String = New s 3
lﬂ}arkev T | y A C}lck SaYe and then OK in the Apply Color
Filters dialog.
A dialog opens, charting the progress as the filter
e runs, and in a snap, the display is colorized. The
up o down new colors make it easy to tell who’s chattering
on your network.
&
el [Listis processed in order until match is found] El ~ 248! tc()oll'](')lzlli: ﬁaec:S;ntaOCI::)r:)et ?I’?eyt(::fi;ll(?tcl'?;trl]selt']v(\;?rk
[ o ] [y | [ swe | [ e || comca | & being generated by a network computer. It's

also an easy way to monitor an individual

* Figure 36-8: The completed Apply Color Filters dialog. user's traffic.

] If you really want conversations to stand out at
0 a glance, choose a background color as well.
& That can get a bit garish, but it's worth experi-
menting with.



Evaluating Your
Network Security

Yethnigue  With Nessus

Save Time By

+~ Using Nessus to evaluate
your network security

v~ Closing any security
vulnerabilities you find
before a hacker can
exploit them

one, a hacker running loose on your system can cause mega-damage

(and time loss) in a matter of minutes. Running a tight ship is impor-
tant. When you set up your network, you're likely to have taken quite a
few measures to ensure your network’s security, but how do you know
you haven’t missed something?

It doesn’t matter if you're the administrator of a big network or a small

A top-notch open-source project called Nessus provides a security scan-
ner that can check your (hopefully) tight ship for leaks — security vul-
nerabilities that hackers could exploit if they had the chance. If your
system freely gives up information about open ports (or more specifi-
cally, the services running behind them), hackers can exploit that infor-
mation easier than they could if they had to make guesses about your
system.

Nessus can do a lot more than detect open ports. Here are some other
timesaving features Nessus has to offer:

v If the security tests you need aren’t included in the distribution, you
can write your own customized plug-ins to get the job done.

v Nessus has a friendly graphical user interface with easy-to-read
reports, or you can run it from the command line.

v The Nessus project stays up-to-date with recent security issues and
provides easy automatic updates of the security test scripts.

v Nessus also supports SSL services, making sure your network is
secure while it works on your ports.

v The Nessus plug-ins search for backdoors, denial-of-service vulnerabil-
ities, sturdy firewalls, remote shell accesses, peer-to-peer filesharing,
useless services, and tons of other security risks. The database cur-
rently has over 2,000 plug-ins.

v Nessus can handle big or small networks with ease, with tailored test-
ing that won’t waste a lot of time.
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In this technique, we show you how to use Nessus to
evaluate your network security. It’s a great tool
that’s easy to use, and the time you save by finding
security loopholes before the hackers do will defi-
nitely justify the time spent investigating your net-
work security.

Getting Up and Running
with Nessus

Setting up Nessus is a matter of a few simple steps.
Before you can use Nessus, you need to do the
following:

1. Satisfy its dependencies by installing the other
programs that Nessus needs to run.

Compile and install the Nessus files.

Create a user identity.

Create an SSL certificate to ensure that the
Nessus transactions are all handled securely on
your system.

NWN

Follow along, and you’ll be up and running in no
time!

Installing programs Nessus needs to run

Nessus has a couple of prerequisites — you need to
have GTK (the Gimp Toolkit) installed on your sys-
tem, as well as the sharutils RPM package. If you've
installed the GNOME desktop environment, GTK is
included. If not, you need to install it.

You can install GTK from your distribution media:

1. Open a terminal window and gain superuser
privileges with the su command. Then move to
the directory containing the RPM packages.

2. Type the following command and press Enter:

# rpm -Uhv gtk2-version.rpm

The RPM for GTK installs.
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You also need the sharutils package, which is
included with most Linux distributions.

3. Toinstall sharutils, type the following com-
mand and press Enter:

# rpm -Uhv sharutils-version.i386

After sharutils installs, you've satisfied the
dependencies for the Nessus program.

- package and install the dependencies is a defi-
nite timesaver. Check out Technique 19 for

information about Synaptic.

%( Using Synaptic to download a Nessus RPM
g

&

Installing Nessus

Now that the program dependencies have been met,
you're ready to download and install Nessus. To
download the latest version of Nessus for your sys-
tem, follow these steps:

1. Open a Web browser and surf to

www.nessus.org/download.html

2. Click the link to the most recent copy of Nessus
for UNIX-compatible computers.

You're taken to a download page.

w

On the download page, scroll down to find The
Easy and Less Dangerous Way section.

Click the link to the server nearest to you.

L A

When the new window opens, click the link for
the nessus-installer.sh file.

Save the file to your home directory.

N S

When the file is done downloading, close the
download manager and the browser window.

You’ve downloaded the files, and now you need to
compile and install Nessus. Fortunately, the kind
programmers at Nessus have provided a pretty
decent setup tool. To install Nessus, follow these
steps:



1. Open a terminal window and give yourself
superuser privileges with the su command.

2. Move to your home directory, type the follow-
ing command, and press Enter:

# sh nessus-install.sh

The Nessus Installation Script opens, as shown
in Figure 37-1.

B sxisaan & localho st home s - Shell - Konsake
Session Edt View Bookmarks Sellings Help

&[] |

NESSUS INSTALLATION SCRIPT

Welcome to the Nessus Installation Seript |
This script will install Nessus 2.0.10a (STARLE) on your system.

Please note that you will need root privileges at some point so that
the installation can complete,

Nessus is released under the version 2 of the G¥U General Public License
(50 http://wew.gnu.arg/licences/gpl.htnl for details).

To get the latest version of Nessus, visit hEtp://www.nessus.org

Press ENTER to continuell

¢ Figure 37-1: The Nessus Installation Script window.

3. Press Enter to continue.

The installation script begins extracting the
archives and setting up shop.

4. When prompted, press Enter to accept the
default location for the Nessus installation.

5. Confirm the installation with another press of
the Enter key when prompted.

Nessus begins compiling the libraries and config-
uring the sources for your system. You may see a
few warnings go by — don’t worry about them
too much — they’re for the authors of the code
to watch.

6. When Nessus prompts you to build libraries,
answer y.

You see a window confirming that the Nessus
installation is finished, as shown in Figure 37-2.
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B ciisn @ localhosthome/sugan - Shell - Kansole

Session Edt View Bookmarks Sellings Help

3 [

Hessus installation : Finished

Congratulations ¢ Nessus is now installed on this host

. Create a nessusd certificate using fusr/
. Add a nessusd user use fust/local/shin/n
Nessus daenon (nessusd) use fu

1/sbin/nessus-skcert
adduser
cal/sbin/nessusd -D

NoE: client (nessus) use fusr/local/bin/nessus
+ To uninstall Nessus, use Susr/local/sbin/uninstall-nessus

. Remember to invoke ‘nessus-update-plugins' periodically to update your
List of plugins

. A step by step dema of Nessus is available at :
http:/wen nessus , org/deno/

rru-.-. ENTER 1o quit

* Figure 37-2: The Nessus Installation: Finished window.

You have only a couple more steps to go before
you’re ready to run Nessus. You still need to add a
user and create an SSL certificate for the program.

Adding a user to Nessus

In the wrong hands, Nessus can make life miserable
for a system administrator. Although most people
use Nessus to scan their own networks, Nessus can
be used to discover (and, to a small extent, exploit)
vulnerabilities in other computers. To minimize the
chances that abuse originates from your computer,
Nessus keeps its own user database. Before you can
use Nessus, you need to add a user and create a
password:

1. Enter the following command:
# /usr/local/sbin/nessus-adduser

The Nessus Add User script starts. The ques-
tions are fairly simple and quick.

2. The script prompts you for a login. Type your
user name and press Enter.

The script prompts you for a means of
authentication.

3. Type pass to use password authentication or
cert to use certificate authentication.
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4, Press Enter to accept the default (password)
and continue.

You’re prompted to enter the login password.

5. Enter a good password (one that’s easy to
remember but hard to guess).

You're prompted to enter a set of rules for the
user. Just accept the default (an empty set) and
move on to Step 6.

6. Press Ctrl+D to continue.

You're asked to confirm the entries for the new
user — glance through the summary to make
sure everything looks correct.

7. Press Enter to continue.

You’re done creating a user in Nessus. The last

step in the setup process is creating a certificate.

See the next section for details.

Generating a certificate

After you add a user for the Nessus security tool, you
need to generate an SSL certificate. The Nessus
server sends the SSL certificate to your Nessus client
so you know that you're connected to the real server
and not someone impersonating your server for das-
tardly purposes. (See Technique 45 for more details
on how SSL certificates safeguard your system.) To
generate the server certificate, follow these steps:

7. Still at the command line, start the Nessus cer-
tificate generator by typing the following com-
mand and pressing Enter:

# /usr/local/sbin/nessus-mkcert

The answers to the following questions are used
to create the security certificate.

First, you're prompted for the CA certificate
lifetime (in days).

2. Press Enter to accept the default of 1460 days,
or enter another length of time.

You're prompted for the server certificate
lifetime.
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3. Press Enter to accept the default.

)

Enter an appropriate, two-letter country code
and press Enter when you’ve decided on a loca-
tion code.

The default is France.
5. Enter your state or province and press Enter.
6. Enter your city and press Enter.
7. Enter your organization name and press Enter.

The questions are done, and your monitor
should be displaying a window confirming
that your SSL certificate has been created
(see Figure 37-3).

8. Press Enter to exit the nessus-mkcert program
and return to the command line.

B tiiean G localhostihome suan - Shell - Konsole

Session Edit View Boockmarks Settings Help
i

treation of the Nessus 551 Cervificate

congratulations. Your server certificate was properly created.
fusr/local fete/nessus nessusd. conf updated
The following files were created :
. Certification authority :
Certificate = jusr/local/com/nessus /CA/cacert, pen
Trivate key = fusr/local/var/nessus/CA/cakey.pen
. Nessus Server :
Certificate = /usr/local/com/nessus/CA/servercert.pen
Private koy = jusr/local/var/nessus/CA/serverkey , pon
Press [ENTER] to exit

[roatalocalbost susane [l

=

* Figure 37-3: The new SSL certificate has been created.

Using Nessus to Scan
Your Network

After you download, install, and set up Nessus, add
your user account, and create the SSL certificate,
you're ready to scan your network for vulnerabili-
ties. The graphical interface makes Nessus quick to
use and fairly intuitive. You’ll be scanning in no time!



You need to do the setup and installation only the
first time you run Nessus. After that, you just start
the daemon and the user interface each time you
want to scan your system.

Starting the daemon and the interface

Nessus is a client/server program. Before you can
scan other machines on your network, you need to
start the Nessus daemon. To start the daemon, fol-
low these steps:

1. Type the following command and press Enter:

# /usr/local/sbin/nessusd -D

2. To start the user interface, type this command
and press Enter:

# /usr/local/bin/nessus

The Nessus Setup window opens, as shown in

Figure 37-4.
N s BEE
Nessusd host [Plugins [ Prets [Sean options | Tanget selection [user | k@ [ creaits
New session setup
=2 Messusd Hast | localhost
Port: 1241
() Login : | susan

Password

Login

[ Start the scan ] [ Load report ] [ Quit

¢ Figure 37-4: The Nessus Setup window.

3. Enter your Nessus login and password in the
appropriate fields in the setup window, and
then click Log In.
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After validating your password, Nessus opens a
dialog, offering you choices about your level of
security.

4. View and approve the certificate to continue.

Nessus moves you to the Plugins tab of the
Nessus Setup window.

A Warning dialog opens, warning you that
volatile plug-ins have been disabled (see
Figure 37-5).

) Warning l=1E]

have heen disabled. %ou should activate them if you want wour security

E The pluging that have the ability to crash remote services or hosts
audit to he complete

* Figure 37-5: A fairly ominous-looking warning dialog.

By default, Nessus disables dangerous plug-ins
that may crash the computer you scan. The
warning that you see is telling you that your
security audit won’t be complete without
enabling the plug-ins that are a threat to your
system.

If you enable the dangerous plug-ins, you may
crash the target system. Are you feeling lucky
today?

5. Click OK to continue.

On the Plugins tab, you see a list of the plug-ins

that are currently installed on your system. They
are grouped according to component type in the
top frame of the window, as shown in Figure 37-6.

6. In the Plugin Selection area, highlight one of
the types to display a list of the plug-ins that
make up that component in the lower part of
the window.

Use the scroll bar to cruise through the list. You
can see that the boxes next to the plug-ins that
are considered volatile are not checked, as
shown in Figure 37-7.
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©ENEHHSSEWP = I~iaix

Messusd husi| Plugins ‘ Prefs |S|:an options |Target selection |Llser | KB ‘ Credits |

Plugin selection

Gain root remotely [« |12
CGl abuses ¥
Windows [ s
Gain a shell remotely [«
Clsco =
Firewalls [« (]
Misc. ¥
Denial of Service [
Remote file access [«
Backdoors ¥
General [« |[+]

|Enab|e aHHEnah\E all but dangerous plugins| |Disah\e aHH Upload plugin

[]Enable dependencies at runtime

\ Start the scan

Load report | Quit \J

¢ Figure 37-6: The Plugins tab of the Nessus Setup window.

(2 Nessus Setup BIEIES
Nessusd host] Piugins [Prefs. | scan options [ Target setection [user [ka | Creuits |

Plugin selection
Gain root remotely =|H
Cal abuses I
Windaws |7
Gain a shell remotely Ell
cIsco I
Firgwalls |

[
[=

Backdoors I
General [+

[ Enable all il Enable all but dangerous pluging il Disable all il Upload plugin. ]

[]Enable dependencias at runtine [ Filter. |
EMule Dos. a O
Interscan 3.32 SMTP Denial A O
stream ¢ A O
Too long line A O
i2tpd Dos
Sambar weh server DOS
AppSocket Dos A0
BadBlue invalid GET DoS A O
MDaemon crash A O
Argosoft Dos
p-smash Dos (ICMP 3 fload) a0
MDaemnn Weheanfin crash miic|

[ Start the scan Il Load report 1 Quit

* Figure 37-7: The Nessus Setup window with
volatile plug-ins.

7. Hover the mouse pointer over the dangerous
plug-in’s warning icon (the little yellow yield
sign with the ! on it) to display a tooltip that
tells you what might happen to your system if

you invoke this plug-in (see Figure 37-8).

R Nessus Setup: BEIE
Nessusd host| Piugins | Prets. | Soan aptions | Target setection | user [ka | creats |
Plugin selection
Gain raat remotely =|H
CGl sbuses I
windows =2
Gain a shell remotely |
cIsco ¥
Firewalls |F
Misc. ¥
o ce
Remote file access [
Backdoors I
General [
[ Enable all 1 Enable all but dangerous plugins I Disable all I Uplaad plugin |
[ Enatle dependencies at runtime Filter
AppSacket Dog =)=
BadBlue invalid GET DoS A Ol
Daemon crash a0
5
p-smash DoS (ICMP 4 flood) A0
MDasmon Wehconfig crash O
Cisco Do3 Crashes the remote servics |
SNMP bad length field Dos o]
Orange Dos. A O
Dragon telnet overflow A O
Linksys WRT54G Dos A O
winnuke imi|cs

[ Startthe scan Nl Load report ] [ Quit

* Figure 37-8: Check out the warnings.

8. Click the yield sign to display a more graphic

explanation of the problems you may

encounter if you enable the plug-in (see the

example in Figure 37-9).

[¥ tiasnas Setup

__i I'Iq\—.l-in Scan optans | Taeget setocton Credn
Pagin 1#Hba0

el
0

o e
Famote tle access
»

Pusr File Sharing

P

Enale ail |

Tha waming tign mese Bt i phogin may Bam T

(& remote hOW By deabbng the aacied service of by Crashing e host

e it v vk ke e e 96 e e W et
FOUS BRIVETE OF AeiSar Soma SENACET manualy

[ Enabie degencancies o nmine

|

LPEnO matamed inout

T ] Load report [

g

o

TRV 1 R

* Figure 37-9: The complete explanation.




We don’t recommend enabling dangerous
plug-ins unless you have a specific security
need. Be sure not to probe someone else’s

machine with a dangerous plug-in enabled
because some of the plug-ins can crash the
remote machine.

9. Highlight a plug-in in the list box at the bottom
of the window to display a more complete
explanation of the specific security threat it’s
designed to combat (see Figure 37-10).

/bin/login overflow exploitation

findlogin overflow exploitation
This script is Copyright (C) 2002 Renaud Detaison

Family : Gain a shell remotely
Categary : destructive_attack
Messus Plugin 1D : 11136
CWE : CVE-2001-0797
Bugtrag 1D : 3681
fRevision: 1.2 §

‘What is shown if the aftack is successful :

Thete is a bug in the remote /hindogin which
allowes an attacker to gain a shell on this host, without
even sending a shell code.

[+]

An attacker may use this flaw to log in as any user
{except rooty on the remote host.

Solution : See hitpudwww.certorgfadvisories/C A-2001-34.html
Risk factor : High

[<]

| Set plugin timeout... |

| Show dependencies |

| Close |

* Figure 37-10: Information about the plug-in.

70. Across the middle of the Plugins tab are four
buttons, indicating the plug-ins you’d like to
apply to your scan. Choose to

» Enable All: Enable all the plug-ins currently
on your system.
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» Enable All but Dangerous Plug-ins: Don’t
enable the plug-ins that might cause problems
on the target systems.

» Disable All: Disable all the plug-ins for a
minimal scan.

» Upload Plugin: Upload any plug-ins that you
write to the Nessus server.

] For a good starting place, click the Enable All
- («a

but Dangerous Plugins button. That way, you
avoid spending time fixing system corruption
until you've done some preliminary scans for
loose security. Save the risky endeavors for
Fridays, before slow weekends, after a good
solid backup.

é

7171. Click the Target Selection tab to select the
machine that you want to test. Enter the host
name (or IP address) in the Target(s) field and
click the Start the Scan button.

The scan opens another window, where progress
bars chart the progress of the scan, as shown in
Figure 37-11. When the scan is complete, the
original window and a window with the results of
the scan appear on your desktop. Now, you need
to interpret those results, which we discuss in
the next section, “Reading the grim results.”

K Scanning network from localhost

a8 Portscan

192.168.0.1 Checks

| Stop the whole test

* Figure 37-11: The scan in progress.
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Reading the grim results

You can enter multiple machines in the
Target(s) field by separating the host names
(or IP addresses) with a , (comma). Click the
Start the Scan button, and a scan of all the
systems displays on the desktop.

At first glance, the scan report looks pretty good; in
fact, it looks empty (see Figure 37-12). Just wait until
you start exploring.

 Neasas Setug -ox
Nessusa hast | Plugion | Prods | Scan optians | Targst selsction | User | KB | Crocity
Target saiecean

Targeils) Ainsd fle

Partorm 8 00¢% tons Eansfer

5assion [Taegets

Arin o

St e 180

Save negant Clote wisdow

L o
* Figure 37-12: The scan results.

The good news is, the reports will tell you what to
do about any security breaches Nessus finds. The
bad news, well, bear with us. Here’s how to delve
into the report:

1. Highlight the subnet for your system in the
Subnet frame.

The individual machines that you've included in
the scan are listed below, in the Host frame.

2. To see itemized information about what the
scan found for each machine, highlight the
machine address.

Technique 37: Evaluating Your Network Security with Nessus

A list of the ports found open in the scan
appears in the Port frame, as shown in
Figure 37-13.

Wesusd hast | Plagiss | Prods :knm:_'«rll-:--ﬂ.néuw KE | Cradiy
Target saiecean

Targeils) Ainsd fle

Prtim 8 D85 fone kanafer

5assion [Taegets

Arin o

St e 180

Savw tvpan Chote window

= |

* Figure 37-13: The ports that Nessus explored.

The icons to the left of the ports tell you what
Nessus found when connecting to those ports. A
yellow triangle with a ! in it indicates a port you
should be concerned about.

3. Highlight the port name, and the Security
Warning icon displays in the Severity frame, as
shown in Figure 37-14. Highlight the security
warning to view detailed information about the
scan results in the bottom frame of the window.

» Ared stop sign with a line through it indicates
a security hole.

» A triangle with an exclamation point indicates
a security warning.

» Alight bulb indicates a security note (just a
bit of trivia you might find interesting).

4. Highlight one of the ports with an icon next to
it to open the details in the Severity frame.

You may find that a given port sponsors more
than one level of offense.



5. In the Severity frame, highlight the security
level you want to explore to show the scan find-
ings in the frame below (see Figure 37-15).

BEIE

| | Severity o2

® nethios-sen (1awc |~ TR
A nethios-ns (137/udp) |

[ Nessus "NG” Report

Subnet * | | Port

microsofi-ds (445/tcp)
¢ Idap (383/cp)
h3z3hastcall (1720/cp)
' generalfudp
generaliicp
generalficmp
domain (S3/udp)
' hootps (B7/udp) I+

The following local accounts have passwords which never expi| |

Administratar
Guest

Password should have a limited lifetime
Saolutian : disable passward nan-expiry
Risk factar : Medium

The following local accounts have never logged in @

L _Guest
I [

| | Close window |

| Save report

* Figure 37-14: This port might cause a problem.

[ Nessus "NG” Report

Subnet * | | Port

~ | | Severity £
i OE [~ A\ Security Waming |
nethios-ns (137/udp) | | ¥ Securty Note

$  microsofi-ds (4454cp) | = Security Hole
) Idap (389/cp) |

h3z3hasteall (1720/4cp)

' generalfudp

generaltcp

generalficmp

domain (S3/udp)

) bootps.(67,/udp). |2

It was possible to log into the remote host using a MULL sessmm.
The concept of a NULL session is o provide a null username ar
a null password, which grants the user the 'guest' access

To prevent null sessions, see MS KB Article Q143474 (NT4.0) ||
Q246267 (Windows Z000).

Mote that this wan't completely disable null sessions, but wil
prevent them from connacting to IPCH

Please see hitpfmsgs securepoint.comicg-bin/getmessus-020¢

| All the smb tests will be done as ™ in domain WORKGROUP ZI
B3| I iB]|

| Save report. | |

Close window |

* Figure 37-15: This is a security hole.

The really good news is that Nessus doesn’t
leave you hanging; a solution is included in the
lower frame (see Figure 37-16).
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v [Nessus "NG" Report

‘ Sulnet v| | Fort

unknown {5900/tcp)
unknown (135/tcp)
) unknown {1026/tcp)
unk £ 4]
nethios-ssn (13914cp)
nethios-ng (137/udp)
microsofi-ds (445/cp)

/- Idap (389tep)
h3z3hastcall (17204cp) |
) generaliudy |

Distributed Computing Enviranment (DCE) services running on t)|
can be enumerated by connecting on port 135 and daing the ap

An attacker may use this fact {0 gain more knowledge
about the remote host

Solutian : fitter incoming traffic to this port
Rigk: Lows

Here is the list of DCE services running on this part

| UUID: 4290i720-a533-11d0-1003-0004ac32e603, version 1+
BE| Z I [+

| | Close window |

| Save report.

* Figure 37-16: A security note.

6. Click the Security Note icon in the Severity
frame to open a list of recommendations about
the port. Be sure to scroll down through the
report to see the recommendations — they’re
worth the time and effort.

7. Its not a bad idea to save your reports for later
use. Just click the Save Report button at the
bottom of the report to open the file selection
dialog. Specify a location to save the file in, and
click OK.

- ( a Save your reports for later comparisons, and
& you'll see new problems as they appear.

Keeping Your Plug-ins
Up-to-Date

Nessus uses plug-ins to keep its security checks up-
to-date. When a new security problem is discovered,
it’s likely that someone (either at www.nessus.org or
in the community of Nessus users) will write a plug-
in to handle the vulnerability and publish it for the
benefit of other Nessus users. You can update the
Nessus plug-ins on your system with one simple
command.
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To update the Nessus plug-ins, open a command line We've just scratched the surface of what you can do
and give yourself superuser privileges. Then type with the Nessus tool; its capabilities go far beyond
the following command and press Enter: the reach of this technique. If you're interested in
) . finding out more about Nessus, visit the Web site at
# /usr/local/sbin/nessus-update-plugins www.nessus.org and explore the online documenta-

tion. Also check out the man page: $ man nessus.
It's a good idea to update your plug-ins often.
Consider setting the update as part of a
nightly cron job. Set it up with Task Scheduler
as a nightly task, and you'll save time, and the
process will be automated.



Person-to-Person
Networking

Yethnigue  with IRC

Save Time By

v~ Networking online
with IRC

v~ Customizing your KSirc
workspace

You can use IRC channels to network with other Linux users online
to help solve problems and get the support you need to solve
open-source problems.

There’s computer networking, and then there’s human networking.

IRC stands for Internet Relay Chat. Yes, we’re talking about chat rooms —
but specifically the chat rooms targeted to open-source and Linux users.
Find the right channel though, and you can find quick access to a user or
developer who may be able to help solve a problem.

who use (and often write) the open-source projects that you use.
Sometimes, when the documentation fails you, going online for the
answers is the quickest way to find a solution for your problem.

z IRC networking can put you in touch with experts and amateurs
@l

In this technique, we introduce you to KSirc, which is one of the IRC tools
included with the KDE distribution. We also show you the way to some
productive, helpful chat rooms. Networking with the professionals online
can be a great timesaver in a pinch.

Finding the Answers You Seek
in a Linux Chat Room

We've tried to provide the quickest, most dependable ways we know to
implement system solutions to meet your needs. Unfortunately, system
configurations vary, and your needs sometimes extend beyond the bor-
ders of what would be considered typical. In those cases, looking through
online IRC channels for someone who’s encountered a similar situation
can help you find a quick solution to your problem.

Most standard Linux distributions come with several IRC clients, and lit-
erally dozens of IRC clients are out there. One friendly and usable client
is KSirc. KSirc is included in a standard installation of the KDE desktop
on both Fedora and SuSE Linux systems.
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To use KSirc with Mandrake, you'll first
need to install the kdenetwork-ksirc-
version.rpm package. It's included with the
distribution — see Technique 17 for informa-
tion about installing RPM packages.

Follow these steps to use the KSirc IRC client:
1. On Fedora, open the Main Menu and choose

Internet~>More Internet Applications=>KSirc.

On SuSE or Mandrake, open the Main Menu and
choose InternetoChat=>Ksirc.

The KSirc Server Control dialog opens, as shown
in Figure 38-1.

I Server Control - KSirc

File Connections Settings Help

Active server connections:

. =

* Figure 38-1: The KSirc Server Control dialog.

With no connections, the server control is kind
of a sad and worthless place. Establishing some
connections is the first step to finding other
Linux users.

2. Choose Connections->New Server from the
menu bar.

The Connect to Server dialog opens, as shown in
Figure 38-2.

3. Use the arrow to the right of the Group field to
open a drop-down list box of available servers.
Scroll down and choose Freenode from the list.
Then click the Connect button.

The KSirc connection window opens display-
ing information about the connection (see
Figure 38-3).
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Cnnnecllnserverm

Group: Server/Quick connect to: Eort:
Recent 'H '||5567 "
Server Description Server Access
Recent Server Password
O
‘ ‘ | ‘Connect | ‘ Cancel

* Figure 38-2: The Connect to Server dialog.

- -0%
Channel Edit Users Help

[07.58:40] O Welcome to ssbice version 2,211 type fhelp for help =8
{(07:58:50] O Loading fiter parser...

{[07-56:50] O Filter Passer Loaded

[[07:56:50] O
[07.58:50] @
(o755 50] @ Con |

o7 58'52] O Locking up your hostname
[07-58:53] O Checking ident

1107.58.:53] @ Found your hostname
[07:58:53] O No identd {auth) response
[[07.:56:53] @ Welcome to the freenode IRC Network susan

[07-56:53] O Your host s saberhagen.{reenode. net{rigel. tick-17.Info/5667], running version dancer-rcd-1.0.35
j[07:58:53] O Your host is saberhagen.{reencde.netlrigel.trick-17.Infore667], running version dancer-rcd-1.0.35
[07:55:53] @ This server was cobbled together Sun Feb 15 031853 UTC 2004

{07 5853] O saberhagen,freenode. et dancer-ired-1,0.35

A bBe CUDeEIFCHHIKKIL opPOrR=SIL ¥Y2Z0123455'® b qutv

[[07:58.53] O MODES=4 CHANLIMIT=#:20 NICKLEN=16 USERLEN=10 HOSTLEN=63 TOPICLEN=450 KICKLEN=450
FCHANNELLEN=10 KEYLEN=23 CHANTYPES=# PREFIX={ovh@+ CASEMAPPING=ascll CAPAR IRCD=dancer are
favallable on this server

[07:58:53] O There are 7612 victims and 7957 hiding on 31 servers

[07-5553] O 34 flagged etaff members

[0 5a53] O 521 chanmels fomed

{[07.58:53] O | have 1854 i O servers

[07.58:53] O Current local 1854 Max: 2446

Lag 0.92

Ino_channel | _I

* Figure 38-3: The KSirc connection window.

4., Choose Channel~>New from the menu bar.
In the unlabeled field near the bottom of the
KSirc window, enter the following command:

/1ist

The list of currently active channels begins to
scroll by. Literally hundreds of channels are open
at any given time, so the list can take a minute or
two to load (see Figure 38-4).

Use the scroll bar to view the entire list. The list-
ing shows the current time, the #fname of the
channel, the number of users currently in atten-
dance, and a note about the channel’s subject
matter.

4. To join the active channel discussing Fedora,
enter the following command:

/join {fFedora
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[Try #wineha, Scrossover of Swinex

[06:02:24] O svideclan 60 hnp: Yo _4/) de bim | scheduled SVN server
Imaimenance on Thu, Apr 15 19:00 CEST 2004 (17:00 GMT) - expect up to 1hr downtime

[06:02:24] O mucsonvsbiz 4 hip:/fwww, the omimleases.ohp - Ca a un PIV 3Ghz, et une magvalse connection
fintemet....HA HA HAIL

{[0m:02:24] @ rdevice-mappes 12 device-mapper i 3 low-level volime manager in linu 2.6

(08 02:24] @ FpismSd-devel 7 next step | WPA suppiort

[08:02;24] O fdeblan.it 8 Benvenuti su debian.i | Parda Ralano cometta, senza storplature, I you can’t speak Palian,
::wdl English || 1) leggi la documentazione 2) non chiedere i chiedere. Chiedl solamente. 3} Non ripetere le domande.
chi 2 nel canale 1 aiutera’ se, & non appena, patra’. || This is a discussion channel; if you have a question about Deblan
FGNU/Linux
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* Figure 38-4: The currently open channels.

The Fedora channel is displayed, as shown in
Figure 38-5.

hod Flidora (+incH) susan (1 T: READ THIS BEFORE ASKING ANY OUES T1ONS hittp:
Channel Edit Users Help

READ THIS BEFORE ASKING ANY QUESTIONS hitp:/timyurl comjanel | FC2 tes12 released :
bt froment.dulsg.duke.edw | Home: hetp:/fedora.redhat.comy FACQ: hrep:wew.fedoratag.ong/ '[
Extras: it www.fedora. us wiki/FedoraHOWTO DVD: hitp:jitoment. dulug.duke. edu/

itinyurl.comianel | FCE e g=lE

NewsHOWTOs Tutorals: hitp:fedorantws. cig | Fedora Cone 1 (Yamow)
: TS W T 00

ORI 4] O ST TWATT 53 1 - T
l[os 0357 # (~LIneS5213-136-16-04 ads!,bet_nl) has joined channel fedora {=} | #0 Chansery =
[08 04, 08] it “aplge install libwml2 7 g

[[08.04:13] swistn maybe an old version? — Wi
|os:04:19] # (~Kpran @ pcp7BOBINRC S, ONSCMOL. v comeast.net) has joined channel Fa—

{stedoca I

[[06:04:22] ~wt | downboadesd iboml2-2.6.6-3.1366.rpm and wy w install: package sl
Plibumi2-2.6.6-3 Is already Installed —

06 04: 25] camnami just 3 nD0b's thought | +a Active-Force

[[08 04 56] i if 2.6.6-3 15 the newest version then dont ask me -

08 05:33] 2 {~osvida® 147.33.97.240) has foined channel ffedora i

[[08.05,55] bt wiosd i1's possibde the error you described s just something trying to N

laccess the CD drive., | think, | dont know encugh about that stuff 1o 1ell you. -
[08:06:02] s 15 there some additional package for pestgresgl that has ‘the rest* of ama

[the deviopment headers? The -devel package orly has a subset of them for some reasce. -

[06-06:04] st ok I

08 06:04] & Signaf {Chent Couet) p—

{[08.05:10] s anyhady aroung here with knowledge about iptables and bandwith thiotting |~
[08:06;15] st would Tspcl v’ show me what device that 157

[[06:05:19] s oh, it méght be this... =
i x|

sledora | N

* Figure 38-5: The current activity on the Fedora IRC
channel.

) To join any of the channels displayed in the list
3 («@ of open channels, enter the command /join
jfchannelname. If you're interested in SuSE or
Mandrake specific channels, skip ahead to the
sections titled “Looking for Answers in the
SuSE Chat Room” or “Finding Fellow Mandrake
Users in the Mandrake Chat Room.”
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Chatting in the Fedora
Chat Room

You're almost ready to start chatting. Before joining
the Fedora conversation, you should read the eti-
quette directives at tinyurl.com/anel. It’s also a
good idea to lurk for a while to check out the flavor
of the conversation before jumping in with your
questions and/or answers.

Hackers can be brutal if provoked. Be polite in
IRC channels and observe etiquette, even if
you're chatting with someone who goes by
the nickname of pigfilth.

When you're ready to ask a question (or respond to
one), follow these steps:

1. Type into the unlabeled field (near the bottom
of the window) and press Enter when you’re
finished.

Your question appears in the scrolling region,
prefixed with your nickname.

Some IRC servers require you to register before
you can talk (but you can usually listen without
registering). If you run into such a server, follow
the directions that it sends your way.

You can monitor multiple channels at one
time. As you open each channel, a new tab
control is added to the bottom of the KSirc
window (see Figure 38-6).

2. When you’re done participating in a discus-
sion, you can leave a channel by opening the
Channel menu and choosing Close.

The tab control closes, leaving your remaining
channels intact. If you have only one channel
running, KSirc closes.
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bitpjroment. dulug. duke.edw | Home: herp:/fedorredhat.comy FAG: hrtp: ffwew fedorafag.org/ I o
Extras: hitp:/www.fedora. us wiki/FedoraHOWTO DVD: hitp:ioment. dulug duke. edu/
News/HOWTOs Tutorals: hitp(fedoranews. org | Fedora Coe 1 (Y amow)
e e e e e
[ p——— L&} |+0 ChanSen L
[08:06:04] # Signadt {Cliert Q) —
[08.06:10] e amybesdy aroung hene with knowledge about iptables and bandwith thiotting s I
[06:06; 15] st would Tspel -v' show me what device that 57 -
[06:06:16] st oh, it might be this.... g
[06:06:36] “wsises when | installed linu | had a floppy drive installed, bus | laser removed it s
and disabled It In beos i
[0 06:52] e na floppy deive? +a Active-Force
[08:0703] «mmmeme thar's a e silly. but.. 1 dunno. -
[[08:07.09] W e can you view the contents of the cd In the file manager? -
{[08.07:13] # Kill_and_sat_me (Kill_and_e@host217-43-21-135, range21 743, bicentralpliss, com) O
fhas joined channel #fedora -
[[06:07:17] st heh, no room, | had 1o stick it out the side of my case a—
[08:07: 36] « S With the ‘medium efmor’, it sounds like i's a drive that's there, with no -
ek in it panr-
[og07:37] & has left channel medor -
(08 07:45] i But I'm not sure. m - LI
[08:08:42] it erd_request: /O error, dev 02:00 (fiop.,.. < floplpy)?
[[05-05:47] swiamss heh, | dunno =l |
<] ] 2] - : =
Lag 171
wledora | meolinux | Emysgl _l

« Figure 38-6: You can monitor multiple channels at one
time.

Looking for Answers in the
SuSE Chat Room

If SuSE Linux is more your style, you'll find lots of
help on the Freenode IRC server. Join the SuSE chat-
room by entering the command /join #suse in the
unlabeled field at the bottom of the KSirc window.
The SuSE channel opens, displaying the current con-
versation in the large window on the left, with the
active participants in the panel on the right.

After lurking for a while, you may want to join the
conversation. Just enter your comments or inquiries
in the field at the bottom of the screen and press
Enter. In a flash, you're participating in the chat.

When you’re ready to leave the chat room, just
choose Channel=>Close. That’s all there is to it!

Finding Fellow Mandrake Users
in the Mandrake Chat Room

You should check out the rules of conversation for the
Mandrake chat room at http://mandrake.brain.org
before joining the conversation in the Mandrake

Technique 38: Person-to-Person Networking with IRC

chat room on the Freenode IRC server. When you are
comfortable with the rules of conduct, just enter
/join fmandrake in the KSirc chat field and press
Enter. The screen promptly presents the current
conversation in the Mandrake chat room and the list
of users currently in attendance.

When you're finished chatting, just choose Channel=
Close.

Customizing KSirc — Who
Do You Want to Be Today?

You can customize your KSirc environment to suit
your tastes and work habits in a flash with the KSirc
Configuration dialog.

To customize KSirc, start a KSirc session and choose
Settings=>Configure KSirc. The Configure KSirc dialog
opens, as shown in Figure 38-7.

hd Configure KSirc [=1E3

General KSirc Settings

&

-~ Window Mode
Choose your favorite window mode:

v
g
2
1=

=

) SDI mode (old behavior)

Os
(@ Paged MDI mode (XChat)

&

Colors L
ﬁ}ﬂ - Misc
Fonts Auto create window Beep on notify

Nick completion Color picker popup

Display topic in caption Auto-rejoin

Time stamp History length: |200lines :
Announce away messages
Tonit
pap!
@ Eoll [so

* Figure 38-7: The Configure KSirc dialog.
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uration menus:

v General: Use the General menu to set options

P

that affect the general look and feel of the ses-
sion, from the session information included in
the display to the wallpaper.

Startup: Use the Startup menu to create a nick-
name (or an alternative nickname if Funkmaster
is already logged in).

v Colors: Use the Colors menu to set your color
preferences for your IRC session.

v Fonts: Use the Fonts menu to set the font type
and size for your IRC session.

After you've set your preferences, click OK to save
your changes and close the Configure KSirc dialog.
The next time you start a KSirc session, your prefer-
ences are in place!
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Save Time By

v~ Using the tools in procps
to control processes at
the command line

v Using ps, pstree, and
pgrep to retrieve process
details

v~ Killing off unwanted
processes at the
command line

1~ Setting program priorities
atthe command line with
REnice

Controlling
Troublesome
Processes at the
Command Line

tem, hogging resources, slowing down the network, and refusing to

die. Controlling the troublemakers is a snap, thanks to Linux. With
Linux, you have some great command line tools, all bundled up in one lit-
tle RPM package called procps (pronounced “proc ps”).

E very now and then a troublesome process gets loose on your sys-

ps, pstree, and pgrep are the stud finders in the toolbox that help you
find the troublemaking processes. With ps, pstree, and pgrep, you can
identify the process, the user, and the terminal being used. You can also
get a good idea of what system resources the process is using to decide if
the process should be terminated.

ki1l, ki11a11, and xki11 are the hammers in the toolbox. How big of

a hammer you need depends on the scope of the process or processes
you're trying to stop, and the precision you need to kill them off. Choose
from the three commands to remove any unwanted processes that
you've identified.

You can use the renice command to level the playing field by assigning the
troublemaking process a nice value. The processes with lower nice values
have to surrender system resources to processes with higher priorities.

In this technique, we introduce you to some handy command line tools
that make process management a breeze. With these tools in your tool-
box, you can build a better system fast, even if you don’t have a graphi-
cal environment to help you along the way.

Processing Processes with procps

The tools packaged in the procps RPM package are a handy but diverse
bunch. They can retrieve information about processes or users, kill off
unwanted processes, and watch the activities on your system. procps is
an all-purpose toolkit designed to provide power at the command line to
make process management quick and easy.
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7 Getting familiar with procps is a good invest-
- { @) ment of time. After you know the tools, you'll
) turn to them again and again.

The procps package contains several tools that you
can use to monitor and control processes:
¥ Dps
sysctl
free
pgrep
pkill

top

W W W W WA

w

¥ watch

Chances are, procps is already installed on your sys-
tem. If not, you can find the RPM package on the
Linux distribution discs.

On Fedora or Mandrake, open a terminal window,
and with superuser privileges, mount the disc and
install the package with the following command:

# rpm -Uhv procps-version.rpm

If you're a SuSE user, open a terminal window, and
with superuser privileges, mount the disc and install
the RPM package with the command:

# rpm -Uhv ps-version.rpm

See Technique 17 for more information about
installing software with rpm.

Keeping Track of Process Status
with ps, pstree, and pgrep

Before you can control a troublesome process on
your system, it helps to have good, solid information
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about that process. Knowing the identity of the user,
the process ID, and the terminal that is controlling
the process is valuable when you need to track
down a process and its origins. Statistical informa-
tion about the process (such as memory usage and
CPU time) is also helpful when you need to catch
troublemaking programs that might be causing per-
formance problems. procps provides several good
tools that can help you get that information in the
form that helps you most.

Using ps to filter process status information

Most Linux users have at least a passing familiarity
with the ps command. ps stands for process status,
and it displays just that: the status of a process.

If you just type ps without any extra arguments or
options, you see a quick synopsis of the programs
running within your terminal window:

PID TTY TIME CMD
10181 pts/7 00:00:00 bash
10521 pts/7 00:00:00 ps

This information is organized in four columns:

v PID: The first column shows the process ID,
which is a unique number assigned to each
process when it starts running.

v TTY: The second column displays your tty
device name. In this example, pts/7 means that
you're logged into pseudo-terminal number 7.
(When you open a new terminal window, you cre-
ate a new pseudo-terminal.)

v TIME: The third column shows the amount of
CPU time used by each process.

v (CMD: The last column shows the name of the pro-
gram running within each process.

Note that you don’t have to live with the default
columns. You can change the way the output looks.
See “Viewing ps output the way you want to see it”
later in this technique.
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That's an oversimplification because many fla-
vors of UNIX have existed (HP/UX, AIX, BSD,
Digital UNIX, SCO UNIX, and so on). Linux
uses the standard GNU version of ps. As a
result, the ps command supports a wide vari-
ety of command line options. Save yourself
some time and learn the portable (that is, long-
format) command line options. For example,
use ps --pid 1 instead of the equivalent ps
-p 1. The long-form options require a bit more
typing, but they're much easier to remember.

z The ps command was inherited from UNIX.
<

&

If you want to see all the processes running on your
system, add -A to the end of the command line, like
this:

$ ps -A
PID TTY TIME CMD
17 00:00:04 init
2 ? 00:00:00 keventd
37 00:00:00 kapmd
4 7 00:00:00 ksoftirqgd/0
6 ? 00:00:00 bdflush
5039 ttyl 00:00:00 mingetty
5040 ttye 00:00:00 mingetty

Notice that the TTY column displays a ? for many
processes. Those processes are noninteractive, and
they’re generally server-type processes like Apache,
xinetd, or MySQL. To see only the interactive
processes (processes associated with a terminal or
terminal window), use -a instead of -A.

You can also choose processes based on the process
characteristics shown in Table 39-1.

TaBLE 39-1: PS PROCESS SELECTION OPTIONS

Option Description
-C command Displays processes running command
-G group Displays processes that have the

--group group effective group ID group (group
can be a group name or a numeric

group ID)
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Option Description

-U user Displays processes that have the

--user user effective user ID user (user can be a
user name or a numeric user ID)

-g group Displays processes that have the

--Group group real group ID group (group can be a

group name or a numeric group ID)

-u user
--User user

Displays processes that have the
real user ID user (user can be a
user name or a numeric user ID)

-p process-ID
--pid process-ID

Displays processes that have the
process ID process-1D

-t tty-name
--tty tty-name

Displays processes running at
terminal tty-name

If you list more than one process selector, ps dis-
plays all processes that meet any of the constraints.
For example, to see all processes with an effective or
real user ID of freddie, use the following command:

$ ps --user freddie --User freddie

If you want to select multiple processes based on
the same characteristic (but different values), just
list each value, separating the values with commas.
These two commands are equivalent:

$ ps -C bash -C zsh
$ ps -C bash,zsh

Viewing ps output the way you want to see it

You can also change the columns listed by the ps
command. To specify an output format, use the fol-
lowing option:

-0 columnl,column]. ..
ps lets you choose an output format from 126 differ-

ent columns! Some of the more useful columns are
shown in Table 39-2.
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TaBLE 39-2: pS COLUMN SPECIFIERS

Column Name Description

%Cpu Percentage of CPU time used by process

%mem Percentage of memory used by process

Comm Command name

Args Command line arguments

Command Command name plus command line
argument

egroup Effective group name

egid Effective group ID (numeric)

rgroup Real group name

rgid Real group ID (numeric)

euser Effective user name

euid Effective user ID (numeric)

ruser Real user name

ruid Real user ID (numeric)

Pid Process ID

Stat Process state (running, sleeping, waiting
for I/O, and so on)

Cputime Cumulative CPU time

Tty Terminal name

Don’t worry about memorizing the list of column
specifiers; use the command ps L (that’s L, not -L)
to display the complete list.

Normally, ps displays process information in process
ID order. You can choose your own ordering with
--sort column. For example, to list processes in
increasing order by command name, use the follow-
ing command:

$ ps --sort cmd

You can use any of the column specifiers displayed
by ps L. If you want to sort first by command name
and then by process ID, use this command:

$ ps --sort cmd,pid
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If you put a minus sign in front of a sort specifier, you
reverse the ordering. For example, the command

$ ps --sort cmd,-pid

sorts processes first by command name (in ascend-
ing, or A-Z, order) and then by process ID in
descending (999999-1) order.

ps comes preloaded with a few predefined output
formats that display the information you’re most
likely to need. The default output format shows the
process ID, tty, CPU time, and user name. The -1 (or
long) format displays a ton of information about the
state of the process (priority, state, process size, and
so on). The u option (note: u, not -u) displays user-
oriented information (percentage of CPU time, per-
centage of available memory, and such).

that you frequently use a few output options
in combination. Use the alias command (part
of the bash shell) to create new commands
that correspond to the options that you prefer.
For example, to create a new command
named psu that displays user-oriented process
information, use the following command:

? If you experiment with ps, you'll probably find
<&l

$ alias psu="ps -o
pid,euser,ruser,%cpu,smem,command"”

Now, when you type the command psu, you
see only the columns that you're interested in.

Of course, you can specify other options when you
run the psu command:

$ psu -C bash

PID EUSER RUSER %CPU %ZMEM COMMAND

9318 freddie freddie 0.0 0.3 bash
9380 franklin franklin 0.0 0.2 bash
9428 root root 0.0 0.2 bash

] See Technique 10 to find out how to save bash
&- { <@ aliases so they're available every time you
&

log in.
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Making parent-child relationships
stand out in a ps listing

When you’re looking at a long ps listing, it’s difficult
to discern the parent-child relationships among
processes. ps has two command line options that
make that relationship a little easier to see.

The -H option indents child processes; each gen-
eration is indented a bit more than the previous
generation:

$ ps -AH
PID TTY TIME CMD

17 00:00:04 init
4993 7 00:00:00 atd
4647 7 00:00:00 crond
5022 ? 00:00:00 dbus-daemon-1
4240 7 00:00:00 dhclient
5045 ? 00:00:00 gdm-binary
5175 ? 00:00:00 gdm-binary
5176 ? 00:07:43 X
5197 ? 00:00:00 startkde
5323 ? 00:00:00 kwrapper
5256 ? 00:00:00 ssh-agent

You can see from this example that the init process
(process ID 1) is that ancestor of all the other
processes. Process 5175 is the parent of two children
(5176 and 5197) and the grandparent of process 5323
and process 5256.

To see a slightly fancier display, use the --forest
option instead of -H:

$ ps -AH --forest

PID TTY TIME CMD
17 00:00:04 init

4993 ? 00:00:00 atd
4647 7 00:00:00 crond
5022 ? 00:00:00 dbus-daemon-1
4240 ? 00:00:00 dhclient
5045 ? 00:00:00 gdm-binary
5175 7 00:00:00 \_ gdm-binary
5176 ? 00:07:48 \_ X
5197 72 00:00:00 \_ startkde
5256 7 00:00:00 \_ ssh-agent
5323 ? 00:00:00 \_ kwrapper
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Personally, we find the --forest option a tad
confusing; we prefer the pstree command
instead. See the next section for details on
pstree.

Climbing the family tree with pstree

pstree is similar to the ps command, but it has far
fewer options. When you run pstree, you see a graph
of processes running on your system, similar to that
shown in Figure 39-1.

[dsusan@localhost/homefsusan - Shell -Konsole

Session Edit View Bookmarks Settings Help

ElE

[root@localhost susan]# pstree
init——apnd

f—bdflush
j—cardmgr
f—crond
f—cupsd
f—dhclient
f—gconfd-2
—gdn-binary—gdn-binary—X
L—startkde——kwrapper
L-ssh-agent
—Epm
|-httpd—=a* [httpd]
|—kapmd
|-kdeinit——artsd
{—autorun

|—eggcups

2% [kdeinit]

|—kdeinit— bash—su—bash— pstree
|—ksnapshot
|-pam-panel-icon—pam_timestamp_c
L-rhn-applet-gui

|
|
|
|
}
[-10%[kdeinit]

* Figure 39-1: Output from the pstree command.

You can see that pstree makes the process tree easy
to see. By default, pstree compresses the process
tree by removing duplicate branches from the dis-
play. You can see all the processes running on your
system by including the -c, -a, or -p option:

v -c simply disables compression.

v -atells pstree to display the command line argu-
ments for each process, as shown in Figure 39-2.

v -pforces pstree to add process IDs to the graph,
as shown in Figure 39-3.

[/ You can use the -p and -a options in the same
report. The command $ pstree -pa includes
in the output the command line arguments for

the process as well as the process ID.

%
o

&



278

Technique 39: Controlling Troublesome Processes at the Command Line

j—gdm-binary -nodaemon

f—gpm -m /dev/mouse -t imps2 [=|
f-httpd D

R4 susan@localhost:/home/susan - Shell - Konsole BEE R susan@localhost:/home/susan - Shell - Konsole BEE
Session Edit View Boockmarks Settings Help Session Edit View Bookmarks Settings Help
ElE EiE]
[root@localhost susan]# pstree -a [+] [root@localhost susan]# pstree -h [«]
init | init——apmd |
f-apmd -p 10 -w 5 -W -P /etec/sysconfig/apm-scripts/apmscript f-atd
f—atd [—bdflush
—(bdflush) |—cardngr
I-cardmgr I-crond
Icrond Icupsd
f—cupsd f—dhelient
f—dhclient -1 -q -1f /var/lib/dhcp/dhclient-eth0.leases —pf /var/run/dhclien f—geonfd-2
j—geonfd-2 14 f—gdm-binary—gdm-binary—X

Lgdm-binary -nodaemon
I-X :0 -audit 0 -auth /var/gdm/:0.Xauth vt7
L-startkde /usr/bin/startkde
|—kwrapper ksmserver
L-ssh-agent startkde

|-httpd
f-httpd
|-httpd
|-httpd
[-httpd
{—httpd [=]

L-startkde——kwrapper
L-ssh-agent
F-gpm
|-httpd—=8*[httpd]
p—kapmd
f—kdeinit—artsd
|-autorun
{—eggcups
|37 [kdeinit]
|-kdeinit—bash—su—bash—pstree
{—ksnapshot
| {—pam-panel-icon—pamn_timestanp_c
| Lrhn-applet-gui
|-10% [kdeinit]

o &=

¢ Figure 39-2: pstree -a displays command line

7V susan@ localhost:/home/susan - Shell - Kunﬂ’leiu =] ‘ x

Session Edit View Boockmarks Settings Help

EAE]

arguments.

[root@localhost susan]# pstree -p E
[init(1)——apnd(2026) |

f-atd(2415)
{—bdflush(6)
|—cardngr (2000)
|—crond(2318)
|—cupsd(2202)
{—dhelient(2179)
|-gconfd-2(4592)
I—gdn-binary(2460)—gdn-binary(4424)——X(4425)
Lstartkde(4454)——kwrapper(4572)
L-ssh-agent(4507)
f—gpm(2296)
-httpd(5182)—httpd(5185)
{—httpd(5186)
—httpd(5187)
f-httpd(5188)
|-httpd(5189)
|—httpd(5190)
|—httpd(5191) D
Lhttpd(5192)
|—kapmd(3)
|—kdeinit(4537)——artsd(4557)
{—autorun(4582) [=]

¢ Figure 39-3: pstree -p displays process IDs.

pstree has a few more options that you might find
useful:

’/

-h highlights your current process and all ances-
tors (see Figure 39-4), making it easy to find your-
self in a complex listing.

-u shows the user name associated with each
process. (Actually, -u displays the user name
only when it changes from parent to child.)

¢ Figure 39-4: pstree highlight mode.

If you want to see the descendents of a specific
process, include the process ID at the end of the
command, like this:

$ pstree 5296

To see the processes for a particular user, include
the user name at the end of the command line:

$ pstree freddie

Finding processes with pgrep

ps and pstree are useful tools when you want to see
the big picture, but it can be tough to find the process
you're looking for in a long list. That’s where pgrep
comes in. pgrep lets you search for specific processes
based on a number of process characteristics.

To search for processes running a particular program,
run pgrep pattern. For example, here’s how to search
for all processes running mozilla:

$ pgrep mozilla
5385
5391
5393
5395
5400
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Hmmm . . . that output is a bit terse. Use the -1
option to display the program name as well as the
process ID:

$ pgrep -1 mozilla
5385 run-mozilla.sh
5391 mozilla-bin
5393 mozilla-bin
5395 mozilla-bin
5400 mozilla-bin

pgrep matches program names based on regular
expressions (that is, wildcards), so it displays
processes whose names include mozi11a. For a com-
plete rundown on the regular expression syntax
understood by psgrep, see the man page for regex
(info regex). If you want an exact match (not a regu-
lar expression match), use the -x option. By default,
pgrep matches the pattern that you provide against
the program name for each process. To match the
pattern anywhere in the command line (not just in
the program name), include -f on the command line:

$ pgrep -f1 mozilla

5385 /usr/ local/mozilla/run-mozilla.sh
5391 /usr/local/mozilla/mozilla-bin
5393 /usr/local/mozilla/mozilla-bin
5395 /usr/local/mozilla/mozilla-bin
5400 /usr/local/mozilla/mozilla-bin
9388 more run-mozilla.sh

Notice process 9388: The program running there
is more, but because the command line arguments
include mozil1a, pgrep displays it.

pgrep can also find processes based on the criteria
shown in Table 39-3.

TaBLE 39-3: PGREP OPTIONS THAT Look FOR MATCHING DATA

Option Description

-P pid Selects processes whose parent is

process pid

-g process-group Selects processes belonging to

process group process-group
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Option Description

-s session-1ID Selects processes belonging to the

login session session-1D

-u user Selects processes whose effective
user IDs match user (user can be a

user name or a numeric user ID)

-U user Selects processes whose real user
IDs match user (user can be a user

name or a numeric user ID)

-G group Selects processes whose effective
groups match group (group can be

a group name or a numeric group ID)

-T terminal Selects processes associated with

terminal (or pty) terminal

In addition to the matching options described in
Table 39-3, you can negate the criteria with the -v
option. For example, to find all the processes not
owned by user root, use this command:

$ pgrep -U root -v

You can also tell pgrep to display only the most
recent process that matches your criteria. To do so,
just include -n on the command line like this:

$ pgrep -n xmms

That’s handy if you want to find the most recently
invoked copy of a program.

As explained earlier, pgrep displays a list of process
IDs by default, but you may want to see more infor-
mation. To help pgrep overcome its minimalism, you
feed the output from pgrep (the list of processes that
match your criteria) into another program that knows
how to use a process ID. For example, here’s how to
see detailed information about all the processes
owned by user freddie or by user franklin:

$ ps -1 --pid $(pgrep -U freddie,franklin)

The bash shell first executes the command inside
the parentheses and then builds a new command
that incorporates the output from pgrep. That might
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sound confusing if you’re not familiar with the bash
command substitution feature, so it may help to
break the command down a bit. Assume that the
pgrep command returns three process IDs:

$ pgrep -U freddie,franklin
5523
7879
8256

bash substitutes the output from pgrep into the ps
command like this:

$ ps -1 --pid 5523 7879 8256

You can feed the output from pgrep into any program
that expects a list of process IDs, such as ki11. To kill
all processes owned by user freddie, you can com-
bine pgrep and ki17 like this:

$ kill $(pgrep -U freddie)

Killing Processes with pkill

An easy way to Kkill off unwanted processes is pkill.
pkil1 is nearly identical to pgrep (in fact, you can
select processes using the same criteria in Table 39-3,
which you can find earlier in this technique) except
that pki11 kills the matching processes instead of
displaying matching process IDs. To kill all processes
owned by user freddie, use the following command:

$ pkill -U freddie

pkill (and its cousin, ki11) work by sending a signal
to the targeted process. By default, pkil1 sends the
SIGTERM signal to suggest that the target process ter-
minate itself. If you find a program that’s not willing
to honor SIGTERM, you can be more forceful by
using the -SIGKILL option:

$ pkill -SIGKILL -U freddie

You can send any signal with pki11. For a complete
list of signals (and their meanings), see man 7 signal.
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Killing Processes with killall

pkill is a bit aggressive, and if you're not
careful, it can kill processes that you don't
intend to harm. If you want to kill a collection

of processes, exercise some caution and use
ki1lall instead.

killall isn’t as flexible as pki11 when it comes to
selecting processes, but it has one very nice feature:
interactive mode. ki11a11 selects processes based
on program name. When you run ki11al1, use the
--interactive option (or -i for short) to tell ki11a11
to prompt you before it kills each process:

$ pgrep -1f more

10512 more mozilla/run-mozilla.sh
10513 more /etc/passwd

$ killall --interactive more

Ki11l more(10512) ? (y/n) y

Kill more(10513) ? (y/n) n

Like pki11, ki11a11 sends SIGTERM by default. If
you want to send a different signal, use the --signal
signal-name option:

$ killall -i --signal SIGKILL more
Ki11l more(10512) ? (y/n) y
Ki1l more(10513) ? (y/n) n

Closing Windows with xkill

Once in a while, a window appears on your desktop,
and you just don’t know where it came from. It might
be a pop-up ad from a piece of spyware, an annoying
message from a program running in the background,
or just a program that forgot to identify itself. If you
don’t know the name of the program that created the
window, you can’t kill it with ki17, pki11, or killall.
You need xki11, which kills off a program when you
click the program’s window. To see xki11 in action:



1. Start up a copy of xmms and tell it to play a
media stream (see www.shoutcast.com if you’re
looking for some good music).

2. Now, open a terminal window and run the fol-
lowing command:

$ xkill
Select the window whose client you wish
to kill with button 1....

Notice that the mouse cursor has changed from
its familiar arrow to something that looks like a
target sight in an F-16.

3. Click anywhere on the xmms window, and the
media player is killed.

Be careful with xki11 — you can easily kill off the
wrong program with a single click. xki11 will kill just
about any window that you click — even the KDE (or
GNOME) taskbar!

Make sure that the window you want to kill is

visible. You can’t move to a different desktop
by clicking the pager (the multiple-desktop
control down on your taskbar) because you’ll
kill the pager instead.

If you change your mind after you start xkil1,
just right-click anywhere on the screen, and
xki171 will end without doing any damage.

xki11 isn’t foolproof. It can’t kill every program, but
we've yet to find one that it can’t handle. Of course,
you need the right privileges to use xki11. You can
kill off processes that you own, but you can’t kill
processes owned by other users.

] If you need to kill a process owned by another
3 (@ user, give yourself superuser privileges (with

& su) before you run xki11.
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Getting Your Processes’ Priorities Straight

Getting Your Processes’
Priorities Straight

Linux uses a relatively simple scheme for divvying
up available CPU time. CPU time is divided into
short segments, and each period is called a quantum.
As each quantum expires, the kernel chooses a new
process to run from the list of processes with the
highest priorities. Each process is assigned a prior-
ity that can change over time. The base priority
assigned to a process is known as its nice value.

The name is a little strange and so is the numbering
scheme. Nice values range from +20 (lowest priority)
to —20 (highest priority), and most processes start
with a nice value of 0. Think of it this way: A program
with a high nice value is being nice to other processes
by giving up the CPU when someone else needs it.

To view the nice value of an existing process, use
this command:

$ ps -1 process-id

You can lower the priority (that is, increase the nice
value) of your own processes by using the renice
command. For example, here’s how to lower the pri-
ority of your bash shell:

$ renice +10 $$%
6297: old priority 0, new priority 10

(The $$ shell variable contains the process ID of
your shell.)

If you have superuser privileges, you can increase or
decrease the nice value of any process. You can iden-
tify processes by process ID (-p pid), process group
(-9 process-group), or user name (-u user).
@ You can also use KDE System Guard to
- («ﬂ renice programs in a graphical environment.
& Check out Technique 41 for help using KDE
System Guard.
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Technique

Save Time By

+* Using the Fedora/
Mandrake user manager
to add users and groups

+~ Forcing users to update
passwords

+* Changing passwords with
a few clicks

v~ Organizing your users
into groups

v~ Using filters to find users
fast

that you need at least two user accounts: you and your alter ego —

the superuser. Your wild side (the superuser) is there when you
need it to customize configuration files, install software, and remove old
files. Your more sensible identity is for moving with speed and agility,
without the danger of accidentally wiping out the contents of your online
world with a typing error.

Even if you're the only user on your system, you likely already know

If you manage a system with multiple users, or you manage a network,
you've likely set up each user with his or her own identity so you don’t
have roots running around willy-nilly changing passwords and unin-
stalling packages.

Whether you manage two user accounts or 200, the graphical user man-
ager that comes with your distribution is the timesaving way to manage
them. This tool simplifies account-related tasks, letting you avoid com-
mand line interaction. You don’t have to remember any commands; just
point and click to create and manage users and their information. The
process of adding new users and modifying existing ones is fast.

Using groups to organize file privileges can save you a ton of time. The
graphical user manager makes it easy to create and populate groups with
its handy checklist. Fedora Linux and Mandrake Linux (currently) use the
same user manager tool. As we describe the Fedora user manager, just
remember that everything that we tell you applies to the Mandrake user
manager as well.

In this technique, we introduce you to the advantages of your distribu-
tion’s user manager. You'll save time (and a lot of typing) by using this
simple tool to keep your user accounts and groups up-to-date. Every file
and program on a Linux computer is owned by a single user and a single
group. Every file (and program) also has a set of permissions that deter-
mine what the owner can do to the file, what members of the group can
do, and what everyone else can do.

To make the system a safer place, assign each user a unique user name
and password. When you create a separate account for each user, it has
the following effects:
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v Users can’t read each other’s e-mail or other
private documents.

v Users can’t alter each other’s files.

v User can’t lock others out of the system by
changing a shared password.

v Users have separate home directories to keep
their work in.

v Privileges for programs and data files can be
assigned to individuals.

This makes your work as a user administrator much
quicker and easier.

Managing Users and Groups
with the Fedora/Mandrake
User Manager

In this section, we give you a tour of the Fedora/
Mandrake user manager. If you're a SuSE user, skip
ahead to the section, “Managing Users and Groups
with the SuSE User Administrator.”

The user manager makes user and group manage-
ment a snap. With just a few clicks, you can set up
new users or temporary accounts, change pass-
words, and manage groups.

The user manager works from either the KDE
Desktop or the GNOME desktop. If you're running
Fedora Linux, you can start the user manager by
opening the main menu and choosing System
Settings=>Users and Groups. If you're running
Mandrake Linux, start the user manager by opening
the main menu and choosing System=>Configuration>
Other=>User Administration. In either case, enter the
superuser password if you are prompted to do so.

The user manager then opens, as shown in Figure 40-1.

The user manager gives you all the access you need
to add and modify groups and users. The easy-to-read
user lists and intuitive dialogs make it a quick tool to
get up and running with.
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FRed Hat User Manager

Eile Proferences  Help

B B B8 &

Add User  Add Group 1 Ll Help Befresh
Seaech filter Apply finer |
Users | Graxips
User Name |||m (-3 |P1|m.\l\l Growp |Full Name ]myn Shell |Hﬂmo Cirecrory
susan 500 susan douglas fhinjbash  fhome/sisan
franklin 501 franklin fraskdn dewey fanbash  jhame/franklin
frodde 502 frecddie funkmaster  fhinbash  homefedde

* Figure 40-1: The Fedora/Mandrake User Manager.

Adding new users

To add a user, follow these steps:
1. In the user manager, click the Add User icon on
the toolbar.

The Create New User dialog opens, as shown in
Figure 40-2.

Create New User

User Name: duncan

Full Name: Duncan Hubbard

Password: it

Confirm Password: ’-‘“’““1.

Login Shell: /binfbash

Create home directory
Home Directory: ;fhcmefduncan
Create a private group for the user

[] Specify user ID manually

»

uiD; | 500 [+

2ganceIH @ oK ‘

* Figure 40-2: The Create New User dialog.
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2. Fillin the fields in the dialog appropriately:

» User Name: This is the name that you'll see
next to the cursor when you log in to the shell
(so make sure it’s polite).

» Full Name: This name is for internal use. If
you're managing a large company, you may
need to distinguish between your Bobs or
Jennifers.

» Password and Confirm Password: Enter a
password and confirm the password in the
next field. The password has to be at least six
characters long, and it can be any combina-
tion of upper- and lowercase letters, numbers,
and characters.

» Login Shell: The option you choose from this
drop-down list determines which shell starts
when the user opens a terminal window. bash
is a good, friendly choice, but if the new user
is a real macho-type programmer, he or she
might want a more hearty shell like /bin/csh
(designed to be friendly to C programmers —
need we say more?).

» Create Home Directory: This defaults to
/home/username for the user, but you can
specify a different directory if you choose.

» Create a Private Group for the User: Check
this box if you want to create a new group.

» Specify User ID Manually: Check this box if
you want to choose the user ID rather than
allow the system to manage the numbers. We
don’t recommend that unless you have a
really good reason. Linux knows best.

Never create a user with a UID of 0. The user
manager won't let you do it, but you can do it
at the command line. User 0 is always root,

and any user with a UID of 0 is also root (and
has superuser privileges).

3. After you fill in the dialog, click OK to add the
new user.

You're finished!

Technique 40: Taking Care of New (And Old) Users

Modifying user accounts

Users come and go — that’s the nature of business.
If you're responsible for many user accounts, you’ll
need to change forgotten passwords and delete old
accounts. The user manager’s graphical interface
makes quick work of keeping up with the human
resources department.

If you need to delete a user, the process is simple:
Just select the user and click Delete on the toolbar.

When you click the Delete button, take note of

the Delete User's Home Directory option. Be
sure that nothing important is in that directory
before you click Yes.

To make changes to a user account, follow these
steps:

1. Double-click a user name in the user manager.

The User Properties dialog appears, as shown in
Figure 40-3. With the User Properties dialog, you
can change the user account with just a few
clicks.

User Properties

ata)| Account Info | Password Info | gmup5|

User Name: freddie
Full Name; funkmaster
Password: il

Confirm Password: | e

Jhome/freddie

,.'bin_fbash

‘IgancelH o oK ‘

Home Directory:

Login Shell:

¢ Figure 40-3: The User Properties dialog.

2. Adjust different settings on the four tabs, as
follows:
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» User Data: Use this tab to change the user’s
password, home directory, or login shell.

7 If a user forgets a password, this is the place to
- («a go. The old password is masked, but you can
& enter a new password for the user in seconds.

» Account Info: On this tab, check the Local
Password Is Locked box to lock the user out
of his or her account. Check the Enable
Account Expiration option if you want the
account to expire on a certain date, and then
enter the expiration date.

» Password Info: Use this tab to control
changes to a user’s password. You can specify
the number of days before a change is allowed,
or the number of days before a change is
required. You can also set up a warning date,
warning the user that his or her password is
about to expire, or specify the number of days
before the account will be rendered inactive.

g Expiring a password limits the amount of time

B («a that a hacker can use it. It also takes a fair
amount of horsepower to crack a password, so

if someone gets an encrypted version of your
password file, odds are that the password will
have changed by the time that the hacker
decrypts it. Good password management is a
real timesaver.

» Groups: Use this tab to specify the groups to
which a user belongs. You can also specify the
user’s primary group here.

3. When you've finished making changes, click
OK to save your work.

Adding groups

A group is a collection of users. Groups make it easy
to manage file permissions. If you have several users
that all need to access the same file, create a new
group with those users in it.

The user manager makes it a breeze to create and
modify groups. To add a group, follow these steps:
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1. Open the Main Menu and choose System
Settings=>Users and Groups.

2. Choose the Groups tab.

The currently defined groups are displayed, as
shown in Figure 40-4.

Fud Hat User Manager B ETEd |

Eile Proferences  Help

B B B8 &

Add User  Add Group 1 d Help Befresh

Seaech filter

Ugers | Gromps |

Group hame Jc.m.n 0 |G|r.up Mombers
susan 500 susan

franklin 501 Frankiin

frodde 502 frecdie

duncan 503 duncan

accountng 504 duncan, frasiklin

¢ Figure 40-4: The Fedora/Mandrake user manager
Groups tab.
3. Click the Add Group button on the toolbar.

The Create New Group dialog appears, as shown
in Figure 40-5.

Group Name: recwerﬂ

[[] specify group ID manually

GID: (500

of OK

R Cancel

¢ Figure 40-5: The Create New Group dialog.

4. Specify a name in the Group Name field.

5. If you need to specify a group number, you can
check the Specify Group ID Manually box, but
we recommend accepting the default and let-
ting Linux assign the group number to avoid
potential conflict.
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6. Click OK when you’re done.

The group is created. Now, you need to add the
members.

7. Back in the Groups tab of the user manager,
double-click the group in the list.

The Group Properties dialog appears, as shown
in Figure 40-6.

Group Users

Group Name: |recovery

P oK

38 cancel

¢ Figure 40-6: The Group Properties dialog.

8. To add users to your new group, choose the
Group Users tab.

9. Check the boxes next to the users that will be
members of the group.

710. Click OK when you’re finished.

The Groups tab in the user manager is updated
to reflect the new group members.

Filtering users and groups

One really handy feature of the Fedora/Mandrake user
manager is the Search Filter, located in the upper-
right corner of the screen. You can apply the Search
Filter to either the Users list or the Groups list.

Technique 40: Taking Care of New (And Old) Users

To use the filter, type in the first few letters of the
user name and click Apply Filter. The names are
screened to include only those starting with that
search string (see Figure 40-7).

Elle  Proferences  Help

» @8 B B &
Add User  Add Group 1 Ll Help Refres]
ermri

Ugers | Groups

User Name |||m [ |P1|m.\l\l Growp |Full Name Imqm Shall |Hm|- Directory
Frankiin 501 franklin framiin dewey  feybash  homedranklin

fredde 502 freddie: funkmaster fhinjbash  fhomefreddie

* Figure 40-7: The Users list, filtered for names beginning
with fr.

To refresh the list to show all users, clear the Search
Filter field and click Apply Filter. The list then
refreshes, showing all users.

Managing Users and Groups
with the SuSE User
Administrator

The SuSE user and group administrator is part of the
YaST Control Center. SuSE’s user and group tools are
powerful and friendly — a timesaving combination.

To start the SuSE user administrator, open the main
menu and choose System=>YaST. (Enter the super-
user password if prompted). When the YaST con-
trol center appears, click Security and Users and
then Edit and Create Users.

The user and group administrator opens, as shown
in Figure 40-8.
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SuSE

[iux 2 mutduser system. = User and Group Administration
Sevemldiferent users can be

Inggad in the systsm at the ® Use= () Groups

=ame time. To avoid
confusion, each user must
have a unique identity if they
want to use Linuk.
Furhermore, svery usarat
least bekngs to ans gmoup.

Filler: Local Users

Login - MNams uD  Gmoups

freddie freddis funkmaster 500 usersdiabout,uucp video audio

frnkiin franklin dewsy 501 usersdiakbut,uucp video,audio

In this diakg, get information
about existing Users.

To shitt to the group diakbg,
select Groups.

To create a new user, push
the button Add.

To edit or delete an existing
user, select one user from the
list and click Editor Delete.

| Add Edit | | Dalste

Glick Expert Options to adit ‘ ‘
various exper settings:

password sncryptian type, |
ussrauthentication method, . |

default valuss for new ussrs,

SetFiler ¥ ‘ Gustomize F.m.l |E¥:sﬂﬂp(nns 24 ‘

Back ‘ | Abort ‘

* Figure 40-8: The SuSE User and Group Administration
dialog.
Adding new users

To add a new user, follow these steps:

1. In the user administrator, click Add (near the
bottom of the window).

The Add a New Local User dialog opens, as
shown in Figure 40-9.

.= & e
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2. Fillin the fields in the dialog appropriately:

» Full User Name: This name is for internal use.
Type in the full name of the new user.

» User Login: This is the name of the new user
account (in other words, the login name).

» Password and Verify Password: Enter a pass-
word and verify the password in the next
field. The password has to be at least five
characters long, and it can be any combina-
tion of upper- and lowercase letters, numbers,
and characters.

3. Click Details to open the Add/Edit User
Properties dialog, shown in Figure 40-10.

a5 5
e mesling o) e ne e e Add/Edit User Properties - Details
descrbed below:
tisar ID [ols): ERonilg Tl —Detailed Prmfile for User " madsan”
known to the systemby a
unique numbar, the "Usar 10" UserID (uid) Additional Grup Membare
For normal users, you shoukl
use a UIDbigger than 493 ‘592 O ueers
because the smaller UIDs are O cdom
used by the system forspecil Home Dirctory O flppy
puposss and psauda bgins. “_mm‘_mdssn . [ da=mon
: = e, F diakout
If you change the UID of an O=
sxetng e e minghie Additianal User Info matian: =
i A video
files this usar owns must ba
changsd. This i dans O postiix
automatically for the files in the O trusted
user's home directory, but not Login ghell O utme
for files located ekawherm ‘h " B audi
binbasl -
O ntadmin
Home Directory: The homs O«
dirsctory of the usar. Normally Default group O e
this i /home/usemame. ‘ adm = neaRP:
To salect an existing disclory, O modem T
click Browse O games -
Additional Some
additional userdata coud be | Back | Abot

If you fill out the fiekds Full “  Adda New Local User
User Name and User Login, a

new useraccount is created

with the Password given in

the conespanding fiakd [~ User Dat

When entsring a password, Full Ussr Name

distinguish batween ||

uppercase and bwerass. It

shoukd not cantain any special LUssr Login

chamcters (= 9., accsntsd ,— Buegesitn
chamsters]

Password

With the cunrent password
enciyptian (DES), the [
password kength shoukd be

between 5 and 8 characters.

Verity Password
Valid password chamcters are |

leties, digits, blanks, and

i -HISRE/ |7

(o1)- Password Settings

Back ‘ | Abort ‘

To =nsure that the password
was entersd comectly, repeat it
esactly in a second field. Do
nol farget your password

Tha Usar Laain roud ke

* Figure 40-9: The Add a New Local User dialog.

¢ Figure 40-10: The detailed user properties dialog.

4. Change the fields in the detailed properties dia-
log to suit your needs:

» User ID (uid): In most cases, you can accept
the default user ID chosen by YaST. If, for
some reason, you need to choose a different
user ID, type in a value between 500 and 6000:
YaST will display an error message if the user
ID you specify is already in use.

» Home Directory: This defaults to /home/
username, but you can specify a different
directory if you choose.
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» Additional User Information: Enter any extra
information that you want to note about this
user. The information that you supply here is
ignored by most Linux programs, but will be
displayed if someone “fingers” this user with
the finger command (see man finger for
more information).

» Login Shell: The option you choose from this
drop-down list determines which shell starts
when the user opens a terminal window. bash
is usually a good choice.

» Default Group: SuSE typically adds new users
to the users group, but you can choose a dif-
ferent one by selecting the group from the
Default Group drop-down list.

» Additional Group Membership: Use the
scrolling list on the right side of the dialog to
enroll the user in other groups or to remove
the user from other groups.

5. When you're finished with the Add/Edit User
Properties dialog, click Next to continue.

Note: If you click Back, YaST silently discards
any changes that you made to the Add/Edit User
Properties dialog.

6. Click Password Settings to open the Password
Settings dialog, shown in Figure 40-11.

-~
SuSE

Warning before expiration
Users can ba wamed befors
expimtion of their passwords.
Set how many days before
expition the waming i
issued. Set -1 fo disable
waming

Logging in after expiration
Users can by in after
expimtion of passwords, Set
how many days after
axpimtion bgin i albwed. Usa
-1 for unlimited access.

Lifetime of passward
Set how many day=sa ussrcan
use the same password belore
it expires,

Winimum age of password
Sat the minimum aga of &
password before & useris
albowed to changs i.

Expiration Date
Sel the date when this
account expires. The dats

Password settings for user modean:

Date of the kst password changs: 04/25/2004

Days befors Password Expimtion to lssus Waming

[ :

Days after Password Expires with Usable Login

[ >

Wximum number of days for the same password

|ggggg 7]

Minimum number of days for the same password

o 2

Expimtion date

¢ Figure 40-11:

The Password Settings dialog.

7.

Technique 40: Taking Care of New (And Old) Users

Change the fields in the Password Settings dia-
log to enable and adjust the password aging
options for this user:

» Days Before Password Expiration to Issue
Warning: The typical default value (7) starts
warning the user one week before his or her
password expires. Each time you log in to
Linux, the login program compares the cur-
rent date to the password expiration date for
your account. If your password is about to
expire, Linux displays a warning and suggests
that you may want to change your password
before it expires.

» Days After Password Expires with Usable
Login: This might seem like a strange ques-
tion at first. If you can log in even though your
password has expired, what good is password
expiration? When you log in to Linux after
your password has expired, you must change
your password before you can do any other
work. The default value for this field (-1) lets
you change your expired password at any
time. If you enter some other value in this
field, you can only change your expired pass-
word within that interval — after that, you’ll
have to ask the system administrator to reset
your password for you.

» Maximum Number of Days for the Same
Password: Enter a value in this field to specify
how often the user must change his or her
password. If you enter, say, 7 in this field, the
user must change his or her password every
week.

» Minimum Number of Days for the Same
Password: The default value of 0 means that
the user can change his or her password at
any time. If, for some reason, you want the
user to keep the same password for some
period of time, enter the number of days in
this field.

» Expiration Date: If you enter a date in this
field, the user account will be disabled after
that date. Note that the expiration date is
not the same thing as password aging. When
your password expires, you can change it
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and continue to use your account. When your
account expires, you will no longer be able to
log in.

8. When you're finished with the Password
Settings dialog, click Next to continue.

Note: If you click Back, YaST silently discards any
changes that you made to the password settings.

9. When you're back at the Add a New Local User
dialog, click Create to create the account.

That’s it; you've just created a new user account. You
now see the User and Group Administration dialog
again (refer to Figure 40-8). The user account that you
just created will not be active until you click Finish to
close the window.

Modifying user accounts

You can also use YaST’s User and Group Administra-
tion tool to modify and delete user accounts.

If you need to delete a user, the process is simple:
Just highlight the user and click Delete. When you
delete a user, YaST will ask if you want to delete the
user’s home directory as well — be sure you've
made a backup of any files that may be important
before you click Yes.

To modify a user account, highlight the account and
click Edit (or just double-click the user name). When
you modify an account, you use the same set of
dialogs that you used to create the account: Simply
change any settings that you want to modify and
click Next to save your work.

Adding groups

A group is a collection of users. Groups make it easy
to manage file permissions. If you have several users
who all need to access the same set of files, create a
new group with those users in it.

YaST makes it easy to create and modify groups. To
add a new group, you use the same User and Group
Administration tool that we described previously:
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1. In the User and Group Administrator, click the
Groups option button near the top of the dialog.

2. Click Add.

YaST opens the Add a New Local Group dialog,
shown in Figure 40-12.

\—II_'IIM
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Add a New Local Group
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intemal mpressntatian
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Figure 40-12: The Add a New Local Group dialog.

3. Type a name for the new group in the Group
Name field.

4. Enter a Group ID or accept the default gid
selected by YaST.

YaST displays an error message if the group ID
you specify is already in use.

5. If you want Linux to require a password before
a user can switch to this group, enter (and con-
firm) the password.

In most cases, you can leave the password blank:
You must be a member of a group before you can
switch to that group, so assigning a group pass-
word is usually overkill.

6. Use the scrolling list at the right side of the dia-
log to add and remove members of the new

group.

7. Click Next to save your changes and return to
the User and Group Administration dialog.
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Filtering users and groups

The SuSE User and Group Administration tool
enables you to filter the users and groups that you
see while you're adding and modifying accounts. By
default, YaST displays local users. A local user is a
user whose numeric user ID is in the range 500
through 60,000 (inclusive). A system user is a user
whose numeric user ID is less than 500 or greater
than 60,000. User root is a system account (root’s

uid is 0). SuSE Linux defines a number of other sys-
tem accounts such as bin (user bin owns most of the
programs in the /bin directory), daemon (used to run
many of the background daemons on a typical Linux
system), and mail (user mail owns most compo-
nents of the e-mail processing system).

To switch between local users (or local groups) and
system users (or groups), click Set Filter and select
the filter you want to use.



Keeping an Eye on
Vour System

Technique

Save Time By

v Watching the activity in
your system logs

v~ Customizing your log files

v~ Customizing system noti-
fications for better alerts

v~ Creating custom resource
worksheets with KDE
System Guard

In this technique, we show you how to collect and customize that
information. We also introduce you to some handy tools that help
you monitor your log files and system resources.

I inux log files can provide all sorts of information about your system.

The system log viewer is an easy way to review all your log files at once.
An easy graphical interface allows you quick click-and-view access to all
the logs, in one place. You can also customize the displays to call your
attention to problems without having to search through long log files.
The filter mechanism built into the system log viewer enables you to
quickly and easily find problems related to device failures or programs
that just won't start.

The syslogd daemon is responsible for deciding what gets written to the
log files. The daemon comes preconfigured with a standard set of instruc-
tions, but you can customize the rules in the /etc/syslog.conf file to
make the daemon more sensitive to problems. We show you how in this
technique.

KDE System Guard is a great graphical tool that creates custom system
and network resource-usage worksheets. You can arrange sensors that
display information from your computer and other machines on your net-
work to compare system resources in plotted charts and bar graphs. You
can also use the process table to manage tasks — kill off runaway pro-
grams or change the scheduling priority of processes as they execute.
You can also tell at a glance who’s running what tasks and who’s hogging
your resources.

This technique is all about controlling information. Just like a detective,
you need sources. The great thing about Linux’s information resources
is you don’t have to pay them off for information. Just keep an eye on
them, and they’ll tell you what you need to know about the state of your
computer.
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Keeping an Eye on the
System Logs

Log files contain information about the activities on
your system. Information about various system
processes is recorded into log files. The information
in your log files can provide handy clues when
things go wrong.

System logs contain a ton of information, but they
can be a bit clunky to use. The system log viewer is a
great tool to access your information quickly and
conveniently, without the clunk.

Graphical system log viewers are included in most
Linux distributions, and include handy search features
and customizable warnings and alerts. The default
log viewers included with Fedora and Mandrake are
very similar — we’ve grouped the instructions for
their tools together in the next section, “Viewing and
filtering log files with Fedora and Mandrake.” The log
viewer included with SuSE is a bit more primitive,
but it still renders a lot of insight into the activity on
your system. You can find instructions for using the
SuSE default log viewer later in this technique in the
section, “Viewing your log files from SuSE.”

Viewing and filtering log files with
Fedora and Mandrake

If you're using Fedora or Mandrake, and want to see
what’s going on in your log files with the System Log
viewer, follow these steps:

1. If you're using Fedora, open the Main Menu
and choose System Tools=>System Logs. On
Mandrake, open the Main Menu and choose
System Monitoring->System Log.

2. Enter the superuser password (if prompted to
do so).

The System Logs window opens. The left panel
displays a list of log names.

3. Select a log file to view details of the log in the
window on the right, as shown in Figure 41-1.
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hd System Logs -3
File Edit Help
Boot Log Kemel Startup Log
Cron Log
Reme = hnin o @ (Td?';;lselscg) file contains the startup messages from the kemel
Mail Log
News Log Linux version 2.4.22-1.2115.nptl (bhcompile@daffy. perf.redhat.com) (gec vy
RPM Packages B10S-provided physical RAM map:
% " BIOS-e820: 0000000000000000 - 0000000000900 (usable)
eculy Log BIOS-e820: 0000000000900 - 0000000000000 (reserved)
System Log BIOS-e820: 00000000000f0d7a - 0000000000100000 (reserved)
XFree86 Log BIOS-e820: 0000000000100000 - 0000000014000000 (usable)

BIOS-e820: 00000000ffff0d7a - 0000000100000000 (reserved)
OMB HIGHMEM available.
320MB LOWMEM available.
ACPI: have wakeup address 0xc0001000
On node 0 totalpages: 81920
zone(0): 4096 pages.
zone(1): 77824 pages.
zone(2): 0 pages.
DMI not present.
&

Filter for:

¢ Figure 41-1: The Kernel Startup Log file.

You may have more log files or fewer (and some
of the log files may be empty). Use the scroll
bars to scan the displayed log file or use the
Filter feature to find specific messages.

Follow these steps to use the Filter tool:

1. Enter the keywords in the Filter For field and
click the Filter button.

Only those lines that include the keywords are
displayed, as shown in Figure 41-2.

nd System Logs -3
Eile Edit Help
Boot Log Kernel Startup Log
Cron Log
This log file contains the startup messages from the kemel
Kemel Startup Log @ sl
Mail Log
News Log PCI: PCI BIOS revision 2.10 entry at 0xf5040, last bus=0

PCI: Using configuration type 1

RPM Packages
PCI: Probing PCI hardware

Seclriy'Log PCI: Probing PCI hardware (bus 00}
System Log PCI: Discovered primary peer bus ff [IRQ]
XFree86 Log PCI: Using IRQ router PIIX/ICH [8086/7110] at 00:07.0

Limiting direct PCI/PCI transfers.

Serial driver version 5.05¢ {2001-07-08) with MANY_PORTS MULTIPORT SH/
PlIX4: IDE controller at PCI slot 00:07.1

PCI: Enabling device 00:07.2 (0004 -> 0005)

PCI: Found IRQ 10 for device 00:07.2

I:]

[

Filter for: PCI

Search results for PCI displayed.

¢ Figure 41-2: A filtered result set.



Unfortunately, the Filter tool is case-sensitive;
error and Error are two different words as far
as the viewer is concerned.

2. To show the complete log file again, click the
Reset button.

Adding and deleting log files from the viewer

The log viewer lets you keep your most commonly
viewed log files ready and waiting for you. You can
add more log files to the display or remove log files
that you're not interested in. The log viewer remem-
bers your preferences from session to session. To
customize the set of log files displayed, follow these
steps:

1. Choose Edit=>Preferences from the log viewer’s
menu bar.

The Preferences dialog opens, as shown in Figure
41-3. It has three tabs: Log Files, Alerts, and

Warnings.
Rarreierences
Log Flles |Alerts |wamings |
Log Files
x Configure the path and filename for each
log file displayed.
|L0g File |L0cari0n | ] | Add |
Boot Log Jvarflog/boot.log
Cron Log fvarflog/cron
ete
Kernel Startup Log /varflog/dmesg —
Mail Log Jvarflog/maillog
News Log Jvarflog/s pooler
RPM Packages fvarflog/rpmpkgs
Security Log Jvarflog/secure |Z|
Refresh Rate -
Refresh log file every |30 : seconds.

¢ Figure 41-3: The Preferences dialog.

2. If you want, set the refresh rate on the Log
Files tab.
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The refresh rate determines how often the viewer
rereads the log files to display new messages. The
default refresh rate is every 30 seconds; use the
controls next to the field to adjust it.

- z a Pressing Ctrl-R refreshes the logs immediately
8 from any display in the System Log viewer.
3. To add a log file, click the Add button on the

Log Files tab.

The New Location dialog appears, as shown in
Figure 41-4.

[l New Location

% Specify a new log file location.
Name:'|
Description: |

Location:

‘ 8 cancel H o oK |

* Figure 41-4: Add a new log file with the New Location
dialog.

4, Fill in the dialog and then click OK to add an
existing log to the list.

The System Log viewer is a viewer only; the log
file must exist for it to show up in the viewer.

5. To change the pathname for a log file that’s cur-
rently in the list, highlight the log’s filename
and click Edit.

You'll rarely need to change the pathname for an
existing log file unless you've changed the tool
that creates the log.

The Log File Locations dialog opens, as shown
in Figure 41-5.

6. Use the Browse button to find the log file (or
just type in the name if you know it) and then
click OK to save your new location.
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If you want to delete a log file from the viewer’s
list, select the file and click the Delete button. This
doesn’t actually delete the log file; it just removes
the log file from the list of log files you see in the
viewer.

b L0g File Locations il 4

% Please enter a new location for the Cron Log.

Location: | IERIERTEEN

[Browse...]

| 8 cancel H o oK ‘

¢ Figure 41-5: The Log File Locations editor.

Setting up alerts and warnings

When you’re browsing through a long log file (and
log files can get very long), it’s easy to miss impor-
tant information amidst all of the trivia. The log
viewer can search for keywords in a log file and high-
light any entries that contain those keywords. By
default, the log viewer will search for words like
“fail,” “denied,” and “error” and display a bright red
stop sign when it finds one (the red stop sign is
called an alerf). More innocuous words like “warn-
ing” are flagged with a yellow triangle (the yellow tri-
angle is a warning). You can adjust the alert and
warning keywords to fit your preferences.

To set up alerts, choose Filem>Preferences in the log
viewer. Then click the Alerts tab to open a dialog
with a list of keywords, as shown in Figure 41-6.

Whenever the log viewer sees a message that con-
tains one of the words listed, it displays an alert icon
(ared stop sign, with an x in it) next to the message.
Use the Add and Delete buttons to customize the
keyword list.

To set up warnings, choose Filew>Preferences in
the System Log viewer and then select the Warnings
tab. If the log viewer sees a message that contains
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any of the words listed on the Warnings tab (see
Figure 41-7), it displays a warning icon (a yellow
triangle with an ! in it) next to the message.

liual Preferences Bx

Log Files | Alerts |ﬂam§ngs |

Alerts

Show alert icon for the following key
words.

T
i

rejected
| oops
| segfault

| segmentation

* Figure 41-6: The Alerts keyword list.

liual Preferences Bx

Log Eiles |A1en5 |ﬂamings |

‘Warnings

Show warning icon for the following key
words.

T | -

* Figure 41-7: The Warnings keyword list.



Use the Add and Delete buttons to customize the
Warnings keyword list. The alert and warning icons
make problems easy to spot in a crowded log file.

Viewing your log files from SuSE

The default log viewer included with SuSE (GNOME
System Log Viewer) doesn’t have as many bells and
whistles as the Fedora and Mandrake versions do,
but you can still save time while gleaning informa-
tion from your log files with its help. To monitor
your log files from SuSE Linux, follow these steps:

1. Open the Main Menu and choose System=>
Monitor—>System Log.

The GNOME System Log Viewer opens, display-
ing the contents of the /var/log/messages file
(see Figure 41-8).

—— om Log Viewsr 8
FEile View Help

Date Host Name Process IMessage [#]
- Apilzs ) i

11:31:33 linux syslogd 1.4.1 restart.

kiogd 1.4.1, log source = /proc/kmsg started.

11:31:38 linux kernel Inspecting /boot/System. map-2.4. 21-89-default

11:31:38 linux kernel Loaded 21414 symbols from /boot/System.map-2.4.21

11:31:38 linux kernel Symbols match kemel version 2.4.21.

11:31:38 linux kernel Loaded 238 symbols from 7 modules.

11:31:48 linux kernel rawi394: /dev/raw1394 device initialized

11:31:50 linux kernel usb.c: registered new driver usbdevis

11:31:50 linux kernel usb.c: registered new driver hub

11:31:50 linux kernel usb-uhci.c: $Revision: 1.275 § time 13:50:22 Sep 24 21

11:31:50 linux kernel usb-uhci.c: High bandwidth mode enabled

11:31:50 linux kernel usb-uhci.c: USB UHCI at 1/0 0x1060, IRQ 9

11:31:50 linux kernel usb-uhci.c: Detected 2 ports

11:31:50 linux kernel ush.c: new USB bus registered, assigned bus number :
K3 1] = |

Last Modified: 04/25/04

¢ Figure 41-8: The GNOME System Log Viewer.

Use the arrow to the left of the date to open and
close the tree control and display the entries for
that day.

2. Double-click an item to open a detailed view of
the log entry (see Figure 41-9).
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| — o aymien o e B
File View Help
Date ‘Hum Name‘Frwess !Message #]
- April 25 - )

11:31:33 linux syslogd 1.4.1 restart.

11:31:38 linux kernel klogd 1.4.1, log source = /proc/kmsg started

11:31:38 linux kernel Inspecting /boot/System. map-2.4.21-99-default

11:31:38 linux kernel Loaded 21414 symbols from /boot/System.map-2.4.21

11:31:38 linux kernel Symbols match kemel version 2.4.21.

11:31:38  linux kernel Loaded 238 symbols from 7 modules.

11:31:49 linux kernel raw1394: /dev/raw1394 device initialized

11:31:50 linux kernel usb.c: registered new driver usbdevis

11:31:50 linux kernel

11:31:50 linux kernel

11:31:50 linux kernel

11:31:50 linux Kernel Apil 2511:31:38

11:31:50 linux kernel Process: kernel

11:31:50 linux kernel Message: Inspecting /boot/System.map-2.4.21-99-default

Dx i . This messages are generated by the linux kemel. TH
@ i

* Figure 41-9: Details of a log entry.

Monitoring your log files from SuSE

You can also use the System Log Viewer to monitor
the activity in a log file. To monitor the activity in a
log file, follow these steps:

1. Choose File>Monitor.

The Monitor Options dialog opens (see
Figure 41-10).

T T— i)
4P Add

Choose logs to monitor: Currently monitored logs:

/var/log/messages

|| Hide Application (% Execute Actions

[ Actions J lxgancelj L &g}( J

* Figure 41-10: The Monitor Options dialog.
2. Highlight a log file in the left panel and click
the Add button.

The log file is moved to the right panel (see
Figure 41-11).
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IR T —)

Currently monitored logs:

Choose logs to monitor:

/var/log/messages

= Bemove

|| Hide Application (X Execute Actions

[ Actions J LxQﬂﬂCEﬂJ l QK J

¢ Figure 41-11: Adding a log file to the list of currently
monitored logs.

3. Click the OK button to open a monitor dialog
for that log file.

The Monitoring Logs dialog opens, as shown in
Figure 41-12.

25/ 4 14:16:16 gconfd (root-3619) Resolved address ":(rﬂl'reaﬂnmIy'p’etcm;:mfgmnrﬂefgccvr'lf.fprec:nm.’g|T
26/ 4 14:16:16 gconfd (root-3619) Resolved address "xml:readwrite:/root/.gconf" to a writable conf
25/ 4 14:16:16 gconfd (root-3619) Unable to open saved state file Vroot/ gconfd/saved_state’ No sli
- I -

* Figure 41-12: Current log activity displayed by the Log
Monitor.

] Take a quick trip back in time to view the log
- { -@ entries recorded on a prior date by choosing
& Viewr>Calendar to open the Calendar dialog.
Log files exist for the dates displayed in bold
text — click the date to see the log file for that
date.

Customizing Your Log Files

Most log files are recorded by the syslogd daemon.
When an application (such as an e-mail relay or a
login program) wants to record a log message, it
sends the message to syslogd, and syslogd decides
what to do with it. Every log message is comprised
of three parts:

Technique 41: Keeping an Eye on Your System

v Facility: The facility tells you which subsystem
produced the message. Table 41-1 shows some of
the facilities recognized by Linux.

v Severity: The severity (the sys1og documenta-
tion calls it a priority) tells you how important
the message is. Table 41-2 lists the severity
codes defined by Linux.

V¥ Message text: The message text tells you about
an event detected by the facility.

Most log messages are simply discarded without
anyone actually seeing them, but you can customize
log handling by adjusting the /etc/syslog.conf con-
figuration file. You can route messages generated by
a given facility to a separate log file (for easier view-
ing) or tell syslogd not to throw out messages that
you might want to see.

Each entry in syslog.conf is made up of three parts:
a facility code, a severity code, and a target. The
facility code and severity code are used to classify
incoming messages, and the target tells syslogd
what do with matching messages. For example, sup-
pose you have an entry like this:

mail.error /var/log/maillog

syslogd will route error messages generated by the
mail facility to a file named /var/log/maillog.
Actually, that entry will route error messages and all
messages with a higher severity (crit, alert, and
panic)to /var/1og/maillog. If you want to route only
the error messages, put an equal sign in front of the
severity, like this:

mail.=error /var/log/maillog

If you peek at your own syslog.conf file, you'll prob-
ably see a few wildcards, too. You can use a * on
either side of the dot that separates the facility and
severity:

v To select all mail messages, regardless of sever-
ity (for example), type in an entry like this:

mail.* /var/log/maillog



v To select every critical message, regardless of
the facility that produced it, use an entry like
this:

*.crit /var/log/serious

It's not a good idea to use a wildcard on both
sides of the period because that would select
all facilities and all severities.

The first two pieces of a syslog.conf entry (the facil-
ity code and the severity code) decide which mes-
sages are routed by that entry. The last piece (the
target) decides what happens to those messages.

Most sys1og messages are either discarded or
recorded in a log file, but you can also route mes-
sages to other destinations. The first character of
the target tells sys1ogd whether to send messages to
a file, a named pipe, another computer, or a list of
users. The following list explains what the different
characters accomplish:

v /:lIf the first character of the target is a /, the
target is a filename (or the name of a terminal
device).

v @ If the first character is @, the target is a host
name (selected messages are routed to the
syslog daemon on the named computer).

¥ |:You can route messages to another program
by creating a named pipe and prefixing the name
of the pipe with a |.

v *:Route selected messages to a group of one or
more users by listing the users (separated by
commas), or route messages to all users cur-
rently logged in by specifying a target of *.

To summarize, here are a few sample syslog.conf
entries that show you how to specify message
targets:

¥ *.crit /var/log/serious: Writes critical mes-
sages to /var/log/serious

V¥ *.crit /dev/console: Displays critical mes-
sages on the console
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¥ *.crit @bastille: Sends critical messages to
the syslogd daemon on host bastille

¥ *.crit |/var/log/messages: Writes critical
messages to the named pipe /var/log/messages

v *.crit freddie,franklin: Sends critical mes-
sages to users freddie and frank1in (if they're
logged in)

¥ *.crit *:Sends critical messages to all users

TaBLE 41-1: sysLoG FACILITIES

Facility Description

Authpriv Security and authorization
messages (you can also spell
this facility Auth)

Cron Messages sent by the task
schedulers (cron, at, anacron,
and so on)

Daemon Messages sent by daemon
processes (also known as
services)

FTP Messages sent by the FTP server

Kern Messages sent by the Linux
kernel

Lpr Messages sent by the printing
subsystem

Mail Mail-processing messages

News Usenet news-processing
messages

Syslog Messages sent by the syslog
facility itself

User Generic messages not falling into
another category

uuce UUCP messages (you’ll probably
never see UUCP messages
though)

LocalO-Local?7 User-definable messages (sort of

user-definable anyway)
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The severity component indicates the importance of
the message. Linux supports the severities shown in
Table 41-2.

TaBLE 41-2: SYSLOG SEVERITIES

Severity Description

Panic (or Emerg) Serious problems — break out

the fire extinguisher.

Alert Something’s about to go wrong
unless you do something to

stop it.

Crit Critical condition encountered
(something like “out of disk
space” or “out of memory™).

Error An error has occurred.

Warning Something went wrong, but you
can continue to do whatever you

were doing.

Notice Things are okay, but here’s
something you might like to

know.

Info Things are okay, but you
probably won’t be interested
in this.

Debug Debug messages intended for

propeller-heads.

Keeping an Eye on Resources
with KDE System Guard

KDE System Guard is a customizable system monitor
capable of monitoring not only your local system,
but remote systems as well. The information dis-
plays in several easy-to-read formats that make it a
snap to see where your performance bottlenecks
are. KDE System Guard includes a task manager that
tells you with a quick glance who’s using system
resources. It also gives you easy click-and-kill access
to runaway processes.
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If you're using GNOME, KDE System Guard
isn’t available. Instead, GNOME includes a
much simpler tool called System Monitor. To
run System Monitor, open the Main Menu
and choose System Tools=>System Monitor.

Finding and killing runaway processes

KDE System Guard makes managing processes easy.
Here’s how to get started:

1. To start KDE System Guard in Fedora, open the
Main Menu and choose System Tools~>More
System Tools~>KDE System Guard.

If you're using Mandrake, open the Main Menu
and choose System=>Monitoring=KDE System
Guard.

From SuSE, open the Main Menu and choose
System=>Monitor=>KDE System Guard.

The KDE System Guard window appears, as
shown in Figure 41-13.

B Frocess Table - KDE System Guard |
File Edit Semings Help
| Fg Dl S8
Sensor Biowser | Senso | System Load | Process Table
+ Mlecalhost
Name PID |Userss |Mice vmSize Login | Command L
£ aneal E2OE 000 0 100 swman  jusghinfatsd
£ auton B30 000 0 5672 susan  jusybinfautonm
£ bonoho-activali ERR7 000 0 7096 susan  fuseflibexesbanobo.a
F deopencer 271 000 0 PISO6 suman  kdeinit deophences
2 evolgion-alam RRS1 000 0 MNP susan juselibexesfevalution!
£3 evoltionwomba BRE0 000 0 37140swman  fusyfibexesfevolution,
£ grontd 2 BEAS 000 0 &2 uman  jusylibexecfqeonid 2
3 kalarmat EIGA 000 0 4996 swman  kalarmd
B ed BeFd 102 0 aese0susan  kdeinn koed
i deirar HIFO 000 0 F1ES1suman kdeind Hunning,
# kdesktop HIlZ 026 0 fE020susan  kdeint kdesktop
) kapg BEEZ 000 0 2576 suman kgpg e
i kicker B3R 137 0 29076 susan  kdeinit kicker i
[« .
O (omPocemes y3) (g ) (s
] LI |
(o Frocesses | memary: 300700 KB used, 19632 ki free | Swag: 2848 KB used, 648176 £8 free |

¢ Figure 41-13: The KDE System Guard main window.

2. Click the Process Table tab see a list of the
processes running on your system and some of
their more important properties.

By default, you see all processes currently
running on your system, but you can limit
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the processes with the drop-down list box at
the bottom of the screen (see Figure 41-14).

| File Edit Senings Help

[ Fs a8

Sensor Browser |Senso | System Load | Process Table

o ecalhost
Name PID |Users |Nice VmSize Login | Command *
£ ansal B206 000 ] 10144 susan Susefhinfartad
£} autonn B0 000 0 SE72susan  juse/binfautonn
£ boncho activali B8S7 000 0 7096 swsan fusyfibexe fbanabe.
T deapsener B71 025 0 2396 swman  kdeinit deoprenes
£} evolgion alam B8] 000 0 4212 mwman  fusyibexes fevoiulion
£} evolidionwomba BRSY 000 0 27140%wman  jusyfibexer fevolulion
£} geontd 2 REES 000 0 &7 wman  fusylibexeejyconid 2
&3 kalarmal B3 000 0 24096 susan  kalarmd
Tt e R7Y 125 0 P6520swsan  kedeinil kited
B hadeinit R70 000 0 2188 susan  kedeinil: Running,.
B hieskiop B2 000 0 2A020swman  kdeinil kiesktop
B kgpg ER12 000 0 25764 suman  kgpg it
T kicker B 075 0 29108 swsan  kdvinil kicker B
[ e — e | i
\Zj Iree | Cwm Processes iJ‘ | Befresh -
« I (e All Processes |
i| 69 Processes | Memory, 300R36 KB used, 104) SYS18M PIOCESSEs  Lpyp oy 618176 KB lee o |
el bt s o biotlice |
| Eerr—

¢ Figure 41-14: The process selection drop-down list box.

3. Choose one of the four options in the drop-
down list box to limit the view:

» All Processes shows all processes currently
running on the system.

» System Processes shows all processes that
are currently running that are owned by
root — processes like services and watchdog
programs.

» User Processes shows all processes that are
owned by any user on the system.

» Own Processes shows the processes that are
owned by the user logged in and running KDE
System Guard.

4. Click the Refresh button to update the selected
worksheet.

By default, the worksheet updates every two sec-
onds, but you can change the update interval by
choosing Edit=>Work Sheet Properties from the
menu bar. The Worksheet Properties dialog
opens (see Figure 41-15). To change the update
interval, just use the spin control or type in a
new number, and then click OK.
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—Process Table -

Rows: !1

Columns: |l =

Update interval: |2 5 sec.

* Figure 41-15: The Worksheet Properties dialog.

5. If you see a runaway process, highlight the
process name in the list and click Kill to stop
the process.

A confirmation dialog appears so you can change
your mind (see Figure 41-16).

[ Kill Process - KDE System Guard =dk

Do you want to kill the selected process?

Cancel

* Figure 41-16: Confirmation of a process kill.

6. Click the Kill button in the warning dialog to
stop the process.

In a second or two, the process table updates,
and you'll see that the victim process is gone.

7. Back in the Process Table tab, check the Tree
box to display the parent-child relationships
among processes.

] If you have multiple copies of the same pro-
- («@ gram running, use the tree format to tell the
& child processes apart.
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Prioritizing processes to smooth
a network bottleneck

You can make users play nice by “renicing” the
processes that aren’t quite as important as others.
(Each process has a nice value that controls its pri-
ority in relation to other processes.) To change a
program’s priority, follow these steps:

1. Open a terminal window and give yourself
superuser privileges with the su command.

Type ksysguard at the command line to open
System Guard.

Right-click on a process name in the list, and
choose Renice Process from the pop-up menu.

N W N

Use the bar control to raise or lower the process
priority and click OK to confirm the change.

7 In a system with cramped resources, lowering
e- { -@ process priorities can give you a short-term
& solution to a performance bind. In the long-

run, you'll probably want to upgrade your sys-
tem because lowering someone’s priority is a
good way to make enemies (if they figure out
who did it).

Watching your system load

KDE System Guard comes with a built-in worksheet
that displays the current system load in an easy-to-
understand format. With a quick look, you can see a
graph showing CPU Load, Physical Memory, Load
Average, and Swap Memory. To use the System Load
tool, follow these steps:

1. In the KDE System Guard window, choose the
System Load tab to open the system monitors,
shown in Figure 41-17.

2. You can add sensors to this display by choosing
Edit~>Work Sheet Properties.

Each sensor monitors some aspect of your sys-
tem. For example, the Battery Charge sensor

Technique 41: Keeping an Eye on Your System

measures the amount of juice left in your battery
(assuming that you’re running Linux on a laptop)
and the Load Average sensors measure the over-
all system load for that past minute, five minutes,
or 15 minutes (depending on which Load Average
sensor you choose).

0 5vstem Load - KOE System Guard BEIE

| Fle o Senings Heip
[ T 2 ¥
& Fo Hdal @
Sensor Broweser
KMocalhost e

+-Advanced Power b
+-CPUO

v Disk Throughput
+-Load

+-Memary

+- Network.

i Panition Usage
iyFrocess Control Phyzical Memory

| System Load | Process Takie |
Load Average {1 min} Sensor Logger

Logging | Timenntenval

= |l

Swap Memory Clock Frequency [MHz]

BPiocess Count
Ide Load System Load System Load [%]
« EHT i |
A LS BN A G R N AN St S LI AR B AT R 1] |

¢ Figure 41-17: The System Load worksheet.

3. In the Worksheet Properties dialog that
appears, add rows or columns to create empty
slots in the worksheet for the sensors (see
Figure 41-18). Then click OK to close the dialog.

~System Load

: | |
Rows: =
Columns: |

Update interval: |2 :_ Sec.

oK Cancel
L =)

¢ Figure 41-18: Add sensors to new fields.
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4., Expand the tree control in the Sensor Browser
panel on the left to see the list of available
Sensors.

5. To add a sensor, drag the sensor name from the
tree and drop it on a Drop Sensor Here label
(in the worksheet).

A pop-up menu appears showing the sensor dis-
play options, as shown in Figure 41-19.

Pop-up menu

B4 5vstem Load [modified] - KDE System Guard BEE
[
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The Settings window appears, as shown in Figure
41-20. The Settings window varies with the sen-
sor type. A quick look through the tabs will help
you decide on the customizations you’d like for
your display.

il Signal Plotter Settings E E]

[Style ‘ Scales |Gn’d |Sensors ]

~Title
Read Dt

—Graph Drawing Style

i) Original - single line per data point
) Basic polygons

i fie Edit Semngs Haip
L o 5 |
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Wiccalhost CPU Load _oad Average (L min | | Sensor Logger Drop Sensor Here
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cPUa Logging | Timer |
Disk Throughp) s
a0 = Tl
Physical Memary Swap Memary lock Frequency IMH: - Deop Sersor Hers
i Load ﬁ
+-Memary Il Loadd Sysiem Load System Laad [%] oo Sensar Hens
+-Netwark
= Partition Usagl
boer
-yl
-yFreal | = ="
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{F P + Multimeter
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— s Bastisaph
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* Figure 41-19: Sensor display options.

The sensor types are as follows:

» Signal Plotter: This is the default display type
for the System Load window.

» Multimeter: This is a large digital display.

» BarGraph: Drag multiple sensors into one
window to show value comparisons.

» SensorLogger: Create custom logs for your
system resources.

6. Choose a sensor type from the pop-up menu.
The new sensor is added to the display grid.

7. To change the properties of a sensor, right-click
on the sensor and choose Properties from the
pop-up menu.

Apply

Cancel
4

* Figure 41-20: The Settings window for a Signal Plotter
sensor type.

] A few sensors can display the status of multi-
B (@

ple objects in table form. For example, the
Partition Usager>Table Sensor displays the free
space available on all disk partitions. That's a
handy way to view a group of resources quickly.

&

After you set up the sensors and preferences you
need, you can monitor your system for perform-
ance or resource bottlenecks.

Creating a new worksheet

If you’d like to create a new worksheet instead of
revamping the System Load page, or if you want to
create multiple worksheets to display the various
system attributes, it’s easy to do with KDE System
Guard. Here’s how:

1. Click the New icon on the toolbar.

The Worksheet Properties dialog opens.
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2. Enter the number of rows and columns you
want in the new worksheet and then click OK.

Your new worksheet is created, ready for new
SEensors.

Drag multiple sensors onto a bar graph display
to compare sensor values.

KDE System Guard has a few resizing issues. If
6 a worksheet gets too full (or contains too
many sensors), it likes to delete titles and/or

hide the sensor browser selector. It's nothing
personal — it does that to everyone.

Creating system resource logs

You can use KDE System Guard to create system
resource logs to your custom specifications. If the
system seems slow at 1:00 p.m., when your users
come back from lunch, you can create a custom
resource log to help confirm your suspicions and
track down the bottlenecks.

To create a custom resource log, follow these steps:
1. Click the New icon on the toolbar to create a
new worksheet.
The Worksheet Properties dialog opens.
2. Enter a title for the worksheet and click OK.

A blank worksheet appears, ready for the new
Sensors.

3. Drag sensors onto the worksheet.

Here are some sensors you may want to include
in a system usage log:

» Free Physical Memory
» Free Swap Memory

» CPU Load

» Disk Throughput

Technique 41: Keeping an Eye on Your System

Throughout the day, watch the sensors that we men-
tion and see how they change as your system load
changes throughout the day. Watching how the sen-
sors vary will help you identify resource bottlenecks.
For example, if Disk Throughput is very high but
CPU Load is low, you know that your computer is
spending a lot of time waiting for the disk drive (and
you may want to invest in some more drives to share
the load).

As you add each sensor, here’s how to spot the
bottlenecks:

1. Choose the Sensor Logger type from the pop-up
menu.

The Sensor Logger dialog opens, as shown in
Figure 41-21.

—Timer Interval

|2

|

—Alarm for Minimum Value

|| Enable alarm Lower limit: |

—Alarm for Maximum Value-

|| Enable alarm Upper limit: |

QK Cancel

* Figure 41-21: The Sensor Logger dialog.

2. Complete the Sensor Logger dialog for each
sensor:

» Enter the name of the file that you want to
contain the sensor log.
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» If you'd like the log to alert you to extreme
drops in resources, check the Enable Alarm
box in the Alarm for Minimum Value frame
and enter a Lower Limit value in the activated
field.

» If you want the log to alert you to extreme
spikes in resource usage, check the Enable
Alarm box in the Alarm for Maximum Value
frame, and enter an Upper Limit value in the
activated field.

3. When you suspect a system slowdown, right-
click on each sensor and choose Start Logging
to start the log files.

Keep an eye on your sensor logs. They can get
really huge really fast (and eat up the
resources you're trying to preserve)!

4. When you suspect the system is returning to
normal, right-click on the sensor and choose
Stop Logging to stop the logs.

[ Most log files are written to the /var/1og
- (@

directory, but if you haven't started KDE
System Guard with superuser privileges, be
sure to write the logs to a file you have the
privileges to create.

&

If you’ve told System Guard to alert you when
extreme values are reached, the worksheet changes
the sensor name to red and notifies you based upon
the settings in your Control Center. To customize
your notification settings for KDE System Guard, fol-
low these steps:

1. Open the Main Menu and choose Control
Center.

Expand the Sound and Multimedia entry in the
Index tree control.

2
3. Click System Notifications.
4

From the drop-down list at the top of the
screen, choose KDE System Guard.
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The System Notifications window opens, as
shown in Figure 41-22. Use this dialog to cus-
tomize system notifications for KDE System
Guard and other tools on your system. Several
options for alert customization are available.
Experiment to find a combination that will help
you get your work done, but not drive you nuts
with whistles, klaxons, and pop-ups.

5. After you finish changing the System
Notifications, click Apply and then close the
Control Center.

B = vstem Hotlficatlons - Coniral Genter 'HEE
File View Help
| tndex [Sgarch [ Help KDE System Guard 5
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O £ @ 0 &) § Cvens
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+- b KDE Components
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=& Sound & Mutimedia
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& System Bell
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* Figure 41-22: The System Notifications window.

Displaying network resources

One really cool feature of KDE System Guard is its
ability to monitor resources on other computers.
System Guard supports a number of methods for
establishing a remote connection, but the quickest
(and most foolproof) is to use SSH.

Follow these steps to add sensors for another
computer:

1. Click the Connect Host icon on the toolbar
(the icon looks like a plug and socket, plugged
together).

The Connect Host dialog opens, as shown in
Figure 41-23.
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v ‘Connect Host 77
Host leaga ¥ J
— Connection Type
®) ssh ) 1sh ) Daemon ) Custom command
Part: 5 eg. 3112
Command LI !
e.g. ssh - root remote.host.org ksysguardd

* Figure 41-23: The Connect Host dialog.

2. Enter a host name in the Host field, or choose a
host from the drop-down list.

3. The ssh option button is chosen by default. If
you don’t have an ssh connection to the other
machine, click the Help button for information
about other connection types.

] Better yet, see Technique 33 for help setting
- { -@ up an SSH connection. ssh is easy to use and
& your best bet.

4. Click OK.

If you've configured public-key authentication for
the remote host (see Technique 33), the com-
puter name appears in the sensor list. If not, you
have to enter a user name and password before
the remote computer appears. Now you can cre-
ate comparison worksheets showing computer
against computer, as shown in Figure 41-24.
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¢ Figure 41-24: System comparison worksheet — Kaga
versus Kobe.

This is a great way to monitor network load and disk
space. Set up signal-plotter graphs for each resource
or use bar graphs to compare resources.

resources from each machine on a network
into a single sensor frame to compare resource
usage on the fly. It's easy to spot at a glance
which system has resources to spare and
which system needs help.

7 Create a bar graph by dragging the same
e («.

&

Taking the time to explore KDE System Guard can
really add to your productivity levels. It’s a great
timesaving tool that gives you the information in just
about any configuration you could want.
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Keeping an Apache
Server in Top Form

Technique

Save Time By

+* Using Synaptic or your
distribution’s installer to
resolve Apache's
dependencies

v~ Using OpenOffice.org
Writer to set up a quick
Web page

+* Using dynamic DNS to
keep your server at home,
but make your data avail-
able to the world

v Using the HTTP
Configuration tool to
make easy changes to
your Apache server

server today. It’s easy to use, and it’s powerful. You can use Apache
to serve up data to users on your own network or to locations
across the Web.

The Apache Web server is without a doubt the most popular Web

If your company is already bogged down with e-mail, using a Web server
can be a great way to publish information to users on your network. You
can create company newsletters and change important information quickly
and easily with a WYSIWIG editor like OpenOffice.org. Users can easily
browse to the company’s local site to find out what’s going on without
your making the information available for the whole world to see.

If you do want to take your site public, you may or may not want to rent
space on someone else’s host machine. Keeping a server up and running
on your local network is a great idea if your site requires a lot of monitor-
ing and upkeep. With dynamic DNS, you keep just a name and IP address
registered on someone else’s server — your data stays home where you
can take good care of it. Your IP address may change, but your host name
never will. If your IP address changes, you update the new address to the
name server. When customers or associates search for you by name
across the Internet, the name server relays the current IP address to them
to complete the search. You save the high cost of machine rental on
someone else’s servers, and because your system is local, maintenance
is quick and easy.

In this technique, we show you how to get your Apache server running at
full speed in no time. We also show you a few quick tools you can use to
populate and distribute your Web site and to keep it running in good con-
dition. Serving up data is simple and quick with Apache.

Setting Up Apache — Quick!

The Apache Web server is easy to install, but it has quite a few depend-
encies (53!) that can really slow you down. The easiest (and quickest)
way to install Apache is from disc (with your distribution’s installer) or
by downloading and installing it with Synaptic.
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] You can set up Apache by installing individual
- («a RPM packages with the rpm command, but
) the process goes a lot faster with a tool like

Synaptic or the Fedora Package Manager.
Resolving the dependencies manually can
seem to take forever.

Using Synaptic to download and install Apache

Manually satisfying all the dependencies of a
program like Apache can be a real pain and time-
consuming. You have to round up and install each
RPM package before the next will allow you to con-
tinue. Using a tool like Synaptic can save you a ton
of time when you need to install a complex program
with many dependencies.

g Synaptic is the right tool for downloading or
i («a updating any of the software on your system.
) Technique 19 is all about using Synaptic to
keep your software current. Check it out for
details about downloading and installing
Synaptic. It's a definite timesaver.

If you've installed Synaptic on your system, a pain-
free installation of Apache is just a few clicks away.
To download and install Apache, follow these steps:

1. Open a terminal window and enter the
following command:

# synaptic
You're prompted to enter the root password.
2. Enter the root password and click OK.
Synaptic opens.
3. Click the Update button (on the toolbar).

Synaptic connects to each repository and
updates the local index that tells Synaptic which
programs are available (see Figure 42-1).

4, Enter httpd in the Find field in the upper-right
corner of the window.

Synaptic finds the first package whose name
starts with httpd.
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ok
status |size  |uml [
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* Figure 42-1: Updating the Synaptic packages.

5. Click the Find Next arrow (the right arrow
just to the right of the Find field) to move
through the matches that Synaptic finds and
then click the Install Latest Version button
when you find the following packages:

httpd-manual
httpd

7 If you already have either of these packages
e- { <@ installed on your system, the Install Latest
& Version button will be labeled Update instead.
Update your versions of Apache as long as
you're here. It only takes a minute.

6. Click the Execute button (on the toolbar).
A Summary dialog opens, as shown in Figure 42-2.
7. Click Proceed to start the download.

A dialog opens, showing the progress as Synaptic
retrieves the package files. When the download
completes, the installation begins.

When Synaptic is finished with the installation,
another dialog signals that the installation is
complete (see Figure 42-3).

8. Close the dialog and Synaptic.

Your installation of Apache and its dependencies
is complete!
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86 packages were kept back and not upgraded;
4 new packages will be installed;

12.1MB will be used after finished.
2121kE need to be downloaded.

Package changes
» To beinstalled

[: To be kept back

[] Perform package download only.

Show Details | | Cancel || Proceed |

* Figure 42-2: Synaptic, waiting to install new packages.

[l Package Manager output

Extra output was generated during Package Manager operation

[+]

| While installing package httpd-devel-2.0.48-1.2:

| Done.

[+] [*]

¢ Figure 42-3: The installation is complete.

Installing Apache from disc

If you have a set of installation discs for your Linux
distribution, you can use the installer program (the
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Fedora Package Manager, YAST, or Rpmdrake) to
install Apache instead of downloading Apache from
the Web. In this section, we show you how to install
Apache using the Fedora Package Manager.

If you’re running SuSE Linux, the procedure is
similar — use System=>YAST>Install and Remove
Software; choose the Selections filter and click
Simple Webserver. Mandrake users can install
Apache using Rpmdrake (Main Menu=>System=>
Configuration>Packaging=Install Software).

g If you happen to have a copy of Red Hat
- (@ Linux Fedora For Dummies, by Jon ‘maddog’
& Hall and Paul G. Sery (published by Wiley),
you already have the Fedora distribution on
DVD; you can install Apache from that DVD.
Just insert the disc, enter the root password
when prompted, and follow along.

To install Apache from the Fedora install discs, fol-
low these steps:

1. Open the Main Menu and choose System
Settings=>Add/Remove Applications.

A dialog opens, prompting you for the root
password.

2. Enter the root password and click OK.

A dialog opens and confirms that Fedora is
checking the system package status. The
Package Management window opens.

3. Scroll down to the Servers section and check
the Web Server box (see Figure 42-4).

] If you plan on incorporating other programs
e (@ (like PHP or PostgreSQL) into your Web
& server, you can save time by adding them
now. Click the Details button to the right of
the Web Server entry to view the package
contents. Check the boxes next to any addi-
tional packages you'd like to add. When you're
finished, click the Close button to return to the
Package Management window.
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[rackage Managemens Ry

Add or Remove Packages

[servers &
Server Configuration Tools [5/12] Details

@ This group contains all of Red Hat's custom server
configuration tools.

Web Server [2/171 Details
ﬁj These tools allow you to run a Web server on the system.

Mail Server 18] Details

I

,\gy These packages allow you to configure an IMAP or Postfix
N mail server.

[] windows File Server [0/2]

{E} This package group allows you to share files between Linux
4 J and MS Windows(tm) systems.

[] DNS Name Server [oy3]

This package group allows you to run a DNS name server
(BIND) on the svstem. =]

Total install size: 2,261 Megabytes

¢ Figure 42-4: The Package Management window.

4. Click Update.

A dialog opens confirming that the system prepa-
ration is completed.

5. Click the Continue button.

A dialog opens, confirming that your system is
being updated.

6. Click Continue, and when prompted, insert the
Fedora disc and click OK.

(8 on which disc images you're using. Just follow
along and click — the Package Manager is easy

to get along with.

Z The last few steps may vary a bit depending
g}

&

When the system updates are complete, a window
opens confirming the successful installation. Now,
you need to start the service, which we explain in
detail in the next section.

Starting the Apache Service

The Apache Web server is a daemon — it lurks in the
background, waiting for inquiries from browsers that
just happen to come looking for you on TCP port 80.
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To start the Apache Web server on a Fedora system,
you need to start the httpd service. To start the
service, follow these steps:

1. Open the Main Menu and choose System
Settings—>Server Settings->Services.

A dialog opens, prompting you for the root
password.

2. Enter the password and click OK.

The Service Configuration window opens, as
shown in Figure 42-5.

[l Service Cnnﬁgurali;
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[ daytime
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-

¢ Figure 42-5: The Service Configuration window.

3. Use the scroll bar to scroll down through the
list of services, and check the box next to httpd
when you find it.

The Status frame shows that the httpd service is
stopped.

4. Click the Start button on the toolbar.

An Information pop-up informs you that httpd
started successfully (see Figure 42-6).

4. Click OK to close the pop-up.

6. Click the Save button in the Service
Configuration window and then close the
window.

Your Apache Web server is up and running!



¢ Figure 42-6: The httpd service is Apache.

If you're running SuSE, you can use YaST to start the
Apache Web server by following these steps:

1. Open the Main Menu and choose System=>YaST.

2. Ifyou’re not logged in as the superuser, SuSE
prompts you for the root password. Type in the
root password and click OK.

3. Click Network Services, and then click HTTP
Server.

4. When the HTTP Server Configuration window
appears, click Enabled and then Finish.

After a short delay, your Apache Web server is
ready to serve browser requests.

If you're a Mandrake user, follow these steps to start
the Apache Web server using the Mandrake Control
Center:

1. Open the Main Menu and choose Systemr>
Configuration~>Configure Your Computer.

2. Ifyou're not logged in as the superuser,
Mandrake prompts you for the root password.
Type in the root password and click OK.

3. Choose System->Services.

4. Use the scroll bar to scroll down through the
list of services, and select the On Boot check
box next to httpd.

5. Click the Start button (next to httpd).

The Apache Web servers starts.
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6. Click OK, and then close the Mandrake Control
center.

The Apache Web server is up and running and
will automatically start each time you reboot
your Mandrake computer.

To check the installation and service status of your
new Apache Web server, open a Web browser and
surf to http://127.0.0.1. Your browser displays the
Apache Server Test Page, shown in Figure 42-7.

s} Test Page for Apache instaliation - Konqueror

Location Edit View Go Bookmaks Jook Seftings Window Hep
€3 L} (& =
L C &2 @

B Losaton: [ & hip icatnost

LAG ae %
LR

If you can see this, it means that the installation of the Apache web server software on this
system was successful. You may now add content to this directory and replace this page.

T
Seeing this instead of the website you expected?

This page is here because the site administrator has changed the configuration of this web
server. Please contact the person responsible for maintaining this server with questions.
The Apache Software Foundation, which wrote the web server software this site administrator is
using, has nothing to do with maintaining this site and cannot help resolve configuration issues.

The Apache documentation has been included with this distribution.

You are free to use the image below on an Apache-powered web server. Thanks for using
Apache!

wered by
APAaCH

Page badsd

* Figure 42-7: The Test Page for Apache Installation.

At this point, you're ready to serve up Web content
to machines on your local network. Apache is a
quick way to distribute a company newsletter or
share other in-house information. In the next sec-
tion, we show you how to create simple Web content
with OpenOffice.

7 To make your server accessible to your com-
(4& pany or network, but not vulnerable to the

outside world, allow traffic from port 80 at
your local interface, but disallow traffic on port
80 from the outside world. See Technique 34
for helpful ideas about using Webmin to set
up a functional firewall.

&
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If you want to serve up data to the rest of the world,
you need an IP address and domain name — more
about that later.

Building a Quick Web Page
with OpenOffice.org

After you have a server up and running, you need to
provide some content for your users. A quick and
easy way to set up and maintain an internal newslet-
ter is with OpenOffice.org. One of the great features
of OpenOffice.org Writer is a WYSIWIG editor that
lets you create and save HTML documents in no
time. It’s also very affordable.

7 If you haven't already installed OpenOffice,
e («a you need to install it before you proceed with

the steps in this section. See Technique 17 if

you need help installing software on your
system.

&

To create a simple Web page with OpenOffice.org
Writer, follow these steps:

1. Open a terminal window and give yourself
superuser privileges with the su command.

2. Enter the following command and press Enter:

# oowriter

OpenOffice.org Writer opens to a blank docu-
ment, waiting for you to add content to your new
Web page.

3. Add content to the Web page — text, pictures,
and any graphics you want to distribute.

- into place within the directory structure of
your Web page so that Apache can find them.
If you copy pictures into an OpenOffice.org
document that you later save to an HTML file,
the pictures are added as links. The links are
replaced with images when the document is

viewed in a browser.

Z If you add graphics, don't forget to copy them
<}

&
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4. When you're finished creating your opening
Web page, choose File>Save As from the
menu bar.

If you're running Fedora or Mandrake Linux, save
your file as
/var/www/html/index.html

If you’re running SuSE, save your file as

/srv/www/htdocs/index.html

&, Use the scroll bar next to the File Type field to
highlight the HTML Document (OpenOffice,org
Writer)(.html;htm) option in the drop-down list.

6. Click the Save button.

Your new Web page is saved where your Apache
server can find it.

To check out your new network Web site, open your
browser and surf to http://127.0.0.1.

Your new page is displayed; it should appear nearly
identical to the document you created in Writer (see
Figure 42-8).
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Open Office is a great way to build a
web page fast!

Check out OpenOffice.org For Dummies!
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* Figure 42-8: Start your site quick with OpenOffice.org.

7 For a top-notch tour of OpenOffice.org and a
- { @) complete rundown of its capabilities, look for
& OpenOffice.org For Dummies, by Gurdy Leete,
Ellen Finkelstein, and Marty Leete (Wiley) at
your favorite online or local bookstore.



To edit and update your page with the current news
of the day;, just fire up OpenOffice.org Writer and
open your document. Make your changes and save
the file, and your local network site is automatically
updated.

Taking Your Site Public
with Dynamic DNS

You can make your Web site public by renting server
space from an ISP or by obtaining your own domain
name and hosting the site from your Apache server.
When you rent machine space from an ISP, you pay
not only for the room your data takes up, but also
for the Web traffic to your site. If you have a small
and simple site with little traffic, that’s not a prob-
lem. If you have a large or complex site with a lot of
traffic, renting server space can get costly.

(2 high-maintenance Web sites on local machines.
If you use PHP to build your site or have live
database access from the site, keeping the
data where it can be updated easily is a real

timesaver.

z You can save time and money by running
<8}

&

In order for others to find your Web site, you have to
have a host name, and the host name must be fully
qualified — that is, your host name must include a
domain name (something like www.example.com). If
your ISP is willing to assign you a fully qualified host
name, you're good to go. If not, don’t despair — you
can borrow someone’s domain name by using
dynamic DNS.

Understanding how dynamic DNS works

When a user surfs to your spanking new Web site, he
types a name (say www.example.com). His Web browser
asks a name server to convert the site name into an
[P address. His local name server defers the request
to a well-known name server somewhere on the
Internet. Eventually, the name server chain locates a
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server that’s responsible for the example.com domain.
That name server returns the IP address for host www
(that is, host www within the example.com domain).

A normal name server maintains a database that
converts host names into IP addresses for the hosts
on the name server’s local network. A dynamic DNS
server provides the same service (host name to IP
address translation), but it lets you change the data-
base. To use a dynamic DNS server, you send your IP
address and desired host name to the server, and it
agrees to give out your IP address whenever some-
one asks for your fully qualified host name. Of course,
the domain name that you get to use is owned by the
dynamic DNS provider, but it gives you a permanent,
fully qualified name that you can hand out to friends
and business partners (without purchasing a domain
name for yourself).

What happens if your Internet service provider
changes your IP address? Simple — just update the
dynamic DNS database.

Setting up dynamic DNS

To use dynamic DNS, you first contact a company
(often an ISP) that will register your site name. You
can find quite a few free (and paid) dynamic DNS
providers online.

) Each service provider has its own how-to's for
e { - setting up a dynamic DNS service. The basics
) are pretty much the same, but read the FAQs
for each service online before registering an
account with that service.

One dynamic DNS service worthy of mention is
DynDNS.org. Follow the simple how-to page at
www.dyndns.org/services/dyndns/howto.html to set
up your dynamic DNS account in no time. Follow the
links to do the following:

1. Register for an account.

You'll receive an e-mail confirming the account
registration.
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2. Confirm the account registration to activate the
account.

3. Add host information for your computer:

» Choose a host name and an extension. Our
personal favorite has to be is-a-geek.com.

» The DynDNS service automatically detects
and fills in the IP Address field.

Select the Wildcard check box if you want
your name to be accessible from both
www.sitename.dyndns.comand
sitename.dyndns.com.

4. Click the Add Host button, and you’re done.

If your Apache server is running and your firewall is
allowing access through port 80, your Web site
should be exposed to the Web.

The exposure you get through the Web is also
a liability. Build a good, sturdy firewall to pro-
tect the rest of your system — see Technique 34

for more information about firewalls.

- Technique 58 for information about installing

Z Better yet, keep your site in a UML jail. Visit
<}
Apache in a UML jail with ADIOS.

&

Updating your IP address

Different ISPs have different policies about changing
the IP address of your local network. If you're con-
nected to the Internet using a dial-up account, your
[P address changes each time you connect. Other
connection types may assign you a semi-permanent
[P address or change your address every few days. If
your ISP changes your IP address only when you log
out, you need to update the dynamic DNS host infor-
mation only when you’ve logged out and back in
again. If your IP address changes more often, you’ll
probably want to use a client program to monitor the
changes and update the host information for you.
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You can also update the host information manually by
visiting your account information at DynDNS. Choose
your host from the list of hosts that you manage, and
its server will detect your address. If your address
has changed, click the Modify Host button to update
the information.

e address when it hasn't changed will invoke the
ire of the good people at DynDNS. Compare
IP addresses and update your account only if
the IP address has changed. Otherwise, your

service will be interrupted for abusing your

%( Be sensitive to the fact that updating your IP
g}

&

privileges.
7 Technique 45 is all about creating a self-signed
SSL certificate for your Apache Web site.
& Check it out!

Keeping Your Apache Server
Up-to-Date the Easy Way

If you run an Apache server for any length of time,
you’ll probably find it needs a bit of tweaking. You
may want to enable new features or add virtual
hosts (whole new Web sites) to your servers. You
can make those changes directly with a text editor
and the Apache configuration file, but you can save
time by configuring your server with a good graphi-
cal tool.

Fedora Linux comes with a very friendly configura-
tion tool that makes it easy to manage your Apache
server: It’s called the HTTP Configuration tool, and
we show you how to install and use it in this section.
If you're using a distribution other than Fedora
(say, Mandrake or SuSE), we recommend that you
get familiar with Webmin’s Apache configuration
module — it’s not as friendly as Fedora’s tool, but
it’s better than editing configuration files by hand.
See Technique 17 for more information about
Webmin.



Keeping Your Apache Server Up-to-Date the Easy Way

Fedora’s HTTP Configuration tool is an easy-to-use,
graphical interface that allows you to access many
of the Apache configuration options with just a few
mouse clicks. For simple configuration changes, or
complex virtual host setups, it’s great.

Installing the Fedora HTTP Configuration tool

The Fedora HTTP Configuration tool is not installed
by default with a standard Fedora installation, but it
is included on the Fedora distribution media. So you
can have it up and running in no time.

To install the HTTP Configuration tool, follow these
steps:

1. Open the terminal window and give yourself
superuser privileges with the su command.

2. Mount your Fedora media and move into the
directory containing the RPM packages.

3. Enter the following command:
# rpm -Uhv redhat-config-httpd-
1.1.0-5.no0arch.rpm

With a few whirrs and clicks, the package
installs.

Putting the HTTP Configuration tool to work

After you install the HTTP Configuration tool, it’s
ready to use. Follow these steps to open the HTTP
Configuration tool:

1. Open the Main Menu and choose System
Settings->Server Settings->HTTP.

A dialog opens, prompting you for the root
password.

2. Enter the password and click OK.

The HTTP Configuration tool opens, as shown in
Figure 42-9.
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Virtual Hosts | Senver | Performance Tuning

Basic Setup
Server Name:
Webmaster email address: | root@localhost
Available Addresses
All available addresses on port 80 |

| | Edit...

Delete

IIE
=

Set addresses for Apache to listen for requests on.

| Breb |

oo |

‘ # Cancel ‘

* Figure 42-9: The HTTP Configuration tool.

The tool features four tabs, each controlling a differ-
ent aspect of the Apache service:

v Main: The Main tab controls the basic setup of
the server. Use this tab to specify the server
name and the Webmaster’s e-mail address, and
to add or change the IP address(es) that Apache
listens to. Click the Edit button to edit the IP
address and port information (see Figure 42-10).

d Edit an address...
@ iListen to all addresses!

@ () Address: |

Q2 :
Port: B0

| o oK H ﬂgancel‘

* Figure 42-10: Edit the address for your Apache server.

- on your system, each card has a unique IP

address (and, probably, a unique host name).
Specify which card Apache should service by
selecting the Address radio button and enter-

ing the address of the preferred card.

z If you have multiple network interface cards
=)

&
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v Virtual Hosts: Choose the Virtual Hosts tab to

add or edit information about virtual hosts resid-
ing on your Apache server. Your Apache server
can host multiple Web sites. Each virtual Web
site has its own set of properties defining its
name, where its root directory resides, and secu-
rity information for that site.

Click Edit to open the Properties window for
existing hosts, or click Add to create additional
hosts.

» Click the General Options entry in the left
frame to open the Basic Setup menu. Use the
Basic Setup menu to enter information about
the name and location of the Web site files, as
well as the Webmaster’s e-mail address.

» Use the Site Configuration menu to edit the
directory name list and error pages that dis-
play for the virtual host.

» Click the SSL entry in the left frame of the
Virtual Host Properties window to edit the SSL
certificate information for the virtual host. If
you choose to enable SSL certification, enter
the location of the certificates on this menu.

» Use the Logging menu to control the transfer
logs and error logs for the virtual host.

Adding a reverse DNS lookup to the error log
< shows you who generates errors, but it also
slows down your server. Gain a bit of speed by
changing the drop-down list to read No
Reverse Lookup.
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» Use the Environment Variables and
Directories menus for advanced management
of scripts and directories.

Server: Choose the Server tab on the HTTP
Configuration tool to edit user and group owner-
ship information and set the file locations for the
process ID, lock file, and core dump directory.

Performance Tuning: Choose the Performance
Tuning tab to set the number of connections
allowed to the Apache server, and the connec-
tion timeout information.

The HTTP Configuration tool manipulates variables
in the Apache configuration file. You can edit the
configuration file directly with your favorite editor,
but if you're trying to keep life simple, the HTTP
Configuration tool is about as quick as it can get.

st

The configuration file for your Apache server
is located at /etc/httpd/conf/httpd.conf.
You need superuser privileges to make
changes to this file.

We recommend that you make a copy of the
configuration file before making any changes
to the original. It's always good to have some-
thing to fall back on.



Keeping an Eye
on Vour Servers

Technique

Save Time By

v Using apachetop to
monitor your Apache
server

v~ Using the MySQL Control
Center to monitor and
maintain your MySQL
server

+~ Using mtop to audit your
MySQL statistics at the
command line

hen you expose a server to others, you need to be able to moni-
Wtor the server traffic and statistics. With good monitoring tools,

you can find the slowdowns and tailor the server’s responses to
your users’ needs.

apachetop is a handy, open-source monitoring tool designed specifically
to return information about an Apache Web server. It’s similar in nature
to top, running at the command line, and it displays statistics about your
server and the users who are visiting it. apachetop is easy to install and
use, and although it doesn’t go all out with bells and whistles, it returns a
good amount of information. You can use apachetop to monitor not only
the visitors to your server, but also your server speed as it serves up the
resources in its repertoire.

The MySQL database server is a great tool by itself, but it’s even better
with good monitoring and management tools. The MySQL Control Center
(MySQLCC) is a graphical tool that lets you monitor, test, and repair the
tables in your MySQL databases. You can also use the handy features of
the Control Center to manage database users and supervise the database
processes.

If you're working with MySQL in a nongraphical environment, mtop is a
handy tool that gathers and displays information about the traffic on
your MySQL server. It’s similar to top (and apachetop), and it’s a breeze
to use. Installation is a bit of a chore, but don’t worry — we help you
through that.

This technique is all about using the tools to monitor and improve your
servers. Whether it’s an Apache server or a MySQL server, keeping track
of the vital statistics about its operation will let you make decisions that
make your servers run faster and keep your users happy.
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Watching Your Web Server
Traffic with apachetop

apachetop is a real-time monitor for the Apache Web
server. It’s an open-source project, readily available
on the Web. Installation is quick, and it’s an easy
program to use.

With apachetop, you can see the host machine that
your visitors are using, determine whether they
came by way of a search engine, and find out what
pages they visited while they were there.

] You can also use apachetop to see if your visi-
- { -@) tors are repeatedly asking for documents that
) don’t exist. You may want to rename your Web

pages if the same page name is mistyped over
and over.

Installing apachetop

To download and install apachetop, follow these steps:

1. Open a browser window and surf to
clueful.shagged.org/apachetop

2. Click the link to download the latest stable
release. As of this writing, it’s

apachetop-0.11.tar.gz

3. When the Download Manager opens, save the
download to your home directory.

4. Open a terminal window and give yourself
superuser privileges with the su command.
5. Unpack the tarball with this command:
# tar -zxvf apachetop-0.11.tar.gz

6. Move to the apachetop directory:
# cd apachetop-0.11

7. Configure the package with the following
command:

# ./configure --with-logfile=/etc/
httpd/logs/access_log
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This command tells apachetop where to find the
Apache log file. (The Apache server distributed

with Fedora writes log files in an unusual location,
so you have to tell apachetop how to find them.)

configure checks out your system, looking for
the compilers and libraries it needs to properly
build a working program.

8. Compile the program with the following
command:

# make

9. Then copy the file into a useful place with this
command:

# make install

With apachetop installed, you're ready to run the
program and start putting it to use. See the fol-
lowing sections for details.

Running and exiting apachetop

To run apachetop, move to the /usr/local/shin
directory and enter the following command:

# ./apachetop

apachetop opens, displaying a status window that
shows your server activity (see Figure 43-1).

fd susan® localhost:/usr/local/sbin - Shell - Konsole
Session Edit View Bookmarks Settings Help
5/[a]
A
last hit: 21:40:59 atop runtime: O days, 00:03:40 21:41:04 |*|
la11: 18 reqs (  0.1/sec) 15.0k (  0.1K/sec) (  0.8K/req)
23 0 ( 0.0%) 3xx: 2 (11.1%) 4xx: 16 (88.9%) 5xx: 0 ( 0.0%)
R ( 30s): 6 regs ( 0.2/sec) 5.2k (  0.2K/sec) ( 0.9K/req)
ix'x: 0 ( 0.0%) 3xx: 0 ( 0.0%) 4xx: 6 (100.0%) 5xx: 0 ( 0.0%)
IREQS REQ/S KB KB/S URL
1 0.05 0.3 0.0%/garbanzo
1 0.06 0.3 0.0 /kidney
1 0.07 0.3 0.0 /pinto
1 0.08 0.3 0.0 /fadzuki
1 0.12 0.3 0.0 /lima
1 0.20 3.8 0.8 /
=]

¢ Figure 43-1: apachetop in action.

When you’re done using apachetop, just type g to quit,
and apachetop returns you to the command line.



Watching Your Web Server Traffic with apachetop

Navigating apachetop

The top portion of the apachetop display (refer to
Figure 43-1) shows the statistics for the server. The
lower portion of the display lists information about
specific HTTP requests. Here are some navigation
tricks that help you find your way around apachetop:

v Use the up- and down-arrow keys to move the
selection asterisk through the list of specific
requests.

v For more information about a specific request,
move the cursor to the request line and press
the right-arrow key. The request screen now
includes the host and referrer IP addresses for
the visitor, as shown in Figure 43-2.

R4 susan@localhost/ust/local/sbin - Shell - Konsole Si=1E3
Session Edit View Bookmarks Settings Help

[e=]

|

last hit: 21:44:21 atop runtime: 0 days, 00:07:01 21:44:25 |*|
All: 27 Tegs ( 0.1/sec) 20.9K ( 0.1K/sec) ( 0.8K/req)
2xx 0 ( 0.0%) 3xx: 2 ( 7.4%) 4ux: 25 (92.6%) 5xx: 0 ( 0.0%)

R ( 30s): 5 regs ( 0.2/sec) 4.9K ( 0.2k/sec) ( 1.0K/req)
23k ¢ 0 ( 0.0%) 3xx: 0 ( 0.0%) 4xx: 5 (100.0%) 5xx: 0 ( 0.0%)

REQS REQ/S KB KB/S
1 0.06 0.3 0.0 /garbanzo
HOST
1 0.06 0.3 0.0 127.0.0.1

REFERRER
1 0.06 0.3 0.0 -

]

¢ Figure 43-2: Extended information about who's visiting
your server.

v To customize the information displayed about a
specific request from a user visiting your Apache
server, type t to view the Toggle Subdisplay
menu. From here, type

» u to exclude URL information
» r to exclude or include referrer information
» h to exclude or include host information

When you're finished looking at detailed informa-
tion about a specific request, use the left-arrow
key to return to the request list.

v You can sort the information in the request list
by typing s to access the Sort By menu. From
this menu, you can choose from
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» r to sort by the number of requests made

» R to sort by the number of requests per
second

» b to sort by the size of the request in bytes

» B to sort by the number of bytes per second
transferred

] Enter #apachetop -h at the command line
e~ (@ (or type ? while apachetop is running) to see
& online help.

Switching among the log files (or watching
several at once)

By default, Apache records activity in five different
log files, which you can find in the /etc/httpd/logs
directory:

¥ access_log

¥ error_log

V¥ ssl_access_log

¥ ssl_error_log

¥ ssl_request_log
At configuration time, we told apachetop to watch

the access_1log. To view entries in one of the other
log files, use the following command:

# apachetop -f /etc/httpd/logs/filename

You can watch many log files at the same time by
appending multiple -f 7ogf7iTe options to the end of
the command line:

# apachetop -f /etc/httpd/logs/access_log
\
-f /etc/httpd/logs/error_log \
-f /etc/httpd/logs/ssl_access_log

-f /etc/httpd/logs/ssl_error_log
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Changing the display time of
apachetop statistics

By default, apachetop displays statistics for only the
previous 30 seconds. Unless you have a lot of traffic
at your server, you may want to extend the display
time to hold the information longer.

You can customize the apachetop display to
- («@ retain statistics about your server for a longer

& or shorter length of time, depending on your
needs. If you have a lot of server traffic, short-
ening the display time leaves you with easier-
to-read reports. If your server traffic is low, a
longer display time allows you to gather infor-
mation over the course of hours for the sake
of comparison and easy monitoring.

Use the following command to extend the display

time to an hour (3600 seconds):

# apachetop -T 3600

The default refresh rate for the display is 5 seconds.
If you have a lot of traffic and want the screen to
refresh more often, use the following command:

## apachetop -r 2

Now, the screen refreshes every 2 seconds. Of course,
you can combine display options on the command
line:

# apachetop -r 2 -T 3600
This command refreshes the statistics every 2 sec-

onds and displays the request activities for the pre-
vious hour.

Monitoring MySQOL Server with
the MySQL Control Center

One cool tool for monitoring and maintaining your
MySQL databases in a graphical environment is the
MySQL Control Center (MySQLCC). The MySQL
Control Center is available from the official MySQL
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Web site (www.mysql.com). The Control Center (like
MySQL) is dual-licensed — see the MySQL Web site
for licensing specifics.

Downloading and installing the
MySQL Control Center

To download and install the MySQL Control Center,
follow these steps:

1. Open a browser and surf to
www.mysql.com/downloads/mysqlcc.htm]l

2. Click the Pick a Mirror link for the Linux
(%86, glibc 2.3) download.

It’s the second link in the Linux Downloads por-
tion of the page.

3. When the Select a Mirror page opens, click an
HTTP link from a mirror close to your location.

4., When the Download Manager opens, save the
tarball to your home directory.

We're telling you to download and install
2 («& MySQLCC in your home directory for the
sake of having a consistent point of reference
for this technique. You may want to save it
elsewhere on your system. To make it easy to
run (no matter where you install it), include
the directory in your search path so you can
run it without issuing the complete pathname
every time. See Technique 7 to find out how.

5. Open a terminal window, give yourself super-
user privileges with the su command, and
unpack the tarball with the following command:

# tar -xzvf \
mysqlcc-0.9.4-Tinux-glibc23.tar.gz

6. Move into the mysqlcc-0.9.4-Tinux-glibc23
directory:

# cd mysql-0.9.4-1inux-glibc23

That’s it! MySQLCC doesn’t come with any fancy
installers; you just load the program onto your
computer and run it as we describe in the next
section.
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Accessing MySQL Control Center features

After you install the MySQL Control Center, you're
ready to take advantage of its handy tools. Here’s
how to get to them:

1. Start the Control Center with the following
command:

##./mysqglcc

The MySQLCC window and the Register Server
dialog both open (see Figure 43-3).

el MySQLCC - Register Server

General IMySQL Options I Databases | Save Options I

Mame |

Host Name I

User Mame Isusa.n

Fassword I

Port |3308 3:

Table retrieval method
’;7 SHOW TABELE STATUS

" SHOW TABLES ‘

Optiar
W Use Compression I~ Prompt for Password
[ Blocking Gueties 'l

¥ Completion and Syntas Highlighting N

Socket File | El

[¥ Make this server the Default Connection
[~ Never automatically connect to this server on startup

El B Test |

* Figure 43-3: MySQLCC's opening view.

2. On the General tab of the Register Server dia-
log, enter the name of the computer in the Host
Name field.

) If you have multiple MySQL servers running
(scattered around your network), you may
& want to enter a server name that’s meaningful
to you in the Name field to make the different

servers easy to distinguish.

3. Click Add to display the session properties
neatly in the Console Manager (see Figure 43-4).

RdMySQLCC - Console Manager

Fle Wiew Options Astion Hotkesys Help
G (@] il | & % | B
k| §

Froperty Value

Connected Mo

Date Created 2004-03-25 03:51:43
Date Modiflac 2004-03-25 08:51:43
Fields Enclosed by :

Fielcls Separated by ,

Has Syntax Highlighting anc Completion Yes

MySAL Servers

susan@ocalhostmy

Host Mame localhost

Lines Terminated by rin

Socket File varfibimysclimysol.sock
User Mame root

Using a Single Connection Ma

Using Blocking Queries No

Using Compression Ves

Using Prompt for Password Mo

Using S5L Mo

x| [ETannection soded successmuly ;i
L) root@localhost mysgl.sock] Querying My SAL Server for Database Information.
i) poot@localnost mysel.sock] Guerying MySEL Server far Table information in database: test
‘ i) foot@localhost mysel sock] Querying MySOL Server for Table information in database: myagl Zi
__\ Messages A 501 Debug S
4

¢ Figure 43-4: The Console Manager.

4. Double-click a server name in the MySQL
Servers frame to expand the tree control and
display the controls for Databases, Server
Administration, and User Administration.

5. Highlight any entry in the Server tree control
(Databases, Server Administration, or User
Administration) to display status information
about that aspect of the MySQL server.

The following sections have more details on each
of these controls.

Viewing, managing, and repairing a database
with the Databases controls

The Databases controls enable you to view your
database, and you also have tools for managing data
and fixing problems as well.

MySQLCC is a complete MySQL client application.
You can use MySQLCC to execute SQL commands
and queries, but it’s really designed to give you

a quick overview of the state of your database.
To view the statistics for databases, follow these
steps:
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1. Follow the steps in the section, “Accessing
MySQL Control Center features,” earlier in this
technique, to access the controls.

2. Highlight the Databases entry, as shown in
Figure 43-5.

Il MySQLCC - Console Manager H=1E

fle Mew Options Action HotKews Help

G| ] s | )] B
=

50k

T e
@ruot@lucalhusl:mysq\.sock Flush tables 1
Opens 108
4 Open tables 1
Queries per second avg 0.011
[ User Aiministration i
7 susan@localhost mysql.sock Slow queties o
Threacts 2
Uiptime 1 day 1 hour 48 min 28 sec

x| [/ Connection added
¥
L [root@localhost:mysal.sock] Querving My3AL Server for Database Information.

Y Messages A SQL Debug J
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[ M_vSQLCC - Console Manager EE x
Fe Miew Options dcfion Hotkeys Help
[B[E[ ] s R0 x4
—A|[fp | Tvpe bt [ ke [t
MySaL Servers T id int(11) PRI
| hroot@localhost mysgl sock — lvarchareany VES TMuL
- Databiases adeiress warchart4i) YES
[yt » city |varchartny VES | ML
- @ekblﬁ state varchar(an) VES
Bl e zip warchar(3) VES
E http_auth
[E testac
- 4§ Server Administration
[ 3 User Administration
hsusan@localhost mysal sock
4] | |
| [ Faot@iocalhest sl sooh] Lueryig My SUL Server for e wiomaten n datwoese et ]
) [root@lacalhost mysgl sock] Querying MySGL Server for Table information in database: mysd|
i) root@lacalhost mysl sock] Querying MySGL Server for Database Information
1) root@iosalhostmysql sock] Guerying MySaL Server for Table information in database: test El
\ Messages A SQL Debug /

* Figure 43-6: A quick view of the fields within a table.

[ MySQLCC - [root@ localhost mysql.sock] Query Window

* Figure 43-5: The Databases statistics.

)

“

.'lg [root@localhost:mysel sock] Querving My SQL Server for Takle information in database: test E\eﬂ By ‘guery aotiens IHutﬁeys =]
.:I,J[rool@\ocaihost 5ol sock] Querying My SAL Server for Tahle information in database: mysgl j ”@ =~ | L (K E | é“l" | Lo | '% E“” Slll’i |j ” ! & ‘ i ‘ iﬂ ?’l
g | # rame | sddress |2ty | state —
A 7 T Traewars 200 Briack: Strest | Beltavils WD Columns
2 2 Franklin Books 1157 Literary Awe. | Seaille W 3*:”’555
b ci
my
name
state
3. Click the tree control next to the Databases @
folder to display the databases on the server.
Click the tree control next to the Tables entry A | N
to view the tables in the database. et |
£ dJ2rows in set (0.02) sec
Highlight a table name to view the fields within
that table (see Figure 43-6). s £t s
. | |
Double-click the table name to see the data <

o

within that table.

The table data is displayed, as shown in
Figure 43-7.

You can adjust the number of rows displayed,
but by default, MySQLCC displays the first
1,000 rows. To adjust the default row limit,
highlight the server (in the left-most pane),
click the Edit button (in the toolbar), then
choose MySQL Options and type a row count
into the limit field.

* Figure 43-7: Table data displayed with the Control Center.

The Databases controls include some handy tools to
help you manage and repair your MySQL database:

1. Highlight Tables in the tree control and then
choose Action=>Tools to open the drop-down
menu (see Figure 43-8).

2. Choose an option from the Tools menu. Here
are your choices:
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» Analyze Table: This tool updates the data sta-

tistics used by the MySQL optimizer. Run this mww ; -ox

when you’ve made significant changes to the tese =
data in your tables.

_auth 90000 5310000 2004-03-25 10:15:41  MyISAM
1 20 2004-03-25 10:16:53  MylSAM

» Check Table: This tool checks the table for
errors. If you get an error message that you

don’t understand, run Check Table to look for (il I w—w—J ]
possible problems. A
1B server Administration
» Repair Table: This tool repairs the table. AU seinsrston
Choose this tool if Check Table reports any I
errors. i i
zj [& rootigdocalhost mysdgl sock] Uuerying Wy STIL Server for %IETﬂﬁrnTaﬁﬁﬁlﬁi{iﬁi'1§s—|’7a

i) jroot@iocalhost mysgl.sock] Guerying MySGL Server for Tale information in dataisase: mysel
1) root@iocalhostmysdl.sock] uerying MySQL Server for Datakase Information.
| ) Froct@iocaihostmysal sock] Querying MySQL Server for Table information in datekase: test z‘

\ Messages A 501 Debug [

» Optimize Table: This tool reclaims free space
and rebuilds indexes to increase performance.

» Show Create: This tool displays the Create -
Table and Create Index statements that cre- * Figure 43-9: Choose a table from the list.

ated the table.
(o e e T T e T — | % It's a good idea to analyze, check, and opti-

File Vew Dption:

SR L mize your MySQL tables on a regular basis to
% keep them in top form (database performance
WEaL e T reiE: o e tends to degrade over time and the analyze
[root@saestm 4 Beftwh  opfiniesTade 000 2004-00-25 101541 wylsaM and optimize tools can give you a quick speed
; R R P =005 101655 [y boost). If the Check Table tool reports any

Comment

Show Create
errors, use the Repair Table tool to correct the
& customer problem.
[ http_auth
o ] testas
3 Server Adminiztration . . . .
g siitaton Putting the Server Administration
[k susan@localhost mysol sock
controls to work
| | 2
T T T ey s ety S Sever o T e o] Follow these steps to begin working with the Server
i s Administration controls:
L) poot@localhostmyse) sack] Querying MySQL Server for Table information in database: test j
IR Messages A SOL Debug
A 1. Follow the steps in the section, “Accessing
« Figure 43-8: The tools included with MySQLCC. MySQL Control Center features,” earlier in this
technique, to find the Server Administration
controls.
After you select the tool that you want to run, a
pop-up window opens, displaying the tables in 2. Double-click the Server Administration entry
your database (see Figure 43-9). on the tree control to open the Administration
Panel.
3. Choose the table you want the tool to act on and
then click the Action button (for the Analyze The panel has three tab controls. Table 43-1
Table tool, it’s labeled Analyze, for the Check gives you a quick look at what each tab has to

Table tool, it’s labeled Check, and so on). offer.
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q ping y

TaBLE 43-1: Using THE MYSQL ControL CENTER SERVER ADMINISTRATION TOOLS
Tab What It Does Timesaving Bonus Info

Process List Displays a list of the MySQL  Click the clock icon at the right end of the toolbar to turn the auto-refresh
client sessions option on and off. With auto-refresh on, the Process List tab displays the on-
going activities on your server (see Figure 43-10). If a process in the Process
List is running slow, you can use the MySQL Control Center to kill it off.
Check the box in the ID column to the left of the session and choose
Action>Kill Process.

Status Displays statistical The values shown in the Status tab give you a detailed look at how your
information about the server MySQL server is being used. You can see the number of client connections,
number of queries executed, as well as a count of how many times each
MySQL command has been executed since your server booted.

Variables Displays configuration The Variables tab shows you each MySQL configuration parameter and its
information for the server information for the servercurrent value.

b M_VSQ_LC_E—[rool@Iucalhosl:mvsql.sn:k] Administration Panel 2 Right_click User Administration and choose
Hie View Action Hotleys .
FRE RG] -0 New User from the pop-up menu.
S Process List | i Btatus | Variabies |
o [user [vost [ [ Conmma [Tme [otete [nfo L The Add User dialog opens, as shown in
™ B2 [susan localhost | [NULL]  Slesp 3596 [MULL S .
| |root localhost myscl  Sleep 267, |MULL Flgure 43_1 1
I 2% root  locahost | [NULL] Guery 0/ [NULL] | SHOW FULL PROCESSLIST
I~ 9% |susan locahost test | Cuery 7 Whiting 1/ select * from hitp_auth,custarr
Usernamel Ao accessta
Host I
Passwordl s g msal
2 [ Refresh susssssful — Privileges Lig @t%t
i) Refresh successtul I A&l Privileges
|\ Messages —
&]

B et e s B R L e e e e b e e

‘ J i root@iocalhostmysal.sock] Guerying My SEL Server for Datebase Information
[ ‘]

1) oot @localhostmysel sock] Guerying MySL Server for Table information in cltabase: test j

Y Messages A 501 Debug [/

* Figure 43-10: Live monitoring of activity on the MySQL
server.

[T With GRAMT option

Adding a new user
g b ] | L] I Close

Here’s how to add a new user with the MySQL Control

Center: * Figure 43-11: The Add User dialog.
1. Follow the steps in the section, “Accessing 3. Fill in the dialog and then click the Add button
MySQL Control Center features,” earlier in this to add your new user.

technique, to get to the User Administration
controls.



If you use MySQL, the MySQL Control Center is a
handy tool to add to your collection. Check it out!

Watching Your MySOL Traffic
with mtop

MySQLCC is a great monitoring tool if you're running
in a graphical environment, but if you keep your
servers and data in a non-GUI environment, use mtop.
mtop is a handy command line tool that lets you watch
your database traffic and transactions. You can also
use mtop to help find and debug slow queries.

-3 days, but you can save money and improve
performance by keeping your MySQL servers

in a nongraphical environment.

z Graphical tools are available everywhere nowa-
-

&

Gathering all the packages that mtop needs

You need a number of prerequisite packages to run
mtop. Obviously, you need to be running MySQL. You
also need the mysq1-devel RPM package that goes
with the MySQL version you’re running. Both are
included on the Fedora and SuSE distributions and
can be added with either the Package Manager or as
RPM packages from a distribution disc. If you're a
Mandrake user, you’ll have to find the mysq1-devel
package on the Web.

You need to download and install a few Perl modules
before you can install mtop. The easiest way to install
Perl modules is to use the CPAN (Comprehensive Perl
Archive Network) interface. CPAN retrieves Perl mod-
ules and installs them on your system automatically.

You need to have Internet access for the
machine you're using CPAN with.
To install Perl modules with CPAN, follow these steps:

1. Open a terminal window, give yourself super-
user privileges with the su command, and enter
the following command:

# perl -MCPAN -e 'install DBI'
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2. When you’re asked if you're ready for manual
configuration, type no and press Enter.

CPAN continues to work, retrieving the Perl DBI
modules. Depending on your system and connec-
tion speed, this could take a few minutes.

3. Enter the following command:
## perl -MCPAN -e 'install DBD::mysql’

If you have trouble installing the DBD: :mysq]
module, be sure you've installed the mysq1 -
devel RPM package. DBD: :mysql won't
install without it.

@
B><<@
é

4. Enter the following command:
$ perl -MCPAN -e '"install Getopt::Long'

5. Enter this command:
$ perl -MCPAN -e 'install Net::Domain'

The last Perl module that you need is Curses. At the
time we’re writing this, the Curses module available
from CPAN fails to install on Fedora (and possibly
other distributions as well). To install Curses, follow
these steps:

1. Open a Web browser and surf to

bastille-linux.org/perl-rpm-chart.html

2. Click the most recent link to download per1-
Curses (Text/Console).

Currently, that version is for Red Hat 9; it works
fine with Fedora.

w

Save the RPM package to your home directory.

)

Open a terminal window and give yourself
superuser privileges with the su command.

“

Move to your home directory.

o

Install the per1-Curses RPM package with the
following command:

# rpm -Uhv perl-Curses-1.06-219.1586.rpm

Now that the program dependencies are in place,
you'’re ready to download and install mtop, as
described in the next section.
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Installing mtop

To install mtop, follow these steps:

1. Open your favorite Web browser and navigate to

sourceforge.net/projects/mtop/

Scroll down and click the download link for the
most recent mtop release.

N

w

When the download page opens, click the link
to download the most recent tarball.

)

On the mirror page, click the link for the down-
load site nearest you.

Save the file to your home directory.

o &

Open a terminal window and give yourself
superuser privileges with the su command.

Extract the contents of the tarball with the fol-
lowing command:

N

# tar -xzvf mtop-0.6.4.tar.gz

8. Move into the mtop directory:
# cd mtop-0.6.4

9. Now you’re ready to compile mtop. Enter these
commands:

# perl Makefile.PL
# make
# make install

mtop is now installed in /usr/local/bin and is
ready to use!
Monitoring traffic

mtop is a MySQL client application so you must pro-
vide a MySQL user name when you run mtop. To start
mtop, use the following command:

$ ./mtop --dbuser=root

You can substitute any reasonably privileged
user for root in our example.

Technique 43: Keeping an Eye on Your Servers

When you press Enter, the mtop display opens,
showing the activity on your MySQL server (see
Figure 43-12).

R 5usan € localho st~/ miop-0.6.4 - Shell - Konsole
Session Edt View Bookmarks Seftings Help

&/al

¢ Figure 43-12: mtop monitoring a MySQL Server.

Across the top of the display, you see the vital statis-
tics on your MySQL server and its activity. The load
average, the length of time that the server has been
running, and performance indicators are all included
in the statistical information.

Type ? while mtop is running to display a list of com-
mand options. Here are some of the more useful
options:

v z: Type z and enter a process ID from the
process list to zoom in on a process.

v e:Type e and enter a process ID from the
process list to display the optimizer plan for the
query that is executing.

v s: Type s and enter the number of seconds
between screen refreshing.

v u: Type u and enter a user name to display only
the server transactions for the named user.

v q: Type q to quit.
If a given query runs for a while, the color progresses

from white to purple, yellow, and red to indicate the
length of time the query has run. You can use the k



option to kill off unwanted or runaway processes.
Type k, type the process ID, and press Enter to ter-
minate the process (see Figure 43-13).

) If you're running MySQL servers in a non-
S (@ graphical environment, mtop is a definite time-
& saver. Getting acquainted with its features can
help you monitor and manage your server
with just a few keystrokes.

Enter $§ ./mtop --help at the command line
to display a list of command line options to
use at startup.
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bl 5usan & localhosc~/miop-0.6.4 - Shell - Kensole -0x
Session Edt View Bookmarks Seftings Help

Ir

* Figure 43-13: mtop killing off an unwanted process.



Making a MySQOL
Server Vour SOL

Technique  Setver

Save Time By

1~ Setting up replication on
your MySQL servers

v~ Backing up MySQL data
with mysq1dump

+* Using file system tools to
back up MySQL data

v~ Taking care of business
with MySQL
Administrator

uted with most Linux systems. You can use MySQL to store busi-
ness records, baseball scores, user account information, network
configurations, and just about anything.

MySQL is a fast, powerful, reliable, low-cost database that’s distrib-

MySQL is very flexible. One of the hallmarks of MySQL is that when it
comes to performance, you don’t pay for features that you don’t need.
When you store data in a MySQL database, you can choose from a variety
of storage engines. If you don’t need the extra reliability offered by secure
transactions, you gain extra performance (and reduce multiuser con-
tention) by using nontransactional tables. If the data that you're storing
just has to be right (maybe you’re storing payroll information or cus-
tomers’ credit card numbers), use InnoDB tables. They offer ACID (that
is, safe) transactions in exchange for a bit of performance.

We don’t have enough room to give you a complete overview of MySQL
(we recommend Paul Dubois’s wonderful book, MySQL [New Riders/
Sams Publishing]), so we give you a few tips that can make MySQL your
database. In this technique, we cover these topics:

v Installing MySQL the easy way. The MySQL team has turned a com-
plex procedure into a simple two-step process.

v Pushing your data to remote offices (or just spreading a heavy user
load across multiple servers) with MySQL’s replication features.

v Keeping your data safe by archiving it with MySQL-specific tools or
file system backup tools.

v Using the up-and-coming tool MySQL Administrator. MySQL
Administrator is an enterprise-level control center written by the
MySQL team. It’s designed for MySQL version 4 (and above), but many
features work with older servers.



The MySQL software is distributed under a
dual licensing scheme. If you're not redistribut-
ing MySQL as part of a closed-source pack-

age, you can use MySQL under the terms of
the GNU General Public License. If you are
redistributing MySQL as part of a proprietary
software package, or you want warranty sup-
port from MySQL AB, you have to purchase a
license. We're not attorneys, so please see the
MySQL Web site (www.mysq1.com) for the
official license policies.

Building a MySQOL Server

If you've slogged through the installation instructions
at the MySQL Web site, you’ll be happy to know that
creating a MySQL server on Linux is surprisingly
easy. The MySQL team has followed all the instruc-
tions on your behalf and wrapped everything up in a
tidy RPM package that does all the dirty work for you.

Installing the necessary packages

To create a MySQL server on your computer, use
your distribution’s installer to install the MySQL

server, MySQL client, and all necessary dependencies.

If you're a Mandrake user, use Rpmdrake and select
Server=>Database=>Other>MySQL. Rpmdrake auto-
matically installs the MySQL client and a whole slew
of dependencies for you.

If you're a Fedora user, use Add/Remove Packages
and scroll down to the Servers section. Click the
Details link next to SQL Database Server and choose
MySQL-server. Fedora automatically resolves all
dependencies and installs the MySQL client software
for you.

SuSE fans should use YaST2 to install MySQL. You’ll
find MySQL in Productivity=>Databases=>Servers.
Like the Fedora and Mandrake installers, YaST2
will install the MySQL client software and any
dependencies.
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Starting the MySQL server

Before you can use MySQL, you need to start the
MySQL server:

1. Open the Main Menu and choose System->
Services (or, if you’re using GNOME, choose
System Settings—>Server Settings->Services).

N

Enter the root password if prompted.

w

Scroll through the list of services (in the left-
most column) and find the service named
mysqld.

4. Check the box to the left of mysq1d and then
click Save (on the toolbar).

5. Click Start (also on the toolbar).

A message appears confirming that the mysq1d
service started successfully.

6. Click OK and close the Service Configuration
window.

You must hold superuser privileges to start the
MySQL server. Open a terminal window and give
yourself the required privileges with the su -
command.

To start the MySQL server on a Mandrake system,
type in the following command:

# /etc/init.d/mysql start

On a SuSE computer, use this command:

# /usr/sbin/rcmysql start

If you're running Fedora, use the following command:

# /etc/init.d/mysqld start
MySQL is up and running. The first time you start

the MySQL server, it creates the server environment
and an empty database named test.

The data files for your MySQL database are
stored in the /var/1ib/mysql directory.
For convenience, we refer to that directory

as $MYSQL.
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] If you plan to use MySQL in your daily work,
- (4& it's a good idea to configure your system to
) start the MySQL server each time you boot

your computer: See Technique 20 for the
details. Just remember, the MySQL service is
named mysql on SUSE and Mandrake sys-
tems, and mysq1d if you're running Fedora.

After you start the server for the first time, create a
MySQL password for the root user:

1. Open a terminal window and give yourself
superuser privileges:
$ su -
Password:

2. Type in the following command (substituting
your desired password for new-password):
# mysgladmin -u root password new-
password

Now you're ready to use your MySQL server. If
you're already comfortable with MySQL, we give you
a few more timesaving tips in the rest of this chapter.
If not, it’s time to hit the books. You can find a wide
variety of books on MySQL in your local book store
(or at a bookseller online), but we happen to think
that MySQL [New Riders/Sams Publishing] by Paul
Dubois is one of the best.

Replicating MySOL Data

MySQL supports data replication. When you config-
ure replication, MySQL automatically forwards data
modifications (INSERTs, UPDATEs, and DELETES) from
one MySQL server to another. If you have a geo-
graphically distributed organization, MySQL can
automatically push data from your central database
out to your branch offices. Changes that you make
to the master database appear almost instantly in
each of the remote servers.

Replication offers three important benefits:

v It improves the overall reliability of your data-
base. If the master database becomes unavail-
able for some reason (hardware problems, a

Technique 44: Making a MySOL Server Your SOL Server

system crash, or normal maintenance), a slave
database can take over.

v It improves the overall performance of your
database. Create a replication slave on a sepa-
rate computer, and you've spread the user load
onto two systems. MySQL's replication architec-
ture makes it easy to configure as many slave
servers as you need.

v It improves availability while you’re backing
up your data. Because the slave servers contain
the same data as the master, you can take a slave
offline and archive the data from there instead of
from the master server.

Configuring replication: The three topologies

Different database vendors offer different replication
topologies (the topology of a replication system
describes which servers push data to other servers).
MySQL supports three basic topologies:

v Single-master/single-slave
v Single-master/multiple-slave

v Single-master/chained-slaves

The single-master/single-slave topology is easiest
to understand. One server acts as the replication
master. When you change a table in the master, the
modification is pushed to another server, called the
replication slave.

A single replication master can push data to multiple
slave servers. That’s a single-master/multiple-slave
topology.

A replication slave can push changes (which it
receives from the replication master) to another slave,
resulting in a single-master/chained-slaves topology.

Replication data always flows in one direction:
from the master to the slave. The replication
master records all data modifications to a

binary (that is, not human-readable) log file.
When a replication slave connects to the mas-
ter, it reads the log file and applies all the
changes to its own copy of the data.



That means that you should never change the
data on a replication slave. If you do change
data on a slave, the master and slave servers
get out of synch, and you may lose data. When
you create a slave, you start with a copy of the
data as it exists on the master.

MySQL lets you choose which tables you want to
replicate (you don’t have to replicate all the tables in
a database). That means that a single server can act
as both a master and a slave, as long as it’s a master
for some tables and a slave for others.

Setting up replication for a single slave
and master

Creating a single-slave/single-master topology is easy,
but you have to do a bit of work on both the master
and slave servers, as outlined in the following steps:

1.

Log in to your MySQL server on the replication
master:
# mysql
Welcome to the MySQL monitor. Command
end with ; or \g.
Your MySQL connection id is 5 to server
version 3.23.58

Type 'help;' or '\h' for help.
Type '\c' to clear the buffer.

mysql>

Create a new MySQL user account — the repli-
cation slave will log into the replication master
using this account:

mysql> GRANT FILE ON *.* TO 'repl_sTave'
IDENTIFIED BY 'repl_pass';
Query 0K, 0 rows affected (0.13 sec)

Exit MySQL and shut down the server:

mysql> quit
# service mysqld stop

Create a backup of all the databases that you
want to replicate:

## cd /var/1ib/mysql

# 1s

8.
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mysql prod devel

# tar -zcvf data.tgz prod devel
prod/

prod/cust.frm

prod/cust.MYI

prod/cust.MYD

Copy the archive (data.tgz) to the replication
slave:

# scp data.tgz slave:/tmp/data.tgz
test.tgz 100% 108.0KB/s 00:05

Edit the /etc/my.cnf file and find the section
that starts with

[mysqgld]
datadir=/var/lib/mysql
socket=/var/1ib/mysql/mysql.sock

Add the following lines to the end of that section:
log-bin

server-id =1

Restart the master server:

# service mysqld start

On the replication slave(s), follow these steps:

1.

2.

Shut down the MySQL server:
# service mysqld stop

Edit the /etc/my.cnf file and find the section
that starts with

[mysqld]

datadir=/var/lib/mysql
socket=/var/1ib/mysql/mysql.sock

Add the following text to the end of that section:

master-host = master-hostname
master-user = repl_slave
master-password = repl_pass
server-id =2

Unpack the archive you made on the server:
## cd /var/1ib/mysql
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Choosing a Method to Back Up
MySOL Data

Archiving (or backing up) the data in a MySQL data-
base can be a bit tricky. The archive method that
you choose is primarily influenced by three factors:

v Database availability (hot-backup or shutdown)
v Table type (MyISAM, InnoDB, and so on)

v Archive size

If your database must be online 24/7, you must use a
hot-backup technique. If you can afford to take your
MySQL server down for a while, you can use a file-
system backup technique.

If you can take your server offline, you can use normal
filesystem backup tools (like tar). If you need to use a
hot-backup technique, you can use mysqlhotcopy or
mysqldump. Or, for the ultimate in availability, use repli-
cation to archive your data. We explain how each of
these backup tools works in the sections that follow.

Backing Up and Restoring
with mysqldump

To back up a table using mysq1dump, follow these steps:

1. Open a terminal window.

2. Execute the following command:
$ mysqgldump database > backup.sql

Replace database with the name of the database
that you want to archive.

3. Copy the resulting file (backup.sql) to CD (or
tape) or move it to a different host to safeguard
the data.

Technique 44: Making a MySOL Server Your SOL Server

The mysqldump program creates an archive in the
form of a series of SQL commands that will re-create
the data should you restore from the archive. As
mysqldump processes each table, it writes a CREATE
TABLE command to re-create the table and all indexes
defined for that table. Then it writes an INSERT com-
mand for each row in the table.

Listing 44-1 shows a snippet from a typical mysq1dump
archive.

LisTING 44-1: MYSQLDUMP ARCHIVE

-- Table structure for table “customer’
CREATE TABLE customer (

id int(11) NOT NULL default '0',

name varchar(40) default NULL,

address varchar(40) default NULL,

city varchar(40) default NULL,

state varchar(20) default NULL,

zip varchar(9) default NULL,

PRIMARY KEY (id),

KEY cc_name (name),

KEY cc_city_state (city,state)
) TYPE=MyISAM;

-- Dumping data for table “customer®

INSERT INTO customer VALUES (1,'TrixieWare',
'200 Snack Street',
'Beltsville','MD', '25525");

INSERT INTO customer VALUES (2, 'Franklin
Books','157 Literary Ave.', 'Seattle',
"WA','97745");

mysqldump backup options

The mysqldump command supports a variety of com-
mand line options, many of which affect the format
of the data in the archive itself. One particularly



handy option is --add-drop-table. This option

tells mysqldump to include a DROP TABLE command
before each CREATE TABLE command. If you don’t use
--add-drop-table, the resulting script will fail if
tablename already exists when you run the script
(which is usually the case).

You should also consider using the --a11 option.
--al1 writes all the table options (character set,
comment, row format, and so on) used when each
table was originally created. If you don’t use --al1,
you’ll lose all those table options if you restore from
an archive script. Table 44-1 lists the mysq1dump

options that affect the format of the resulting archive.

that saves all data (even the extra table
options normally saved with the --a11 flag) in
a form that’s optimized for quick restores.

g It's a good idea to use the --opt option in
e { <@ most scenarios. - -opt produces an archive
&

The --complete-insert option is useful when you
suspect that you may restructure a table between
the time you create the archive and the time you
restore from that archive.

TaBLE 44-1: mysaLbumP ARCHIVE OPTIONS

Backing Up and Restoring with mysqldump
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Backing up multiple databases

To archive all databases, add the --al1-databases
option to your command line when you create the
archive. Or you can archive a set of databases like
this:

$ mysqldump --databases dbl db2 db3

Compressing the archive

The archive produced by mysqldump can get
very big very fast. Instead of storing the raw
archive on disc, you can compress the script that
mysqldump produces by using gzip or bzip2.

Because mysqldump writes the script to its standard
output stream, you can easily pipe the script into the
standard input stream of a compression tool, like this:

$ mysqldump database | gzip > backup.sql.gz

This command archives the given database, pipes
the resulting script to gzip, and saves the com-
pressed script to backup.sql.gz.

Option Description

--all Force mysqldump to archive all table options (TYPE, COMMENT, and so on).

--complete-insert
--extended-insert
--add-drop-table
--add-Tocks
--disable-keys
--no-autocommit
--no-create-db

--quote-names

--xml
--where=where-clause

--opt

Include column names in every INSERT command.

Insert multiple rows with a single INSERT command.
Insert a DROP TABLE command before each CREATE TABLE.
Lock each table for WRITE access before inserting new rows.
Update indexes after all data has been inserted.

Restore each table in a single transaction.

Don’t write CREATE DATABASE commands to the script.

Quote all column and table names in the script. Use this option only if you’ve created a
table (or column) whose name conflicts with a reserved keyword.

Produce the archive in the form of an XML document rather than an SQL script.
Only archive rows that satisfy the where-clause.

Optimize the archive for best restore performance.
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Restoring a mysqldump archive

After you've created an archive with mysqldump, it’s
easy to restore your data if something goes wrong.
Because mysqldump created an SQL script for you, all
you have to do to recover lost data is to run the script.

For example, if you've created an archive named
backup.sql, simply feed that script back into the
mysql client, like this:

$ mysql database < backup.sql

Note that you must provide a database name if you
archived a single database.

If you back up multiple databases in the same
archive file with the --al1-databases option or the
--databases option, you don’t have to specify a data-
base when you restore (the database names are
stored in the archive).

To restore from a compressed archive, use the zcat
program to decompress the script and pipe the result
into mysql:

$ zcat backup.sql.gz | mysql database

7 If you normally back up your data to CD or
g (ﬂ

DVD, see Technique 50 for a handy way to
stream your MySQL archive directly onto a set
of one or more discs.

&

Backing Up with File
System Tools

If you can afford to take your MySQL server offline
occasionally, you can use normal Linux backup tools,
such as tar and gzip. (See Technique 50 for informa-
tion about using file system backup tools to archive
your data.)

MySQL tables are stored in normal file system data
files. If you have a MyISAM table named customer (in
a database named acctg), you see three customer-
related files in /var/1ib/mysql/acctg:
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v customer. frm: Contains the metadata for the
customer table (that is, the table, column, and
index definitions)

v customer.MYD: Contains the rows in the customer
table

¥ customer.MYI: Contains the indexes defined for
the customer table (if any)

You can back up an entire database by archiving the
files in the database directory. For example, use the

following command to create a file system backup of
the acctg database:

$ tar -zcvf acctg.tgz /var/lib/mysql/acctg

Remember to be safe and shut down your MySQL
server before you copy the table files.

If you can’t shut down your MySQL server on a regu-
lar basis, you can still use file system archive tools,
but you have to ensure that the tables that you're
backing up are not being modified at the time you
archive them.

Making a mysqlhotcopy
of Your Database

The mysqlhotcopy program creates a copy of MyISAM
table files from a running server. When mysqlhotcopy
archives a table, it acquires a READ lock on the table,
creates a copy of the table’s data files, and then
releases the READ lock. The READ lock prevents
updates but allows other users to read the table at
the same time.

To back up the acctg database using mysqlhotcopy,
use the following command:

$ mysglhotcopy acctg

The table files are copied to a directory named
/var/1ib/mysql/acct_copy. You can use a file system
archive tool to back up the copy.
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The mysqlhotcopy utility copies only MyISAM tables,
not InnoDB or BDB tables. Using mysqlhotcopy is less
intrusive than taking your database offline, but it can
slow things down if you're backing up a busy data-
base. (mysqlhotcopy has to wait for the READ lock on
all tables before it proceeds and blocks all table
modifications until it finishes.)

Archiving a Replication Slave

Another very useful alternative to mysqlhotcopy is
replication. When you replicate a database (or a table
within a database), the replication slave maintains
an exact copy of the data stored in the replication
master.

To back up your data, simply shut down the slave
and use a file system backup tool to archive the
slave database. While your slave database is offline,
users can still read and modify the master. Then
when the slave comes back online, the replication
mechanism automatically applies any changes to the
slave database. When you back up a replication slave,
you must archive the $MYSQL/master.info and
$MYSQL/relay-1og.1info files, too.

Taking Care of Business with
MySOL Administrator

MySQL Administrator is a graphical interface that
helps you manage your MySQL server. It’s a very
young tool (in fact, it’s still in alpha-release land),
complete with all the bugs you would expect from a
program at this stage of maturity. It does show a ton
of promise though, and it’s worth getting familiar
with. We think it has a great future as it grows and
develops.

The official voices at MySQL say that this tool
will not work well with the release-3 servers —
but only a few of the features don’t work.

Fedora is currently distributed with release-3
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servers but should be stepping up to release-4
servers any day now. SUSE and Mandrake ship
with MySQL release 4.

You can run release-4 MySQL servers on Fedora, but
they’re not standard issue. However, they should
become standard equipment soon.

This is alpha-release software. It seems pretty
stable, but it shouldn’t be used in a production
environment yet (that is, with really, really

important data). It's a good product to get
familiar with though — just keep lots of back-
ups of any data dear to your heart or business.

Installing MySQL Administrator
To install MySQL Administrator, follow these steps:

1. Open a browser window and surf to

www.mysql.com/downloads/

2. Scroll down the page to the Graphical Clients
section and click the MySQL Administrator link.

3. Scroll down the MySQL Administrator page and
click the Pick a Mirror link next to the Linux
download labeled Linux (x86, glibc 2.3,
stripped).

The nonstripped version contains debug infor-
mation and other stuff you most likely don’t
need, and it will just slow down the download.

4. Scroll through the mirror sites to find a down-
load location geographically near you. Click
the HTTP link to start the download.

5. Save the download to your home directory
(or /tmp — you won’t need the tarball after
you’ve installed it).

6. Close the download manager and the browser.

7. Open a terminal window and give yourself
superuser privileges with the su command.
8. Unpack the tarball with the following command:

# tar -C / -zxvf mysql-administrator-
1.0.2b-alpha-linux-stripped.tar.gz
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The installation instructions on the MySQL
Administrator Web page are wrong at the
time we’re writing this. If you've downloaded

version 1.0.2b-alpha, use the preceding com-
mand to install the program in the correct
location.

Starting MySQL Administrator

After you install MySQL Administrator, you're ready
to start the program and begin using its tools. To
start the program, follow these steps:

1. Move to the directory containing the program:
# cd /opt/mysql-administrator/bin

2. Start the program with the following command:

# ./mysql-administrator

] Add /opt/mysql-administrator/bin to your
- { <@ shell's search $PATH, and you'll be able to start
& the program from anywhere on your system
with just the program name. See Technique 7

for details about updating $PATH.

The MySQL Administrator connection dialog
opens, as shown in Figure 44-1.

E2MySoL Administrator s

Connect to MySQL Server Instance

['—g Connection: v|

Username:
Passwaord:
Hostname:
Part: 3306 2
‘Qetails SN ‘ # Cancel ‘ | Clear ‘ ‘ o Connect

¢ Figure 44-1: The MySQL Administrator connection
dialog.
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3. Enter the connection information for your
MySQL server — a user name, password,
and host name — and then click the Connect
button.

The MySQL Administrator window opens to the
Server Information page, displaying information
about the connection, the server version, and
the client (see Figure 44-2).

MySCL Version  MySL 4.8 18 standandiog
st ahast ls¢ siderman

3 Aesi

! Catilon Version
1P 1
Opesating System: Linox 2.4 220 2115 red
e Fersiurn Il Diesehutes) 210 51 Midz. 113 MB RAM

MySOL Ciens Weersian 50008, Prosscol 10
lecahant lscaldoman

L J
¢ Figure 44-2: The MySQL Administrator opening window.

Exploring MySQL Administrator's tools

The panel on the left side of the MySQL
Administrator window contains menu names for the
different features that MySQL Administrator can
help control. Highlight a menu name to view (and
change) a set of features. Here’s an overview of the
tools you'll find:

v Service Control: Click Service Control in the
menu panel to open the Service Control menu.
From this menu, you can monitor the startup log
messages. You can also start and stop the server
by clicking the Stop the Server (or Start the
Server) button.

v Startup Variables: Click Startup Variables to
change the configuration parameters for your
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MySQL server. The Startup Variables menu has a
series of tab controls that group the configura-
tion parameters into manageable chunks, as
shown in Figure 44-3.

) et Paramers
Thes page coreams gueeral parameters fot the MySCL bevver
henwarhing
Dinalie sermaking  (lon) aow comnections via TEPAP
Data drecaary d Path 18 the database sset
Memary usage
Kcting i Jovcsmy eré' =
Section mysod % Drucand Chasgen || o Mgy Chimges

* Figure 44-3: The Startup Variables menu.

With the tabs on this menu, you can adjust many
configuration parameters, including the following:

» General Parameters: On this tab, check the
Disable Networking box to restrict access to
your MySQL server to those clients on the
same machine as the server.

» Log Files: On this tab, click the Slow Queries
Log box to generate a log file that displays
“slow” queries. If you find that performance is
lagging, this tells you which queries are con-
suming the most resources.

» Security: On this tab, check the Make All
Tables Read-Only box for your replication
slave servers. You shouldn’t modify replicated
tables from slave servers.

Check out all the tabs and the options they
include to find new ways to customize and opti-
mize your MySQL server.

v User Administration: Click User Administration in
the menu listing to open the User Administration
menu. MySQL user accounts are listed in the
lower-left frame of the window, as shown in
Figure 44-4.
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User Infaem, ahan Sehema Fmd-w\‘ﬂnmn(uvix
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The isser's Il narme
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¢ Figure 44-4: The User Administration menu.

To create a new MySQL user account, click the
New User button. Complete the user information
and then click Apply Changes. Use the Schema
Privileges and Resource Limits tabs to view

(or modify) user privileges.

- than version 4.0, you'll get an error message
when you modify user information. Ignore the
message and consider upgrading to a more

recent version of MySQL.

z If you're running a version of MySQL younger
-

é

v Server Connections: Click Server Connections to
view all active connections and see what users
are up to. The User Connections tab displays a
detailed list of user sessions. Highlight a user
name to display the active threads for that user,
as shown in Figure 44-5.

you can kill them off on the User Connections
tab with the Kill Thread button, or terminate
all threads for a single user with the Kill User
button. Just highlight the thread or user name
and click the appropriate button.

2 If you have runaway (or really slow) queries,
<}

&

v Health: Click Health in the left panel to access
graphs of performance and server statistics for
your MySQL server. The Health menu opens, dis-
playing a trio of Connection Health graphs, as
shown in Figure 44-6.
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* Figure 44-5: User and thread information on the User
Connections tab.
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¢ Figure 44-6: Server Health graphs.

Every MySQL server maintains a set of status
variables that track performance and usage sta-
tistics. Click the Status Variables tab to see the
server status variables. Highlight a group in the
Status Variables column to view the variables
within that group, as shown in Figure 44-7.

Click the Server Variables tab to view the config-
uration parameters for your server. Highlight a
group in the Server Variables column to see the
configuration parameters in that group, as
shown in Figure 44-8.
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¢ Figure 44-7: Status variables for a MySQL server.

v Server Logs: Click Server Logs in the menu panel
to open the log viewer (the log viewer does not
appear to work with a version-3 MySQL server).
This feature needs a bit of help right now, but
we're sure the problems will be worked out.

R My S0 Adminisiraier ool locatho il ik socked

Commection Heash | Memery Hesth] Sesmsn Varislen | Server Vanisties

# Serves Vanabies

]

L |

* Figure 44-8: Configuration parameters for the MySQL
server.

v Backup: The Backup menu lets you create (and
execute) backup profiles. With this menu, you
can define jobs that archive all or part of your
server data. Click the New Profile button and
enter a name for the backup profile in the Project
Name field. Highlight a database name in the
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Databases column and click the right-arrow but-
ton to include that database in the Backup
Content pane. Expand the database into a tree
control form by clicking the arrow next to the
database name. Check the boxes next to each
table name to include (or uncheck the boxes to
exclude) the tables in the backup (see Figure 44-9).

R My S0 Adminisiraier ool locatho il ik socked

Bl Ede iew e

Wackisp Proyect | Advanced Opsems
¢ Mackup Project
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W ietac  MyISAM 1 20040325 141655

Bachup Profaes
row b [
<
G o Prosite || [ impest Pratie lSove Projees || (3 St Bacism

* Figure 44-9: Creating a new backup profile.

When your profile is complete, click the Save
Project button. To run the backup, click the Start
Backup button.

In this technique, we’ve given you other,
dependable ways to back up. They're not
graphical, but dependability counts when

you're making backups. Until this product
matures a bit, we recommend sticking to tried
and true backups for data you treasure.

v Restore Backup: The Restore Backup menu
selection opens a dialog designed to restore from
archives created with the Backup menu. For now,
we recommend that you use more dependable
methods to back up and restore.

v Replication Status: The Replication Status menu
selection opens a dialog displaying information
about the state of your replication topology. (We
cover MySQL replication features earlier in this
technique.)
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v Catalogs: The Catalogs menu selection displays
information about the databases and tables
defined on your MySQL server.

] The creators of MySQL Administrator are a bit
B (@ loose with their labels. The Catalogs and

& Schemata labels both refer to what are nor-
mally called databases.

Highlight a database name in the Schemata
frame to see the tables stored in that database.
Highlight a table name in the top panel to display
the columns within that table, as shown in

Figure 44-10.

Use the tab controls in the lower panel to view
information about the Columns, Indices, Table
Status, and Row Status.
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* Figure 44-10: Table information displayed with MySQL

Administrator.
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MySQL Administrator should grow up to be a
nifty timesaving tool. If you're just starting to
use MySQL, you may want to avoid the frus-
tration (and slowdowns) caused by the bugs
and skip the installation of the version distrib-
uted with Fedora (3.x). You can download

the RPM packages that you need to install
MySQL version 4.0 or better from www .
mysql.com/downloads.



Safequarding Your
Apache Server with

Technigiie SSL Certificates

Save Time By

v~ Generating your own SSL
certificate

v~ Signing your own SSL
certificates for private
use

v~ Vliewing the CAs that your
browser currently trusts

visiting your Web site that you are who you say you are. OpenSSL is

a Linux software package that implements the SSL protocol. If you're
running a Web server that handles financial transactions or sensitive
documents, an SSL certificate tells your customers or colleagues that
their information is really in your hands, and not in the hands of some
troll who has intercepted the transaction.

SSL (Secure Sockets Layer) is a security protocol that assures users

To use SSL security at your Web site, you need a signed SSL certificate.
Your Web server (typically Apache) sends your certificate whenever a
browser requests a secure connection. You can purchase a signature from
a trusted authority, or you can obtain a signature from an intermediate
authority to generate a certificate that’s part of a chain of trust. In a chain
of trust, a high-level certification authority entrusts an intermediary who in
turn signs your certificate, guaranteeing that you're reputable.

You can also sign your own certificates by becoming your own certificate
authority without a chain of trust. Your certificate may not convey enough
trust for consumers to send in their credit card numbers, but within a cir-
cle of colleagues, having an active certificate is an assurance that their
transactions are being handled with respect.

In this technique, we explain the trust levels associated with each type of
certificate. We also show you how to request a signed certificate from a
trusted certificate authority, how to create a self-signed certificate that
you can use to test your Web server configuration, and how to create your
own certificate authority. You'll save time and assure your colleagues and
customers that they really are in contact with your computer and not an
interceptor.

Understanding the Basics
of How Certificates Work

In geek-speak, a certificate is a document that proves your identity.
Certificates are like passports in that they contain information about



your identity. A passport contains your name, birth
date, and birthplace. An SSL certificate contains your
name, location (country, state/province, and city),
organization name, and e-mail address.

Passports (and SSL certificates) also provide some
method for ensuring that your identity is correct.
Your passport contains a photograph that someone
can compare with your face. An SSL certificate con-
tains the public half of a public/private key pair.

A passport also contains safeguards against forgery:
Every passport contains a watermark, and many
governments will soon issue passports that contain
holograms (which are very difficult to forge). Like-
wise, an SSL certificate is digitally signed with the
issuer’s private key, and any tampering makes the
digital signature invalid.

Passports and SSL certificates share another impor-
tant characteristic: They’re both issued by trusted
third parties. A border authority isn’t likely to trust a
passport that you've issued to yourself. Instead, a
passport office (the U.S. State Department, for exam-
ple) verifies your identity and issues a passport.
Foreign governments trust that the passport office
has done a thorough job investigating your identity.
SSL certificates work the same way.

Choosing an SSL Certificate

To obtain an SSL certificate, you send a request
(called a certificate signing request, or CSR), along
with proof of your identity, to a trusted authority.
The trusted authority (also known as a certification
authority, or CA) compares your request to the proof
of identity that you provide, and if it’s satisfied that
you are who you claim to be, it issues you a certifi-
cate. The certificate that you receive is signed with
the issuer’s private key — you can verify the signa-
ture by using the issuer’s public key.

You can get three different types of SSL certificate,
and each provides a different level of trust:

341

Creating a Certificate Signing Request

v A self-signed certificate is untrustworthy (but
useful for testing).

v A certificate signed by a local CA (a CA that you
create and manage yourself) can be trusted by
your peers.

v A certificate signed by a well-known CA can be
trusted by outside parties (that is, customers).

Obtaining a signed certificate costs money. The CA
assumes the work of verifying your identity and main-
taining a database of valid certificates. A number of
companies are in the certification business, and two
of the best known are VeriSign (www.verisign.com)
and thawte (www.thawte.com). If you decide to go this
route, see the following section, “Creating a Certificate
Signing Request,” for details on how to get the certifi-
cate from a CA.

If you want to test out your Web site before you shell
out a few bucks to a CA, you can create a self-signed
certificate. A self-signed certificate looks and acts
like a normal certificate except for one very impor-
tant difference: You should never trust a self-signed
certificate. Trusting a self-signed certificate is like
trusting a self-issued passport. Anyone can create a
self-signed certificate, and more importantly, anyone
can forge a self-signed certificate. We explain how
this is done in the “Creating a Self-Signed Certificate”
section, later in this technique.

In some cases, you may want to act as a CA yourself.
For instance, if you head up the IT department at a
large company, you can issue certificates to in-house
Web servers without having to pay a third-party CA
for each one. You might use your in-house CA to
distribute trusted software or deliver confidential
content such as payroll information.

Creating a Certificate
Signing Request

To request a signed certificate from a CA, you must
first create a certificate signing request (or CSR). The
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CSR contains two important pieces of information:
your identity and your public key.

In an SSL certificate, the identity is called the subject
(and the CA is called the issuer). Every subject

(and every issuer) is identified by the following
information:

v Location (country, state/province, city)

v Organization (organization name and organiza-
tional unit)

v Common name (the name of your Web server, as
seen by the outside world)

v E-mail address

If you're a Fedora user, you can use the tools
installed with Apache to generate a CSR (we show
you how in a moment). If you're not using Fedora,
you have a bit more work to do: We suggest using
Webmin and Webmin'’s Certificate and Key Manage-
ment module to generate a CSR. Technique 17 shows
you how to install and use Webmin (the Certificate
and Key Management module is an add-on that you’ll
have to download separately from the www.webmin.
com Web site).

Fedora makes it easy to create a CSR (and the
public/private key pair that you need in order to
sign the CSR):

1. Open a terminal window and give yourself
superuser privileges with the su command.
2. Move to the directory /etc/httpd/conf:
# cd /etc/httpd/conf

3. Type make certreq and press Enter.

)

If you have an existing server key (it’s stored in
/etc/httpd/conf/ss1.key/server.key), you'’re
prompted for the passphrase for that key. If you
don’t have an existing server key, OpenSSL cre-
ates a new server key for you and asks for a
passphrase that will protect your private server
key from unauthorized use. In either case, type
in the passphrase and press Enter.
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The OpenSSL program now asks you a series of
questions regarding your identity.

5. Enter the two-letter code for your country.

For example, type US for United States or CA for
Canada.

6. Enter the full name (not the abbreviation) for
your state or province.

7. Enter the name of your organization (a com-
pany name, for example).

8. Enter the name of your department within the
organization. Or, if you’re requesting a certifi-
cate for your entire organization, just press
Enter.

9. Enter the name of your Web server (for exam-
ple, www.example.com). If you have (or plan to
have) multiple Web servers at your site, use a *
in place of the host name, like this: *.example.
com (you still need to include your domain
name).

It’s very important that you enter your real Web
server name here. When the CA issues a certifi-
cate, it belongs to a specific Web site. If you try
to use that certificate on a Web server with a dif-
ferent name, visitors to your Web site will be
greeted with a scary message warning of certifi-
cate forgery.

70. Enter your e-mail address.

711. Next, you're prompted for two extra pieces of
information: a challenge password and an
optional company name. Just press Enter twice
to ignore those questions.

OpenSSL saves the resulting CSR (certificate
signing request) in /etc/httpd/conf/ssl.csr/
server.csr.

If you'd like to see what’s inside the CSR in human-
readable form, use the following command:

$ openssl regq -text -in
ssl.csr/server.csr.

You see a result similar to that shown in Listing 45-1.
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Creating a Certificate Signing Request

343

Certificate Request:

Data:

Version:

Subject: C=US, ST=Virginia,

0 (0x0)

CN=www.trixieware.com/emailAddress=newdoo@trixieware.com

Subject Public Key Info:

Public Key Algorithm:
RSA Public Key:
Modulus (1024 bit):

Signature

04:
7f:
Oe:

1d
ca

61
ba

ad:
:be:
:6a:
29:
f6:

8a

4f:
:80

:e0:
167
4d:
d8:
c2:
14d:
fa:

00:
8a:
Oe:

e?

39:

32

cl:

6a

c3:

ac:
13:

51

165
2b:
:6d
al:
:01
ef:

Exponent:
Attributes:
a0:00

Algorithm: md5WithRSAEncryption

3d
:9a

a8:
2a:
34:
de:
12:

14b:
:34:
Oc:
:49:
167
f6:
10:

12
f7

be:
cf:

CERTIFICATE
MIIB3DCCAUUCAQAWGZsxCzAJBgNVBAYTATVTMQswCQYDVQQIEwJWYTETMBEGALIUE
BXMKRnJvZyBMZXZ1bDETMBEGATUEChMKVHIpeGT1V2FyZTESMBAGAIUECXMJQ292
bWIsb2d5MRswGQYDVQQDExJ3d3cudHIpeGl11d2FyZS5jb20xJDATBgkghkiGI9w0B
CQEWFW51d2Rvb0BOCm14aWV3YXJTLmNvbTCBnzANBgkghkiGOwOBAQEFAAOB jQAW
gYkCgYEArP1RtLBCgOVPf1INUZBUKE/5FgZx71aRY12g60YQ0UXdX1Se201vhUMgB
L171ZTaeZ01jiKfQVS9YqRk5K4UKwqI7ps4+oVeomXIybUBwMoYQpvAJrPTm6WTB
oNPKemEBSrA/WwOVHVhgAbnK4sjdrEKDTuQ+HfvD780owwB5vqTkCAWEAAGAAMAQG
CSqGSIb3DQEBBAUAA4GBAARNADILaSuSd/vn8aHiKiE9iX+62500nd5zAPR5bAG/
V51tCA6tTagMWvP8Q6JK/Fokx0sCVR2+2C0SSZHQ8cNhYthzTWLJI+MpqwjT3ZwI0
Xdy2N11Gx502eimKTd5e9r1SJjP1jfL9z9pLZfZP+hLPEBPXuxv3ImC5mk0gSYGA
fffff END CERTIFICATE REQUEST

69:
9c:

5a

REQUEST

fd:
fe:
277
:36:

85

:40:
d3:
:b9:
:30:

Ca

51
45
57

:0a

Cca
ca

65537

2b:
9e:
:f3:

91

:02
b9:
13:

92

52
d7

9e:

73:
fc:
:d0:
:34:

:b4:
:81
121
64:
:c2
70:
:7a
el
c0:

32

127
00:
43:
:c3:
:dc:
33:
1b:

fl
5d

126
:bb:

rsakncryption
(1024 bit)

127
ed
:al

:86:

161

:C8:
le:

:fb:
4.

az

b0:
:9c:

42

dd

6f:
(0x10001)

e’/
79

:4a

61

b6:

eb
f7

:80:
7b:
:b6:
163
:3b:
10:
:01

db

3a:
88:
a6:
a6:
:4a
rac:
a9:

:fl
:6C:
:fc:
162
36:
:8d
122

eb:
1ad:
5b:
a’:
ce:
f0:
:b0:
49:

39

:al

Oa
5a

:d8:

59

:f2
:60:

el
:bf:
124
73:
146
: fd

b9

:/f:
:23:
:50:
:55:
:al:
:ac:
:5b:
ide:

:2a:
57:

c/

95:

c7

:cf:
:9a

21:
99:
:4b:
62:
:9d:

da

:4d:

:54:
:3a:
:81:
:58:
:a8:99:
:e9:
1d:
1d:

:15:
:3e:

3d

6d:
02:
c9:
36:
:4b:
20:

64:
dl:
Ze:
a9:

:89:
08:
55:
f8:
7a:
65:
49:

L=Anytown, 0=TrixieWare, OU=Cosmology,

You can see that the certificate contains all the infor-

mation that you entered. The CSR is digitally signed

with your private key; the CA verifies the signature
by using the public key included in the CSR.

Send the CSR (/etc/httpd/conf/ssl.csr/server.csr)
to the certification authority that you've selected,
along with the proof-of-identity documents that it
requires.
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When you receive the final certificate, simply copy it
to /etc/httpd/conf/ssl.crt/server.crt and restart
your Apache server.

Creating a Self-Signed
Certificate

Creating a self-signed certificate with Fedora is just
as easy as creating a CSR, but you end up with a test
certificate rather than a request that you send to a
CA. Again, if you're not using Fedora, we recommend
that you generate SSL certificates with the help of
Webmin'’s Certificate and Key Management module
(see Technique 17 for more details).

Here are the steps you need to follow to create a self-
signed certificate with Fedora:

1. Open a terminal window and give yourself
superuser privileges with the su command.

2. Move to the directory /etc/httpd/conf:
# cd /etc/httpd/conf

3. Type make testcert and press Enter.

4. You're prompted for the password that protects
your private server key. Type in the password
and press Enter.

4. OpenSSL prompts you for the same information
that you provide when creating a CSR (loca-
tion, organization, e-mail address, and so on).
Answer each question in turn.

After you've answered the last question (your
e-mail address), OpenSSL creates a self-signed
certificate and saves it in /etc/httpd/conf/ss1.
crt/server.crt

To view the certificate at the command line, use the
following command:

## openssl x509 -in ssl.crt/server.crt -text

You'll see that the issuer and subject are identical —
that’s a self-signed certificate.
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Fedora automatically saves the self-signed certificate
where Apache expects to find it. To see your certifi-
cate in action, restart your Apache server:

f# /sbin/service httpd restart
Stopping httpd: [0K]
Starting httpd:
Apache/2.0.47 mod_ss1/2.0.47

(Pass Phrase Dialog)
Some of your private key files are
encrypted for security reasons.

In order to read them you have to provide
us with the pass phrases.

Server localhost.localdomain:443 (RSA)
Enter pass phrase:

Ok: Pass Phrase Dialog successful.

Notice that Apache now asks for the passphrase that
protects your server’s private key.

Now, open a Web browser and connect to

https://127.0.0.1

Notice the preceding URL starts with https
rather than http. That means it's connecting
to a secure server.

You've just created a self-signed certificate and
installed it on your own Apache server.

Because your users may receive a warning when
they encounter this certificate, it’s a good idea to
give them a little forewarning about what’s going on.
See the sidebar, “When Mozilla encounters a self-
signed certificate,” for details on how this works.

When Mozilla encounters
a self-signed certificate

Self-signed certificates are not very trustworthy. When you
visit a site with a self-signed certificate, you should receive a
warning screen from Mozilla asking if you know this joker
and if his certificate is good enough for you (see the follow-
ing figure). From here, follow these steps to examine the
certificate:



fd Website Certified by an Unknown Authority

i: Unable to verify the identity of Freddie Funkmaster as a trusted site.

Paossible reasons for this error

- The site's certificate is incomplete due to a server misconfiguration.

confidential information.
Please notify the site's webmaster about this problem.
Before accepting this certificate, you should examine this site's certificate carefully. Are

you willing to to accept this certificate for the purpose of identifying the Web site Freddie
Funkmaster?

Examine Certificate...

() Accept this certificate permanently
(@ Accept this cenificate temporarily for this session

() Do not accept this certificate and do not connect to this Web site

- Your browser does not recognize the Certificate Authority that issued the site’s certificate,

- You are connected to a site pretending to be Freddie Funkmaster, possibly to obtain your

| oK H Cancel || Help

1. Click the Examine Certificate button to see the

details of the certificate (see the following
figure).

[ Certificate Viewer:"Freddie Funkmaster” -
‘General | Details

Could not verify this certificate because the issuer is not trusted.

Issued To

Common Name (CN) Freddie Funkmaster
Organization (0) Funkmaster, Ltd.
‘Organizational Unit (OU) Acctg.

Serial Number 00

Issued By

‘Common Name (CN) Freddie Funkmaster
Organization (0) Funkmaster, Ltd.
‘Organizational Unit (OU) Acctg.

validity
Issued On 03/26/2004
Expires On 03/26/2005

Fingerprints
SHAL Fingerprint
MDS5 Fingerprint

35:23:02:2E:2F:27:CE 8E:12:BDB2:4A:02:81: EQ:C2: DA FCI2F:37
48:8E:E0:E0:2E:92:E3:C4:05:EB.7E:83:D3:AAI9C:7F

2. Click the Details tab, and then highlight the
Issuer line in the Certificate Field frame.

In the Field Value frame, you'll see the name and

e-mail address of the certificate issuer. You can decide

for yourself if this person is trustworthy.
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Creating a Signing Authority with openssl

Creating a Signing Authority
with openssl

Use openss]1 to create a certificate authority (CA)
yourself if you want to sign certificates for use within
your organization. Running your own CA can be use-
ful if you want to hand out trusted software to other
people in your organization. A CA is also useful if
you want to serve secure content (payroll benefits
and in-house sales, for example).

A CA has three responsibilities:

v Verifying identity
v Signing requests

v Maintaining a database of signed certificates

openss] comes with a program that can handle the
last two responsibilities for you. You still have to
verify identities yourself using whatever method is
appropriate for your site: If you are creating a CA for
your company, a photo ID card may be sufficient.

Creating a certificate authority

To create a CA, follow these steps:

1. Open a terminal window and give yourself
superuser privileges with the su - command:

$ su -
Password:

i
2. If you're using Fedora or SuSE, move to the
directory that contains the CA shell script:

# cd /usr/share/ssl/misc

If you're using Mandrake:
# cd /usr/1ib/ss1/misc

3. Create the CA infrastructure with the following
command:

# ./CA -newca
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On Mandrake and SuSE systems, use this com-
mand instead:

# ./CA.sh -newca

The CA script now asks you a series of questions,
most of which will be familiar by now. The first
step in creating the CA infrastructure is to create
a new, self-signed certificate. You're prompted
for an existing CA certificate:

CA certificate filename
(or enter to create)

4. Just press Enter to create a new certificate.

5. Enter a passphrase that will protect your CA’s
private key:
Making CA certificate ...
Generating a 1024 bit RSA private key
................. +H++++
writing new private key to
'./demoCA/private/./cakey.pem’
Enter PEM pass phrase:
Verifying - Enter PEM pass phrase:

6. The CA script prompts you for the same bits of
information that you provide when creating a
self-signed certificate or a certificate signing
request. Answer each question in turn.

After you've answered the last question, the
CA script creates a self-signed certificate in
./demoCA/cacert.pem.

Take a peek at this certificate with the following
command:

# openssl x509 -in demoCA/cacert.pem -text

Notice that the issuer and the subject are identical —
that tells you that this is a self-signed certificate.

Signing a CSR

When you have a CA up and running, you can start
to sign CSRs (converting them from requests into
actual certificates).

To sign a CSR, follow these steps:
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1. Open a terminal window and give yourself
superuser privileges with the su - command:

$ su -
Password:

#

2. Move to the directory that contains the CA
shell script:

# cd /usr/share/ssl/misc

3. Type in the following command:

# openssl ca -policy policy_anything \
-in filename.csr \
-out filename.crt

Substitute the CSR name where you see
filename.csr and the desired certificate name
where you see filename.crt. For example, if you
want to sign the CSR for your own Apache Web
server, you would type this:

# openssl ca -policy policy_anything \
-in /etc/httpd/conf/ssl.csr/server.
csr\
-out /etc/httpd/conf/ssl.crt/server.
crt

Next, the openss1 program asks for the pass-
phrase that protects your CA’s private key:

Enter passphrase for ./dem...
/cakey.pem:

4., Type in the password that you assigned when
you created the CA and press Enter.

openssT displays the content of the CSR (in
human-readable form) and asks if you want to
sign the certificate.

5. Look over the content, and if the information
looks correct, press Y and then Enter to sign it.

6. openssl asks if you want to commit your
changes to the CA database: Press Y and then
Enter to finish.

That’s it! The new, signed certificate is saved in the
file that you specified. If you signed the certificate
for another user, e-mail the certificate to the recipi-
ent. If you signed a certificate that you want to use in
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your Web server (and you followed our example),
the certificate is already in place in /etc/httpd/
conf/ssl.crt/server.crt; all you have to do now is
restart httpd (the Apache server):

# service httpd restart
Stopping httpd: [0K]
Starting httpd:
Apache/2.0.47 mod_ss1/2.0.47
(Pass Phrase Dialog)
Some of your private key files are
encrypted for security reasons.

In order to read them you have to provide
us with the pass phrases.

Server localhost.localdomain:443 (RSA)
Enter pass phrase:

Ok: Pass Phrase Dialog successful.

Trusting in Trusted Certification
Authorities

When customers visit a Web site with the intent to
make a purchase, they want a serious guarantee that
their personal information — name, address, and
credit card number — isn’t being distributed across
the Internet for just anyone to use.

When you connect to a Web site secured with an

SSL certificate, a little gold padlock appears in the
browser tray. Hover your mouse over the lock icon
to see a short description of the CA that signed the
certificate. To see more information about the certifi-
cate (and the signer), click the lock icon. In the Page
Info window that appears, click View to see all the
gory details.

Exploring Your Certificate
Collection with Mozilla

As you browse the World Wide Web, you're bound to
encounter certificates from various sites. How does
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your Web browser know which certificates to trust?
Each browser (Mozilla, Internet Explorer, Netscape,
and so on) comes with a set of predefined trusted
authorities.

To explore the certificates and authorities trusted by
your Mozilla browser, follow these steps (the proce-
dure is similar if you're using a browser other than
Mozilla):

1. Open the Main Menu and choose
Internet->Mozilla Web Browser.
The Mozilla Web browser opens.

2. To view the certificate authorities that are cur-
rently trusted by your Mozilla browser, choose
Edit~>Preferences.

The Preferences dialog opens.

3. Expand the Privacy & Security portion of the
tree control in the Category column and then
click Certificates.

The Certificates dialog opens, as shown in
Figure 45-1.

b Preferences

Categor .
il —— Certificates
[ Appearance

El Navigator
History
Languages
Helper Applications
: Smart Browsing
Internet Search
Tabbed Browsing
Downloads
Composer

Client Certificate Selection

Decide how Mozilla selects a security certificate to present to web sites that
require one:

(@ Select Automatically () Ask Every Time

Manage Certificates

Use the Certificate Manager to manage your personal certificates, as well as
those of other people and certificate authorities.

Mail & Manage Certificates...
= Privacy & Security

Cookies
Images
Popup Windows

Manage Security Devices

Use this button to manage your security devices, such as smart cards.

Passwords
Master Passwords
SSL
|- Certificates ]

Validation
Advanced
Offline & Disk Space

[ ok ][ cancel |[  Hep

* Figure 45-1: The Certificates dialog.

4. Click the Manage Certificates button to open
the Certificate Manager.
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5. Click the Authorities tab to see the signing 3 You can remove Ferﬂﬂcates t!"nat are currently
authorities trusted by your browser (see e { - gccepted b'y' Mozilla with a click of the mouse
Figure 45-2) & in the Certificate Manager. If you want to

remove a certificate, highlight the certificate
Bd Certificate Manager i-2x and click the Delete button. You'll be asked to
Your Certificates | Other People’s | Web Sites| Authorities verify that you want to delete the certificate —
You have certificates on file that identify these certificate authorities: Click OK, and |t'5 history.
Certificate Name I Security Device J EEJ
Entrust.net Secure Server Cert... Builtin Object Token [+] . one .o .
Entrust.net Client Certification ... Builtin Object Token 7. YOll can view addltlonal certlﬁcate deta'lls by
El Equifax clicking the Details tab on the Certificate
Equifax Secure CA Builtin Object Token . .
B Equifax Secure Viewer (see Figure 45-4).
Equifax Secure eBusiness CA 2 Builtin Object Token D
= Equifax Secure Inc. [ Certificate Viewer:"Builtin Object Token:Equifax Secure CA"
Equifax Secure Global eBusine... Builtin Object Token General| Details
Equifax Secure eBusiness CA-1 Builtin Object Token
EI GTE Corporation Certificate Hierarchy
GTE CyberTrust Root Builtin Object Token Builtin Object Token:Equifax Secure CA
GTE CyberTrust Global Root Builtin Object Token
Fl GeoTrust Inc.
GeoTrust Global CA Builtin Object Token [
View E | Edit | ‘ Import ‘ | Delete |
l Help i Certificate Fields
— Serial Number

* Figure 45-2: The authorities trusted by our browser.

6. Highlight a certificate name and click the View
button (located in the lower left-hand corner of
the Certificate Manager window).

The Certificate Viewer dialog opens with informa-
tion about the certificate, as shown in Figure 45-3.

[08/22/2018 12:41:51

(08/22/2018 16:41:51 GMT)

Certificate Signature Algorithm
Issuer
Elvalidity
Not Before
“-Not After
Subject
El'Subject Public Key Info
Subject Public Key Algorithm
Subject’s Public Key
B Extensions
Field value

[ Certificate Viewer:"Builtin Object Token:Equifax Secure CA"

This certificate has been verified for the following uses:

| SSL Certificate Authori
& 8.
Issued To
Common Name (CN) <Not Part Of Certificate>
Organization (O) Equifax
Organizational Unit (OU) Equifax Secure Certificate Authority
Serial Number 35:DE:F4:CF
Issued By
Common Name (CN) <Nat Part Of Certificate>
Organization (Q) Equifax
Organizational Unit (OU) Equifax Secure Certificate Authority
validity
Issued On 08/22/1998
Expires On 08/22/2018
Fingerprints
SHAI Fingerprint D2:32:09:AD:23:D3:14:23:21:74:E4:0D: 7F:9D:62:13:97: 86:6
MD5 Finaernrint 67 CROCOr13:24-8A°82:0R-R2-17-1E-D1- 1R FC-D4

¢ Figure 45-3: Information about a specific CA.

¢ Figure 45-4: Detailed certificate information.

Highlight the fields in the tree control in the
center pane to view the specific details of the
certificate in the Field Value pane.



Retrieving HTTPMail
Using hotway and

Technigue  Evolution

Save Time By

v+~ Retrieving e-mail from
HTTPMail accounts with
hotway

v Using hotway with Ximian
Evolution to make the
most of your e-mail
accounts

v~ Customizing Evolution to
bring you information fast

send and retrieve e-mail. SMTP is used to send e-mail, and POP

and IMAP are used to retrieve e-mail. Some of the larger Web
portals — such as Microsoft’s Hotmail, MSN, and Lycos — have developed
their own e-mail protocols based on HTTP, which is the underlying trans-
port mechanism used by Web browsers.

Most e-mail service providers use three standardized protocols to

E-mail accounts from portals using HTTPMail servers often come with a
catch: Because of the strange protocol, you must access their services
with a Web browser, logging in to their servers and stopping to view all
the advertisements along the way. You can use an open-source tool called
hotway to retrieve your e-mail with an e-mail client, avoiding the hassles
and slowdowns of ads, pop-ups, and online logins.

Check with your e-mail provider and make sure that its user service
agreement doesn’t include any legalese that requires you to use a

browser to view your e-mail.

In this technique, we introduce you to an open-source project called
hotway. hotway can retrieve your mail from an HTTPMail server and deliver
it your to e-mail client. hotway can also forward e-mail that you send from
a mail client to an HTTPMail server. We also take you on a quick tour of
Ximian Evolution — a great tool to use in combination with hotway. You'll
save time by accessing your HTTPMail accounts without stopping to view
the ads along the way, and get to know a great e-mail client in the process.

Introducing hotway

The hotway (hotmail gateway) project at hotwayd.sourceforge.net pro-
vides an open-source gateway that retrieves e-mail from an HTTPMail
server and delivers it to your Linux mailbox. You can also send e-mail
from your Linux client (Ximian Evolution, KMail, Mozilla mail, and so on)
to an HTTPMail server.
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hotway works with the following accounts:

v Accounts at hotmail.com
v Accounts at msn.com

v Lycos accounts with the suffixes .co.uk, .ch,
.de, .es, .it,or .at

v Accounts at spray.se

Getting Started with hotway

You typically interact with an HTTPMail server by
pointing your Web browser to the portal, typing in
your user name and password, and navigating
through tons of advertisements before you can read
your e-mail. If you're using Windows, you can avoid
the portal Web site by reading your e-mail with
Microsoft Outlook (or Outlook Express) mail clients.
If you're using Linux, you haven’t been so lucky —
until now.

7 Read your e-mail provider's end-user agree-
e { -@) ment to be sure that dodging its advertising is
& okay.

hotway is quick and easy to set up, and after it’s in
place, you'll never even know it’s there. When you
install hotway, you’re running a daemon (background
process) named hotwayd that listens for e-mail
requests. hotwayd is controlled by xinetd — xinetd
lurks in the background, waiting for activity on TCP
port 2500. When an e-mail request comes in, it fires
up hotway to handle the request.

To install hotway on your Linux machine, follow
these steps:

1. Open a Web browser and surf to

hotwayd.sourceforge.net

2. Click the Download link.

3. Click the link for
hotwayd-0.8-1.1386.rpm

Technique 46: Retrieving HTTPMail Using hotway and Evolution

You're directed to a download page listing avail-
able mirrors.

4., Click a download link to a mirror site near you.

“

Save the RPM package to your home directory.

6. Close the browser window and the Download
Manager. Open a terminal window and give
yourself superuser privileges with the
su command.

7. Install the RPM package with the following
command:

# rpm -Uhv hotwayd-0.8-1.1386.rpm

That’s all there is to it — you’re ready to use hotway.
® xinetd automatically starts the hotway dae-

&= { <t) mon when it's needed — no extra work is
& required.

Setting Up Evolution to Read
HTTPMail Accounts with
hotway

hotway works with any e-mail client, but we're
particularly fond of Ximian Evolution. Evolution is a
quick, slick e-mail client bundled with most Linux
distributions. If you’ve already installed Evolution
(it should appear in the Internet menu or Internet=
Mail menu), you're ready to go. If not, install
Evolution before proceeding.

To set up an e-mail account using Evolution and
hotway, follow these steps:

1. Open the Main Menu and choose
Internet->Evolution E-Mail.

The first time you use the Evolution e-mail client,
it greets you with the Evolution Setup Assistant.

2. Click the Forward button to continue with
setup.
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3. Enter your full name and e-mail address in the
appropriate fields. You can also choose to com-
plete the Optional Information portion of the
window to redirect any e-mail responses to
another e-mail account (see Figure 46-1).

[l Evolution Account Assistant E L3
i 3
Identity o

Please enter your name and email address below. The

“optional” fields below do not need to be filled in, unless

you wish to include this informatien in email you send.
Required Information

FEull name: Freddie Funkmaster

Email address: freddiefunkmaster@hotmail.com
Optional Information

Reply-To:

Organization

Default signature: Add new signature...
‘ 8 cancel | | <@ Back ‘ ‘ P> Eorward

[l Evolution Account Assistant x

Receiving Email

Please enter information about your incoming mail
server below. If you are not sure, ask your system
administrator or Internet Service Provider.

Server Type: | POP 7

Description: For connecting to and downloading mail from POP servers.
Configuration

Host: |127.0.0.1

Username: |freddiefunkmaster@hotmail.com

Authentication

{Remember this password;

Check for supported types

Note: you will not be prompted for a password until you connect for the first time

‘ 8 cancel | | < Back ‘ ‘ P> Forward |

g

¢ Figure 46-1: Enter your Identity information.

If you want all e-mail responses to be sent to a
single account, enter the e-mail address that you
want to use in the Reply-To field. In most cases,
you can leave the Reply-To and Organization
fields blank.

4. Click the Forward button to continue.
The Receiving Email window opens.

5. From the Server Type drop-down list box,
choose either the IMAP or POP server type to
display a more complete Receiving Email form,
as shown in Figure 46-2.

IMAP, we usually use POP. It’s just a bit more

Z Unless there is a compelling reason to use
<}
reliable than IMAP.

b

6. Click the Check for Supported Types button
and Evolution will connect to the server to ask
it what Authentication Types it supports. The
results are copied into the Authentication Type
list box. Alternatively, use the list box to
choose the authentication type you prefer.

* Figure 46-2: The complete Receiving Email form for a

POP server.

7. Enter 127.0.0.1 in the Host field and then click
the Forward button.

The Receiving Mail Options window opens.

8. Check the Automatically Check for New Mail

Every box, and customize the time options to
determine how often Evolution checks your
e-mail account.

9. Use the options listed in Message Storage to

control whether the messages are deleted after
download. Be sure to disable support for POP3
extensions when you're creating an account
serviced by hotway. Click the Forward button
to continue.

The Sending Mail window opens, as shown in
Figure 46-3.

70. Enter 127.0.0.1:2500 in the Host field, check

the Server Requires Authentication box, and
make sure that the Username field contains
a complete e-mail address. Click Forward to
continue.

The Account Management window opens, as
shown in Figure 46-4.
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w Evolution Setup Assistant = m e, o
Sending Mail %4

Please enter information about the way you will
send mail. f you are not sure, ask your system
administrator or Internet Service Provider.

Server Type: SMTP i

Description: For delivering mail by connecting to a remote mailhub using SMTP.

Server Configuration- -]

Hnst‘f
Use secure connection (SSL): Never |-
I Server requires authentication

rAuthentication

Authentication Type: ‘ PLAIN |

‘ Check for supported types |

Usermame: freddiefunkmaster

1 Remember this password

XGarcel | pack

¢ Figure 46-3: The Sending Mail window.

711. Enter a user-friendly name in the Name field
and click the Forward button. Click Forward to
continue.

The Timezone window opens, as shown in
Figure 46-5.

Account Management /

‘You are almost done with the mail configuration process.
The identity, incoming mail server and outgoing mail
transport method which you provided will be grouped
together to make an Evolution mail account. Please
‘enter a name for this account in the space below. This
name will be used for display purposes enly.

Account Information

Type the name by which you would like to refer to this account.
For example: "Work" or "Personal”

[ lireddiefunkmaster@hotmail. com|

Make this my default account

‘ 8 Cancel | ‘ < Back ‘ | PEorward‘

* Figure 46-4: The Account Management window.

Selection: i uTC | v |

[hd Evolution Setup Assistant

Timezone

Use the left mouse butten to zoom in on an area of the map and select a time zone.
Use the right mouse button to zoom out.

Time Zones

—— -

Gl B

AsiafShanghai

#8 cancel ‘ | <d Back | ‘ > Forward |

* Figure 46-5: Choose your time zone.

12.

13.

14.

15.

Click the map to choose your time zone and
then click Forward to continue.

A window opens, indicating you've successfully
entered the information needed.

Click Apply to continue.
Evolution opens, ready to retrieve your e-mail.

Click the Inbox button in the Shortcuts panel
on the left, and then click the Send/Receive
mail button on the toolbar.

The Send & Receive Mail and Enter Password
dialogs open, as shown in Figure 46-6.

Enter your password and click OK.

Your e-mail should arrive in the inbox any
second now!
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RS — e X
A Send & Receive Mall x -
fﬁ Sefver. 127.0.0.1, Type: pop

wainng. ., e cace]

e @O E

w Server. 127.0.0.1, Type: smip = I X canc O naw, 0 1ol
Compiete ) s
— || Clmar |
% cancel All | et Date [=
&
Inbax
Calendar I Enter Password for ireddisfunkmasiar o how BSL=]E)
T (.ﬂ Please enter the POP passwond for
\’  frecdiefunkmaster@hotmai.com #127.0.0.1
Tasks
ol =] Bemember this password
m - W Cancel o oK

=F= GDFetching Mail L.}

* Figure 46-6: Getting ready to retrieve e-mail.

Ringing the Bells and Blowing
the Whistles: Your Evolution
Summary Page

When you open Ximian Evolution, you're treated to a
feast of information, all displayed in a tidy summary

page. What's the best thing about the summary page?
You can customize it in a snap!

] When you customize your summary page to
e («a include information, news, and appointments,
é you're also creating browsable links from your
e-mail client to information that is important
to you.

Follow these steps to customize your summary in
Evolution:
1. Choose Tools->Settings.

The Evolution Settings dialog opens, as shown in
Figure 46-7.
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You can use the Evolution Settings dialog to cus-
tomize the features shown in the left panel. The
tabs in the right panel change to reflect the fea-
tures that you can customize.

K Evolution Settings BEE

Mail | News Feeds | Weather | Schedule
u

Local Folders
Other Contacts
VFolders

D

Mail Accounts

k¥

Folder Settings

Mail Preferences

E

Composer Preferences

b

Calendar and Tasks

Directory Servers
apl

i Summary Preferences

[] show full path for folders

[+

| o Apply H X Close H & oK ‘

* Figure 46-7: The Evolution Settings dialog.

2. Use the scroll bar to scroll down and choose the
Summary Preferences button in the left panel.

The tab dialogs are now labeled as follows
(refer to Figure 46-7):

» Mail

» News Feeds
» Weather

» Schedule

3. Click the Mail tab, and then expand the Local
Folders tree control to view the folders you can
include on your summary page, as shown in
Figure 46-8.

4. Check the boxes next to the folders you want to
include on the summary page and then click

Apply.
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Mail | News Feeds |Weather | Schedule

[ Al ¥
{Yahoo World News |
Advogato

BSD Today

Barrapunto

Barrapunto GNOME
Beyond 2000

DVD Review
Dictionary.com Word ...
Footnotes - GNOME...
Freshmeat

HispaLinux

Intemet.com

KDE Dot News

KuroShin

Linux Games

Linux Today

Linux Weekly News

News Feed Settings

Refresh time (seconds): 600

Max number of items shown: |10

BEIE

Yahoo World News
Dictionary.com Word of t...

2 | [ New Feed

12| | ¥ Delete Feed

‘ & Apply H X Close H & ok |

‘ o Apply H X Close H of o |

¢ Figure 46-8: Customizing the folders on your summary
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page.

Select the mailboxes you need to access most

< often. You'll have fast access to them with a

single click on your summary page.

Click the News Feeds tab to add RSS feeds to
your summary page.

RSS (Really Simple Syndication) feeds are little
snippets of headline-making news that you can
customize to suit your interests (see Figure 46-9).

To add an RSS news feed to your summary
page, highlight the name of the feed in the list
in the All panel and then click the Add button.
When you’re finished adding feeds, click the
Apply button.

When you click Add, the feed name is copied to
the Shown panel.

You can also find and add new RSS feeds from
the Web. Click New Feed to open the New News
Feed dialog. Fill in the Name and URL fields and
click OK to add it to the list of feeds.

* Figure 46-9: Customize the RSS news feeds displayed on

7.

your summary page.
Yahoo! offers a few RSS feeds that you might be
interested in:

» Yahoo! World News at rss.news.yahoo.com/
rss/world

» Yahoo! Tech News at rss.news.yahoo.com/
rss/tech

» Yahoo! Science News at rss.news.yahoo.com/
rss/science

Do a Web search for RSS news feeds to find

< feeds about interesting topics that you can

add to your summary page.

To remove a news feed from the summary
page, highlight it in the Shown panel and click
the Remove button. Click the Apply button

to make the changes take effect — it's quick
and easy!

Click the Weather tab to customize the weather
reports displayed on your summary page.
Expand the tree control in the All panel, find
the city whose weather you want to monitor,
and click the Add button.
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The name is added to the list in the Shown panel,
as shown in Figure 46-10. You can monitor the
weather for multiple locations.

‘ « Apply H X Close H @ ok ‘

* Figure 46-10: Add custom weather information to your

8.

10.

11.

summary page.

You can also choose to display the tempera-
tures in Celsius or Fahrenheit, and set the
refresh time with the controls found on the
Weather tab. Click the Apply button to save
your changes.

Click the Schedule tab (shown in Figure 46-11)
to customize the calendar and task information
displayed on your summary page.

In the Calendar area, specify the number of days
you want to display in the calendar. In the Tasks
area, decide whether to display all pending
tasks or just those tasks scheduled for today.
Then click the Apply button to save your
choices.

When you’ve finished customizing your sum-
mary page, click the Close button to return to
your newly updated summary.

Custom weather, news, and appointments are

all waiting for you, along with one-click access
to your most frequently used mail folders (see
Figure 46-12).

K Evolution Settings [=[2]x

D

Mail ‘ News Feeds ‘Weafher‘ Schedu\e‘

Mail Accounts
| ~Calendar

How many days should the calendar display at once?
() One day

]

Folder Settings O Evedays

® One week!

g

() One month

Mail Pref

o

rences

Tasks

E

O Show all tasks @ Show today's tasks
‘Composer Preferences

B

Calendar and Tasks

5D

. Mimctony;Serers: |

i summary Preferences

[

| & Apply H X Close H & ok ‘

* Figure 46-11: Customize your calendar display for the
summary page.

R S ummary - Ximian Evolition =2
Elle  View Actions  Tools  Help

O New v | P Send Recetve DL Pt Y Reload

Shocits < 5 [ Sammary
J% 7%y weather > &)
\‘}& ‘f._,j L‘:,\.‘] Mall summary

Summary T Richmand

Few clouds 50.0F Lnbox 1/1
ar d€AL 071

Inbos (1)
@‘il’uus 10 New Releases 3 I Appeintments

| E ; 1 Thaow Dawn the Reins - Panurge
Rock Around the Clock - Bill Haley & His Comerts
Mizery Is a Buerly - Blonde Redhead

Colendas The Thirping’ Crickets - Buddy Holly & The
Criekets

- Congurtadon (Horms Traek) - Cool Taglor
Aber School Sassion - Chuck Barsy
20 Centary Massers - The Millenium Collection
The Best of The Del Vikings - The Del Vikings

Tasks Bay for Night - Boug Powell B fasis

Trading Smakeoil lor Wolkickes - Gary Jules
i The Gt Up Kads - Tunes Sessions - The Gertip |

Kids [ Gt bed sore betore it ains again., |
O Comoute oo 40 ballion plages

coneacts | [+
== |
* Figure 46-12: Create a custom summary of the info you
need for the day.

Creating a custom summary page can save you time
because the information you need is right at your
fingertips. Evolution keeps you up-to-date on
appointments, weather, news, and e-mail.



Stopping Spam with
SpamAssassin

Technique

Save Time By

* Using SpamAssassin to
screen your e-mail

v+~ Configuring
SpamAssassin with the
Configuration Generator

1~ Setting up SpamAssassin
as a filter for your
Evolution e-mail client

v~ Updating your rule set
with RulesDuJour

talking about isn’t the pink stuff in a can — it’s junk e-mail. (We

wanted to include a technique about the edible Spam, but our editors
said no: See www. spam. com for your daily dose of pink meat.) Unsolicited
commercial e-mail not only takes up your valuable time reading and
weeding through it, but also ties up your CPU and consumes valuable
storage space on your server. And it’s downright annoying. Fortunately,
you can reduce the amount of spam you receive with the help of a great
tool called SpamAssassin.

f ; pam is a major waste of time and resources. The kind of spam we’re

SpamAssassin has several mechanisms for deciding what is and isn’t spam:

v Rule set that computes a spam threshold: A numerical score identi-
fies an e-mail message as spam or ham (ham is the opposite of spam —
we’re not making this up).

v Bayesian filtering: Bayesian filtering figures out what spam looks like
as it reads your e-mail. It learns and evolves to keep up with spam-
mers’ tactics.

v Character-set and language sensitivity: You can specify languages and
character sets that should be considered spam. (For example, unless
you're conversing in Russian, e-mail composed entirely of Cyrillic char-
acters is likely to be spam.)

In this technique, we introduce you to your new e-mail assistant,
SpamAssassin. With the added tool, RulesDuJour, updating your rule
sets is a breeze. With up-to-date rule sets, SpamAssassin learns and
grows to keep up with the ever-changing antics adopted by spammers,
and saves you time and frustration by letting you read the ham without
having to wade through the spam.

Installing SpamAssassin

SpamAssassin is an open-source project that screens incoming e-mail for
unwanted or commercial e-mail. It’s a smart tool, with ever-evolving rule
sets that can keep pace with even the slickest of spammers.



You can install SpamAssassin from the Fedora or
SuSE distribution media or by downloading the lat-
est RPM packages from www.spamassassin.org, the
official Web site of SpamAssassin.

Installing from the distribution media

If you're a Fedora user, the quickest and easiest way
to install SpamAssassin is with the Fedora Add or
Remove Packages program and the Fedora distribu-
tion media. The procedure is similar on SuSE sys-
tems except that you use YAST2 (SpamAssassin is
well-hidden in Productivity=>Networking=>Email=>
Utilities).

) Check out Technique 56 for details about
B (@ downloading and burning your own set of
& distribution discs.

To install SpamAssassin from the Linux distribution
media, follow these steps:

1. Open the Main Menu and choose System
Settings>Add or Remove Packages. Click the
Forward button.

A scan for currently installed packages begins.

2. When the Add or Remove Packages window
opens (see Figure 47-1), scroll down and check
the Mail Server box.

3. Click the Details link to the right of the Mail
Server entry to open the Mail Server Package
Details window.

4. Check the Spamassassin box to include the
package in the installation, as shown in
Figure 47-2.

5. Click the Close button, and then in the Add or
Remove Packages window, click the Forward
button.

The system update is prepared, and a Package
Installation Overview window appears, display-
ing SpamAssassin and any dependencies (see
Figure 47-3).
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lhd Package Management EE x

Add or Remove Packages

Server Configuration Tools [5/12] Detalls |[%]

@ This group contains all of Red Hat's custom server
configuration tools.

‘Web Server [12/17] Details
ﬁj These tools allow you to run a Web server on the system.

Mail Server [y8]  Details'
s These packages allow you to configure an IMAP or Postfix
@3 mail server.
[] windows File Server [0/2]

@1, This package group allows you to share files between Linux
@J and MS Windows(tm) systems.
[] DNS Name Server [or3]
This package group allows you to run a DNS name server
(BIND) on the system.
PE— _ =

Total install size: 2,566 Megabytes

‘ #8 cancel ‘ ‘ <@ Back | | Wﬁorwa|d|

* Figure 47-1: Check the Mail Servers box.

v Mail Server Package Details E x

A package group can have both standard and extra package

members. Standard packages are always available when the
package group is installed.

Select the extra packages to be installed:

l> Standard Pacl-(ages
~ Extra Packages
[ squirrelmail - SquirrelMail webmail client |
[[] sendmail-cf - The files needed to reconfigure Sendmail. |
[J mailman - Mailing list manager with built in Web access.
[CTimap - Server daemons for IMAP and POP network mail protocols.
[[] dovecot - Dovecat Secure imap server
[ postfix - Postfix Mail Transport Agent

Package Information

Full Name: spamassassin
Size 2,064 Kilobytes

% Close

* Figure 47-2: Check the box next to Spamassassin.

6. Click the Forward button.

The system update begins. When installation is
complete, the Package Installation Complete win-
dow is displayed.

7. Click the Finish button.
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(hl Package Management !E x
Package Installation Overview };
5 packages are queued for installation
This will take 2,792 Kilobytes of diskspace.
Packages to be Installed
perl-Digest-HMAC-0:1.01-11.noarch 24 Kilobytes
perl-Digest-SHA1-0:2.01-15.1386 104 Kilobytes
perl-Net-DNS-0:0.31-3.2.noarch 472 Kilobytes
perl-Time-HiRes-0:1.38-4.i386 128 Kilobytes
spamassassin-0:2.60-2.i386 2,064 Kilobytes

‘ #8 Cancel | | <@ Back | | B> Eoward ‘

* Figure 47-3: These are the packages that will be installed.

That’s it. Fedora (or SuSE) takes care of resolving the
dependencies as it installs the spamassassin RPM
package. Now, you need to start SpamAssassin, as
described in the section, “Starting the service,” later
in the technique.

Installing from RPM downloads

If you don’t have the Fedora or SuSE distribution
media and don’t want to take the time right now to
make a set, you can get SpamAssassin up and run-
ning with a quick visit to the SpamAssassin Web
site. Follow these steps to download and install
SpamAssassin:

1. Open your favorite browser and surf to
www.spamassassin.org/released/RPMs
2. Click the download links to retrieve the follow-
ing RPMs:
perl-Mail-SpamAssassin-version.i386.rpm

spamassassin-version.i386.rpm

Be sure to choose the most recent version and
save the files to your Desktop.

Technique 47: Stopping Spam with SpamAssassin

3. Close the browser and open a terminal window.
Give yourself superuser privileges with the su
command.

4. Move to your Desktop directory and install the
packages with the following commands:
# cd ~/Desktop
# rpm -Uhv perl-Mail-SpamAssassin-
2.63-1.1386.rpm
# rpm -Uhv spamassassin-2.63-1.1386.rpm

That’s it — the per1-Mail-SpamAssassin package sat-
isfies the dependencies of the spamassassin RPM
package. You're ready to start the service! See the
next section for details.

Starting the service

You'll get the best performance from SpamAssassin
by running it as a client/server installation. Keeping
the spamd daemon alert and on its toes saves startup
time every time you get an e-mail message.

To start the SpamAssassin service, open a terminal
window and give yourself superuser privileges
with the su - command. Then enter the following
command:

# service spamassassin start

The terminal echoes this message:

Starting spamd: [0K]

That’s it. You're ready to configure SpamAssassin.

Fine-Tuning SpamAssassin
to Separate the Ham from
the Spam

You can fine-tune SpamAssassin to screen your e-mail
more aggressively or less aggressively. If you screen
more aggressively, you run the risk of missing a mes-
sage that might be trapped by mistake; if you don’t
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screen aggressively enough, you’ll be greeted by
spam in your e-mail client. It’s important to note that
your e-mail client decides what to do with mail clas-
sified as spam, not SpamAssassin — SpamAssassin
classifies each piece of e-mail; your e-mail client

can throw out spam messages or route it to a spe-
cific mailbox (we show you how to configure your
e-mail client in the section, “Adding a New Filter to
Evolution”).

The easy way to configure SpamAssassin is with the
help of the SpamAssassin Configuration Generator.
Open your favorite browser and surf to

www.yrex.com/spam/spamconfig.php

You're taken to the SpamAssassin Configuration
Generator, shown in Figure 47-4. The next two sec-
tions explain how to customize SpamAssassin and
then save your configuration file.

bt 5 pamAssassin Configuration Generator - Mozilla 3

T Ple Edt View Go Qookmarks Tools Window Lielp |

T A 3, [Fllasan] < -
el e i e & nonp o yres. comspam/spamcentigphe ||| 8 Search| vt

7| AhHome | whRockmarks . Red Hat, Inc. . Red Hat Network [ Suppon Z§5hop i Products (4 Training

SpamAssassin Configuration Generator

This tool is designed to make it @asier to customize an installation of SpamAssassin with some
cammon aptions. After you answer the q below, a S A i file
your choices will be displayed, and you can download it and wse it with your SpamAssassin
installation.

A

This is designed to work with Sp in 2.5 b will not work comectly with previous versions,

Threshold and Report Options

Score Threshold: Anything above the threshold is marked as spam. Increasing this threshold will
increase the amount of spam missed, but will reduce the risk of false positives. (required_hits)

# Low Threshold (5.0, default)

© Medium Threshold (7.5)

" High Threshold (10,0}

P TR R TR R SN AR S SO

ele)

* Figure 47-4: The SpamAssassin Configuration Generator.

) If you're using Webmin for administrative

B («a tasks, be sure to check out the Webmin inter-
face for configuring the SpamAssassin Mail

Filter. You find it in the Servers menu of your
Webmin client. The SpamAssassin Configura-
tion Generator at yrex.com is quick and easy,
but Webmin gives you finer control over
SpamAssassin. See Technique 17 for more
information about Webmin.
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Customizing settings

The Configuration Generator lists a series of settings
that you can customize. Check the radio button next
to the desired setting to add that value to the cus-
tom configuration file. The settings are described in
the following list:

v Score Threshold: The first setting in the Configu-
ration Generator is for the Score Threshold. Each
e-mail is assigned a score based on its content.
The higher the score, the more likely the e-mail
is spam.

For example, if your threshold is set to 5, an
e-mail with a spam score of 7 is considered
spam, and an e-mail with a score of 3 is consid-
ered ham.

] If you start out at 5, you'll probably want to
- (@ eventually lower the threshold. We've noticed
& that even at 3, we still get spam. Our sugges-
tion is to start at 5, and watch what’s getting
through before you set the threshold too low.

v Rewrite Message Subjects: If you check the
Rewrite Subjects box, the text string shown is
written into the subject line before the e-mail is
added to your inbox. This feature doesn’t work
with the Evolution e-mail reader. If you're using
an e-mail client other than Evolution, a string
such as “POSSIBLE SPAM - ” is a good choice that
will make it easy to spot spam in your mailbox.

v Encapsulate Spam in Attachments: If you accept
the default, SpamAssassin encapsulates any mes-
sage that scores above the spam threshold into a
new message as a MIME attachment. This can
help prevent accidental virus infection. For even
more protection, select the Use Text-Only
Attachments radio button. This feature doesn’t
work with the Evolution e-mail client either.

v Use Terse Reports: If enabled, SpamAssassin
issues a shorter version of the spam report. If
you get a lot of spam, you may want to go with a
shorter report. This feature also does not work
with Evolution (don’t worry; you don’t need it).
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When used with Evolution, SpamAssassin acts
as a filter. SpamAssassin classifies the e-mail as
spam or ham, but it doesn’t make modifica-
tions to the e-mail. It does, however, put the
e-mail into a separate folder so you can speed
cruise it later.

v Bayes Options: By enabling the Bayes Options,

you allow SpamAssassin to learn what spam
looks like from e-mails that score highly on the
spam threshold. As each message arrives,
SpamAssassin Bayesian filter searches it for
words and phrases that appear often in spam
messages. If a message contains many words
and phrases that are commonly found in spam,
SpamAssassin assumes that the new message is
likely to be spam as well. SpamAssassin learns
what spam looks like if you enable Bayes filtering.

7
B»(«&
&

» Use Bayes System: Accept the default setting
to use Bayesian analysis to identify spam.

Rather than shipping a set of rules to every user
in the world, a custom set of rules is built for
each user. For example, if a doctor actually
wants all that e-mail about Viagra, he or she
can tell the filter that.

Technique 47: Stopping Spam with SpamAssassin

» Use Network Checksum Tests: Computed
checksums on known spam are kept in several
distributed databases. If you select this option
and install the appropriate client software,
your incoming e-mail messages are screened
against the checksums maintained in the data-
bases. Any matches are considered spam and
are treated as such.

Language Options: You can set SpamAssassin fil-
ters to watch for the character sets or recognized
language patterns in the body of the e-mail mes-
sage. By default, all languages are accepted —
check the boxes next to any languages you
would consider to be spam.

Check the Use Language Testing box to read the
body text of a message looking for recognized
languages that can’t be distinguished by the
character set alone. Hungarian and English use
the same character set, so check this box to
screen out excessive Hungarian spam.

Saving your settings

After you’ve customized your settings in the Configu-
ration Generator (as described in the preceding
section), follow these steps to save your configura-

» Use Auto Learning: Accept the default setting tion file:
to allow SpamAssassin to automatically train
its Bayes database based on non-Bayesian 1. Click the Generate the Configuration File button.

classification rules.

Network Test Options: The Network Test Options
uses information gleaned from the Internet to sep-
arate the spam from the ham.

2.

You're taken to a new Web page, displaying the
new configuration file (see Figure 47-5).

Click the Download This File button and save
the file to disk.

You can either save the file in place or copy it

7 The Network Test Options will slow down your
- { @ e-mail traffic. The more e-mail you get, the
& slower your e-mail arrives because each piece
needs to be verified against an Internet
resource.

into place later.

To save the configuration file into place for a
single user, enter the following code in the File
Name field of the Download Manager:

~/.spamassassin/user_prefs
» Enable RBL Checks: If you accept the default P 1 P

and enable RBL (Realtime Black List) checks,
your incoming e-mail is compared to a black-
list. If the sender of the e-mail is on that list,
the e-mail is considered spam.

To save the file into place for the entire system,
copy the Tocal.cf file into

# /etc/mail/spamassassin/local.cf
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SpamAssassin Configuration Generator

The foll q © file was g d based on your selected ophions. You can now copy it to

your SpamAssassin installanon,

This is di d to work with Spi 2.5, Itwill not work comectly with previous versions,

Deowrioad This File

Spantssassin config file for version 2.5%
penerated by hEtp:/fwew.vrex.com/span/spanconfig.php (versien 1.01)

# How nany hits before o message is considered spam,

equired hits 5.0

Whether te change the subject of suspected span
rewra te_subject 1

Text to prepend to subject if rewrite subject is used

subject._tag 444958 an_here’ L

Encapsulate span in an attechoont

|-l

* Figure 47-5: Your new SpamAssassin Configuration File.

You may need to create the .spamassassin
subdirectory in your home directory.

3. Click Save, and your configuration file is
copied into place.

] Need to tighten your configuration? Just
i («a revisit the Configuration Generator and copy
& the new configuration file into place over the
old one. Easy!

Adding a New Filter
to Evolution

After you've created an awesome spam filter by con-
figuring SpamAssassin, you'll want to apply it to your
e-mail client. If you're using Evolution, the process is
simple:

1. Open your Evolution e-mail client.

2. Open your Inbox, and choose Tools>Filters
from the menu bar.

The Filters dialog opens, as shown in Figure 47-6.
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Adding a New Filter to Evolution

‘glncamlng

Filter Rules

@ Add
Edit
== Remove

& Up

i I I I [
g

‘agancel H o oK ‘

* Figure 47-6: The Evolution Filters dialog.

3. Click the Add button.
The Add Rule dialog opens, as shown in

Figure 47-7.
v Gl
Rule name: | TS
i
. o Add Execute actions | If all criterla are met e
i Sender * || contains ¥ | = gemove
Then
| 4 asa
[Mmlandﬂ - !'um here 1o select a loldee | o Rere
| # Cancel o ok
L =l |

* Figure 47-7: Add a new rule for SpamAssassin.
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4., Enter a new name in the Rule Name field.
In the drop-down list box to the right of the
Sender field, choose Pipe Message to Shell
Command. Then to the right of that drop-down
list box, enter:

spamc -c¢ > /dev/null

5. Use the arrow to the right of the Returns field
to open the drop-down list box and change the
field to Returns Greater Than.

6. Click the Click Here to Select a Folder field to
open the Select Folder dialog, shown in
Figure 47-8.

[ Select Folder

@Summar\#

i - Local Folders

| E- Other Contacts
- VFolders

‘ [ New H # cancel H o« oK ‘

¢ Figure 47-8: The Select Folder dialog.

7. Click the New button to open the Create New
Folder dialog, shown in Figure 47-9.

8. Enter a name for your junkmail folder in the
Folder Name field.

Harry or Roger would work, but we call ours
junkmail.

9. Highlight Local Folders in the Summary list,
and click OK.

70. Select your new junkmail folder from the list in
the Select Folder dialog. Then click OK.
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“ Create New Folder B X
Folder name:
junkmail
Folder type:
| Mail o

Specify where to create the folder:

(@ Summary

' Local Folders
# Other Contacts
# VFolders

‘ 3 Cancel H o DK ‘

* Figure 47-9: Create a new junkmail folder.

The completed rule is displayed, as shown in
Figure 47-10.

[ 44 e ox
Rube name:  SpamAssassin
i
& Add Execite actions | if al crtena are met ¥
Pipe Messige to Shell Command = [Ispame < » fdevimll | u-m...] returns greates than = | |0
3] [
Then
% Add
Move 10 Folder ' | L3 “lunkmail® in “Local Folders® = Eamove
| mgancel || Pox |

¢ Figure 47-10: The completed rule.

The new rule is now included in the Filters list.
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Click OK to close the dialog.

SpamAssassin is now actively protecting you and
your Evolution account from spam.

Serving Up a Big Bow!
of the RulesDujJour

RulesDulour is a neat script that downloads new
SpamAssassin rule sets. Spammers are becoming
more sophisticated (well, more persistent anyway) on
an almost daily basis. Keeping your rule set up-to-date
helps SpamAssassin screen the spam more efficiently.

To install RulesDuJour, follow these steps:

1.

2.

Open your Web browser and surf to
www.exitO.us/index.php/RulesDudour

Scroll down the page and click the download
link for rules du jour. When the download
manager opens, save the files to your home
directory.

Open a terminal window and edit the
rules_du_jour file:

$ kedit rules_du_jour

Serving

4.

®
w(@
&
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Up a Big Bow! of the RulesDuJour

Scroll down and change the entry in line 40
to this:

["${SA_DIR}"] || SA_DIR="/etc/mail/
spamassassin”;

Change the entry in line 44 to this:

["${MAIL_ADDRESS}"] || MAIL_ADDRESS=
"example@e-mail.com";

Save the file and close the editor.

Make the script executable with the following
command:

$ chmod u+x rules_du_jour

To run the script, give yourself superuser privi-
leges with the su command and then enter the
following command:

./rules_du_jour

Rules Du Jour goes to work and retrieves the
most recent rule set for SpamAssassin.

This task is a natural for automating. Check
out Technique 20 for information about using
Task Scheduler to schedule RulesDulour to
run nightly, while network usage is low.
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The Internet e-mail system consists of three components:

v MUA (mail user agent): Evolution and Mozilla mail are both popular
mail user agents (also known as e-mail clients).

v MDA (mail delivery agent): The MDA moves the e-mail from Sendmail
into your local mailbox. Procmail is a popular Linux MDA.

v MTA (mail transfer agent): The MTA moves e-mail from one machine
to another across the Internet. Sendmail is an MTA.

Most users’ interaction with e-mail stops with their mail agent, when they
press the Send button. However, if you're running the mail service for a
domain (rather than having an ISP provide the mail service), you need to
interact with the mail transfer agent.

Sendmail is easy to use, but also incredibly flexible and powerful. In this
technique, we introduce you to Sendmail, and the easy-to-use configura-
tion interface provided by Webmin. If you need to manage configuration
files, Webmin is a definite timesaver.

Registering Your Address

Before you can send or receive e-mail with Sendmail, you need a registered
domain name. You can purchase a name with a permanent address from an
ISP or a name registry, or use a free Dynamic DNS service for sites that
change addresses from time to time. Technique 42 has good information
about using Dynamic DNS services — check it out.

Taming a Sendmail Server

Setting up an e-mail server with Sendmail is simple. The sendmail RPM
packages are included in most Linux distributions, and come with a
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pretty fair configuration file to get you started. The
installation and initial setup is super-fast!

To install Sendmail, follow these steps:

1. Open a terminal window and give yourself
superuser privileges with the su - command.

2. Insert and mount your distribution media. Use
the cd command to move into the directory
containing the sendmail RPM packages.

3. Install sendmail with the following command:
# rpm -Uhv sendmail-version.i386.rpm

4., Install the sendmail configuration file with the
following command:

#irpm -Uhv sendmail-cf-version.i386.rpm

Be sure to choose the version that you see on
your distribution media.

That’s it — Sendmail is installed.

To start Sendmail on a Fedora computer, use the fol-
lowing command:

# service sendmail start

If you're a SuSE user, type in this command:

# rcsendmail start

Or, if you're running Mandrake Linux, use this
command:

# /etc/init.d/sendmail start

The configuration can still use some tweaking, but
Webmin can help with that, as described in the next
section.

Tweaking Your Configuration
Files with Webmin

In Technique 17, we walk you through an installation
of the top-notch tool, Webmin. If you haven’t
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installed it already, check out Technique 17 for
instructions.

e tool that provides an easy-to-use interface for
servers, security issues, and other administra-

tive tasks. It's definitely worth getting to know.

z Webmin is a browser-based administration
E<]

&

After installing Webmin, follow these steps to access
the Sendmail Configuration menu:

1. Open your favorite Web browser and surf to
localhost:10000/

Webmin opens to the login screen.

2. Enter your user name and password and click
the Login button.

The Webmin main menu appears, as shown in
Figure 48-1.
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* Figure 48-1: The Webmin main menu.

3. Click the Servers button at the top of the page.
The Servers page opens.

4. Click the Sendmail Configuration button, near
the bottom of the page.

The Sendmail Configuration menu opens, as
shown in Figure 48-2.
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One quick glance tells you that Sendmail is a com-
plex but powerful program. Fortunately, most of the
default configuration options are okay, and the cus-
tomizations are simple with Webmin. The following
sections detail how to customize settings from the
Sendmail Configuration menu.

Serving up mail for multiple domains

You can use Sendmail to retrieve e-mail from multi-
ple DNS servers if you have multiple registered names
that point to the same server address. To serve up
e-mail for multiple domains, you need two things:

v Multiple DNS records that list your server and its
current address
v Multiple listings in the Local Domains list for

your Sendmail configuration file

From the Sendmail Configuration menu, follow these
steps to add the listings to the Local Domains list:

1. Click the Local Domains (Cw) button near the
top of the Sendmail Configuration menu.

The Local Domains page opens, as shown in
Figure 48-3.

* Figure 48-3: The Local Domains list.

2. Add your domain names to the list and then
click the Save button.

You can send and receive e-mails only from
registered names that point to your current
e-mail address.

Relaying e-mail

If you need to allow remote employees to send e-mail
through your local network, take advantage of the
Spam Control (Access) feature of Sendmail. With
message relaying, the end user sees your employee’s
e-mail as coming from your local network even if

the employee is accessing your mail server from a
distance.

This feature is really intended to keep nasty
6 people out of your system. Spammers with ill
intentions often hack systems to route e-mail

through unsuspecting Sendmail hosts. Be cau-
tious about setting up relays for friends or
employees with loose security habits.

From the Sendmail Configuration menu (refer to
Figure 48-2), follow these steps to set up message
relaying:
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1. Click the Spam Control (Access) button to open
the Spam Control menu, shown in Figure 48-4.
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* Figure 48-4: The Spam Control menu.

2. Choose Domain from the Mail Source drop-
down list, and to the right of this list, enter the
domain address of your remote employee.
Then select the Allow Relaying radio button
and click Create.

The new relay is added to the list of sources.

3. Click the Return to sendmail configuration link
(at the bottom of the page) to go back to the
Sendmail Configuration menu.

4. Click the Stop Sendmail button at the bottom
of the page. When the button name changes
to Start Sendmail, click it again to make the
changes to your configuration file take effect.

Using aliases to simplify mail handling

You can redirect e-mail on your system with Send-
mail’s Alias feature. If you have an incoming address
that you want distributed to multiple individuals, fol-
low these steps:

1. Click the Mail Aliases (Aliases) button on the
Sendmail Configuration menu.

The Mail Aliases menu appears.

B
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7 You may want to use the Alias feature to dis-

(«a tribute sales inquiries to your entire sales force,
technical inquiries to an entire support depart-

ment, or a humorous mailing to everyone.

&

2. Enter the address in the Alias Address field.

The address should not include a domain or an
extension.

3. If you want the alias to take effect immediately,
check the Enabled radio box.

4., In the Alias To drop-down list box, select
Addresses in File, and to the right of the
list box, enter the file name, as shown in
Figure 48-5.

5. Click Create to add the new alias.
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* Figure 48-5: Creating a mail alias.

The new alias is created and added to the list. Now,
when an e-mail is sent to the address in the alias,
Sendmail redistributes it to all the e-mail addresses
in the file.

] You can create e-mail address files quickly
- («@ with your favorite text editor. Enter one
& address per line and save the file somewhere
safe but memorable.
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Any server is a potential security risk. With an
e-mail server, you run multiple risks from
hackers that want to exploit the free use of

your server (and address) to create potential
system vulnerabilities. A UML jail might be a
good place to keep a mail server — see
Technique 58 for details.
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Backing Up Means
Never Having to
Say You're Sorry

The 5th Wave By Rich Tennant

“You ever get the feeling this project
could just up and die at any moment?"
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up an archiving scheme that’s easy to use (and easy to restore

from) is important. Unless you make the process quick and easy,
and enforce your routine with discipline, you'll find it too easy to slack
off and forget to back up an irreplaceable piece of work. We know —
we’ve had to learn the hard way.

ﬁ rchiving important data is vital — no question about that. Setting

For the small system or single computer, the consequences of data loss
might not affect other people, but losing your own work is still losing
time. Having a dependable backup system is just as important to single
users as it is to administrators of large networks.

Choosing the right backup media can make the difference between
painful and tedious backup jobs, and backup jobs that are simple and
unobtrusive. If you're the administrator of a large network, it’s especially
important that you choose your media well — other people’s work is in
your hands. Choosing dependable media (preferably stored off-site)
helps ensure a safe recovery if you do need to restore from backup.

In addition to choosing the type of media you’ll be using to back up your
system, you need to consider whether incremental, differential, or full
backups are best for your system. Differential backups are great if
resources (such as money for media) are limited and you don’t need to
restore often. Incremental backups are quicker to restore, but they con-
sume more media than a differential backup. If you need to restore from
backup often but have the resources to do full backups, automating full
backups saves restoration time in the long run.

Selecting a good archive tool is important, too, and you have a large num-
ber of options. Commercial backup tools are typically easy to use and
well suited for both commercial and home use. A ton of free archive tools
are also available, a few of which are already loaded on your computer.

In this technique, we give you some food for thought about choosing a
backup scheme for your system. Whether your system is large or small, if
you've got important information on it, backing up is important. We give
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you some factors to consider to help you choose the
right media, archiving scheme, and archive type.

Deciding What to Archive

When you consider putting together a backup plan,
your first instinct might be to back up everything.
That way, if anything goes wrong you can get your
data back quickly. But consider how much media
you would need to archive your entire system. These
days, it’s not uncommon to find notebook comput-
ers with 60GB hard drives. Given that a CD holds
only 660MB (or 0.66GB), you would need 100 discs
to back up the whole drive. (Actually, you would
need fewer than that if you use compression.) You
wouldn’t want to back up your system very often at
that rate.

Instead, back up only data that you can’t easily
reproduce. You know that you can reinstall Linux on
your computer without too much hassle. You can
reinstall all the RPM packages and other software
that you've loaded. And you certainly don’t need old
log files and temporary files. That narrows your
backup requirements considerably.

So what should you archive? Basically, anything that
you've created or modified, including the following:
v Configuration files
v User home directories

v E-mail (if you store e-mail on your computer
rather than at your ISP)

v Software (or other projects) that you've
developed

Choosing Archive Media

Choosing an archive media type is a matter of finding
a balance among the following factors: the cost of the
backup device and media, the speed and ease of use,
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and how much data the media can hold. The value of
your data should definitely impact your choice as
well. Here are several media types to consider:

v Tape drives

v Removable disks (SCSI drives or external hard
drives)

v Removable non-optical media (Jaz and Zip
drives)

v Removable optical media (CDs and DVDs)

v Online storage services

The size and configuration of your system influences
the requirements of your backup scheme. Good
backup media for one system isn’t necessarily a
good choice for another.

Making the trade

When putting together a backup plan, a major trade-off to
consider is recovery time versus the amount of media you
need. If you're a small network or single computer user, you
can choose to back up only the things you can’t replace —
e-mail files, data files, high score files for your favorite games,
and so on. On the other hand, if you archive data and pro-
grams, you won't have to reinstall (and reconfigure) all of the
programs you already have on your system.

Tape drives

A tape drive is a good choice for backing up large
systems. In fact, a tape drive is often the only practi-
cal choice if you have a lot of data to archive. Many
consumer and business tape drives are available
with a wide range of prices and capacities. Tape
drives can be either internal or external, and they
come in a variety of formats. You can choose from
dozens of drive manufacturers.

The biggest advantage of a tape backup scheme is
the storage capacity. Depending on the tape drive,
the contents of a complete system can easily be
archived onto a single tape. Tape media is also very
affordable, so keeping archived backups generally



isn’t a problem. The biggest investment is in the tape
drive itself.

Tape drives can range in price from hundreds
to thousands of dollars, depending on the
backup capacity. Although the drive might be
expensive, the media is affordable, making it
feasible to archive backups.

One disadvantage of using tape backup is the rela-
tively high failure rate compared to other media
types. Tape drives also tend to be slower than other
backup types. For a large system, they can be a good
choice, but for a small system, you might want to
consider other options.

Removable and external disk drives

If you're backing up a single machine, removable or
external hard disks are good options to consider.
They’re fast and dependable, and the prices are drop-
ping almost daily. With an external FireWire drive,
you can back up an entire computer in minutes.

@ FireWire is a very fast hardware protocol. If
e { <@ your system supports FireWire, look for
-

FireWire-enabled devices to save time.

Removable hard drives are drives that fit into a slot
on your computer. Plug one in, and you’ve got an
extra drive that you can use to hold archived data.
Unplug it and store it someplace safe so you’ll have a
backup if you need it.

Removable hard drives are too expensive for most
people to use for archiving backups; buying a bunch
of hard drives to store would add up fast. They are
also more fragile than other media — jostling a
removable drive in and out of the slot doesn’t help
its longevity. Still, for backing up a small system,
removable hard drives can be a good choice.

External drives are a better choice for many people
than removable hard drives. They're sturdier, and
because the connection is made with a cable instead
of a slot, the chance of damaging the drive in the
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process of connecting it is minimal. External drives
hold a good amount of data and are very affordable.
With a FireWire interface, they're also fast. Many
external drives offer both FireWire and USB connec-
tions for more flexibility.

] Depending on your system, you can also use a
S (ﬂ FireWire external drive as an alternate boot
) disk.

Flash drives, SD memory cards, CompactFlash, and
other removable media types also deserve mention.
They’re little, but they’re really handy if you just
need to back up a small amount of data.

] Use a flash drive as a backup container for
(«ﬂ your passwords. Make copies of your

~/.gnupg directory and ~/ . ssh directories,
as well as encrypted text files containing other
passwords you need often. Now, you can eas-
ily take your passwords and keys with you
when you travel.

Be sure to encrypt cleartext password files and
6 your private keys in case you lose the flash
drive.

Removabhle media

&

A Zip drive is like a floppy drive on steroids. It can
hold a good amount of data, it’s easy to store off-site,
and it’s portable and network friendly.

A Zip drive can be either internal or external (ITomega
even has an external FireWire available), and the
media itself is rugged and portable. The largest Zip
drive currently holds 750MB — that’s a little bit
more than a CD.

Zip disks are more expensive than blank CDs or DVDs,
and most systems now come with a CD or DVD writer.
On the upside, Zip drives have two main advantages:
Writing data to a Zip drive is much faster than writ-
ing to a CD or DVD, and a Zip drive is inherently
rewritable (it’s just a disk drive). Zip disks are about
as durable as CDs.
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Optical media (CDs and DVDs)

CDs and DVDs might be the best backup media for
the small network or single system user. They're dirt-
cheap, durable, easy to use, and fast. They store for-
ever (well, a long time anyway) and move easily
from one machine to another. Most new computers
come with a CD or DVD recorder, and if it’s not
included, it’s easy to add at a fair price.

What’s the downside? A CD doesn’t hold very much
data — 660MB or so. A DVD can hold 4.7GB. Is that a
problem? Probably not if you're backing up a single
computer or a small network. Each disc holds enough
data that you can most likely back up an entire sys-
tem with just a handful of discs.

] DVD recorders are just starting to show up in
- («a consumer-level computers, but you can easily
add an external DVD writer, and the once-high
price tags are dropping fast. A DVD holds con-
siderably more data than a CD, so the time
you can save in backing up makes the invest-
ment in a DVD recorder worth considering.

CDs or DVDs may not be the perfect storage answer
for a large system, but for a single machine or small
network, they’re great.

Online storage

Online storage services abound — just run a Google
search, and you'll find hundreds of them. The serv-
ices range in price from free (for 5GB or so of backup
space) to reasonable, and if you have a good (fast)
network connection, online backup is a good choice.
Online storage has the added advantage that your
data is being stored at a different physical location
from your home or business. If your building burns
down, you know your backups are safely stored
somewhere else. Of course, if you use an online stor-
age service, you're trusting them with your data —
and it may be difficult to recover your data should
the provider go out of business.

Online backup services offer the single user or small
network administrator a user-friendly and secure
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interface for quick updates to archive files. The
administrator of a larger system will find conven-
ience in scheduling whole-system backups for times
when network usage is lowest. In either case, online
services are friendly (usually), easy to use, and safe.

Choose a dependable service (preferably one that’s
been in business for a while, with good references),
with an interface that works for you. With a fast (and
secure) connection, online storage might be the best
choice for you.

Choosing an Archive Scheme

You can choose from three basic backup schemes:
full, differential, and incremental. They each have
advantages — some save restoration time, and some
save media.

Cost, convenience, and time are the primary
considerations when choosing an archiving
scheme. For example, if you need to shuffle

a lot of discs to do a full backup, run a full
backup once a week, and schedule unattended
incremental backups on the days in between.
Or, if you use a tape changer (or an online
service), you can schedule a full backup every
night.

Full backups

A full backup is just that — an archive that contains
all the data that you want to save. You can create a
full backup without archiving every program and
data file on your computer; you can pick and choose
only the files that you can’t conveniently re-create.
What makes a full backup different from the other
schemes is that you archive all the selected data
every time you back up.

Differential backups

A differential backup saves only the data that
changes from one day to the next. To build a differ-
ential backup set, you start each cycle with a full



backup on the first day. Each backup after that is a
snapshot of the changes made since the previous
backup. Keep the initial backup and all the snapshots
in a safe place in case you need to restore data. Every
so often, start the cycle over again. The cycle always
starts with a full backup.

You need at least two full sets of backup media
to use incremental media safely so you don’t
write over a backup that you may need to
restore from.

To restore from a differential backup, apply the
entire chain of archives, starting with the most
recent complete backup and appending each snap-
shot in sequence. If the last full backup was a month
ago and you back up daily, you’ll have 31 tapes in
your archive to restore.

Incremental backups

To use an incremental backup scheme, take a full
backup on the first day and then a differential backup
on the second day. The second day’s backup includes
only those files that have changed since the last full
backup. The third day of an incremental backup
scheme captures all file changes that have taken
place since the last full backup.

Incremental versus differential backups

You may be thinking that an incremental scheme
sounds suspiciously similar to a differential scheme.
They are in fact very similar — each scheme archives
only the data that’s changed. The difference is that a
differential scheme archives the changes since the
previous differential backup; an incremental backup
archives the changes since the previous full backup.

Here’s an example:

1. You start with a full backup Sunday night.

2. On Monday, you create a new file named
/home/freddie/spybusiness.html. Monday
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night, you create a differential archive that con-
tains only the new file (spybusiness.htm1).

3. Tuesday morning, you create another new file
named /home/freddie/gadgets.html. Here’s
where the difference appears:

» If you create a differential backup, Tuesday’s
archive will only contain gadgets.html. (A
differential backup archives the data that’s
changed since the previous differential
backup.)

» If you create an incremental backup, Tuesday’s
archive contains both files: spybusiness.html
and gadgets.html (an incremental backup
archives the data that’s changed since the last
full backup).

You can see that an incremental backup scheme takes
more media than a differential scheme. The big
advantage of an incremental backup scheme (com-
pared to a differential scheme) shows up at recovery
time. If you need to recover from a hardware failure
(or from a nasty typo), you only restore the latest
full backup and the last incremental backup.

Having a backup plan

Formalize your backup plans and make them part of a rou-
tine instead of just performing a backup when you think
you've accomplished something really monumental. Some-
times, truly monumental or important things go unnoticed
until disaster strikes; unless you have a backup, you'll lose a
great piece of work. Make a plan and stick with it.

It's not good enough to just have a backup plan. You also
need to make sure that you can restore a backup if you
need to. Don't wait until the last minute to find out that
your tapes are unreadable or that an online service is flaky.
Test your media whether it's on-site or off.

How often you back up is a decision only you can make,
but consider how long it will take to reproduce the work
lost if your backup routine is sporadic. Backing up is easy
and painless, but losing a month’s work hurts.
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Choosing an Archive Program

Many archiving programs are available for backing
up Linux computers. Here are a few that you should
consider:

v AMANDA (Advanced Maryland Automatic
Network Disk Archiver): This suite of tools
is designed to archive entire networks. With
AMANDA, you create a single “backup server,”
and from there, you can archive any computer
that you can reach over the network. You
can even use AMANDA to back up Windows-
based computers. You can find AMANDA at
www.amanda.org.

v Arkeia Light: Arkeia is another network-enabled
backup tool. You can find it at www.arkeia.org.
The free version is missing a few features that
are included in the commercial program, but
Arkeia Light is still a very useable tool with a
nice-looking user interface. One of the big advan-
tages to Arkeia (the commercial version) is that
you can talk to a support person if something
goes wrong (a service you don'’t get with open-
source tools).

v Bacula: A relatively recent addition to the open-
source archive arena, Bacula has some heavy-
duty features that you may need in a large
organization. Bacula keeps a complete history of

all archive operations in a relational database
(SQLLite, PostgreSQL, or MySQL), which makes it
quick and easy for you to find the archive vol-
ume that contains the data that you're interested
in. And, because the history is stored in a data-
base, you can create custom tools and custom
reports from the archive history tables.

Bacula lives at www.bacula.org. Its motto is “It
comes by night and sucks the vital essence from
your computers” — how could you resist a tool
like that?

Mondo: Mondo is not really an archive program
as such — it’s a rescue tool. After you build a
bootable Mondo rescue disk, you can restore
your entire operating system without reinstalling
everything from scratch. Combine Mondo with a
complete backup plan, and you’ll recover from
hardware failures much faster. You can find more
information about Mondo at www.microwerks.
net/~hugo.

tar: Short for tape archiver, tar is the long-
running standard for backup. It’s versatile,
flexible, and reasonably easy to use. It’s also
available on every Linux (or UNIX) computer
you're likely to encounter (it’s even available
on many Windows systems). In the next tech-
nique, we show you how to use tar (together
with a helper tool named cdbackup) to create
multidisc backup sets on CDs or DVDs.
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v~ Estimating how much
media you'll need for your
backup

v~ Taking interim backups of
the directories that are
most likely to be lost

v~ Using incremental or dif-
ferential backup schemes

v~ Using tar and cdbackup
to make backup CDs

or an entire system. You may choose to do incremental backups,

differential backups, or full backups depending on the amount of
data you need to store and the value of that data (see Technique 49 for
details on the different backup types). One way or the other, you’ll be
using an archiving program.

B acking up data may mean backing up a single file, a directory tree,

tar is a simple but flexible tool that creates sturdy, portable archives.
You can use tar to create archives quickly and easily, and you can write
those archives straight onto your hard drive or onto other devices. You
can use tar to bundle files into archives, and move them easily and
quickly to CDs or thumb drives or across your network.

Performing interim backups of important directories that might be lost
through user error (such as home directories and e-mail files) can save
you from restoring from a system backup just to extract a single file.

tar won’t write straight to CD without a helper application — it’s great
with tape drives, but it’s not so hot with CDs. We’ve found a great helper
tool called cdbackup that we show you how to use in this technique.
cdbackup works with tar to create archives that can span multiple CDs
(or DVDs).

In this technique, we show you some useful variations on the tar com-
mand and give you a step-by-step introduction to differential and incre-
mental backup schemes. Remember, backing up means never having to
say you're sorry.

Estimating Your Media Needs

It’s nice to know how much media you’ll need before you start a backup.
You don’t want to get halfway through and find out that you need to run

to Office Depot to pick up more tapes. It’s also nice to know your archive
size if you're planning on carrying it with you on a thumb drive or other

removable media.



378

Technique 50: Backing Up Your Data

The easiest way to find out how much media you’ll
need to hold an archive is to make a dry run first. If
you're using tar to create the archive, use the same
options that you plan to use when you create the
real backup, but pipe the results to wc -c instead of
writing it to media:

## tar -cvplf - backupcontents | wc -c

The -f - option tells tar to write the archive to its
standard output stream. When tar completes, wc dis-
plays the total number of bytes required to hold the
archive. If you plan to create a compressed archive,
be sure to include the compression option when you
compute the archive size; otherwise, you’ll overesti-
mate the amount of media that you need. For exam-
ple, if you use bzip2 compression to create an
archive, calculate the archive size like this:

## tar -jcvplf - backupcontents | wc -c

The -j flag tells tar to use bzip2 compression; use
-z if you want to use gzip compression instead.

You need superuser privileges to back up files
that aren’t your own.

Creating Data Archives with tar

tar is an archive tool that you can use to create
backups. It’s been around for a long time, it’s stable,
and it’s relatively easy to use. Much of the data and
programs out on the Web are distributed as com-
pressed tar archives (affectionately known as tar-
balls). tar runs just about everywhere — Linux,
UNIX, Windows, and Mac — so the archives that you
create are portable. It’s included in even the most
basic of Linux installations, so you don’t need to
spend any time installing it.

] tar also has the advantage of knowing how to
e («a manage incremental and differential backups.

& That's a huge bonus if you're an administrator
on a tight media budget. Of course, you can
compress archives as you create them, saving
even more time and money.

Backing up files and directories

Before you start a backup, use the 1sof com-
mand to be sure files aren’t in use. The com-
mand 1sof | grep directoryname will tell

you if any files are open in the directoryname
directory tree. If the fourth column has any u’s
or wW's in it, someone has a file open in update
or write mode. See Technique 36 for more
information about using 1sof.

To archive a single file or directory with tar, enter
the following command:

# tar -cvzf archivename filename
Here’s a breakdown of this command:

v The -cflag tells tar to create an archive.

v The-v flag tells tar to run in verbose mode
(listing the archive content as it’s created).

v The -z flag compresses the archive using gzip
compression.

v The -f archivename option tells tar where to
write the archive. archivename can name a data
file, a device name, or - (standard output
stream).

You can follow the first 777ename with more file and
directory names to write multiple files to the same
archive.

- - (standard output). Use the - to pipe the

7 tar can write archives to files, to devices, or to
Q@,
archive to other commands.

&

In our examples, we use /dev/rmt0 as the device
name — a pretty common name for a tape drive.

Backing up account information and passwords

Use the following command to back up user account
information and passwords:

# tar -cvzf /dev/rmt0 \
/etc/passwd /etc/shadow



This command tells tar to create a gzip-compressed
archive containing the /etc/passwd file and the
/etc/shadow directory and write the archive to a
tape drive (/dev/rmt0).

Any user can read the user account informa-
@ tion stored in /etc/password, but you must
be the superuser to read the /etc/shadow file

(where the passwords are really stored).

Targeting bite-sized backups
for speedier restores

Keeping individual backups of the data that you're
most likely to need is a good idea — especially if you
use differential backups on a long backup cycle.
Instead of doing a complete restore cycle just to
recover the lost home directory of one sad user, you
can unpack the lost data from a small archive.

Here are a few directories that you may want to
archive separately to avoid a lengthy restore cycle:

v /home: The /home directory contains the home
directories of all the system users.

v /etc: The /etc directory contains most system
configuration files.

v /spool: The /spool directory contains mail-
boxes and print files.

To back up the /home directory and the /home/user
directories of all users, use the following command:

# tar -cvzf /dev/rmt0 /home

The tar command automatically recurses into subdi-
rectories, which means all files and subdirectories
underneath the parent are included in the new
archive.

Rolling whole file systems into a tarball

Use the tar command to back up an entire file sys-
tem by adding the -1 flag to the command:

# tar -cvlizf /dev/rmtO filesystem
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The -1 (lowercase L) option tells tar to stay within
the given filesystem. That’s important if you think
that fi7esystem might contain mount points for
other file systems.

To back up multiple file systems, append a list of
the file system names to the end of the command.
To find a complete list of the file systems on your
system, use the mount command with superuser
privileges:

# mount

The mount command returns a list of file systems
that looks similar to the list shown in Figure 50-1.

hd root kobe:~ - Shell - Konsole <2>
Session Edit View Bookmarks Settings Help

=
[susan@kobe susan]$ su -
Password:
[root@kobe root]# mount
/dev/hda2 on / type ext3 (rw,usrquota,grpquota)
none on /proc type proc (rw)
none on /dev/pts type devpts (rw,gid=5,mode=620)
usbdevfs on /proc/bus/usb type usbdevfs (rw)
/dev/hdal on /boot type ext3 (rTw)
none on /dev/shm type tmpfs (rw)
[root@kobe root]#

* Figure 50-1: The file system listing.

Use the listing to find the mounted file systems you
want to include in the backup.

If you need to create a multitape archive, add the -M
flag to the command:

# tar -cv1zfM /dev/rmt0 filesystemname

The -M flag won'’t help if you're using CDs or DVDs to
hold your archives, but we show you how to create
multidisc backup sets in the section, “Backing Up to
CD (Or DVD) with cdbackup,” later in this chapter.
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Starting a Differential
Backup Cycle

You can use the tar command to create incremental
or differential backups. We explain the subtle differ-
ences between incremental and differential backups
in Technique 49. You may want to check out that
technique before deciding on the type that’s right
for you.

Each time you create a backup in a differential or
incremental cycle, you include an extra command
line option:

-g snapshotfileName

The snapshot file keeps track of which files and
directories you've written to an archive. The next
time you create an archive using the same snapshot
file, tar saves only those files that have changed
since the previous backup. (It knows which files to
save by comparing the current state of your disk
with the information saved in the snapshot.)

It's a good idea to store tar snapshot files in a
directory that you aren't likely to clean out on
a regular basis. Don't put the log files in the
/tmp or /var/1og directories. Instead, create a
separate directory to hold snapshot files. In our
examples, we assume that you want to store
snapshot files in /backups.

For a differential (or incremental) backup scheme,
you start each cycle by creating a full backup. tar
creates a snapshot file that records the fact that the
archive contains a complete copy of everything that
you want to save.

To employ a differential backup cycle, follow these
steps:

7. On the first day of the backup cycle (assume it’s
Monday for this example), start by removing
the log file:

# rm /backups/etc.snap

2. Next, create a full backup with the following
command:

# tar -cvlfz /dev/rmtO \
-g /backups/etc.snap
/etc

Substitute your tape drive name for /dev/rmt0.

This command backs up the /etc directory and
everything underneath it. If you want to back up
more file systems, just append the names to the
end of the command line (and choose a more
meaningful name for the snapshot file).

Store the backup tape somewhere safe, like in a
fireproof safe or an off-site location.

3. On the second day of the cycle (Tuesday), use
the same command:

# tar -cvifz /dev/rmt0O \
-g /backups/etc.snap
/etc

This time, tar compares /backups/etc.snap to
the current state of the /etc directory tree and
saves only those files that have changed (or new
files).

tar also updates the snapshot file to reflect the
new state of your archive collection.

Store this backup in a safe place.

4. On the third day (Wednesday), use the same
command:

# tar -cvifz /dev/rmt0 \
-g /backups/etc.snap
/etc

Again, tar compares the snapshot to the current
state of the /etc directory tree. But this time, the
snapshot records the archive cycle as of the end
of the day on Tuesday. So, the archive you create
on Wednesday contains only the files that have
changed since Tuesday. When it’s finished, tar
updates the snapshot file to reflect the state of
your archive collection.



Wednesday's archive stores only the changes

made between Tuesday and Wednesday. The

changes made between Monday and Tuesday
are in the first differential archive.

Store Wednesday’s tape with Monday’s and
Tuesday’s tapes. If you need to restore from
backup, you need all the tapes to capture an
accurate picture of all the changes made to the
/etc directory tree.

You can see the pattern start to form. This cycle
goes on and on until you start over again with a full
backup. Each time you start the cycle, delete the
snapshot file first so that the first archive is a com-
plete backup.

Keep at least two cycles of media to be sure
@ that you have a backup to restore from in case

of emergency.
On the upside, although it takes a lot of media to cre-
ate a differential backup, it takes less time because

each backup represents only one day’s worth of
changes.

On the downside, if you need to restore data, you
have to restore all the days in the backup cycle.

Starting an Incremental
Backup Cycle

Incremental backups are a bit confusing at first, but
the concept is simple when you understand it. An
incremental backup works very much like a differen-
tial backup, except you have to manage the snap-
shot file more carefully.

A differential backup saves only the files that have
changed since the most recent backup. An incremen-
tal backup saves only the files that have changed
since the most recent complete backup. In other
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words, an incremental backup contains everything
that’s changed since the start of the cycle.

tar uses a snapshot file to decide which files it
needs to save. tar only saves files changed since the
snapshot was last updated.

So how do you get tar to save all files changed since
the beginning of the cycle? Simple — throw out the
update snapshot file after each incremental backup.
If you start an incremental cycle every Monday, you
want tar to use Monday'’s snapshot file on Tuesday,
Wednesday, Thursday, and Friday. (With a differen-
tial scheme, you use Monday’s snapshot on Tuesday,
Tuesday’s snapshot on Wednesday, Wednesday’s
snapshot on Thursday, and so on.) Shuffling snap-
shot files might seem like an odd way to get a good
backup, but it does work.

scheme is when you have to restore lost data.
You restore the first archive in the cycle and
the last archive — you don’t have to apply all
the intermediate archives like you would in a
differential scheme. That might not sound like
a big timesaver, but if your backup cycle is

30 days long instead of 7, you get to go home
for the weekend instead of shuffling tapes.

2 The advantage to an incremental backup
=)

Follow these steps to start an incremental backup
cycle:

1. On the first day of the backup cycle (assume it’s
Monday for this example), start by removing
the log file:

# rm /backups/etc.snap

2. Create a full backup with the following
command:

# tar -cvifz /dev/rmt0 \
-g /backups/etc.snap
/etc

Store the backup tape somewhere safe.
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3. On the second day of the cycle (Tuesday), make
a temporary copy of Monday’s snapshot file:

# cp /backups/etc.snap \
/backups/etc.tmp

4. Now invoke tar, but this time tell it to read
from (and update) the temporary snapshot file
rather than the master copy:

# tar -cvifz /dev/rmtO \
-g /backups/etc.tmp
/etc

tar compares /backups/etc.tmp to the current
state of the /etc directory tree and saves only
those files that have changed since the first
archive in the cycle.

tar also updates the snapshot file (/backups/
etc.tmp), but you'll overwrite that file on the
next day anyway.

Store this backup in a safe place.

5. On every other day in the cycle, repeat Steps 3
and 4.

In an incremental backup, each backup after
the initial backup contains all the changes that
have occurred between the first full backup
and the current state of the system.

On the downside, incremental backups take longer
to create, and they consume more media.

On the upside, if you need to restore data, you only
need to use two tapes to do it: the initial (full)
backup and the most recent incremental.

Restoring from Backup with tar

Restoring from backup with tar is as easy as backing
up with tar. Instead of creating archives, you use
tar’s extract command to extract the data that you
need.

To restore an entire directory tree, move to the root
directory and use the following command:

# tar -xzvf /dev/rmtO /directoryname

To restore a single file, use this command:

# tar -xzvf /dev/rmtO /directory/filename

You can restore many files (or directories) at once
by listing the names at the end of the command line.
Be sure to use the same compression options that
you used when you created the archive.

If you've used an incremental backup scheme,
extract the files that you want from the full backup
tape first, and then extract the same files from the
most recent incremental backup. (If the files that you
want to extract haven’t changed since the full
backup, they won’t appear in the incremental
archive, but that’s okay. You should still try to
restore from the incremental archive just in case.)

If you're keeping incremental backups, you'll
@ restore two backups: the first backup and then
the most recent incremental backup.

Restoring from a differential backup is the same
basic procedure, but it takes more time because you
have more tapes to go through.

7 Hopefully you've kept simple interim backups
e (481 of the files you're most likely to need to
& restore (see the section, “Targeting bite-sized

backups for speedier restores,” earlier in this
technique), and you'll have to restore from a
differential backup only in the case of an
extreme disaster — we’'ll all hope that doesn’t
happen.

If your system is damaged to the point where you
can’t boot into Linux, don’t panic. Just reinstall
Linux and then restore your data from backup.

See — aren’t you glad you have a good backup plan?



Backing Up to CD (Or DUD)
with cdbackup

Without a little help, tar cannot write archives
directly to CD or DVD media. You could write an

archive to your hard drive and then copy the archive

to a CD (or DVD) with a tool like k3b or nautilus, but
that’s a hassle. You’d need enough free space on
your hard drive to hold the intermediate copy, and
you’d have to figure out how to split a big archive
onto multiple discs — definitely not a timesaving
technique.

Fortunately, the open-source community comes to
the rescue again. The cdbackup and cdrestore com-
mands are helper programs that you can use with
tar to write archives onto a CD or DVD. cdbackup
writes straight onto a CD or DVD without laying
down a file system first. That saves you some space
and time, but you won’t be able to read the discs
with other programs. cdbackup can write a large
archive to multiple discs (something that tar can’t
do by itself). Because cdbackup cooperates so well
with tar, you can use the combination to create
complete backups, incremental backups, and differ-
ential backups that span multiple discs.

You can find the CDBackup package at the author’s
Web site: www.muempf.de/index.html.

Creating the backup

Creating a multidisc backup with tar and cdbackup is
easy:

1. Type in the tar command that archives the
data that you want to save and then tell tar to
write the archive to its standard output stream,
like this (but don’t press Enter yet):

# tar -zcvf - /home /etc

Backing Up to CD (Or DUD ) with cdbackup
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2. Then pipe the archive to cdbackup:

## tar -zcvf - /home /etc | cdbackup -m
-r 0,0,0 -a "My Backup"

If you're burning a DVD instead of a CD, be sure
to include -1 4600 in your command line so
cdbackup knows that it can write up 4.6GB per
disc (-1 4700 might be safe too, but leave your-
self a little wiggle room).

tar starts building the archive, and when it has
enough data, cdbackup starts writing it to CD
(or DVD).

3. Press Enter, and your backup begins.

)

When cdbackup fills the first disc, it prompts
you to insert a new one. After you do so, press
Enter to continue.

Under the hood, cdbackup uses the cdrecord package
to do the tough work. In fact, you can pass command
line options to the underlying cdrecord command
when you invoke cdbackup. Table 50-1 lists some of
the more useful cdbackup options.

TasLe 50-1: HANDY cDBACKUP OPTIONS

Option What It Does

-m Enables multidisc recording

-r device Specifies which CD/DVD drive to record to

-s speed Specifies the write speed (the default write
speed is 4, or 4 times the normal write
speed)

-a label Adds a descriptive name (7abel) to the
archive set

-1 size Tells cdbackup how many megabytes can
fit on one disc (the default is 650 — about
the size of a blank CD)

-- options Passes command line options to the

cdrecord command
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v

o, | don’t want a moment to reflect
on my backup.”

By default, cdrecord (and therefore cdbackup) pauses for
ten seconds before it starts burning a CD, giving you a
chance to change your mind and cancel the burn. That
pause can get a bit annoying after a while. You can shorten
the delay by including a cdrecord option at the end of the
command line:

# tar -zcvf - /home /etc | cdbackup -m -r
0,0,0 -a "My Backup" -- gracetime=2

The -- flags tells cdbackup to pass the rest of the com-
mand line options to cdrecord. In this case, gracetime=2
shortens the preburn delay to 2 seconds (the minimum
allowed by cdrecord).

If you don’t know the full name of your CD/DVD recorder,
run the following command:

# cdrecord -scanbus

You should see a result similar to this:

scsibusl:

1,0,0 100) 'TEAC' 'DW-224E ' 'F.OA' CDRW
1,1,0 101) *

1,2,0 102) *

1,3,0 103) *

1,4,0 104) *

1,5,0 105) *

1,6,0 106) *

1,7,0 107) *

Find your recorder in the list: The first three numbers on
that line make up the device number. If you see more than
one device in the list, choose your drive by its model name.
In our case, we would tell cdbackup to record on device
1,0,0.

Restoring from a CD or DVD backup

To restore a file (or set of files), you use cdrestore
and tar. For example, to restore the /etc/passwd file
from a backup set, place the first disc in the drive
and then type this command:

## cdrestore /dev/cdrom -t 1 | \
tar -zxvf - /etc/passwd

If the file you're looking for is not on the first disc,
cdrestore prompts you to insert the next disc; press
Enter to continue. In fact, cdrestore asks you to
insert the next disc even if it does find /etc/passwd
on the first disc. cdrestore can’t tell when tar has
finished its work, so when you’re sure you have the
files that you need, you can just press Ctrl-C to kill
the job. Be careful though, because the file that
you're looking for may be split across multiple discs.

When you run cdrestore, you can use the normal
/dev/cdrom device name instead of -r 1,0,0. The

-t 1 option tells cdrestore to read from the first track
on the disc (yes, cdbackup can write multiple tracks
so cdrestore can read them). Pipe the output from
cdrestore to tar and tell tar to extract the files that
you want. Notice that you can use compression
(either the -z gzip variety or the -j bzip2 variety).
You have to specify the compression type when you
create the archive and when you restore from the
archive.

To see a listing of the archive content, use the
following command:

## cdrestore /dev/cdrom -t 1 | tar -ztvf -

The cdrestore part of the command is the same, but
you use the -t flag to list the content instead of -x to
extract it. You can also use the -q flag to view infor-
mation about the disc that you have in the drive:

# cdrestore -q /dev/cdrom

Tracks: 1
Disk size: 666000 kB ( 333000 blocks)
Space used: 1872 kB ( 936 blocks)

Space avail: 641328 kB ( 320664 blocks)
Track 01: 1 MB: Part 2: My Backup

Restoring from a disc containing
multiple archives

One of nicest cdrecord features is that you can write
multiple archives to the same disc. For example, if
you use an incremental or differential backup plan,
you might do a complete backup on Sunday and an



incremental (or differential) backup every weekday.
The weekday backups are likely to be small enough
to fit on a single disc without filling it up. With
cdrecord, just put Monday’s disc in the drive when
you create Tuesday’s archive because cdbackup is
smart enough to append the new archive to the end
of the disc. If you have multiple tracks on the same
disc, cdrestore -q shows you all of them:

# cdrestore -q /dev/cdrom

Tracks: 3
Disk size: 666000 kB ( 333000 blocks)
Space used: 64442 kB ( 32221 blocks)

Space avail: 587758 kB ( 293879 blocks)
Track 01:10 MB: Part 1: Monday's backup
Track 02:20 MB: Part 1: Tuesday's backup
Track 03:10 MB: Part 1: Wednesday's backup

Backing Up to CD (Or DUD ) with cdbackup
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When you restore from a multitrack disc set, just tell
cdrestore which track you want to start with, as in
the following example:

# cdrestore /dev/cdrom -t 2 | \
tar -zxvf - /etc/passwd

The -t 2 flag tells cdrestore to read from track 2
(Tuesday’s backup).



Ouick Backup to
Remote Storage

Technique

Save Time By

v~ Creating and moving
archives with tar
and ssh

v Backing up to tape drives
on remote hosts

v Using rdist with ssh for
simple remote backups

v~ Creating simple remote
backup commands that
you can automate

where it’s feasible to use a second computer as a backup device.

Keeping a backup computer system on your own network or at
another office accessible from the Web is a viable option for many com-
panies. You don’t need fancy backup software to mirror your data on a
remote computer; Linux already includes the tools to do the job.

The price of a well-outfitted computer has dropped to the point

In Technique 50, we show you how to use the tar program to create
archives of your data. In this technique, we show you how to combine
tar and ssh (the secure shell) to create archives on a remote computer.
When you use ssh to back up your data, the data stream is encrypted, so
you’re guaranteed that your important files won’t be read by the world.
You can use ssh across your local network or across the Web with equal
ease. Backing up with ssh is easier and quicker than mounting a network
drive — you don’t even need superuser privileges.

Piping compressed archives created by the tar command to the ssh com-
mand makes it easy and quick to back up to remote hosts. You can create
an archive containing your important files and move it to a remote host
with just one command. It doesn’t get much quicker than that.

You can also use the tar command in combination with ssh to write to
tape drives on remote machines. It’s a quick way to share resources on
your network without a lot of hardware investment or software conflicts.

We also introduce you to the rdist command. With rdist, you can create
a mirror image of your working system on a remote machine. A complete
copy of your important information is not only safe, but also ready to use
in an instant. Use the rdist command with ssh to make the remote con-
nection simple, fast, and secure. By using Task Scheduler with rdist and
ssh, you can even automate your nightly backups.

In this technique, we show you some shortcuts that work with some old
favorites to make backing up to remote systems quick and easy.
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Combining the Power of tar with
ssh for Quick Remote Backups

tar is an archiving tool that can create new archives,
display the contents of an existing archive, or extract
data from an archive. An archive is just a simple file
that contains other files within it. Archives are handy
because they let you work with (e-mail, copy, or back
up, for example) a whole collection of files with ease.
When you use tar to create an archive, tar copies the
contents of each file into the archive, along with some
bookkeeping information such as the file owner, file
permissions, and modification date. The Linux ver-
sion of tar (actually, the GNU version included with
Linux) can compress an archive on the fly, and the
compressed archive is usually smaller than the sum
of its parts.

tar by itself is a useful command, but add the power
of ssh, and you've got a great combination that
makes it easy to back up your data to a remote sys-
tem. You can also use tar and ssh to access tape
drives mounted on remote machines.

Testing the ssh connection to the remote host

tar and ssh are installed with most Linux distribu-
tions by default — you already have a working copy
of each program on your system. Before you try to
use tar and ssh together, test the ssh connection to
the remote host:

$ ssh remotehost

If the ssh connection is good, you're prompted for
your password.

It's unlikely that you'll get connection errors,
but if you do, you need to resolve them
before you can continue.

Creating a tar archive over the ssh connection

After you've tested the ssh connection, you're ready
to go. To create a tar archive over an ssh connec-
tion, use the following command:
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$ tar -zcv -f - /source | ssh remotehost
"cat > targetfile.tgz"

Replace the source and destination names with your
own. Then press Enter to start the backup.

Here’s a closer look at the preceding command:

v tar -zcv -f -:Creates a tar archive, using the
following options:

» z:Create the archive in compressed gzip
format.

» c:Create a tar archive.

» v: Use verbose mode. Display progress on the
screen.

» -f -:The -f archive option tells tar where
to write the archive. In this case, you want tar
to write the archive to the standard output
stream (which you’ll connect to the standard
input stream of the ssh command with the
pipe character | ).

v /source: Specifies the files and/or directories
that should be added to the tar archive. You can
add multiple files or directories to the archive by
listing each filename (or directory name), sepa-
rated by a space:

$ tar zcvf - /home /usr | ssh remotehost
"cat > targetfile.tgz"

The preceding command creates an archive

(on the machine remotehost) containing the
contents of the /home directory and the contents
of the /usr directory.

v |:Pipes the standard output from the first com-
mand into the standard input for the second
command.

¥ ssh remotehost: Opens an encrypted connec-
tion to the remote computer.

Vv cat > targetfile.tgz: Receives the data com-
ing through the standard input of the ssh com-
mand and directs it, byte-by-byte, to the file
named targetfile.tgz. This creates a duplicate
of the archive on the remote host, in the filename
specified.
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Whenever the remote command contains
spaces, you need to enclose the command in
quotes.

That simple tar and ssh command makes creating

tar archives on a remote machine about as quick
and easy as it gets.

Check out Technique 13 for more information
about using archives and tar. The tar man
page also details tons of options you can add
to the tar command to tailor this technique to
your system.

When you execute the command, you’re prompted
for your password on the other machine. Adding
public key authentication to the SSH connection
allows you to skip password authentication.

] Setting up a key ring for authentication takes
- { @ only a few minutes and can save you a lot of
& time in the long run. See Technique 33 for the
lowdown on setting up ssh to accept public
keys.

Backing up to tape drives on remote machines

One other quick trick you can do with tar and ssh is
to back up to remote tape drives. Just replace the
destination filename with the device name, and ssh
delivers your archive to the tape drive. For example,
if the tape drive on your remote host is named
/dev/rmt0, use the following command:

$ tar zcvf - /source | ssh remotehost "cat
> /dev/rmt0"

With just a few variations, the tar command pro-
vides a powerful backup tool. Use it with Task
Scheduler to automate nightly backups, and you’ll
really save time! (See Technique 20 for more informa-
tion about scheduling automated tasks).

Technique 51: Quick Backup to Remote Storage

Backing Up to a Remote
Computer with rdist and ssh

rdist is a command line tool that helps you maintain
identical copies of files or directories over multiple
hosts. You can use rdist with ssh to distribute sales
reports, inventory lists, or other files to remote
offices that need access to shared data. tar and ssh
make it easy to create an archive on a single remote
computer, but rdist can push complete directory
trees to any number of remote systems.

- Zﬂ You can easily back up a single system to

A multiple remote hosts with rdist.

You can also use rdist to back up important system
and data files to a remote host. With the cost of well-
outfitted computers at an all-time low, keeping a mir-
ror image of important files is financially feasible.
Using rdist to create a mirror image of treasured
files makes backing up quick and easy.

An rdist backup isn’t a perfect mirror image
@ of your complete working system. The boot
sectors of your local machine and any files

being used at the time of backup will be dif-
ferent on the remote host.

Testing the ssh connection to the remote host

Before you can use rdist, you need to have a clean
ssh connection with each of your targets. Test the
ssh connection at the command line with a trial
connection:

$ ssh remotehostname

If you've lived a good clean life, you should be able
to make an ssh connection to the remote host. If the
connection succeeds, you're prompted for a pass-
word and allowed to log in to the remote system.

- key authentication for you so you don't need
to enter a password. Check out Technique 33

for details.

z Save time by setting up ssh to handle public-
g}

&
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Creating the distfile

After you've tested the ssh connection to the remote
machine, you must create a file (called distfile)
that contains the information that rdist needs to
run — such as the remote host name, the files you
want to transfer, and any exceptions to the default
rules.

To create a distfile, follow these steps:

1. Open a terminal window to your home direc-
tory and enter the following command:

$ kedit distfile

kedit opens into a fresh file, waiting for your
distfile code.

2. Enter the following code (substituting your
username and remotehost name):

HOSTS = ( username@remotehost )
FILES = ( ~/ )
EXCEPT = ( ~/Desktop/Trash )

${FILES} -> ${HOSTS}
install -oyounger,whole target
except ${EXCEPT}

3. Click the Save icon on the toolbar and close the
editor.

You've just created a basic distfile. The first three
lines of the distfile define a few variables that
make it easy to write the rest of the file:

v HOSTS: This variable holds a list of one or more
host names. (If you want to distribute data to
more than one host, list each host name between
the parentheses, separated by spaces.) If you're
using ssh to establish the connection to a remote
machine, you can prefix the host name with a
user name followed by an @ character, like this:

HOSTS = ( freddie@bastille freddie@
lTouvre )

7

FILES: This variable contains a space-separated
list of the files or directories that you want to
copy to the remote host. In our example, we
want to copy the $HOME directory.

EXCEPT: This variable names the files that you
don’t want to send to the remote host(s). You
usually don’t need a duplicate of the Trash bin.

The second half of the distfile contains the com-
mands for rdist:

v The first line tells rdist to move the files (as

defined by the FILE variable at the top of the
distfile) to the hosts named by the HOSTS vari-
able (also defined at the top of the distfile).

The install command follows with the options
that rdist should use for the backup. In our
example, the option -oyounger tells rdist to
check the timestamp on the file and update only
those files that have been changed since the last
backup. The target names the directory on the
remote host that receives the backup. If you
leave it blank, rdist creates a duplicate of the
local directory tree on the host and copies the
files into the mirror image.

The -0 needs to be right next to the install
option; otherwise, rdist copies the files into a
directory named whatever install option
you try to use (for example, if you typed in
“-0 younger” instead of the correct
“-oyounger”, rdist would create a directory
named younger). To use multiple install
options, chain them together with commas,
like this: -oyounger,quiet, remove.

v The except command tells rdist to skip the files

that are named in the EXCEPT variable.

Table 51-1 lists some of the more useful install
options.
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TaBLE 51-1: USEFuL INSTALL OPTIONS

Option

What It Does

younger

compare

savetargets

whole

quiet

remove

This option compares the datestamp of
the files on the remote machine to the
local machine, and updates only the files
that have been changed since the last
backup. This is a great option if your sys-
tems are time-synced.

This option compares the contents of the
files and updates the remote version if the
files are different. Use the compare option
if your computers aren’t time-synced;
otherwise, you may transfer more data
than you need to, or you may miss impor-
tant changes.

This option makes a backup of each file on
the target before it overwrites the content.
The backup file is named f77ename.0LD.

This option preserves the whole path-
name when making the backup copy on
the remote host.

This option silences the feedback from
rdist as it creates the backup.

Use this option carefully because it
removes all the files on the remote host
before copying in the new backups of your
files.

Technique 51: Quick Backup to Remote Storage

Make sure that you want to remove files from
the backup before you use the remove option.
In the process of testing these commands, we
accidentally wiped out the CVS repository for
this book and the results of a (fortunately
completed) consulting project on one of our
systems. remove really does remove every-
thing. It's a good thing we had backups!

For more options to use with rdist, visit the
rdist manual page: $ man rdist.

Backing up

After you've tested your ssh connection and created
the distfile, you're ready to back up. Open a termi-
nal window and enter the following command:

rdist takes it from there, consulting the distfile for

$ rdist -P /usr/bin/ssh

the information it needs to complete the backup. It
doesn’t get much quicker than that!

9

B &
/E\

The last argument in the command must be

the complete pathname to the ssh program. It
would be nice if you could specify the transfer
program (ssh) in the distfile, but you can't.

As a real timesaver, set up a cron job to trans-
fer your files every night. See Technique 20 for
help using Task Scheduler to set up an auto-
matic backup in a snap!



Archiving Changes
with CUS

Technique

Save Time By

+* Using CVS to archive
projects

v Using cervisia to man-
age your repository

+” Reverting to a previous
project stage in an
emergency

v~ Creating project branches
and development lines

work on the same project without the risk of losing work. CVS

tracks changes to the files that make up the project. For example,
while writing this book, we stored each technique in a separate file in a
CVS repository. When we wanted to make a change to a technique, we
checked out the file, made our changes, and committed the changes back
to the repository. We both used the same CVS repository (in fact, Susan
was writing with a Macintosh, and Korry was making typos on a Linux
computer). Sometimes, the same technique was checked in and out sev-
eral times before it was done. With CVS, there’s no risk of data loss. If we
would have both gotten the same technique accidentally, the merge fea-
ture would have resolved the differences in the versions (not that it
would ever have happened). We also had a complete history of all the
changes that we ever made.

CVS (Concurrent Versions System) enables multiple developers to

When using a CVS repository, it’s a good idea to commit your changes
frequently. In addition to ensuring that your coworkers have access to
the latest version of your work, if something happens to your CVS client,
the CVS server will always have a copy of your latest work. This tech-
nique shows you how to use a CVS system to keep your work safe with
minimal time and effort.

CVS can be used with any type of file (though it’s not particularly power-
ful for binary files). System administration files, sales lists, artwork, and
programming projects are all good candidates for a CVS repository. If a
project goes awry, and you need to revert to a previous stage in your
development, CVS can reconstruct a working version from a previous
point in the project. We show you how in this technique.

CVS is a great timesaver — saving you time by avoiding the potential
problems that come from lost data and crossed development paths. With
CVS, you can secure your files and keep creativity flowing at a pace that
suits everyone.
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A CVS repository contains all the files that are rele-
vant to a developing project. Each developer (or
administrator, or author, or artist) checks out a copy
of a project file to make changes to it. The revised
file is then committed back to the repository, along
with comments (for easy review later). The master
copies always live in the repository; each developer
checks out a sandbox to play, er, work in.

CVS client software is available for most platforms,
so having many developers on a mixed-machine net-
worKk is easy. You can work in the environment of
your choice without causing any conflicts with the
overall project.

Checking whether CVS is installed

If you installed the Development Tools package when
you set up your Linux system, you probably already
have CVS installed. To check, type cvs at the com-
mand line and press Enter. If CVS is installed, Linux
displays a list of command options.

If CVS isn’t installed on your system, you can find
the RPM package on your Linux CD (or DVD), or just
search and download an RPM file from the Web. Visit
Technique 17 if you need help installing the RPM.

RCS versus CVS

RCS (Revision Control System) is the old versioning soft-
ware that is included with Linux. Unlike CVS, RCS works
only on a local machine, so its usefulness is limited to small
projects. CVS is constructed as a wrapper around RCS. The
storage mechanisms are the same, but CVS offers more
advanced functionality for managing complex projects.

Discovering what to use CVS for

CVS is good for all sorts of projects. It was developed
primarily to track changes to software development
projects, but it’s great for the following uses as well:

Technique 52: Archiving Changes with CUS

Keeping system configuration changes
Tracking Web site versions

Keeping manuscript backups

A W W WA

Tracking sales lists, inventories, art work, and so
on — basically any project that evolves over time

CVS ensures that you won'’t lose work. Whatever
project you're working on, you occasionally need to
back up, change direction, or just figure out what
changed. CVS can do all that in a snap, for anything
you can keep in a file.

Creating a CUS Repository

After CVS is installed on your system, you're just a
few quick steps away from having a working CVS
repository.

] Be sure you have plenty of disk space available
i («a on your CVS repository system. Remember
& that it's keeping not only the current project,

but also the project history. Repositories can
be huge, and not having to move them later is
a big timesaver.

In this example, you create a CVS repository to track
the changes in configuration files. You have to play a
few games with permissions because configuration
files can be modified only by someone with superuser
privileges. Most of the Linux configuration files reside
in the /etc directory (or a subdirectory of /etc).
You'll be creating a repository to hold the master
copies (and revision histories) of each configuration
file. The /etc directory becomes a sandbox; that is,
you can check a working copy out of the repository
and into the /etc directory tree.

Follow these steps to create a cvs group (only mem-
bers of this group can interact with the repository)
and a CVS repository:

1. Open a command line and give yourself
superuser privileges:

$ su
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When prompted, enter the superuser password.

w

Create the cvs group:

# groupadd cvsusers

If you see a message stating that group cvs
already exists, just ignore it.

4., Move to the root directory:
## cd /

5. Create a new directory for cvs:

# mkdir cvs

Keeping our repository directly under the
root directory is just a matter of preference. It
can reside anywhere you like.

6. Change the group ownership of the CVS
repository:

# chgrp cvsusers /cvs

7. Set the permissions for the cvs directory:

# chmod g+srwx /cvs

These permissions allow any member of the cvs
group to view or modify the files in the reposi-
tory. The g+s part ensures that all the files that
you store within the repository are also owned
by the cvs group.

8. Initialize the repository by typing the following
command and pressing Enter:

# cvs -d /cvs init

If you look in your new directory, you’ll find a subdi-
rectory called CVSROOT. The CVSROOT directory con-
tains administrative files for use by CVS.

Don’t forget to add the appropriate users to the cvs
group (at least add yourself).

) A fast way to add a user to your new group is
g («8

with the command /usr/bin/gpasswd -a
username groupname. To use this command,
you must hold superuser privileges.

b
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Populating Your Repository with Files

Populating Your Repository
with Files

After you've created a CVS repository, you need to
populate it. For now, just add a few files; you can
always add more later.

To add files to your repository, follow these steps:

1. Move to the directory that you’ll be archiving:
## cd /etc

2. Check out the top-level CVS directory:
## cvs -d /cvs checkout .

Don’t forget the . (dot) at the end.

The checkout command creates a sandbox. At
this point, the repository holds only CVS book-
keeping information, but later, a sandbox will
contain a working copy of each file in the
repository.

3. The cvs add command inserts a new file into
the repository, so add the hosts file as follows:
## cvs add hosts

4. You can also add subdirectories. This com-
mand creates a new subdirectory within the
repository:

# cvs add xinetd.d/

5. Now move into the /etc/xinet.d directory:
## cd xinetd.d/

6. Add all the files in /etc/xinet.d:
# cvs add *

7. After the files and directories are added to the
repository, move back to /etc:

#cd ..

8. At this point, you've scheduled a few files to be
added to the repository, but you haven’t com-
mitted your changes. To make your changes
permanent, use the cvs commit command:

# cvs commit -m "Adding initial files"
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The -m flag tells CVS that you want to include in
the revision history the text that follows. If you
don’t include the -m flag (and a comment), CVS
prompts you for a comment.

The primary Web site for CVS is www .
cvshome.org. This is a handy address to
have if you need downloads or more
information.

The CVS repository now contains a history file for
each file you added. You can’t use these files
directly; you have to create a sandbox and grab a
working copy. From this point forward, you never
change the masters.

If you look into each of the directories that you’'ve
added files from, you'll also notice that a CVS direc-
tory has been added to each directory. These direc-
tories hold the internal bookkeeping information
that CVS needs to do its thing.

Checking Files In and Out (Or
Playing in Your Sandbox )

When you want to change a configuration file, check
out a copy of the file you need from the CVS reposi-
tory and place it into your personal sandbox. When
you're finished modifying your local copy, you then
commit your changes to the repository. Here’s how
to do all that:

1. Atthe command line, type the following com-
mand and then press Enter:

$ mkdir ~/work

This command creates a directory to hold your
sandbox.

2. Move into the sandbox directory you just
created:

$ cd ~/work

3. Check out a work copy of the hosts file:

$ cvs -d /cvs checkout hosts
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Now, you've got a copy of the hosts file (in your
sandbox) that you can modify. Fire up your
favorite editor and czhange the file as you see fit.

4. Modify your local copy and then commit your
changes with the following command:

$ cvs commit -m "your comment here"
hosts

Use the -m flag to include your comment in

- («a your commit statement. It's not only faster, but
also saves you a trip into vi (or vim). vi can

be a cold, dark place.

When CVS is finished, it displays a message like
this:
Checking in hosts;
/cvs/hosts,v <-- hosts
new revision: 1.2; previous revision:
1.1
done

Neat and fast! Your changes are now stored in the CVS
repository. CVS keeps enough information to recon-
struct any version of the file. Note that you haven’t
modified the hosts file in the /etc directory, just the
version that’s stored in the repository. You still have
to update the /etc sandbox by following these steps:

1. Move into the /etc directory:
$ cd /etc

2. Give yourself superuser privileges with the su
command (nonprivileged users can’t change
the files in /etc):
$ su
Password:

#

3. Update the hosts file from the CVS repository:

# cvs update hosts
U hosts

That’s it. You've made a change to an important
Linux configuration file, but you've saved the origi-
nal version (in the CVS repository) and a useful com-
ment to tickle your memory later.
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Life at the command line is great, if you're used to
living there. But sometimes a great tool can help
speed up the process and, at the same time, be
friendly and easy to use. Numerous graphical inter-
faces for CVS are available, but one that works great
with KDE is included in most Linux distributions. It’s
called cervisia.

) Use the command line to create your initial
- (@ repository. You can use cervisia to check out
& files or add files to an existing repository
quickly, but it's not the right tool for creating
repositories.

cervisia is a CVS client that works with local or
remote repositories and provides a user friendly and
intuitive work atmosphere, as shown in Figure 52-1.

b M/ gaican /wo rkijcve) - Konguenor -mx
Location Edit View Go Bockmarks Advanced Repository Tools Sefings Window Help
: ) =l & M MR
L4 B FO DT a VvV O OGN [
b Lpcation: | = fle:/home/susanywerk Lk
Fila Mame = |'e.|am [H\wlm [taquum ]nmnump [L
nipd Lk L1 20040103 1811
pemcia Unknown L1 2004-01-03 1E11
prefink Unknown 11 2004-01-03 1811
rawdevices Unknown 11 2004-01-03 1811
redhan-conlig-secunirylevel Unknown L1 2004-01-03 1611
redhat-configusers Unknown L1 2004-01-03 1811
redhat doguiower Unknown 11 20040103 1811
samba Unknown L1 2004-01-03 1811
serulmail Unkrower: 11 2008-01-03 1811 |
syshog Ukt 1.1 2004-01-03 1811

2004-01-03 1611

xawty Unkrown 11
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+- 55 winetd.d

20040103 1511
20040103 1E11

= aml B
caralog Linknown L1

evs f update 4 P ‘sysconfigivacseners' 2-81
[Finished]

Dane

¢ Figure 52-1: cervisia in action.

For more information about using cervisia
across the Web, you can find the full docu-
mentation at cervisia.sourceforge.
net/documentation/index.html.
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Installing cervisia

cervisia is installed with KDE if you chose to include
the KDE Software Development package when you
first installed Linux.

If cervisia isn’t installed and you want to add it, use
your distribution’s installer to install the KDE Soft-
ware Development package (sometimes known as
kdesdk).

Putting files in your sandbox

To start cervisia, click the Start Here icon on your
desktop to open Konqueror. Navigate to your work
directory (your sandbox), and click the brick wall
icon at the far right of your toolbar.

Or, to create a new sandbox with cervisia, follow
these steps:

1. Open the Konqueror browser and navigate to
your work directory.

2. Choose Repository=>Checkout from the
menu bar.

The CVS Checkout dialog opens, as shown in
Figure 52-2.

» Kongquersr -0X
Location Edit View Go Bookmarks Advanced Bepository Tools Setfings Window Help

A4PAFOHODD @A V| OOEE B

- b.ug—amrl 2 il o s anfex amphe '| |

File Name = | status |Revision [1agate |Timestamp

Bepasitary |fevs * |
Module: L = | FechUst |
Branch tag

Working dnectory. | thome/susanjexampla fis

| betp ance |

* Figure 52-2: The cervisia CVS Checkout dialog.
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3. In the Repository field, enter the location of
your repository (/cvs if you’ve been following
along from the beginning of this technique).

4. Enter a . (dot) in the Module field.

5. Enter the pathname of your working directory
in the Working Directory field.

6. Click OK.

cervisia checks out the contents of your CVS
repository into your work directory.

This is either a bug or an undocumented fea-
ture, but we need to exit cervisia and restart
it before the files show up in the browser win-

dow. These things happen.

The contents of your sandbox are displayed in your
browser window and organized in the following
columns:

v File Name

v Status

v Revision Number
v Tag/Date

v Timestamp

To edit a file, double-click it, and the file opens in
your favorite editor, ready to edit.

7 See Technique 3 to set up the MIME map-
- («a pings for your editor. Between cervisia and
) MIME, you can edit and update your files in
no time!

Adding more files to your repository

Often, you have to add files to your CVS repository —
especially if you're using it for tracking your system
configuration files. To add a new file to your reposi-
tory, follow these steps:
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1. Enter the file location in the Location line of
your browser.

2. Right-click the file you want to add, and from
the pop-up menu that appears, choose Add to
Repository.

cervisia’s View menu contains an option to
Hide Non-CVS Files. If you can't see a file that
you know is there, make sure that you don’t
have that option checked.

3. When the CVS Add dialog opens, verify that the
file you’ve selected is listed and then click OK.

At this point, the file you’'ve chosen has been ear-
marked for inclusion, but it isn’t actually in the
repository.

4. Commit your addition by right-clicking the file-
name and choosing Commit.

5. Enter a log message (the more meaningful, the
better) and click OK.

Your file is added to the repository.

Go work on the file in your sandbox!

Committing your changes

When you’ve finished editing a file, follow these

steps to commit your changes to the CVS repository:
1. Right-click the filename and choose Commit.

A CVS Commit dialog opens (see Figure 52-3). It
shows the name of the file (or files) you're com-
mitting and supplies a field in which you can
enter a log message.

2. Enter a log message and click OK.

cervisia checks in your changes.



ha CVS Commit

Commit the following files:

bashrc

Older messages:

Current A

Log message:

Initial addition to the repository

| oK || Cancel ‘

* Figure 52-3: The cervisia CVS Commit dialog.

The next time you (or another user) check out the
file, you get a fresh copy that includes your most
recent updates.

Diplomacy 101 — resolving conflicts

At some point in time, despite the best efforts of sys-
tem administrators, two users will edit the same file,
and a conflict will arise. If Freddie and Georgette
both check out a file, both change it, and then both
check it in, CVS will catch the problem and try to
resolve it.

If Freddie and Georgette changed different parts of
the same file, CVS graciously merges the changes.
If they both change the same part of the file, human
intervention is called for.

If Freddie checks in his changes and then Georgette
tries to check in hers, Georgette sees an error mes-
sage stating that her copy of the file is not current.
If Georgette then updates her files, the files’ status is
changed to Conflict (assuming that CVS could not
resolve the differences by itself).
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cervisia has a handy problem solver built-in: the
CVS Resolve feature. If a file is highlighted in red and
the status is listed as Conflict, right-click the file-
name and choose Resolve from the pop-up menu.
The CVS Resolve dialog opens (see Figure 52-4).
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* Figure 52-4: The CVS Resolve dialog.

The merged version in the lower half of the screen
presents four possible merge options (A, B, A+B, and
B+A) and the option to edit the merged results. Click
the >> button to highlight the next conflict, and then
click the button for the merge option that is the best
solution to the conflict. If the combinations offered
aren’t correct, click the Edit button to edit the text.

Browsing your log files

cervisia includes a nice log file display tool that
shows graphical representations of all the changes
in a development tree. The browser enables you to
quickly determine where your project is and has
been recently.

To use the log browser, right-click the filename,
and choose Browse Log. The CVS Log dialog opens
(see Figure 52-5).
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* Figure 52-5: The cervisia CVS Log dialog.

Choose a revision from the tree, and the information
is transferred to the bottom half of the screen and
shown in Revision A.

Now, if you middle-mouse click another revision, the
information is transferred into Revision B. (Left-click
selects a revision into the Revision A fields; middle-
click selects a revision into the Revision B field.)

If you don’t have a middle mouse button,
move to the List view, and use the arrow keys
and Ctrl-A and Ctrl-B to select your revisions.

From the CVS Log dialog, you can use the Diff button
to display the differences between revisions, as
shown in Figure 52-6.
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* Figure 52-6: The cervisia CVS Diff dialog.

7 The Diff view can be your best friend in times
o («.

of trouble. If things get really off course, you
can use Diff to help you quickly find the point
in the revisions that took you off course.

&

The Annotate button shows you a line-by-line view of
the changes made to reach revision A (we call the
Annotate tool the blame button because you can see
who made a given modification). Hovering over the
screen entries shows revision information about that
line, as shown in Figure 52-7.

fd CVS Annotate: bashrc -[B]%

4
1.4 susan 04-Jan-04
Resolved conflict ‘

Close

¢ Figure 52-7: The cervisia CVS Annotate dialog.

Marking milestones with tags

The typical CVS repository holds many (sometimes
thousands) of files. It’s unlikely that you’ll modify
every file in the repository whenever you change
one file in the repository. Instead, troublesome files
are modified frequently, and stable files tend to
remain unchanged. That means that at any point in
time, you’ll have some files at revision number 1.5,
some files at revision 1.200, and a few at revision 4.2.
At certain points, you’ll want to tag all the files in the
repository so that you can get back to that point in
time without having to look up all the revision num-
bers yourself. A fag marks a point in time. The tag
(usually) includes all the files in the repository as of
a given date and time.

It’s a good idea to tag the repository whenever you
reach a point where the collective revisions make up
arelease or a working version of whatever it is that
you're tracking.

Simple tagging is quick and easy with cervisia. To
tag a version, follow these steps:



1. Highlight the top level directory (your sandbox
pathname) and choose Advanced~ Tag/Branch.

2. Enter a tag name and click the OK button.
That was fast, eh?

Here are a few points to keep in mind when choosing
tag names:

v A common naming convention is the project
name followed by a version number.

v Tag names can’t include blanks or punctuation
marks.

v Tags are most helpful when you’ve chosen mean-
ingful names.

- JustPriorToMessingUpMyConfigurationFiles
aren’t a bad idea. They can make it easy for

you to find a place to revert to.

z Names like WorkingConfiguration or
&)

b

To revert to a tagged revision of your project,
choose Advanced=>Update to Tag/Date. You have the
option to change your sandbox copy to a branch, a
tag, or a previous date.

[ Didn’t tag, but need to revert? No problem;
B> («& just select the Update to Date option button,

& enter your date, and click OK. You'll have a
new old sandbox in no time.
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Simplifying CUS with cervisia

Branching off with cervisia

When your project branches, it usually means that
one part of your project maintains the current devel-
opment path, while another part heads in a new direc-
tion. Software developers create branches all the
time. While one release is maintained and stable,
another branch is growing with radical changes. If
the changes don’t work out along the way, the origi-
nal, stable branch is still there and available for users,
or you can revert to it if needed. By branching off,
your project can remain on one development line
while evolving into another.

¥
&»(«
)

Branching with cervisia is similar to tagging:

Use a branch or a tag at any point in develop-
ment where your project will take a radical
turn. That way, you have a safe place to go
back to!

1. Highlight the top level directory in your sand-
box and choose Advanced= Tag/Branch.

The Tag/Branch dialog appears.

2. Enter the branch name, check the Create
Branch with This Tag box, and click OK.

You've branched out!

Create your branches in your sandbox, and
commit them just like any other change.
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Using Open-Source
APls to Save Time

Technique

Save Time By

v~ Using the Tibcurl library
to Web-enable your
programs

v~ Creating Flash movies
with Ming

ment time is to build programs using components developed by others.

In fact, every time you build a program that runs on a Linux computer,
you’re using open-source components. The C runtime library, the Linux
runtime library, and even the kernel functions are open-source APIs (API
stands for application program interface). Imagine how difficult your job
would be if every time you wrote a new program, you had to write a disk
driver, a windowing system, or even a complete operating system.

If you're a programmer, you know that the best way to save develop-

Using open-source APIs saves development time and debugging time. If
you start with trusted, well-written components, you can concentrate your
debugging efforts on the code that you're writing (and, because you're
using prebuilt components, that’s a lot less code).

Open-source libraries can also make your programs compatible with
standards and protocols used by other applications. In fact, in this tech-
nique, we show you how to write simple Web-enabled programs by using
two open-source APIs.

In this technique, we also show you the power behind cur1, which is a
command line program that can upload and download files from FTP and
HTTP servers. By adding the curl library (1ibcurl) to your programs,
you can easily interact with FTP, secure FTP, HTTP, secure HTTP, GOPHER,
telnet, dict, and LDAP servers. Your programs can handle cookies, use
network proxies, and even resume interrupted transfers with just a few
lines of code. Imagine how long it would take to write all that code by
hand.

We also show you a fun library named Ming. Ming creates Flash movies
(Ming, Flash Gordon, get it?). Flash movies are typically played in a Web
browser, but you can also download a stand-alone player. If you're not
familiar with Flash, surf to the Macromedia Web site (www.macromedia.com)
and watch a few of its Flash showcases. You can use Ming to produce static
(unchanging) movies that show bar graphs and pie charts (or just about
any other type of graph). You can also create interactive movies that you
can control with a mouse and your keyboard.
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Using the libcurl Library
(C Programming )

curl is a command line tool that can upload and
download files from HTTP and FTP servers. Actually,
that’s a gross oversimplification; cur1 knows how to
deal with HTTP, FTP, secure HTTP and FTP servers,
gopher servers, telnet servers, local files, and many
more protocols.

Downloading a file with curl is easy. For example,
to download a file named news.htm1 from the
example.com Web site (and save it to a file named
mylocalfile), execute the following command:

$ curl -o mylocalfile http://example.com/
news.html

curl is very similar to the more familiar wget, except
that wget can only download data; curl can move
data in both directions.

You can harness the power of curl in your own C
programs by making calls to the 1ibcurl APIL The
Tibcurl library comes in two flavors that you can
mix and match. The easy API defines only six func-
tions (and you can write useful, network-enabled
programs using only four of those functions). The
multi interface is more complex. When you call a
function in the easy API, your program pauses until
the function completes. The multi interface, on the
other hand, performs transfers in the background,
returning control to your program as soon as you ini-
tiate a transfer. In other words, the easy APl is syn-
chronous, and the multi interface is asynchronous.

You can find the cur1 (and 1ibcur1) Web site
at curl.haxx.se. You'll find complete (and
easy-to-follow) documentation about both the
easy and the multi interface.

The Fedora, SuSE, and Mandrake distributions all
include the curl command line program in an RPM
package named curl. To write 1ibcurl-enabled pro-
grams, install the curl package and the curl-devel
package.
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The multi API is built with functions defined by the
easy API. That means that you can mix functions
from both interfaces.

g Everything that you know about the easy
e («a interface is applicable when you build a more
& sophisticated program based on the multi

interface.

Uploading a File with a Simple
Program Using libcurl

Every 1ibcurl program starts with a call to an initial-
ization function (typically curl_easy_init()) and
ends with a call to a cleanup function (typically
curl_easy_cleanup()). In between these calls, you
use the curl_easy_setopt() and curl_easy_perform()
functions to create and execute transfer jobs. Listing
53-1 shows a simple program (named curlupload)
that uses 1ibcur1’s easy API to upload a file.

When you run curlupload (we show you how to
compile it in a moment), include two command line
parameters:

v The name of the file you want to upload
v The upload destination, specified in the form of

a URL

For example, to upload a file named photo. jpg to an
FTP server, use this command:

$ curlupload ./photo.jpg ftp://ftp.
example.com/pub/upload/

When you use this example in your own code,
be sure to add some error checking. Check
the command line arguments and be sure the

files are valid files. See the Tibcurl documen-
tation to find out how errors are reported to
your program.

The following sections take a closer look at some
lines in the curlupload program.



Uploading a File with a Simple Program Using libcurl

LiSTING 53-1: CURLUPLOAD.C
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1 /* File: curlupload.c

2 ** usage: curlupload <filename> <URL>

3 */

4

5 f#finclude <stdlib.h>

6 f#finclude <string.h>

7 ffinclude <curl/curl.h>

8

9 int main( int argc, char * argv[] )

10 {

11 CURL * curl;

12 FILE * srcFile = fopen( argv[1l], "rb" );

13

14 if(( curl = curl_easy_init()) != NULL )

15 {

16 char errorMsg[CURL_ERROR_SIZET];

17

18 curl_easy_setopt( curl, CURLOPT_ERRORBUFFER, errorMsg );
19 curl_easy_setopt( curl, CURLOPT_UPLOAD, TRUE );
20 curl_easy_setopt( curl, CURLOPT_URL, argv[2] );
21 curl_easy_setopt( curl, CURLOPT_READDATA, srcFile );
22

23 if( curl_easy_perform( curl ) I= 0 )

24 fprintf( stderr, "%s\n", errorMsg );

25

26 curl_easy_cleanup( curl );

27 1

28

29 return( EXIT_SUCCESS );
30 )

Line 7: Defining functions and data types

The 1ibcurl C functions and data types are defined
in the curl/curl.h header file, so 1ibcurl-enabled
programs should #include that file (see line 7).

Line 14: Calling the initialization function

Line 14 shows the call to the 1ibcurl initialization
function, curl_easy_init(). curl_easy_init(). This
call returns a handle.

A handle is a small piece of data that a library uses
to keep track of the state of something. In the case of
Tibcurl, the handle holds the state of a transfer job.
In 1ibcurl programs, a handle takes the form of a
CURL pointer (see line 11).

So what does a CURL pointer point to? Who knows?
That’s the whole point of a handle — the API's author
puts anything that he needs into the structure behind
the handle, but the author of a client application
(that’s you) can’t see the data. The API creates the
handle, and the client application just gives it back
to the APl whenever it’s needed.

Lines 18- 21: Defining the transfer

To create a transfer job, use curl_easy_setopt()
to define the characteristics of the transfer. Each
time you call cur1_easy_setopt(), you pass three
parameters:



400

v The CURL handle returned by curl_easy_init()

v The symbolic name of the option you want to
change

v The new value for the option

To upload a file, you must set four transfer options,
as shown on Lines 18-21.

Line 18: Routing libcurl error messages

Line 18 sets the CURLOPT_ERRORBUFFER option. This
option tells 1ibcur1 where to store any error mes-
sages in case something whacks out. When you set
the CURLOPT_ERRORBUFFER option, the third argument
specifies the buffer where 1ibcurl will store the error
messages. The documentation tells you that the error
message buffer should be at least CURL_ERROR_SIZE
bytes long (see line 16).

Speaking of documentation, when you install
the cur1 RPM package, the documentation
for 1ibcurl is installed as well. See info
curl_easy_setopt (orman curl_easy_
setopt if you prefer) for a complete list of
transfer options and values.

Line 19: Telling libcurl you want to upload a file

At line 19, you define the CURLOPT_UPLOAD option to
let 1ibcurl know that you want to upload a file (by
default, 1ibcurl assumes that you want to down-
load data).

You may have noticed that the data type for the
third argument to curl_easy_setopt() varies. In
some cases, the third argument is a char *; in others,
it’s a numeric value; and a few options expect a
Boolean value. Unfortunately, you have to infer the
proper data type from the online documentation.

Line 20: Telling libcurl where to send data

To tell Tibcurl where you want the data sent, set
the CURLOPT_URL option (line 20). The destination is
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specified in the form of a URL, and curlupload sim-
ply passes along the second command line argument
(argv[21). CURLOPT_URL is arguably the most impor-
tant and most powerful transfer option.

Tibcurl supports full URL syntax, so you can include
a host name, user name, password, directory, and
file name when you run curlupload. Here are a few
examples:

v ftp://example.com

A simple URL specifies a protocol (ftp) and a
host name (example.com). 1ibcurl can upload
data by using http or ftp. You can’t upload to a
URL this simple because you have to specify a
target filename (but you can download from a
simple URL).

v ftp://freddie@example.com

If you don’t specify a user name, 1ibcurl assumes
that you want to log in to an FTP server as user
anonymous. If you want to connect using a differ-
ent user name, just insert the user name, followed
by @ in front of the host name.

v ftp://freddie:password@example.com

You can also include a password in a URL by
inserting a colon (:) and the password following
the user name.

v ftp://example.com/pub/

A URL that ends with a / specifies a directory
name. You can’t upload to a URL that ends with
/, but you can download from such a URL.

v ftp://example.com/pub/drinks.txt

Because this URL does not endin a /, Tibcur]
assumes that drinks.txt is the name of the
destination file.

Line 21: Telling libcurl where the data resides

The last option (line 21) tells 1ibcur1 where to find
the data that you want to upload. You can give upload
data to 1ibcurl two ways:



v If the data resides in a file, just fopen() the file
(see line 12) and give the resulting FILE pointer
to 1ibcurl by using the CURLOPT_READDATA
option.

v If the data does not reside in a file (maybe you're
computing the data on the fly), you can write a
custom function that 1ibcurl calls whenever
it needs more data. See the description of the
CURLOPT_READFUNCTION option in man curl_
easy_setopt for more information.

Line 23: Starting the transfer

After you've primed the CURL handle with all the
options that you need, start the transfer with the
curl_easy_perform() function (see line 23). curl_
easy_perform() carries out the transfer operation
that you defined with the series of calls to cur1_
easy_setopt().In fact, you can use the same CURL
handle in a whole series of transfer operations just
by changing the options in between each transfer.
(Typically, you’ll change the CURLOPT_URL and
CURLOPT_READDATA before you start the next
transfer.)

If the transfer succeeds, curl_easy_perform() returns
0. If an error occurs, curl_easy_perform() stores an
error message in errorMsg[ ], and curlupload dis-
plays the text of the message at line 24.

Line 26: Finishing the upload

When you're finished with the CURL handle, you
should ca